
PDF-XChange PRO V10
USER MANUAL

© 2024. PDF-XChange Co Ltd. All Rights Reserved.

Tracker Software Products (Canada) Ltd.

P.O. Box 79

9622 Chemainus Road

Chemainus, British Columbia

V0R 1K0

Canada

Sales

Tel: Canada (+00) 1-250-324-1621

Fax: Canada (+00) 1-250-324-1623

https://www.pdf-xchange.com

sales@pdf-xchange.com

In Europe:

PDF-XChange Co. Ltd

Horsmanshoad, Pickwell Lane,

Bolney, West Sussex

RH17 5RH 

United Kingdom

Sales

Tel: +44 (0)20 8503 8711

Fax: (+00) 1-250-324-1623

Head Office:

support@pdf-xchange.com

mailto:sales@tracker-software.com
mailto:sales@tracker-software.com


Last Updated: 07/03/2024Last Updated: 07/03/2024



3

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

1. Welcome
 
                                                                                                                     18

2. Installation
 
                                                                                                                   21

2.1 System Requirements ........................................................................................................................... 23

2.2 Switches for MSI Installers ................................................................................................................... 24

2.3 Switches for EXE Installers .................................................................................................................... 36

2.4 Licensing ................................................................................................................................................. 42

2.5 End User License Agreement ................................................................................................................ 49

2.6 The PDF-XChange Updater ................................................................................................................... 57

3. PDF-XChange Editor Plus V10 User Manual
 
                                                             64

3.1 Features Overview ................................................................................................................................ 66

3.2 Explore the User Interface .................................................................................................................... 74

3.3 Tabs Guide ............................................................................................................................................. 82

File Tab ............................................................................................................................................ 843.3.1
Open ........................................................................................................................................................................................... 873.3.1.1

Recent Files ......................................................................................................................................................................... 893.3.1.1.1

Sessions ............................................................................................................................................................................... 913.3.1.1.2

Add a Place ......................................................................................................................................................................... 943.3.1.1.3

Save Options ............................................................................................................................................................................. 963.3.1.2

New Document ....................................................................................................................................................................... 1083.3.1.3

With Blank Pages ............................................................................................................................................................ 1103.3.1.3.1

Combine Files Into a Single PDF ................................................................................................................................... 1123.3.1.3.2

PDF Portfolio .................................................................................................................................................................... 1163.3.1.3.3

From Text ........................................................................................................................................................................... 1203.3.1.3.4

From Markdown .............................................................................................................................................................. 1253.3.1.3.5

From CSV File .................................................................................................................................................................... 1283.3.1.3.6

From Rich Text .................................................................................................................................................................. 1313.3.1.3.7

From Web Page ................................................................................................................................................................ 1343.3.1.3.8

From Email ........................................................................................................................................................................ 1373.3.1.3.9

From Image File(s) ........................................................................................................................................................... 1403.3.1.3.10

From Scanner ................................................................................................................................................................... 1513.3.1.3.11

From Clipboard ................................................................................................................................................................ 1553.3.1.3.12

Print Options .......................................................................................................................................................................... 1583.3.1.4

Export ....................................................................................................................................................................................... 1643.3.1.5

Export to Image ................................................................................................................................................................ 1663.3.1.5.1

Export to MS Word Document ....................................................................................................................................... 1683.3.1.5.2

Export to MS Excel Document ........................................................................................................................................ 1713.3.1.5.3

Export to MS PowerPoint Document ............................................................................................................................ 1743.3.1.5.4

Share ........................................................................................................................................................................................ 1773.3.1.6

Document Properties ............................................................................................................................................................ 1793.3.1.7

Preferences ............................................................................................................................................................................. 1923.3.1.8



4

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Documents ........................................................................................................................................................................ 1953.3.1.8.1

General .............................................................................................................................................................................. 1983.3.1.8.2

Page Display ..................................................................................................................................................................... 2023.3.1.8.3

Page Text ........................................................................................................................................................................... 2063.3.1.8.4

Registration ...................................................................................................................................................................... 2083.3.1.8.5

Accessibil ity ..................................................................................................................................................................... 2103.3.1.8.6

Color Management .......................................................................................................................................................... 2123.3.1.8.7

Commenting ...................................................................................................................................................................... 2143.3.1.8.8

Convert to/from PDF ....................................................................................................................................................... 2163.3.1.8.9

Customize UI ..................................................................................................................................................................... 2183.3.1.8.10

Document Info Bar .......................................................................................................................................................... 2203.3.1.8.11

File Associations ............................................................................................................................................................. 2223.3.1.8.12

Forms ................................................................................................................................................................................. 2243.3.1.8.13

Full Screen ........................................................................................................................................................................ 2263.3.1.8.14

Identity .............................................................................................................................................................................. 2293.3.1.8.15

JavaScript .......................................................................................................................................................................... 2313.3.1.8.16

Languages ......................................................................................................................................................................... 2333.3.1.8.17

Launch Applications ....................................................................................................................................................... 2353.3.1.8.18

Measurement ................................................................................................................................................................... 2383.3.1.8.19

Measurement 3D ............................................................................................................................................................. 2423.3.1.8.20

Multimedia 3D ................................................................................................................................................................. 2443.3.1.8.21

OCR ..................................................................................................................................................................................... 2463.3.1.8.22

Performance ..................................................................................................................................................................... 2483.3.1.8.23

Places ................................................................................................................................................................................ 2503.3.1.8.24

Plugins ............................................................................................................................................................................... 2523.3.1.8.25

Scanner Presets ............................................................................................................................................................... 2543.3.1.8.26

Search Providers ............................................................................................................................................................. 2563.3.1.8.27

Security .............................................................................................................................................................................. 2583.3.1.8.28

Send Mail .......................................................................................................................................................................... 2613.3.1.8.29

SharePoint ........................................................................................................................................................................ 2633.3.1.8.30

Signatures ......................................................................................................................................................................... 2653.3.1.8.31

Snapshot Tool .................................................................................................................................................................. 2693.3.1.8.32

Speech ................................................................................................................................................................................ 2713.3.1.8.33

Tools .................................................................................................................................................................................. 2733.3.1.8.34

Update ............................................................................................................................................................................... 2753.3.1.8.35

Manage Settings .................................................................................................................................................................... 2763.3.1.9

Home Tab ...................................................................................................................................... 2813.3.2
Hand Tool ................................................................................................................................................................................ 2863.3.2.1

Selection Options .................................................................................................................................................................. 2893.3.2.2

Transform ............................................................................................................................................................................... 2913.3.2.3

Duplicate ................................................................................................................................................................................. 2933.3.2.4

New Stamp from Selection ................................................................................................................................................... 2963.3.2.5

New Document from Selection ............................................................................................................................................ 2983.3.2.6

Link Options ........................................................................................................................................................................... 2993.3.2.7

Run a JavaScript .............................................................................................................................................................. 3073.3.2.7.1

Go To Page Options ......................................................................................................................................................... 3093.3.2.7.2



5

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Open a Web Link .............................................................................................................................................................. 3123.3.2.7.3

Open a File ........................................................................................................................................................................ 3143.3.2.7.4

Execute a Command ........................................................................................................................................................ 3163.3.2.7.5

Reset a Form ..................................................................................................................................................................... 3203.3.2.7.6

Submit a Form .................................................................................................................................................................. 3223.3.2.7.7

Play a Sound ..................................................................................................................................................................... 3253.3.2.7.8

Go to a 3D/Multimedia View ......................................................................................................................................... 3273.3.2.7.9

Show/Hide a Field ........................................................................................................................................................... 3293.3.2.7.10

Set Layer Visibil ity ........................................................................................................................................................... 3313.3.2.7.11

Read an Article ................................................................................................................................................................. 3343.3.2.7.12

View Tab ........................................................................................................................................ 3353.3.3
Editing Panes .......................................................................................................................................................................... 3423.3.3.1

Bookmarks ........................................................................................................................................................................ 3453.3.3.1.1

Thumbnails ....................................................................................................................................................................... 3513.3.3.1.2

Comments ......................................................................................................................................................................... 3583.3.3.1.3

Attachments ...................................................................................................................................................................... 3633.3.3.1.4

Fields ................................................................................................................................................................................. 3663.3.3.1.5

Signatures ......................................................................................................................................................................... 3713.3.3.1.6

Layers ................................................................................................................................................................................. 3743.3.3.1.7

Content .............................................................................................................................................................................. 3883.3.3.1.8

Destinations ..................................................................................................................................................................... 3933.3.3.1.9

3D Model Tree .................................................................................................................................................................. 4013.3.3.1.10

Links ................................................................................................................................................................................... 4053.3.3.1.11

Tags .................................................................................................................................................................................... 4093.3.3.1.12

Order .................................................................................................................................................................................. 4143.3.3.1.13

Accessibil ity Checker ...................................................................................................................................................... 4183.3.3.1.14

Accessibil ity Report ........................................................................................................................................................ 4213.3.3.1.15

Pan and Zoom .................................................................................................................................................................. 4233.3.3.1.16

Stamps Palette ................................................................................................................................................................. 4263.3.3.1.17

Comment Styles Palette .................................................................................................................................................. 4293.3.3.1.18

Spell Check ........................................................................................................................................................................ 4333.3.3.1.19

Document Recovery ......................................................................................................................................................... 4353.3.3.1.20

History ............................................................................................................................................................................... 4373.3.3.1.21

Properties Pane ............................................................................................................................................................... 4413.3.3.1.22

Zoom In/Out Tool .................................................................................................................................................................. 4433.3.3.2

Loupe Tool ............................................................................................................................................................................... 4443.3.3.3

Pan and Zoom ........................................................................................................................................................................ 4463.3.3.4

Page Transitions .................................................................................................................................................................... 4483.3.3.5

Rulers, Guides and Grid ....................................................................................................................................................... 4503.3.3.6

Comment Tab ................................................................................................................................ 4573.3.4
Select Comments .................................................................................................................................................................... 4623.3.4.1

Typewriter Tool ...................................................................................................................................................................... 4643.3.4.2

Text Box Tool .......................................................................................................................................................................... 4693.3.4.3

Callout Tool ............................................................................................................................................................................ 4743.3.4.4

Sticky Note Tool ..................................................................................................................................................................... 4803.3.4.5

File Attachment Tool ............................................................................................................................................................. 4853.3.4.6



6

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Sound Tool .............................................................................................................................................................................. 4903.3.4.7

Highlight Text Tool ................................................................................................................................................................ 4953.3.4.8

Underline Text Tool ............................................................................................................................................................... 5003.3.4.9

Strikeout Text Tool ................................................................................................................................................................. 5053.3.4.10

Insert Text Tool ...................................................................................................................................................................... 5103.3.4.11

Replace Text Tool ................................................................................................................................................................... 5163.3.4.12

Text Correction Tool .............................................................................................................................................................. 5223.3.4.13

Accounting Calculator .......................................................................................................................................................... 5243.3.4.14

Line Tool .................................................................................................................................................................................. 5293.3.4.15

Arrow Tool .............................................................................................................................................................................. 5363.3.4.16

Rectangle Tool ........................................................................................................................................................................ 5433.3.4.17

Oval Tool ................................................................................................................................................................................. 5493.3.4.18

Polygon Line Tool .................................................................................................................................................................. 5543.3.4.19

Polygon Tool ........................................................................................................................................................................... 5623.3.4.20

Cloud Tool ............................................................................................................................................................................... 5703.3.4.21

Stamp Tool .............................................................................................................................................................................. 5753.3.4.22

Pencil  Tool .............................................................................................................................................................................. 5923.3.4.23

Measuring Tools .................................................................................................................................................................... 5973.3.4.24

Distance Tool ................................................................................................................................................................... 5993.3.4.24.1

Perimeter Tool .................................................................................................................................................................. 6053.3.4.24.2

Area Tool ........................................................................................................................................................................... 6113.3.4.24.3

Set Scale ............................................................................................................................................................................ 6173.3.4.24.4

Add/Edit Video Annotations ................................................................................................................................................ 6193.3.4.25

Add/Edit Sound Annotations ............................................................................................................................................... 6233.3.4.26

Add/Edit 3D Annotations ..................................................................................................................................................... 6273.3.4.27

Manage Comments ................................................................................................................................................................ 6313.3.4.28

Summarize Comments .................................................................................................................................................... 6333.3.4.28.1

Import Comments ............................................................................................................................................................ 6363.3.4.28.2

Export Comments ............................................................................................................................................................. 6383.3.4.28.3

Show Comments ............................................................................................................................................................... 6393.3.4.28.4

Flatten Comments ............................................................................................................................................................ 6413.3.4.28.5

Show Comments List ....................................................................................................................................................... 6433.3.4.28.6

Comment Styles Palette .................................................................................................................................................. 6443.3.4.28.7

Protect Tab .................................................................................................................................... 6463.3.5
Digital Signature Options .................................................................................................................................................... 6513.3.5.1

Signatures and Initials ......................................................................................................................................................... 6603.3.5.2

Redaction and Sanitization ................................................................................................................................................. 6633.3.5.3

Create DocuSign Envelope ................................................................................................................................................... 6723.3.5.4

Form Tab ........................................................................................................................................ 6763.3.6
Add Text Fields to Documents ............................................................................................................................................. 6813.3.6.1

Add Check Boxes to Documents .......................................................................................................................................... 7043.3.6.2

Add Radio Buttons to Documents ....................................................................................................................................... 7143.3.6.3

Add List Boxes to Documents .............................................................................................................................................. 7243.3.6.4

Add Dropdown Menus to Documents ................................................................................................................................ 7363.3.6.5

Add Buttons to Documents .................................................................................................................................................. 7633.3.6.6

Add Digital Signature Fields to Documents ...................................................................................................................... 7803.3.6.7

Add Barcodes to Documents ............................................................................................................................................... 7983.3.6.8



7

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Add Date Fields to Documents ............................................................................................................................................ 8153.3.6.9

Add Image Fields to Documents ......................................................................................................................................... 8253.3.6.10

JavaScript Console ................................................................................................................................................................ 8343.3.6.11

Populate Forms ...................................................................................................................................................................... 8363.3.6.12

Identify Forms ........................................................................................................................................................................ 8413.3.6.13

Editing Forms ......................................................................................................................................................................... 8433.3.6.14

Organize Tab ................................................................................................................................. 8533.3.7
Insert ........................................................................................................................................................................................ 8573.3.7.1

Delete Pages ........................................................................................................................................................................... 8663.3.7.2

Extract Pages .......................................................................................................................................................................... 8693.3.7.3

Duplicate Pages ..................................................................................................................................................................... 8723.3.7.4

Move Pages ............................................................................................................................................................................. 8753.3.7.5

Replace Pages ........................................................................................................................................................................ 8773.3.7.6

Split Options .......................................................................................................................................................................... 8803.3.7.7

Swap Pages ............................................................................................................................................................................. 8863.3.7.8

Merge Pages ........................................................................................................................................................................... 8883.3.7.9

Overlay Pages ........................................................................................................................................................................ 8913.3.7.10

Rotate Pages ........................................................................................................................................................................... 8953.3.7.11

Crop .......................................................................................................................................................................................... 8973.3.7.12

Resize ....................................................................................................................................................................................... 9013.3.7.13

Set Margins ............................................................................................................................................................................. 9043.3.7.14

Watermarks ............................................................................................................................................................................ 9063.3.7.15

Background ............................................................................................................................................................................. 9093.3.7.16

Header and Footer ................................................................................................................................................................. 9123.3.7.17

Bates Numbering ................................................................................................................................................................... 9163.3.7.18

Number Pages ........................................................................................................................................................................ 9213.3.7.19

Convert Tab ................................................................................................................................... 9323.3.8
OCR Pages ............................................................................................................................................................................... 9363.3.8.1

Enhance Scanned Pages ....................................................................................................................................................... 9433.3.8.2

Convert Colors ....................................................................................................................................................................... 9463.3.8.3

Rasterize Pages ...................................................................................................................................................................... 9513.3.8.4

Recompress Images .............................................................................................................................................................. 9543.3.8.5

Replace Fonts ......................................................................................................................................................................... 9573.3.8.6

Share Tab ....................................................................................................................................... 9613.3.9

Review Tab .................................................................................................................................... 9693.3.10
Spell Check .............................................................................................................................................................................. 9733.3.10.1

Compare Documents ............................................................................................................................................................. 9773.3.10.2

Accessibility .................................................................................................................................. 9803.3.11

Bookmarks Tab .............................................................................................................................. 9853.3.12
Generate Bookmarks from Page Text ................................................................................................................................. 9883.3.12.1

Bookmark Every Nth Page .................................................................................................................................................... 9963.3.12.2

Generate Bookmarks from Table of Contents .................................................................................................................. 9983.3.12.3

Generate Bookmarks from Text File ................................................................................................................................. 10003.3.12.4

Add Text to Bookmark Titles .............................................................................................................................................. 10033.3.12.5

Change Bookmark Case ...................................................................................................................................................... 10053.3.12.6

Change Bookmarks Zoom Factor ...................................................................................................................................... 10073.3.12.7

Convert Named Destinations to Regular Destinations ................................................................................................ 10093.3.12.8



8

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Find and Replace Bookmark Text ..................................................................................................................................... 10113.3.12.9

Remove Actions from Bookmarks .................................................................................................................................... 10133.3.12.10

Sort Bookmarks ................................................................................................................................................................... 10163.3.12.11

Validate Bookmarks ........................................................................................................................................................... 10183.3.12.12

Merge Duplicate Bookmarks ............................................................................................................................................. 10203.3.12.13

Build Table of Contents ...................................................................................................................................................... 10223.3.12.14

Create Links from Bookmarks ........................................................................................................................................... 10253.3.12.15

Sort Pages by Bookmarks .................................................................................................................................................. 10273.3.12.16

Convert to Named Destinations ....................................................................................................................................... 10283.3.12.17

Export Bookmarks to HTML ............................................................................................................................................... 10303.3.12.18

Export Bookmarks to Text File .......................................................................................................................................... 10313.3.12.19

Help Tab ...................................................................................................................................... 10343.3.13
Customize Toolbars ............................................................................................................................................................ 10373.3.13.1

Report a Problem ................................................................................................................................................................ 10643.3.13.2

Format Tab .................................................................................................................................. 10663.3.14

Arrange Tab ................................................................................................................................. 10683.3.15

Portfolio Tab ................................................................................................................................ 10723.3.16

Order Tab .................................................................................................................................... 10783.3.17

3.4 Appendix ............................................................................................................................................ 1081

Accessibility Check ...................................................................................................................... 10833.4.1

Alt Shortcuts ................................................................................................................................ 10863.4.2

Add/Edit Content ......................................................................................................................... 10873.4.3

Blend Mode ................................................................................................................................. 11093.4.4

Changing the Layout of Panes .................................................................................................... 11123.4.5

Command Line Options ............................................................................................................... 11193.4.6

Comments Shortcut Menu ........................................................................................................... 11303.4.7

Converting Files to PDF ............................................................................................................... 11343.4.8

Date Format Specification ........................................................................................................... 11363.4.9

Document Tab Options ............................................................................................................... 11393.4.10

Editing Document Pages ............................................................................................................. 11413.4.11

Editing Text in Annotations ......................................................................................................... 11423.4.12

Features Added in V10 ................................................................................................................ 11453.4.13

Find .............................................................................................................................................. 11473.4.14

Keyboard Shortcuts ...................................................................................................................... 11493.4.15

Macros ......................................................................................................................................... 11663.4.16
Application Version ............................................................................................................................................................ 11693.4.16.1

Auto Number ........................................................................................................................................................................ 11713.4.16.2

Bates Numbering ................................................................................................................................................................. 11743.4.16.3

Bates Page Numbering Value ............................................................................................................................................ 11763.4.16.4

Bookmark Level .................................................................................................................................................................... 11783.4.16.5

Bookmark Title ..................................................................................................................................................................... 11813.4.16.6

Computer Name ................................................................................................................................................................... 11843.4.16.7

Date ........................................................................................................................................................................................ 11863.4.16.8

Day ......................................................................................................................................................................................... 11893.4.16.9



9

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Document Index ................................................................................................................................................................... 11923.4.16.10

Document Info ..................................................................................................................................................................... 11953.4.16.11

Document Title ..................................................................................................................................................................... 12013.4.16.12

Environment Variable ........................................................................................................................................................ 12033.4.16.13

FileName ............................................................................................................................................................................... 12073.4.16.14

File Extension ....................................................................................................................................................................... 12113.4.16.15

File to Open .......................................................................................................................................................................... 12133.4.16.16

Folder Name ......................................................................................................................................................................... 12173.4.16.17

Folder Title ........................................................................................................................................................................... 12193.4.16.18

Hierarchical Index .............................................................................................................................................................. 12213.4.16.19

Hour ....................................................................................................................................................................................... 12243.4.16.20

Index in Parent .................................................................................................................................................................... 12273.4.16.21

Minute ................................................................................................................................................................................... 12303.4.16.22

Month .................................................................................................................................................................................... 12333.4.16.23

Named Destination ............................................................................................................................................................. 12363.4.16.24

Number of Pages ................................................................................................................................................................. 12403.4.16.25

Page First Text Line ............................................................................................................................................................. 12433.4.16.26

Page Label ............................................................................................................................................................................. 12463.4.16.27

Page Number ........................................................................................................................................................................ 12493.4.16.28

Page Numbering Style ................................................................................................................................................... 12543.4.16.28.1

Seconds ................................................................................................................................................................................. 12613.4.16.29

Sequential Number ............................................................................................................................................................. 12643.4.16.30

Time ....................................................................................................................................................................................... 12673.4.16.31

Username .............................................................................................................................................................................. 12703.4.16.32

Web Link to Open ................................................................................................................................................................ 12723.4.16.33

Year ........................................................................................................................................................................................ 12763.4.16.34

Macro-Enabled Operations .............................................................................................................................................. 12793.4.16.35

Page Boxes .................................................................................................................................. 12823.4.17

Page Range Settings ................................................................................................................... 12853.4.18

Read Out Loud Feature ............................................................................................................... 12863.4.19

Removing Trial Watermarks ........................................................................................................ 12883.4.20

Removing Activations from a License ......................................................................................... 12933.4.21

Search .......................................................................................................................................... 12953.4.22

Shell Extensions .......................................................................................................................... 13003.4.23

Tool Properties ............................................................................................................................ 13033.4.24

4. PDF-Tools V10 User Manual
 
                                                                                  1307

5. Features Overview
 
                                                                                                 1309

6. User Interface
 
                                                                                                         1315

7. Create Tool
 
                                                                                                              1323

8. Clone Tool
 
                                                                                                               1330



10

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

9. Actions Library
 
                                                                                                        1336

9.1 Create PDF Actions ............................................................................................................................ 1338

Convert Files to PDFs .................................................................................................................. 13399.1.1

Create PDF Portfolio .................................................................................................................... 13469.1.2

Create PDF from Images ............................................................................................................. 13489.1.3

Create PDF from Text .................................................................................................................. 13559.1.4

Extract Pages ............................................................................................................................... 13599.1.5

Get Images from Scanner ............................................................................................................ 13619.1.6

Split/Merge Documents .............................................................................................................. 13659.1.7

9.2 Export PDF Actions ............................................................................................................................ 1367

Export PDF to Images .................................................................................................................. 13689.2.1

Export PDF to Microsoft Excel Spreadsheet ................................................................................ 13729.2.2

Export PDF to Microsoft PowerPoint Presentation  ..................................................................... 13769.2.3

Export PDF to Microsoft Word Document ................................................................................... 13819.2.4

Export PDF to Plain Text  ............................................................................................................. 13859.2.5

Extract Attachments .................................................................................................................... 13879.2.6

Extract Images from PDF ............................................................................................................. 13899.2.7

PDF to Audio ................................................................................................................................ 13919.2.8

9.3 Input/Output Actions ....................................................................................................................... 1394

Choose Input Files ....................................................................................................................... 13959.3.1

Save Documents .......................................................................................................................... 14039.3.2

Save Images ................................................................................................................................ 14059.3.3

Send Mail ..................................................................................................................................... 14089.3.4

Show Files .................................................................................................................................... 14109.3.5

9.4 Bookmark Actions ............................................................................................................................. 1412

Build Table of Contents ............................................................................................................... 14139.4.1

Export Bookmarks ........................................................................................................................ 14189.4.2

Export Bookmarks to Text File ..................................................................................................... 14199.4.3

Find and Replace Bookmark Text ................................................................................................ 14229.4.4

Generate Bookmarks from Page Text ......................................................................................... 14249.4.5

Import Bookmarks ....................................................................................................................... 14329.4.6

Import Bookmarks from Text File ................................................................................................ 14349.4.7

9.5 Optimize PDF Actions ........................................................................................................................ 1436

Enhance Scanned Pages .............................................................................................................. 14379.5.1

Optimize Document ..................................................................................................................... 14409.5.2

Recompress Images .................................................................................................................... 14499.5.3

9.6 PDF Standard Actions ....................................................................................................................... 1454

Convert to PDF/A ......................................................................................................................... 14559.6.1

Convert to PDF/X ......................................................................................................................... 14579.6.2



11

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Discard Special PDF-Standard ..................................................................................................... 14599.6.3

9.7 Pages Actions ..................................................................................................................................... 1461

Add Bates Numbering ................................................................................................................. 14639.7.1

Add Header and Footer ............................................................................................................... 14679.7.2

Add Watermarks .......................................................................................................................... 14719.7.3

Change Page Background ........................................................................................................... 14759.7.4

Crop Pages .................................................................................................................................. 14799.7.5

Delete Pages ............................................................................................................................... 14829.7.6

Duplicate Pages .......................................................................................................................... 14849.7.7

Import as Layer Overlay .............................................................................................................. 14869.7.8

Insert Empty Pages ...................................................................................................................... 14899.7.9

Insert Pages ................................................................................................................................. 14919.7.10

Merge Pages ............................................................................................................................... 14949.7.11

Move Pages ................................................................................................................................. 14979.7.12

OCR Pages ................................................................................................................................... 14999.7.13

Overlay PDF ................................................................................................................................. 15049.7.14

Rasterize Pages ........................................................................................................................... 15069.7.15

Remove Bates Numbering ........................................................................................................... 15099.7.16

Remove Headers and Footers ..................................................................................................... 15109.7.17

Remove Page Background ........................................................................................................... 15119.7.18

Remove Watermarks ................................................................................................................... 15129.7.19

Replace Pages ............................................................................................................................. 15139.7.20

Resize Pages ............................................................................................................................... 15169.7.21

Rotate Pages ............................................................................................................................... 15199.7.22

Setup Page Transitions ................................................................................................................ 15219.7.23

Split Pages ................................................................................................................................... 15239.7.24

9.8 Links Actions ...................................................................................................................................... 1526

Create Weblinks .......................................................................................................................... 15279.8.1

Delete Links ................................................................................................................................. 15299.8.2

Delete Weblinks .......................................................................................................................... 15319.8.3

9.9 Forms Actions .................................................................................................................................... 1533

Delete Form Fields ...................................................................................................................... 15349.9.1

Export Form Data ......................................................................................................................... 15369.9.2

Import Form Data ........................................................................................................................ 15389.9.3

Reset Form .................................................................................................................................. 15409.9.4

9.10 Comments Actions ............................................................................................................................ 1541

Delete All Comments .................................................................................................................. 15429.10.1

Delete Markup Annotations ........................................................................................................ 15449.10.2

Export Comments ........................................................................................................................ 15469.10.3

Flatten Comments and Fields ...................................................................................................... 15489.10.4



12

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Import Comments ........................................................................................................................ 15509.10.5

Summarize Comments ................................................................................................................. 15529.10.6

9.11 Protection Actions ............................................................................................................................ 1555

Add Timestamp ........................................................................................................................... 15569.11.1

Apply Redaction .......................................................................................................................... 15599.11.2

Certify Document ........................................................................................................................ 15609.11.3

Clear Digital Signatures .............................................................................................................. 15649.11.4

Find and Redact ........................................................................................................................... 15659.11.5

Sanitize Document ....................................................................................................................... 15689.11.6

Secure Document ........................................................................................................................ 15709.11.7

Sign Document ............................................................................................................................ 15739.11.8

9.12 Advanced Actions ............................................................................................................................. 1577

Change Document Properties ..................................................................................................... 15789.12.1

Convert Colors ............................................................................................................................. 15859.12.2

Create File List ............................................................................................................................ 15909.12.3

Filter Documents ......................................................................................................................... 15919.12.4

Filter Files .................................................................................................................................... 15939.12.5

Filter Pages .................................................................................................................................. 15959.12.6

Find by Regular Expression ......................................................................................................... 15979.12.7

Print Document ............................................................................................................................ 15999.12.8

Run Application ........................................................................................................................... 16049.12.9

10. Default Tools
 
                                                                                                           1606

10.1 Create PDF Tools ................................................................................................................................ 1607

Convert Files to PDFs .................................................................................................................. 160810.1.1

Create PDF from Images ............................................................................................................. 161010.1.2

Create PDF from Text .................................................................................................................. 161210.1.3

Create PDF Portfolio .................................................................................................................... 161410.1.4

Extract Pages ............................................................................................................................... 161610.1.5

Scan to PDF .................................................................................................................................. 161810.1.6

Split/Merge PDFs ......................................................................................................................... 162010.1.7

10.2 Pages Tools ........................................................................................................................................ 1622

Add Bates Numbering ................................................................................................................. 162410.2.1

Add Header and Footer ............................................................................................................... 162610.2.2

Add Watermark ........................................................................................................................... 162810.2.3

Crop Pages .................................................................................................................................. 163010.2.4

Delete Pages ............................................................................................................................... 163210.2.5

Duplicate Pages .......................................................................................................................... 163410.2.6

Import as Layer Overlay .............................................................................................................. 163610.2.7

Insert Empty Pages ...................................................................................................................... 163810.2.8

Insert Pages ................................................................................................................................. 164010.2.9



13

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Merge Pages ............................................................................................................................... 164210.2.10

Move Pages ................................................................................................................................. 164410.2.11

OCR Pages ................................................................................................................................... 164610.2.12

Overlay PDF ................................................................................................................................. 164810.2.13

Rasterize Pages ........................................................................................................................... 165010.2.14

Remove Bates Numbering ........................................................................................................... 165210.2.15

Remove Headers and Footers ..................................................................................................... 165410.2.16

Remove Pages Background ......................................................................................................... 165610.2.17

Remove Watermarks ................................................................................................................... 165810.2.18

Replace Pages ............................................................................................................................. 166010.2.19

Resize Pages ............................................................................................................................... 166210.2.20

Rotate Pages ............................................................................................................................... 166410.2.21

Set Page Transitions .................................................................................................................... 166610.2.22

Set Pages Background ................................................................................................................. 166810.2.23

Split Pages ................................................................................................................................... 167010.2.24

10.3 Links Tools .......................................................................................................................................... 1672

Create Weblinks .......................................................................................................................... 167310.3.1

Delete Links ................................................................................................................................. 167510.3.2

Delete Weblinks .......................................................................................................................... 167710.3.3

10.4 Forms Tools ........................................................................................................................................ 1679

Delete Form Fields ...................................................................................................................... 168010.4.1

Export Form Data ......................................................................................................................... 168210.4.2

Import Form Data ........................................................................................................................ 168410.4.3

Reset Forms ................................................................................................................................. 168610.4.4

10.5 Comments Tools ................................................................................................................................ 1688

Delete All Comments .................................................................................................................. 168910.5.1

Delete Markup Annotations ........................................................................................................ 169110.5.2

Export Comments ........................................................................................................................ 169310.5.3

Flatten Comments and Fields ...................................................................................................... 169510.5.4

Import Comments ........................................................................................................................ 169710.5.5

Summarize Comments ................................................................................................................. 169910.5.6

10.6 Bookmarks Tools ............................................................................................................................... 1701

Build Table of Contents ............................................................................................................... 170210.6.1

Export Bookmarks ........................................................................................................................ 170410.6.2

Export Bookmarks to Text File ..................................................................................................... 170610.6.3

Find and Replace Bookmark Text ................................................................................................ 170810.6.4

Generate Bookmarks from Page Text ......................................................................................... 171010.6.5

Import Bookmarks ....................................................................................................................... 171210.6.6

Import Bookmarks from Text File ................................................................................................ 171410.6.7

10.7 Protection Tools ................................................................................................................................ 1716



14

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Apply Redaction .......................................................................................................................... 171710.7.1

Certify PDFs ................................................................................................................................. 171910.7.2

Clear All Digital Signatures ......................................................................................................... 172110.7.3

Find and Redact ........................................................................................................................... 172310.7.4

Sanitize Document ....................................................................................................................... 172510.7.5

Secure PDF ................................................................................................................................... 172710.7.6

Sign Document ............................................................................................................................ 172910.7.7

Timestamp PDFs .......................................................................................................................... 173110.7.8

10.8 Optimize PDF Tools ........................................................................................................................... 1733

Enhance Scanned Pages .............................................................................................................. 173410.8.1

Optimize PDF ............................................................................................................................... 173610.8.2

Recompress Images .................................................................................................................... 173810.8.3

10.9 PDF Standard Tools ........................................................................................................................... 1740

Convert to PDF/A ......................................................................................................................... 174110.9.1

Convert to PDF/X ......................................................................................................................... 174310.9.2

Discard Special PDF-Standard ..................................................................................................... 174510.9.3

10.10 Export PDF Tools ............................................................................................................................... 1747

Export PDF to Audio ..................................................................................................................... 174810.10.1

Export PDF to Images .................................................................................................................. 175010.10.2

Export PDF to Microsoft Excel Spreadsheet ................................................................................ 175210.10.3

Export PDF to Microsoft Powerpoint Presentation ...................................................................... 175410.10.4

Export PDF to Microsoft Word Document ................................................................................... 175610.10.5

Export PDF to Plain Text .............................................................................................................. 175810.10.6

Extract Images from PDF ............................................................................................................. 176010.10.7

10.11 Advanced Tools ................................................................................................................................. 1762

Change Document Properties ..................................................................................................... 176310.11.1

Convert Colors ............................................................................................................................. 176510.11.2

Extract Attachments .................................................................................................................... 176710.11.3

Print Document ............................................................................................................................ 176910.11.4

Send E-Mail ................................................................................................................................. 177110.11.5

11. Appendix
 
                                                                                                                 1773

11.1 Available File Filters .......................................................................................................................... 1774

11.2 Add Tools to the Windows Shell Menu .......................................................................................... 1778

11.3 Command Line Options .................................................................................................................... 1780

11.4 Crop Margins ..................................................................................................................................... 1790

11.5 Features Added in Version 10 .......................................................................................................... 1792

11.6 Font and Paragraph Parameters ...................................................................................................... 1794

11.7 Macros ................................................................................................................................................ 1796



15

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Application Version ..................................................................................................................... 179911.7.1

Auto Number ............................................................................................................................... 180111.7.2

Bates Numbering ......................................................................................................................... 180411.7.3

Bates Page Numbering Value ..................................................................................................... 180611.7.4

Computer Name .......................................................................................................................... 180811.7.5

Date ............................................................................................................................................. 181011.7.6

Day .............................................................................................................................................. 181311.7.7

Document Index .......................................................................................................................... 181611.7.8

Document Info ............................................................................................................................. 182011.7.9

Document Title ............................................................................................................................ 182411.7.10

Environment Variable .................................................................................................................. 182611.7.11

FileName ..................................................................................................................................... 183011.7.12

File Extension .............................................................................................................................. 183211.7.13

Folder Name ................................................................................................................................ 183411.7.14

Folder Title .................................................................................................................................. 183611.7.15

Hour ............................................................................................................................................. 183811.7.16

Minute ......................................................................................................................................... 184111.7.17

Month .......................................................................................................................................... 184411.7.18

Number of Pages ......................................................................................................................... 184711.7.19

Page Number ............................................................................................................................... 185011.7.20
Page Numbering Style ......................................................................................................................................................... 185511.7.20.1

Seconds ....................................................................................................................................... 186011.7.21

Time ............................................................................................................................................. 186311.7.22

Username .................................................................................................................................... 186611.7.23

Year ............................................................................................................................................. 186811.7.24

11.8 Media Foundation Installation ........................................................................................................ 1871

11.9 Page Range Options .......................................................................................................................... 1873

11.10 Preferences ........................................................................................................................................ 1875

General ........................................................................................................................................ 187811.10.1

Languages ................................................................................................................................... 188411.10.2

Passwords ................................................................................................................................... 188611.10.3

Registration ................................................................................................................................. 188811.10.4

Color Management ...................................................................................................................... 189011.10.5

Convert from PDF ........................................................................................................................ 189211.10.6

Convert to PDF ............................................................................................................................. 189411.10.7

Customize UI ............................................................................................................................... 189611.10.8

Identity ........................................................................................................................................ 189811.10.9

Measurement .............................................................................................................................. 190011.10.10

OCR ............................................................................................................................................. 190111.10.11

Performance ................................................................................................................................ 190311.10.12

Plugins ......................................................................................................................................... 190411.10.13



16

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

Scanner Presets ........................................................................................................................... 190611.10.14

Send Mail ..................................................................................................................................... 191011.10.15

Signatures .................................................................................................................................... 191211.10.16

Update ......................................................................................................................................... 191611.10.17

11.11 Folder Monitors ................................................................................................................................. 1917

12. PDF-XChange Standard V10 User Manual
 
                                                           1922

13. Features Overview
 
                                                                                                 1924

14. PDF-XChange Printer Standard Printer Settings
 
                                                  1926

14.1 Profiles ............................................................................................................................................... 1932

14.2 Driver Mode ....................................................................................................................................... 1936

14.3 Macros ................................................................................................................................................ 1940

Application Name ........................................................................................................................ 194314.3.1

Computer Name .......................................................................................................................... 194714.3.2

Date and Time Macros ................................................................................................................ 195114.3.3

Document Name .......................................................................................................................... 195514.3.4

Document Path ............................................................................................................................ 196014.3.5

Environment Variable .................................................................................................................. 196514.3.6

Pages Count ................................................................................................................................ 197014.3.7

Page Number ............................................................................................................................... 197414.3.8

User Name ................................................................................................................................... 197914.3.9

14.4 Paper .................................................................................................................................................. 1983

Standard Layout ........................................................................................................................... 198614.4.1

Booklet Layout ............................................................................................................................. 198814.4.2

Multiple Pages per Sheet ............................................................................................................ 199014.4.3

14.5 Custom Forms .................................................................................................................................... 1992

14.6 General ............................................................................................................................................... 1995

14.7 Compression ...................................................................................................................................... 1999

14.8 Graphics ............................................................................................................................................. 2001

14.9 Fonts ................................................................................................................................................... 2003

14.10 Watermarks ....................................................................................................................................... 2005

14.11 Overlays ............................................................................................................................................. 2009

14.12 Security .............................................................................................................................................. 2011

14.13 Links .................................................................................................................................................... 2017

14.14 Bookmarks ......................................................................................................................................... 2019

14.15 Default File Append .......................................................................................................................... 2021

14.16 Headers and Footers ......................................................................................................................... 2023



17

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Table of Contents

14.17 Document Info ................................................................................................................................... 2026

14.18 Save .................................................................................................................................................... 2028

14.19 e-Mail ................................................................................................................................................. 2030

14.20 Optimization ...................................................................................................................................... 2032

14.21 Languages .......................................................................................................................................... 2035

15. Convert Web Pages to PDF
 
                                                                                   2037

16. PDF Saver
 
                                                                                                                2038

17. MSOffice Toolbar Add-in
 
                                                                                       2044

18. MS Outlook Add-in
 
                                                                                                 2053

19. OFFice2PDF
 
                                                                                                             2058

20. Features Added in Version 10
 
                                                                               2062

Index 2065



18

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Welcome

1 Welcome

 PDF-XChange PRO V10

The PDF-XChange PRO V10 bundle combines three of PDF-XChange's applications:

 PDF-XChange Editor Plus – one of the fastest and most feature-rich applications

used worldwide to create, view, edit and annotate PDF files. The PDF-XChange Editor manual is

available here.

 PDF Tools – a dynamic and user-friendly solution for the batch-creation

and manipulation of industry-standard PDF and image files. Featuring seventy-seven

default tools, as well as the option to clone, edit and create fully-customizable tools,

it’s the ideal software to compliment your existing PDF facilities. The PDF-Tools user

manual is available here.  

 PDF-XChange Standard – our virtual printer that is used to convert industry-standard

file formats to PDF. It's compatible with files from almost all Windows applications such as MS

Word, Excel and AutoCAD. It features an optimized, hybrid engine that significantly increases

the quality of conversion for images and image-based text characters, and prints to both GDI

and XPS. The PDF-XChange Standard user manual is available here.

The combination of these products makes it possible to create, view, edit and print PDF files

to the highest levels of quality. We offer several other applications for the manipulation of

PDF and image files. Further details are available at the PDF-XChange Products Page.

We offer several other applications for the manipulation of PDF and image files. Please see

the PDF-XChange Products Page for further information. The User Forums are an excellent

resource for troubleshooting, and our Knowledgebase contains over four hundred articles

64

1307

1922

http://www.pdf-xchange.com/products
http://www.pdf-xchange.com/products
https://www.pdf-xchange.com/forum3/
https://www.pdf-xchange.com/knowledgebase
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about our software and other relevant information. If you have any queries then please

Contact Us.

This manual is composed of the following sections:

· Installation details the installation process, system requirements, installation switch

options and licensing details for the software.

· PDF-XChange Editor Plus User Manual is a comprehensive guide to PDF-XChange

Editor, the PDF-editing software that is included with this product.

· PDF-Tools User Manual is a comprehensive guide to PDF-Tools, the PDF-

conversion software that is included with this product.

· PDF-XChange Standard User Manual is a comprehensive guide to PDF-XChange

Standard, the virtual printer that is included with this product.

A PDF version of this manual is available here.

The system administrator's guide, for managing PDF-XChange products across an enterprise, is

available here.

The PDF Format

The Portable Document Format (PDF) is an internationally-recognized file format that was

developed in 1992 in order to present documents, including text formatting and images,

between users of different platforms, application software, hardware and operating systems,

who may not have access to mutually-compatible application software. PDF files are based

on the PostScript page-description language, and every PDF file contains a complete

description of a fixed-layout flat document, including the text, fonts, vector graphics, raster

images and other information required to display it. PDF was standardized as an open

format in 2008, and since then has expanded to contain a range of additional content

besides flat text and graphics, including logical structuring elements, interactive elements

such as annotations and form fields, layers, rich media (including video content), three

dimensional objects that use the U3D or PRC formats, encryption options, digital signatures,

file attachments and document metadata. The specifications of the PDF format are defined

and maintained by the International Organization for Standardization (ISO), which

determines the content that is permitted in PDF documents, the properties of that content

and the manner in which it can be manipulated. The original PDF specification was created

in 1993, and since then it has been regularly expanded and enhanced to include additional

content. The ISO published the most recent specification, PDF 2.0, ISO 32000-2:2020, in

December 2020. All documents that are created and/or edited with PDF-XChange software

conform to the ISO specification and are therefore compatible with all systems and

software worldwide that also conform to the ISO specification.

http://www.pdf-xchange.com/contact
https://pdf-xchange.com/PDFXP10_MAN.pdf
https://help.pdf-xchange.com/sysadmin/
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2 Installation

 Installation

Follow these steps to install PDF-XChange PRO:

1. Use the link in your purchase confirmation email, or the download option on the

product page here, to download an evaluation version of PDF-XChange PRO.

2. When the download is complete, click the PDFXPro10.zip file to open the

containing folder. (Winzip and CnetsDownload.com have free downloads available if

you require software to unzip files).

3. The PDFXPRO10.exe is displayed next to an icon. Double-click either the text or the

icon to open the Run/Cancel dialog box.

4. Click Run to open the PDF-XChange PRO V10 Setup dialog box.

5. Click Install. (Please note that the first time you run the installer you will be prompted to enter

your registration number/activation code. We recommend that you copy and paste this from your

receipt to avoid mistakes).

6. When prompted, click Next in the PDF-XChange PRO V10 Setup dialog box.

7. Read the license agreement and select the I accept the terms in the License Agreement box,

then click Next.

8. Select Custom to determine program feature parameters, or click Complete to install all

program features.

9. Click Install. The software will then install on the local computer.

Note that it is not necessary to be online to install a license for PDF-XChange PRO. If you

have a hard copy of your license key (for example on a USB stick) then you can simply copy

it into the text box in the Registration section of PDF-XChange Editor, PDF-Tools and/or

PDF-XChange Standard as required.

https://www.pdf-xchange.com/product/pdf-xchange-pro
http://www.winzip.com/
http://www.download.com/
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VERY IMPORTANT

Please keep your serial key/activation code safe. Do not share it with other parties, as doing

so constitutes an illegal breach of copyright. If we discover evidence of abuse then updates

will be disabled for your account. Serial keys/activation codes found on websites offering

free and illegal software distribution will be disabled immediately. We monitor such

websites on a daily basis. Help us safeguard the integrity of our products to ensure that their

future development is made possible. Theft of our software deprives us of investment that

improves our products for the benefit of all clients.
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2.1 System Requirements

   System Requirements

PDF-XChange PRO supports all Windows (32/64 bit) operating systems from Windows 7

and later, including Windows 11.

Please note the following:

· All versions from V4 to V10 are Microsoft/Citrix Terminal Server compatible.

· All versions from V4 to V7 are Windows XP/Vista compatible.

· V3 is still available for Windows 95/98.

· We recommend that users install the latest Microsoft Windows service packs and updates

before using our products, as doing so will ensure the greatest possible performance of the

software.

· Our products - in particular the printer drivers that PDF-XChange Standard and PDF-XChange

Lite utilize - are not designed to work in virtualized environments such as the XenApp

software.

· There are some limitations to product support for Windows XP as Microsoft have stopped

supporting it. Further information about this issue is available here.

· If you are using Windows 7 then please ensure you have the latest release and all available

fixes - otherwise you may encounter issues, as detailed here.

https://www.pdf-xchange.com/knowledgebase/399-Microsoft-to-End-Support-for-Windows-XP-Home--Professional-3264-bit
https://www.pdf-xchange.com/knowledgebase/546-I-have-a-problem-with-installing-or-updating-the-Editor-while-running-Windows-7
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2.2 Switches for MSI Installers

  Switches for MSI Installers

The most useful options for msiexec are detailed below. Please note that parameters are case sensitive.

All available options are detailed here.

The command line for installation is: msiexec /Option <Required Parameter> [Optional Parameter]

[PROPERTY=PropertyValue]

Install Options

/package or /i

This switch installs or configures the product specified.

Syntax

<Product.msi>

/a

This switch installs the product specified on the network as an administrative install.

Syntax

<Product.msi>

/j<u|m>

https://docs.microsoft.com/en-us/windows/desktop/Msi/command-line-options
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This switch advertises the specified product. "u" advertises to the current user, "m" advertises to all

users.

Syntax

<Product.msi>

Parameters

· [/t <Transform List>] 

· [/g <Language ID>]

/uninstall | /x

This switch uninstalls the product specified. 

Syntax

<Product.msi>

Parameters

The parameter for this switch can be either an .msi file or the relevant product code.

Display Options

/quiet

This switch installs the application without user interaction.

/passive

This switch installs the application in unattended mode. The user will see only the progress bar.

/q[n|b|r|f]
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This switch sets the user interface level. "b" installs a basic UI, "f" installs a full UI and is the default

setting, "n" means that no UI is installed, "r" installs a reduced UI. 

Restart Options

/norestart

This switch disables the automatic system restart when installation is complete. (Please note

that many PDF-XChange products require a restart to function properly).

/promptrestart 

This switch prompts the user for a restart when it is necessary.

/forcerestart

This switch forces a system restart when installation is complete.

Logging Options

/l

This switch defines the logging level for installation.

Syntax

<Logfile>

Modifiers

a - start up of actions.
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c - initial UI parameters.

e - all error messages.

i - status messages.

m - out of memory or fatal exit information.

o - out of disk space messages.

p - terminal properties.

r - action-specific records.

u - user requests.

v - verbose output.

w - nonfatal warnings.

x - extra debugging information.

+ - append to existing file.

! - flush each line to the log.

* - log all information except for verbose output and extra debugging information.

/log

This switch is the equivalent for /l* <LogFile>.

Syntax

<LogFile>

Repair Options
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/f

This switch repairs the product specified.

Syntax

<Product>

Parameters

The parameter for this switch can be either an .msi file or the relevant product code.

Modifiers

a - forces the reinstallation of all files.

c - if a file is missing or checksum does not match the calculated value. 

d - if a file is missing or a different version is installed. 

e - if a file is missing or an equal or older version is installed.

m - all required computer-specific registry entries. This is a default setting.

o - if a file is missing or an older version is installed. This is a default setting.

 

p - only if a file is missing.

s - all existing shortcuts. This is a default setting.

u - all required user-specific registry entries. This is a default setting. 

v - runs from source and re-caches the local package.

Standard Properties

ADDLOCAL
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The value of the ADDLOCAL property is a list of features, delimited with commas, that install locally. If

it is not used the all available options will be installed. If it is used then all required features must be

specified.

Syntax

ADDLOCAL=<list of features>

Features

· F_Viewer - PDF-XChange Editor and its main components.

· F_Plugins - the plugins module for PDF-XChange Editor. (This requires F_Viewer).

· F_Plugin_SP - the spell-checker plugin. (This requires F_Plugins).

· F_FileOpenPlugin - the security plugin that handles FileOpen DRM. (This requires F_Plugins). 

· F_ReadOutLoudPlugin - the plugin that provides 'read-out-loud' functionality. (This requires

F_Plugins).

· F_EOCRAPlugin - facilitates the use of the enhanced OCR features. (This requires F_Plugins).

· F_AzureRMSPlugin - the plugin for handling PDF files protected by MS Azure RMS. (This

requires F_Plugins).

· F_OptimizerPlugin - the plugin that optimizes PDF files.

· F_BookmarksPlugin - the plugin that facilitates the inclusion of advanced functionality for

bookmarks. (This requires F_Plugins).

· F_PDFAPlugin - the plugin that converts PDF files into PDF/A format. (This requires F_Plugins).

· F_SPPlugin - the SharePoint plugin, which facilitates the use of files located on SharePoint

servers. (This requires F_Plugins).

· F_GDPlugin - facilitates the use of files located on Google Drive™. (This requires F_Plugins).

· F_OFCPlugin - to install the plugin that allows the conversion of documents into MS Office

formats directly within the software. (This requires F_Plugins).

· F_IdentifyFormsPlugin - the plugin that enables the detection and creation of form fields in

documents converted to PDF. (This requires F_Plugins).

· F_DBPlugin - facilitates the use of files located on the DropBox™ cloud. (This requires

F_Plugins).

· F_OCRPlugin - facilitates the use of the default OCR features. (This requires F_Plugins).

· F_MDPlugin - to install the plugin that enables the conversion of Markdown files into PDF

documents. (This requires F_Plugins).

· F_ODPlugin - the plugin that enables working with files located on Microsoft OneDrive. (This

requires F_Plugins).

· F_BoxPlugin - the plugin that enables working with files located on Box.com. (This requires

F_Plugins).

· F_3DPlugin - the plugin that enables the viewing of embedded 3D content in PDF documents.

(This requires F_Plugins).

· F_ColorPlugin - the plugin that enables the conversion of colors in PDF documents. (This

requires F_Plugins).
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· F_CSVPlugin - the plugin that enables the conversion of .csv files to tables in PDF documents.

(This requires F_Plugins).

· F_BrowserPlugins - the plugin for web browsers that facilitates browser-based PDF file

viewing. (This requires F_Viewer, as well as F_IEPlugin and/or F_NPPlugin).

· F_NPPlugin - the plugin for Firefox, Chrome, Safari and Opera. (This requires

F_BrowserPlugins and F_Viewer).

· F_IEPlugin - the plugin for Internet Explorer. (This requires F_BrowserPlugins and F_Viewer).

· F_SanitizePlugin – the plugin that enables the sanitization of documents. (This requires

F_Plugins).

· F_VLangs - provides additional languages for the localization of PDF-XChange Editor. (This

requires F_Viewer).

· F_Tools - the plugin for PDF Tools and its components.

· F_Tools_Plugins - the plugins that extend the functionality of PDF Tools. (This requires

F_Tools).

· F_TLangs - provides additional languages for the localization of PDF Tools. (This requires

F_Tools).

· F_Drivers - PDF-XChange Standard Printer and related components.

· F_Office2PDF - the Office to PDF facility, which enables the batch-conversion of MS Office

documents to PDF. (This requires F_Drivers).

· F_OfficeAddin - provides extended support for MS Office applications when converting

documents to PDF. (This requires F_Drivers).

· F_IEAddin - the add-in for MS Internet Explorer that facilitates the conversion of web pages to

PDF format. (This requires F_BrowserExts).

· F_Langs_Drv - language localization files for the PDF-XChange Standard printer driver, the

Office Addin and the Office2PDF feature. (This requires F_Drivers).

· F_ShellExt - the plugins for Windows Explorer and Windows shell. These extensions enable

the viewing of PDF thumbnails in Windows Explorer, display PDF file properties, handle the

previewing of PDF files in Windows Vista and Office 2007 and provide the IFilter component,

which allows the Windows Desktop Search to operate within PDF files.

· F_Updater - the updater for PDF-XChange products. The updater checks automatically for

updates to the software.

· F_KeyInstaller - the key installer for PDF-XChange products.

· F_BrowserExts - plugin for browsers that enables the conversion of web pages into PDF files.

· F_ChromeExt - extension for Chrome browser that enables the conversion of web pages into

PDF files. (This requires F_BrowserExts).

· F_EdgeExt - extension for Edge browser that enables the conversion of web pages into PDF

files. (This requires F_BrowserExts).

 

A comprehensive list of properties defined by the Windows installer is available here.

Product Specific Properties

http://msdn.microsoft.com/en-gb/library/aa370905(VS.85).aspx
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PNAME

This property specifies the name of the printer to be used. The default value is "PDF-XChange

Standard."

Syntax

PNAME=<printer name>

INSTALLLOCATION

This property specifies the installation folder.

Syntax

INSTALLLOCATION=<installation folder>

SET_PRINTER_AS_DEFAULT

When specified with a value of "1" the PDF-XChange Standard printer will be set as the default printer

after installation. If this property is not specified then the PDF-XChange Standard printer will not be

set as the default printer.

Syntax

SET_PRINTER_AS_DEFAULT="0"

SET_AS_DEFAULT

If this property is unspecified, or specified with value of "1", then PDF-XChange Editor will be set as

the default application for PDF files.

Syntax

SET_AS_DEFAULT="0"
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VIEW_IN_BROWSERS

If this property is unspecified, or specified with a value of "1", then PDF-XChange Editor will be

configured to open PDF files inside browsers.

Syntax

VIEW_IN_BROWSERS ="0"

DESKTOP_SHORTCUTS

If this property is unspecified, or specified with a value of "1", then the installer will place shortcuts for

installed applications on the desktop.

Syntax

DESKTOP_SHORTCUTS="0"

PROGRAMSMENU_SHORTCUTS

If this property is unspecified, or specified with a value of "1", then the installer will create a program

menu group for installed applications and their components.

Syntax

PROGRAMSMENU_SHORTCUTS="0"

USERNAME

This property specifies the username to which applications will be registered.

Syntax

USERNAME=<username>
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ORGANIZATION

This property specifies the organization name to which applications will be registered.

Syntax

ORGANIZATION=<organization name>

USERMAIL

This property specifies the user email.

Syntax

USERMAIL=<user email>

KEYFILE

This property specifies the UNC location of the license vault file <filename>.xcvault. See here  for

further information.

Syntax

KEYFILE=<path to xcvault file>

KEYDATA

This property specifies the registration key.

Syntax

KEYDATA=<registration key>

APP_LANG

This property specifies a language for PDF-XChange Editor, PDF-Tools and the PDF-XChange

Standard printer. (This requires F_Vlangs in order to operate for PDF-XChange Editor, F_TLangs in

order to operate for PDF-Tools, and F_Langs_Drv to operate for PDF-XChange Standard). This

42
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property uses the "language culture name" to define languages. For example German is "de-DE". The

<id> for target languages is available here. The parameters "Auto", "Builtin" and "None" can also be

used instead of a language culture name. Auto uses the system locale language, Builtin uses US

English and None retains the existing language in cases where the software is being upgraded, or

operates in the same manner as Auto if the software is being installed for the first time.

Syntax

APP_LANG=<id>

NOUPDATER

If this property is unspecified, or specified with a value of "0", then the PDF-XChange Updater  will

be installed. If specified with a value of "1" then the updater will not be installed. (Available from build

310).

Syntax

NOUPDATER=<0>

SCHEDULEUPDATER

If this property is unspecified, or specified with a value of "1", then the installer will add a task to the

task scheduler to check for software updates.

Syntax

SCHEDULEUPDATER=<0>

MSI Installer Examples

· Install the application in quiet mode to the folder "C:\Program Files\My PDF Applications":

msiexec /i ProV10.x64.msi /quiet INSTALLLOCATION="C:\Program Files\My PDF
Applications"

57

https://docs.microsoft.com/en-us/previous-versions/commerce-server/ee825488(v=cs.20)
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· Install the application in quiet mode to the default folder and specify the user license

information with the key as a string:

msiexec /i ProV10.x64.msi /qb USERNAME="John Doe" USERMAIL="abc@a.b.c"
KEYDATA="PVP60-….+XivqqLSozuRTqTCxnRv0sNR1i2UTPSA5AvAUl4Q="

· Install the application in quiet mode to the default folder and specify the user license

information with the key as a vault file:

msiexec /i ProV10.x64.msi /qn USERNAME="John Doe" USERMAIL="abc@a.b.c"
KEYFILE="\valid\UNC\path\to\vault\file.xcvault"

· Install only PDF-XChange, Office Add-In and PDF Tools, and specify a new name for the

printer:

msiexec /i ProV10.x64.msi /qb ADDLOCAL="F_Drivers,F_OfficeAddin,F_Tools"
PNAME="My PDF Printer"

· Install all products with German as the application UI language.  (If ADDLOCAL is not called

then all features, including all languages, are available to the installer and the following

properties can be used. If ADDLOCAL is used to specify components and an alternative

language is to be used then corresponding language components (F_Vlangs, F_Langs_Drv

and/or F_TLangs) must be explicitly called:

 msiexec /i ProV10.x64.msi /quiet APP_LANG=de-DE
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2.3 Switches for EXE Installers

  Switches for EXE Installers

The EXE installers support both 32 and 64 bit versions of MS Windows. However, the Microsoft MSIN is

not always compatible with a unified 32/64 bit installation. If there is any uncertainty about the details

of the system onto which PDF-XChange PRO is being installed, then using the EXE installer is

recommended. This is because it has the ability to identify the target computer's system architecture

and install 32 or 64 bit binaries accordingly.

The command line for installation is: PDFXPRO10.exe /Option [Optional Parameter]

[PROPERTY=PropertyValue]

The most useful EXE installation switches for PDF-XChange PRO are detailed below. Please

note that parameters are case sensitive. All available options are detailed here.

Install Options

/install

This switch installs or configures the product specified. It is the default setting.

Syntax

<Product>

/uninstall

This switch uninstalls the product specified.

Syntax

https://docs.microsoft.com/en-us/windows/desktop/Msi/command-line-options


37

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Installation

<Product>

/layout

This switch creates a complete local copy of the bundle in the directory.

Display Options
(Please note that the default settings display the UI and all prompts during installation).

/quiet

This switch determines that neither a UI nor prompts are displayed during installation.

/passive

This switch determines that a minimal UI and no prompts are displayed during installation.

Restart Options

/norestart

This switch suppresses any attempts to restart the computer on which the installation is taking place.

The default setting is for the UI to prompt before restarts take place.

Logging Options

/log
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This switch logs to a specific file. The default setting is for a log file to be created in %TEMP%. This is

also the case if the path is not specified.

Syntax

<LogFile>

Repair Options

/repair

This switch repairs existing installations of the product.

Product Specific Properties

USERNAME

This property specifies the username for which applications are registered.

Syntax

USERNAME=<username>

ORGANIZATION

This property specifies the organization name for which applications are registered.

Syntax

ORGANIZATION=<organization name>

USERMAIL
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This property specifies the user email.

Syntax

USERMAIL=<user email>

SET_AS_DEFAULT

If this property is not specified, or is specified with a value of "1", then PDF-XChange Editor will be set

as the default application for viewing PDF files.

Syntax

SET_AS_DEFAULT="0"

VIEW_IN_BROWSERS

If this property is not specified, or is specified with a value of "1", PDF-XChange Editor will be

configured to open PDF files within browsers.

Syntax

VIEW_IN_BROWSERS="0"

APP_LANG

This property specifies a language for PDF-XChange Editor, PDF-Tools and the PDF-XChange

Standard printer. This property uses the "language culture name" to define languages. For example

German is "de-DE". The <id> for target languages is available here. The parameters "Auto", "Builtin"

and "None" can also be used instead of a language culture name. Auto uses the system locale

language, Builtin uses US English and None retains the existing language in cases where the software

is being upgraded, or operates in the same manner as Auto if the software is being installed for the

first time.

Syntax

APP_LANG=<id>

https://docs.microsoft.com/en-us/previous-versions/commerce-server/ee825488(v=cs.20)
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DESKTOP_SHORTCUTS

If this property is not specified, or is specified with a value of "1", then the installer will place shortcuts

for installed applications on the desktop.

Syntax

DESKTOP_SHORTCUTS="0"

PROGRAMSMENU_SHORTCUTS

If this property is not specified, or is specified with a value of "1", then the installer will create a

program menu group for installed applications and their components.

Syntax

PROGRAMSMENU_SHORTCUTS="0"

KEYDATA

This property specifies a registration key.

Syntax

KEYDATA=<registration key>

KEYFILE

This property specifies the UNC location of the license vault file <filename>.xcvault. See here  for

further information.

Syntax

KEYFILE=<path to xcvault file>

NOUPDATER

42
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If this property is not specified, or is specified with a value of "0", then the updater will be installed.  If

specified with a value of "1" then the updater will not be installed. (Available from build 310).

Syntax

NOUPDATER="0"

EXE Installer Examples

 

· Install the application in quiet mode to the default install folder "C:\Program

Files\Tracker":

PDFXPRO10.exe /quiet

· Install the application in quiet mode to the default folder and specify the user

license information and key as a vault file:

PDFXPRO10.exe /quiet USERNAME="John Doe" USERMAIL="abc@a.b.c"
KEYFILE="C:\license\V10Pro.xcvault"

· Install the application in quiet mode to the default folder and specify the user

license information and key as a string:

PDFXPRO10.exe /quiet USERNAME="John Doe" USERMAIL="abc@a.b.c"
KEYDATA="PVP60 - ZJ2J77DN5kdBuQRhj ...
dmGZ7VXrd6TkEJoJCz+1i2UTPSA5AvAU14Q="
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2.4 Licensing

 Licensing

Since version 5.5 and build 308 PDF-XChange has moved to a new serial key licensing system. The new

system offers both the standard serial key method of licensing our applications as well as the option to

use a license file. The license file is known as an "XCVault" file, which is a modified .zip file. The main

benefit of this feature is that there is no longer a need to re-install the software if you are using an

evaluation version and intend to upgrade. Follow the steps below to access and activate XCVault files:

1. Login to your account with PDF-XChange.

2. Move to the "Your products and Serial numbers" tab.

3. Move to the desired product and click the arrow icon indicated below, which will expand the

window:
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Figure 1. XCVault File Access Point

4. Click the Download button. The XCVault file will then download.

5. Click the download icon to launch the XCVault file. All product licenses will then update

automatically. 

System administrators should note that this information is stored within the Windows Registry.

However, the method used to license the application can have an effect on the storage location. When

an XCVault file is being used, its information is stored in two locations: HKCU\Software\Tracker

Software\Vault and HKLM\SOFTWARE\Tracker Software\Vault. It should also be noted that license

information is stored as a hexadecimal value. Therefore, if a registration key is being used to deploy

the license, it is advisable to first license a single machine in order to create the first registration key.

Standard Deployment

Copy and paste serial keys into the installer to implement them during installation. Alternatively, click

the personal.xcvault file after installation has taken place.

Silent Deployment

XCVault files can also be used for silent deployment of serial keys after installation has taken place. A

windows command line can be used to push the XCVault file to each user that qualifies for a full
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license. The command line for operation is: XCVault.exe /Option <path_to_xcvault_file>. Available

command line options are detailed below:

XCVault Command Line Options

/Install 

This command designates the utility as the default handler of .xcvault files in the system. Please note

that this requires administrative rights.

Example

xcvault.exe /Install

/AddKeys

This command installs all keys from .xcvault files.

Syntax

xcvault.exe [/AddKeys] <xcvault_file> [/M|/S|/R]

/M – specifies that new keys are added in the HKEY_LOCAL_MACHINE registry section and

administrative rights are required.

/R – specifies that new keys will be unencrypted when added. Please note that this does not

affect existing keys.

/S – specifies that the command is not permitted to show error/information messages.

Examples

xcvault.exe /AddKeys "c:\Personal.xcvault"

xcvault.exe "c:\Personal.xcvault"

/AddKeyData
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This command installs the specified key.

Syntax

xcvault.exe [/AddKeyData] <keystring> [/M|/S|/R]

/M –  Installs key into HKLM for per-machine use. This option requires administrative rights. If this

option is not specified then key will be installed in HKCU for per-user use and administrative

rights are not required.

/S – specifies that the command is not permitted to show error/information messages.

/R – specifies that new keys will be unencrypted when added. Please note that this does not

affect existing keys.

Examples

xcvault.exe /AddKeyData <keystring>

/OpenKeys

This command stores all keys in an open form, instead of encrypting them by machine-specific ID. This

option is useful for terminal servers that have a load-balancing and/or VDI environment.

Syntax

xcvault.exe /OpenKeys [/M|/S]

/M – decrypts keys only in the per-machine store (HKLM). This option requires administrative

rights. If it is not specified then the keys will be changed only in the per-user store (HKCU).

/S – specifies silent mode and suppresses any messages with information about results.

Example

xcvault.exe /OpenKeys

/ProtectKeys
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This command is the opposite of the "OpenKeys" command:

Syntax

xcvault.exe /ProtectKeys [/M|/S]

/M – encrypts keys only in the per-machine store (HKLM). This option requires administrative

rights. If it is not specified then the keys will be changed only in the per-user store (HKCU).

/S – specifies silent mode and suppresses any messages with information about results.

Example

xcvault.exe /ProtectKeys

/ActivateKeys

This command activates installed keys.

Syntax

xcvault.exe /ActivateKeys [/S|/AA]

/S – specifies silent mode and suppresses any messages with information about results.

/AA – specifies that currently activated keys will be reused in the activation process.

Example

xcvault.exe /ActivateKeys

/RemoveKeys

This command removes all license keys for all products from the per-user store (HKCU). If the per-

machine store (HKLM) is available for modification then all keys will be removed from it, otherwise

keys from this store will be marked as removed for only the current user.

Syntax

xcvault.exe /RemoveKeys [/S|
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  /S – specifies silent mode and suppresses any messages with information about results.

Example

xcvault.exe /RemoveKeys

/Cleanup

  

This command removes all license-related information for all installed products from per-machine

(HKLM) and per-user (HKCU) stores. If the per-machine store is not empty then administrative rights are

required.

Syntax

xcvault.exe /Cleanup [/S|

  /S – specifies silent mode and suppresses any messages with information about results.

Example

xcvault.exe /Cleanup

A sample script and associated literal path is detailed below:

C:\Program Files\Tracker Software\Vault>XCVault.exe /S with literal path D:

\Documents\Ref\Personal.xcvault

Activating silent deployment is a two-step process. The first step is to call on the XCVault.exe that will

apply the key. The second step is to specify the literal path to the personal.xcvault file. The presence of

the script means that users are not notified of serial key deployment. 

Passing License Details During Installation

The inclusion of XCVault files since version 5.5 and build 308 means that the command line install

option KEY=<regkey> no longer passes license details to associated products. The command line can

be used to resolve this issue and there are two methods available:
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The first method is to use the option KEYFILE=<xcvault file> to specify the UNC location of the

license vault file <filename>.xcvault. For example: 

KEYFILE="C:\Users\JohnDoe\Desktop\Personal.xcvault".

The second method is use the option KEYDATA=<regkey> to specify the registration key with a text

string. For example: 

KEYDATA="PXP70-Y5EN....cFrBqnyKhv7eOw=".

The first method is recommended as the new keys are very complex and therefore less suited to being

passed as strings at the command line. The details of these switches and examples of their use are

available here. 24
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2.5 End User License Agreement

 End User License Agreement

PDF-XChange® Versions 10.x EULA (End User License Agreement)

This license agreement details your rights and entitlement to use PDF-XChange Printer Lite (When

used commercially), PDF-XChange Printer Standard, PDF-XChange Viewer, PDF-XChange Editor,

PDF-XChange Editor Plus, PDF-Tools, PDF-XChange PRO (suite/bundle) and all other utilities and

components for when licensed for ‘End User use’. Please read it carefully and treat it as valuable

property.

This agreement is between you (either an individual or an entity) and PDF-XChange Co Ltd,

(hereinafter called ‘PDF-XChange Co’). PDF-XChange Co is willing to grant you the following rights to

use the software known as PDF-XChange Printer Lite, PDF-XChange Printer Standard, PDF-XChange

Editor, PDF-XChange Editor Plus, PDF-Tools and/or PDF-XChange PRO, and its accompanying

documentation, (collectively, the ‘software’) only if you agree to be bound by all of the terms and

conditions of this agreement, relevant to the version in use. If you are not willing to agree to any of the

terms of this agreement, PDF-XChange Co is unwilling to grant you a license and you should not open

the sealed media package (or distributed software files if it was supplied by electronic distribution).

Instead, you must promptly return any sealed media packaging and documentation or, in the case of

electronic distribution, delete it completely from any storage media on which you may have saved it. If

you meet these above conditions then any payment you have made will be refunded, except in cases

where a trial version of the software was used prior to payment and an unlock code was subsequently

supplied.

This software is provided for your use free of charge (functionality may be limited or available only in

evaluation mode) or as a licensed and chargeable product when all functionality is provided for use

without limitation. If you wish to use all of the features of the software without restriction or limitation

then you will require a license for the specific application you wish to use.

You may use the free and trial versions of these applications without charge provided you are the end

user and do not intend to distribute or incorporate it with or into any other product or software

package intended for resale or distribution for any purpose whatsoever, other than as provided for in

this license. Should you wish to distribute the PDF-XChange Viewer/Editor (free versions) for any

purpose, please email PDF-XChange Co at sales@pdf-xchange.com and, provided you receive no

mailto:sales@pdf-xchange.com
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direct or indirect commercial or financial gain from doing so, such permission will usually be granted

promptly and for ‘free’.

Use of the advanced ‘PRO’ features contained in the PDF-XChange Editor or Editor Plus

trial/evaluation/free versions may result in ‘DEMO’ label stamps being placed on your documents.

Please pay attention to the onscreen messages and warnings when using our trial/evaluation/free

versions and, if you are in any doubt about whether or not you are using licensed features, always

ensure you have a copy of any documents prior to making modifications or using Free/Trial Versions of

this software.

1. OWNERSHIP: The software is and shall remain a propriety product of PDF-XChange Co. PDF-

XChange Co and its suppliers shall retain ownership of all copyrights, patents, trademarks, trade names,

trade secrets and other proprietary rights relating to or residing in the software. Except for the license

grant provided in Section 2, you shall have no right, title or interest in or to the software. The software

is licensed, not sold to you and for you to use only under the terms of this agreement. If you agree to

be bound by all of the terms of this agreement then you will own only the media (if any) on which the

software may have been provided, and not the software itself.

2. GRANT OF LICENSE AND VOLUME LICENSES: PDF-XChange Co grants you a personal, non-

exclusive, non-transferable, restricted right to use the software for your own personal, commercial or

business uses – provided you and/or your business are end users, and not software developers or

distributors to end users – subject to the terms of this license agreement. This license does not allow

the accessing of the API of the software – even if you have a developer’s kit – this is an END USER

version ONLY of the software – it is not a developer software tool. Should you wish to utilise a version

of this product linking to or from within another software application (directly or indirectly) – you must

purchase and license a software development kit (SDK) that is intended specifically for this purpose.

These SDKs are available from PDF-XChange Co Ltd on a limited and case-by-case basis, please email

sales@pdf-xchange.com for further information on SDK licensing.

Each licensed user may use this software in PERPETUITY, and there is no requirement to make any

further payment for the continued use of the version of the software purchased, provided you adhere to

these Terms and Conditions. Optional annual maintenance is available to allow users to update to

Licensed versions released after their maintenance expires, and there will be an annual charge payable

should they wish to have access to these later versions. Each licensed user may install and use this

software on a single desktop PC and one laptop or notepad PC, provided that the user is the PRIMARY

USER of both pieces of equipment.

OWNERS OF CORPORATE AND ENTERPRISE LICENSES may use and install the software on an

unlimited number of workstations or servers, provided that sufficient licenses are purchased to cover all

users, we do not support the ‘Concurrent User’ License model – each and every user must be licensed.

Additionally, where a geographically limited ‘Site’ or ‘Country’ license pack has been purchased for use

by an unlimited number of users, the following geographical and scope-based restrictions apply: 

mailto:sales@pdf-xchange.com
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· A single SITE LICENSE is for a single corporate ‘body’ and for use in a single

geographical/physical corporate location;

· Owners of the CORPORATE ‘COUNTRY’ LICENSE may install and use the software on

unlimited sites within a single national border/nation – but not in other countries, and only for

the benefit of a single corporate body or its wholly owned subsidiary enterprises.

 

· Owners of the WORLD-WIDE CORPORATE LICENSE (GLOBAL) shall have the right to install

and use the software in an unlimited number of locations, and without any restriction on use in

so far as national borders are concerned – all of these licenses relate to a single corporate

body or its wholly owned subsidiary enterprises.

· Owners of the WORLD-WIDE CORPORATE LICENSE (ENTERPRISE) shall have the right to

install and use the software in an unlimited number of locations and without any restrictions on

use in so far as national borders are concerned. Licenses relate to a single corporate body, any

subsidiary enterprise in which an ultimate controlling interest (howsoever structured) of not less

than 50.1% is held by the licensee, and to all staff employed by any agency or affiliate of the

corporate body, provided that such staff are employed and engaged in a role exclusively for

the benefit of the licensee or its qualifying subsidiary enterprises on a long-term basis.

· This software may only be installed on equipment directly owned or leased by the licensee and

used by its staff or agency staff who are employed long-term with and for the sole benefit of

the licensee.

 

· In the case of ACADEMIC CAMPUS LICENSEES, teaching staff may install the software on

personal equipment used in pursuance of their academic course work. Use of the software by

students on campus equipment is allowed, however - the installation and use of the software

on the personal equipment of students is prohibited.

· Government Licenses. For the purposes of this agreement, municipal & local government

offices/departments shall be treated as the commercial equivalent of a single corporate

body/entity. Individual state and federal government departments shall be treated as the

equivalent of a single corporate body/entity. If a state or federal government wishes to

purchase a license to cover multiple departments then a ‘Federal’ license will be required –

details of which are available by contacting your reseller or PDF-XChange Co Ltd directly at

sales@pdf-xchange.com

3. RESTRICTIONS: I) PDF-XCHANGE CO RESERVES ALL RIGHTS IN THE SOFTWARE NOT EXPRESSLY

GRANTED TO YOU. II) EXCEPT AS PERMITTED IN SECTION 2, YOU MAY NOT USE, COPY, MODIFY,

CREATE DERIVATIVE WORKS OF, SELL, DISTRIBUTE, ASSIGN, PLEDGE, SUB LICENSE, LEASE, LOAN,

RENT, TIMESHARE, DELIVER, ELECTRONICALLY TRANSMIT OR OTHERWISE TRANSFER THE SOFTWARE,

NOR PERMIT ANY THIRD PARTY TO DO ANY OF THE FOREGOING. III) YOU MAY NOT REMOVE FROM

THE SOFTWARE, OR ALTER ANY OF THE TRADEMARKS, TRADE NAMES, LOGOS, PATENT OR

mailto:sales@pdf-xchange.com
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COPYRIGHT NOTICES OR MARKINGS, OR ADD ANY OF THE FOREGOING TO THE SOFTWARE. IV) YOU

MAY NOT DERIVE OR ATTEMPT TO DERIVE ANY OF THE SOURCE CODE BY ANY MEANS, NOR PERMIT

A THIRD PARTY TO DO SO. V) YOU MAY NOT REVERSE ENGINEER, DECOMPILE, DISASSEMBLE, OR

TRANSLATE THIS SOFTWARE OR ANY PART THEREOF. VI) NO LICENSES ARE GRANTED UNDER THIS

LICENSE AGREEMENT UNDER ANY PATENTS OF IMAGES. IF YOU BELIEVE YOU NEED ANY SUCH

LICENSES YOU MUST CONTACT ANY THIRD PARTIES YOURSELF DIRECTLY TO OBTAIN THEM.  

PDF-XCHANGE CO welcomes all magazine, printed publications, software download sites etc in

facilitating the distribution of the free version of the software, which they are permitted to do free of

charge – provided that no re-engineering occurs to the installer or components, and that no added

charge is made for the distribution of the software – other than any publisher’s subscription/news stand

fees or other similar costs that are always charged for their publication.

4. LIMITED WARRANTY: PDF-XChange Co does not warrant that the functions contained in the

software will meet your requirements or that the operation of the software will be uninterrupted or

error-free (it is furnished ‘AS IS’ and without warranty as to performance or results). PDF-XChange Co

warrants that the media on which the software is supplied will be free from defect for a period of thirty

(30) days from the receipt of the software or, in the case of electronic supply, that the ‘wrapper’ in

which the software is contained shall be complete and without defect on our end of the connection.

However, we cannot warranty that it will be received in the same condition, as the means of supply is

beyond our absolute control. This limited warranty shall be void if failure of the software to conform to

the warranty has resulted from improper installation, misuse, testing, neglect, accident, fire or other

hazard or any breach of this agreement. This warranty is limited to you and is not transferable. No PDF-

XChange Co supplier, agent or employee is authorized to make any changes, modifications,

alterations, extensions or additions to this limited warranty.

5. LIMITED REMEDIES: In the event of a breach of the foregoing limited warranty, you must return the

software to PDF-XChange Co or the PDF-XChange Co authorised distributor that provided you with

the software, postage prepaid, before the expiration of the warranty period, with a copy of the invoice

for the software. PDF-XChange Co’s entire liability, and your exclusive remedy, shall be at PDF-

XChange Co’s sole discretion, either to i) refund the license fee you paid and terminate this agreement

or ii) provide a replacement copy of the software with said replacement being warranted for thirty (30)

days. 

6. NO OTHER WARRANTIES: Other than the foregoing limited warranty, which is made solely by PDF-

XChange Co and not by any other PDF-XChange Co supplier, this software is licensed to you 'AS IS',

without warranty of any kind. PDF-XChange Co and its suppliers disclaim and reject all other

warranties express or implied, including without limitation the warranties of merchantability, fitness for

a particular purpose, title and non-infringement of third-party rights. Some jurisdictions do not allow

the disclaimer of implied warranties, so the above disclaimer may not apply to you, in which case the

duration of any implied warranties is sixty (60) days from the date on which you receive the software.

This warranty gives you specific legal rights, and you may have additional legal rights depending on

your jurisdiction.
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If and where Optical Character Recognition (OCR) functionality is provided in this software, it is

essential that all users of this product understand that OCR cannot and does not provide perfect

conversion from image based content to editable text content. Results are dependent on many factors

including but not limited to, the original documents Image quality, Resolution, Language, Style, Font

etc. All results must be checked and proof read for accuracy prior to use by the end user or any party

for any purpose and PDF-Xchange Co and its suppliers offer no guarantees as to the accuracy of

results and specifically and universally reject all liability and warranty’s as to consequences of any

subsequent use of converted image to text content attained by use of this product. All risks are borne

by the user and author of all documents created, assembled and converted as a result of use of this

application.  

Always ensure you have a copy of any documents prior to making modifications when using features

that will permanently modify content.

7. LIMITATION OF LIABILITY: PDF-XChange Co’s aggregate liability in connection with this

agreement and the software, regardless of the form of action giving rise to such liability (whether in

contract, tort or otherwise), shall not exceed the license fees paid by you to PDF-XChange Co under

this agreement. No PDF-XChange Co suppliers shall have any liability whatsoever under this

agreement. PDF-XChange Co and any of PDF-XChange Co’s suppliers shall not be liable for any

indirect, exemplary, special, consequential or incidental damages of any kind (including without

limitation lost profits), even if PDF-XChange Co or such supplier has been advised of the possibility of

such damages. Some jurisdictions do not allow the limitation or exclusion of liability consequential or

incidental damages, so the above limitation or exclusion may not apply to you. PDF-XChange Co shall

not be held liable for any claims of third parties relating to the software. The limited warranty, limited

remedies and limited liability provisions contained in this agreement are fundamental parts of the

basis of PDF-XChange Co’s bargain hereunder, and PDF-XChange Co would not be able to provide

the software to you absent of such limitations.

The only exception committed to by PDF-XChange Co in relation to the above indemnification is that

in using any product created by PDF-XChange Co to create, view, modify or print PDF files, PDF-

XChange Co indemnify the licensee from any liability in regards to use of the PDF format and its

products. The PDF format has always been an open standard – it was originally designed and owned by

Adobe Systems Inc, who formally relinquished control to the International Standards Organization

(ISO), which is now responsible for maintaining the specifications for the current version (1.x) and for

updating and developing all future versions. Further, PDF-XChange Co will at all times endeavour to

ensure its products meet the PDF format as specified by the ISO committee and thus ensure

compatibility with all other PDF-compliant products from other manufacturers.

8: FREE & TRIAL VERSIONS: Where the software is provided for free on a permanent, semi-

permanent, limited use or trial basis, all the terms relating to licensing shall be identical, save that you

accept there has been no financial gain on PDF-XChange Co’s part, and as such you will use the

software without warranties or guarantees of any kind. The risk is entirely yours and you acknowledge
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this. You agree to indemnify us against all claims by you or any third parties for any reason whatsoever.

You accept that we have provided the software for your sole benefit, and that we have received no

financial reward and as such cannot be held responsible in any way and/or for any reason.

9. TERMINATION: You may terminate this agreement at any time. This agreement shall terminate

automatically upon breach of any term of this agreement. Upon termination you shall destroy the

software and any additional copies that you made of it pursuant to this agreement.

10. GOVERNMENT END USERS: This paragraph applies only if you are a branch or agency of the U.S.

government. The software is comprised of ‘Commercial Computer Software’ and ‘Commercial

Computer Software Documentation’ as such terms are used in 48 C.F.R. 12.212 (Sept 1995), and is

provided to the government I) for acquisition by or on behalf of civilian agencies, consistent with the

policy set forth in C.F.R. 12.212 or II) for acquisition by or on behalf of units of the Department of

Defence, consistent with the policies set forth in 48 C.F.R. 227-7202-1 (Jun 1995) and 227-7202-3 (Jun

1995).

11. US GOVERNMENT ECCN CERTIFICATE: The software has been tested & certified under by the

Department of Commerce ECCN process. Any individual or company interested in being provided

with our ECCN certificate information can contact support@pdf-xchange.com for further information.

 

12. GENERAL: This agreement shall for all purposes be governed by and interpreted in accordance

with the Courts and Laws of England or, if agreed in preference by both parties, Canada may optionally

be substituted as the preferred legal jurisdiction for governance and interpretation. If any of the

provisions of this agreement is held by a court of competent jurisdiction to be unenforceable for any

reason, then the remaining provisions hereof shall be unaffected and remain in full force and effect.

This agreement is the final, complete and exclusive agreement between the parties relating to the

subject matter hereof, and supersedes all prior or contemporaneous understandings and agreements

relating to such subject matter, whether oral or written, and may not be amended except by writing

executed by both parties. 

COPYRIGHT: THIS SOFTWARE AND ALL ACCOMPANYING DOCUMENTATION ARE COPYRIGHTED AND

PDF-XCHANGE CO RESERVES ALL RIGHTS. THE ACCOMPANYING EULA (END USER LICENSE

AGREEMENT) SPECIFIES THE TERMS AND CONDITIONS GOVERNING USE OF THIS PRODUCT.

Tracker Software Products (Canada) Ltd is a wholly owned subsidiary of PDF-XChange Co Ltd.

Registered in England. Registration No: 11091579

Copyright © 2001-2023 PDF-XChange Co Ltd; RH17 5RH. England. 

www.pdf-xchange.com email: sales@pdf-xchange.com

TRADEMARK: PDF-XChange® is a Registered Trademark of PDF-XChange Co Ltd

ALL RIGHTS RESERVED. 

mailto:support@pdf-xchange.com
mailto:sales@pdf-xchange.com
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Third Party Libraries are used in these products to provide additional functionality all Trademarks

specifically acknowledged as follows;

The PDF-XChange Enhanced OCR Plug-in is powered by the ABBYY® FineReader® Engine 12 © 2017

ABBYY Production LLC., ABBYY and

FINEREADER are either registered trademarks or trademarks of ABBYY Software Ltd. and cannot be

used without prior written consent of

ABBYY Software Ltd.

ABBYY FineReader SDK incorporates Datalogics Software and Adobe Products (Adobe PDF Library and

Adobe Color Profile)

Copyright 2000 – 2012 Datalogics, Inc.

Copyright 1984 - 2012 Adobe Systems Incorporated and its licensors. All rights reserved.

ABBYY SDK incorporates additionally in part or in full;

CUMINAS DjVu

Portions of this computer program are copyright © 2008 Celartem, Inc. All rights reserved.

Portions of this computer program are copyright © 2011 Caminova, Inc. All rights reserved.

Portions of this computer program are copyright © 2013 Cuminas, Inc. All rights reserved.

Portions of this computer program make use of the Tesseract OCR Library. All rights reserved.

Portions of this computer program are copyright © 2023 Hunspell, Inc. All rights reserved.

Portions of this computer program are copyright © 2023 Mozzila SpiderMonkey, Inc. All rights

reserved.

Portions of this computer program are copyright © 2023 libxml2, Inc. All rights reserved.

Portions of this computer program are copyright © 2007 libheif, Inc. All rights reserved.

Portions of this computer program are copyright © 1995-2023 libpng, Inc. All rights reserved.

Portions of this computer program are copyright © 2023 libexpat, Inc. All rights reserved.

Portions of this computer program make use of the libwebp. Copyright (c) 2010, Google Inc. All rights

reserved.

DjVu is protected by U.S. Patent No. 6,058,214. Foreign Patents Pending. Powered by AT&T Labs

Technology.

DjVu SDK contains the following Third Party Code:

Oniguruma Copyright © 2002-2006 K.Kosako <sndgk393 AT ybb DOT ne DOT jp>. All rights reserved.

A portion of this software is derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Mersenne Twister Copyright © 2006,2007 Mutsuo Saito, Makoto Matsumoto and Hiroshima University.

All

rights reserved.

WIBU, CodeMeter, SmartShelter, SmartBind are registered trademarks of Wibu-Systems.

German export regulations apply in the event of an export of Wibu-Systems products.

Leptonica By Dan Bloomberg

ZLIB by Mark Adler & Jean-Loup Gailly

Little CMS by Marti Maria and IPG (C) 1991-1998

PDF-XChange is based in part on the Independent JPEG Group's work and uses the libjpeg-turbo library.

Copyright (C)2009-2021 D. R. Commander. All Rights Reserved.

Copyright (C)2015 Viktor Szathmáry. All Rights Reserved.
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PDF-XChange uses the Open Source Computer Vision Library

Copyright (C) 2000-2020, Intel Corporation, all rights reserved.

Copyright (C) 2009-2011, Willow Garage Inc., all rights reserved.

Copyright (C) 2009-2016, NVIDIA Corporation, all rights reserved.

Copyright (C) 2010-2013, Advanced Micro Devices, Inc., all rights reserved.

Copyright (C) 2015-2016, OpenCV Foundation, all rights reserved.

Copyright (C) 2015-2016, Itseez Inc., all rights reserved.

Copyright (C) 2019-2020, Xperience AI, all rights reserved.

THIRD PARTY SUPPORT AS DETAILED ABOVE IS PROVIDED BY THE COPYRIGHT HOLDERS AND

CONTRIBUTORS "AS IS", AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR

ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF

USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF

LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR

OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE

POSSIBILITY OF SUCH DAMAGE.

All Other Trademarks/Copyrights acknowledged & are the property of their respective owners.

Last amended date: June 14, 2023



57

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Installation

2.6 The PDF-XChange Updater

 The PDF-XChange Updater

The PDF-XChange Updater is used to check for and download updates to the software applications

included in PDF-XChange PRO. Follow the steps below to access and edit updater settings:

PDF-XChange Editor

Click the Help tab, then click Check for Updates:

Figure 1. Help Tab, Check for Updates

The PDF-XChange Updater dialog box will open, as detailed below.
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PDF-Tools

Click the Help dropdown menu, then click Check for Updates:

Figure 2. Help Dropdown Menu, Check for Updates

The PDF-XChange Updater dialog box will open, as detailed below.

PDF-XChange Standard

1. Click the Windows Start Button.

2. Click Control Panel. The Control Panel dialog box will open.

3. Click Devices and Printers in the Control Panel dialog box.

4. Move to the Printers tab and right-click PDF-XChange Standard.

5. Click Printing Preferences. The PDF-XChange Standard Printing Preferences

dialog box will open.
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6. Click the About tab, then click Check for Updates in the Help dropdown menu to open the

PDF-XChange Updater:

Figure 3. About Tab, Check for Updates

The PDF-XChange Updater dialog box will open, as detailed below.

The PDF-XChange Updater
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Figure 4. PDF-XChange Updater Dialog Box

· Available updates are displayed in the main window. Click the Download button to download

and install available updates.

· Click Update History to view a breakdown of recent updates.

· Click Installed Products to view a breakdown of installed products from PDF-XChange.

· Click Settings to customize settings for the PDF-XChange Updater. These options are detailed

beneath (figure 3) below.

· Click Help to launch the online help for the PDF-XChange Updater.

· Select/clear the Show Hidden Updates box to show/hide hidden updates.

· Click Check Again to check for more recent updates.

· Click Close to close the PDF-XChange Update dialog box.

Settings
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Figure 5. Updater Settings Dialog Box

· Select/clear the Automatically Install After Downloading Updates box to enable/disable the

automatic installation of downloaded updates.

· Select/clear the Include Updates That Are Incompatible with Maintenance Plan box to

include/exclude products that are not included in your current maintenance plan. Note that if

updates are listed here and your license has expired, then the software will revert to evaluation

mode when the updates are downloaded.

· Select an option in the Configure Proxies to Access the Internet section to determine the

proxy that the updater uses to access the internet:

· Select No Proxy to disable the use of a proxy to access the internet.

· Select Use System Proxy Settings to use the current system proxy settings to access the

internet.

· Select Manual Proxy Configuration to use a custom proxy, then enter the Proxy Server

and Port number details in the text boxes.

· Select the Proxy Server Requires a Password box to set a password for the use of Proxy

Server when the Manual Proxy Server option above is used, then enter the Proxy User and

Password details in the text boxes.
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· Select the Use Regional Language box to use the regional language as the interface language

for downloaded updates, or select a different option from the dropdown menu. Note that the

language of the user interface can be subsequently changed as desired in the user preferences.

· Click Save to save settings.

Autostart

Use the Autostart tab to set a schedule for automatically checking for updates to the software:

Figure 6. Updater Settings Dialog Box, Autostart Tab

· Select Never to disable this feature.

· Select Daily, Weekly or Monthly to check for updates automatically on a daily, weekly or

monthly basis as desired. Note that different scheduling options are available depending on

which option is used.

· Use the Start text box to determine the date and time at which the schedule starts.

· Select Automatically Download Available Updates to download available updates

automatically, or select Only Show Notification to receive a notification that updates are

available instead.
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Click Save to save settings.
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3 PDF-XChange Editor Plus V10 User Manual

 PDF-XChange Editor Plus V10 User Manual

PDF-XChange Editor is one of the fastest and most feature-rich applications used

worldwide to create, view, edit and annotate PDF files. Please note that this manual details

PDF-XChange Editor when it is viewed in the Ribbon UI, which was introduced in version

seven. The Classic UI version of the manual is available here.

This manual is composed of the following sections:

· Features Overview details the main features of PDF-XChange Editor.

· Explore the User Interface details the software as it appears via the ribbon user

interface.

· The Tabs Guide is structured to match the UI of the software and details

comprehensive operational instructions for its features and functionality. The ribbon

tabs each have a corresponding section in the manual, where their submenu options

and associated settings are explained. The ribbon tabs are highlighted in the image

below.

· Appendix details additional information that relates to the software.

https://help.pdf-xchange.com/pdfxe9c/
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Figure 1. Ribbon Tabs



66

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.1 Features Overview

 Features Overview

The main feature categories of PDF-XChange Editor are detailed below:

Accessibility Features:

· Determine the Reading Order of Documents.

· Perform Accessibility Checks on Documents.

· Set Alternate Text Descriptions for Document Content.

· Use the Accessibility Checker/Report Pane to View/Edit Document Accessibility

Information.

· Use the Tags Pane to Create/View/Edit Structured PDF Information.

Annotation Features:

· 3D Comment Support.

· Add Annotations to Documents:

· Add Area Measurement Annotations to Documents.

· Add Audio File Annotations to Documents.

· Add Callout Annotations to Documents.

· Add Caret Annotations to Documents.

· Add Cloud Annotations to Documents.

· Add Distance Annotations to Documents.

· Add File Attachment Annotations to Documents.

· Add Freehand Annotations to Documents.

· Add Highlight Annotations to Documents.

· Add Line and Arrow Annotations to Documents.

· Add Link Annotations to Documents.

· Add Oval Annotations to Documents.

· Add Perimeter Measurement Annotations to Documents.

· Add Polygon Annotations to Documents.

· Add Polyline Annotations to Documents.

· Add Rectangle Annotations to Documents.

· Add Sound Annotations to Documents.

414

418

980

421

409

401

457

611

490

474

522

570

599

485

592

495

536

300

549

605

562

554

543

623
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· Add Stamps to Documents.

· Add Sticky Note Annotations to Documents.

· Add Strikeout Annotations to Documents.

· Add Text Box Annotations to Documents.

· Add Typewriter Annotations to Documents.

· Add Video Annotations to Documents.

· Add Underline Annotations to Documents.

· Clear Measurements from Distance Annotations.

· Convert Line Annotations to Distance Annotations.

· Convert Polygon Annotations to Area Annotations.

· Convert Polyline Annotations to Perimeter Annotations.

· Cross Section Support for 3D PDFs.

· Export Comments to Data File.

· Export Measurements to CSV File.

· Export Selected Comments.

· Fit Box by Text Content.

· Flatten Comments.

· Summarize Comments.

· Use the Comment Styles Palette to View/Edit Comment Styles.

· Use the Eraser Tool to Erase Freehand Comments.

· Use the JavaScript Console to Create Dynamic Stamps.

· Use the Thin Lines Feature to Reduce the Size of Annotation Lines to One Pixel.

· View/Edit Paragraph Properties for Annotations.

Bookmark Features:

· Add Text to Bookmark Titles.

· Bookmark Every Nth Page.

· Build a Table of Contents from the Structure of Bookmarks.

· Change the Case of Bookmark Titles.

· Convert Bookmark Destinations to Named Destinations.

· Convert Named Destinations to Regular Destinations.

· Create Links from Bookmarks.

· Export Bookmarks to HTML Format.

· Export Bookmarks to Text File.

· Find and Replace Bookmark Text.

· Generate Bookmarks from Page Text.

· Generate Bookmarks from Table of Contents.

· Generate Bookmarks from a Text File.

· Merge Duplicate Bookmarks.

· Remove Actions from Bookmarks.

· Set the Zoom Type for Bookmarks.

· Sort Document Pages by Bookmarks.

575

480

505

469

464

619

500

1130

1130
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1130

401

638
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457
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· Use the Bookmarks Pane to View and Edit Bookmarks.

· Validate Bookmarks.

Convert Documents to/from PDF:

· Convert PDF Files to MS Word Format.

· Convert PDF Files to PDF/A Format.

· Convert PDF Files to PDF/X Format.

· Convert PDF Files to Plain Text Format.

· Convert PDF Files to MS Excel Format.

· Convert PDF Files to MS PowerPoint Format.

· Convert CSV Files to PDF.

· Convert Image Files to PDF.

· Convert MS Excel Documents to PDF.

· Convert MS PowerPoint Documents to PDF.

· Convert MS Publisher Documents to PDF.

· Convert MS Visio Documents to PDF.

· Convert MS Word Documents to PDF.

· Convert Markdown Files to PDF.

· Convert RTF Files to PDF.

· Convert Text Files to PDF.

· Convert Windows Metafiles to PDF.

· Convert XPS Files to PDF.

Create Documents:

· Combine Existing Files into a New Document.

· Create PDF Portfolio Files.

· Create New PDF Files.

· Create a PDF from Clipboard Content.

· Create a PDF from Scanned Content.

· Create a PDF from a CSV File.

· Create a PDF from a Markdown File.

· Create a PDF from a Text File.

· Create a PDF from an Image File.

· Create a PDF from an RTF File.

Create Fillable Forms:

· Add Form Fields to Documents.

· Add Barcode Fields to Documents.

· Add Button Fields to Documents.

· Add Check Box Fields to Documents.

345
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· Add Date Fields to Documents.

· Add Digital Signature Fields to Documents.

· Add Dropdown Fields to Documents.

· Add Image Fields to Documents.

· Add List Box Fields to Documents.

· Add Radio Button Fields to Documents.

· Add Text Fields to Documents.

· Create/Edit Fillable Forms.

· Email Form Data.

· Highlight Form Fields.

· Identify Forms.

· Reset Forms.

· Use CSV Files to Populate Forms.

· Use Forms to Calculate Values.

· Use Forms to Validate Values.

· Use the Fields Pane to View/Edit Form Fields.

Customize the UI/Software:

· Add Launch Options to Launch Third-Party Software.

· Avail of a Range of Page Display Options.

· Create Customized Settings Files.

· Create Your Own Toolbars.

· Customize the Layout of Editing Panes.

· Enable the Autosave/Autorecovery Feature.

· Enable/Disable Stroke Adjust for Page Rendering.

· Export/Import/Reset Settings.

· Group Your Favorite Tools into a New Ribbon.

· Select from a Range of Default Page Layout Options.

· Save Your Current Session for Subsequent Use.

· Set the Language of the User Interface.

· Toggle the Ribbon View for Documents.

· Toggle the Right-to-Left Page Layout.

· Toggle between Default, Ribbon and Touch-Optimized Layouts.

· Use and Customize Browser Plugins.

· Use Preferences to Customize Settings.

Edit Documents:

· Add/Edit Document Text.

· Arrange Selected Content Items.

· Copy, Cut, Delete or Zoom to Selected Content.

· Correct Text with the Text Correction Tool.

815

780

736

825

724

714

681

676

679

676

841

676

836

695

691

366

235

335

276

1037

1112

435

202

276

1058

80

91

233

338

338

77

252

192

1100

1068

1098

522



70

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Create Custom Stamps.

· Create Documents from Selected Content.

· Create Stamps from Selected Content.

· Create/Edit/Remove Weblinks.

· Crop to White Margins.

· Draw Lines for Tables in OCR.

· Duplicate Selected Content.

· Edit Document Content in Third-Party Applications.

· Edit Document Pages.

· Crop Document Pages.

· Delete Document Pages.

· Delete Empty Document Pages.

· Duplicate Document Pages.

· Extract Document Pages.

· Merge Document Pages.

· Move Document Pages.

· Overlay Document Pages.

· Replace Document Pages.

· Resize Document Pages.

· Rotate Document Pages.

· Split Document Pages.

· Swap Document Pages.

· Edit and Manipulate Images.

· Edit and Manipulate Paths.

· Edit PDF Portfolio Files.

· Edit the Base Content of Documents.

· Enable Snapping for Precision Editing.

· Export Selected Content to MS Office Formats.

· Find and Redact Document Content.

· Flatten Layers to Base Content.

· Font Replacement Feature for Editing Document Fonts.

· Insert Pages into Documents.

· Insert RTF Files into Documents.

· Insert Text into Documents.

· Normalize Media Box Offsets.

· OCR Selected Areas of Documents.

· Perform OCR on Documents.

· Redact Documents.

· Rename Documents.

· Sanitize Documents.

· Set Document Margins.

· Spell Check Documents.

· Split Documents by Size.
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· Split Pages by Guide Lines.

· Take Document Snapshots.

· Transform Selected Content.

· Use Editing Panes to View/Edit Document Content.

· Use the 3D Model Tree Pane to View/Edit 3D Comments.

· Use the Attachments Pane to View/Edit Document Attachments.

· Use the Comments Pane to View/Edit Comments.

· Use the Content Pane to View/Edit Document Content.

· Use the Destinations Pane to View/Edit Named Destinations in Documents.

· Use the History Pane to View/Edit the History of Opened Documents.

· Use the Layers Pane to View/Edit Document Layers.

· Use the Links Pane to View/Edit Document Links.

· Use the Properties Pane to View/Edit the Properties of Selected Document

Content.

· Use the Signatures Pane to View/Edit Signature Information.

· Use the Thumbnails Pane to View/Edit Document Pages.

· Use Guides and Rulers to Enhance the Editing Process.

· Use the Format Tab to Edit Document Content.

Enhance Documents:

· Add Backgrounds to Documents.

· Add Barcodes to Documents.

· Add JavaScript to Documents.

· Add/Remove Watermarks.

· Convert Document Colors.

· Deskew Scanned Pages.

· Enhance Scanned Pages.

· Rasterize Pages.

· Recompress Document Images.

· View/Edit Document Properties.

Integrate Cloud-Based Services:

· Open Documents from Box.com.

· Open Documents from Dropbox.

· Open Documents from Google Drive.

· Open Documents from OneDrive.

· Open Documents from SharePoint.

Manipulate Documents:

· Add Images to Documents.
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· Add/Remove Bates Numbering.

· Add/Remove Headers and Footers.

· Autoscoll through Documents.

· Calibrate Measurement Scales.

· Compare Documents.

· Create Number Ranges.

· Crop Documents.

· Email Documents.

· Export Documents to Image Format.

· Open Documents from a URL.

· Optimize Documents.

· Playback Documents.

· Print Documents.

· Search Document Text.

· Set Page Transitions.

· Show/Hide Page Boxes and Guide Lines in the Loupe View.

· Split the Page View.

· Use Inherited Zoom for Named Destinations.

· Utilize Macros to Enhance the Process of Editing Documents.

· Utilize Zoom Features.

Secure Documents:

· Add Digital Signatures to Documents.

· Add Long-Term Validation for Digital Signatures.

· Add Security Policies and/or Passwords to Documents.

· Certify Documents.

· Certify Documents without Adding a Physical Signature.

· Customize Security Options for Documents.

· Timestamp Documents.

Miscellaneous Features:

· Adjustable Cursor Sizes.

· Advanced Bookmark Macros.

· Control the Tab Title of Documents.

· DocuSign Integration.

· Dynamic Shell Extensions.

· Dynamic Thumbnail Selection Options.

· Type Your Signature.

· Use Command Line Options.

· Use the Word Count Feature to Review Documents.
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3.2 Explore the User Interface

 Explore the User Interface

The PDF-XChange Editor user interface appears as below:

Figure 1. PDF X-Change Editor User Interface

The ribbon tabs are located at the top of the window:
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Figure 2. PDF X-Change Editor User Interface, Ribbon Tabs Highlighted

Click the links below to view the options and functionality of each tab:

· File  contains file-level operations such as open, close, save and print.

· Home  contains the most commonly-used commands, such as the basic tools, links to

editing panes, view and rotation options, content-editing features, annotation tools and

document signing options.

· View  contains options that determine what is displayed in the main window such as

toolbar shortcuts and editing panes. Document layout options are also available in this tab.

· Comment  contains options for editing document comments, such as converting

comments to base content, importing/exporting comments and creating a comment

summary.

· Protect  contains options for signing and certifying documents, creating/editing security

policies and redacting documents.

· Form  contains options for managing, highlighting and creating document form fields such

as radio buttons, dropdown menus and barcodes.

· Organize  contains options for editing documents, such as add/remove watermarks,

insert/delete/crop/resize pages, edit backgrounds, add headers and footers/Bates

numbering.
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· Convert  contains options for creating documents from the local scanner, combining

existing files into a new file, creating blank documents, performing OCR on documents and

converting PDF files to other formats such as MS Word, Excel and Powerpoint formats. Note

that files exported to (*.docx) format are compatible with MS Word 2010 and later.

· Share  contains options that relate to files associated with the Microsoft Office

SharePoint Server, such as checking documents in/out or discarding documents from

Sharepoint, and also contains an option for emailing documents from PDF-XChange Editor.

· Review  contains options for reviewing documents, such as the spell check and word count

features, as well as options to create/delete and manipulate document comments.

· Accessibility  contains options for viewing/editing/creating document accessibility in PDF-

XChange Editor. These features are intended to make documents accessible to visually

impaired or otherwise disabled users. 

· Bookmarks  contains options that relate the creation and management of document

bookmarks.

· Help  contains links to software assistance, such as the PDF-XChange main website and

user forum, and customizable options for the UI theme and toolbars.

Note that the layout and content of the ribbon tabs can be fully customized, as detailed here.

The Quick Access Toolbar is located in the upper left of the user interface:
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Figure 3. PDF X-Change Editor User Interface, Quick Access Toolbar Highlighted

Use the icons in this toolbar to perform the following operations:

Click  Open to open files, or click the dropdown arrow to view/select recent files, including

pinned recent files, as detailed here.

Click  Save to save files. Note that additional save options, such as Save As and Save as

Optimized, are available in the File  tab.

Click  Print to print files. The Print dialog box will open and can be used to customize print

settings, as detailed here.

Click  Email to email files, or click the dropdown arrow to view/manage available mail clients,

as determined in the Send Mail  preferences.

Click  Scan to scan documents into PDF-XChange Editor, or click the dropdown arrow to

select a preset scanning mode. The Scan Properties dialog box will open and can be used to

customize scan settings, as detailed here.  Scanned documents will be converted to PDF and

displayed in the main window.

Click  Undo to undo the most recent action.

Click  Redo to reverse the most recent undo action.

Click  Previous View to navigate to the previous document view.

Click  Next View to navigate to the next view. Note that this option is only available when the

Previous View option has been used.

If you would prefer the Quick Access Toolbar to be located beneath the ribbon UI, then right-click the

Quick Access Toolbar and click Show Below the Ribbon in the shortcut menu.

The Quick Launch and Quick Find toolbars are used to determine the format of the user interface,

enable fullscreen mode and find/search document text:
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Figure 4. PDF X-Change Editor User Interface, Quick Launch and Quick Find Toolbars Highlighted

Click  UI Options to view/select UI options for PDF-XChange Editor:

· Click Switch to Classic Toolbars to switch to the classic UI layout that PDF-XChange

Editor used before version seven. The classic UI version of this manual is available here.

· Click Switch to Touch-optimized UI to switch from Mouse-optimized UI to Touch-

Optimized UI and vice versa. The Touch-Optimized UI features larger icons and is

intended for use in conjunction with tablets, smartphones and similar devices. When the

Touch-Optimized UI is enabled you can use single/double taps in the place of

singe/double mouse clicks in standard UI mode, and you can tap-and-hold to open

context menus. Additional options for customizing the touch UI are available in the

commenting preferences detailed here.

· Click Customize Toolbars to customize toolbars, as detailed here.

Click  Full Screen Mode to enable fullscreen mode. Note that fullscreen mode has many

customizable features, as detailed here.

Click  Find to enable the Find feature. This feature locates specified document text, as

detailed here.

Click  Search to open the Search pane and search for text is documents open in PDF-

XChange Editor or folders on the local computer, as detailed here.
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Click the  icon on the right of the Search icon to toggle the document toolbar and/or ribbon

tab view.

Click the  Quick Launch text box to find and launch commands in PDF-XChange Editor -

enter search terms in the text box and then click search results to activate them.

There are four toolbars in the lower section of the user interface:

Figure 5. Lower UI Toolbars

When the UI is maximized, the Document Options Toolbar displays the dimensions of the document

and the current pointer location:

Figure 6. Document Options Toolbar

Click Options to open/close the document editing panes and view/select editing tools, as detailed

here.

The Page Navigation Toolbar is used to navigate between document pages and views:

1045
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Figure 7. Page Navigation Toolbar

· Click the blue arrow icons to move to the first page, previous page, next page or last page of

documents. 

· Click the green arrow icons to move between the most recent views within documents.

· The number box at the center shows the current page and the total number of pages in the

active document. Enter a page number and press Enter to move to it.

The Page Layout Toolbar is used to determine how pages are displayed in the main window:

Figure 8. Page Layout Toolbar

· Single Page displays one page at a time.

· Continuous displays single pages continuously.

· Two Pages displays two pages at a time.

· Two Pages Continuous displays two pages continuously.

The Page Zoom toolbar is used to determine the zoom level:

Figure 9. Page Zoom Toolbar

Enter the desired zoom level and press Enter to move to it, or select an option in the dropdown menu.

Alternatively, use the slider to adjust the zoom level manually.

The Launch Application Toolbar is used to open current documents in different applications:

Figure 10. Launch Application Toolbar

Use the Launch Applications  preferences to add applications to the toolbar, then click applications

in the toolbar to launch them with the current document open inside.

The Quick Tools toolbar is available on the left side of the window:

235
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Figure 11. Quick Tools Toolbar

This toolbar provides quick access to the editing panes used in PDF-XChange Editor. The editing

panes are detailed here.

Note that the arrow icons on the left of toolbars can be used to expand/collapse toolbars, and the grid

of dots above the arrow icon can be used to click and drag toolbars to a different location in the user

interface.

Additionally, please note that several of the keyboard shortcuts relate to the commands displayed on

the user interface. See here  for a comprehensive list of available keyboard shortcuts.
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3.3 Tabs Guide

 Tabs Guide

This section of the manual details the content of the ribbon tabs in PDF-XChange Editor. When each

tab is selected, a different set of functions appears in the user interface:

Figure 1. Ribbon Tabs

Click the links below to view the options and functionality of each tab:

· File  contains file-level operations such as open, close, save and print.84
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· Home  contains the most commonly-used commands, such as the basic tools, links to

editing panes, view and rotation options, content-editing features, annotation tools and

document signing options.

· View  contains options that determine what is displayed in the main window such as

toolbar shortcuts and editing panes. Document layout options are also available in this tab.

· Comment  contains options for editing document comments, such as converting

comments to base content, importing/exporting comments and creating a comment

summary.

· Protect  contains options for signing and certifying documents, creating/editing security

policies and redacting documents.

· Form  contains options for managing, highlighting and creating document form fields such

as radio buttons, dropdown menus and barcodes.

· Organize  contains options for editing documents, such as add/remove watermarks,

insert/delete/crop/resize pages, edit backgrounds, add headers and footers/Bates

numbering.

· Convert  contains options for creating documents from the local scanner, combining

existing files into a new file, creating blank documents, performing OCR on documents and

converting PDF files to other formats such as MS Word, Excel and Powerpoint formats. Note

that files exported to (*.docx) format are compatible with MS Word 2010 and later.

· Share  contains options that relate to files associated with the Microsoft Office

SharePoint Server, such as checking documents in/out or discarding documents from

Sharepoint, and also contains an option for emailing documents from PDF-XChange Editor.

· Review  contains options for reviewing documents, such as the spell check and word count

features, as well as options to create/delete and manipulate document comments.

· Accessibility  contains options that are used to view/edit document accessibility and

utilize accessibility features. These features are intended to make documents accessible to

visually impaired or otherwise disabled users.

· Bookmarks  contains options that relate the creation and management of document

bookmarks.

· Help  contains links to software assistance, such as the PDF-XChange main website and

user forum, and customizable options for the UI theme and toolbars.

· Format  is used to edit content and comment and form field styles in PDF-XChange

Editor.

· Portfolio  is used to edit and manipulate PDF portfolio files.
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3.3.1 File Tab

 File Tab

When the File tab is selected, the following options are available:
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Figure 1. File Tab

Use the options in the pane on the left to perform the following operations:

· Click Open  to open documents in PDF-XChange Editor, restore previous sessions, link to

Dropbox, Google Drive and SharePoint accounts, or open files from URLs.

· Click the Save Options  to save documents. 

· Click New Document  to create new documents. Create documents from text files, rich text

format files, image files or the local scanner. Combine existing files into a single document, or

create new blank documents.

· Click the Print Options  to print documents. 
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· Click Export  to export a copy of documents to image format or MS

Word/Excel/Powerpoint formats. Note that files exported to (*.docx) format are compatible

with MS Word 2010 and later.

· Click Share  to utilize SharePoint options or email documents from PDF-XChange Editor. 

· Click Revert to undo changes that have not been saved in the current document. 

· Click Document Properties  to view/edit document properties.

· Click Audit Space Usage to view a breakdown of space usage in the document.

· Click Rename to rename the document.

· Click Move to Trash to delete the document.

· Click Close to close the current document, or click Close All to close all open documents.

· Click Preferences  to view/edit the PDF-XChange Editor preferences.

· Click the Manage Settings  to Export/Import/Reset settings.

· Click Exit to exit PDF-XChange Editor.
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3.3.1.1 Open

 Open

The Open options are used to open files in PDF-XChange Editor:

Figure 1. File Tab Submenu, Open Submenu, Recent Files Options

· Click Recent Files  to view/open recent files.

· Click Sessions  to view/open saved sessions.

· Click Open from URL to open a document from a URL.

· Click Add a Place  to add new places to the Open list, such as Dropbox, Google Drive and

SharePoint folders.

· Click Browse to open a file from the local computer.
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· Enter search terms in the Find text box to search for recently open documents.
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3.3.1.1.1  Recent Files

 Recent Files

Click Recent Files to view files recently open in PDF-XChange Editor:

Figure 1. File Tab, Open Submenu, Recent Files Options

· All documents viewed previously in PDF-XChange Editor are detailed chronologically in the

Unpinned Recents list. 

· Click the pin icon next to unpinned documents in order to add documents to the list of Pinned

Recents. This feature is included so documents considered more important are not moved

down the list when new documents are opened. They remain in the Pinned Recents list instead.
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· Click the pin icon next to Pinned Recents in order to remove documents from the list. Click

documents from either list to open them. 

· Hover the pointer over documents to view their details.

· Use the Find text box to locate and open recent files.

· Click History to open the History pane in order to view/open recently opened documents, as

detailed here.

· Click Manage History and Recents to view/edit the History and Recent List Options:

Figure 2. Manage History and Recents Dialog Box

· Use the Max. number of items number box to determine the maximum number of files stored

in the history of PDF-XChange Editor.

· Use the Item's lifetime number box to determine the lifetimes of items in the file history list.

· Use the Show max. number of items number box to determine the maximum number of

items in the Recents lists.

· Use the check boxes to determine the elements of files that are displayed in the list.

· Click Clear to remove items from the history list.

Click OK to save changes.

437
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3.3.1.1.2  Sessions

 Sessions

Click Sessions to view, manage, save or open sessions: 

Figure 1. File Tab, Open Submenu, Sessions Options

A session is defined as an active instance of using PDF X-Change Editor to view/edit documents. When

a session is saved, PDF-XChange Editor remembers which documents were open, their order/layout

within the main window, the location of the main window on the screen and the status of editing panes.

The most recently saved sessions are detailed at the top of the Sessions list. 

· Click sessions in the Sessions list to open them.
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· Click Last Used Session to restore the last session of PDF-XChange Editor.

· Click Manage Sessions to manage existing sessions. The Manage Sessions dialog box detailed

will open, as detailed in (figure 2).

· Click Save Current Session to save the active session. The Save Current Session dialog box

will open. Enter a name for the session in the text box and click OK to save. It will then be

available in the Manage Sessions list as detailed above.

· Click Save Current Session to a File to save the current session as a .xcesession file for

subsequent use. Saved sessions can be imported via the Manage Sessions dialog box.

Alternatively, double-click to restore sessions.

· Click Open Session from a File to open a session saved in the .xcesession format as detailed

above.

Figure 2. Manage Sessions Dialog Box
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· Click Import to import a previously saved session. The Open Session dialog box will open.

Select the desired file and click Open to open it. 

· Click Export to export the session currently selected in the list of sessions. The Save Current

Session dialog box will open. Enter a name for the file and click Save to save it.

· Click Rename to rename the session currently selected. The PDF-XChange Editor dialog box

will open. Enter a new name for the session in the text box and click OK to save it.

· Click Remove to remove the session currently selected.

· Click Remove All to remove all sessions from the list.

Further settings are available in the Additional Options section:

· Select the Restore whole session including saved windows layout button to restore the open

documents and windows layout (such as the Thumbnails/Bookmarks pane) when sessions are

opened.

· Select the Keep current position of active main window to retain the current position

of the main window when sessions are opened.

· Select the Just open documents from the session and add them to button to restore only

the open documents from the session, and then select an option from the dropdown menu to

determine how the documents are added:

· Active Tab Group

· New Tab Group in the Active Window

· New Tab Group in a New Window

· Select the Use the History to restore last document's view position box to open documents

at the location that was current when the document was last closed. If this option is not

selected, then documents will open at the location that was current when the session was saved.

· Select the Store path relative to the session file when saving current session to save

sessions relative to the session file. This feature is useful in cases where documents (including

the session file) are located on a network/portable device such as a USB stick that multiple

users will share. Note that the session file and any associated files must be saved on the same

disk for this feature to operate.
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3.3.1.1.3  Add a Place

 Add a Place

Click Add a Place to add new places to the Open list for subsequent use:

Figure 1. File Tab, Open Submenu, Add a Place Options

· Click WebDAV, Box.com, Dropbox, Google Drive, OneDrive or SharePoint, then enter your

login details to add an account to the list.

· Click Local Folder to add a folder on the local computer to the list, then select a folder to add

it to the list.

Added places appear as detailed below:
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Figure 2. File Tab, Open Submenu, Places Added

Click places to open them, then select files to view/edit them in PDF-XChange Editor. Click the 'x' icon

to remove places from the list and the pencil icon to rename places.
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3.3.1.2 Save Options

 Save Options

The save options are used to save documents in PDF-XChange Editor:

Figure 1. File Tab Submenu. Save Options

· Click Save to save the active document. Any changes made since the document was opened

will be saved and the original version of the document will be overwritten. 

· Click Save As to save the edited document with a new name and retain the original version of

the document.

· Click Save as Optimized to optimize files before they are saved, as detailed below.

· Use the Add a Place options to add save locations to the Save As list:
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· Click Dropbox, Google Drive or SharePoint, then enter your login details to add an

account to the list.

· Click Local Folder to add a folder on the local computer to the list, then select a folder to

add it to the list.

Note that added places for saving documents are displayed in the Save As list. Click places to save files

to those places. Click the 'x' icon to remove places from the list.

Saving Documents

Documents can be saved to a range of different formats. Available formats are detailed in the Save

File As dialog box. Click Browse as detailed in (figure 1) to open the Save File As dialog box, then

click the Save as Type dropdown menu to select the desired format:

Figure 2. Save File As Dialog Box, Save Format Options

· Select PDF Documents to save the document as a (*.pdf) file.

· Select Plain Text to save the document as a (*.txt) file.

· Select MS Powerpoint Presentation to save the document as a (*.pptx) file.
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· Select MS Word Document to save the document as a (*.docx) file.

· Select MS Excel Workbook to save the document as a (*.xlsx) file.

· Select PDF/A Document to save the document as a (*.pdf) PDF/A file. The PDF/A format is

used for archiving documents. Further information about this format is available here.

· Select PDF/X Document to save the document as a (*.pdf) PDF/X file. The PDF/X format is

used for the facilitation of graphics exchange. Further information about this format is available

here.

· Select Optimized PDF to optimize the document and save it as a (*.pdf) file. The process of

optimization is to reduce the file size. Further information about this option is detailed below.

· Select Sanitized PDF to sanitize the document of sensitive information and save it as a (*.pdf)

file. Further information about document sanitization is available here.

Save As Optimized

When this option is selected the Optimize PDF dialog box will open:

669

https://en.wikipedia.org/wiki/PDF/A
https://en.wikipedia.org/wiki/PDF/X
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Figure 3. Optimize PDF Dialog Box, Images Tab

These settings are used to optimize PDF content:

Images

The options for optimizing images are detailed in (figure 3). They are as follows:

· Click the Color Images, Grayscale Images, Indexed Images and Monochrome Images menus

to select settings for the respective image formats.

· Click the Bicubic Downsampling/Subsampling menus to increase/reduce the resolution of

images.

· Click the arrows in the DPI box, or enter a figure manually, to select the dots-per-inch

resolution for new images.

· Click the arrows in the for images above box, or enter a figure manually, to select the

minimum DPI at which images are downsampled/subsampled.
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· Click the Compression menus to select the compression format of images. Where applicable

click the Quality menu to select the compression quality.  

· The Optimize images only if there is a reduction in size box is selected by default. Clear this

box to optimize images even when there is no reduction in size.

Fonts

Click Fonts to determine the settings for font optimization:

Figure 4. Optimize PDF Dialog Box, Fonts Tab

· Use the Unembed Fonts dropdown menu to determine font embedding options:

· Select Do Not Unembed any font to retain all embedded fonts.

· Select Unembed recommended fonts to unembed recommended fonts, which will

result in the unembedding of the most common fonts in order to reduce the file size.
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· Select Unembed all fonts to unembed all fonts. This will reduce the size of files as far as

possible with regard to fonts. However, it also increases the risk of compatibility issues

for subsequent users of the document. This is because they will not be able to read the

document unless the application they are using to view the document contains the font.

Therefore this setting should be used only in cases where documents contain only

common fonts. 

· Select Select fonts to unembed manually to unembed a custom selection of fonts.

When this option is selected the fonts used in the current document are displayed in the

Embedded Fonts pane. Select fonts and click the Unembed button to unembed them

when the file is optimized. Select fonts within the Fonts to Unembed pane and click

Retain to retain them when the file is optimized.

· Select the Merge fonts subsets box to merge duplicated font subsets.

Discard Objects

Click Discard Objects to determine the settings for discarding objects:
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Figure 5. Optimize PDF Dialog Box, Discard Objects Tab

· Select the Discard all form submissions, import and reset actions box to remove these

elements from the document.

· Select the Discard all JavaScript actions box to remove JavaScript actions from the document.

· Select the Discard all alternate images box to remove alternate images from the document.

Alternate images are additional versions of existing images that may differ slightly, such as in

resolution or color space.

· Select the Discard embedded page thumbnails box to remove embedded page thumbnails

from the document.

· Select the Detect and merge image fragments box to merge image fragments. Note that

some images are composed of fragmented sections that are spliced together. Merging these

fragments will reduce the file size.

· Select the Discard embedded print settings box to discard remnant encoding in cases where

documents were created with a virtual printer.

· Select the Discard bookmarks box to remove all bookmarks from the document. 
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Discard User Data

Click Discard User Data to determine the settings for discarding user data:

Figure 6. Optimize PDF Dialog Box, Discard User Data Tab

· Select the Discard all comments, forms and multimedia box to remove these elements from

the document.

· Select the Discard document information and metadata box to remove all metadata from

the document.

· Select the Discard file attachments box to remove attached/embedded files from the

document.

· Select the Discard private data of other applications box to remove information from the

document that is useful only to the application used to create it.
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· Select the Discard hidden layer content and flatten visible layers box to remove hidden

layers from the document and flatten the visible layers to base content.

Cleanup

Click Cleanup to determine cleanup options:

Figure 7. Optimize PDF Dialog Box, Cleanup Tab

· Select the Discard Duplicates of Fonts box to remove redundant fonts from the document.

· Select the Discard Duplicates of Images box to remove duplicate images from the

document.

· Select the Discard duplicates of XForms box to remove duplicate XForms from the

document.

· Select the Use Flate to encode streams that are not encoded box to compress document

information that is pending for compression.
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· Select the In Streams that use LZW encoding use Flate instead box to use Flate

compression instead of LZW encoding. This is recommended as Flate is compatible with a

wider range of platforms.

· Select the Discard Invalid Bookmarks box to discard bookmarks that do not contain

actions/valid destinations. 

· Select the Discard Unreferenced Named Destinations box to remove named destinations

that are not referenced in the document. 

· Select the Find and Remove Content Outside of the Crop Box box to remove content

outside the crop box. Note that this content is hidden when documents are displayed.

Settings

Click the Settings dropdown menu to toggle between Standard Mode, which is best for computers,

and Mobile Mode, which is best for tablets and cell phones:

Figure 8. Optimize PDF Dialog Box, Settings Dropdown Menu
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The Settings dropdown menu is also used to save, manage and delete customized settings:

· Click Save Current Settings to save custom settings for subsequent use. Saved

profiles are detailed in the Settings dropdown menu.

· Click Delete to delete selected profiles.

· Click Manage to manage saved custom settings. The Manage Presets dialog box

will open:

Figure 9. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles. This makes it possible to duplicate profiles

and then customize their settings whilst retaining the existing profile and its

parameters.

· Use the up and down arrow to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.

Select an option in the Make Compatible With dropdown menu to make optimized

documents compatible with specified versions of Acrobat:
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Figure 10. Optimize PDF Dialog Box, Make Compatible Dropdown Menu

Click Audit Space Usage to view a breakdown of the space used in the document.

Click OK to save changes.
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3.3.1.3 New Document

 New Document

Click New Document to view the options for creating new documents:

Figure 1. File Tab Submenu, New Document Options

· Click With Blank Pages  to create a blank document.

· Click Combine Files into a Single PDF  to combine existing files into a single document.

· Click PDF Portfolio  to create a PDF portfolio file.

· Click From Text  to convert text files into PDF.

· Click From Markdown  to convert Markdown files into PDF.

· Click From CSV File  to convert CSV (comma separated values) files into PDF.

110

112

116

120

125

128



109

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Click From Rich Text  to convert RTF files into PDF.

· Click From Web Page  to convert a webpage to PDF.

· Click From Email  to convert email files to PDF.

· Click From Image File(s)  to convert image files into PDF.

· Click From Scanner  to create new PDF documents from the local scanner.

· Click From Clipboard  to create a new PDF document from the content in your clipboard.
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3.3.1.3.1  With Blank Pages

 With Blank Pages

Click With Blank Pages to create a blank document: 

Figure 1. File Tab Submenu, New Document Options, With Blank Pages

The New Empty Document dialog box will open:
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Figure 2. New Empty Document Dialog Box

· The Standard options are standard dimensions for documentation such as those used by the

ISO and ANSI.

· The Custom options can be used to enter custom dimensions. Enter the desired measurements

into the text boxes and select the units of measurement.

· Select either Portrait or Landscape as the orientation.

· The Count option determines how many blank pages are created.

Click OK to create the new document.
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3.3.1.3.2  Combine Files Into a Single PDF

 Combine Files into a Single PDF

Click Combine Files into a Single PDF to combine existing files into a single document:

Figure 1. File Tab Submenu, New Document Options, Combine Files into a Single PDF

 The Combine Files dialog box will open:
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Figure 2. Combine Files Dialog Box

· Click Add Files to select files from the local computer to add to the list of source files. Click the

dropdown arrow for additional options:

· Click Add All Opened Documents in Opened Order to add all open documents in the

order in which they were opened.

· Click Add All Opened Documents in the Current Tab Order to add all open documents

in their current order in the document tab.

· Click Add Folder to add entire folders to the list of source files. Click the arrow adjacent to the

button to determine further options. The Add Files From Folder Options dialog box will open.

This is detailed in (figure 3).

· Click Page Range to determine the page range of selected documents. Page range settings are

explained here.  

· Use the arrow icons (or click and drag) to reorder selected documents in the list. This

determines the order in which they appear in the new document.

· Click Options to determine the actions taken with objects contained within combined files. The

Options dialog box will open. The available actions relate to comments, form fields and

bookmarks. Select the Add root bookmark with file name box as desired.

Click OK to combine all files in the Combine Files dialog box into a single PDF.

1285
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Figure 3. Add Files From Folder Options Dialog Box

· Select the Ask for suitable file extensions after choosing a source folder box to launch this

dialog box when folders are selected using the Add Folder button. 

· Select the Include Subfolders box to include subfolders of the parent folder when the software

searches for files to add to the list of source files.

· Select the Select file types which should be added while searching folders box to determine

file types to be included when the software performs a search.

· Custom filters can be added using the Add Custom Filter option. This facilitates the creation of

custom profiles for subsequent use that search for specific file extensions. Click Add Custom

Filter to open the Add Custom Filter dialog box:

Figure 4. Add Custom Filter Dialog Box
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· Enter a name for the custom filter.

· Enter the desired file extensions. File extensions must begin with an asterisk and a period, for

example: *.apm, *.bmp. 

· When the desired details have been entered, click OK to save the custom filter.
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3.3.1.3.3  PDF Portfolio

 PDF Portfolio

PDF portfolio files are a unique format of PDF file in which multiple files are assembled into an

integrated PDF unit for convenience of use. Click PDF Portfolio to create a PDF portfolio file: 

Figure 1. File Tab Submenu, New Document Options, PDF Portfolio

The Create PDF Portfolio dialog box will open:
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Figure 2. Create PDF Portfolio Dialog Box

· Click Add Files to select files from the local computer to add to the portfolio file.

· Click Add Folder to add entire folders to the list of source files used to create the portfolio file.

Click the arrow adjacent to the button to determine further options. The Add Files From Folder

Options dialog box will open. This is detailed in (figure 3).

· Use the arrow icons to reorder selected documents in the list. This determines the order in

which they appear in the portfolio file.
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Figure 3. Add Files From Folder Options Dialog Box

· Select the Ask for suitable file extensions after choosing a source folder box to launch this

dialog box when folders are selected using the Add Folder button. 

· Select the Include Subfolders box to include subfolders of the parent folder when the software

searches for files to add to the list of source files.

· Select the Select file types which should be added while searching folders box to determine

file types to be included when the software performs a search.

· Custom filters can be added using the Add Custom Filter option. This facilitates the creation of

custom profiles for subsequent use that search for specific file extensions. Click Add Custom

Filter to open the Add Custom Filter dialog box:

Figure 4. Add Custom Filter Dialog Box
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· Enter a name for the custom filter.

· Enter the desired file extensions. File extensions must begin with an asterisk and a period, for

example: *.apm, *.bmp. 

· When the desired details have been entered, click OK to save the custom filter.
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3.3.1.3.4  From Text

 From Text

Click From Text to convert text files into PDF:

Figure 1. File Tab Submenu, New Document Options, From Text Files

The Convert Text Files to PDF dialog box will open:
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Figure 2. Convert Text Files to PDF Dialog Box

The options in this section are the same as those outlined in the Combine Files into a Single PDF

section, with the difference that files must be in plain text (*.txt) format. There are also additional

options in the Selected File Options section:

· Text Encoding sets the text encoding format. This determines the representation of language-

specific characters within imported files. 

· New Paragraph Mode defines when new paragraphs are started. There are four options:

· Auto Detect is the default setting. The software will detect automatically when new

paragraphs begin.

· Each newline character starts a new paragraph. (A newline is a special character in

computing that signifies the end of a line of text).

· Double newline character starts a new paragraph, singles ignored.

· Double newline character starts a new paragraph, singles converted into space.

· Place File Mode determines what happens with each file as it is placed in the combined

document. There are two options:

· Start each file from a new paragraph. 

· Start each file from a new page.

· Click Options to view/edit further options:

112
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Figure 3. Options Dialog Box

New Page Options

· The Standard option centers the original files in a new PDF of standard size. 'Standard' refers to

common sizes such as those used by the ISO and ANSI.

· The Custom option allows the user to enter custom dimensions.

· The Orientation option has the settings Portrait or Landscape as the page orientation. 

· The Page Rotation option rotates images as required during conversion.

· The Margins options facilitate the customization of the image margins. Enter the values

desired into the number boxes.

Text Format

When this option is selected, the following dialog box will open:
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Figure 4. Text Format Options

· The Font and Paragraph buttons determine the font and paragraph settings of the text. 

· The Columns options determine the number of columns of text, spaces between columns and

unit of measurement for the spaces.  

· Select the Line between columns box to insert lines between the columns of text. The Style,

Thickness and Color settings determine the parameters of the lines.

File Separator

The File Separator inserts a label that shows a divide between files after they have been combined into

one document. When the File Separator option is selected, the following dialog box opens:
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Figure 5. File Separator Options

· Select the Show title box to give the file separator a title. Click the icon to add macros.

· The Back color option determines the color of the file separator.

· The Font and Paragraph settings determine the font style and paragraph layout of the file

separator.

· Select the Draw line box to add a line to the file separator. Use the menus to determine Style,

Thickness and Color options.

· Select the Place line above header box to position the line above the header of the document.

Click OK to save settings.
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3.3.1.3.5  From Markdown

 From Markdown

Click From Markdown to convert Markdown files into PDF:

Figure 1. File Tab Submenu, New Document Options, From Markdown

The Convert Markdown to PDF dialog box will open:
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Figure 2. Convert Markdown to PDF Dialog Box

· Click Add Files to select files from the local computer to add to the list of source files. Click the

dropdown arrow for additional options:

· Click Add Folder to add entire folders to the list of source files.

· Use the arrow icons to reorder selected documents in the list. This determines the order in

which they appear in the new document.

· Click Options to determine conversion options. The Markdown to PDF Options dialog box

will open:
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Figure 3. Markdown to PDF Options Dialog Box

· Use the Standard dropdown menu to set a standard document size for the dimensions of the

new document.

· Click the Custom button to set a custom document size for the dimensions of the new

document, then use the number boxes and the units of measurement dropdown menu to

determine the dimensions.

· Use the Orientation and Page Rotation dropdown menus to set the orientation and page

rotation of the new document.

· Use the Margins dropdown menus to determine the margins of the new document.

· Use the Path text box to determine the text style/presentation of the new document. Note that

it is necessary to use a (*.css) file to determine these options. Further information about this

file format is available here.

https://en.wikipedia.org/wiki/Cascading_Style_Sheets
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3.3.1.3.6  From CSV File

 From CSV File

Click From CSV File to convert CSV (comma separated values) files into PDF:

Figure 1. File Tab Submenu, New Document Options, From CSV File

The Open Files dialog box will open. Select the desired file and click Open. The CSV to PDF dialog

box will open:
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Figure 2. CSV to PDF Dialog Box

· Use the Delimiter box to specify the delimiter used in the input file to separate values, or select

the adjacent check box to perform this operation automatically.

· Use the Quotes box to specify the character used to determine quotes in the input file.

· Select an option in the Standard dropdown menu to specify the page size of the output

document, or use the Custom options to specify a custom page size.

· Use the orientation and units of measurement dropdown menus to specify the orientation and

units of measurement used for the output document.

· Use the Margins number boxes to specify the margins of the output document.

· Click Font to determine font options for the output document, as detailed in (figure 3) below.

· Select the Automatically calculate column widths based on data box to calculate column

widths according to the data in the source document.

· Select the Draw table header on each page and/or Use bold font for header text boxes as

desired.

· Select the Draw table border box as desired, and use the Border width and color dropdown

menus to determine the border width and color used for the table border.
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Click OK to convert the csv file to PDF.

Figure 6. Select Font Dialog Box

· Use the Font text box to enter the name of the desired font, or select one from the options

listed below the text box.

· Use the Style menu to determine the style of the font.

· Use the Size menu to determine the size of the font.

· Use the Fill menu to determine the color of the font. 

· Use the Stroke menu to determine the color of the stroke. This color will border the text.

· Use the Stroke width menu to determine the size of the stroke. 

· Use the Underline menu to enable/disable font underline.
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3.3.1.3.7  From Rich Text

 From Rich Text

Click From Rich Text to convert RTF files into PDF:

Figure 1. File Tab Submenu, New Document Options, From Rich Text

The Convert RTF Files to PDF dialog box will open:
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Figure 2. Convert RTF Files to PDF

The options are the same as those outlined in the Combine Files into a Single PDF  section with the

differences that files must be in (*.rtf) format, and the available parameters are different in the

Options dialog box:

Figure 3. Convert RTF files to PDF Options

Relative path is the only option in the categories menu. There are four relative path options:

· Keep existing means relative paths remain as they are.

· Make absolute makes the relative paths absolute. 

112
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· Make relative makes the relative paths relative. (Absolute paths show the full name of the

file/internet address in question. Relative paths are shorter and link to more specific locations). 

· Select the Replace relative documents extensions box to create a PDF document from linked

RTF files.

Click OK to save settings.
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3.3.1.3.8  From Web Page

 From Web Page

Click From Web Page to convert web pages into PDF:

Figure 1. File Tab Submenu, New Document Options, From Web Page

The Create PDF from Web Page dialog box will open:
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Figure 2. Create PDF from Web Page Dialog Box

· Enter the URL of the web page you want to convert to PDF, then click OK to perform the

conversion.

· Click Browse to select a file on your machine to convert to PDF.

· Click Settings to view additional settings for converting web pages to PDF. The Html to PDF

Options dialog box will open:

Figure 3. Html to PDF Options Dialog Box

· Select the Standard button to create a document using a standard size, then select the desired

size from the dropdown menu.

· Select the Custom button to create a document using a custom size, then use the adjacent

boxes to determine the size of the document.

· Use the Margins number boxes to specify the margins in the document.
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· Use the Compression level dropdown menu to determine the level of compression used in the

document.

Click OK to save settings.
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3.3.1.3.9  From Email

 From Email

Click From Email to convert email files into PDF:

Figure 1. File Tab Submenu, New Document Options, From Email

The Convert Email Files to PDF dialog box will open:
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Figure 2. Convert Email Files to PDF Dialog Box

· Click Add Files to select files from the local computer to add to the list of source files. 

· Click Add Folder to add entire folders to the list of source files. 

· Use the arrow icons (or click and drag) to reorder selected documents in the list. This

determines the order in which they appear in the new document.

· Click Options to determine document output options:
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Figure 3. Email to PDF Options Dialog Box

· Select Standard to create a document using a standard ISO size, then select an option in the

dropdown menu.

· Select Custom to create a custom document, then enter the desired dimensions in the number

boxes and units of measurement dropdown menu.

· Use the Orientation and Scale boxes to determine the orientation and scale of the document

as desired.

· Use the Margins number boxes to determine the margins for the document.

· Use the Compression dropdown menu to determine the compression used for the the

document.

Click OK to create the document.
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3.3.1.3.10  From Image File(s)

 From Image File(s)

Click From Image Files to convert image files into PDF:

Figure 1. File Tab Submenu, New Document Options, From Image Files

The Image to PDF dialog box will open:
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Figure 2. Images to PDF Dialog Box

· The Add Files and Add Folder options are the same as those outlined above in the Combine

Files into a Single PDF  section.

· Click Import to add images from the local scanner. The Scan Properties dialog box will open.

Select the desired parameters as detailed here  and click Scan to import images.

· Click Webcam to add images from the local webcam. The Image from Webcam dialog box

will open. Click the camera button to take a picture, then apply the crop as desired and click

Next to add the image to the Image to PDF dialog box.

· Select an image from the Source image files list and click Edit to edit it before it is converted

to PDF, as detailed in (figure 10) below.

· Click the arrow icons to move images up or down within the list. Click the Remove icon to

remove selected images from the list. The format in which files are shown within the list can be

adjusted using the icon on the far right.

· Click Options for further options, as detailed in (figure 3) below.

· Click OK to create the new document.

112

861
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Figure 3. Images to PDF Options Dialog Box, New Page Options

New Page Options

When this option is selected in the Categories menu, the dialog box detailed in (figure 3) opens. The

options are as follows:

· The Select Paper Size by Image Size option crops new documents according to the image size

converted. I.e. the borders of the original image define the borders of the new document.

· The Standard option centers the original file in a new document of standard size. 'Standard'

refers to common sizes such as those used by the ISO and ANSI. Click the menu for a list of

available sizes. 

· The Custom option allows the user to enter custom dimensions. There is also a choice for

portrait or landscape style (unless the Choose Paper Size by Image Size option is selected).

· The Page Rotation option rotates images as required during conversion. Click the menu for

rotation options. 

· The Margins option facilitates the customization of the image margins. Enter the values

desired into the boxes. The new PDF will feature these dimensions.
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Click OK to save settings.

Images Layout Options

When this option is selected in the Categories menu the following options are available:

Figure 4. Images to PDF Options Dialog Box, Image Layout Options

· The Layout Rules options determine the layout of images within new documents. Enter the

desired dimensions in the Columns and Rows number boxes. Use the Space between

Columns and Space between Rows boxes to determine the amount of empty space between

columns and rows of images.

· Align Images determines the alignment of images within new documents. There are two

options: Reduce to Cell and Fit to Cell. Reduce to Cell is the default setting. This reduces the

size of the images to fit the size of the document. If the original images are smaller than the

document then they will remain at their original size. The Fit to Cell setting fits the images to

the size of the document. If the images are smaller than the document then they will be

increased in size to match the size of the new document. 
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· The Keep Aspect Ratio box is selected by default. This means that images keep their original

proportions and fit the specified PDF dimensions as far as possible within those proportions.

Clear this box to disable the aspect ratio. Images will then match the PDF size exactly but may

distort as a result (depending on the dimensions of the PDF document in relation to the

dimensions of the original images).

· Horizontal and Vertical Alignment determines the location at which images in the new

document appear.

Click OK to save settings.

Image Labels

When this option is selected in the Categories menu the following options are available:

Figure 5. Images to PDF Options Dialog Box, Image Labels Options

· Select the Use special text label for each image box to enable further options.

· Enter the desired label text in the text box. Click the blue icon to utilize Macros  as desired.1166
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· Back Color determines the background color of the label. Click the box to open a menu of

available colors. 

· The Paragraph settings determine the alignment, indentation and spacing of the text on the

label. Click Paragraph to adjust these settings. The indentation settings include two special

options. Select the First Line option to indent the first line, as in a standard paragraph. The

second special option is Hanging indentation, which means the first line is not indented but all

subsequent lines are. When either of these settings are being used the ‘By’ box must be

adjusted accordingly. 

· Click Font to determine the font used for the label. The dialog box in detailed in (figure 6) will

open.

· If the Place label above image box is not selected then the label will appear below the image.

· Select the Add bookmark for each image with the same text as label as desired. Further

information about bookmarks is available here.

 

Figure 6. Select Font Dialog Box

· Use the Font text box to enter the name of the desired font, or select one from the options

listed below the text box.

· Use the Style menu to determine the style of the font.

· Use the Size menu to determine the size of the font.

· Use the Fill menu to determine the color of the font. 
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· Use the Stroke menu to determine the color of the stroke. This color will border the text.

· Use the Stroke width menu to determine the size of the stroke. 

· Use the Underline menu to enable/disable font underline.

Click OK to save settings.

Image Processing

When this option is selected in the Categories menu the following options are available:

Figure 7. Images to PDF Options Dialog Box, Image Processing Options

· These settings determine the dimensions for converted documents of different formats: True

Color, Grayscale, Indexed and Monochrome. There are two options for each format:

· Downsampling reduces the sampling rate of images. Each format has three options: Linear,

Bilinear and Bicubic. Further information about these options is available here. Use the pixels

per inch boxes to determine the size above which and to which images will be downsampled. 

https://en.wikipedia.org/wiki/Decimation_(signal_processing)
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· Conversion relates to the automatic conversion of files, where possible, from one format to

another. Use this option to convert the format of new files when they are created. Where

applicable, select the box for dithering as desired. 

Click OK to save settings.

Image Compression

When this option is selected in the Categories menu the following options are available:

Figure 8. Images to PDF Options Dialog Box, Image Compression Options

· Image compression is enabled by default. Clear the boxes to disable this setting.

· When compression is enabled, use the adjacent menu to select the type of compression that

the tool performs. Auto is the default setting. 

· Where applicable, adjust the JPEG Quality/JBIG2 Method and Lossless options as desired. 

Click OK to save settings.

https://en.wikipedia.org/wiki/Dither
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Image Post-processing

When this option is selected in the Categories menu the following options are available:

Figure 9. Images to PDF Options Dialog Box, Image Post-Processing Options

· Select the Deskew box to deskew images. This straightens the edges of images automatically

and is a useful tool if images have been scanned or photographed crookedly.

· Select the Despeckle box to despeckle images. This removes speckles from images during

conversion.

· Select the Run OCR box to OCR images after processing. Click the OCR Settings button to set

the language and accuracy of the OCR process. 

Click OK to save settings.

Editing Images before Converting to PDF

When you have added images to the Image to PDF dialog box, you can click Edit to edit images

before they are converted to PDF:
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Figure 10. Image to PDF Dialog Box, Edit Option Highlighted

When this option is selected the editing window will open:

Figure 11. Image Editing Window
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· Click Flip Horizontal/Flip Vertical to flip images horizontally/vertically before they are

converted to PDF.

· Click Rotate 90 CCW/Rotate 90 CW to rotate images ninety degrees

counterclockwise/clockwise before they are converted to PDF.

· Click Apply Filter to apply filters to images before they are converted to PDF, then select the

desired filter from the list of options.

· Click Convert to to convert images to a different format before they are converted to PDF, then

select the desired format from the list of options.

· Click Grayscale to convert images to grayscale before they are converted to PDF.

· Click Deskew to deskew images before they are converted to PDF. Deskewing is used to

straighten images that have been scanned crookedly.

· Click Crop to crop images before they are converted to PDF. A bounding box will appear

around images when this option is used. Click and drag the bounding bow to determine the

cropping parameters as desired.

· Click Fit Visible to fit images to the image editing window.

· Use the Zoom in/Zoom Out options, or the zoom number box, to change the zoom level of

images.

Click OK to convert images to PDF.
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3.3.1.3.11  From Scanner

 From Scanner

Click From Scanner to create PDF documents from the local scanner:

Figure 1. New Document Submenu. From Scanner Option

· Preset options are displayed in the From Scanner list. Click these options to create a new

document according to their preset parameters.

· Click Configure Presets to determine preset parameters for each mode, as detailed here.

· Click Custom Scan to determine custom parameters. The Scan Properties dialog box will

open:

254
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Figure 2. Scan Properties Dialog Box

· Click the Scanner Settings menu to select a preset scanning mode. 

· Click the Scanner menu to select a scanner to use. 

· Click the Data Transfer Method menu to select either Native Mode or Memory Mode:

· Native Mode uses a single memory buffer. This is the default and fastest

mode, and is compatible with the broadest range of scanners.

· Memory Mode enables the use of multiple memory buffers. This is a useful

function in cases where memory is low and/or when large images are being

scanned.

· The Show Native UI box is selected by default, which means the user interface of

the device driver is used. This is the most reliable option, and the scanner will select

certain parameters of the scan itself: Color Mode, Resolution, Paper Size and

Source. Clear the Show Native UI box to customize these options:

· Color Mode has four options: Auto detect, Color, Grayscale and Black & White. These

refer to the format of scanned documents.

· Click the Resolution menu to select the DPI (dots per inch) of scanned documents.

· Paper Size refers to the size of the paper used when scanning. Click Setup for further

options, which are as follows:
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· The Automatic option determines the paper size automatically.

· The Standard option contains standard sizes such as those used by the ISO and

ANSI.

· The Custom option can be used to enter custom dimensions.

· Source has three options Auto, Flatbed and Feeder. These refer to the type of scanner

being used.

· Click the Sides menu to determine which sides of documents are scanned. There are three

options: Simple Scan, Manual Duplex and Manual Duplex Reversed. Click the arrow for an

explanation of these options.

· Click the Scan More Pages menu to select the setting for when additional pages are scanned.

· Select the After scanning, show images insertion dialog box to view the images insertion

dialog box after the scan has taken place. This enables the customization of images and

images settings.

· Click the Images Insertion Options button to determine further options for inserted images.

Those options are explained here.

Click Scan to scan pages.

Scanner Settings

Click the Scanner Settings menu to save custom settings for subsequent use. The following dialog box

will open:

141
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Figure 3. Scanner Settings Options

These options are used to adjust the scanner mode or save custom settings. There are five preset

modes that relate to the format of scanned documents. They feature settings that are optimal for their

respective modes. These modes can also be selected when choosing the option through which the new

document is created. Hover the pointer over the New Document>From Scanner option and a menu

will appear. The options to Custom Scan and Configure Presets are also available on this menu. Click

Custom Scan to launch the Scan Properties dialog box shown in (figure 2) above. Click Configure

Presets to open the Configure Scanner Presets dialog box and determine the presets for scanning.

When custom parameters have been entered in the Scan Properties dialog box they can be saved for

subsequent use with the Save Current Settings option. Click the icon/text to save the current settings.

Enter a name (and brief description, if desired) for the customized settings. Click Manage to edit

customized settings and Delete to remove them.
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3.3.1.3.12  From Clipboard

 From Clipboard

Click From Clipboard to create a PDF document from the content of your clipboard:

Figure 1. New Document Submenu. From Clipboard Option

The Create New Document from Clipboard dialog box will open:
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Figure 2. Create New Document from Clipboard Dialog Box

Select the content that you want to use to create the new document, then click OK to create the

document.

If you are creating a new document from an image, then you can click the Options button to determine

conversion options. The Image to PDF Options dialog box will open, and can be used to determine

conversion options as detailed here.

If you are creating a new document from text, then you can click the Options button to determine

conversion options. The Options dialog box will open, and can be used to determine conversion

options as detailed here.

141

122
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3.3.1.4 Print Options

 Print Options

Click Print (or press Ctrl+P) to print the current document: 

Figure 1. File Tab Submenu, Print Options

The Print dialog box will open:
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Figure 2. Print Dialog Box

· The options in the Printer section determine the printer to be used and its associated settings:

· Use the Name text box to select a printer to use.

· Use the Copies text box to determine how many copies of the document are printed.

· Select the Collate box to collate document pages. This is a useful feature when printing

multiple copies of multi-page documents. It prints entire copies of documents together,

as opposed to multiple copies of each page at a time.

· Click the Properties button to open the Properties dialog box for the selected printer.

· Click the Page Setup button to open the Page Setup dialog box. See (figure 3) below.

· The options in the Page Range section determine which pages of the document will be printed:

· Select the Pages button to print a selection of the document pages:

· Select All to print all pages.

· Select Current to print only the current page.

· Select Custom to print a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or

Even as desired.

· Select the Reverse Order box to print pages in reverse numerical order.

1285
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· Select the Current View button to print only the current view of the document.

· Select the Selected Graphic button to print only the graphic currently selected in the

document.

· The options in the Pages Placement and Scaling section determine the placement and scaling

of the document:

· Use the Type menu to select a standard placement setting. When a setting is selected its

features will be shown in the preview window. Each setting has further options that

become available when the setting is selected. The effect that these have will be shown in

the preview window when they are adjusted.

· Use the Page Zoom number box to determine the level of zoom on the page. Select the

check boxes to enable further settings.

· The options in the Advanced Print Options tab determine advanced printing options: 

· Use the Print menu to determine which elements of the document are printed. Click

More for further options. See (figure 4) below.

· Select the Print as Image box to print the selected pages as images.

· When the desired parameters have been selected, click Print to print the document.

Figure 3. Page Setup Dialog Box

· Select a size for the document from the Size menu.

· Select a source for the document from the Source menu.



161

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Use the option buttons to select either Portrait or Landscape as the orientation for the

document.

Click OK to apply changes.

Figure 4. Advanced Print Options Dialog Box

· Use the Print Content Options to determine printed document content.

· Use the Rendering Options to determine how documents are rendered:

· Use the Color Override dropdown menu to determine color override options:

· Auto permits PDF-XChange Editor to select the color override setting. 

· Grayscale prints documents in grayscale.

· Monochrome prints documents in monochrome.
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· Color prints documents in color.

· Use the Text Rendering Mode dropdown menu to determine how text is rendered:

· Auto permits PDF-XChange Editor to select the text rendering mode. Additionally,

it should be noted that this option is required in order to print embedded fonts.

· Outline for Embedded Fonts prints embedded fonts as outlines, which are vector

images.

· Outline Always prints all fonts as outlines.

· Bitmap for Embedded Fonts prints embedded fonts as bitmap images.

· Bitmap Always prints all fonts as bitmap images.

· Use the Maximum Resolution for Images dropdown menu to set the maximum

resolution of images in printed documents.

· Use the Resolution for Gradient Fills dropdown menu to determine the resolution used

for gradient fills.

· Select the Ignore check boxes as desired.

Click OK to apply changes.

Print All

Click Print All to print all open documents in the current window as a single document:
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Figure 5. File Tab Submenu. Print All Option

The Print dialog box will open, as detailed above. Set the desired printing parameters and then click

Print to print all open documents in the current window as one document.
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3.3.1.5 Export

 Export

Click Export to export a copy of the current document to a different format:

Figure 1. File Tab Submenu, Export Options

 

· Click Export to Image(s) to export PDF documents into image format, as detailed here.

· Click Export to Microsoft Word Document to export documents to (*.docx) format, as

detailed here.

· Click Export to Microsoft Excel to export documents to (*.xlsx) format, as detailed here.

· Click Export to Microsoft Powerpoint Presentation to export documents to (*.pptx) format,

as detailed here.

166
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Please note that MS Office must be installed on the local computer for the Export to MS Office

features to operate, and Save As XPS functionality must be available in the version of MS Office being

used. This functionality was added in MS Office 2007.
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3.3.1.5.1  Export to Image

 Export to Image

Click Export to Image(s) to export PDF documents into image format. The Export to Image(s) dialog

box will open:

Figure 2. Export to Images Dialog Box

· Use the Page Range options to select the pages that will be exported:

· Select the Pages button to print a selection of the document pages:

· Select All to print all pages.

· Select Current to print only the current page.
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· Select Custom to print a custom page range, then enter the desired page range

in the adjacent number box. Further information about how to specify custom

page ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or

Even as desired.

· Select the Reverse Order box to print pages in reverse numerical order.

· Select the Current View button to print only the current view of the document.

· Select the Selected Graphic button to print only the graphic currently selected in the

document.

· Use the Save As options to determine the file type and location of the saved document:

· Use the Image Type dropdown menu to determine the image format. Click the Options

button to determine further document properties.

· Use the Destination Folder text box to enter the folder in which the document will be

saved. Alternatively, click the adjacent icon to browse the folders on the local computer. 

· Use the Filename text box to enter a file name for the new document. Add macros  as

desired - enter them after the file name or click the adjacent icon.

· Use the Export Mode setting to select the mode in which multiple-page documents are

exported. There are three options:

· Save all pages to a single multi page image file.

· Save each page range to a multi page image file.

· Save each page to a separate single page image file.

· The Open the Desintation Folder box is selected by default. Clear this box to disable this

function. 

· Use the Graphic options to determine the graphics settings:

· Page Zoom increases or decreases image dimensions.

· The Resolution boxes determine the horizontal and vertical resolution of images. The

ratio is constrained by default. Click the chain icon to disable this setting.

· The Page Background setting determines the color of the background in the new

document.  

When custom export options have been selected they can be saved using the Export Settings menu.

Click Save to save the current settings. Enter a name (and brief description, if desired) for the settings.

Click Manage to edit customized settings and Delete to remove the setting currently selected.

Click OK to export the document to image format.

1285

1166



168

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.1.5.2  Export to MS Word Document

 Export to MS Word Document

Click Export to Microsoft Word Document to export documents to (*.docx) format, which is intended

for use with Microsoft Word. The MS Word File dialog box will open:

Figure 1. MS Word File Dialog Box

· Use the Pages options to determine the pages to be exported to (*.docx) format:

· Use the Page Range options to select the pages that will be exported:

· Select All to export all pages.

· Select Current to export only the current page.
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· Select Custom to export a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Note that the current export settings are detailed in the dialog box window. Click Edit/Reset to

edit/reset these settings. When you click Edit the Options dialog box will open:

Figure 2. Options Dialog Box

· Use the Language dropdown menu to specify the language of the source document. This

setting is necessary in cases where document text has the incorrect encoding and OCR is used

to determine the correct unicode to use. AUTO is the default setting and the language is taken

from the document properties when it is used.

· Use the Fonts dropdown menu to determine font embedding options.

· Select either the Retain Page Layout or the Retain Flowing Text button as desired. Retain

Page Layout adds a page break after each page and a line break to lines that are shorter than

other lines within the same paragraph. Retain Flowing Text retains the text flow as a priority

over the page layout and will allow text to wrap if there are multiple columns of text.

· Select the Use OCR to fix garbled text in output files box to use the OCR engine to recognize

symbols, which may resolve garbled output text in cases of documents with invalid character

encoding.

· Select the Make invisible text visible in output document and Include

Comments/Images/Links boxes as desired.

1285
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Click OK to export the document to (*.docx) format.

Please note that MS Office must be installed on the local computer for this feature to operate, and

Save As XPS functionality must be available in the version of MS Office being used. This functionality

was added in MS Office 2007.
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3.3.1.5.3  Export to MS Excel Document

 Export to MS Excel Document

Click Export to Microsoft Excel Document to export documents to (*.xlsx) format, which is intended

for use with Microsoft Excel. The MS Excel File dialog box will open:

Figure 1. MS Excel File Dialog Box

· Use the Pages option to determine the pages to be exported to (*.xlsx) format:

· Select All to export all pages.

· Select Current to export only the current page.
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· Select Custom to export a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Note that the current export settings are detailed in the dialog box window. Click Edit/Reset to

edit/reset these settings. When you click Edit the Options dialog box will open:

Figure 2. Options Dialog Box

· Use the Language dropdown menu to specify the language of the source document. This

setting is necessary in cases where document text has the incorrect encoding and OCR is used

to determine the correct unicode to use. AUTO is the default setting and the language is taken

from the document properties when it is used.

· Select the Detect decimal and thousands separators using regional settings to specify the

use of regional settings to determine the thousands separator in exported documents.

Alternatively, select the second radio button and then select the desired symbols in the

dropdown menus.

· Select the Make invisible text visible in output document box as desired.

· Use the Create Worksheet dropdown box to determine whether a worksheet is created for the

whole document or for each page of the document.

· Select an option in the Use a new row in the sheet for each dropdown menu to determine

how rows are defined in the output document.

1285
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· Select the Use OCR to fix garbled text in output files box to use the OCR engine to recognize

symbols, which may resolve garbled output text in cases of documents with invalid character

encoding.

Click OK to export the document to (*.xlsx) format.

Please note that MS Office must be installed on the local computer for this feature to operate, and

Save As XPS functionality must be available in the version of MS Office being used. This functionality

was added in MS Office 2007.
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3.3.1.5.4  Export to MS PowerPoint Document

 Export to MS PowerPoint Document

Click Export to Microsoft Excel Document to export documents to (*.pptx) format, which is intended

for use with Microsoft PowerPoint. The MS PowerPoint File dialog box will open:

Figure 1. MS PowerPoint File Dialog Box

· Use the Pages option to determine the pages to be exported to (*.pptx) format:

· Select All to export all pages.

· Select Current to export only the current page.
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· Select Custom to export a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Note that the current export settings are detailed in the dialog box window. Click Edit/Reset to

edit/reset these settings. When you click Edit the Options dialog box will open:

Figure 2. Options Dialog Box

· Select the Convert Entire page content to Image box to convert the entire document to

image format in the output (*.pptx) document.

· Use the Resolution dropdown menu to determine the resolution of the image when the

Convert Entire page content to Image option is used.

· Use the Language dropdown menu to specify the language of the source document. This

setting is necessary in cases where document text has the incorrect encoding and OCR is used

1285
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to determine the correct unicode to use. AUTO is the default setting and the language is taken

from the document properties when it is used.

· Use the Mode dropdown menu to determine the text conversion mode.

· Select the Embed all fonts to embed all fonts in the source document into the output

document.

· Select the Allow to use substitution for fonts that cannot be embedded to enable the

substitution of fonts that cannot be embedded.

· Select the Allow to convert a text that uses problematic fonts to curves to enable the

conversion of text to curves in cases of problematic fonts.

· Select the Use OCR to fix garbled text in output files box to use the OCR engine to recognize

symbols, which may resolve garbled output text in cases of documents with invalid character

encoding.

· Use the Resolution dropdown menu to determine the resolution of rasterized text in cases

where it cannot be converted according to the settings specified in the dialog box.

· Select the Make invisible text visible in output document and Include Comments/Links

boxes as desired.

Click OK to export the document to (*.pptx) format.

Please note that MS Office must be installed on the local computer for this feature to operate, and

Save As XPS functionality must be available in the version of MS Office being used. This functionality

was added in MS Office 2007.
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3.3.1.6 Share

 Share

Click Share to email documents or manipulate SharePoint documents:

Figure 1. File Tab Submenu, Share Options

 

· Click Send by E-mail to email the document. The mail client set in the Email Preferences

 will open and the document will be added to an outgoing email as an attachment.

· Click Send by E-mail Open All to email all open documents. The mail client set in the Email

Preferences  will open and all open documents will be added to an outgoing email as an

attachment.

· Click Check In/Check Out to check the document in to/out from a SharePoint account.

261

261
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· Click Discard Check Out to discard the file currently checked out from a SharePoint account.

· Click Enable Editing to enable editing for the file currently checked out from a SharePoint

account.

· Further information about the SharePoint options is available here. 961



179

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.1.7 Document Properties

 Document Properties

Click Document Properties to view/edit document properties: 

Figure 1. File Tab Submenu, Document Properties

The Document Properties dialog box will open: 
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Figure 2. Document Properties Dialog Box, Description Option Selected

· Please note that the keyboard shortcut Ctrl+D can also be used to launch this dialog box. 

· Click Audit Space Usage to view a breakdown of space usage in the document. 

Select an option from the Categories menu to view/edit properties:

Description

This option displays details about the current document:

· The File Info section contains information about the file name, location and size. Click the

folder icon on the right to open the containing folder on the desktop.

· The Document Info section contains information about the Document Title, Author, Subject

and Keywords. These can be edited using the adjacent text boxes. Further document details

can be viewed beneath this section. Click the Additional Metadata button to view/edit

additional document details:
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Figure 3. Document Metadata Dialog Box, Description Tab

· Use the text boxes to view/edit document metadata. 

· Click Advanced in the Categories menu to view the metadata structure of the document, as

detailed below.

· Use the options in the Advanced dropdown menu to save the metadata template of the

document or show the templates folder on the local machine.
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Figure 4. Document Metadata Dialog Box, Advanced Tab

Existing document metadata is detailed in the pane on the right. Click options in the dialog box to

Replace, Append, Save, Delete or Remove All document metadata as desired.

Fonts

This option displays details about document fonts. Please note that the information displayed is read-

only. The Save as Optimized  settings can be used to customize font embedding options.

Security

This option displays document security details:

96
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Figure 5. Document Properties Dialog Box, Security Option Selected

· Use the Security Method menu to select the type of security used in the document: 

· No Security is the default setting, which means subsequent users have no restrictions on

editing the document. This option should also be used when removing security from

documents. 

· Password Security enables document encryption, passwords and permissions. When it is

selected the dialog box in (figure 6) will open. 

· The Certificate Security option is available only when documents feature certificate

security.

· The Microsoft Azure Information Protection option is available only when documents

feature Microsoft Azure security.

· The FileOpen option is available only when documents feature FileOpen security. 

· Click the Apply Security Policy button to apply a new security policy or clone/edit

existing policies, as detailed in (figure 7).

· Additional security options are available here.

Click OK to save settings.

258

http://www.fileopen.com/
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Figure 6. Password Security Settings

· Use the Compatibility menu to set the document security compatibility.

· Select an encryption option button to determine which elements of documents are encrypted.

· Select the Require password to open the document box to set a password for opening the

document. Enter the password in the Document Open Password text box and confirm it in the

text box below.

· Select the Restrict editing and printing of the document box to set a password for editing

and printing the document. Enter the password in the Change Permissions Password text box

and confirm it in the text box below. Use the dropdown menus and check boxes in the

Permissions section to select the settings that these passwords will enable. 
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Click OK to save settings.

Figure 7. Managing Security Policies Dialog Box

This dialog box is used to create and manage security policies:

· Click Add New to add a new security policy. The Password Security Settings dialog box

detailed in (figure 6) will open. Determine parameters as desired then click OK to save.

· Click Clone/Edit/Rename/Delete to perform these operations on selected security policies.

· Click Export to export the security policy for subsequent use. Exported polices can be imported

with the Import button, which is on the right of the Export button.

· Click Apply to Document to apply the security policy selected in the Managing Security

Policies dialog box to the current document.

Initial View

These settings determine the layout when files are opened:
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Figure 8. Document Properties Dialog Box, Initial View Option Selected

The Initial View settings are as follows:

· The Navigation View menu determines the panes that are visible when documents are opened:

· Select Default to retain the default settings of the application used to open documents. 

· Select Page Only to view only the document itself.  

· Select Bookmarks pane and page to view the document and the bookmarks pane.

· Select Thumbnails pane and page to view the document and the thumbnails pane. 

· Select Layers pane and page to view the document and the layers pane. 

· Select Attachments pane and page to view the document and the attachments pane.

· The Page Layout menu determines the page layout when documents are opened:

· Select Default to retain the default settings of the application used to open documents.

· Select Single Page to view a single page at a time.

· Select Continuous to view pages in a single, scrolling column.

· Select Two Pages Continuous to view two pages at a time in scrolling columns.

· Select Two Pages Continuous, with Cover Page to view as above, but with a cover page

included.

· Select Two Pages to view two pages at a time.
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· Select Two Pages with Cover Page to view as above, but with a cover page included.

· The Action Type menu determines the action performed when documents are opened:

· Select None for no action to be performed when documents are opened.

· Select Goto Page to open documents to a specific page. When this option is selected,

the Open to Page and Magnification dropdown menus will become available. Select

options in those menu to determine the page at which documents are opened, and the

type of magnification used. The Magnification options are detailed below:

· Select Default to retain the default settings of the application used to open

documents.

· Select Actual Size to view pages at their actual size. The resulting display will

include resolution settings. 

· Select Fit Page to view the full extent of page content regardless of its size.

· Select Fit Width to fit pages according to their width.

· Select Fit Height to fit pages according to their height.

· Select Fit Visible to view the entire page within the confines of the viewing area.

· Alternatively, select an option from the list of numerical percentages to determine

the magnification level.

The Window Options are as follows:

· Show in Title determines the name displayed in the document tab when documents are

opened. The options are File Name or Document Title. 

· Select the Open in Full Screen Mode box to open documents in full screen mode.

· Select the Resize Window to Initial Page box to resize the viewing window according to the

dimensions of the first page of the document.

· Select the Center Window on Screen box to center the viewing window on the monitor screen.

The User Interface Options are as follows:

· Select the Hide Menu Bar box to hide the Menu toolbar when documents are opened. 

· Select the Hide Window Controls box to hide windows controls when documents are opened. 

· Select the Hide Toolbars box to hide toolbars when documents are opened.

Click OK to save settings. 

Custom

These settings determine custom document properties:
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Figure 9. Document Properties Dialog Box, Custom Option Selected

· Click Add to add custom document properties to documents. The Custom Document

Property dialog box will open. Enter a name and value for the property, then click OK to create

it.

· Click Edit to edit selected custom document properties.

· Click Delete to delete selected custom document properties.

· Click Remove All to remove all custom document properties.

Advanced

These settings determine advanced document properties:



189

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 10. Document Properties Dialog Box, Advanced Option Selected

· The PDF Settings feature two parameters:

· Enter a URL in the Base URL text box to specify a base URL for weblinks in documents.

The option is included to simplify the management of web links to an external website. If

the URL to the external site changes then this setting can be used to avoid having to edit

manually every link in documents that refer to the external site. (Please note that the base

URL is not used if a link contains a complete URL address).

· The Trapped option determines trapping options with regard to printing. This is a

complex process that aims to optimize the quality of printed documents. See here for

further details. 

· Select the Print Dialog Presets box to override the viewing application's default print settings

with those specified within the file itself:

· Select an option in the Page Scaling dropdown menu to determine the page scaling

used:

· Default retains the default settings. 

· None disables page scaling. 

· Select an option in the Duplex Mode dropdown menu to determine the default duplex

mode for printing.

https://en.wikipedia.org/wiki/Trap_(printing)
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· Select the Paper Size by document Page Size box to use the size of the document pages

to determine the paper size of the document.

· Enter the pages to be printed in the Print Page Range text box. Further information on

the specification of page ranges is available here.

· Use the Number of Copies dropdown menu to determine how many copies of the

document are printed.

· Select the Reading Options box to enable binding and language options:

· Select either Left to Right or Right to Left as the document Binding option.

· Select an option in the Language dropdown menu to determine the language of the

document.

Actions

These settings enable the activation of JavaScript commands when documents close/save/print:

Figure 11. Document Properties Dialog Box, Actions Option Selected

These settings can be used to enable JavaScript commands when the following operations take place:

· Before Document Close

1285
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· Before Document Saving

· After Document Saving 

· Before Document Printing

· After Document Printing

Double-click the text box beneath operations to add JavaScript, as detailed here.

Click OK to save settings.

JavaScript

This option details JavaScript in the active document: 

Figure 12. Document Properties Dialog Box, JavaScript Option Selected

JavaScript is a high-level programming language that can be used to perform a range of operations.

Click Add, Edit or Delete to add/edit/delete JavaScript. See here for an index of existing JavaScript

operations that PDF-XChange Editor supports and additional information about JavaScript.

307

https://opensource.adobe.com/dc-acrobat-sdk-docs/library/jsapiref/index.html
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3.3.1.8 Preferences

 Preferences

Click Preferences (or press Ctrl+K) to view/edit the PDF-XChange Editor preferences:

Figure 1. File Tab Submenu, Preferences

The Preferences dialog box will open:
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Figure 2. Preferences Dialog Box

You can use the Find bar to search the PDF-XChange Editor preferences for settings. Click the

categories in the pane on the left side to determine the settings of the associated section of the

software. Click the links below for further information:

· Documents

· General

· Page Display

· Page Text

· Registration

· Accessibility

· Color Management

· Commenting

· Convert to/from PDF

· Customize UI

· Document Info Bar
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· File Associations

· Forms

· Full Screen

· Identity

· JavaScript

· Languages

· Launch Applications

· Measurement

· Measurement 3D

· Multimedia 3D

· OCR

· Performance

· Places

· Plugins

· Scanner Presets

· Search Providers

· Security

· Send Mail

· SharePoint

· Signatures

· Snapshot Tool

· Speech

· Tools

· Update
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3.3.1.8.1  Documents

 Documents

When the Documents tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Documents Tab Selected

· Select the Restore Last Session when application starts box to restore the most recent

session when PDF-XChange Editor is launched.
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· Click Manage History and Recents to manage settings for the history of open documents in

PDF-XChange Editor. The Manage History and Recents dialog box will open. See (figure 2)

below.

· Select the Back/Forward commands navigate through all opened documents dialog box to

include all open documents when the back/forward navigation commands are used. If this box

is not selected then PDF-XChange Editor will navigate through the views of only the active

document when these commands are used.

· Select the Always use Incremental Save dialog box to enable incremental save. PDF-

XChange Editor will remember the original content of the document when this option is

enabled, and will store information about all new changes. This should reduce the amount of

time taken to save files, but please note that the size of files will increase each time a save

operation is performed.

· Use the Select destination folder for 'Save As' documents dropdown menu to determine the

folder in which documents are saved when the 'Save As' option is used.

· Select the 'Save Autorecover information every' box to enable the saving of autorecovery

information, which is useful in the event of software crashes or when documents are closed

without changes having been saved. Use the number box to determine the interval at which

autorecovery information is saved.

· Select the Keep recovery information when closing and discarding changes box as desired.

· Select the Show Recovery Panel if there is any recovery data available to launch the

Document Recovery Panel whenever there is recovery data available.

· Use the PDF-Specification dropdown menu to determine the PDF specification of documents

created in PDF-XChange Editor.

Click Apply to apply changes and OK to save changes.



197

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 2. Manage History and Recents Dialog Box

· Use the Max. number of items number box to determine the maximum number of files stored

in the history of PDF-XChange Editor.

· Use the Item's lifetime number box to determine the lifetimes of items in the file history list.

· Use the Show max. number of items number box to determine the maximum number of

items in the Recents lists.

· Use the check boxes to determine the elements of files that are displayed in the list.

· Click Clear to remove items from the history list.

Click OK to save changes.
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3.3.1.8.2  General

 General

When the General tab is selected the following options are available:

Figure 1. Preferences Dialog Box, General Tab Selected

· Click Setup to determine the tabs and windows settings in PDF-XChange Editor, as detailed in

(figure 2) below.
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· Click Manage to manage the prompts and warning message dialog boxes in PDF-XChange

Editor, as detailed in (figure 3) below.

· Use the High PDF scaling behavior dropdown menu to set the UI scale used for monitors when

you are switching between screens that have different resolution settings.

Figure 2. Manage Tabs and Windows Dialog Box

· Select the Single document mode box to enable single document mode, which means that

only one document can be open at a time.

· Select the Open each document in a new window box to open each new document in a new

PDF-XChange Editor window.

· Select the Shrink document tabs when there is not enough space for them box to shrink the

size of document tabs when there are multiple tabs open and not enough space to display the

names of all open files.

· Select the Scroll across document tabs with the mouse wheel, instead of changing the

active document box to scroll through document tabs with the mouse wheel instead of having

the active document change.
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· Select the Hide tab bar when only a single document is opened box to hide the tab bar when

only one document is open and maximize the workspace area.

· Select the Hide close (x) button in document tabs box to hide the close document button in

document tabs. Click the mouse wheel to close documents when this option is enabled.

· Select the Hide close (x) button in all non-document tabs box to hide the close button in

non-document tabs such as the Thumbnails and Bookmarks panes. Click the mouse wheel to

close panes when this option is enabled.

· Select the Hide close (x) button for all inactive tabs box to hide the close document button

for inactive document tabs.

· Select the Hide 'Close Active Tab' button in all tab-bars box to hide the close active tab

button for all tabs.

· Select the Disable underline-effect for selected tabs box to disable the animated underline

that indicates the tab currently selected in the user interface.

· Select the Synchronize the layout of document panes across all opened documents box to

synchronize the layout of Editing Panes  for all open documents.

· Use the Open new document dropdown menu to determine the tab location at which new

documents are opened:

· Select in new tab to open new documents in a new tab on the document toolbar.

· Select in new adjacent tab to open new documents in a new tab adjacent to the tab of

the current document in the document toolbar.

· Use the Open related document dropdown menu to determine the location at which

documents related to the current document, such as attachments and linked documents, are

opened:

· Select in new tab to open related documents in a new tab on the document toolbar.

· Select in new adjacent tab to open related documents in a new tab adjacent to the tab

of the current document in the document toolbar.

· Select in the same tab to open related documents in the same tab as the current

document. Please note that if this option is selected then the current document is closed

when related documents are opened.

· Select the Minimize to System Tray box to minimize PDF-XChange Editor to the system tray

when the minimize option is used.

· Select the Close to System Tray box to close PDF-XChange Editor to the system tray when the

close option is used.

· Use the Document Tab Title dropdown menu to determine the name of the document as

displayed in the tab title:

· Select Auto to allow PDF-XChange Editor to select the document tab title automatically.

· Select Document Title to use the document title as defined in the Document

Properties.

· Select Document filename to use the document filename. 

· Use the Document tab title truncation dropdown menu to determine how document tab titles

are truncated in cases where the tab is too narrow to display the whole title.

342
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Figure 3. Manage Prompts Dialog Box

· Click Enable/Disable All to enable/disable all check boxes in the dialog box.

· Click Reset to Default the Selected to reset selected prompts to their default setting.

· Select/clear the boxes of the prompts that you want to show/hide.

Click OK to save changes.
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3.3.1.8.3  Page Display

 Page Display

When the Page Display tab is selected the following dialog box is displayed:

Figure 1. Preferences Dialog Box, Page Display Tab Selected

· The Initial Display settings determine the layout of documents when they are opened:

· Select the upper check box to restore the most recent display settings. Please note that

the Crop Pages  settings can be used to determine page boxes.897



203

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Use the Default View menu to select the default viewing parameters for documents. 

· Select the middle check box to retain the most recently used page layout and zoom

settings when recent document are opened.

· Use the Default Page Layout and Default Page Zoom dropdown menus to determine

the default layout and zoom settings.

· Select the lower check box to override the settings determined in this section with the

existing settings of documents.

· The Page Display settings determine what is displayed on the active page: 

· Select the required check boxes. Please note that the Crop Pages  feature can be used

to define the Art, Trim and Bleed Boxes.

· Select an option from the Use Resolution menu to determine the viewing resolution.

· Select the indicated check box to disable zoom settings when 'Go to Destination'

actions are launched.

· Click the Rendering button to determine the rendering settings. The following dialog box

will open:

Figure 2. Rendering Dialog Box

· The Smoothing options are used to smooth PDF content and create a softer appearance:

· Select the desired format for smoothing text.

· Select the Smooth Line Art and Smooth Images boxes as desired.

· Please note that some fine detail may be lost as a result of using these options.

· The Advanced options determine advanced display settings for color modes and objects:

897

309
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· Select the Enhance thin lines box to repair instances of blurring that may occur when

using metric measurements such as point (pt).

· Use the Synchronous page rendering menu to define the page rendering method:

· Select No to disable synchronous page rendering. If this option is selected then

rendering results are displayed when they are complete. Page scrolling is always

smooth when this option is selected, but some pages may be blank initially. This

option is best for heavy documents that contain a lot of content, as it ensures that

PDF-XChange Editor remains fully responsive at all times.

· Select Yes to enable synchronous page rendering. If this option is selected then the

page view in PDF-XChange Editor will wait until the content of all visible pages is

rendered before displaying it on the screen. Pages will not be blank initially, but

page scrolling will not always be smooth – especially on pages that contain a

significant amount of content. This option is best for light documents – for example

documentation that contains predominantly text and a small amount of images.

· Select Auto to combine the benefits of synchronous and asynchronous rendering. If

the rendering time is small – for example in light documents – then PDF-XChange

Editor operates with synchronous rendering enabled. However, if the rendering

time exceeds a given threshold, then it will switch to asynchronous rendering. This

means that no pages will be displayed as blank initially for light documents, and

that page scrolling is always smooth for heavy documents.

· Use the Default transparency blending color space menu to select the default color

space for transparency blending:

· Auto uses RGB color when there is no transparency between intersecting objects

and CMYK in cases of transparency.

· Working RGB uses only RBG color space.

· Working CMYK uses only CMYK color space and converts it to RGB when displayed

on-screen.

· Working Grayscale uses only grayscale when rendering.

· Use the Text Hinting menu to enable/disable text hinting, or set this feature to Auto as

desired. Text hinting adjusts the display of outline fonts to make them line up with a

rasterized grid.

· Use the Stroke Adjust menu to enable/disable the stroke adjust feature. Stroke adjust

specifies that the line widths and coordinates of strokes are adjusted automatically to

produce strokes of uniform thickness. This is performed in order to compensate for the

effects of rasterization and fit lines (and other figures) more precisely to the pixel grid of

monitors and other displays. The width will be as near as possible to the requested line

width, and no more than half a pixel in difference. Please note that disabling Smooth

Line Art when stroke adjust is enabled will have a negative effect on image quality.

· On forces the use of stroke adjust in all cases.

· Off disables the use of stroke adjust.

· Auto determines the use of stroke adjust according to the content of the file. Note

that stroke adjust is not specified in most cases, and the default value is On.
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Click OK to save changes.
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3.3.1.8.4  Page Text

 Page Text

When the Page Text tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Page Text Tab Selected

· Select the Detect Interactive Text Links check boxes as desired to determine the parameters

for interactive text.
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· Select an option from the Copy white spaces mode dropdown menu to determine the

outcome when white space is copied.

· Select the Preserve original ligatures box to preserve original ligatures. (Ligatures occur when

letters are joined as single glyphs, such as the "æ" grapheme in English).  If this box is cleared

then ligatures will be created from individual letters instead.

· Use the check boxes in the Bookmark Creation Options section to determine text settings

when bookmarks are created.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.5  Registration

 Registration

When the Registration tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Registration Tab Selected

The Registration tab is used to register/edit license keys in PDF-XChange Editor. Current keys and

their details are displayed in the Installed License Keys pane.
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· Click Add New License Key to add new license keys.

· Click Remove to remove current license keys.

· Click Activate to activate keys that are detailed in the pane but have not yet been activated.

You can then select to either Activate via Internet, which will activate the license key

immediately, or Activate Manually, which requires the saving of the license key to a device

such as a USB stick for subsequent activation. The latter option is intended for use in cases

where an internet connection is not immediately available.

· Select the Hide all licensed features from toolbars and menus box to remove licensed

features from the free version of PDF-XChange Editor.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.6  Accessibility

 Accessibility

When the Accessibility tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Accessibility Tab Selected

The Accessibility tab is used to control the color options of PDF documents.

· Select the Override Document Colors box to enable further options. 
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· Use the Page Background Color/Text Color dropdown menus to determine the page

background/text color.

· Use the Line Art dropdown menus to determine the Fill Color and Stroke Color used for line

art.

· Select the Change the color of black text or line art only box to apply changes to only black

text/line art.

· Use the Cursors Size dropdown menu to change the size of the cursors in PDF-XChange

Editor.

Click Apply to apply changes and OK to save changes.



212

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.1.8.7  Color Management

 Color Management

When the Color Management tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Color Management Tab Selected

· The Color Settings dropdown menu is used to store and manage customized color profiles.

Use this menu to save settings when they have been adjusted using the options detailed below.
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· Use the RGB, CMYK and Grayscale dropdown menus to determine the settings for these color

modes.

· Use the Engine dropdown menu to determine the engine used for color management.

· Select the Use Black Point Compensation box to enable black point compensation, which is a

technique used in digital photography printing for the creation of adjustments between the

maximum black levels of digital files and the black capabilities of digital devices.

Click Apply to apply changes and OK to save changes.



214

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.1.8.8  Commenting

 Commenting

When the Commenting tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Commenting Tab Selected

These options determine the settings for comments:
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· Select the boxes in the Comments Viewing Options section to determine options for

displayed comments.

· Select the Always use Login Name for Author name box to use your login name as the

author name for comments.

· Select the Copy encircled text into pop-ups of Drawing comments box as desired. This

setting is used in conjunction with the shape annotations. Text that new shape annotations

encircle is automatically added into their pop-up note when this setting is enabled.

· Select the Copy selected text into pop-ups of newly created Text Markup comments box as

desired. Text that the Highlight, Strikeout and Underline Text tools are used to annotate will

automatically be copied into their pop-up note when this setting is enabled.

· Select the Automatically open pop-ups for newly created Text Markup comments box as

desired. 

· Select the Automatically Switch to Pencil or Eraser tool with Stylus box as desired.

· Select the Allow Draw with a Finger Touch option to enable the drawing of comments with a

finger touch for touch-based devices.

· Select the Allow Draw with a Mouse option to enable the drawing of comments with the

mouse. If this option is disabled then the stylus can be used to draw comments.

· Select the Do not use semi-transparency for comments when creating or editing box as

desired.

· Select the Auto-select newly created comment box as desired.

· Select the Apply comment-style to selected annotation(s) on style activation box as

desired.

· Select the Paste Comment into mouse position box to paste copied comments at the current

pointer location.

· Select the Do not apply Redaction to the comments box to exclude comments when the

Redaction  feature is used.

Click Apply to apply changes and OK to save changes.

663
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3.3.1.8.9  Convert to/from PDF

 Convert to/from PDF

Convert to PDF

When the Convert to PDF tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Convert to PDF Tab Selected
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This option shows the file formats that can be converted to PDF format. If selected formats have further

options then the Setup button will be enabled.

Convert from PDF

The options in the Convert from PDF tab are the same as those detailed above, but they are used

when converting from PDF format.  

Click Apply to apply changes and OK to save changes.
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3.3.1.8.10  Customize UI

 Customize UI

When the Customize UI tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Customize UI Tab Selected

 These settings determine the appearance of the user interface:
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· Use the Theme dropdown menu to specify the theme for the user interface. Select the Allow

Dark Mode from system box to permit the use of dark mode for the user interface.

· Use the menus in the Fonts section to determine the font style and size for menus, toolbars and

dialog boxes.

· Use the menus in the Colors section to determine the colors of the UI.

· Use the menus in the Backgrounds section to determine the UI display for backgrounds:

· Use the Type menu to select the background to customize.

· Use the Style/Pattern menus to select the style and color of the selected background.

· Select the Show Overlay Shadows box as desired.

· Select the Turn off all textured backgrounds to improve UI performance on terminal

session box as desired.

· Click Reset to Defaults to reset all UI customization.

It is also possible to customize toolbars in PDF-XChange Editor. Those settings are explained here.

Click Apply to apply changes and OK to save changes.

1037
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3.3.1.8.11  Document Info Bar

 Document Info Bar

When the Document Info Bar tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Document Info Bar Tab Selected

Document Info Bars appear to alert users of specific information when documents are viewed/edited

in PDF-XChange Editor, as detailed in (figure 1).
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· Select/clear the upper check box to enable/disable Document Info Bars.

· Select/clear the eight remaining check boxes to enable/disable the associated Document Info

Bars.

· Click Reset to Default to reset all Document Info Bars to their default values.

Click Apply to apply changes and OK to save changes. A sample Document Info Bar is displayed

below: 

Figure 2. Form Document Info Bar
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3.3.1.8.12  File Associations

 File Associations

When the File Associations tab is selected the following options are available:

Figure 1. Preferences Dialog Box, File Associations Tab Selected

File associations are used to associate file types with applications capable of opening those file types.

The file association preferences in PDF-XChange Editor determine the settings for the PDF application

designated as the current application for PDF files. This file association settings for Windows can be



223

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

used to determine the current application for PDF files. PDF-XChange Editor is set as the default

application in (figure 1). 

· Use the dropdown menus to adjust the settings for the current application.

· Select the Apply changes only for current user box as desired. Click Apply to apply changes

for only the current user.

· The Notify when PDF-XChange Editor is not default PDF Application box is selected by

default. Clear the box to disable notifications.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.13  Forms

 Forms

When the Forms tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Forms Tab Selected

These settings determine the options for forms in PDF-XChange Editor. There are several forms

available in PDF-XChange Editor, which each feature different features and functionality. Further

information on forms is available here. 676
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The options in the General section are as follows:

· Select the Automatically calculate form field values box to perform form field calculations

automatically in forms that have been set up to perform calculations. Further information on

this process is available here.

· Select the Show focus rectangle box to enable the focus rectangle, which indicates the form

field that has focus when multiple fields are selected.

· Select the Show text overflow indicator box to enable the text overflow indicator, which is an

icon that appears when text exceeds the bounds specified when form fields are created.

The options in the Highlight Form Fields section are as follows:

· Select the Highlight Form Fields When Document Is Opened box as desired.

· Select the Highlight Required Fields Only box as desired. Fields designated as required must

be filled before documents can be submitted. See here  for information on how to designate

forms as required forms.

· Select the Show Hover Border for Fields box as desired. 

· Use the dropdown menus to select the Fill Color, Border Color and Hover Color for

highlighted forms.

· Select the Highlight All Form Fields option button as desired.

· Alternatively, select the Highlight Only Fields of Selected Types option button and then select

the desired forms to be highlighted when documents are opened.

Click Apply to apply changes and OK to save changes.

695
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3.3.1.8.14  Full Screen

 Full Screen

When the Full Screen tab is selected the following options are available::

Figure 1. Preferences Dialog Box, Full Screen Tab Selected

· The General settings determine parameters for full screen mode:

· Use the upper dropdown menu to determine what happens when documents request full

screen mode.
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· Use the lower dropdown menu to determine which monitor is used for full screen mode.

· Select the Stay awake box to prevent the computer from going into

screensaver/sleep/hibernate mode.

· The Pages Navigation settings determine navigation parameters for full screen mode:

· Select the Exit by pressing 'Esc' key box to enable the use of the Esc key to exit full

screen mode.

· Select the Show Pages Navigation Bar to enable the Page Navigation Toolbar  when

full screen mode is active.

· Select Presentation Mode to enable Presentation Mode when full screen is enabled.

This is a unique mode that is designed for giving presentations. When it is enabled the

following settings are active:

· Left-click moves to next page.

· Right-click moves to previous page.

· Press 'B' or 'W' to make the entire screen black or white.

· Press 'P' to pause/resume the automatic scrolling of documents.

· Commenting is disabled.

· Select the Loop after last page box repeat documents when the last page is reached and

Presentation Mode is enabled.

· Select the Automatically go to the next page after box to enable the automatic page-

browsing feature. Enter a value in number box to determine the rate of browsing.

· Select the Keep current page layout and zoom when switching to/from Full Screen

mode box to retain the page layout and zoom settings when moving to/from full screen

mode.

· The Appearance settings determine further options of the software when full-screen mode is

enabled:

· Use the Background color dropdown menu to determine a background color when full

screen mode is enabled.

· Select the Use solid background box set a solid background color in full screen mode.

· Select an option from the Mouse Cursor dropdown menu to determine the setting for

the mouse cursor in full screen mode.

· Select/clear the Show page border and shadow box as desired.

· The Page Transition settings determine the page transition settings:

· Select the Always use default transition box to use the transition determined in the

dropdown menu immediately below. 

· Select an option from the Default Transition menu to determine the page transition

style in full screen mode.

· Use the Direction dropdown menu to determine the direction of the transition style

selected in the Default transition dropdown menu.

Click Apply to apply changes and OK to save changes.

1049
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3.3.1.8.15  Identity

 Identity

When the Identity tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Identity Tab Selected

The Identity text boxes store user information for use in comments, comment reviews and digital

signatures. Enter details into the text boxes as desired.
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Click Apply to apply changes and OK to save changes.
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3.3.1.8.16  JavaScript

 JavaScript

When the Javascript tab is selected the following options are available:

Figure 1. Preferences Dialog Box, JavaScript Tab Selected

These settings determine the JavaScript options in PDF-XChange Editor:

· Select the check boxes as desired in the JavaScript section. 
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· Select the Enable Javascript Interactive Console box to enable the JavaScript Console, which

is detailed here.

· Select the Show Console on Errors and Messages box to activate the console when JavaScript

encounters errors.

· Select the Syntax Highlighting box to highlight syntax entered into the JavaScript Console.

· Use the Console Font and Font Size menus to determine font settings in the JavaScript

Console.

Click Apply to apply changes and OK to save changes.

834
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3.3.1.8.17  Languages

 Languages

When the Languages tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Languages Tab Selected

· Use the language pane to set the language for the user interface of PDF-XChange Editor.

· Click Set as Default to set the selected language as the default language.

· See here for further information on languages in PDF-XChange Editor.

https://www.pdf-xchange.com/editor_lang
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Click Apply to apply changes and OK to save changes.
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3.3.1.8.18  Launch Applications

 Launch Applications

When the Launch Applications tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Launch Applications Tab Selected

This pane displays the list of third-party applications currently available in the Launch Applications

Toolbar.  This toolbar provides a convenient way to open active documents using third-party

applications.

1047
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· Click New to add a new application. The dialog box in (figure 2) will open. Follow the

instructions below (figure 2) to determine options when adding new applications.

· Click Edit to edit the selected application.

· Click Make Current to set the selected application as the default application.

· Use the arrows to move selected launch applications up or down in the window. 

· Click Remove to remove selected applications.

· Select the Hide applications that are detected automatically box as desired.

Figure 2. New Launch Application Dialog Box

· Enter a name for the launch application in the Name text box.

· Enter the path executable in the Path text box, or use the folder icon to select the application

manually. 

· Use the Parameters text box to add additional parameters to new applications. These

parameters are variables that result in the retention of specific document values when

documents are opened in third-party applications via the Launch Applications Toolbar. All

available parameters are macros.  'Macro' is an abbreviation of 'macroinstruction' - a term in

computer science for a rule that specifies how input characters should be entered to create

corresponding output. Enter macros in the Parameters text box as desired. Alternatively, use

the dropdown icon to select macros manually. The following parameters are available for most

applications:

· File name, which uses the syntax %1 and inherits the file name and path. This is the only

parameter that is required in all cases and it must be contained in double quotation

marks.

· Zoom, which uses the syntax %z and inherits the zoom level.

· Page Number, which uses the syntax %p and inherits the current page number.

1166
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· Page (0-base numeration), which uses the syntax %p0 and inherits the first numerical

page number that starts at 01, 02 etc.

· Position X (in pixels), which uses the syntax %vx and inherits the position viewed along

the x axis in pixels.

· Position Y (in pixels), which uses the syntax %vy and inherits the position viewed along

the y axis in pixels.

· Position X (in pt), which uses the syntax %px and inherits the position viewed along the

x axis in points.

· Position Y (in pt), which uses the syntax %py and inherits the position viewed along the

y axis in points.

· View Rotation, which uses the syntax %vr and inherits the rotation value of documents.

· Additional macros to those detailed above are available, but it is necessary to use the launch

commands of the application in question. For example, if PDF-XChange Viewer is being used,

the launch command to open a file to a specific page is /A "page=<page_number>".

Therefore the parameter /A "page=%p" "%1" can be used, where the desired page number is

entered as the %p variable and the file name is entered as the %1 variable. If more than one

parameter is being used then parameters must be separated with an "&" symbol. Please note

that some applications may not support the use of parameters.

Click OK to add new applications.
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3.3.1.8.19  Measurement

 Measurement

When the Measurement tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Measurement Tab Selected

These options determine the units of measurement and certain feature layout options in PDF-XChange

Editor:
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· Use the Units and Rulers dropdown menu to determine the units of measurement. 

· Select the Show Rulers box to enable document rulers.

· Select the Show Fractions box to enable fractions in units of measurement. 

· Use the Grids and Guides section to determine the layout and color of document grids/guides.

These features are used to assist in document editing, as detailed here.

· Select the Use Snapping box to enable snapping, which assists in the precise placement of

document content, as detailed in (figure 4) below.

· Click Nudge to determine the settings for the nudge feature, which is used to manually adjust

the position of selected document content/comments:

Figure 2. Nudge Settings Dialog Box

· Enter the desired value and units of measurement in the Normal dropdown menus to

determine the standard nudge size. Selected content will be moved according to these

dimensions when the arrow keys are used.

· Enter the desired value and units of measurement in the Super dropdown menus to determine

the 'super' nudge size. Selected content will be moved according to these dimensions when

Shift is pressed and the arrow keys are used.

· Enter the desired value and units of measurement in the Micro dropdown menus to determine

the 'micro' nudge size. Selected content will be moved according to these dimensions when

Ctrl+Shift are pressed and the arrow keys are used.

· Click Snapping to customize snapping parameters:

450
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Figure 3. Customize Snapping Dialog Box

· Select the Show Snap location marks box as desired.

· Use the Grid settings to determine how objects in the document interact with grids:

· Select the Snap to Grid box to align objects with the nearest grid line when they are

moved.

· Select the Snap only to Grids Intersections box to align objects to only the grid

intersections.

· Select the Snap to Guides box to snap objects to guide lines when they are moved.  

· Use the Threshold menu to determine the level of sensitivity for guide lines.

· Use the Objects settings to determine how snapping operates in conjunction with objects:

· Select the Snap to Objects box to enable snapping to objects.

· Select the Snap to Annotations Only box to enable snapping to only annotations and

not other objects. 

· Use the Threshold menu to determine the level of sensitivity for snapping to objects.
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· Select the check boxes in the Snap to menu to determine at which points snapping is enabled

for objects.

Click OK to save settings. Then, in the Preferences dialog box, click Apply to apply changes and OK to

save changes.

Figure 4. Active Snapping Feature
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3.3.1.8.20  Measurement 3D

 Measurement 3D

When the Measurement tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Measurement 3D Tab Selected

· Select the Use Scale and Units from Model box to the the scale and units in cases where they

are present for the current document.
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· Select the Use default display unit box to specify a default measurement unit, then select the

desired unit of measurement in the adjacent dropdown menu.

· Use the Significant Digits to Display dropdown menu to determine how many decimal places

are displayed for 3D measurements.

· Use the Measure Font Size dropdown menu to determine the font size used for measurements.

· Use the 3D Measuring Line Color dropdown menu to determine the color used for 3D

measurement lines.

· Use the Snap Hint Color dropdown menu to determine the color used for snapping hints.

· Use the Angular Measurements Shown In dropdown menu to determine the units of

measurement used for angular measurements.

· Use the Circular Measurements Shown As dropdown menu to determine the units of

measurement used for circular measurements.

· Select the Show Circle for Radial Measurements check box to enable/disable the display of

the circle for radial measurements. 
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3.3.1.8.21  Multimedia 3D

 Multimedia 3D

When Multimedia 3D tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Multimedia 3D Tab Selected

· Select the Enable 3D Content box to enable 3D content in documents. Note that only U3D

content is supported at the moment.

· Use the Renderer Options to determine how 3D content is rendered:
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· Select an option in the Rendering Engine dropdown menu to determine the rendering

engine used.

· Select an option in the Framerate dropdown menu to determine the frames per second

for 3D content.

· Select an option in the Anti-Aliasing dropdown menu to determine the level of anti-

aliasing, which reduces the level of distortion that is sometimes seen in 3D images. Note

that increasing the level of anti-aliasing requires more memory.

· Select/clear the Show 3D axes box to display/hide 3D axes as desired.

· Select an option in the Pick Mode dropdown menu to determine the order in which 3D objects

are selected.

· Select a Highlight Color as desired.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.22  OCR

 OCR

When OCR tab is selected the following options are available:

Figure 1. Preferences Dialog Box, OCR Tab Selected

Note that two optical character recognition engines are available in PDF-XChange Editor: the Default

OCR engine and the Enhanced OCR engine, which is available when PDF-Exchange Editor Plus is

purchased (either as a stand-alone product or as part of the PDF-XChange PRO bundle). The
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Enhanced OCR engine is faster, more accurate and more dynamic than the default OCR engine, and it

also contains some extra features. Further information about the Enhanced OCR engine is available

here.

· Use the dropdown menu to select either the Enhanced or Default OCR engine.

· Click Add/Update languages to view/download/uninstall languages to use in conjunction with

the OCR features of PDF-XChange Editor.

Click Apply to apply changes and OK to save changes.

https://www.pdf-xchange.com/product/ocr-plugin
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3.3.1.8.23  Performance

 Performance

When the Performance tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Performance Tab Selected

· Use the Cache settings to determine how much system memory PDF-XChange Editor is

permitted to use:
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· Select an option from the Use system memory (in percentage points) menu to set

memory usage to Automatic or one of the listed percentages of total system memory.

· Select an option from the Use system memory (in megabytes) menu to set memory

usage in megabytes.

· Use the dropdown menu to determine the maximum lifespan of cached data that is not

being used. Note that selecting Auto will result in the optimal setting for your hardware.

· Please note that increasing memory usage will improve the performance of PDF-

XChange Editor, but may also impact overall system performance.

Use the Threads dropdown menus to determine how many threads are used for page rendering and

thumbnail creation, and the maximum amount of working threads at any given moment. 

Click Apply to apply changes and OK to save changes.
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3.3.1.8.24  Places

 Places

When the Places tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Places Tab Selected

· Use the Delete Places on Exit dropdown menu to determine what happens to places when

PDF-XChange Editor is closed:

· No retains all places when PDF-XChange Editor is closed.
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· All deletes all places when PDF-XChange Editor is closed.

· Only Newly Added deletes only places that have been recently added when PDF-

XChange Editor is closed.

· Use the Action for related History/Recents items when Place(s) deleting dropdown menu to

determine what happens to items in the history/recents lists when the places from which they

came are deleted:

· Ask for Delete displays a message and prompts the user for action to take.

· Delete means that associated items will be removed from the History/Recents lists.

· Keep means that associated items will be retained in the History/Recents lists.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.25  Plugins

 Plugins

When the Plugins tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Plugins Tab Selected

This dialog box shows plugins available for PDF-XChange Editor:

· Select plugins to view their details in the Plugin information section. The following plugins are

available:
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· Azure RMS Plugin - the plugin for handling PDF files protected by MS Azure RMS.

· Bookmarks Plugin – the plugin that facilitates the inclusion of advanced functionality for

bookmarks. 

· Box.com Access Plugin – the plugin that enables working with files located on Box.com.

· PDF Color Converter Plugin – the plugin that enables the conversion of colors in PDF

documents.

· PDF to MS-Office Converters Plugin – the plugin that allows the conversion of

documents into MS Office formats.

· CSV to PDF Plugin – the plugin that enables the conversion of .csv files to tables in PDF

documents.

· DropBox Plugin – the plugin that enables the software to work in conjunction with files

located on the Dropbox cloud.

· Enhanced OCR (FineReader) Plugin – facilitates the use of the enhanced OCR features. 

· File Open Client Plugin – the security plugin that handles FileOpen DRM.

· Google Drive Access Plugin – the plugin that allows the software to work with files

located on Google Drive cloud storage.

· Identify Form Fields Plugin - the plugin that enables the identification and conversion

of form fields. 

· Markdown to PDF Plugin – the plugin that enables the conversion of Markdown files

into PDF documents.

· OCR Plugin – facilitates the use of the default OCR features.

· OneDrive Access Plugin – the plugin that enables working with files located on

Microsoft OneDrive.

· PDF/A Converter Plugin – the plugin that converts PDF files into PDF/A format.

· PDF Optimizer Plugin – the plugin that optimizes PDF files.

· Read Out Loud Plugin – the plugin that provides read-out-loud functionality.

· Sanitize Plugin – the plugin that enables the sanitization of documents.

· SharePoint Plugin – the plugin that allows the software to work with files located on

Sharepoint/Office 365 servers.

· Spell Checker Plugin – the spell-checker plugin.

· U3DPlugin – the plugin that enables the viewing of embedded 3D content in PDF

documents.

· Click the Enable/Disable buttons to enable/disable selected plugins. 

· Click More Plugins to view further information about plugins from PDF-XChange.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.26  Scanner Presets

 Scanner Presets

When the Scanner Presets tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Scanner Presets Tab Selected

These settings determine the presets for scanning:

· Click the Scanner Settings menu to select a preset scanning mode or a saved profile.
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· Click the Scanner menu to select a scanner to use. 

· Click the Data Transfer Method menu to select either Native Mode or Memory Mode:

· Native Mode uses a single memory buffer. This is the default and fastest

mode, and is compatible with the broadest range of scanners.

· Memory Mode enables the use of multiple memory buffers. This is a useful

function in cases where memory is low and/or when large images are being

scanned.

· The Show Native UI box is selected by default, which means the user interface of

the device driver is used. This is the most reliable option, and the scanner will select

certain parameters of the scan itself: Color Mode, Resolution, Paper Size and

Source. Clear the Show Native UI box to customize these options:

· Color Mode has four options: Auto detect, Color, Grayscale and Black & White.

· Click the Resolution menu to select the DPI (dots per inch) of scanned documents.

· Paper Size refers to the size of the paper used when scanning. Click Setup for further

options:

· Automatic determines the paper size automatically.

· Standard contains standard sizes such as those used by the ISO and ANSI.

· Custom can be used to enter custom dimensions.

· Source has three options Auto, Flatbed and Feeder. These refer to the type of scanner

used for scanning.

· Click the Sides menu to determine which sides of documents are scanned. There are three

options: Simple Scan, Manual Duplex and Manual Duplex Reversed. Click the dropdown

arrow for an explanation of these options.

· Click the Scan More Pages menu to select the setting for when additional pages are scanned.

· Select the Before scanning, show Scan Properties dialog box to view/edit scan properties

before scans take place.

· Select the After scanning, show images insertion dialog box to view/edit the images

insertion dialog box after the scan has taken place. This dialog box enables image

customization.

· Click the Images Insertion Options button to determine further options for inserted images.

Those options are explained here.

Use the Scanner Settings menu to save custom settings. Click Save Current Settings to create a

custom profile for subsequent use. Click Manage to manage previously saved profiles and Delete to

remove the profile currently selected.

Click Apply to apply changes and OK to save changes.

141
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3.3.1.8.27  Search Providers

 Search Providers

When the Search Providers tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Search Providers Tab Selected

This pane displays a list of available search providers. These search providers are used to search the

internet for text selected with the Select Text Tool in the current document. Select the desired text with
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the Select Text Tool and then right-click the text and click Internet Search By to select the desired

search provider. 

The Search Providers preferences dialog box contains the following options:

· Click New to add a new search provider. 

· Click Edit to edit the selected search provider.

· Click Make Current to set the selected search provider as the default search provider.

· Use the arrows to move the selected search provider up or down in the display window.

· Click Remove to remove the selected search provider.

· Select the Turn off all search providers box to disable all search providers.

· Select the Allow obtaining icons for search providers from the Internet option to permit the

software to obtain search provider icons.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.28  Security

 Security

When the Security tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Security Tab Selected

The Security settings are used to determine the actions that PDF-XChange Editor takes when

documents attempt to open files/attachments/sites:
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· There are four options when the software is opening a file or an attachment:

· Use Trusted/Untrusted list, which can be specified using the Trusted/Untrusted

locations and names text box. If the file/attachment is not specified then PDF-XChange

Editor will prompt before opening.

· Prevent it, which prevents all files and attachments from being opened. The

Attachments Pane  can be used to open attachments when this option is enabled.

· Allow it, which allows all files and attachments to be opened.

· Allow PDF(s) and use Trusted/Untrusted list for other, which allows all PDF

files/attachments to be opened and refers to the Trusted/Untrusted list for other

formats. If a file/attachment is not specified in the list then PDF-XChange Editor will

prompt before opening it.

· There are three options when the software is opening a site:

· Use Trusted/Untrusted list, which can be specified using the Trusted/Untrusted

locations and names text box. If the site is not specified in the list then PDF-XChange

Editor will prompt before opening it.

· Prevent it, which prevents all sites from opening.

· Allow it, which allows all sites to be opened.

Use the Trusted/Untrusted locations and names window to determine trusted and untrusted

elements. Click Add to add new elements. The following menu will be displayed:

Figure 2. Add Trusted/Untrusted Options

· Click Add File to launch the Add File dialog box and add files from the local computer. 

· Click Add Folder to launch the Add Folder dialog box and add folders from the local

computer.

· Click Add Host to launch the Add New Trusted/Untrusted Item dialog box. Enter the internet

address of the desired host and select Trusted or Untrusted as required, then click OK to save

the host.

· Click Add File/Host Name Pattern to specify a text pattern as either Trusted or Untrusted.

Text patterns can include any text but are intended for use with file extensions.

Click Apply to apply changes and OK to save changes.

Additional security options are available here.

363

182



260

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual



261

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.1.8.29  Send Mail

 Send Mail

When the Send Mail tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Send Mail Tab Selected

These settings determine parameters for the Send by Email  feature of PDF-XChange Editor.

Existing email methods are displayed in the Available Methods pane.

177
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· Click New to add new email methods. Select Custom SMTP, Yahoo SMTP, Hotmail SMTP,

Outlook SMTP, GMX SMTP, Mail.ru SMTP, GMail Webmail, Outlook Webmail or GMail

Send as desired. Please note that the GMail Send option operates via GMail SMTP and does

not open your webmail when the Send by Email  feature is used. It uses your GMail

credentials to email silently via Google's SMTP, which requires SMTP to be enabled in your

GMail account, as detailed here.

· Click Edit to edit selected email methods.

· Click Make Current to enable the selected email method.

· Click Remove to remove the selected email method.

· Use the Default Subject text box to determine an automated subject line of emails. Macros

 are enabled for this option.

· Select the Pack File Attachments box to pack email attachments as ZIP files.

Click Apply to apply changes and OK to save changes.

177

1166

https://www.pdf-xchange.com/knowledgebase/513-Why-cant-I-use-Gmail-in-the-Send-by-Email-feature-of-PDF-XChange-Editor
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3.3.1.8.30  SharePoint

 SharePoint

When the SharePoint tab is selected the following options are available:

Figure 1. Preferences Dialog Box, SharePoint Tab Selected

Use the dropdown menus and check boxes to determine parameters as desired, then click Apply to

apply changes and OK to save changes.
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3.3.1.8.31  Signatures

 Signatures

When the Signatures tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Signatures Tab Selected

These options determine the settings for digital signatures:
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· The Creation & Appearance settings determine the options detailed in (figure 2) below. Click

More to access these settings.

· The Verification settings determine how and when signatures are verified. Click More to access

these settings, then select the check boxes as desired.

· Select the "Show Save As..." box to enable/disable the display of the Save As dialog box

when signing documents. Select one of the radio buttons below the check box to determine

when the Save As dialog box is displayed.

Figure 2. Creation and Appearance Dialog Box

The Creation settings are as follows:

· Select an option from the Default Signing Method menu to determine the default signing

method settings.  

· Select an option from the Default Signing Format menu to determine the signing format.

· PKCS#7 - Detatched encodes certificates in Abstract Syntax Notation One (ASN.1)

format. 

· CAdES is an electronic signature created in compliance with eIDAS and has the same

legal value as a handwritten signature.

· Select the Include signature's revocation status box as desired. The revocation status of the

signature will be shown in the main window when this option is enabled. Signatures are long-

term validation enabled when this option is selected.

· Select the Flush PIN cache before applying signature box as desired.

· Click the More button to set the Digital Sign Appearance Templates:
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Figure 3. Digital Signature Appearance Templates Dialog Box

· Select signature templates, then select Clone/Reset/Edit as desired:

· Click Clone to clone the selected signature template. This is a useful feature if parameters of

existing signature templates need to be changed and saved without editing the original

template.

· Click Reset to revert the values of the the selected signature template to its default state. 

· Click Edit to adjust the values of the selected signature template:
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Figure 4. Edit Template of Digital Sign Dialog Box

· Use the Template Name text box to edit the name of the signature template.

· Use the Icon dropdown menu to specify the icon used with the signature, and use the adjacent

Font dropdown menu to specify the font used.

· Use the Background Logo dropdown menu to specify the logo used with the signature, and

use the adjacent Opacity number box to specify the transparency level of the background.

· Use the Display Text check box options to specify the text that is displayed with the signature.

Click OK to save changes.
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3.3.1.8.32  Snapshot Tool

 Snapshot Tool

The Snapshot Tool is used to take document snapshots. When the Snapshot Tool tab is selected the

following options are available:

Figure 1. Preferences Dialog Box, Snapshot Tool Tab Selected

The Image Copy Options determine the settings for images that the Snapshot tool produces:
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· Use the Resolution dropdown menu to specify the image resolution for snapshots.

· Select the Force snapshot images to grayscale box as desired.

· Select the Automatically copy image to clipboard, after move or resize box as desired.

· Use the Select All type dropdown menu to determine the Select All setting. This option is

available in the right-click shortcut menu when the Snapshot Tool is selected. The options are:

· Select nearest whole page, which takes a snapshot of the nearest whole page.

· Select visible portion of nearest page, which takes a snapshot of the visible portion of

the nearest page.

· Select the check boxes in the Notifications section as desired.

Click Apply to apply changes and OK to save changes.
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3.3.1.8.33  Speech

 Speech

When the Speech tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Speech Tab Selected

These settings determine the options for the read out loud feature of PDF-XChange Editor: 
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· Select the Use default voice box as desired. Clear this box to choose an alternative voice from

the Voice menu. 

· Select the Use default speech attributes box as desired. Clear this box to adjust the Pitch and

Rate settings.

· Select the Read comments and Read Form Fields boxes as required.

· Use the Test text box to test customized settings. Enter sample text into the text box and click

Read this text to test settings.

Instructions on how to use the Read Out Loud feature are available here.

Click Apply to apply changes and OK to save changes.

1286
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3.3.1.8.34  Tools

 Tools

When the Tools tab is selected the following options are available::

Figure 1. Preferences Dialog Box, Tools Tab Selected

· Use the Default Tool menu to select the default tool in PDF-XChange Editor.

· Select the upper check box to retain the active tool between sessions.

· Select the lower check box to retain the active tool when new documents are opened.
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Click Apply to apply changes and OK to save changes.
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3.3.1.8.35  Update

 Update

The Update tab is used to check for software updates. Click Check for Updates Now to search for

updates. 
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3.3.1.9 Manage Settings

 Manage Settings

Click Manage Settings to Export/Import/Reset settings in PDF-XChange Editor:

Figure 1. File Tab Submenu, Manage Settings

The following options will be displayed:
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Figure 2. Manage Settings Options

Export Settings

Click Export Settings to export the current settings of PDF-XChange Editor to a data file. The Export

Settings Options dialog box will open:
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Figure 2. Export Settings Options Dialog Box

Select the settings to be exported and click OK to export.

Import Settings

Click Import Settings to import saved settings. The Import Settings from File dialog box will open.

Select the desired settings file and click Open. The Import Settings Options dialog box will open:
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Figure 3. Import Settings Options Dialog Box

Select the desired settings and click OK to import.

Reset Settings

Click Reset Settings to revert the current settings of PDF-XChange Editor to their default values. The

following dialog box will be displayed:
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Figure 4. Reset Settings Options Dialog Box

Select the desired settings and click OK to reset them.
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3.3.2 Home Tab

 Home Tab

When the Home tab is selected, the following options are available:

Figure 1. Home Tab

There are five groups in the Home tab:

Tools

The Tools group contains the most commonly-used tools:



282

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 2. Tools Group

· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· The Select Comments Tool is used to select and edit comments. Click to enable the Select

Comments Tool, then click to select comments. Click and drag to select multiple comments.

Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to enable

the Snapshot Tool, then click or click and drag to take snapshots. Further information about

this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content of the

clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

View

The View group contains the most commonly-used viewing commands:

Figure 3. View Group
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Use the  Zoom feature to change the level of zoom. Click the plus and

minus icons, select an option in the dropdown menu or enter a value manually to change the

zoom level.

Click  Actual Size to set the zoom level to 100% and view pages at their actual size.

Click  Fit Page to fit the page length to the editing space of the user interface.

Click  Fit Width to fit the page width to the editing space of the user interface.

Click  Fit Visible to fit the page width to the editing space of the user interface and ignore

white page margins.

Click  Rotate CCW  to rotate the current view ninety degrees counter-clockwise.

Click  Rotate CW  to rotate the current view ninety degrees clockwise.

Click  Bookmarks to show/hide the Bookmarks  pane, which is used to create/edit

bookmarks.

Click  Thumbnails to show/hide the Thumbnails  pane, which is used to used to view/edit

document pages.

Click   Comments to show/hide the Comments  pane, which is used to view/edit

comments.

Click  Attachments to show/hide the Attachments  pane, which is used to view/edit

attachments to the current document.

Click  Content to show/hide the Content  pane, which is used to view/edit base content.

Click  Properties to show/hide the Properties  pane, which is used to view/edit the

properties of selected items.

Objects

The Objects group contains options for adding and editing document content:

Figure 4. Objects Group

· Click Edit to edit base content and images. Further information about this feature is available

here.
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· Click Add to add content to documents. Use the dropdown menu to select Text, Image or

Barcode as desired. Further information on these options is available here.

· Click Selection to edit/interact with the content currently selected in the document. Further

information about this feature is available here.

Comment

The Comment group contains options for adding comments to documents:

Figure 5. Comment Group

· Click Typewriter to add a typewriter-style comment to documents, as detailed here.

· Click Sticky Note to add a sticky note comment to documents, as detailed here.

· Click Highlight to highlight document text, as detailed here.

· Click Arrow to add arrow annotations to documents, as detailed here.

· Click Underline to underline document text, as detailed here.

· Click Rectangle to add rectangle annotations to documents, as detailed here.

· Click Stamp to add stamps to documents, as detailed here.

Right-click options to view/select preset comment styles.

Links

The Links group contains options for creating links/bookmarks:

Figure 6. Links Group

· Click Weblinks to create/remove weblinks in the current document. Note that weblinks are

created from existing URLs in the document when the Create Weblinks option is used. Further

information about this feature is available here.

· Click Add/Edit Links to add/edit links in the active document. A range of additional actions

can be added to links, as detailed here.
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· Click Add Bookmark to create a new bookmark from the current document location. Further

information about bookmarks is available here.

Protect

The Protect group contains one option:

Figure 7. Protect Group

Click Sign Document to add a digital signature to documents. Further information about this feature is

available here.
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3.3.2.1 Hand Tool

 Hand Tool

The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. It is located in the upper-left section of the UI in several of the tabs:

Figure 1. Home Tab, Hand Tool Highlighted

Click to enable the Hand Tool, then click and drag the page in the desired scrolling direction in order

to browse through documents. When the Hand Tool is selected, click the Format tab to customize how

the tool operates:
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Figure 2. Hand Tool, Format Tab

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the Hand

Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to click on areas that overlap with

other content and navigate through documents without the risk of accidentally selecting

undesired items. When Exclusive Mode is disabled, the pointer recognizes and interacts with

all underlying elements in the usual manner.

· Click Inertial Scroll to enable inertial scroll. When this feature is enabled, document pages will

continue to scroll and come to a stop gradually after scrolling actions are performed. When it is

disabled document pages will scroll in synchronization with the pointer.

· Click Select Text/Images to enable the selection of text and images with the Hand Tool. The

tool will then be able to select text/images when it is hovered over text-based/image content,

and indicates that it is able to do so via a change in the cursor. Click and drag to select text, or

click to select images. Note that you can also double/triple/quadruple-click text to select

words/paragraphs/all document text. Click outside of selected text/images to cancel the

selection. If you are using a touch-based device then tap text to enable text-selection mode, or

tap images to select them. Touch outside selected text/images and then move and release in

order to cancel the selection mode. If the page has no regions that do not contain text/images,

touch on any image then move and release in order to cancel the selection mode, or simply tap
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outside of the page. Note that if you are using a touchscreen in conjunction with a

stylus/digitizer, then the behavior is identical to using a mouse in desktop mode.
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3.3.2.2 Selection Options

 Selection Options

Use the Selection dropdown menu to edit and manipulate selected content:

Figure 1. Selection Dropdown Menu

· Click Transform to edit the position, size and/or rotation of selected annotations/content

items, as detailed here.

· Click Duplicate to duplicate selected annotations/content items, as detailed here.

· Click Copy, Cut, Delete, Deselect or Zoom To Selection to perform these operations on

selected annotations/content items.
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· Click New Stamp from Selection to create a new stamp from selected annotations/content

items, as detailed here.

· Click New Document from Selection to create a new document from selected

annotations/content items, as detailed here.

· Click OCR Selected Region to perform optical character recognition on the selected region of

the document, as detailed here.
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3.3.2.3 Transform

 Transform

Click Transform to edit the position, size and/or rotation of selected annotations/content items:

Figure 1. Selection Submenu, Transform

The following dialog box will open:
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Figure 2. Transform Selection Dialog Box

· Click the boxes in the grid to view the current location of the corresponding points of the

selected content.

· Use the X and Y number boxes to determine the new positioning of the selected content. The X

value is the horizontal plane and the Y value is the vertical plane.

· Click the arrow in the Y box to enable/disable the bottom-up Y-axis. 

· Select the ∆X; ∆Y box to determine offset values relative to the current position of the selected

content.

· Use the Unit dropdown menu to select the units of measurement.

· Use the Width and Height boxes to adjust the size of the selected content.

· Use the Rotation box to adjust the rotation of the selected content.

· Use the Shear box to determine a shear angle. This will slant the selected object along a

horizontal axis.

Click OK to transform selected content.
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3.3.2.4 Duplicate

 Duplicate

Click Duplicate to duplicate selected annotations/content items:

Figure 1. Selection Submenu, Duplicate

The Duplicate Content Items dialog box will open:
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Figure 2. Duplicate Content Items Dialog Box

· Select the upper radio button to enable the duplication of selected content items and the

creation of a page offset between duplicates. The number entered in the upper number box

determines the page offset between the selected content item and duplicates created through

the process of duplication. The specified page offset will also be used between duplicates

when more than one duplicate is created. Enter a number in the lower number box to specify

the number of duplicates created.

· Select the lower radio button option to enable the duplication of selected content items to a

specified page range:

· Select All to duplicate across all pages.

· Select Current to duplicate to only the current page.

· Select Custom to duplicate to a custom page range, then enter the desired page range

in the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Use the Duplicates per Page dropdown menu to determine the number of duplicates

per page.

1285
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Use the Duplicate Options settings to determine duplicate parameters:

· Use the Horizontal Offset box to determine the horizontal offset in relation to the duplicated

content.

· Use the Vertical Offset box to determine the vertical offset in relation to the duplicated

content.

· Select the Place each selected page's content as an XForm box to place duplicated content

as an XForm.

Click OK to duplicate content.

https://en.wikipedia.org/wiki/XForms
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3.3.2.5 New Stamp from Selection

 New Stamp from Selection

Click New Stamp from Selection to create a new stamp from selected document content:

Figure 1. Selection Submenu, New Stamp from Selection

The Add New Stamp dialog box will open:
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Figure 2. Add New Stamp Dialog Box

· Enter a name for the stamp in the Stamp Title text box. Click the blue icon to add Macros

 as desired.

· Use the Target Collection dropdown menu to select the stamp collection in which the new

stamp will be located. Click Add New to create a new stamp collection.

· Created stamps can be used in conjunction with the Stamp Tool.

Click OK to create the new stamp.

1166

575
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3.3.2.6 New Document from Selection

 New Document from Selection

Click New Document from Selection to create a new document from selected document content: 

`
Figure 1. Edit Tab Submenu. New Document from Selection

The new document will be created automatically and then open in a new window in PDF-XChange

Editor.
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3.3.2.7 Link Options

 Link Options

Click the Web Links dropdown menu to view options for document weblinks:

Figure 1. Home Tab, Web Links Dropdown Menu

· Click Create Web-Links from URLs to convert existing page text URLs into clickable hyperlinks.

· Click Remove All Web-Links to remove existing hyperlinks from page text URLs.

Please note that it is necessary to disable the Create links from URLs in page text preference in the

Page Text preferences for these features to operate:
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Figure 2. Create Links from URLs in Page Text Preference Disabled

Create Links

Click Add/Edit Links to create links:
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Figure 3. Home Tab, Create Link

When this feature is enabled, the pointer becomes a crosshairs icon. Click and drag to determine the

size and location of the link. The Browse for Link Target dialog box will open:
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Figure 4. Link Creation Tool Example

· If the Ignore Zoom Level box is selected then PDF-XChange Editor will ignore the document

zoom level when links are created. If this box is cleared then the zoom level will update to the

zoom level that was present at the time of link creation when links are used.

· If the Use Zoom Mode box is selected then PDF-XChange Editor will ignore the active zoom

mode when links are created. If this box is cleared then the zoom mode will update to the

mode that was active at the time of link creation when links are used.

· Move to the desired link location and zoom level, then click Set Link to create the link.

· Note that when the Browse for Link Target dialog box is open, you can also click named

destinations in the Named Destinations  pane to specify them as the target for the link.

· Click Advanced to determine advanced settings for links. The Edit Action List dialog box will

open:

393
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Figure 5. Edit Actions List Dialog Box

· Click Add to add actions to the list. Actions will be executed when the link is selected. All

available actions are detailed below.

· Select actions and click Edit to adjust their settings.

· Click Add from Boomark to add 'Go to Page' actions using link targets from bookmarks.

· Click the arrow icons to move selected actions up or down in the list. 

· Click Remove to remove selected actions from the list.

· Note that it is possible to add multiple actions to the list. The order of actions in the Edit

Action List dialog box determines the order in which they are performed.

 The following actions are available:

· Run a JavaScript

· Go to Page Options  (Go To a Page in the Document, Go To a Page in Another

Document and Go To a Page in an Embedded Document).

· Open a Web Link

· Open a File

· Execute a Command

· Reset a Form

· Submit a Form

· Play a Sound

· Go to a 3D/Multimedia View

· Show/Hide a Field

· Set Layer Visibility
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· Read an Article

Note that it is possible to edit links after they have been created. Click Add/Edit Link in the Home tab,

then click to select the link and then click the Format tab:

Figure 6. Selected Link

· Click and drag the yellow control points to resize links.

· Click and drag link boxes, or use the arrow keys, to reposition links. Hold down Shift to move at

an increased increment when using the arrow keys.

· Use the editing aids detailed here  to assist in the precise placement of links.

· Right-click links for further options. See here  for an explanation of these options.

· Use the options in the Format tab to customize the appearance of links:

· Click Stroke Color to determine the color of the link border. Note that it is necessary to

adjust the width of link borders in order for the color to be visible.

· Click Border Width to determine the width of the link border.

· Click Border Style to determine the style of the link border.

· Click Highlight Mode to determine the visual effect when the link is clicked.

· Use the Style Tools to copy/apply link tool styles:

· Click Copy Comment Style to copy the style properties of selected link

annotations.

450

1130
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· Click Apply Copied Comment Style to apply a copied link style to the selected link

annotation.

· Click Apply Copied Comment Appearance to apply copied comment properties

to the selected content.

· Click Make Current Properties Default to set the properties of the selected

annotation as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default link annotation properties to

the selected link annotation.

· The layer to which the link belongs is detailed in the Optional Content tab. Click Current

Layer to move the link to a different layer. Further information about layers is available

here.

· Click Properties to view/edit additional link properties, as detailed below:

Figure 7. Link Properties Pane

· Printable is the print status of the link. If this property is enabled then the link is printed with

the document. If this property is not enabled then the link is not printed.

· Locked is the locked status of the link. If this property is enabled then the link cannot be

deleted and its properties (including its position and size) cannot be modified by users.

· Layer specifies the optional content layer to which the link belongs. Further information about

layers is available here.

374
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· Stroke Color determines the border color of the link.

· Border Style determines the border style of the link

· Border Width determines the border width of the link.

· Highlight determines the visual effect when the link is clicked.

· Mouse Up determines the action taken when the link is clicked. Click the ellipsis icon on the

right of the action to view/edit/add actions, as detailed above.

Please note that the Add/Edit Links Tool must be selected in order to edit/delete links. It is also

possible to press Ctrl+A in order to select all links in the current document when this tool is enabled.
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3.3.2.7.1  Run a JavaScript

 Run a JavaScript

This action executes JavaScript when links are clicked: 

Figure 1. Edit Action List Dialog Box, Run a JavaScript

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Run a JavaScript" Dialog Box

Enter the desired JavaScript and click OK to save.
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3.3.2.7.2  Go To Page Options

 Go To Page Options

There are three Go To Page options available for links:

Figure 1. Edit Action List Dialog Box, Go to Page Options

Go To a Page in the Document

This action moves the main window to a different document page when links are clicked. When it is

selected the following dialog box will open:
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Figure 2. Add Action: "Go to a Page in the Document" Dialog Box

· Click the plus/minus icons to zoom in on/out from the current view. 

· Click Use Current View to use the view currently displayed in the preview pane as the link

destination. Note that this option can be used to link to locations on the same page as the

parent link.

· Alternatively, use the Destination Properties options to select a page. Enter a page number or

use a Named Destination  to determine the destination:

· Select the Use Page Number option button to specify a page number as the link location. The

figures entered in the X and Y boxes determine the location on the horizontal and vertical

planes respectively. When this option is used it is also possible to determine the zoom level, or

use a rectangle to designate the destination:

· Select the Use Zoom Level option button to determine the level of zoom used in the link.

Use Inherit Zoom to save the zoom level used when creating the link.

· Use the Use Rectangle option button to use a rectangle as the link location. Enter values

for the Width and Height as desired.

393
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· Alternatively, select the Use Named Destination option button to select a named destination

to use as the link location, or click Add Current View to create a new named destination from

the current view.

· Note that you can use the Add from Bookmark option in the Edit Action List dialog box to

create Go To Page actions that use a link target taken from a bookmark.

Click OK to save settings.

Go To a Page in Another Document

This action moves the main window to a page in a different document when links are clicked. When it is

selected the Open Files dialog box will be displayed. Select the file and click Open. The Add Action:

"Go to a Page in Another Document" dialog box will open. The settings are the same as those

detailed in (figure 2).

Go To a Page in an Embedded Document

This action moves the main window to a different page in an embedded document when links are

clicked. When it is selected the Choose Root Document dialog box will be displayed. Select either

This document or Choose external document. (When an external document is used, enter the name

of the document in the text box or click the folder icon to select a document from the local computer).

The Add Action: "Go to a Page in Embedded Document" dialog box will open. The settings are the

same as those detailed in (figure 2).
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3.3.2.7.3  Open a Web Link

 Open a Web Link

This action launches a web link in the default browser when links are clicked:

Figure 1. Edit Action List Dialog Box, Open a Web Link

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Open a Web Link" Dialog Box

Enter the desired URL in the text box and then click OK to save the link.
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3.3.2.7.4  Open a File

 Open a File

This action opens a file when links are clicked:

Figure 1. Edit Action List Dialog Box, Open a File

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Open a File" Dialog Box

· Enter the name of the file to be opened in the File Name text box, or click Browse to select a

file from the local computer.

· Use the Open In menu to select where the file opens.

· Select either Open or Print in the Operation dropdown menu to determine whether the

designated file opens or prints when the link is clicked.

· Enter the directory of the file in the Directory text box, or click Browse to select a folder from

the local computer.

· Use the Parameters text box to include further parameters of the default program used to

open the file. Available parameters depend on the command line options available to the

program used.

Click OK to save settings.
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3.3.2.7.5  Execute a Command

 Execute a Command

This action executes a command when links are clicked:

Figure 1. Edit Action List Dialog Box, Execute a Command

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Execute a Command" Dialog Box

Click the dropdown arrow to view the list of available commands. Select commands and then click OK

to add them to the link. Note that multiple commands can be added as desired. The following

commands are available:

· AcroForm:Form Data_Export Data - exports form data to file.

· AcroForm:Form Data_Import Data - imports form data from a file.

· AcroSendMail:SendMail - emails a copy of the document to a recipient.

· ActualSize - sets the zoom level of the document to 100% and shows document pages at their

actual size.

· AddFileAttachment - adds an attachment to the document.

· Annots:Tool:InkMenuItem - enables the Pencil Tool for creating freehand annotations.

· AutoScroll - enables the autoscroll, which scrolls through documents automatically.

· COMP:AddBackground - adds a background to the document.

· COMP:HeadFoot - adds headers and footers to the document.

· COMP:AddWatermark - adds a watermark to the document.

· Clear - deletes the current selection.

· Close - closes the document.

· Copy - copies the current selection to the clipboard.

· CopyFileToClipboard - copies the name and path of the current document to the clipboard.

· CropPages - redefines the visible area of the document, and removes content outside of the

cropped area as desired.

· Cut - cuts the current selection from the document and copies it to the clipboard.

· DIGSIG:CertifyInvisible - certifies the document without adding a visible signature.

· DIGSIG:ClearAll - clears all digital signatures in the document.

· DIGSIG:NextSigPullRight - signs existing/creates and signs a new signature field.

· DIGSIG:SaveAndAuthenticateTask - certifies the document and adds a visible signature.

· DIGSIG:ValidateAll - validates all digital signatures in the document.

· DeleteEmptyPages - deletes empty pages from the document.

· DeletePages - deletes pages from the document.

· Editor:New - creates a new document.

· ExtractPages - extracts pages from the current document to other documents.

· Find - finds user-specified text in the current document.
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· FindCurrentBookmark - expands all parent bookmarks to ensure the visibility of

corresponding bookmarks.

· FindSearch - opens the advanced search pane.

· FirstPage - moves to the first page of the document.

· FitHeight - sets the zoom level so the height of the page fits the document window.

· FitPage - sets the zoom level so the page fits the document window.

· FitVisible - sets the zoom level so the page content fits the document window.

· FitWidth - sets the zoom so the width of the page matches the width of the document window.

· FullScreen - displays the document in full screen mode.

· GeneralInfo - displays the properties of the document.

· GeneralPrefs - displays the Preferences dialog box.

· GoBack - navigates one step backward in the document.

· GoBackDoc - navigates to the previous document.

· GoForward - navigates one step forwards in the document.

· GoForwardDoc - navigates to the next document.

· GoToPage - navigates to a specific page of the document.

· HandMenuItem - enables the Hand Tool for document navigation.

· InsertPages - inserts pages from a different document into the current document.

· LastPage - navigates to the last page of the document.

· LoupeMenuItem - launches the Loupe Tool to assist in viewing/editing documents.

· NewBookmark - creates a new bookmark that points to the current page.

· NextPage - navigates to the next page of the document.

· OneColumn - sets the viewing mode to display a single page continuously.

· Open - opens a document.

· PanAndZoomMenuItem - shows/hides the Pan and Zoom pane.

· Paste - pastes the current clipboard content into the document.

· PrevPage - navigates to the previous page of the document.

· Print - prints the current document.

· Property Toolbar - show the properties of selected objects.

· Quit - exits PDF-XChange Editor (and will prompt to save any unsaved changes in the current

document).

· Redo - redoes the last operation that was undone.

· ReplacePages - replaces pages in the current document with pages from a different document.

· Revert - reverts the current document to its original state.

· RotateCCW - rotates the current view counter-clockwise.

· RotateCW - rotates the current view clockwise.

· RotatePages - rotates pages in the current document.

· RotatePagesCCW - rotates selected pages ninety degrees counter-clockwise.

· RotatePagesCW - rotates selected pages ninety degrees clockwise.

· RotatePagesCW180 - rotates selected pages one hundred and eighty degrees.

· Save - saves the current document.

· SaveAs - saves the current document with a new name/location.

· Scan - creates a new document using custom scan options.
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· Scan:Create - inserts new pages into the current document from scanned image files.

· SelectAll - selects all items.

· ShowCoverPage - displays the first page of documents separately when two-page viewing

modes are enabled.

· ShowGaps - enables/disables the display of a gap between document pages.

· ShowGrid - enables the grid in order to assist with object placement in documents.

· ShowGuides - enables the guide line feature in order to assist with lining up objects in

documents such as annotations.

· ShowHideAnnotManager - shows/hides the Comments pane to view/edit document

comments.

· ShowHideArticles - shows/hides the Articles pane.

· ShowHideBookmarks - shows/hides the Bookmarks pane, to view/edit document bookmarks.

· ShowHideContentPanel - shows/hides the Content pane, to view/edit document content.

· ShowHideDestinations - shows/hides the Named Destinations pane, to view/edit named

destinations.

· ShowHideFileAttachment - shows/hides the Attachments pane, to view/edit attachments in

the document.

· ShowHideLinks - shows/hides the Links pane, to view/edit links in the document.

· ShowHideOptCont - shows/hides the Layers pane, to view/edit optional content layers in the

document.

· ShowHideSignatures - shows/hides the Signatures pane, to view/edit signatures in the

document.

· ShowHideThumbnails - shows/hides the Thumbnails pane, to view/edit thumbnails in the

document.

· ShowRulers - shows/hides the rulers in order to assist in measuring document objects.

· SinglePage - toggles the single-page mode and displays document pages one at a time.

· SnapToGrid - enables the snap to grid setting, which means that document content will align

to the grid when it is moved manually.

· TwoColumns - sets the viewing mode to display two pages continuously.

· TwoPages - sets the page-viewing mode to display two pages side-by-side.

· Undo - undoes the most recent action.

· ZoomTo - sets a custom zoom level for the document.

· ZoomViewIn - zooms in on the page.

· ZoomViewOut - zooms out from the page.
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3.3.2.7.6  Reset a Form

 Reset a Form

This action resets form data when links are clicked:

Figure 1. Edit Action List Dialog Box, Reset a Form

Form data is information entered into fillable forms, which the Form  tab can be used to create in

PDF-XChange Editor. The following dialog box will open when this action is selected:

676
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Figure 2. Add Action: "Reset a Form" Dialog Box

· Click Select All to select all forms.

· Click Deselect All to deselect all forms.

· Click Invert Selection to invert the current form selection.

Click OK to save settings.
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3.3.2.7.7  Submit a Form

 Submit a Form

This action sends specified form data to a URL when links are clicked:

Figure 1. Edit Action List Dialog Box, Submit a Form

When it is selected the following dialog box will open:
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Figure 1. Add Action: "Submit a Form" Dialog Box

· Enter the desired URL in the text box. The specified form data will be sent to this address when

the link is clicked.

· All document forms are detailed in the Form-Field Selection pane. Use the check boxes to

select forms to be sent when the link is clicked.

· Click Select All to select all forms.

· Click Deselect All to deselect all forms.

· Click Invert Selection to invert the current form selection.

· Select the Exclude Selected and Include Empty Fields boxes as desired.

· Use the Export Format options to determine export format options: 

· Use the Type dropdown menu to determine the format of submitted content.

· Select the Convert dates to standard format box as desired.

· Select the Field Data, Comments and/or Incremental changes boxes as desired.

Selected elements will be included in the submitted content.
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Click OK to save settings.

Note that the Form  tab can be used to create/edit forms to use in conjunction with this feature.676
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3.3.2.7.8  Play a Sound

 Play a Sound

This action plays a sound when links are clicked:

Figure 1. Edit Action List Dialog Box, Play a Sound

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Play a Sound" Dialog Box

· Click the Browse button to select a sound file from the local computer. The Open Files dialog

box will open. Select the desired file and click Open. The selected sound file will play when the

link is clicked.

· Alternatively, click the record button to record a sound. Click again to finish the recording. Click

the play and stop buttons to review the sound. Use the volume slider to adjust the volume of

the sound. 

Click OK to save the file.
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3.3.2.7.9  Go to a 3D/Multimedia View

 Go to a 3D/Multimedia View

This action moves the main window to a specified 3D/multimedia view:

Figure 1. Edit Action List Dialog Box, Go to a 3D/Multimedia View

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Select 3D View" Dialog Box

· Select the 3D annotation you want the link to open in the Select 3D Annot list.

· Select the view of the 3D annotation you want the link to open in the Select 3D View list.

· Select Named View to specify a named view for the link to open, then select the desired view

in the pane.

Click OK to save settings.
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3.3.2.7.10  Show/Hide a Field

 Show/Hide a Field

This action is used to show/hide form fields when links are clicked:

Figure 1. Edit Action List Dialog Box, Show/Hide a Field

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Show/Hide a Field" Dialog Box

All document forms are detailed in the dialog box.

· Select forms and then click either Show or Hide as desired.

· Click Select All to select all forms.

· Click Deselect All to deselect all forms.

· Click Invert Selection to invert the current form selection.

 Click OK to save settings.



331

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.2.7.11  Set Layer Visibility

 Set Layer Visibility

This action is used to set layer visibility when links (or form fields/bookmarks that contain actions) are

clicked:

Figure 1. Edit Action List Dialog Box, Set Layer Visibility

When it is selected the following dialog box will open:
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Figure 2. Add Action: "Set Layer Visibility" Dialog Box

Available layers are detailed in the Available Layers pane. Please note the following:

· The Use dropdown menu can be used to specify either the use of All Layers in the document,

or only the layers presented in the Layers pane.

· The Select dropdown menu can be used to Select All layers, Visible layers or Hidden layers,

and also to invert the current selection of layers in the dialog box.

· When layers are selected in the Available Layers pane, click the lightbulb icons to move them

to the Affected Layers pane. Layers that are placed into the Affected Layers pane are the

layers that will be affected when the action executes.

· Click the activated lightbulb to enable the layer when the action executes.

· Click the deactivated lightbulb to disable the layer when the action executes.

· Click the semi-activated lightbulb to toggle the layer when the action executes. This

means that enabled layers will be disabled, and disabled layers will be activated in the

document when the action executes.

· Use the State dropdown menu to change the state of layers in the Affected Layers pane.

Additionally, the blue arrow icons can be used to move layers up or down in the Affected

Layers pane.

· Click Remove to remove layers from the Affected Layers pane.

· Click Simplify to simplify layer overrides in the Affected Layers pane.

· Select the Ignore Radio Button Groups box to ignore radio button groups when this feature is

used in conjunction with radio buttons.
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Click OK to save changes.
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3.3.2.7.12  Read an Article

 Read an Article

This action is not currently available. It will be added in a future build.
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3.3.3 View Tab

 View Tab

When the View Tab tab is selected, the following options are available:

Figure 1. View Tab

The options in the View tab are used to navigate and manipulate documents. There are five groups in

the View tab:
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Tools

The Tools group contains shortcuts to tools and other features:

· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Further

information about this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

Go To

286

1102

1087

462

269

1147 1295
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The Go To group contains options for navigating the current document:

· The number box displays the current page and the total number of pages in the active

document. Enter a page number and press Enter to move to it.

· Click  First Page to move to the first page of the active document.

· Click  Previous Page to move to the previous page.

· Click  Next Page to move the next page.

· Click  Last Page to move to the last page.

· Click  Previous View to move to the previous view of the current document.

· Click  Next View to move to the next view. This option is available when the Previous View

option has been used.

Zoom

The Zoom group contains options for adjusting the page view:

 

· Click  Actual Size to set the zoom level to 100% and view pages at their actual size.

· Click  Fit Page  to fit the page length to the editing space of the user interface.

· Click  Fit Width  to fit the page width to the editing space of the user interface.

· Click  Fit Visible  to fit the page width to the editing space of the user interface and ignore

white page margins.

· Click  Zoom In or  Zoom Out to zoom in on/out from the active document.

· Click  Continuous Zoom to enable the Continuous Zoom Tool, which allows you to zoom

in/out continuously. When this tool is enabled, click and hold the mouse button and then move

the mouse up/down to scroll in/out.
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· Click  Zoom In/Out Tool to zoom in on/out from the active document. The pointer

becomes a magnifying glass icon when this tool is enabled. Move it to the desired location and

then click to zoom. Hold down Ctrl and click to zoom out.

· Click  Loupe Tool to enable the Loupe Tool, which utilizes a zoom pane that magnifies

page portions to assist in document editing. Further information on this tool is available

here.

· Click  Pan and Zoom Tool to enable the Pan and Zoom Tool, which utilizes a zoom pane

that enables dynamic page navigation. Further information on this tool is available here.

Page Display

The Page Display group contains options for adjusting the page display:

· Click Rotate View to view rotation options:

· Click Rotate CCW to rotate the current view ninety degrees counter-clockwise.

· Click Rotate CW to rotate the current view ninety degrees clockwise.

Please note that rotations are intended for viewing/editing purposes only and will not be saved. (The

Rotate Pages  feature can be used to rotate pages permanently).

· Click  Single Page to display documents one page at a time.

· Click  Continuous to display documents one page at a time continuously.

· Click  Two Pages to display documents two pages at a time.

· Click  Two Pages Continuous to display documents two pages at a time continuously.

· Click  Show Gaps Between Pages to enable/display the display of gaps between pages.

· Click  Show Cover Page in Two Pages View to include/exclude the first page of

documents in Two Pages/Two Pages Continuous layout when these modes are enabled.

· Click  Right-to-Left Page Layout to enable/disable right-to-left page layout when the

Two Pages/Two Pages Continuous modes are enabled.

· Click  Page Layout to switch between Standard Layout, which displays pages in top-to-

bottom order, and Ribbon Layout, which displays pages in left-to-right order.

444

446

895
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· Click  Show Rulers to show/hide rulers, which can be used to assist in measuring

documents and document content. The Rulers feature is detailed here.

· Click  Thin Lines to enable/disable the Thin Lines feature, which displays all annotation

lines at a thickness of one pixel. This is a useful feature in cases where important document

content is obscured as a result of multiple annotations/annotations with large borders.

Annotation lines are those created using the commenting tools, which are detailed here.

· Click  Snap to enable/disable the Snapping feature, which is used to assist in the

placement of document content, as detailed here.

· Click  Split to split the current document into two views, which is a useful editing aid.

Click the dropdown arrow to select Horizontal Split, Vertical Split or Spreadsheet Split as

desired. When this option is enabled the Split icon is highlighted in the user interface. Click the

icon to disable the split.

· Click  Show Grid to enable/disable the editing grid. The editing grid is transposed onto

documents and used to ensure that objects are aligned correctly.

· Click  Transparency Grid to enable/disable the transparency grid. A grid is displayed

behind transparent objects when this option is enabled.

· Click  Page Transitions to determine how PDF-XChange Editor transitions between pages

when fullscreen mode is enabled. The Page Transition settings are detailed here.

· Click  Show Guides to show/hide guides, which are used in conjunction with rulers to

simplify the process of aligning document objects. Click and drag from rulers to launch guides,

as detailed here.

· Click  Show Page Size/Position to show/hide the current page size and pointer location.

These details are displayed in the Document Options toolbar, which is in the lower-left section

of the user interface.

· Click  Autoscroll to enable/disable autoscroll, which scrolls automatically through

documents. The keyboard shortcut to enable/disable autoscroll is Ctrl+Shift+H. Use the up and

down arrows to adjust the autoscoll speed, and/or press the minus key to change the autoscroll

direction.

Window

The Window group contains options for adjusting document tabs and showing/hiding editing panes:

450
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· Click Document Tabs to adjust document tabs:

· Click New Document Window to open the current document in a new document

window.

· Click Active Document to New Horizontal Tab Group to move the active document to

a new horizontal tab group.

· Click Active Document to New Vertical Tab Group to move the active document to a

new vertical tab group.

· Click All Documents to One Tab Group to move all open documents to a single tab

group.

· Click Close All to close all open documents.

· Click Reopen Recently Closed Document (or press Ctrl+Shift+W) to open recently

closed documents.

· Click Panes to view/select the PDF-XChange Editor panes and pane options:

· Click Bookmarks to open the Bookmarks  pane and view/edit/create bookmarks.

· Click Thumbnails to open the Thumbnails  pane and view page thumbnails/edit

document pages.

· Click Comments to open the Comments  pane and view/edit comments.

· Click Attachments to open the Attachments  pane and view/edit/create attachments

to the current document.

· Click Fields to open the Fields  pane and view/edit form fields.

· Click Signatures to open the Signatures  pane and view/edit digital signatures.

· Click Layers to open the Layers  pane and view/edit layers.

· Click Content to open the Content  pane and view/edit base content.

· Click Destinations to open the Destinations  pane and view/edit named destinations.

· Click Pan and Zoom to launch the Pan and Zoom  tool.

· Click Stamps Palette to open the Stamps Palette  and view/edit/select stamps.

· Click Comment Styles Palette to open the Comment Styles Palette  and view/select

comment styles.

· Click Spell Check to open the Spell Check  pane and check document spelling.

· Click Document Recovery to open the Document Recovery  pane, which is used to

view/manipulate data recovered by the autosave feature.

· Click Properties pane to open the Properties  pane and view/edit the properties of

document objects.

· Click Reset Main Panes Layout to restore the default layout of the Properties Pane,

 Search Pane,  Stamps Palette  and Comment Styles Palette.

· Click Reset Document Panes Layout to restore the default layout of the Bookmarks

Pane,  Thumbnails Pane,  Destinations Pane,  Content Pane,  Signatures

345

351

358

363

366

371

374

388

393

446

426

644

973

435

441

441

1295 579 644

345 351 393 388



341

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Pane,  Layers Pane,  Comments Pane,  Attachments Pane  and Fields

Pane.

· Click Portfolio to view/select options for PDF portfolio files:

· Click Navigator Layout View or Navigator Details View to switch between these two

viewing modes.

· Click Show Cover Sheet to show/hide the cover sheet.

· Click Show Navigator to show/hide the document navigator.

· Click Welcome Page to show/hide the welcome page of PDF portfolio files.

· Click Preview File to preview the file currently selected in the portfolio file.

· Click Portfolio Tools to edit portfolio files, as detailed here.

371 374 358 363

366
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3.3.3.1 Editing Panes

 Editing Panes

Click the Panes dropdown menu to view the editing panes that are available in PDF-XChange Editor:

Figure 1. View Tab, Panes Dropdown Menu

The following dropdown menu will be displayed:
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Figure 2. Panes Dropdown Menu

· The Bookmarks  pane is used to create, view and manage bookmarks.

· The Thumbnails  pane displays thumbnails of documents pages and can be used to edit

documents on the page level.

· The Comments  pane displays all comments in the active document, and can be used to

create and edit comments.

345
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· The Attachments  pane displays all document attachments, and can be used to add, delete

or manage attachments.

· The Fields  pane displays all form fields in the current document, and can be used to edit

and manipulate form fields.

· The Signatures  pane displays all signed and unsigned signature fields in the current

document, and can be used to perform a range of operations that relate to digital signatures.

· The Layers  pane displays all layers in the current document, and can be used to perform a

range of operations that relate to layers.

· The Content  pane displays all content in the current document, and can be used to edit and

manipulate content as desired.

· The Destinations  pane displays all named destinations in the current document, and can be

used to create, edit and update named destinations.

· The 3DModel Tree  pane displays the hierarchy of selected 3D content in the current

document.

· The Links  pane displays all links in the current document and can be used to create new or

edit existing links.

· The Tags  pane displays all tags in the document structure and can be used to create new or

edit existing tags.

· The Order  pane displays the current document order and can be used to reorder and re-tag

structured document information.

· The Accessibility Checker  pane details accessibility check information about the current

document, and can be used to view a breakdown of specific document components and repair

accessibility errors.

· The Accessibility Report  pane displays accessibility reports after an accessibility check has

been performed. It details the results for all accessibility rules and offers hints on how any

issues can be resolved.

· The Pan and Zoom  pane is used to assist in editing documents, and displays a dynamic

miniature version of the current document that can be updated to change the zoom level of the

current document.

· The Stamps Palette  displays all available stamps, and can be used to select, create and edit

stamps.

· The Comment Styles Palette  displays all default, preset and customized comment styles,

and can be used to select and edit these styles.

· The Spell Check  pane is used to check document spelling.

· The Document Recovery  pane displays recovered documents when documents are closed

with unsaved changes in PDF-XChange Editor, and can be used to recover those documents.

· The History  pane displays the history of documents opened in PDF-XChange Editor and

can be used to browse/open those documents.

· The Properties  pane displays the properties of selected content and tools, and can be used

to adjust those properties as desired.
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3.3.3.1.1  Bookmarks

 Bookmarks

Click Bookmarks (or press Ctrl+B) to show/hide the Bookmarks pane:

Figure 1. View Tab, Panes Dropdown Menu, Bookmarks

The Bookmarks pane appears as below:
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Figure 2. Bookmarks Pane

Bookmarks are used to designate specific places of importance within documents. All bookmarks

contained within the active document are displayed in the Bookmarks pane. Use the icons in the

Bookmarks pane to perform the following operations:

Click  Expand All Bookmarks to expand all bookmarks.

Click  Collapse All Bookmarks to collapse all bookmarks.

Click  New Bookmark to create a new bookmark. See Keyboard Shortcuts  for available

keyboard shortcuts when creating new bookmarks.

Click  Delete to delete selected bookmarks.

Click  Ensure Visibility of Corresponding Bookmark to expand parent bookmarks in a

manner that ensures the visibility of corresponding bookmarks.

Click  Properties to view/edit the properties of selected bookmarks. The Bookmark

Properties pane will open:

1149
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Figure 3. Bookmark Properties Pane

· The Title property displays the bookmark title. Click the text to edit the bookmark title.

· The Fill Color property displays the color of the bookmark title. Click to edit the color of the

bookmark title.

· The Bold and Italic properties display the parameter values for whether or not the bookmark

title is bold or italic. Click values to change the property from False to True as desired.

· The Mouse Up property displays the action performed when the bookmark is clicked. The

default action is Go to a Page in the Document, which is the standard action that bookmarks

perform. However, there are a range of alternative actions available, including the activation of

JavaScript, opening of weblinks and execution of PDF-XChange Editor commands. A

comprehensive list of available actions, and instructions on how to add/edit their parameters, is

available here.

Click  Options, or right-click bookmarks, for bookmark options:

304
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Figure 4. Bookmarks Options
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· Click Go To Bookmark to move to the bookmark currently selected.

· Click New Bookmark to create a new bookmark.

· Click Cut, Copy, Paste, Delete  to perform these actions on selected bookmarks. If you have

copied text to the clipboard then you can click Paste as plain text to create a bookmark that

uses the copied text as a bookmark title.

· Click Expand/Collapse All Bookmarks to expand/collapse all bookmarks.

· Click Ensure Visibility of Corresponding Bookmark to expand parent bookmarks in a manner

that ensures the visibility of corresponding bookmarks.

· Click Automatically Expand Bookmarks to expand all child bookmarks by default.

· Click Rename to rename selected bookmarks.

· Click Set Destination to change the location of the selected bookmark to the current view of

the active document.

· Click Set Destination from Selection to change the location of the selected bookmark to the

current selection in the active document.

· Click Make Current Properties Default to set the properties of the current bookmark as the

default setting for subsequent bookmarks.

· Click Apply Default Properties to apply the default bookmark properties to selected

bookmarks.

· Hover over Text Size to set the font size of bookmark titles, then select either Small, Medium

or Large in the submenu.

· Click Wrap Long Bookmarks to fit bookmarks with long names to the dimensions of the

Bookmarks pane. If this option is not enabled then bookmark titles will be a single line

regardless of their length.

· Click Show/Hide Icons as desired.

· Hover over Create Options to view customizable options for creating bookmarks:

· Click Use Inherited Zoom to retain the current zoom level when bookmarks are clicked.

If this option is disabled then the zoom level will change to the level that was current

when the bookmark was created.

· Click Use Current Page to use the current page as the destination when bookmarks are

created. If this option is not selected then the first visible page after the current page will

be used.

· Click Use Selected Text as Title to use selected text as the title for the bookmark in cases

where you are creating a bookmark from selected text.

· Click Use Selected Region as Destination to use selected regions as the bookmark

destination when you are creating new bookmarks. 

· Hover over Pages to view options for pages:

· Click Print to print the pages designated to the bookmark and its child bookmarks. The

Print  dialog box will open with the designated pages in the Page Range box.

· Click Extract to extract the pages designated to the bookmark and its child bookmarks to

a new document. The Extract Pages  dialog box will open with the designated pages

in the Page Range box.

· Click Select to select the pages designated to the bookmark and its child bookmarks in

the Thumbnails  pane, which will open with the designated pages selected.
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· Click Remove to remove the pages designated to the bookmark and its child bookmarks.

· Hover over Sections to view options for sections:

· Click Print to print the sections designated to the bookmark and its child bookmarks. The

Print  dialog box will open with the designated sections in the Page Range box.

· Click Extract to extract the sections designated to the bookmark and its child bookmarks

to a new document. The Extract Pages  dialog box will open with the designated

sections in the Page Range box.

· Click Select to select the sections designated to the bookmark and its child bookmarks in

the Thumbnails  pane, which will open with the designated sections selected.

· Click Remove to remove the sections designated to the bookmark and its child

bookmarks.

· Click Import Bookmarks to import saved bookmarks.

· Click Export Selected Bookmarks to export selected bookmarks.

· Click Export All Bookmarks to export all bookmarks.

· Click Show Info Bar to show/hide the information bar at the bottom of the Bookmarks pane.

· Click Properties to view/edit the properties of selected bookmarks, as detailed in (figure 3).

Further bookmark options are available in the Bookmarks  tab.

158
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3.3.3.1.2  Thumbnails

 Thumbnails

Click Thumbnails (or press Ctrl+T) to show/hide the Thumbnails pane:

Figure 1. View Tab, Panes Dropdown Menu, Bookmarks

The Thumbnails pane appears as below:
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Figure 2. Thumbnails Pane

Thumbnails are a convenient method to view, manage and edit document pages. A smaller

representation of document pages is displayed in the Thumbnails pane. 

· The orange rectangle represents the current page view.

· Click on pages/page locations in the thumbnails pane to move to those locations in the active

document.

· Click and drag thumbnail pages to reorder them in the active document.

· Press and hold Ctrl to select multiple pages for group-editing. 

· Press Ctrl+A to select all pages in the Thumbnails pane.

· The Thumbnails pane can be used to create page ranges. Click the first page of the desired

range, then press and hold Shift and click the final page of the desired range.

· The Thumbnails pane can also be used to copy pages between open documents. Select the

desired pages, then right-click and select Copy in the submenu. Move to the desired location in

the Thumbnails pane of the destination document, then right-click and select Paste to

complete the operation.

· It is possible to paste text, (*.rtf) files and images as new document pages via the Thumbnails

pane.

Use the icons in the Thumbnails pane to perform the following operations:
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Click  Zoom In to zoom in on thumbnails.

Click  Zoom Out to zoom out from thumbnails.

Click  Rotate Pages CCW 90° to rotate selected pages ninety degrees counterclockwise.

Click  Rotate Pages CW 90° to rotate selected pages ninety degrees clockwise.

Click  Print to print documents.

Click  Delete to delete selected pages.

Click  Properties to view the properties of selected pages. The Page Properties pane will

open:

Figure 3. Page Properties Pane

· The Number property displays the physical page number of document pages.

· The Label property displays the logical page number of document pages. The Number

Pages  feature can be used to edit this property.

· The Width and Height properties display the physical size of document pages. The Resize

Pages  feature can be used to adjust the size of document pages.

921

901
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· The Rotation property displays the current page rotation. Click the property and then use the

dropdown menu to adjust the page rotation as desired.

· The Tab Order property displays the designated tab order of pages. This property determines

the method used to scroll through page items such as comments, form fields and images. Click

the property and select an option from the dropdown menu as desired.

· The Page Open and Page Close properties enable the activation of custom actions when

document pages are opened/closed. Click the ellipsis icon on the right of these properties to

add/edit actions. There are a range of actions available, including the activation of JavaScript,

opening of weblinks and execution of PDF-XChange Editor commands. A comprehensive list

of available actions, and instructions on how to add/edit their parameters, is available here.

Click  Options, or right-click thumbnails, for thumbnail options:

304
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Figure 4. Thumbnails Options

· Click Cut, Copy, Paste or Delete to perform these actions on selected thumbnails.

· Click Select to select a subset of pages in the Thumbnails pane, then select the desired option

in the shortcut menu:

· Click Select All to select all pages.
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· Click Pages with Comments to select all pages that contain comments.

· Click Pages with Links to select all pages that contain links.

· Click Pages with Form Fields to select all pages that contain form fields.

· Click Pages with Bookmarks to select all pages that contain bookmarks.

· Click Pages with Text to select all pages that contain text.

· Click Pages with Images to select all pages that contain images.

· Click Pages with Path Items to select all pages that contain path items.

· Click Pages with Search Results to select all pages that contain search results returned

via the Search  feature.

· Click Pages with... to select all pages that contain a combination of the options detailed

in the Select dropdown menu. The Select Pages With dialog box will open. Select the

boxes of the desired items and then click OK to select the corresponding pages.

· Click Empty Pages to select all empty pages.

· Click Invert Selection to invert the current selection of pages in the Thumbnails pane.

· Click Insert Pages to insert pages at the selected location in the Thumbnails pane, as detailed

here.  

· Click Extract Pages to copy and save selected pages, as detailed here.

· Click Replace Pages to replace selected pages, as detailed here.

· Click Delete Pages to delete selected pages, as detailed here.

· Click Crop Pages to crop selected pages, as detailed here.

· Click Remove Cropped Content to remove cropped content from documents. This feature is

intended for use in conjunction with the Crop Pages feature. Cropping pages reduces the

visible page area, but cropped content remains available (and takes up memory) unless this

option is also used.

· Click Rotate Pages to view the Rotate Pages options, which are explained here.

· Click More for Pages to view/select further options for pages:

· Click Duplicate Pages  to duplicate pages.

· Click Resize Pages  to resize pages.

· Click Split Pages  to split pages.

· Click Merge Pages  to merge pages

· Click Swap Pages  to swap the location of two pages.

· Click Move Pages  to move the location of pages.

· Click Page Transitions  to change the manner in which documents browse between

pages in fullscreen mode.

· Click Number Pages  to number document pages and create number ranges.

· Click Print to print documents, as detailed here.

· Click New Stamp from Selection to create a new stamp from selected thumbnails, as detailed

here.

· Click New Document from Selection to create a new document from selected thumbnails.

· Click Export to view export options:

· Click Export to Image(s) to convert selected thumbnails into images. The Export to

Image(s) dialog box will open. See here  for further information.
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· Click Export selection to Microsoft Word Document to convert and save selected

thumbnails in (*.docx) format.

· Click Export selection to Microsoft Excel to convert and save selected thumbnails in

(*.xlsx) format.

· Click Export selection to Microsoft Powerpoint Presentation to convert and save

selected thumbnails in (*.pptx) format.

· Click Zoom In to zoom in on the thumbnails pane.

· Click Zoom Out to zoom out from the thumbnails pane.

· Highlight Visible Area is selected by default. This means the area of the document currently

visible in the main window is highlighted in the corresponding page of the Thumbnails pane.

Disable this option to remove the highlight box.

· Interactive Highlighted Area is selected by default. This means it is possible to click and drag

the Highlight Visible Area detailed above to adjust the page view in the main window. Click

and drag the  icon to adjust the page view.

· Click Show Info Bar to show/hide the information bar at the bottom of the Thumbnails pane.

· Click Properties to launch the Properties pane for selected pages. This pane is detailed

beneath (figure 3) above.
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3.3.3.1.3  Comments

 Comments

Click Comments (or press Ctrl+M) to open the Comments pane:

Figure 1. View Tab, Panes Dropdown Menu, Comments

The Comments pane displays a list of comments, annotations and markups in the current document:
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Figure 2. Comments Pane

Click items in the Comments pane to move to their location in the document. You can use the

lock/unlock and reply buttons to lock/unlock and reply to comments. Use the icons in the Comments

pane to perform the following operations:

Click  Next Comment to move to the next comment.

Click  Previous Comment to move to the previous comment.

Click  Add Reply to add a reply to the selected comment. Replies appear in the pop-up note

of annotations, and are useful for the editing process of documents.

Click  Summarize Comments to create a summary of comments in the document, as

detailed here.

Click Delete to delete selected comments.

Click  Show to determine the content displayed with comments, and the manner in which

comments are displayed.

Click Properties to view/edit the properties of selected comments. The Properties pane will

open:

633
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Figure 3. Properties Pane

Click to edit properties as desired. Please note that the properties available depend on the the

type of annotation selected, and not all properties are editable. Comment properties are detailed

here.

Click  Options for comment options:

457
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Figure 4. Comments Options

· Click Cut, Copy, Delete or Flatten to perform these operations on comments.

· Click Expand All/Collapse All to expand/collapse all comments.

· Click Summarize Comments to create a summary of comments, as detailed here.

· Click Import Comments to import comments from file, as detailed here.

· Click Export Comments to Data File to export comments, as detailed here.

· Click Export Selected Comments to Data File to export a summary of selected

comments to file, as detailed here.

· Click Group By to determine how comments are grouped, then select Page, Type,

Modification Date, Creation Date, Author, Color, Subject, Status, Status and Author

or Author of Last Status to determine how comments are grouped.

· Use the Show options to determine the information displayed with comments in the

Comments pane.

· Click Deselect to deselect selected comments.

633
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· Click Select Correspondent Thumbnails to select the corresponding thumbnails of

selected comments in the Thumbnails pane.

· Click New Stamp from Selection to create a new stamp from selected comments, as

detailed here.

· Click New Document from Selection to create a new document from selected

comments.

· Click Show Info Bar to show/hide the information bar at the bottom of the Comments

pane.

· Click Properties to view/edit the properties of selected comments, as detailed above.

579
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3.3.3.1.4  Attachments

 Attachments

Click Attachments (or press Ctrl+Shift+A) to open the Attachments pane:

Figure 1. View Tab, Panes Dropdown Menu, Attachments

The Attachments pane details attachments to the current document:
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Figure 2. Attachments Pane

Double-click to open attachments. Use the icons in the Attachments pane to perform the following

operations:

Click  to open attachments in their default applications.

Click  to save selected attachments.

Click  to add new attachments to documents. The Open Files dialog box will open.

Select the desired files and click Open to add them as attachments. Alternatively, click and drag

documents into the Attachments pane.

Click  to delete selected attachments.

Click Options for additional attachment options:
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Figure 3. Attachment Options

· Click Open Attachment to open selected attachments.

· Click Save Attachment to save selected attachments to an external file.

· Click New Attachment to add a new attachment to the current document.

· Click Paste to paste the current clipboard content as a new attachment to the current

document.

· Click Delete to delete selected attachments.

· Click Edit Description to edit the description of selected attachments in the Attachments

pane.

· Click Show Info Bar to show/hide the info bar at the bottom of the Attachments pane.

If you have copied content to the clipboard, then it can be used to create a new attachment. Right-click

in the Attachments pane, then click the special paste options Paste as plain text, Paste as Rich Text

or Paste as Image as desired. Note that the available paste options depend on the format of the

content in the clipboard.
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3.3.3.1.5  Fields

 Fields

Click Fields (or press Ctrl+I) to open the Fields pane:

Figure 1. View Tab, Panes Dropdown Menu, Fields

The Fields pane details form fields in the current document:
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Figure 2. Fields Pane

Click Select Fields in the form tab, as detailed in (figure 2), then click fields in the Fields pane to select

them in the document. Use the icons in the Fields pane to perform the following operations:

· Click  Rename to rename selected fields. 

· Click  Properties to view/edit properties of selected fields. The Properties pane will open.

This pane details the status of properties for selected form fields. The properties detailed

depend on the format of selected fields. Further information on form fields and their properties

is available here.

· Click   Options for fields options:

676
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Figure 3. Forms Options

· Click Set as Required Field to set selected fields as required fields, which must be filled

before documents can be submitted. These fields will also be highlighted when the

Highlight Required Fields Only option outlined here  is enabled.

· Click Cut, Copy, Paste or Delete to perform these actions on selected fields.

· Click Expand All/Collapse All to expand/collapse all fields.

· Click Rename to rename selected fields.

· Select either Alphabetical Order or Order by Pages to order forms alphabetically or by

page order as desired.

224
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· Select an option from the Tab Order submenu to determine the order in which fields are

tabbed through with when the Tab key is used. Note that Order by Pages must be

enabled for the Tab Order option to be available.

· Click Select to select a fields of a specific type, or all fields, in the Fields pane.

· Click Reset Selected Form to reset form data entered into selected fields.

· Hover over Current Layer to move selected fields to an optional content layer. Further

information about layers is available here.

· Click Make Current Properties Default to make the properties of selected fields the

default properties for new fields of the same type.

· Click Apply Default Properties to apply default properties to selected fields.  

· Click Calculation Order to determine the order of calculation when more than one form

field in the document contains value calculation properties. See here  for further

information.

· Click Properties to view/edit form properties. Note that the Select Fields feature must be

enabled to view form properties, as detailed in (figure 2). Form properties are detailed

here.

· Click Show Full Fields Name to show/hide the full names of child fields in cases where

fields are grouped according to name. The shared section of names is displayed when

this option is enabled and hidden when it is disabled, as detailed below:

Figure 4. Fields Pane, Show Full Fields Name Enabled
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Figure 5. Fields Pane, Show Full Fields Name Disabled

Additional editing options for forms are detailed here. 676
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3.3.3.1.6  Signatures

 Signatures

Click Signatures to open the Signatures pane:

Figure 1. View Tab, Panes Dropdown Menu, Signatures

The Signatures pane displays information about digital signatures in the current document:
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Figure 2. Signatures Pane

Digital signatures are used to demonstrate the authenticity of documents and increase their security.

They can also be used to determine editing permissions for documents and/or utilize timestamp

servers in order to further increase document security. The Signatures pane displays details about

digital signatures in the current document, such as the restrictions that the signature imposes, the name

of the person who added the digital signature, the time at which the document was signed and

whether or not the signature conforms to the EU 910/2014 standard. Information and instructions about

adding/editing digital signatures is available here.  Use the icons in the Signatures pane to perform

the following operations:

Click  to validate all document signatures.

Click  to clear all digital signature fields in the document. 

Click  for signature options:

651
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Figure 3. Signatures Options Submenu

These options are detailed here. 651
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3.3.3.1.7  Layers

 Layers

Click Layers (or press Ctrl+L) to open the Layers pane:

Figure 1. View Tab, Panes Dropdown Menu, Layers

The Layers pane displays information about document layers:
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 Figure 2. Layers Pane

Layers contain page content and comments that can be displayed/hidden as desired. For example it is

possible to create layers that contain different groupings of comments in order to highlight different

areas of documents:
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Figure 3. Sample Layers Document, "Layer A" Enabled
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Figure 4. Sample Layers Document, "Layer B" Enabled
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Figure 5. Sample Layers Document, "Layer C" Enabled

Use the icons in the Layers pane to perform the following operations:

Click  Options to view options for layers, as detailed below.

Click  Add New Layer to add a new layer to the current document, as detailed below.

Click  Rename to rename selected layers.

Click  Delete to delete selected layers.

Click  to show/hide layers.

Use the Default Layer dropdown menu to determine the default layer for documents:
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Figure 6. Layers Pane, Default Layer Dropdown Menu

When a default layer is specified all new content and comments added to the document will be added

to this layer when the Layers pane is open. This enables you to save time and avoid the need to

manually specify the layer to which new content and comments belong. Note that you can also drag

and drop content/comments from their respective panes into the Layers pane to determine the layer

to which they belong:
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Figure 7. Moving Content from the Content Pane to the Layers Pane

Click  Properties in the Layers pane to view/edit the properties of selected layers. The Layer

Properties pane will open:
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Figure 8. Layer Properties Pane

· The Title property displays the title of layers as they appear in the Layers pane.

· The Intent property displays the intended use for layers:

· None means there is no specified intent.

· View means that the layer is intended for use as a viewing aid.

· Design means the layer is intended for use in understanding the design of the document.

· Design and View means both Design and View.

· Please note that PDF applications may use the Intent property to determine whether or

not layers are displayed.

· The Default State property displays the default state of layers when the document that

contains them is opened.

· The Locked property displays the editable status of layers.

· The Visibility property displays the visibility status of layers.

· The Print property displays the printing status of layers.

· The Export property displays the export status of layers. This property determines whether or

not layers appear in resulting documents when the file is exported to an application/file format

that supports layers.

· The Language property determines layer visibility according to the user interface language. If

Always is selected then the layer is visible regardless of the language of the user interface. If a
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language is specified, then the layer will only be visible when the language of the user interface

matches the language specified for this property.

· The Zoom property determines layer visibility according to the document zoom level. If False

to selected then the layer will be visible regardless of the document zoom level. If True is

selected then the layer will only be visible when the document zoom level is between the zoom

levels specified.

· The Radio Button Group property displays the radio button group to which the layer belongs.

Layers that belong to a radio button group are mutually exclusive - when one layer from a

group is enabled, the other layers in the group are automatically disabled and cannot be

enabled.

Click  Options for layer options:
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Figure 9. Layers Options

· Click Add New Layer to add a new layer to the current document. The Add New Layer dialog

box will open, as detailed below.

· Click Add Text Label to add a text label to selected layers.

· Click Set as Default Layer to set the selected layer as the default layer. All content and

comments added to the document will be added to this layer.
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· Click Flatten All Optional Content to flatten optional content to the base content layer of the

document.

· Click Flatten Selected Layers to convert selected layers into base content. Layers converted in

this manner can then be edited using the Edit Objects Tool.

· Click Import as Layer to import pages from a different document as a new layer, as detailed

below.

· Click Extract Selected Layers to extract selected layers to a new document.

· Click Extract Visible Layers to extract visible layers to a new document.

· Click Merge Selected Layers to merge selected layers.

· Click List Layers for All Pages to display layers on every page of the document.

· Click List Layers for Visible Pages to display layers on the pages currently visible in the

document. 

· Click Reset to Initial Visibility to revert all layers to their default state.

· Click Apply Layers Overrides to display all layers. This option includes layers not listed in the

Layers pane.

· Hover over Select to view options for selecting a subset of items in the Layers pane:

· Click Select All to select all layers.

· Click Text Labels to select all text labels.

· Click Visible to select all visible items.

· Click Hidden to select all hidden items.

· Click Empty to select all items that do not belong to content items or annotations.

· Click Invert Selection to invert the current selection of items in the Layers pane.

· Click Show/Hide/Toggle Selected Layers to show/hide/toggle selected layers in the

document.

· Click Sort Layers Alphabetically to sort layers into alphabetical order.

· Click Expand All to expand all layers in the Layers pane.

· Click Collapse All to collapse all layers in the Layers pane.

· Click Rename to rename selected layers.

· Click Delete to delete selected layers.

· Click Properties to view/edit the properties of the selected layer, as detailed above.

1087
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Figure 10. Add New Layer Dialog Box

· Enter the name of the new layer in the Layer Name text box.

· Select/clear the is ON box to set the default state of the layer to on/off.

· Select the Add to Layers Pane box to add the new layer to the Layers pane.

· Select/clear the Is Locked box to disable/enable subsequent users from changing the state of

the layer. 

· Use the Object Visibility Options dropdown menus to determine the visibility of the layer

when the documents that contains it are viewed/printed/exported.

· Select the Show when system language matches box to show the layer when the application

language matches a given language, then select the desired language in the adjacent

dropdown menu.

· Select the Use partial language match to display the layer when there is a partial language

match with the language specified. A partial language match occurs when the region of the

language is the same as in the language specified but the locale is different. For example, if US

English is specified in the Show when system language matches dropdown menu and the

Use partial language match box is selected, then the layer will be displayed when the

application language is identified as US English, United Kingdom English, South African

English and all other derivatives of English listed in the dropdown menu.

· Select the Show on Zoom box to display the layer when the zoom function is used. Use the

adjacent number boxes to specify the minimum and maximum levels of zoom at which the

layer is displayed.

· Select the Add to a Layer Radio Button Group to add the layer to a Layer Radio Button

Group. Layers contained in a radio button group are mutually exclusive - if one layer is enabled

then the rest are disabled.
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· Select the Add selected Comments to this layer box to add selected comments to the layer.

Click OK to save changes.

Import as Layer

Figure 11. Import as Layer Dialog Box

· Use the File dropdown menu to select a file to import as a layer into the document.

· Use the Pages option to determine the pages used from the source document. Click All to use

all pages, or Custom to specify a custom page range.

· Use the Import Options to determine import options for the new layer:

· Click Create New Layer to create a new layer for the imported content. Enter a name for

the new layer in the text box and click Properties to determine layer properties, as

detailed in (figure 10) above.

· Click Add to Existing Layer to add imported content to an existing layer, then selected

the desired layer from the dropdown menu.

· Click Copy Corresponding Layers from Source to copy corresponding layers from the

source document into the current document.
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· Click Copy Structure of Corresponding Layers From Source to copy the layer structure

from the source document into the current document.

· Use the Destination Page Range options to determine the page range into which layers are

imported:

· Use the Pages option to determine the pages used from the source document. Click All

to use all pages, or Custom to specify a custom page range.

· Use the Repeat Source dropdown menu to determine repeat options for the source

document in cases where it contains fewer pages than the current document:

· Select No to disable the repeating of layers from the source document in the

current document.

· Select Last selected page to repeat the last selected layer in the source document.

· Select Continuously repeat selected pages to repeat the layers selected in the

source document repeatedly until they fill the current document.

· Use the Appearance options to determine the appearance of layers from the source document

in the current document:

· Select an option in the Rotation dropdown menu to determine the rotation of the layers.

· Select an option in the Opacity dropdown menu to determine the opacity of the layers.

· Select an option in the Scale dropdown menu to determine the scaling of the layers.

· Use the Placement Options to determine the placement of layers:

· Use the Horizontal Offset number box to determine the horizontal offset of layers. Use

the adjacent dropdown to determine the location from which the offset is made.

· Use the Vertical Offset number box to determine the vertical offset of layers. Use the

adjacent dropdown to determine the location from which the offset is made.

· Use the Units dropdown menu to specify the units of measurement for offsets.

· Select the As Background box to import layers as a background.

Click OK to import layers.

Please note that it is necessary to save, close and reopen documents in order for some of the settings

detailed above to be displayed.
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3.3.3.1.8  Content

 Content

Click Content to open the Content pane: 

Figure 1. View Tab, Panes Dropdown Menu, Content

The Content pane displays a list of the document pages and the content that they contain:
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Figure 2. Content Pane

Click items in the Content pane to select them in the document. They can then be edited as detailed

here.  Use the icons in the Content pane to perform the following operations:

Click  Collapse All to collapse all items in the Content pane.

Click  Bring Forward to bring selected content forward in cases where multiple content items

overlap.

Click  Send Backward to send selected content backward in cases where multiple content

items overlap.

Click  Delete to delete selected content.

Click  Properties to view/edit the properties of selected content. The Page Content

Properties pane will open. This pane details the status of properties for selected content:

1141
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Figure 3. Page Content Properties Pane

Click to edit properties as desired. Please note that not all properties are editable. The following

properties are available for content items:

· Layer determines the optional content layer to which document content belongs. Further

information about layers is available here.

· Fill Color displays the fill color.

· Opacity displays the level of transparency.

· Stroke Color displays the border color.

· Stroke Opacity displays the border transparency level.

· Border Width displays the border width.

· Line Cap displays the shape used at the start and endcaps for open stroked paths or the caps at

both ends of dashes in stroked paths.

· Line Join displays the shape used at joints between connected segments of stroked paths.

· Filling Rule determines the manner in which fills are defined and displayed.

· Blend Mode displays the blend mode when items overlap. Further information on blend modes

is available here.

· Width displays the width of images.

· Height displays the height of images.

· Type displays the format of images.

374
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· BPC displays the color depth.

· Color Space displays the color model.

· Mask Type displays the mask type.

· Object Number displays the object number of selected content items.

· Font displays the font.

· Font Size displays font size.

· Bold displays the bold status.

· Italic displays the italic status.

· Transparency Group displays the transparency group value for XForms.

Click  for content item options:

Figure 4. Content Options
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· Click Cut, Copy, Paste or Delete to perform these operations on selected content items.

· Use the Current Layer dropdown menu to determine the layer to which content belongs.

Further information about layers is available here.

· Click Show in Tags Panel to show selected (and previously tagged) content in the Tags

 pane.

· Use the Select dropdown menu to select all Shapes, Images, Text, XForms or all content in

the current document. Note that subsequent editing options such as Cut, Copy, Paste, Delete -

and changes made to properties in the Page Content Properties pane - will apply to all

selected content.

· Click Deselect to deselect all selected content items.

· Click Select Correspondent Thumbnails to select the corresponding thumbnails of selected

content in the Thumbnails  pane.

· Click Arrange to arrange selected content items, as detailed here.

· Click Expand All Descendants to expand all descendants of selected content items.

· Click Collapse All to collapse all expanded items in the Content pane.

· Click Automatically Expand Content Items to expand content items in the Content pane

automatically when they are selected with content-editing tools in the document.

· Click New Stamp from Selection to create a new stamp from selected content items, as

detailed here.

· Click New Document from Selection to create a new document from selected content items,

as detailed here.

· Click Export to export selected content items to image format or MS Word/Excel/PowerPoint

format, as detailed here.

· Click Properties to view the properties of selected content in the Page Content Properties

pane, as detailed above.

Right-click items in the Content pane for additional editing options, as detailed here.

374
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3.3.3.1.9  Destinations

 Destinations

Click Destinations to open the Named Destinations pane:

Figure 1. View Tab, Panes Dropdown Menu, Destinations

The Named Destinations pane is used to view/edit named destinations:
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Figure 2. Named Destinations Pane

Named destinations are user-defined locations in documents. They can be used in conjunction with

Bookmarks,  Go To Page  actions and the /Open  command line to navigate to specified

locations. Double-click named destinations to move to their location in the document. Use the icons in

the Named Destinations pane to perform the following operations:

Click  New Destination to create a new named destination from the current view.

Click  Set to set the current view as the new view for the selected named destination.

Click  Delete  to delete selected named destinations.

Click  Options for named destination options:

345 309 1124
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Figure 3. Named Destination Options

· Click Go to Destination to move to selected destinations.

· Click New Destination (or press Insert) to create a new named destination from the

current view.

· Click Delete to delete selected named destinations.

· Click Rename to rename selected named destinations.

· Click Edit Destination to edit the location of the named destination, as detailed below.

· Click Set to set the current view as the target for the selected named destination.

· Click Set from Selection to set the current selection as the target for the selected named

destination.

· Click Wrap Long Titles to spread long named destination titles over multiple lines.

· Click Create Options to view options for creating named destinations

· Click Use Inherited Zoom to enable/disable inherited zoom in the creation of

named destinations.

· Click Use Current Page to specify the use of the current page for named

destinations. If this option is not selected then the first visible page will be used.

· Click Use Selected Text as title to use selected text as the title when creating new

named destinations.

· Click Use Selected Region as Destination to use selection regions as the

destination when creating new named destinations.

· Click Remove Invalid to remove named destinations that do not have a valid destination.

· Click Show Info Bar to show/hide the information bar at the bottom of the Named

Destinations pane.
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Create Named Destinations from Selected Text

When you are creating named destinations, it is also possible to use the Select Text Tool to create a

named destination from selected text in the current document. Follow the steps below to use this

method to create named destinations:

1. Click the Home tab, then click to enable the Select Text Tool and click and drag to highlight

the text you want to use to create the named destination:

Figure 4. Home Tab, Select Text Tool Enabled, Text Highlighted

2. Click the Destinations shortcut in the Quick Tools toolbar to open the Named Destinations

pane:
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Figure 5. Named Destinations Pane Open

3. Click New in the Named Destinations pane to create a new named destination that uses the

highlighted text as the name of the new named destination:
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Figure 6. New Named Destination Created from Selected Text

Editing the Location of Named Destinations

Right-click named destinations in the Named Destinations pane and click Edit Destination to edit the

location of named destinations:
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Figure 7. Named Destinations Submenu, Edit Destination Highlighted

The Edit Destination dialog box will open:
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Figure 8. Edit Destination Dialog Box

· Use the Page dropdown menu to set the page number for the named destination.

· Use the X and Y dropdown menus to determine the X and Y coordinates of the named

destination, or select the Inherit box to use the existing X/Y coordinates of the named

destination.

· Select an option in the Zoom dropdown menu to determine the zoom used for the named

destination. Alternatively, select the Use Rectangle button to specify a rectangle to use, then

enter the desired dimensions in the Width and Height number boxes.

· Note that you can also click and drag the yellow points in the dialog box to specify X/Y

coordinates/width and height values as desired.

Click OK to save changes.
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3.3.3.1.10  3D Model Tree

 3D Model Tree

Click 3D Model Tree to open the 3D Model Tree pane:

Figure 1. View Tab, Panes Dropdown Menu, 3D Model

The 3D Model Tree pane displays a hierarchical list of 3D content in documents:
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Figure 2. 3D Model Tree Pane

Note that it is necessary to click 3D content in order to select/activate them in documents. If 3D content

is not selected then the 3D Model Tree pane will be empty.

Click items in the 3D Model Tree pane to select them in the document. Use the icons in the 3D Model

Tree pane to perform the following operations:

Click  Expand All to expand all branches in the 3D Model Tree hierarchy.

Click  Collapse All to collapse all branches in the 3D Model Tree hierarchy.

Click  Properties to view/edit the properties of selected content. The 3D Properties pane

will open. This pane details the status of properties for selected content:
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Figure 3. 3D Properties Pane

Click to edit properties as desired. Please note that not all properties are editable. The following

properties are available for 3D content:

· 3D Model Type displays the file format of the 3D content.

· Printable displays the print status of the 3D content. If this property is enabled then the

comment is printed with the document. If this property is not enabled then it is not printed.

· Locked determines the locked status of the 3D content. If this property is enabled then the

content cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the 3D content belongs. Further

information about layers is available here.

Click  for 3D content item options:

374
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Figure 4. 3D Content Options

· Hover over Model Render Mode to view/select alternative rendering modes for the 3D

content.

· Click Show All Parts to display all parts of the 3D content in the document.

· Click Fit Visible to zoom the view in order to display all 3D content.

· Click Display Bounding Box to display a bounding box around the 3D node selected in the 3D

Model Tree pane.

· Click Set Bounding Box Color to change the color of the bounding box around the 3D content.

· Click Hide to hide the node of the 3D content selected in the 3D Model Tree pane.

· Click Isolate to display only the node of the 3D content selected in the 3D Model Tree pane.

· Click Isolate Part to display only the part of the 3D content selected in the 3D Model Tree

pane. Note that parts are the parents of nodes in the 3D Model Tree pane.

· Click Zoom to Part to zoom to the part selected in the 3D Model Tree pane.

· Hover over Part Render Mode to view/select alternative rendering modes for the part of 3D

content selected in the 3D Model Tree pane.

· Click Properties to open the 3D Properties pane, as detailed above.
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3.3.3.1.11  Links

 Links

Click Links to open the Links pane:

Figure 1. View Tab, Panes Dropdown Menu, Links

The Links pane displays links in documents:
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Figure 2. Links Pane

Click items in the Links pane to select them in the document. Use the icons in the Links pane to

perform the following operations:

Click  Delete to delete selected links.

Click  Properties to view/edit the properties of selected links. The Link Properties pane will

open. This pane details the status of properties for links:
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Figure 3. Link Properties Pane

Click to edit properties as desired. Please note that not all properties are editable. The following

properties are available for links:

· Printable is the print status of the link. If this property is enabled then the link is printed with

the document. If this property is not enabled then the link is not printed.

· Locked is the locked status of the link. If this property is enabled then the link cannot be

deleted and its properties (including its position and size) cannot be modified by users.

· Layer determines the optional content layer to which the link belongs. Further information

about layers is available here.

· Stroke Color determines the border color of the link.

· Border Style determines the border style of the link

· Border Width determines the border width of the link.

· Highlight determines the visual effect when the link is clicked.

· Mouse Up determines the action taken when the link is clicked. Click the ellipsis icon on the

right of the action to view/edit/add actions, as detailed here.

Click  for link options:

374
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Figure 4. Link Options

· Click Cut, Copy or Delete to perform these operations on selected links.

· Hover over Current Layer to view/edit the layer to which selected links belong.

· Hover over Web Links to view options for weblinks, then click Create Web-Links from URLs

or Remove All Web-Links as desired. Further information about these features is available

here.

· Click Wrap Long Titles to spread the title of links over multiple lines in cases where links have

long names.

· Click Import/Export Links to import links from/to file.

· Click Export Links to CSV File to export links to a CSV file.

· Click Show Info Bar to show/hide the info bar at the bottom of the pane.

· Click Properties to open the Link Properties pane, as detailed above.

299
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3.3.3.1.12  Tags

 Tags

Click Tags to open the Tags pane:

Figure 1. View Tab, Panes Dropdown Menu, Tags

The Tags pane displays tags in documents:
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Figure 2. Tags Pane

Use the icons in the Tags pane to perform the following operations:

Click  New Tag to create a new tag. The New Tag dialog box will open. Select the type of

tag you want to create, then enter a title for the tag and click OK to create it.

Click  Delete to delete selected tags.

Click  Properties to view/edit the properties of selected tags. The Tag Properties pane will

open. This pane details the status of properties for tags:
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Figure 3. Tag Properties Pane

Click to edit properties as desired. The following properties are available for tags:

· Type is the tag type.

· Title is the name of the tag.

· Actual Text is the actual text in cases where the tagged content is text-based.

· Alternate Text is alternate text to the actual text. This is a necessary requirement of tagged

content in documents in order to pass accessibility checks.

· Language is the specified language of the tag.

Click  for tag options:



412

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 4. Tag Options

· Click New Tag to create a new tag, as detailed above.

· Click Delete to delete selected tags.

· Click Delete Empty Tabs to delete empty tags.

· Click Reading Order to determine the reading order of tags. The Order pane will open, as

detailed here.

· Click Find Tag from Selection to search for the tag that contains the text/object selected in the

document.

· Click Create Tag from Selection to create a tag from selected document content.

· Click Change Tag to Artifact to change selected tags to artifacts. Artifacts are ignored by

screen readers and other assistive technologies.

· Click Edit Class Map to create, edit or delete the class map (style dictionary) of the document.

· Click Edit Role Map to create, edit or delete the role map of the document. Role maps allow

documents to contain a unique tag set definition. It is easier to identify and edit custom tags

when they are mapped to predefined tags.

· Click Document is Tagged PDF to add/remove a flag to the document that recognizes it as a

tagged PDF.

· Click Show in Content Panel to display the content of selected tags in the Content  pane.

· Click Apply Role Mapping to Tags to enable/disable the application of role mapping to tags.

1078

388



413

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Click Highlight Content to enable/disable the highlighting of document content that is

associated with tags when those tags are selected in the Tags pane.

· Click Properties to view/edit the Properties pane for tags, as detailed above.



414

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.3.1.13  Order

 Order

Click Order to open the Order pane:

Figure 1. View Tab, Panes Dropdown Menu, Order

The Order pane displays the reading order for document tags:
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Figure 2. Order Pane

Click and drag items in the Order pane to determine the reading order of tagged items in the

document. Click Reading Order to open the Order tab and create/customize tags, as detailed here.

Click  for additional options:

1078
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Figure 3. Options Submenu

· Click the Show page content group dropdown menu, then click Page content order,

Structure types or None in the submenu to determine the page content groups that are

displayed in the document.

· Click Display like elements in a single box to display elements of the same type in a single

box.

· Click Show table cells to display content that has been tagged as a table cell in the document.

· Click Show tables and figures to display content that has been tagged as a tables or figure in

the document.
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· Click Delete Selected Item Structure to delete selected item structures.

· Click Clear page structure to delete the page structure.

· When the Reading Order feature is enabled in the Order pane, click and drag to select

document content and then use the tagging options in the Options dropdown menu to specify

how you want to tag the document content.
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3.3.3.1.14  Accessibility Checker

 Accessibility Checker

Click Accessibility Checker to open the Accessibility Checker pane:

Figure 1. View Tab, Panes Dropdown Menu, Accessibility Checker

The Accessibility Checker pane displays the results of accessibility checks:
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Figure 2. Accessibility Checker Pane

PDF-XChange Editor checks thirty-two rules when documents are checked for accessibility, and

documents must pass all rules in order to meet accessibility standards. The results of checking these

rules are detailed in the Accessibility Checker pane. Right-click failed rules to view options on the

action to take for the rule:
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Figure 3. Accessibility Checker Pane, Right-Click Options for Failed Rules

· Click Fix to fix the document in order to pass the rule. Note that some rules require a manual

fix.

· Click Skip Rule to omit the rule from the accessibility check.

· Click Explain to view an explanation of the rule.

· Click Check Again to check the rule again. You can use this option to save time instead of

running a full accessibility check after you have performed manual repairs on the document.

· Click Show Report to open the Accessibility Report  pane and view the accessibility report

for the current document.

· Click Options to determine options for when the accessibility check runs, as detailed here.

421
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3.3.3.1.15  Accessibility Report

 Accessibility Report

Click Accessibility Report to open the Accessibility Report pane:

Figure 1. View Tab, Panes Dropdown Menu, Accessibility Report

The Accessibility Report pane displays a report after an accessibility check is performed:
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Figure 2. Accessibility Report Pane

This report details a summary of the results of the accessibility check. It also lists the current status of

the document in relation to each rule in the accessibility check. Click rules to view further information. A

complete breakdown of these rules is available here.  You can use the Accessibility Checker pane to

view further information about the results of each rule and fix any issues that are preventing the

document from passing the accessibility check.

1083
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3.3.3.1.16  Pan and Zoom

 Pan and Zoom

Click Pan and Zoom to open the Pan and Zoom pane:

Figure 1. View Tab, Panes Dropdown Menu, Pan and Zoom

The Pan and Zoom pane displays a miniature version of the current page to assist in editing

documents:
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Figure 2. Active Pan and Zoom Pane

The blue rectangle in the Pan and Zoom pane determines the current view in the main window.

· Click and drag the rectangle to adjust the current view.

· Click and drag the yellow control points to manipulate the pan and zoom in the main window.

· Click and drag the Pan and Zoom pane to reposition it on the screen. When it is selected, four

icons will appear in the center of the borders of the main window:
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Figure 3. Pan and Zoom Pane Docking Options

Move the pointer to these icons and then release the mouse button to dock the Pan and Zoom pane.

Use the icons in the Pan and Zoom pane to perform the following operations:

Use the  zoom dropdown menu, or enter a value manually, to adjust the zoom level

of the view in the pan and zoom pane.

Use the   Zoom in/Zoom Out buttons to zoom in/out to predefined levels of zoom.

Use the   First Page/Last Page buttons to move to the first/last page of documents.

Use the   Previous Page/Next Page buttons to move to the previous/next page of

documents.

Use the   Page box to browse to document pages. Enter page numbers and press

enter to move to the page specified.

Use the  Snapshot icon to copy the current view to the clipboard.
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3.3.3.1.17  Stamps Palette

 Stamps Palette

Click Stamps Palette to open the Stamps Palette:

Figure 1. View Tab, Panes Dropdown Menu, Stamps Palette

The Stamps Palette contains all default and custom stamps:
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Figure 2. Stamps Palette

Stamps are used to give documents specific designations, as detailed in (figure 2). Click to select

stamps, then click to add them to documents. Use the icons in the Stamps Palette to perform the

following operations:

Use the  Zoom in/Zoom Out buttons to adjust the zoom level.

Click   Rename to rename selected stamps.

Click  Delete to delete selected stamps.

Click  Add New to view stamp creation options:



428

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 3. Stamp Creation Options

· Click Add New Stamp from File to create a stamp from an existing file.

· Click New Stamp from Selection to create a stamp from selected document content.

· Click New Stamp from Active Document to create a stamp from the active document.

· Click Add New Stamp from Clipboard to create a new stamp from the current clipboard

content.

· Click Get More to view/download free stamps collections on the PDF-XChange Co

website.

· Click and drag the Stamps Palette to reposition it on the screen. When it is selected, four

icons will appear in the center of the borders of the main window:

Figure 4. Stamps Palette Docking Options

Move the pointer to these icons and then release the mouse button to dock the Stamps Palette.

Further information about stamps and the creation of stamps is available here. 579
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3.3.3.1.18  Comment Styles Palette

 Comment Styles Palette

Click Comment Styles Palette to open the Comment Styles Palette:

Figure 1. View Tab, Panes Dropdown Menu, Comment Styles Palette

The Comment Styles Palette contains all default and customized comment styles:
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Figure 2. Comment Styles Palette

Comments are used to markup and annotate documents. The Comment Styles Palette facilitates the

creation, saving and selection of custom comment styles. Select comment formats in the Drawings list

and then click Properties to view/edit the properties of the comment style. All comment properties are

detailed here.  Double-click to enable comment styles for use in PDF-XChange Editor. Click and

drag the Comment Styles Palette to reposition it on the screen. When it is selected, four icons will

appear in the center of the borders of the main window:

1303
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Figure 3. Comment Styles Palette Docking Options

Move the pointer to these icons and then release the mouse button to dock the Comment Styles

Palette pane. Use the icons in the Comment Styles Palette to perform the following operations:

Click  Reset to reset all comment styles.

Click  Clone to clone the selected style. The feature creates a clone of an existing style, which

is useful when it is desired to edit the properties of a style without losing the original

customization.

Click  Rename to rename selected comment styles.

Click  Reset to reset selected comment styles.

Click  Delete to delete selected comment styles. Please note that it is not possible to delete

the default comment styles.

Click  Properties to view/edit the properties of selected comment styles, as detailed above.

Click  Set Current to set the selected comment style as the current style for the selected

comment format.
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3.3.3.1.19  Spell Check

 Spell Check

Click Spell Check to open the Spell Check pane:

Figure 1. View Tab, Panes Dropdown Menu, Spell Check

The Spell Check pane is used to perform spell checks on documents:
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Figure 2. Spell Check Pane

Click Start to initiate spell checks. Further information on the Spell Check feature and its settings are

available here. 973
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3.3.3.1.20  Document Recovery

 Document Recovery

Click Document Recovery to open the Document Recovery pane:

Figure 1. View Tab, Panes Dropdown Menu, Document Recovery

The Document Recovery pane details documents recovered when PDF-XChange Editor is closed and

unsaved changes are present:
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Figure 2. Document Recovery Pane

Recovered documents are detailed in the pane. Use the icons in the Recovery pane to perform the

following operations:

Click  Recover to recover selected documents. Recovered documents will be displayed in the

main window.

Click  Delete to delete selected documents.

Click  Options to view/determine recovery options. The Documents preferences will open.

These preferences are detailed here. 195
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3.3.3.1.21  History

 History

Click History to open the History pane:

Figure 1. View Tab, Panes Dropdown Menu, History

The History pane details the history of documents opened in PDF-XChange Editor: 
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Figure 2. History Pane

The history of opened documents is detailed in the pane. Click the dropdown menus to view

documents opened in the last hour/yesterday/last week/last month, and double-click to open

documents. Use the Find search box to search for/open documents. Use the icons in the pane to

perform the following operations:

Click  Open to open selected documents.

Click  Remove to remove selected documents from the pane.

Click  Collapse to collapse all groups in the pane.

Click  Expand to expand all groups in the pane.

Click  Options for additional options:
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Figure 3. History Options

· Click Open to open selected documents.

· Click Copy Full File Name to copy the full name of selected documents to the clipboard.

· Click Open Containing Folder to open the containing folder of selected documents.

· Click Pin/Unpin to pin/unpin selected documents. Pinned documents remain at the top of the

Recent Files  list, which makes them easier to locate and open. You can use the Show

Pinned Group option detailed below to show/hide pinned documents in the History pane.

· Hover over Sort by to determine how files in the History pane are sorted, then select Opened

time, Modified time, Closed time or Alphabetical as desired. Click Show Time-Groups to

enable/disable the grouping of documents in the History pane.

· Click Show Thumbnail to show/hide document thumbnails in the History pane.

· Click Show Path to show/hide document paths in the History pane.

· Click Show Captions to show/hide document names in the History pane.

· Click Show Pinned Group to show/hide the pinned documents in the History pane.

· Click Show Preview Pop-Up to show/hide a pop-up preview of items in the History pane.

89
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· Click Use Regular Expressions for Find to enable the use of ECMAScript syntax-based regular

expressions in the Find search box of the History pane.

· Click Select All to select all documents in the History pane.

· Click Collapse All/Expand All to collapse/expand all groups of documents in the History pane.

· Click Remove to remove selected documents from the History pane.

· Click Clear to remove specified documents from the History pane.

· Click History and Recents Options to manage options for the document history and recent

documents. The Manage History and Recents dialog box will open, as detailed here. 89

http://www.cplusplus.com/reference/regex/ECMAScript/
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3.3.3.1.22  Properties Pane

 Properties Pane

Click Properties Pane (or press Ctrl+') to open the Properties pane:

Figure 1.  View Tab, Panes Dropdown Menu, Properties Pane

This pane displays the properties of selected document content:
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Figure 2. Properties Pane

Click properties in the Properties pane to edit them as desired. (Please note that not all properties can

be edited). Definitions of tool and comment properties are detailed here. 1303
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3.3.3.2 Zoom In/Out Tool

 Zoom In/Out Tool

Click Zoom In/Out Tool to enable this tool:

Figure 1. Tools Tab Submenu. Zoom In/Out Tool

The Zoom In/Out Tool is used to adjust the zoom level. When it is selected the pointer becomes a

magnifying glass icon. Click to zoom to the location at which the icon is located. Hold Ctrl and click to

zoom out. Alternatively, click and drag the pointer to determine an area. The Zoom In/Out Tool will

move the current view to the area specified when the mouse button is released.
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3.3.3.3 Loupe Tool

 Loupe Tool

Click Loupe Tool to enable this tool:

Figure 1. View Tab, Loupe Tool

The Loupe Tool is used to assist in the editing of PDF documents and to examine documents in closer

detail. When the Loupe Tool is enabled, the Loupe box is displayed in the current document. The

content of the Loupe box determines the content of the Loupe window:
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Figure 2. Active Loupe Tool

· Adjust the size of the Loupe window to determine the proportions of the Loupe box.

· Use the zoom number box in the Loupe window toolbar, or the plus and minus icons, to

determine the level of zoom displayed in the window.

· Click the camera icon in the loupe window toolbar to take a snapshot of the current view. A

bitmap copy of the selection will be pasted to the clipboard.

· Click the track mouse icon in the loupe window toolbar to enable/disable the Track Mouse

feature. When this feature is enabled the Loupe Tool will follow the pointer. Disable this

feature to adjust the size of the Loupe box as a standard content item.

· Click the Show Page Boxes icon to show/hide page boxes. Page boxes determine the content

and appearance of PDF documents, especially with regards to printing. Further information on

page boxes is available here.

· Click and drag the loupe window to reposition it on the screen. When the mouse button is

clicked, four icons will appear in the center of the borders of the main window. Move the

pointer onto these icons and release the mouse button to dock the loupe window.

1282
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3.3.3.4 Pan and Zoom

 Pan and Zoom

Click Pan and Zoom to enable the Pan and Zoom window:

Figure 1. View Tab, Pan and Zoom

The Pan and Zoom window is used to navigate and zoom in on/out from documents:



447

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 2. Pan and Zoom Window

· The blue rectangle determines the current view in the main window. Click and drag the

rectangle to adjust the current view. 

· Adjust the yellow control points to manipulate the pan and zoom. Alternatively, use the plus

and minus icons in the toolbar to zoom incrementally, or enter a zoom level in the number

box. 

· Use the arrow icons in the Pan and Zoom toolbar to move between document pages. 

· Click the camera icon in the Pan and Zoom toolbar to take a snapshot of the current view. A

bitmap copy of the selection will be pasted to the clipboard.

· Click and drag the Pan and Zoom window to reposition it on the screen. When it is selected,

four icons will appear in the center of the borders of the main window. Move the pointer onto

these icons and release the mouse button to dock the Pan and Zoom window.
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3.3.3.5 Page Transitions

 Page Transitions

Click Page Transitions to determine how PDF-XChange Editor moves through pages in full screen

mode:

Figure 1. View Tab, Page Transitions

The Page Transitions dialog box will open:
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Figure 2. Page Transitions Dialog Box

Use the Page Transition settings to determine transition parameters:

· Use the Transition dropdown menu to determine the transition style.

· Use the Direction dropdown menu to determine the direction of transitions.

· Use the Duration dropdown menu to determine the rate of transitions.

· Select the check box to move automatically through pages, then select an option from the

dropdown menu to set an automatic scrolling rate. 

Use the Page Range settings to determine the page range to which the specified transition settings

apply:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

Click OK to save settings.

1285
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3.3.3.6 Rulers, Guides and Grid

 Rulers, Guides and Grid

These features are used to assist in the accurate placement and measurement of document content.

Rulers

Click the View tab, then click Show Rulers to enable/disable rulers:

Figure 1. View Tab, Show Rulers

Rulers will then be displayed in the main window:
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Figure 2. View Tab, Show Page Size/Position Feature and Output Highlighted

Note that the units of measurement used for rulers can be specified in the Measurement

 preferences.

Guides

Guides are used to assist in the accurate placement of document content. 

Click the View Tab, then click Show Guides to enable/disable guides:

238
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Figure 3. View Tab, Show Guides

When guides are enabled, click and drag from rulers to add guide lines to the document:
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Figure 4. View Tab, Guides Added

Right-click rulers for additional options:
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Figure 5. Rulers Right-Click Shortcut Menu

· Click Centimeters, Inches, Millimeters, Picas or Points to determine the units of measurement

that rulers use.

· Click Show Rulers to show/hide rulers.

· Click Show Grid to show/hide the grid, as detailed below.

· Click Show Page Size/Position to show/hide the current page size and pointer location. These

details are displayed in the Document Options toolbar, which is in the lower-left section of the

user interface.

· Click Bottom Up Y-axis to enable/disable the displaying of units in the y-axis from the bottom

of the UI.

· Click Show Guides to show/hide guides that have been created as detailed above.

· Click Add New Guides to add new guides to documents. This feature allows you to add guides

to multiple pages of documents. When it is selected, the Add Page Guides dialog box will

open, as detailed below.

· Click Delete Guides on Current Page to delete guides from the current page.

· Click Delete All Page Guides to delete all page guides from the current document.

· Click Import Guides to import guides into documents.

· Click Export Guides to export guides to file. Exported guides can be imported into documents

using the Import Guides feature.

· Click Measurement Options to view/edit the Measurement preferences, as detailed here. 238
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Figure 6. Add Page Guides Dialog Box

· Use the Page Range options to determine the pages to which new guides are added:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Select Horizontal or Vertical to specify the type of guides you want to add to the document.

· Use the Position on Page dropdown menu to determine the position at which the guides are

added.

· Use the Count per Page dropdown menu to determine how many guides are added to each

page.

· Use the Distance Between dropdown menu to determine the distance between each guide.

· Use the Units dropdown menu to determine the units used in the Distance Between

dropdown menu.

Click OK to add page guides to the document.

1285
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Grid

When the grid is enabled it is interposed on the current document and can be used to ensure that

content is placed on the same horizontal/vertical plane. Click the View Tab, then click Show Grid to

enable/disable the grid:

Figure 7. View Tab, Show Grid Highlighted and Grid Enabled
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3.3.4 Comment Tab

 Comment Tab

When the Comment tab is selected, the following options are available:

Figure 1. Comment Tab

Comments are a convenient and customizable way to markup and annotate documents. There are

seven groups in the Comments tab:

Tools

The Tools group contains shortcuts to tools and other features:
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· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Customizable

options are available for the Snapshot Tool in the Snapshot Tool preferences, which are

detailed here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

· Click Select Comments to select comments for editing purposes. Further information on this

tool is available here.

Text

The Text group contains options for adding annotations that include text to documents:

286

1102

1087

462

269

1147 1295

462



459

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Click Typewriter Tool to add typewriter-style annotations to documents. Further information

about this tool is available here.

· Click Text Box Tool to add text boxes to documents. Further information about this tool is

available here.

· Click Callout Tool to add callout annotations to documents. These annotations are similar to

text box annotations, but they also include an arrow that can be used to highlight a specific

location documents. Further information about this tool is available here.

Note

The Note group contains options for adding note-style annotations to documents:

· Click Sticky Note Tool to add sticky note annotations to documents, as detailed here.

· Click Attach File Tool to attach files to documents and add an icon that can be clicked to open

the attachment, as detailed here.

· Click Sound Tool to add audio content to documents, as detailed here.  

Text Markup

The Text Markup group contains options for updating document text:

· Click Highlight Text Tool to highlight text, as detailed here.

· Click Underline Text Tool to underline text, as detailed here.

· Click Strikeout Text Tool to strikeout text, as detailed here.
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· Click Insert Text Tool to add a caret annotation that indicates text should be inserted, as

detailed here.

· Click Replace Text Tool to add a caret annotation that indicates text should be replaced, as

detailed here.

· Click Text Correction to perform text correction on documents, as detailed here.

Drawing

The Drawing group contains options for adding annotations to documents:

· Click the Line tool to add line annotations to documents, as detailed here.

· Click the Arrow tool to add arrow annotations to documents, as detailed here.

· Click the Rectangle tool to add rectangle annotations to documents, as detailed here.

· Click the Oval tool to add oval annotations to documents, as detailed here.

· Click the Polygon Line tool to add polygon line annotations to documents, as detailed

here.

· Click the Polygon tool to add polygon annotations to documents, as detailed here.

· Click the Stamp tool to add stamps to documents, as detailed here.

· Click the Pencil tool to add freehand annotations to documents, as detailed here.

· Click the Eraser tool and then click and drag to erase pencil tool annotations.

Measure

The Measure group contains options for measuring documents:

· Click the Distance tool to measure the distance between two points in documents and insert

annotations that display the distance measured, as detailed here.

· Click the Perimeter tool to measure the distance between multiple points and insert

annotations that display the distance measured, as detailed here.

· Click the Area tool to measure the area within user-specified polygons, as detailed here.
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Media

· Click Add/Edit Video to add/edit video annotations, as detailed here.

· Click Add/Edit Sound to add/edit sound annotations, as detailed here.

· Click Add/Edit 3D Annotations to add/edit 3D annotations, as detailed here.

Manage Comments

The Manage Comments group contains editing options for comments:

· Click Summarize Comments to create a comment summary, as detailed here.

· Click Import to import comments from file, as detailed here.

· Click Export to export comments to file, as detailed here.

· Click the Show dropdown menu to determine which comments are shown/hidden, as detailed

here.

· Click Flatten to flatten comments to base content, as detailed here.

· Click Comments List to open/close the Comments  pane.

· Click Comment Styles to open the Comment Styles Palette and edit comment styles, as

detailed here.

Additionally, please note that several of the keyboard shortcuts relate to comments. See here  for a

comprehensive list of available shortcuts.
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3.3.4.1 Select Comments

 Select Comments

Click Select Comments to enable the Select Comments tool:

 

Figure 1. Comment Tab, Select Comments

This tool is used to select comments for editing. Click to select comments, or click and drag to select

multiple comments:
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Figure 2. Select Comments, Group Select

· Click and drag control points to resize comments.

· Click and drag comments to reposition them. The circle at the center can also be used for this

purpose.

· Click and drag the green control point at the top to rotate comments. Hold down Shift to

rotate at increments of fifteen degrees.

· Use the arrow keys to reposition comments.

· Use the editing aids detailed here  to assist in the precise placement of comments.

· Press Ctrl+' to open the Properties  pane and view/edit the properties of selected

comments. Note that the subject and author properties can be updated for multiple selected

comments simultaneously.

· Right-click comments to enable further options. See here  for an explanation of these

options.

· The Commenting  preferences can be used to view/edit preferences for comments.

· When customized Comment Styles  have been created it is possible to switch between

styles when comments are selected.
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3.3.4.2 Typewriter Tool

 Typewriter Tool

Click Typewriter to add typewriter-style text comments to documents:

Figure 1. Comment Tab, Typewriter Tool

When the Typewriter Tool is enabled, the text 'Typewriter' will appear beneath the pointer, as detailed

in the upper example in the image below. This text displays at the location where text will be located if

the comment is created at the current location. Click to add typewriter comments:
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Figure 2. Typewriter Tool Examples

· The upper image is how a typewriter note appears before it is first inserted into a document.

Click to add a typewriter note at the current location.

· The central image is how a typewriter note appears when text is being entered. Right-click

typewriter notes to customize text and paragraph options, as explained here.

· The lower image is how a typewriter note appears when it is completed and subsequently

selected.

· Click and drag the control points to resize typewriter text boxes.

· Click and drag to reposition typewriter text boxes.

· Click and drag the green control point to rotate typewriter text boxes. Hold down Shift to

rotate at increments of fifteen degrees.

· Use the arrow keys to reposition typewriter text boxes. Hold down Shift to move at an

increased increment.

· Use the editing aids detailed here  to assist in the precise placement of typewriter text

boxes.

· Right-click typewriter text boxes for further options. See here  for an explanation of

these options.

· Press Ctrl+' to open the Properties pane for selected typewriter comments and view/edit

properties:
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Figure 3. Typewriter Tool, Typewriter Properties Pane Enabled

· Subject is the name of the typewriter note comment, as referenced in the Comments  pane.

· Author is the name of the user that created the typewriter note comment.

· Name is the unique name of the typewriter note comment, as referenced within the

application.

· Created is the date and time at which the typewriter note comment was created.

· Modified is the date and time at which the typewriter note comment was last modified.

· Read Only is the read only status of the typewriter note comment. If this property is enabled

then users cannot interact with the comment. Please note that it is necessary to use JavaScript

to change the value of this property.

· Printable is the print status of the typewriter note comment. If this property is enabled then the

comment is printed with the document. If this property is not enabled then the comment is not

printed.

· Locked determines the locked status of the typewriter note comment. If this property is

enabled then the comment cannot be deleted and its properties (including its position and

size) cannot be modified by users.

· Layer determines the optional content layer to which the typewriter note comment belongs.

Further information about layers is available here.

· Fill Color determines the color of the typewriter note comment.

· Stroke Color determines the border color of the typewriter note comment.
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· Border Width determines the border width of the typewriter note comment.

· Opacity determines the level of transparency in the typewriter note comment.

· Blend Mode determines how the typewriter note comment blends with overlapping content, as

detailed here.

· Rotation determines the degrees of rotation of the typewriter note comment.

 

Note that when the Typewriter Tool is enabled, the Format tab is available and can be used to

customize the default properties of typewriter notes:

Figure 4. Format Tab, Typewriter Tool

· Click options in the Shape Style group to select alternative default typewriter note styles.

· Click Keep Selected to keep the Typewriter Tool enabled and add multiple typewriter notes to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one typewriter note.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Typewriter Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements

of documents other than base content. This makes it possible to create typewriter notes on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.
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· Click Properties to open the Properties pane and view/edit typewriter tool properties, as

detailed above. Note that when the tool is enabled but no comments are selected, there are

additional options available in the Properties pane:

· Text Color determines the default text color for typewriter comments.

· Font determines the default font for typewriter comments.

· Font Size determines the default font size for typewriter comments.

· Text Alignment determines the default text alignment for typewriter comments.

· When typewriter notes are selected, the Style Tools dropdown menu is available in the Format

tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of comments.

· Click Apply Copied Comment Style to apply a copied comment style to selected

comments, including the text properties.

· Click Apply Copied Comment Appearance to apply copied comment styles to selected

comments.

· Click Apply Copied Text Style to apply copied text styles to selected comments.

· Click Make Current Properties Default to set the properties of the selected comment as

the default properties for subsequent comments.

· Click Apply Default Properties to apply the default comment properties to selected

comments.

· Click Make Current Text Format Default to set the text format of selected comments as

the default format for subsequent comments.

· Click Apply Default Text Format to apply the default text format to the text of selected

comments.

· When typewriter notes are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the the Comment Styles Palette  can be used to edit and save customized typewriter note

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.

Note that to select text in an annotation after it has been completed, it is necessary to click to select

the annotation and then click again to select the text. This is because PDF-XChange Editor must

recognize annotations and the text that annotations contain as separate items as they feature different

editing options. Text editing options are detailed here.
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3.3.4.3 Text Box Tool

 Text Box Tool

Click Text Box to add text box comments to documents:

Figure 1. Comment Tab, Text Box Tool

When the Text Box Tool is enabled, click and drag the pointer to determine the size of text boxes:
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Figure 2. Text Box Tool Examples

· The upper image is how a text box appears when it is first inserted into a document. Enter the

desired text using the keyboard. Press Enter to start new lines. Note that text style options are

enabled in the Format Tab when text is being entered.

· The central image is how a text box appears when text is being entered. Right-click text boxes

to view/select text editing options, as detailed here.

· The lower image is how a text box appears when it is completed and subsequently selected.

· Click and drag the control points to resize text boxes.

· Click and drag to reposition text boxes.

· Click and drag the green control point to rotate text boxes. Hold down Shift to rotate at

increments of fifteen degrees.

· Use the arrow keys to reposition text boxes. Hold down Shift to move at an increased

increment.

· Use the editing aids detailed here  to assist in the precise placement of text boxes.

· Right-click text boxes for further options. See here  for an explanation of these options.

· Press Ctrl+' to open the Properties pane for selected text box comments and view/edit

properties:
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Figure 3. Text Box Tool, Text Box Properties Pane Enabled

· Subject is the name of the text box comment, as referenced in the Comments  pane.

· Author is the name of the user that created the text box comment.

· Name is the unique name of the text box comment, as referenced within the application.

· Created is the date and time at which the text box comment was created.

· Modified is the date and time at which the text box comment was last modified.

· Read Only is the read only status of the text box comment. If this property is enabled then

users cannot interact with the comment. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the text box comment. If this property is enabled then the

comment is printed with the document. If this property is not enabled then the comment is not

printed.

· Locked is the locked status of the text box comment. If this property is enabled then the

comment cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the text box comment belongs. Further

information about layers is available here.

· Fill Color determines the color of the text box comment.

· Stroke Color determines the border color of the text box comment.

· Border Style determines the border style of the text box comment
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· Border Width determines the border width of the text box comment.

· Opacity determines the level of transparency in the text box comment.

· Blend Mode determines how the text box comment blends with overlapping content, as

detailed here.

· Rotation determines the degrees of rotation of the text box comment.

Note that when the Text Box Tool is enabled, the Format tab is available and can be used to

customize the default properties of text boxes:

Figure 4. Format Tab, Text Box Tool

· Click options in the Shape Style group to select alternative default text box styles.

· Click Keep Selected to keep the Text Box Tool enabled and add multiple text boxes to the

document. If this option is not enabled then PDF-XChange Editor will revert to the designated

default tool immediately after creating one text box.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the Text

Box Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create text boxes on areas that

overlap with other content without the risk of accidentally selecting undesired items. When

Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying elements

in the usual manner.
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· Click Properties to open the Properties pane and view/edit Text Box Tool properties, as

detailed above. Note that when the tool is enabled but no comments are selected, there are

additional options available in the Properties pane:

· Text Color determines the default text color for text box comments.

· Font determines the default font for text box comments.

· Font Size determines the default font size for text box comments.

· Text Alignment determines the default text alignment for text box comments.

· When text box comments are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of comments.

· Click Apply Copied Comment Style to apply a copied comment style to selected

comments, including the text properties.

· Click Apply Copied Comment Appearance to apply copied comment styles to selected

comments.

· Click Apply Copied Text Style to apply copied text styles to selected comments.

· Click Make Current Properties Default to set the properties of the selected comment as

the default properties for subsequent comments.

· Click Apply Default Properties to apply the default comment properties to selected

comments.

· Click Make Current Text Format Default to set the text format of selected comments as

the default format for subsequent comments.

· Click Apply Default Text Format to apply the default text format to the text of selected

comments.

· When text box comments are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the the Comment Styles Palette  can be used to edit and save customized text box styles

for subsequent use, and the Commenting  preferences can be used to view/edit preferences for all

comments.

Note that to select text in an annotation after it has been completed, it is necessary to click to select

the annotation and then click again to select the text. This is because PDF-XChange Editor must

recognize annotations and the text that annotations contain as separate items as they feature different

editing options. Text editing options are detailed here.
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3.3.4.4 Callout Tool

 Callout Tool

Click Callout to add callout annotations to documents: 

Figure 1. Comment Tab, Callout Tool

Callout annotations are used to highlight specific locations in documents. They are composed of a text

box that features a linked arrow annotation, which is used to highlight areas of importance in the

document. 
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When the Callout Tool is enabled, click to add callout annotations. The position of the pointer when

the mouse is clicked determines the initial position of the arrowhead in the callout arm. The image

below details callout annotations at three stages of editing:

Figure 2. Callout Tool Examples

· The upper image is how a callout annotation appears when it is first inserted into a document.

Enter the desired text using the keyboard. Press Enter to start new lines. Note that text style

options are enabled in the Format Tab  when text is being entered.

· The central image is how a callout annotation appears when text is being entered. Right-click

text boxes to view/select text editing options, as detailed here.

· The lower image is how a callout annotation appears when it is completed and subsequently

selected.

· Click and drag the control points to resize callout annotations and/or reposition the

callout arrow.

· Click and drag callout annotations to reposition them.

· Click and drag the green control point to rotate callout annotations. Hold down Shift to

rotate at increments of fifteen degrees.

· Use the arrow keys to reposition callout annotations. Hold down Shift to move at an

increased increment.
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· Use the editing aids detailed here  to assist in the precise placement of callout

annotations.

· Right-click callout annotations for further options. See here  for an explanation of

these options.

· Press Ctrl+' to open the Properties pane for selected callout comments and view/edit

properties:

Figure 3. Callout Tool, Callout Properties Pane Enabled

· Subject is the name of the callout comment, as referenced in the Comments  pane.

· Author is the name of the user that created the callout comment.

· Name is the unique name of the callout comment, as referenced within the application.

· Created is the date and time at which the callout comment was created.

· Modified is the date and time at which the callout annotation was last modified.

· Read Only is the read only status of the callout annotation. If this property is enabled then

users cannot interact with the comment. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the callout annotation. If this property is enabled then the

comment is printed with the document. If this property is not enabled then the comment is not

printed.
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· Locked is the locked status of the callout annotation. If this property is enabled then the

comment cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the callout annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the callout annotation.

· Stroke Color determines the border color of the callout annotation.

· Border Style determines the border style of the callout annotation

· Border Width determines the border width of the callout annotation.

· Opacity determines the level of transparency in the callout annotation.

· Blend Mode determines how the callout annotation blends with overlapping content, as

detailed here.

· Rotation determines the degrees of rotation of the callout annotation.

· End determines the line ending used for the arm of the callout annotation.

· End Scale determines the size of the line ending in relation to the rest of the callout annotation.

Note that when the Callout Tool is enabled, the Format tab is available and can be used to customize

the default properties of callout annotations:

Figure 4. Format Tab, Callout Tool
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· Click options in the Shape Style group to select alternative default callout box styles.

· Click Keep Selected to keep the Callout Tool enabled and add multiple callout annotations to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one callout annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Callout Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create callout annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Callout Tool properties, as

detailed above. Note that when the tool is enabled but no comments are selected, there are

additional options available in the Properties pane:

· Text Color determines the default text color for callout annotations.

· Font determines the default font for callout annotations.

· Font Size determines the default font size for callout annotations.

· Text Alignment determines the default text alignment for callout annotations.

· When callout annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of comments.

· Click Apply Copied Comment Style to apply a copied comment style to selected

comments, including the text properties.

· Click Apply Copied Comment Appearance to apply copied comment styles to selected

comments.

· Click Apply Copied Text Style to apply copied text styles to selected comments.

· Click Make Current Properties Default to set the properties of the selected comment as

the default properties for subsequent comments.

· Click Apply Default Properties to apply the default comment properties to selected

comments.

· Click Make Current Text Format Default to set the text format of selected comments as

the default format for subsequent comments.

· Click Apply Default Text Format to apply the default text format to the text of selected

comments.

· When callout annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the the Comment Styles Palette  can be used to edit and save customized callout

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.

Note that to select text in an annotation after it has been completed, it is necessary to click to select

the annotation and then click again to select the text. This is because PDF-XChange Editor must
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recognize annotations and the text that annotations contain as separate items as they feature different

editing options. Text editing options are detailed here. 1142



480

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.4.5 Sticky Note Tool

 Sticky Note Tool

Click Sticky Note to add sticky note comments to documents: 

Figure 1. Comment Pane, Sticky Note Tool

Sticky note comments enable the storage of text notes. The text in sticky note comments is contained in

a collapsible text box that can be expanded as required. When the text box is collapsed, only the sticky

note icon remains in the document. This means that large text notes can be stored in documents

without taking up excessive space. If the pointer is hovered over the sticky note icon subsequently then

the note content will be displayed.
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When the Sticky Note Tool is enabled, click to add sticky notes:

Figure 2. Sticky Note Tool Example

· Click and drag the sticky note to reposition it.

· Enter the desired note content within the associated pop-up note text box. This content will be

displayed when the pointer is hovered over the icon subsequently. Right-click when

entering/editing text to launch the text editing options menu. These options are explained

here.

· Use the arrow keys to reposition sticky notes. Hold down Shift to move at an increased

increment.

· Right-click sticky notes for further options. See here  for an explanation of these options.

· Press Ctrl+' to open the Properties pane for selected sticky note comments and view/edit

properties:
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Figure 3. Sticky Note Tool, Sticky Note Properties Pane

· Subject is the name of the sticky note comment, as referenced in the Comments  pane.

· Author is the name of the user that created the sticky note comment.

· Name is the unique name of the sticky note comment, as referenced within the application.

· Created is the date and time at which the sticky note comment was created.

· Modified is the date and time at which the sticky note comment was last modified.

· Read Only is the read only status of the sticky note comment. If this property is enabled then

users cannot interact with the comment. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the sticky note comment. If this property is enabled then the

comment is printed with the document. If this property is not enabled then the comment is not

printed.

· Locked is the locked status of the sticky note comment. If this property is enabled then the

comment cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the sticky note comment belongs. Further

information about layers is available here.

· Fill Color determines the color of the sticky note comment.

· Icon determines the icon used for the sticky note comment.

· Opacity determines the level of transparency in the sticky note comment.
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Note that when the Sticky Note Tool is enabled, the Format tab is available and can be used to

customize the default properties of sticky notes:

Figure 4. Format Tab, Sticky Note Tool

· Click options in the Shape Style group to select alternative default sticky note styles.

· Click Keep Selected to keep the Sticky Note Tool enabled and add multiple sticky notes to the

document. If this option is not enabled then PDF-XChange Editor will revert to the designated

default tool immediately after creating one sticky note.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Sticky Note Tool. When Exclusive Mode is enabled, the pointer ignores all interactive

elements of documents other than base content. This makes it possible to create sticky notes on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

· Click Properties to open the Properties pane and view/edit sticky note properties, as detailed

above.

· When sticky note comments are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of comments.
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· Click Apply Copied Comment Style to apply a copied comment style to selected

comments, including the text properties.

· Click Apply Copied Comment Appearance to apply copied comment styles to selected

comments.

· Click Apply Copied Text Style to apply copied text styles to selected comments.

· Click Make Current Properties Default to set the properties of the selected comment as

the default properties for subsequent comments.

· Click Apply Default Properties to apply the default comment properties to selected

comments.

· Click Make Current Text Format Default to set the text format of selected comments as

the default format for subsequent comments.

· Click Apply Default Text Format to apply the default text format to the text of selected

comments.

· When sticky note comments are selected, the Pop-up group is available in the Format tab and

can be used to interact with the pop-up note of the comment:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When sticky note comments are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized sticky note styles

for subsequent use, and the Commenting  preferences can be used to view/edit preferences for all

comments.

Note that to select text in an annotation after it has been completed, it is necessary to click to select

the annotation and then click again to select the text. This is because PDF-XChange Editor must

recognize annotations and the text that annotations contain as separate items as they feature different

editing options. Text editing options are detailed here.
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3.3.4.6 File Attachment Tool

 File Attachment Tool

Click the File Attachment Tool to embed files into documents:

Figure 1. Comment Tab, File Attachment Tool

When the File Attachment Tool is enabled, the pointer becomes a crosshairs icon. Move the crosshairs

to the desired location and click to embed a file. The Open Files dialog box will open. Select the

desired file and click Open. The link to the embedded file will then appear in the document:
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Figure 2. File Attachment Tool Examples

· Click and drag the file attachment icon, or use the arrow keys, to reposition it. Hold down Shift

to move at an increased increment when using the arrow keys.

· Double-click the file attachment icon to open the attached file.

· Right-click file attachment icons for further options. See here  for an explanation of those

options.

· Press Ctrl+' to open the Properties pane for selected file attachment comments and view/edit

properties:
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Figure 3. File Attachment Tool, File Attachment Properties Pane

· Subject is the name of the file attachment comment, as referenced in the Comments  pane.

· Author is the name of the user that created the file attachment comment.

· Name is the unique name of the file attachment comment, as referenced within the

application.

· Created is the date and time at which the file attachment comment was created.

· Modified is the date and time at which the file attachment comment was last modified.

· Read Only is the read only status of the file attachment comment. If this property is enabled

then users cannot interact with the comment. Please note that it is necessary to use JavaScript

to change the value of this property.

· Printable is the print status of the file attachment comment. If this property is enabled then the

comment is printed with the document. If this property is not enabled then the comment is not

printed.

· Locked is the locked status of the file attachment comment. If this property is enabled then the

comment cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the file attachment comment belongs.

Further information about layers is available here.

· Fill Color determines the color of the file attachment comment.

· Icon determines the icon used for the file attachment comment.
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· Opacity determines the level of transparency in the file attachment comment.

Note that when the File Attachment Tool is enabled, the Format tab is available and can be used to

customize the default properties of file attachments:

Figure 4. Format Tab, File attachment Tool

· Click options in the Shape Style group to select alternative default file attachment annotation

styles.

· Click Keep Selected to keep the File Attachment Tool enabled and add multiple file

attachment annotations to the document. If this option is not enabled then PDF-XChange

Editor will revert to the designated default tool immediately after creating one file attachment

annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the File

Attachment Tool. When Exclusive Mode is enabled, the pointer ignores all interactive

elements of documents other than base content. This makes it possible to create file

attachment annotations on areas that overlap with other content without the risk of

accidentally selecting undesired items. When Exclusive Mode is disabled, the pointer

recognizes and interacts with all underlying elements in the usual manner.

· Click Properties to open the Properties pane and view/edit File Attachment Tool properties,

as detailed above.
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· When file attachment comments are selected, the Style Tools dropdown menu is available in

the Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of comments.

· Click Apply Copied Comment Style to apply a copied comment style to selected

comments, including the text properties.

· Click Apply Copied Comment Appearance to apply copied comment styles to selected

comments.

· Click Apply Copied Text Style to apply copied text styles to selected comments.

· Click Make Current Properties Default to set the properties of the selected comment as

the default properties for subsequent comments.

· Click Apply Default Properties to apply the default comment properties to selected

comments.

· Click Make Current Text Format Default to set the text format of selected comments as

the default format for subsequent comments.

· Click Apply Default Text Format to apply the default text format to the text of selected

comments.

· When file attachment comments are selected, the Pop-up group is available in the Format tab

and can be used to interact with the pop-up note of the comment:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When file attachment comments are selected, the Arrange tab is also available and can be

used to manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized file attachment

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.
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3.3.4.7 Sound Tool

 Sound Tool

Click the Sound Tool to add audio content to documents:

Figure 1. Comment Tab, Sound Tool

When the Sound Tool is selected, the pointer becomes a crosshairs icon. Move the icon to the desired

location and click the mouse. The Edit Action: "Play a Sound" dialog box will open:
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Figure 2. Edit Action: "Play a Sound" Dialog Box

· Click the Browse button to select a sound file from the local computer. The Open Files dialog

box will open. Select the desired file and click Open. An icon will appear in the document as

detailed in (figure 3). The selected sound file will play when the icon is clicked.

· Alternatively, click the record button to record a sound with a microphone. Click again to finish

the recording. Click the play/stop buttons to review the sound, and use the slider to adjust the

volume. Click OK when the desired sound has been recorded. The icon will then appear in the

document:

Figure 3. Sound Tool Examples

· Click and drag the icon, or use the arrow keys, to reposition it. Hold down Shift to move at an

increased increment when using the arrow keys.
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· Double-click icons to open the associated sound file.

· Right-click icons for further options. See here  for an explanation of those options.

· Press Ctrl+' to open the Properties pane for selected sound comments and view/edit

properties:

Figure 4. Sound Tool, Sound Properties Pane

· Subject is the name of the sound comment, as referenced in the Comments  pane.

· Author is the name of the user that created the sound comment.

· Name is the unique name of the sound comment, as referenced within the application.

· Created is the date and time at which the sound comment was created.

· Modified is the date and time at which the sound comment was last modified.

· Read Only is the read only status of the sound comment. If this property is enabled then users

cannot interact with the comment. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the sound comment. If this property is enabled then the

comment is printed with the document. If this property is not enabled then the comment is not

printed.

· Locked is the locked status of the sound comment. If this property is enabled then the

comment cannot be deleted and its properties (including its position and size) cannot be

modified by users.
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· Layer determines the optional content layer to which the sound comment belongs. Further

information about layers is available here.

· Fill Color determines the color of the sound comment.

· Icon determines the icon used for the sound comment.

· Opacity determines the level of transparency in the sound comment.

Note that when the Sound Tool is enabled, the Format tab is available and can be used to customize

the default properties of sound comments:

Figure 5. Format Tab, Sound Tool

· Click options in the Shape Style group to select alternative default sound annotation styles.

· Click Keep Selected to keep the Sound Tool enabled and add multiple sound annotations to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one sound annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Sound Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create sound annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

374
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· Click Properties to open the Properties pane and view/edit Sound Tool properties, as detailed

above.

· When sound comments are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of comments.

· Click Apply Copied Comment Style to apply a copied comment style to selected

comments, including the text properties.

· Click Apply Copied Comment Appearance to apply copied comment styles to selected

comments.

· Click Apply Copied Text Style to apply copied text styles to selected comments.

· Click Make Current Properties Default to set the properties of the selected comment as

the default properties for subsequent comments.

· Click Apply Default Properties to apply the default comment properties to selected

comments.

· Click Make Current Text Format Default to set the text format of selected comments as

the default format for subsequent comments.

· Click Apply Default Text Format to apply the default text format to the text of selected

comments.

· When sound comments are selected, the Pop-up group is available in the Format tab and can

be used to interact with the pop-up note of the comment:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When sound comments are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized sound annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.
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3.3.4.8 Highlight Text Tool

 Highlight Text Tool

Click Highlight to add highlight annotations to document text:

Figure 1. Comment Tab, Highlight Text Tool

When the Highlight Text Tool is enabled, the pointer icon changes when it is hovered over text. Click

and drag to highlight text:
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Figure 2. Highlight Text Tool Example

Press Ctrl+' to open the Properties pane for selected highlight annotations and view/edit properties:
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Figure 3. Highlight Text Tool, Highlight Properties Pane

· Subject is the name of the highlight annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the highlight annotation.

· Name is the unique name of the highlight annotation, as referenced within the application.

· Created is the date and time at which the highlight annotation was created.

· Modified is the date and time at which the highlight annotation was last modified.

· Read Only is the read only status of the highlight annotation. If this property is enabled then

users cannot interact with the annotation. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the highlight annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the highlight annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the highlight annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the highlight annotation.

· Opacity determines the level of transparency in the highlight annotation.
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· Blend Mode determines how highlight annotations blend with overlapping content. These

options are explained here.

Note that when the Highlight Text Tool is enabled, the Format tab is available and can be used to

customize the default properties of highlight annotations:

Figure 4. Format Tab, Highlight Text Tool

· Click options in the Shape Style group to select alternative default highlight annotation styles.

· Click Fill Color to determine the color of the highlight annotation.

· Use the Opacity dropdown menu to determine the level of transparency for the highlight

annotation.

· Use the Blend Mode dropdown menu to determine how highlight annotations blend with

overlapping content. These options are explained here.

· Click Keep Selected to keep the Highlight Tool enabled and add multiple highlight

annotations to the document. If this option is not enabled then PDF-XChange Editor will revert

to the designated default tool immediately after creating one highlight annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Highlight Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements

of documents other than base content. This makes it possible to create highlight annotations

on areas that overlap with other content without the risk of accidentally selecting undesired

1109

1109



499

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

items. When Exclusive Mode is disabled, the pointer recognizes and interacts with all

underlying elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Highlight Tool properties, as

detailed above.

· When highlight annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of highlight annotations.

· Click Apply Copied Comment Style to apply a copied highlight annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied highlight annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the highlight annotation

as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default highlight annotation properties to

selected highlight annotations.

· When highlight annotations are selected, the Pop-up group is available in the Format tab and

can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When highlight annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized highlight

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.
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3.3.4.9 Underline Text Tool

 Underline Text Tool

Click Underline to add underline annotations to document text: 

Figure 1. Comment Tab, Underline Text Tool

When the Underline Text Tool is enabled, the pointer icon changes when it is hovered over text. Click

and drag to underline text:
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Figure 2. Underline Text Tool Example

Press Ctrl+' to open the Properties pane for selected underline annotations and view/edit properties:



502

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 3. Underline Text Tool, Underline Properties Pane

· Subject is the name of the underline annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the underline annotation.

· Name is the unique name of the underline annotation, as referenced within the application.

· Created is the date and time at which the underline annotation was created.

· Modified is the date and time at which the underline annotation was last modified.

· Read Only is the read only status of the underline annotation. If this property is enabled then

users cannot interact with the annotation. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the underline annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the underline annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the underline annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the underline annotation.

· Underline Style determines the style used for the underline annotation.

· Thickness Scale determines the thickness of the underline annotation.

358

374



503

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Opacity determines the level of transparency in the underline annotation.

· Blend Mode determines how underline annotations blend with overlapping content. These

options are explained here.

Note that when the Underline Text Tool is enabled, the Format tab is available and can be used to

customize the default properties of underline annotations:

Figure 4. Format Tab, Underline Text Tool

· Click options in the Shape Style group to select alternative default underline annotation styles.

· Click Keep Selected to keep the Underline Tool enabled and add multiple underline

annotations to the document. If this option is not enabled then PDF-XChange Editor will revert

to the designated default tool immediately after creating one underline annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Underline Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements

of documents other than base content. This makes it possible to create underline annotations

on areas that overlap with other content without the risk of accidentally selecting undesired

items. When Exclusive Mode is disabled, the pointer recognizes and interacts with all

underlying elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Underline Tool properties, as

detailed above.
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· When underline annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of underline annotations.

· Click Apply Copied Comment Style to apply a copied underline annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied underline annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the underline annotation

as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default underline annotation properties to

selected underline annotations.

· When underline annotations are selected, the Pop-up group is available in the Format tab and

can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When underline annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized underline

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.
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3.3.4.10 Strikeout Text Tool

 Strikeout Text Tool

Click Strikeout to add strikeout annotations to document text: 

Figure 1. Comment Tab, Strikeout Text Tool

When the Strikeout Text Tool is enabled, the pointer icon changes when it is hovered over text. Click

and drag to strikeout text:
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Figure 2. Strikeout Text Tool Example

Press Ctrl+' to open the Properties pane for selected strikeout annotations and view/edit properties:
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Figure 3. Strikeout Text Tool, StrikeOut Properties Pane

· Subject is the name of the strikeout annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the strikeout annotation.

· Name is the unique name of the strikeout annotation, as referenced within the application.

· Created is the date and time at which the strikeout annotation was created.

· Modified is the date and time at which the strikeout annotation was last modified.

· Read Only is the read only status of the strikeout annotation. If this property is enabled then

users cannot interact with the annotation. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the strikeout annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the strikeout annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the strikeout annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the strikeout annotation.

· Thickness Scale determines the thickness of the strikeout annotation.

· Opacity determines the level of transparency in the strikeout annotation.
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· Blend Mode determines how strikeout annotations blend with overlapping content. These

options are explained here.

Note that when the Strikeout Text Tool is enabled, the Format tab is available and can be used to

customize the default properties of strikeout annotations:

Figure 4. Format Tab, Strikeout Text Tool

· Click options in the Shape Style group to select alternative default strikeout annotation styles.

· Click Keep Selected to keep the Strikeout Tool enabled and add multiple strikeout

annotations to the document. If this option is not enabled then PDF-XChange Editor will revert

to the designated default tool immediately after creating one strikeout annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Strikeout Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements

of documents other than base content. This makes it possible to create strikeout annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Strikeout Tool properties, as

detailed above.
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· When strikeout annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of strikeout annotations.

· Click Apply Copied Comment Style to apply a copied strikeout annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied strikeout annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the strikeout annotation

as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default strikeout annotation properties to

selected strikeout annotations.

· When strikeout annotations are selected, the Pop-up group is available in the Format tab and

can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When strikeout annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized strikeout

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.
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3.3.4.11 Insert Text Tool

 Insert Text Tool

The Insert Text tool is used when editing documents that contain text. The tool inserts caret

annotations that contain pop-up notes. The creator of the annotation can add their suggestions to the

pop-up note for text that should be inserted at the location of the caret annotation. Subsequent users

of the document can double-click the caret annotation in order to view its pop-up note and the

suggested changes that it contains.

Click Insert Text Tool to use this tool:

Figure 1. Comment Tab, Insert Text Tool
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When the Insert Text Tool is enabled, click and drag over the text that you want to annotate:

Figure 2. Insert Text Tool Active

When you release the mouse button, a caret annotation will be added on the right side of the selected

text. Double click the annotation to open its pop-up note, then enter the desired text:
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Figure 3. Insert Text Pop-up Note Expanded and Edited

Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Insert Text Tool, Insert Text Properties Pane

· Subject is the name of the caret annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the caret annotation.

· Name is the unique name of the caret annotation, as referenced within the application.

· Created is the date and time at which the caret annotation was created.

· Modified is the date and time at which the caret annotation was last modified.

· Read Only is the read only status of the caret annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the caret annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the caret annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the caret annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the caret annotation.

· Opacity determines the level of transparency in the caret annotation.
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· Blend Mode determines how caret annotations blend with overlapping content. These options

are explained here.

Note that when the Insert Text Tool is enabled, the Format tab is available and can be used to

customize the default properties of caret annotations:

Figure 4. Format Tab, Insert Text Tool

· Click options in the Shape Style group to select alternative default caret annotation styles.

· Click Keep Selected to keep the Insert Text Tool enabled and add multiple caret annotations

to the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one caret annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Insert Text Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements

of documents other than base content. This makes it possible to create caret annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

· Click Properties to open the Properties pane and view/edit caret properties, as detailed

above.
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· When caret annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of caret annotations.

· Click Apply Copied Comment Style to apply a copied caret annotation style to selected

annotations.

· Click Apply Copied Comment Appearance to apply a copied caret annotation style to

selected annotations.

· Click Make Current Properties Default to set the properties of the caret annotation as

the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default caret annotation properties to

selected caret annotations.

· When caret annotations are selected, the Pop-up group is available in the Format tab and can

be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When caret annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized caret annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.
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3.3.4.12 Replace Text Tool

 Replace Text Tool

The Replace Text tool is used when editing documents that contain text. The tool inserts caret

annotations that contain pop-up notes. The creator of the annotation can add their suggestions to the

pop-up note for text that should be inserted to replace existing text at the location of the caret

annotation. A strikeout is added to the existing text in order to indicate that it should be removed.

Subsequent users of the document can double-click the annotation in order to view its pop-up note

and the suggested changes that it contains.

Click Replace Text Tool to use this tool:

Figure 1. Comment Tab, Replace Text Tool
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When the Replace Text Tool is enabled, click and drag over the text that you want to annotate:

Figure 2. Replace Text Tool Active

When you release the mouse button, a strikeout annotation will be added to the text and a caret

annotation will be added on the right side of it. Double click the annotation to open its pop-up note,

then enter the desired text:
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Figure 3. Replace Text Pop-up Note Expanded and Edited

Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Replace Text Tool, Replace Text Properties Pane

· Subject is the name of the annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the annotation.

· Name is the unique name of the annotation, as referenced within the application.

· Created is the date and time at which the annotation was created.

· Modified is the date and time at which the annotation was last modified.

· Read Only is the read only status of the annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the annotation. If this property is enabled then the annotation is

printed with the document. If this property is not enabled then the annotation is not printed.

· Locked is the locked status of the annotation. If this property is enabled then the annotation

cannot be deleted and its properties (including its position and size) cannot be modified by

users.

· Layer determines the optional content layer to which the annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the annotation.

· Opacity determines the level of transparency in the annotation.

· Blend Mode determines how annotations blend with overlapping content. These options are

explained here.
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Note that when the Replace Text Tool is enabled, the Format tab is available and can be used to

customize the default properties of annotations:

Figure 4. Format Tab, Replace Text Tool

· Click options in the Shape Style group to select alternative default annotation styles.

· Click Keep Selected to keep the Replace Text Tool enabled and add multiple annotations to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Replace Text Tool. When Exclusive Mode is enabled, the pointer ignores all interactive

elements of documents other than base content. This makes it possible to create annotations

on areas that overlap with other content without the risk of accidentally selecting undesired

items. When Exclusive Mode is disabled, the pointer recognizes and interacts with all

underlying elements in the usual manner.

· Click Properties to open the Properties pane and view/edit properties, as detailed above.

· When annotations are selected, the Style Tools dropdown menu is available in the Format tab.

It contains the following options:

· Click Copy Comment Style to copy the style properties of annotations.
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· Click Apply Copied Comment Style to apply a copied annotation style to selected

annotations.

· Click Apply Copied Comment Appearance to apply a copied annotation style to

selected annotations.

· Click Make Current Properties Default to set the properties of the annotation as the

default properties for subsequent annotations.

· Click Apply Default Properties to apply the default annotation properties to selected

annotations.

· When annotations are selected, the Pop-up group is available in the Format tab and can be

used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized annotation styles

for subsequent use, and the Commenting  preferences can be used to view/edit preferences for all

comments.
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3.3.4.13 Text Correction Tool

 Text Correction Tool

The Text Correction Text tool is used when editing documents that contain text. It inserts annotations

that indicate text should be removed from documents or replaced with different text. 

Click Text Correction Tool to use this tool:

Figure 1. Comment Tab, Text Correction Tool

When the Text Correction Tool is enabled, click and drag over the text that you want to annotate:
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Figure 2. Text Correction Tool Active

Selected text can be edited as follows:

· Press Delete to add a strikeout annotation to selected text. Strikeout annotations indicate that

text should be deleted and can be edited as detailed here.

· Press Insert to add a caret annotation to selected text. Caret annotations indicate that text

should be replaced and can be edited as detailed here.

· Press Ctrl+V to add a caret annotation to selected text, as with the Insert option, and paste the

content of the clipboard in the annotation's pop-up note.

· Use the keyboard to enter text. A caret annotation will be added to selected text, as with the

Insert option, and the text entered will be added to the annotation's pop-up note.

· Press Insert when the Text Correction Tool is enabled, but no text is selected, to add caret

annotations at the location of the pointer. Caret annotations indicate that text should be

replaced and can be edited as detailed here.
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3.3.4.14 Accounting Calculator

 Accounting Calculator

The Accounting Calculator tool is used to perform accounting calculations and create accounting lists

that can be added to documents. Click Accounting Calculator to use this tool:

Figure 1. Comment Tab, Accounting Calculator

The Accounting Calculator dialog box will open:
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Figure 2. Accounting Calculator Dialog Box

Use the keys to perform calculations as desired. The operations you perform will be detailed in the

pane on the right side:

Figure 3. Accounting Calculator in Operation

You can use the controls in the pane as follows:
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· Enter a name in the Tape Name text box to specify a name for the output tape used when the

accounting list is added to the document.

· Click Undo/Redo to undo/redo calculation operations.

· Click Add to add a new calculation line in the calculation pane.

· Click Delete to delete selected calculation lines.

· Click Clear to clear all calculations from the calculation pane.

· Use the Decimal Places dropdown menu to determine how many decimal places the calculator

uses.

· Use the Rounding Mode dropdown menu to determine how numbers are rounded.

· Click Reset List to reset all list settings to their default values.

· Click Show Preview to preview how the calculation tape will look when it is added to the

document.

· Click Settings to open the Settings dialog box for the calculator:

Figure 4. AC Settings Dialog Box

You can use the dropdown menus and text boxes to update the settings used for the calculator as

desired.
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When you have added all desired information to the calculator pane, click Select Place in the

Accounting Calculator dialog box to specify where you want the tape to be located in the document.

A preview of the accounting list will be displayed beneath the pointer:

Figure 5. Accounting List Preview

Click to add the accounting list to the document:
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Figure 6. Accounting List Added

Note that accounting lists are contained with text box comments, and can therefore be edited in the

same manner as text box comments, as detailed here. 469
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3.3.4.15 Line Tool

 Line Tool

Click the Line Tool to add line annotations to documents:

Figure 1. Comment Tab, Line Tool

When the Line Tool is enabled, the pointer becomes a crosshairs icon. Click to initiate a line

annotation, then drag the pointer to the desired location and click again to complete the line

annotation:
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Figure 2. Line Tool Examples

Click to select line annotations, as detailed in the lower annotation in the image above. Selected

annotations can be edited as follows:

· Click and drag the yellow control points to reposition line endings. Hold down Shift to

reposition annotations at increments of fifteen degrees.

· Click and drag, or use the arrow keys, to resposition annotations. Hold down Shift to move at

an increased increment when using the arrow keys.

· Use the editing aids detailed here  to assist in the precise placement of line annotations.

· Right-click annotations for further options, as detailed here.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Line Tool, Line Properties Pane

· Subject is the name of the line annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the line annotation.

· Name is the unique name of the line annotation, as referenced within the application.

· Created is the date and time at which the line annotation was created.

· Modified is the date and time at which the line annotation was last modified.

· Read Only is the read only status of the line annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the line annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the line annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the line annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the line annotation.

The line ending property is detailed below.

· Stroke Color determines the color of the line annotation.
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· Opacity determines the level of transparency in the line annotation.

· Blend Mode determines how line annotations blend with overlapping content. These options

are explained here.

· Start determines the line ending style used at the start of the line annotation.

· End determines the line ending style used at the end of the line annotation.

· Start Scale determines the size of the line ending used at the start of the line annotation.

· End Scale determines the size of the line ending used at the end of the line annotation.

· Leader Length determines the length of the leader lines used for the line annotation. Leader

lines extend from each endpoint of the line annotation, perpendicular to the annotation itself.

· Leader Extension determines the length of leader line extensions that extend from the line

annotation.

· Leader Offset determines the length of the leader line offset, which is the amount of empty

space between the endpoints of the line annotation and the beginning of the leader lines.

· Show Caption determines whether or not the text contained in the pop-up note of the

annotation is displayed.

· Inline Caption determines whether or not the caption is an inline caption. If this option is

enabled then captions are placed inside the line annotation instead of on top of the line

annotation.

· Length determines the length of the line annotation.

Note that when the Line Tool is enabled, the Format tab is available and can be used to customize the

default properties of line annotations:
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Figure 4. Format Tab, Line Tool

· Click options in the Shape Style group to select alternative default line annotation styles.

· Click Keep Selected to keep the Line Tool enabled and add multiple line annotations to the

document. If this option is not enabled then PDF-XChange Editor will revert to the designated

default tool immediately after creating one line annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the Line

Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create line annotations on areas

that overlap with other content without the risk of accidentally selecting undesired items. When

Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying elements

in the usual manner.

· Click Properties to open the Properties pane and view/edit Line Tool properties, as detailed

above.

· When line annotations are selected, the Style Tools dropdown menu is available in the Format

tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of line annotations.

· Click Apply Copied Comment Style to apply a copied line annotation style to selected

annotations.

· Click Apply Copied Comment Appearance to apply a copied line annotation style to

selected annotations.
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· Click Make Current Properties Default to set the properties of the line annotation as the

default properties for subsequent annotations.

· Click Apply Default Properties to apply the default line annotation properties to

selected line annotations.

· When line annotations are selected, the Pop-up group is available in the Format tab and can

be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When line annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized line annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.

Convert Line Annotations to Distance Annotations

If you want to convert line annotations to distance annotations, then right-click the line annotation and

click Convert to Measurement:
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Figure 5. Right-Click Shortcut Menu, Convert to Measurement Highlighted

The line annotation will then convert into a distance annotation. Note that it is possible to convert

multiple annotations at the same time.
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3.3.4.16 Arrow Tool

 Arrow Tool

Click the Arrow Tool to add arrow annotations to documents:

Figure 1. Comment Tab, Arrow Tool

When the Arrow Tool is enabled, the pointer becomes a crosshairs icon. Click to initiate an arrow

annotation, then drag the pointer to the desired location and click again to complete the annotation:
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Figure 2. Arrow Examples

Click to select arrow annotations, as detailed in the lower annotation in the image above. Selected

annotations can be edited as follows:

· Click and drag the yellow control points to reposition arrow endings. Hold down Shift to

reposition annotations at increments of fifteen degrees.

· Click and drag, or use the arrow keys, to resposition annotations. Hold down Shift to move at

an increased increment when using the arrow keys.

· Use the editing aids detailed here  to assist in the precise placement of arrow annotations.

· Right-click annotations for further options, as detailed here.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Arrow Tool, Arrow Properties Pane

· Subject is the name of the arrow annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the arrow annotation.

· Name is the unique name of the arrow annotation, as referenced within the application.

· Created is the date and time at which the arrow annotation was created.

· Modified is the date and time at which the arrow annotation was last modified.

· Read Only is the read only status of the arrow annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the arrow annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the arrow annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the arrow annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the arrow annotation.

The line ending property is detailed below.

· Stroke Color determines the color of the arrow annotation.
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the arrow annotation.

· Blend Mode determines how arrow annotations blend with overlapping content. These options

are explained here.

· Start determines the line ending style used at the start of the arrow annotation.

· End determines the line ending style used at the end of the arrow annotation.

· Start Scale determines the size of the line ending used at the start of the arrow annotation.

· End Scale determines the size of the line ending used at the end of the arrow annotation.

· Leader Length determines the length of the leader lines used for the arrow annotation. Leader

lines extend from each endpoint of the arrow annotation, perpendicular to the arrow

annotation itself.

· Leader Extension determines the length of leader line extensions that extend from the arrow

annotation.

· Leader Offset determines the length of the leader line offset, which is the amount of empty

space between the endpoints of the arrow annotation and the beginning of the leader lines.

· Show Caption determines whether or not the text contained in the pop-up note of the

annotation is displayed.

· Inline Caption determines whether or not the caption is an inline caption. If this option is

enabled then captions are placed inside the arrow annotation instead of on top of the arrow

annotation.

· Length determines the length of the arrow annotation.

Note that when the Arrow Tool is enabled, the Format tab is available and can be used to customize

the default properties of arrow annotations:
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Figure 4. Format Tab, Arrow Tool

· Click options in the Shape Style group to select alternative default arrow annotation styles.

· Click Keep Selected to keep the Arrow Tool enabled and add multiple arrow annotations to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one arrow annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Arrow Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create arrow annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Arrow Tool properties, as detailed

above.

· When arrow annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of arrow annotations.

· Click Apply Copied Comment Style to apply a copied arrow annotation style to selected

annotations.

· Click Apply Copied Comment Appearance to apply a copied arrow annotation style to

selected annotations.
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· Click Make Current Properties Default to set the properties of the arrow annotation as

the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default arrow annotation properties to

selected arrow annotations.

· When arrow annotations are selected, the Pop-up group is available in the Format tab and can

be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When arrow annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized arrow annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.

Convert Arrow Annotations to Distance Annotations

If you want to convert arrow annotations to distance annotations, then right-click the arrow annotation

and click Convert to Measurement:

1068

644

214



542

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 5. Right-Click Shortcut Menu, Convert to Measurement Highlighted

The arrow annotation will then convert into a distance annotation. Note that it is possible to convert

multiple annotations at the same time.
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3.3.4.17 Rectangle Tool

 Rectangle Tool

Click the Rectangle Tool to add rectangle annotations to documents:

Figure 1. Comment Tab, Rectangle Tool

When the Rectangle Tool is enabled, click and drag the pointer to create rectangle annotations:
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Figure 2. Rectangle Tool Examples

Click to select rectangle annotations, as detailed in the lower annotation in the image above. Selected

annotations can be edited as follows:

· Click and drag the control points to resize rectangles.

· Click and drag to reposition rectangles. The circle at the center can also be used for this

purpose.

· Click and drag the green control point at the top to rotate rectangles. Hold down Shift to

rotate at increments of fifteen degrees.

· Use the arrow keys to reposition rectangles. Hold down Shift to move at an increased

increment.

· Use the editing aids detailed here  to assist in the precise placement of rectangles.

· Right-click rectangles for further options. See here  for an explanation of these options.

· Hold down Ctrl to create rectangles from their center.

· Hold down Alt to constrain rectangle proportions.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Rectangle Tool, Rectangle Properties Pane

· Subject is the name of the rectangle annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the rectangle annotation.

· Name is the unique name of the rectangle annotation, as referenced within the application.

· Created is the date and time at which the rectangle annotation was created.

· Modified is the date and time at which the rectangle annotation was last modified.

· Read Only is the read only status of the rectangle annotation. If this property is enabled then

users cannot interact with the annotation. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the rectangle annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the rectangle annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the rectangle annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the rectangle

annotation. The line ending property is detailed below.

· Stroke Color determines the color of the rectangle annotation.
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the rectangle annotation.

· Blend Mode determines how rectangle annotations blend with overlapping content. These

options are explained here.

· Rotation determines the degrees of rotation of the rectangle annotation.

Note that when the Rectangle Tool is enabled, the Format tab is available and can be used to

customize the default properties of rectangle annotations:

Figure 4. Format Tab, Rectangle Tool

· Click options in the Shape Style group to select alternative default rectangle annotation styles.

· Click Keep Selected to keep the Rectangle Tool enabled and add multiple rectangle

annotations to the document. If this option is not enabled then PDF-XChange Editor will revert

to the designated default tool immediately after creating one rectangle annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Rectangle Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements

of documents other than base content. This makes it possible to create rectangle annotations

on areas that overlap with other content without the risk of accidentally selecting undesired
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items. When Exclusive Mode is disabled, the pointer recognizes and interacts with all

underlying elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Rectangle Tool properties, as

detailed above.

· When rectangle annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of rectangle annotations.

· Click Apply Copied Comment Style to apply a copied rectangle annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied rectangle annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the rectangle annotation

as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default rectangle annotation properties to

selected rectangle annotations.

· When rectangle annotations are selected, the Pop-up group is available in the Format tab and

can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When rectangle annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized rectangle

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.

Convert Rectangle Annotations to Measurement Annotations

If you want to convert rectangle annotations to measurement annotations, then right-click the rectangle

annotation and click Convert to Measurement:
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Figure 5. Right-Click Shortcut Menu, Convert to Measurement Highlighted

The rectangle annotation will then convert into a measurement annotation. Note that it is possible to

convert multiple annotations at the same time.
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3.3.4.18 Oval Tool

 Oval Tool

Click the Oval Tool to add oval annotations to documents: 

Figure 1. Comment Tab, Oval Tool

When the Oval Tool is enabled, click and drag the pointer to define oval annotations:
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Figure 2. Oval Tool Examples

Click to select oval annotations, as detailed in the larger annotation in the image above. Selected

annotations can be edited as follows:

· Click and drag the control points to resize ovals.

· Click and drag ovals to reposition them. The circle at the center can also be used for this

purpose.

· Click and drag the green control point at the top to rotate ovals. Hold down Shift to rotate at

increments of fifteen degrees.

· Use the arrow keys to reposition ovals. Hold down Shift to move at an increased increment.

· Use the editing aids detailed here  to assist in the precise placement of ovals.

· Hold down Ctrl to create ovals from their center.

· Right-click ovals for further options. See here  for an explanation of these options.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Oval Tool, Oval Properties Pane

· Subject is the name of the oval annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the oval annotation.

· Name is the unique name of the oval annotation, as referenced within the application.

· Created is the date and time at which the oval annotation was created.

· Modified is the date and time at which the oval annotation was last modified.

· Read Only is the read only status of the oval annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the oval annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the oval annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the oval annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the oval annotation.

The line ending property is detailed below.

· Stroke Color determines the color of the oval annotation.
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the oval annotation.

· Blend Mode determines how oval annotations blend with overlapping content. These options

are explained here.

· Rotation determines the degrees of rotation of the oval annotation.

Note that when the Oval Tool is enabled, the Format tab is available and can be used to customize the

default properties of oval annotations:

Figure 4. Format Tab, Oval Tool

· Click options in the Shape Style group to select alternative default oval annotation styles.

· Click Keep Selected to keep the Oval Tool enabled and add multiple oval annotations to the

document. If this option is not enabled then PDF-XChange Editor will revert to the designated

default tool immediately after creating one oval annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the Oval

Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create oval annotations on areas

that overlap with other content without the risk of accidentally selecting undesired items. When
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Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying elements

in the usual manner.

· Click Properties to open the Properties pane and view/edit Oval Tool properties, as detailed

above.

· When oval annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of oval annotations.

· Click Apply Copied Comment Style to apply a copied oval annotation style to selected

annotations.

· Click Apply Copied Comment Appearance to apply a copied oval annotation style to

selected annotations.

· Click Make Current Properties Default to set the properties of the oval annotation as

the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default oval annotation properties to

selected oval annotations.

· When oval annotations are selected, the Pop-up group is available in the Format tab and can

be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When oval annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized oval annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.
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3.3.4.19 Polygon Line Tool

 Polygon Line Tool

Click the Polygon Line Tool to add polygon line annotations to documents: 

Figure 1. Comment Tab, Polygon Line Tool

When the Polygon Line Tool is enabled, click to designate the starting point of the first line. Move the

pointer to the next desired location, then click to designate the end of the first line and the beginning

of the next line. Repeat this process until the final point of the desired shape is reached, then double-

click to complete the annotation, as detailed in the examples below:
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Figure 2. Polygon Line Tool Examples

Click to select polygon line annotations, as detailed in the lower annotation in the image above.

Selected annotations can be edited as follows:

· Click and drag the outer control points to resize polygon line annotations.

· Click and drag the inner control points to reposition polygon line annotations.

· Click and drag polygon line annotations to reposition them. The circle at the center can also be

used for this purpose.

· Click and drag the green control point at the top to rotate polygon line annotations. Hold

down Shift to rotate at increments of fifteen degrees.

· Use the arrow keys to reposition polygon line annotations. Hold down Shift to move at an

increased increment.

· Use the editing aids detailed here  to assist in the precise placement of polygon line

annotations.

· Right-click polygon line annotations for further options. See here  for an explanation of

these options.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Polygon Line Tool, Polygon Line Properties Pane

· Subject is the name of the polygon line annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the polygon line annotation.

· Name is the unique name of the polygon line annotation, as referenced within the application.

· Created is the date and time at which the polygon line annotation was created.

· Modified is the date and time at which the polygon line annotation was last modified.

· Read Only is the read only status of the polygon line annotation. If this property is enabled

then users cannot interact with the annotation. Please note that it is necessary to use JavaScript

to change the value of this property.

· Printable is the print status of the polygon line annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the polygon line annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the polygon line annotation belongs.

Further information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the polygon line

annotation. The line ending property is detailed below.

· Stroke Color determines the color of the polygon line annotation.
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the polygon line annotation.

· Blend Mode determines how polygon line annotations blend with overlapping content. These

options are explained here.

· Rotation determines the degrees of rotation of the polygon line annotation.

· Start determines the line ending style used at the start of the polygon line annotation.

· End determines the line ending style used at the end of the polygon line annotation.

· Start Scale determines the size of the line ending used at the start of the polygon line

annotation.

· End Scale determines the size of the line ending used at the end of the polygon line

annotation.

Note that when the Polygon Line Tool is enabled, the Format tab is available and can be used to

customize the default properties of polygon line annotations:

Figure 4. Format Tab, Polygon Line Tool

· Click options in the Shape Style group to select alternative default polygon line annotation

styles.
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· Click Keep Selected to keep the Polygon Line Tool enabled and add multiple polygon line

annotations to the document. If this option is not enabled then PDF-XChange Editor will revert

to the designated default tool immediately after creating one polygon line annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Polygon Line Tool. When Exclusive Mode is enabled, the pointer ignores all interactive

elements of documents other than base content. This makes it possible to create polygon line

annotations on areas that overlap with other content without the risk of accidentally selecting

undesired items. When Exclusive Mode is disabled, the pointer recognizes and interacts with

all underlying elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Polygon Line Tool properties, as

detailed above.

· When polygon line annotations are selected, the Style Tools dropdown menu is available in

the Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of polygon line annotations.

· Click Apply Copied Comment Style to apply a copied polygon line annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied polygon line annotation

style to selected annotations.

· Click Make Current Properties Default to set the properties of the polygon line

annotation as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default polygon line annotation properties

to selected polygon line annotations.

· When polygon line annotations are selected, the Pop-up group is available in the Format tab

and can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When polygon line annotations are selected, the Arrange tab is also available and can be used

to manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized polygon line

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.

Convert Polygon Line Annotations to Perimeter Annotations

If you want to convert polygon line annotations to perimeter/multiple annotations, then right-click the

polygon line annotation and click Convert to Measurement:
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Figure 5. Right-Click Shortcut Menu, Convert to Measurement Highlighted

The polygon line annotation will then convert into a perimeter annotation. Note that it is possible to

convert multiple annotations at the same time.

Convert Polygon Line Annotations to Multiple Line Annotations

If you want to convert polygon line annotations to multiple line annotations, then right-click the

polygon line annotation and click Convert to Lines:
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Figure 6. Right-Click Shortcut Menu, Convert to Lines Highlighted

The polygon line annotation will then be converted into multiple line annotations that can be edited as

separate annotations:
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Figure 7. Polygon Line Annotation Converted into Line Annotations
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3.3.4.20 Polygon Tool

 Polygon Tool

Click the Polygon Tool to add polygon annotations to documents:

Figure 1. Comment Tab, Polygon Tool

When the Polygon Tool is enabled, click to designate the first point of the polygon, then move the

pointer to the next location and click to designate the second point. Repeat this process until the final

point of the desired shape is reached and then double-click to complete the polygon:
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Figure 2. Polygon Tool Examples

Click to select polygon annotations, as detailed in the lower annotation in the image above. Selected

annotations can be edited as follows:

· Click and drag the outer control points to resize polygons.

· Click and drag the inner control points to reposition polygons.

· Click and drag to reposition polygons. The circle at the center can also be used for this purpose.

· Click and drag the green control point at the top to rotate polygons. Hold down Shift to rotate

at increments of fifteen degrees.

· Use the arrow keys to reposition polygons. Hold down Shift to move at an increased increment.

· Use the editing aids detailed here  to assist in the precise placement of polygons.

· Right-click polygons for further options. See here  for an explanation of these options.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:

450

1130



564

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 3. Polygon Tool, Polygon Properties Pane

· Subject is the name of the polygon annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the polygon annotation.

· Name is the unique name of the polygon annotation, as referenced within the application.

· Created is the date and time at which the polygon annotation was created.

· Modified is the date and time at which the polygon annotation was last modified.

· Read Only is the read only status of the polygon annotation. If this property is enabled then

users cannot interact with the annotation. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the polygon annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the polygon annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the polygon annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the polygon

annotation. The line ending property is detailed below.

· Stroke Color determines the color of the polygon annotation.
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the polygon annotation.

· Blend Mode determines how polygon annotations blend with overlapping content. These

options are explained here.

· Rotation determines the degrees of rotation of the polygon annotation.

Note that when the Polygon Tool is enabled, the Format tab is available and can be used to customize

the default properties of polygon annotations:

Figure 4. Format Tab, Polygon Tool

· Click options in the Shape Style group to select alternative default polygon annotation styles.

· Click Keep Selected to keep the Polygon Tool enabled and add multiple polygon annotations

to the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one polygon annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Polygon Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create polygon annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.
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When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Polygon Tool properties, as

detailed above.

· When polygon annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of polygon annotations.

· Click Apply Copied Comment Style to apply a copied polygon annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied polygon annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the polygon annotation

as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default polygon annotation properties to

selected polygon annotations.

· When polygon annotations are selected, the Pop-up group is available in the Format tab and

can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When polygon annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized polygon

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.

Convert Polygon Annotations to Area Annotations

If you want to convert polygon line annotations to area annotations, then right-click the polygon line

annotation and click Convert to Measurement:

1068

644

214



567

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 5. Right-Click Shortcut Menu, Convert to Measurement Highlighted

The polygon line annotation will then convert into an area annotation. Note that it is possible to

convert multiple annotations at the same time.

Convert Polygon Annotations to Multiple Line Annotations

If you want to convert polygon annotations to multiple line annotations, then right-click the polygon

line annotation and click Convert to Lines:
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Figure 6. Right-Click Shortcut Menu, Convert to Lines Highlighted

The polygon annotation will then be converted into multiple line annotations that can be edited as

separate annotations:
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Figure 7. Polygon Annotation Converted into Line Annotations
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3.3.4.21 Cloud Tool

 Cloud Tool

Click Cloud Tool to add cloud annotations to documents: 

Figure 1. Comment Tab, Cloud Tool

When the Cloud Tool is enabled, the pointer becomes a crosshairs icon. Click to designate the starting

point of the cloud annotation. Drag the crosshairs to the location at which the first line is to be made.

Click again to define the first line of the annotation. Repeat the process until the desired shape is

complete and then double-click to define the final point:
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Figure 2. Cloud Tool Examples

Click to select cloud annotations, as detailed in the lower annotation in the image above. Selected

annotations can be edited as follows:

· Click and drag the outer control points to resize cloud annotations.

· Click and drag the inner control points to reposition cloud annotations.

· Click and drag cloud annotations to reposition them. The circle at the center can also be used

for this purpose.

· Click and drag the green control point at the top to rotate cloud annotations. Hold down Shift

to rotate at increments of fifteen degrees.

· Use the arrow keys to reposition cloud annotations. Hold down Shift to move at an increased

increment.

· Use the editing aids detailed here  to assist in the precise placement of cloud annotations.

· Right-click cloud annotations for further options. See here  for an explanation of these

options.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Cloud Tool, Cloud Properties Pane

· Subject is the name of the cloud annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the cloud annotation.

· Name is the unique name of the cloud annotation, as referenced within the application.

· Created is the date and time at which the cloud annotation was created.

· Modified is the date and time at which the cloud annotation was last modified.

· Read Only is the read only status of the cloud annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the cloud annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the cloud annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the cloud annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the cloud annotation.

The line ending property is detailed below.

· Stroke Color determines the color of the cloud annotation.
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the cloud annotation.

· Blend Mode determines how cloud annotations blend with overlapping content. These options

are explained here.

· Rotation determines the degrees of rotation of the cloud annotation.

Note that when the Cloud Tool is enabled, the Format tab is available and can be used to customize

the default properties of cloud annotations:

Figure 4. Format Tab, Cloud Tool

· Click options in the Shape Style group to select alternative default cloud annotation styles.

· Click Keep Selected to keep the Cloud Tool enabled and add multiple cloud annotations to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one cloud annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Cloud Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create cloud annotations on areas

that overlap with other content without the risk of accidentally selecting undesired items. When
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Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying elements

in the usual manner.

· Click Properties to open the Properties pane and view/edit Cloud Tool properties, as detailed

above.

· When cloud annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of cloud annotations.

· Click Apply Copied Comment Style to apply a copied cloud annotation style to selected

annotations.

· Click Apply Copied Comment Appearance to apply a copied cloud annotation style to

selected annotations.

· Click Make Current Properties Default to set the properties of the cloud annotation as

the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default cloud annotation properties to

selected cloud annotations.

· When cloud annotations are selected, the Pop-up group is available in the Format tab and can

be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When cloud annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized cloud annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.
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3.3.4.22 Stamp Tool

 Stamp Tool

Click Stamp Tool to add stamps to documents:

Figure 1. Comment Tab, Stamp Tool

Note that this button is divided into two sections. Click the dropdown menu arrow to view/select

available stamps, as detailed in (figure 6) below. Click the icon to enable the Stamp Tool. When the

Stamp Tool is enabled, the active stamp will be displayed beneath the pointer. Move the pointer to the

desired location and then click to add stamps:
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Figure 2. Stamp Tool Example

Click to select stamps, as detailed in the central stamp in the image above. Selected stamps can be

edited as follows:

· Click and drag the yellow control points to resize stamps. Please note that stamp proportions

are constrained.

· Click and drag to reposition stamps.

· Click and drag the green control point to rotate stamps. Hold down Shift to rotate at

increments of fifteen degrees.

· Use the arrow keys to reposition stamps. Hold down Shift to move at an increased increment.

· Use the editing aids detailed here  to assist in the precise placement of stamps.

· Right-click stamps for further options. See here  for an explanation of these options.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:
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Figure 3. Stamp Tool, Stamp Properties Pane

· Subject is the name of the stamp annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the stamp annotation.

· Name is the unique name of the stamp annotation, as referenced within the application.

· Created is the date and time at which the stamp annotation was created.

· Modified is the date and time at which the stamp annotation was last modified.

· Read Only is the read only status of the stamp annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the stamp annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the stamp annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Stamp ID is the name of the icon used to display the stamp.

· Layer determines the optional content layer to which the stamp annotation belongs. Further

information about layers is available here.

· Stroke Color determines the stroke color of the stamp annotation.

· Border Style determines the style of the stamp annotation.
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· Border Width determines the width of the stamp annotation. 

· Opacity determines the level of transparency in the stamp annotation.

· Blend Mode determines how stamp annotations blend with overlapping content. These

options are explained here.

· Rotation determines the degrees of rotation of the stamp annotation.

Note that when the Stamp Tool is enabled, the Format tab is available and can be used to customize

the default properties of stamp annotations:

Figure 4. Format Tab, Stamp Tool

· Click options in the Shape Style group to select alternative default stamp annotation styles.

· Select an option in the Opacity dropdown menu to determine the level of transparency in

stamps.

· Click Keep Selected to keep the Stamp Tool enabled and add multiple stamp annotations to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one stamp annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Stamp Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create stamp annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.
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When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

· Click Properties to open the Properties pane and view/edit Stamp Tool properties, as

detailed above. Property definitions are detailed here.

· When stamp annotations are selected, the Pop-up group is available in the Format tab and

can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When stamp annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized stamp annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.

Stamps Pane

Click the Stamp dropdown menu to view/select available stamps:

Figure 5. Comment Tab, Stamp Dropdown Menu
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The Stamp Pane will open:

Figure 6. Stamps Pane

· Click to select stamps. They will then be displayed with the pointer. Click again to add stamps

to the active document.

· Click Stamps Palette to open the Stamps Palette, which is a detached version of the Stamps

Pane that contains editing options:
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Figure 7. Stamps Palette

· Click Options to determine additional settings for stamps, as detailed in (figure 8).

· Click the Zoom In and Zoom Out icons to zoom in on/out from available stamps.

· Click Add New for stamp creation options:

· Click Add New Stamp from File to create a stamp from a document saved on the local

computer. The Open Files dialog box will open. Select a file and click Open. The file will

be displayed in the Add New Stamp dialog box, as detailed in (figure 9).

· Click Add Custom Stamp to add a custom stamp, as detailed below.

· Click New Stamp from Selection to create a stamp from selected content in the active

document.

· Click New Stamp from Active Document to create a new stamp from the active

document.

· Click New Stamp from Clipboard to create a new stamp from the current clipboard

content.

· Click Rename/Delete to rename/delete selected stamps. Note that the default stamps cannot

be renamed/deleted.
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Figure 8. Options Dialog Box

· Use the Font dropdown menu to determine the font used in stamps.

· Select the Enable Standard stamps localization to enable localization for standard stamps.

· Select the Enable font substitution during localization to enable font substitution when

necessary for stamp localization.

· Select the Place stamps with the last used size box to retain stamp sizes for subsequent use.

· Click the Clear remembered sizes box to clear stamp sizes that PDF-XChange Editor has

remembered for subsequent use.
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Figure 9. Add New Stamp Dialog Box

· Use the Name text box, or click the folder icon, to select a file to use as the stamp.

· The Page Range options determine the pages of the file that will be used for the stamp:

· Select All to specify all pages.
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· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Note that if more than one page is specified then a new stamp will be created for each

page.

· Enter a name in the Stamp Title text box. Click the blue icon to include macros  as desired.

· Use the Target Collection menu to determine the collection in which the new stamp will be

stored.

· Click Add New to create a new stamp collection.

Click OK to create new stamps.

Please note the following:

· Images are usually in raster format and will pixellate with high levels of zoom. Therefore it is

advisable to create stamps from presized images. Note that vector-based images do not

experience this issue.

· If a transparent background is desired for stamps then a suitable image format must be used.

The formats *.gif and *.png support transparency but *.jpg and *.pdf do not. N.b. Microsoft

Paint does not handle *.png transparency well, but most modern graphics programs are

compatible with *.png transparency. GIMP is one such program, and a free download of GIMP

is available here.

· PDF files that contain transparent images/objects without backgrounds (such as scanned

signatures) can also be used to create transparent stamps. Empty space on the page will be

ignored in these cases.

Add New Custom Stamps

1285

1166

https://www.gimp.org/downloads/
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Figure 10. Create Custom Stamp Dialog Box

· Use the icons at the top of the dialog box to perform editing operations on custom stamps:

· Click Menu for menu options:

· Click New to create a new custom stamp.

· Click Open Template to select a custom template to add to the stamp editing area.

· Click Recent Templates to view/select from a list of recently used custom

templates.

· Click Save to save the current custom stamp.

· Click Save As to save the current custom stamp with a new name.

· Click Crop White Margins to crop white margins from the stamp.

· Click Undo/Redo to undo/redo editing operations.

· Click Fit Page to set the zoom level so that the page fits the document window.

· Click Zoom In/Zoom Out to zoom in on/out from the document window, or enter the

desired zoom level in the Zoom number box.

· Click the Background Color box to determine a background color for the stamp.

· Use the Width box to determine the width of the stamp. 

· Use the icons on the left side of the dialog box as required:
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· Click Select to select and interact with content in the document window.

· Click Line, Rectangle, Oval, Polygon or Curve to add these elements to stamps, then

click and drag to add them in the stamp creation window.

· Click Text to add text to stamps.

· Click Date to add a dynamic date field to stamps. Date fields display the current date

when stamps are added to documents.

· Click Identity to view identity options for adding content to stamps. Note that PDF-

XChange Editor will use the identify information defined in the Identity  preferences

for this option:

· Click Name to add a field with your name.

· Click Login Name to add a field with your login name.

· Click Email to add a field with your email.

· Click Organization Name to add a field with you organization name.

· Click Counter to add a counter field to stamps, which is a field that contains a number

that starts at one and will increase by one each time the stamp is placed. The Create

Counter Field dialog box will open:

· Select Per Document if you want the counter to count per document, or Global if

you want the counter to count continually through all documents.

· Enter a name for counter in the Counter Name text box.

· Use the Format dropdown menu to specify the format of the counter used in the

field.

· Click Interactive Field to add an interactive field to stamps that users can interact with

before the stamp is placed. The Create Interactive Field dialog box will open:

· Enter the desired label for the dialog box field in the Field Label text box. This text

will be displayed in the dialog box that appears when the stamp is added to

documents.

· Enter example field text in the Example text box. This text will be displayed as

example text for the field in the stamp when it is added to documents.

· Use the Type dropdown menu to specify the creation of a Text or Date field as

desired.

· Click From File to add an image from file to the stamp, then click and drag to determine

the area in which the image will be placed. The Open Files dialog box will open and you

can then select the file that you want to use in the stamp.

· Click From Template to add a predefined template to stamps. The Stamps Templates

dialog box will open. Select the desired template and click OK to add it to the stamp.

· When you have added stamp content in the document window, you can use the Stamp

Elements and Properties panes to edit stamp content and content properties as desired. 

Click Add Stamp to add new stamps to the stamps palette.

If you are using PDF-XChange Editor Plus then the additional features below are also available:

229
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Add Dynamic Elements to Stamps

Follow the steps below to add JavaScript to stamps:

1. Move to the Stamps Palette.

2. Click Add New Stamp from File:

Figure 11. Stamps Palette, Add New Stamp from File

3. Select the desired file, then follow the steps outlined beneath (figure 8) to create and save a

new stamp. 

4. Close PDF-XChange Editor.

5. Open the file that contains the stamp. Note that the default folder is %appdata%\Tracker

Software\PDFXEditor\3.0 and all custom stamps are stored in the same file.

6. Move the file to the desktop. (This is a necessary step due to encoding parameters - if it is not

included then the changes cannot be saved).
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7. Open the file in PDF-XChange Editor.

8. Use the Form  tab to add a text field to the stamp. (If you want the borders of the text field

to be invisible then set the stroke color to None. The stroke color property can be edited in the

Properties  pane when the text field is selected).

9. Click Select Fields in the Form  tab then right-click the text field and click Properties in the

submenu. The Properties pane will open.

10. Scroll down to the Value Calculation property, then select Custom Action in the Calculation

dropdown menu. The entry 'Calculate action / Run a JavaScript' will appear at the bottom of

the Properties pane:

Figure 12. Dynamic Stamp Creation

11. Click the ellipsis icon (three dots) on the right of the 'Calculate action / Run a JavaScript'

property. The Edit Action: "Run a JavaScript" dialog box will open.

12. Enter the desired JavaScript and click OK.

676
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13. Save the file and close PDF-XChange Editor.

14. Return the stamp file to its original destination folder. The updated stamp will then be

available in the specified stamp collection.

For example, entering the following JavaScript returns the time and date when the stamp is added to

the document:

var d = new Date;

event.value = util.printd("yyyy/mm/dd/ HH:MM:ss", d);

Please note that form content is evaluated immediately before stamps are placed and flattened

immediately after they are placed. The software will recognize it as a stamp, as opposed to a form

field, despite the fact that it includes form field elements. Note that only the text field and barcode

form fields are compatible with the process of creating dynamic stamps.

Add Numbering to Stamps

Follow the steps below to add numbering to stamps:

1. Use the steps detailed above to create a dynamic stamp and enter the following JavaScript at

step twelve:

if (event.source.forReal && (event.source.stampName == "TCS9kAUOm4Abn56QZCOZE3"))

{

   var counter = 0;

   if (typeof event.source.source.info.stampCounter != undefined)

   {

      counter = event.source.source.info.stampCounter;

   }

   counter++;

   event.source.source.info.stampCounter = counter;

   event.value = counter;

}

else

{

   event.value = 1;

}

2. Save the file and close PDF-XChange Editor.

3. Return the stamp to its destination folder. (It should have been moved to the desktop at step

six of the process - see steps for adding dynamic elements to stamps, above).
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4. Open PDF-XChange Editor and create a new document.

5. Place the stamp in the new document and select it.

6. Press Ctrl+J. The JavaScript Console will open. Enter the following JavaScript:

this.selectedAnnots[0].AP

7. Click Run in the JavaScript Console.

8. An alphanumeric string will appear in the lower section of the JavaScript Console. Copy this

string to the clipboard.

9. Close PDF-XChange Editor.

10. Move the stamp from its destination folder to the desktop.

11. Open PDF-XChange Editor and open the stamp.

12. Click Select Fields in the Form  tab, then select the text field of the stamp.

13. Press Ctrl+' to open the Properties  pane.

14. Under the Value Calculation property, use the menu to select Custom Action. The entry

Calculate action / Run a JavaScript will appear at the bottom of the Properties pane.

15. Click the ellipsis icon on the right of the Calculate action / Run a JavaScript property. The

Edit Action: "Run a JavaScript" dialog box will open.

16. Replace the alphanumeric string on line one of the JavaScript Console with the alphanumeric

string in the clipboard.

17. Save the file and close PDF-XChange Editor.

18. Move the file from the desktop to its original folder. The stamp will then feature incremental

numbering when it is placed into documents.

A complete list of JavaScript-supported actions is available here.

Please note that there are some limitations to the JavaScript functionality available for dynamic stamps.

Stamp files do not execute JavaScript in the same manner as PDF files, and functions and variables

cannot be defined in a document script. Calculation scripts of the field placed in stamps are the only

676
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scripts that are guaranteed to work, and everything that is necessary to execute the script must be

present within it in order for it to operate as intended.
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3.3.4.23 Pencil Tool

 Pencil Tool

Click the Pencil Tool to add pencil annotations to documents:

Figure 1. Comment Tab, Pencil Tool

When the Pencil Tool is enabled, click and drag the pointer to create pencil annotations:
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Figure 2. Pencil Tool Examples

Click to select pencil annotations, as detailed annotation on the left in the image above. Selected

annotations can be edited as follows:

· Click and drag the yellow control points to resize pencil annotations.

· Click and drag pencil annotations to reposition them.

· Click and drag the green control point to rotate pencil annotations. Hold down Shift to rotate

at increments of fifteen degrees.

· Use the arrow keys to reposition pencil annotations. Hold down Shift to move at an increased

increment.

· Use the editing aids detailed here  to assist in the precise placement of pencil annotations.

· Right-click pencil annotations for further options. See here  for an explanation of these

options.

· Press Ctrl+' to open the Properties pane for selected annotations and view/edit properties:

450
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Figure 3. Pencil Tool, Pencil Properties Pane 

· Subject is the name of the pencil annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the pencil annotation.

· Name is the unique name of the pencil annotation, as referenced within the application.

· Created is the date and time at which the pencil annotation was created.

· Modified is the date and time at which the pencil annotation was last modified.

· Read Only is the read only status of the pencil annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the pencil annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the pencil annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the pencil annotation belongs. Further

information about layers is available here.

· Stroke Color determines the color of the pencil annotation.

· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

358
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· Width Profile determines the profile used for the annotation. 

· Opacity determines the level of transparency in the pencil annotation.

· Blend Mode determines how pencil annotations blend with overlapping content. These options

are explained here.

· Rotation determines the degrees of rotation of the pencil annotation.

Note that when the Pencil Tool is enabled, the Format tab is available and can be used to customize

the default properties of pencil annotations:

Figure 4. Format Tab, Pencil Tool

· Click options in the Shape Style group to select alternative default pencil annotation styles.

· Click Keep Selected to keep the Pencil Tool enabled and add multiple pencil annotations to

the document. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after creating one pencil annotation.

· Click Exclusive Mode to enable exclusive mode, which simplifies the process of using the

Pencil Tool. When Exclusive Mode is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to create pencil annotations on

areas that overlap with other content without the risk of accidentally selecting undesired items.

When Exclusive Mode is disabled, the pointer recognizes and interacts with all underlying

elements in the usual manner.

1109
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· Click Properties to open the Properties pane and view/edit Pencil Tool properties, as detailed

above.

· When pencil annotations are selected, the Style Tools dropdown menu is available in the

Format tab. It contains the following options:

· Click Copy Comment Style to copy the style properties of pencil annotations.

· Click Apply Copied Comment Style to apply a copied pencil annotation style to selected

annotations.

· Click Apply Copied Comment Appearance to apply a copied pencil annotation style to

selected annotations.

· Click Make Current Properties Default to set the properties of the pencil annotation as

the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default pencil annotation properties to

selected pencil annotations.

· When pencil annotations are selected, the Pop-up group is available in the Format tab and can

be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· When pencil annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized annotation styles

for subsequent use, and the Commenting  preferences can be used to view/edit preferences for all

comments.

Eraser Tool

The Eraser Tool is used to erase pencil annotations. When it is enabled the pointer becomes a white

circle. Click and drag to erase pencil annotations. Click the Format tab to customize the Eraser Tool:

· Diameter determines the diameter of the eraser.

· Keep Selected determines whether or not the Eraser Tool remains selected after a single use. If

this option is enabled then the tool will remain selected and can be used several times

consecutively. If this option is not enabled then PDF-XChange Editor will revert to the

designated default tool immediately after a single use of the Eraser Tool.

1068
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3.3.4.24 Measuring Tools

 Measuring Tools

Click the Measuring Tools to measure distances, perimeters and areas in documents:

Figure 1. Comment Tab, Measuring Tools

The measuring tools are used to measure specific document dimensions:

· The Distance Tool  is used to measure the distance between two points.

· The Perimeter Tool  is used to measure the distance between multiple points.

· The Area Tool  is used to measure the area within designated borders.

599
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3.3.4.24.1  Distance Tool

 Distance Tool

Click Distance Tool to measure the distance between two points:

Figure 1. Comment Tab, Distance Tool

When the Distance Tool is selected the pointer becomes a crosshairs icon. Click to start a measurement

line. A red arrow will appear and the Distance Tool information box will be displayed in the lower

right corner of the active window. Drag the crosshairs to the desired point, then click to determine the

distance measured. The baseline is then established. The distance from the start point will be displayed

as the pointer is moved, and further details will be displayed in the information box. Click again to set

the baseline as the final measured distance. Alternatively, move the pointer up/down to reposition the
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baseline at a parallel position within the document and create perpendicular leader lines at either end.

Click to complete the process:

Figure 2. Distance Tool Examples

· The Distance Tool calculates and displays distances measured according to the active scale,

which can be determined in the Format tab, as detailed below.

· Right-click lines and select Open Pop-Up Note to customize the appearance of the scale

reference figure. 

· Click and drag the control points at either end of the baseline to adjust the length of the

adjoining perpendicular lines.

· Click and drag the second pair of control points to adjust the length of the baseline and the

angle of the annotation.

· Click and drag to reposition lines.

· Use the arrow keys to reposition lines. Hold down Shift to move at an increased increment.

· Use the editing aids detailed here  to assist in the precise placement of lines.

· Hold down Shift to create lines at increments of fifteen degrees.

· Right-click lines for further editing options. See here  for an explanation of these options.

· Press Ctrl+' to open the Properties pane for selected lines and view/edit properties:

450
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Figure 3. Distance Tool, Distance Line Properties Pane

· Subject is the name of the distance annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the distance annotation.

· Name is the unique name of the distance annotation, as referenced within the application.

· Created is the date and time at which the distance annotation was created.

· Modified is the date and time at which the distance annotation was last modified.

· Read Only is the read only status of the distance annotation. If this property is enabled then

users cannot interact with the annotation. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the distance annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the distance annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the distance annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the distance

annotation. The line ending property is detailed below.

· Stroke Color determines the color of the distance annotation.

358
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the distance annotation.

· Blend Mode determines how distance annotations blend with overlapping content. These

options are explained here.

· Start determines the line ending style used at the start of the distance annotation.

· End determines the line ending style used at the end of the distance annotation.

· Start Scale determines the size of the line ending used at the start of the distance annotation.

· End Scale determines the size of the line ending used at the end of the distance annotation.

· Leader Length determines the length of the leader lines used for the distance annotation.

Leader lines extend from each endpoint of the distance annotation, perpendicular to the

annotation itself.

· Leader Extension determines the length of leader line extensions that extend from the

distance annotation.

· Leader Offset determines the length of the leader line offset, which is the amount of empty

space between the endpoints of the distance annotation and the beginning of the leader lines.

· Show Caption determines whether or not the text contained in the pop-up note of the

annotation is displayed.

· Inline Caption determines whether or not the caption is an inline caption. If this option is

enabled then captions are placed inside the distance annotation instead of on top of the

distance annotation.

· Length determines the length of the distance annotation.

· Total Distance displays the total distance of the annotation. If you have multiple distance

annotations selected then the total length of the annotations will be displayed for this property.

· Avg. Distance displays the average distance of the annotation. If you have multiple distance

annotations selected then the average length of the annotations will be displayed for this

property.

· Min. Distance displays the minimum distance of the annotation. If you have multiple distance

annotations selected then the length of the shortest annotation will be displayed for this

property.

· Max. Distance displays the maximum distance of the annotation. If you have multiple distance

annotations selected then the length of the longest annotation will be displayed for this

property.

· Scale determines the scale used for the distance annotation. Further information about scales is

available here.

· Label determines the text label displayed with the distance annotation.

· Precision determines the precision with which scale conversions are displayed.

· Group determines the symbol used as the group separator.

· Decimal determines the symbol used as the decimal separator.

Note that when the Distance Tool is enabled, the Format tab is available and can be used to

customize the default properties of distance annotations:

1109
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Figure 4. Format Tab, Distance Tool

· Use the options in the Shape Style group to determine default distance annotation styles.

· Use the Line Ending dropdown menus to determine the shape used at the beginning and end

of distance annotations.

· Use the Scale dropdown menu to view/edit the scale used for distance annotations, as detailed

here.

· Use the Auto dropdown menus to determine the separators used for thousands and decimals.

· Click Export to CSV to export a breakdown of the document's measurement comments to a

CSV file.

· Click Keep Selected to keep the Distance Tool selected and create multiple lines consecutively.

If this option is disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of one annotation.

· Click Exclusive Mode to give the Distance Tool priority over all other document content. When

Exclusive Mode is enabled, the pointer ignores all interactive elements of documents other

than base content. This makes it possible to create lines on areas that overlap with other

content without the risk of accidentally selecting undesired items. When Exclusive Mode is

disabled, the pointer recognizes and interacts with all content as normal.

· Click Properties to view/edit the Distance Tool properties, as detailed above.

· When distance annotations are selected, additional options are available in the Format tab:

· The Style Tools dropdown menu contains the following options:

617
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· Click Copy Comment Style to copy the style properties of distance annotations.

· Click Apply Copied Comment Style to apply a copied distance annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied line annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the distance

annotation as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default distance annotation properties

to selected distance annotations.

· The Pop-up group can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· The Current Layer dropdown menu can be used to view/edit the current layer of selected

distance annotations. Click Move to New Layer to move selected distance annotations to

a new layer. Further information about layers is available here.

· When distance annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized distance

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.
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3.3.4.24.2  Perimeter Tool

 Perimeter Tool

Click Perimeter Tool to measure the distance between multiple points:

Figure 1. Comment Tab, Perimeter Tool

When the Perimeter Tool is selected the pointer becomes a crosshairs icon. Click to start a perimeter

line. A red line will appear and the Perimeter Tool information box will be displayed in the lower right

corner of the active window. This box will update as the tool is used. Drag the crosshairs to the desired

location and click again to define the first line of the perimeter. Repeat the process until the perimeter

is complete and then double-click to set the final point:



606

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 2. Perimeter Tool Example

· The Perimeter Tool calculates and displays distances measured according to the active scale,

which can be determined in the Format tab, as detailed below.

· Click and drag the perimeter line to reposition it. The circle at the center can also be used for

this purpose.

· Click and drag the outer control points to resize the perimeter line.

· Click and drag the inner control points to reshape the perimeter line.

· Click and drag the green control point at the top to rotate the perimeter line. Hold down Shift

to rotate at increments of fifteen degrees.

· Use the arrow keys to reposition perimeter lines. Hold down Shift to move at an increased

increment.

· Use the editing aids detailed here  to assist in the precise placement of perimeter lines.

· Hold down Shift to create perimeter lines at increments of fifteen degrees.

· Right-click perimeter lines for further options. See here  for an explanation of these options.

· Press Ctrl+' to open the Properties pane for selected perimeter lines and view/edit properties:
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Figure 3. Perimeter Tool, Perimeter Properties Pane

· Subject is the name of the perimeter annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the perimeter annotation.

· Name is the unique name of the perimeter annotation, as referenced within the application.

· Created is the date and time at which the perimeter annotation was created.

· Modified is the date and time at which the perimeter annotation was last modified.

· Read Only is the read only status of the perimeter annotation. If this property is enabled then

users cannot interact with the annotation. Please note that it is necessary to use JavaScript to

change the value of this property.

· Printable is the print status of the perimeter annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the perimeter annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the perimeter annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the perimeter

annotation. The line ending property is detailed below.

· Stroke Color determines the color of the perimeter annotation.
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· Border Style determines the style of the annotation.

· Border Width determines the width of the annotation. 

· Opacity determines the level of transparency in the perimeter annotation.

· Blend Mode determines how perimeter annotations blend with overlapping content. These

options are explained here.

· Rotation determines the degrees of rotation of the perimeter annotation.

· Start determines the line ending style used at the start of the perimeter annotation.

· End determines the line ending style used at the end of the perimeter annotation.

· Start Scale determines the size of the line ending used at the start of the perimeter annotation.

· End Scale determines the size of the line ending used at the end of the perimeter annotation.

· Scale determines the scale used for the perimeter annotation. Further information about scales

is available here.

· Label determines the text label displayed with the pop-up note of the perimeter annotation.

· Precision determines the precision with which scale conversions are displayed.

· Group determines the symbol used as the group separator.

· Decimal determines the symbol used as the decimal separator.

· Total Perimeter displays the total perimeter of the annotation. If you have multiple perimeter

annotations selected then the total perimeter of the annotations will be displayed for this

property.

· Avg. Perimeter displays the average perimeter of the annotation. If you have multiple

perimeter annotations selected then the average perimeter of the annotations will be displayed

for this property.

· Min. Perimeter displays the minimum perimeter of the annotation. If you have multiple

perimeter annotations selected then the perimeter of the shortest annotation will be displayed

for this property.

· Max. Perimeter displays the maximum perimeter of the annotation. If you have multiple

perimeter annotations selected then the perimeter of the longest annotation will be displayed

for this property.

Note that when the Perimeter Tool is enabled, the Format tab is available and can be used to

customize the default properties of perimeter annotations:
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Figure 4. Format Tab, Perimeter Tool

· Use the options in the Shape Style group to determine default perimeter annotation styles.

· Use the Line Ending dropdown menus to determine the shape used at the beginning and end

of perimeter annotations.

· Use the Scale dropdown menu to view/edit the scale used for perimeter annotations, as

detailed here.

· Use the Auto dropdown menus to determine the separators used for thousands and decimals.

· Click Export to CSV to export a breakdown of the document's measurement comments to a

CSV file.

· Click Keep Selected to keep the Perimeter Tool selected and create multiple lines

consecutively. If this option is disabled then PDF-XChange Editor will revert to the designated

default tool after the creation of one annotation.

· Click Exclusive Mode to give the Perimeter Tool priority over all other document content.

When Exclusive Mode is enabled, the pointer ignores all interactive elements of documents

other than base content. This makes it possible to create lines on areas that overlap with other

content without the risk of accidentally selecting undesired items. When Exclusive Mode is

disabled, the pointer recognizes and interacts with all content as normal.

· Click Properties to view/edit the Perimeter Tool properties, as detailed above.

· When perimeter annotations are selected, additional options are available in the Format tab: 

· The Style Tools dropdown menu contains the following options:

617



610

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Click Copy Comment Style to copy the style properties of perimeter annotations.

· Click Apply Copied Comment Style to apply a copied perimeter annotation style

to selected annotations.

· Click Apply Copied Comment Appearance to apply a copied line annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the perimeter

annotation as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default perimeter annotation

properties to selected perimeter annotations.

· The Pop-up group can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· The Current Layer dropdown menu can be used to view/edit the current layer of selected

perimeter annotations. Click Move to New Layer to move selected perimeter

annotations to a new layer. Further information about layers is available here.

· When perimeter annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized perimeter

annotation styles for subsequent use, and the Commenting  preferences can be used to view/edit

preferences for all comments.
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3.3.4.24.3  Area Tool

 Area Tool

Click Area Tool to measure custom document areas:

Figure 1. Comment Tab, Area Tool

When the Area Tool is selected the pointer becomes a crosshairs icon. Click to start an area

measurement. A red line will appear and the Area Tool information box will be displayed in the lower

right corner of the active window. This box will update as the tool is used. Drag the crosshairs to the

location to which the first measurement is to be made, then click again to set the first line of the area

measurement. Repeat the process until the area is complete and then double-click to define the final

point:
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Figure 2. Area Tool Example

· The Area Tool calculates and displays areas measured according to the active scale, which can

be determined in the Format tab, as detailed below.

· Click and drag the area annotation to reposition it. The circle at the center can also be used for

this purpose.

· Click and drag the outer control points to resize the area annotation.

· Click and drag the inner control points to reshape the area annotation.

· Click and drag the green control point at the top to rotate the area annotation. Hold down

Shift to rotate at increments of fifteen degrees.

· Use the arrow keys to reposition area annotations. Hold down Shift to move at an increased

increment.

· Use the editing aids detailed here  to assist in the precise placement of area annotations.

· Hold down Shift to create area annotations at increments of fifteen degrees.

· Right-click area annotations for further options. See here  for an explanation of these

options.

· Press Ctrl+' to open the Properties pane for selected area annotations and view/edit

properties:
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Figure 3. Area Tool, Area Properties Pane

· Subject is the name of the area annotation, as referenced in the Comments  pane.

· Author is the name of the user that created the area annotation.

· Name is the unique name of the area annotation, as referenced within the application.

· Created is the date and time at which the area annotation was created.

· Modified is the date and time at which the area annotation was last modified.

· Read Only is the read only status of the area annotation. If this property is enabled then users

cannot interact with the annotation. Please note that it is necessary to use JavaScript to change

the value of this property.

· Printable is the print status of the area annotation. If this property is enabled then the

annotation is printed with the document. If this property is not enabled then the annotation is

not printed.

· Locked is the locked status of the area annotation. If this property is enabled then the

annotation cannot be deleted and its properties (including its position and size) cannot be

modified by users.

· Layer determines the optional content layer to which the area annotation belongs. Further

information about layers is available here.

· Fill Color determines the color of the line ending style used at the start of the area annotation.

The line ending property is detailed below.

· Stroke Color determines the color of the area annotation.
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· Border Style determines the style of the area annotation.

· Border Width determines the width of the area annotation. 

· Opacity determines the level of transparency in the area annotation.

· Blend Mode determines how area annotations blend with overlapping content. These options

are explained here.

· Rotation determines the degrees of rotation of the area annotation.

· Scale determines the scale used for the area annotation. Further information about scales is

available here.

· Precision determines the precision with which scale conversions are displayed.

· Group determines the symbol used as the group separator.

· Decimal determines the symbol used as the decimal separator.

· Total Perimeter displays the total perimeter of the annotation. If you have multiple

annotations selected then the total perimeter of the annotations will be displayed for this

property.

· Avg. Perimeter displays the average perimeter of the annotation. If you have multiple

annotations selected then the average perimeter of the annotations will be displayed for this

property.

· Min. Perimeter displays the minimum perimeter of the annotation. If you have multiple

annotations selected then the perimeter of the shortest annotation will be displayed for this

property.

· Max. Perimeter displays the maximum perimeter of the annotation. If you have multiple

annotations selected then the perimeter of the longest annotation will be displayed for this

property.

· Total Area displays the total area of the annotation. If you have multiple area annotations

selected then the total area of the annotations will be displayed for this property.

· Avg. Area displays the average area of the annotation. If you have multiple area annotations

selected then the average area of the annotations will be displayed for this property.

· Min. Area displays the minimum area of the annotation. If you have multiple area annotations

selected then the area of the shortest annotation will be displayed for this property.

· Max. Area displays the maximum area of the annotation. If you have multiple area annotations

selected then the area of the longest annotation will be displayed for this property.

Note that when the Area Tool is enabled, the Format tab is available and can be used to customize

the default properties of area annotations:
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Figure 4. Format Tab, Area Tool

· Use the options in the Shape Style group to determine default perimeter annotation styles.

· Use the Line Ending dropdown menus to determine the shape used at the beginning and end

of perimeter annotations.

· Use the Scale dropdown menu to view/edit the scale used for perimeter annotations, as

detailed here.

· Use the Auto dropdown menus to determine the separators used for thousands and decimals.

· Click Export to CSV to export a breakdown of the document's measurement comments to a

CSV file.

· Click Keep Selected to keep the Perimeter Tool selected and create multiple lines

consecutively. If this option is disabled then PDF-XChange Editor will revert to the designated

default tool after the creation of one annotation.

· Click Exclusive Mode to give the Area Tool priority over all other document content. When

Exclusive Mode is enabled, the pointer ignores all interactive elements of documents other

than base content. This makes it possible to create lines on areas that overlap with other

content without the risk of accidentally selecting undesired items. When Exclusive Mode is

disabled, the pointer recognizes and interacts with all content as normal.

· Click Properties to view/edit the Area Tool properties, as detailed above.

· When area annotations are selected, additional options are available in the Format tab:

· The Style Tools dropdown menu contains the following options:
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· Click Copy Comment Style to copy the style properties of area annotations.

· Click Apply Copied Comment Style to apply a copied area annotation style to

selected annotations.

· Click Apply Copied Comment Appearance to apply a copied line annotation style

to selected annotations.

· Click Make Current Properties Default to set the properties of the area annotation

as the default properties for subsequent annotations.

· Click Apply Default Properties to apply the default area annotation properties to

selected area annotations.

· The Pop-up group can be used to interact with the pop-up note of the annotation:

· Click Open to open the pop-up note.

· Click Hide to hide the pop-up note.

· Click Reset Location to reset the location of the pop-up note.

· The Current Layer dropdown menu can be used to view/edit the current layer of selected

area annotations. Click Move to New Layer to move selected area annotations to a new

layer. Further information about layers is available here.

· When area annotations are selected, the Arrange tab is also available and can be used to

manipulate comments as detailed here.

Note that the Comment Styles Palette  can be used to edit and save customized area annotation

styles for subsequent use, and the Commenting  preferences can be used to view/edit preferences

for all comments.
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3.3.4.24.4  Set Scale

 Set Scale

When the Measuring Tools are selected, click Scale in the Format tab to

view/select/manage/calibrate scales:

Figure 1. Format Tab, Scale Options

· Click Manage Measurements to view/edit/clone/delete scales.

· Click Calibrate Measurement to calibrate a new measurement. The pointer will become a

crosshairs icon. Click and drag to determine a distance for calibration. The Calibration dialog

box will open:
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Figure 2. Calibration Dialog Box

· The distance determined in the document is detailed in the upper number box. Use the

dropdown menu to select the desired units of measurement.

· Use the lower number box to determine the scale. Enter a numerical value and the desired units

of measurement for the scale.

· Name and describe the calibration. The scale will be detailed in Scale pane.

Click OK to save the calibration.

The keyboard shortcut to enable this feature is Ctrl+Shift+C.
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3.3.4.25 Add/Edit Video Annotations

 Add/Edit Video Annotations

Click Add/Edit Video to add/edit video annotations:

Figure 1. Comment Tab, Add/Edit Video Highlighted

The pointer will become a crosshairs icon. Click and drag to determine the location at which you want

to insert the video annotation. The Insert Video dialog box will open:
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Figure 2. Insert Video Dialog Box

· Click the File text box/icon to select the file to be inserted into the document.

· Use the Enable when dropdown menu to determine when the video is enabled.

· Use the Disable when dropdown menu to determine when the video is disabled.

· Select the Play in floating window box to play the video in a floating window when the

annotation is selected. Use the Width and Height boxes to determine the width and height of

the floating window.

· Select the Snap to content proportions to scale the rectangle in which the video is placed to

the same proportions as the video content.

· Use the Border dropdown menus to determine the size and color of the border used for the

annotation.

· Use the Poster dropdown menu to determine the image used as the poster for the annotation.

· Select the Transparent background box to give the annotation a transparent background.
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· Select the Show Controls box to display controls for playing, pausing, stopping and controlling

the volume when the video plays.

Click OK to add the video annotation.

The Rich Media Properties Pane

When video annotations are selected, it is possible to view/edit their properties in the Rich Media

Properties pane:

Figure 3. Rich Media Properties Pane

· Media Type is the media type of the annotation.

· Printable is the print status of the annotation. If this property is enabled then the annotation is

printed with the document. If this property is not enabled then the annotation is not printed.

· Locked is the locked status of the annotation. If this property is enabled then the annotation

cannot be deleted and its properties (including its position and size) cannot be modified by

users.

· Layer determines the optional content layer to which the annotation belongs. Further

information about layers is available here.

· Stroke Color determines the border color of the annotation.
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· Border Width determines the border width of the annotation.

· Enable On determines when the annotation is enabled.

· Disable On determines when the annotation is disabled.

Note that it is necessary to click Add/Edit Video in order to edit existing video annotations.
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3.3.4.26 Add/Edit Sound Annotations

 Add/Edit Sound Annotations

Click Add/Edit Sound to add/edit sound annotations:

Figure 1. Comment Tab, Add/Edit Sound Highlighted

The pointer will become a crosshairs icon. Click and drag to determine the location at which you want

to insert the sound annotation. The Insert Sound dialog box will open:
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Figure 2. Insert Sound Dialog Box

· Click the File text box/icon to select the file to be inserted into the document.

· Use the Enable when dropdown menu to determine when the sound is enabled.

· Use the Disable when dropdown menu to determine when the sound is disabled.

· Select the Play in floating window box to play the sound in a floating window when the

annotation is selected. Use the Width and Height boxes to determine the width and height of

the floating window.

· Use the Border dropdown menus to determine the size and color of the border used for the

annotation.

· Use the Poster dropdown menu to determine the image used as the poster for the annotation.

· Select the Transparent background box to give the annotation a transparent background.

· Select the Show Controls box to display controls for playing, pausing, stopping and controlling

the volume when the sound plays.
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Click OK to add the sound annotation.

The Rich Media Properties Pane

When sound annotations are selected, it is possible to view/edit their properties in the Rich Media

Properties pane:

Figure 3. Rich Media Properties Pane

· Media Type is the media type of the annotation.

· Printable is the print status of the annotation. If this property is enabled then the annotation is

printed with the document. If this property is not enabled then the annotation is not printed.

· Locked is the locked status of the annotation. If this property is enabled then the annotation

cannot be deleted and its properties (including its position and size) cannot be modified by

users.

· Layer determines the optional content layer to which the annotation belongs. Further

information about layers is available here.

· Stroke Color determines the border color of the annotation.

· Border Width determines the border width of the annotation.

· Enable On determines when the annotation is enabled.

· Disable On determines when the annotation is disabled.
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Note that it is necessary to click Add/Edit Sound in order to edit existing sound annotations.
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3.3.4.27 Add/Edit 3D Annotations

 Add/Edit 3D Annotations

Click Add/Edit 3D Annotations to add/edit 3D annotations:

Figure 1. Comment Tab, Add/Edit 3D Annotation Highlighted

The pointer will become a crosshairs icon. Click and drag to determine the location at which you want

to insert the 3D annotation. The Add 3D Annotation dialog box will open:
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Figure 2. Add 3D Annotation Dialog Box

· Select the From file button to add a 3D annotation from file, then enter the name and path of

the file or click the icon to select it using the Windows file explorer.

· Select the From annotation button to add a 3D annotation from an existing 3D annotation in

the current document, then select the desired annotation in the dropdown menu.

· Use the Enable when dropdown menu to determine when the 3D annotation is enabled.

· Use the Disable when dropdown menu to determine when the 3D annotation is disabled.

· Select the Play in floating window box to display the 3D annotation in a floating window

when it is enabled. Use the Width and Height number boxes to determine the dimensions of

the floating window.
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· Use the Border number box and adjacent dropdown menu to determine the size and color of

the border around the 3D annotation.

· Use the Poster dropdown menu to determine the image that displays over the 3D annotation

before it is enabled:

· Select Retrieve poster from default view to use the default view of the 3D annotation

as the poster.

· Select Create poster from file to use a file on your computer, then select the file in the

Open Files dialog box.

· Use the Background Color dropdown menu to determine the background color of the 3D

annotation. This color will also be used as the color of the annotation before it is enabled when

the Retrieve poster from default view option detailed above is used.

· Use the Lighting Scheme dropdown menu to determine the lighting scheme of the 3D

annotation.

· Use the Rendering Style dropdown menu to determine the rendering style of the 3D

annotation.

· Use the Animation Style dropdown menu to determine the animation style of the 3D

annotation.

· Select the Show toolbar and/or Show model tree view boxes to enable/disable these options

as desired.

Click OK to add the 3D annotation.

The 3D Properties Pane

When 3D annotations are selected, it is possible to view/edit their properties in the 3D Properties

pane:
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Figure 3. 3D Properties Pane

· 3D Model Type is the model type of the 3D annotation.

· Printable is the print status of the 3D annotation. If this property is enabled then the annotation

is printed with the document. If this property is not enabled then the annotation is not printed.

· Locked is the locked status of the 3D annotation. If this property is enabled then the annotation

cannot be deleted and its properties (including its position and size) cannot be modified by

users.

· Layer determines the optional content layer to which the 3D annotation belongs. Further

information about layers is available here.

· Stroke Color determines the border color of the 3D annotation.

· Border Width determines the border width of the 3D annotation.

· Background Color determines the background color of the 3D annotation. 

· Enable On determines when the 3D annotation is enabled.

· Disable On determines when the 3D annotation is disabled.

Note that it is necessary to click Add/Edit 3D Annotations in order to edit existing 3D annotations.
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3.3.4.28 Manage Comments

 Manage Comments

Use the options in the Manage Comments group to manipulate and utilize comments:

Figure 1. Comment Tab, Manage Comments Group

· Click Summarize Comments to create a comment summary, as detailed here.

· Click Import to import comments from file, as detailed here.

· Click Export to export comments to file, as detailed here.

· Click the Show dropdown menu to determine which comments are shown/hidden, as detailed

here.

· Click Flatten to flatten comments to base content, as detailed here.
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· Click Comments List to open/close the Comments  pane.

· Click Comment Styles to open the Comment Styles Palette and edit comment styles, as

detailed here.
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3.3.4.28.1  Summarize Comments

 Summarize Comments

Click Summarize Comments to create a summary of document comments: 

Figure 1. Comment Tab, Summarize Comments

The Summarize Comments dialog box will open:
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Figure 2. Summarize Comments Dialog Box

· Use the Group by and Sort By dropdown menus to determine how comments are grouped

and summarized:

· Select Page to group/sort comments by page.

· Select Type  to group/sort comments by type.

· Select Author to group/sort comments by author.

· Select Date to group/sort comments by date. 

· Select Subject to group/sort comments by subject.
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· Select Visual Order to sort comments by their visual order.

· Select the Exclude replies box to exclude replies to comments from the summary.

· Select the Include invisible comments box to include invisible comments in the

summary.

· Use the Page Range settings to determine the page range from which the comment summary

comes:

· Select All to include all pages.

· Select Current to use only the current page.

· Select Custom to use a custom page range, then ensure the desired page range in the

number box. Further information on the specification of page ranges is available here.

· Use the Pages box to specify a custom page range.

· Use the Subset option to specify a subset of custom page ranges. Select All Pages, Odd

Pages Only or Even Pages Only as desired.

· Use the Output dropdown menu to determine the format of the summary.

· Use the Options dropdown boxes to determine customizable options for the selected output

format:

· Use the Paper dropdown menu to determine the paper size used.

· Use the Layout dropdown menu to determine the layout used.

· Click Fonts to determine the fonts used for the summary.

· Use the Destination Folder text box to determine the destination folder for the summary, or

click the icon to select a folder on the local computer. 

· Use the Filename text box to determine the name of the summary. Click the macro dropdown

menu to add macros  as desired.

· Select the View New Document after creation box to open the document when the process is

complete.

Click OK to create the summary.

N.b. Text that the Highlight, Strikeout and Underline Tools have been used to annotate is not

included in comment summaries by default. Add text to the pop-up note of these annotations in order

to include them in the comment summary. (This is true for all comments that feature pop-up notes).

There is an option in the Commenting Preferences  that automatically adds annotated text to the

associated pop-up note of annotations.
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3.3.4.28.2  Import Comments

 Import Comments

Click Import to import comments into the active document:

Figure 1. Comment Tab, Import

The Open Files dialog box will open. Select the desired file and click Open to import comments. 

Comments can be imported from (*.fdf) or (*.xfdf) files. FDF format is the file format used to submit,

receive and incorporate form data to a server. It can also be used to export form data to stand-alone

files that can be stored, electronically transmitted and imported back into the corresponding PDF
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interactive form. Use the Export Comments to Data File  feature of PDF-XChange Editor to export

document comments to (*.fdf) or (*.xfdf) files.

Please note that the document location of imported comments matches that of the file used for the

import. If comments appear to be placed incorrectly then it is probable that the source and recipient

files are different in format. For example, if comments from a ten-page document are imported into a

two-page document, then comments from only the first two pages will be imported.
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3.3.4.28.3  Export Comments

 Export Comments

Click Export to export comments from the active document to (*.fdf) or (*.xfdf) files:

Figure 1. Comment Tab, Export 

The Save File dialog box will open. Enter the desired file name and location, then click Save to export

and save the document comments.
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3.3.4.28.4  Show Comments

 Show Comments

Click the Show dropdown menu to view comment display options:

Figure 1. Comment Tab, Show

These options are used to determine the display settings for comments and comment pop-ups:

· Click Show All Comments/Hide All Comments to show/hide all document comments.

· Hover over By Type to determine comment display options according to their format. A

submenu containing all comment formats in the document will be displayed. Select the check

boxes of the desired comment formats to be displayed.
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· Hover over By Author to determine comment display options according to their author. A

submenu containing all comment authors will be displayed. Select the check boxes of the

desired comment authors to be displayed.

· Hover over Checked to determine comment display options according to their

checked/unchecked status in the Comments Pane.  (Please note that each comment in the

Comments pane features a check box, and it is these check boxes that are referenced with

regard to this setting). A submenu containing all available options will be displayed. Select the

check boxes of the desired comment statuses to be displayed.

· Hover over By Status to determine comment display options according to their current editing

status. (Right click comments and hover over Status in the submenu to view/edit the editing

status of comments. The options are None, Accepted, Cancelled, Completed and Rejected.

Click options to set them as the comment editing status). A submenu containing all available

options will be displayed. Select the check boxes of the desired comment statuses to be

displayed.

· Select Open All Pop-ups or Close All Pop-ups to open/close the pop-up annotations of all

comments.

358
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3.3.4.28.5  Flatten Comments

 Flatten Comments

Click Flatten Comments to flatten comments and annotations to the base content layer of documents:

Figure 1. Comment Tab, Flatten Comments

The Flatten Annotations dialog box will open:
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Figure 1. Flatten Annotations Dialog Box

· Use the Page Range options to determine the page range in which comments are flattened:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

· Use the Non-Printable and Form Fields options to determine the outcome of the flattening

process for non-printable annotations and form fields. (The Properties options for

comments/annotations can be used to determine whether or not they are printable):

· Select Flatten to flatten content

· Select Left as Is to retain the existing state of content.

· Select Remove to remove the content from the document.

Click OK to flatten content.

1285
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3.3.4.28.6  Show Comments List

 Show Comments List

Click Comments List (or press Ctrl+M) to show/hide the Comments Pane:

Figure 1. Comment Tab, Comments List

358
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3.3.4.28.7  Comment Styles Palette

 Comment Styles Palette

Click Comment Styles to open the Comment Styles Palette:

Figure 1. Comment Tab, Comment Styles

 The Comment Styles Palette will open:
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Figure 2. Comment Styles Palette

The Comment Styles Palette details current comment styles. Click comment formats in the pane on

the left to view available comment styles. Several default comment styles are available for each format,

and they are displayed in the central pane. Double-click to select styles (which will also update selected

annotations in the current document). The following options are then available:

· Click Clone to clone the selected style. This feature creates a duplicate of styles in order to

enable editing without the loss of the existing style. The cloned style will appear in the

Comment Styles Palette. Select it and then click Properties to edit the properties of the style.

Available properties depend on the comment format. All available properties are detailed

here.

· Click Rename  to rename the selected style, then enter the new name in the Rename

Comment Style dialog box and click OK.

· Click Reset to reset the selected style to its default values.

· Click Delete to delete the selected style.

· Click Set Current to set the selected style selected as the active style for the tool. 

Note that the active style of each comment is displayed in the Comment  tab.

1303
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3.3.5 Protect Tab

 Protect Tab

When the Protect tab is selected, the following options are available:

Figure 1. Protect Tab

The options in this tab are used to enhance/edit document security. There are six groups in the Protect

tab:

Tools

The Tools group contains shortcuts to tools and other features:



647

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Further

information about this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

Digital Signatures

The Digital Signatures group contains options and adding and interacting with digital signatures:
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· Click Sign Document to sign an existing signature field in the current document. If more than

one signature field is present then it is necessary to select the desired field. If there are no

existing signature fields then the pointer will become a blue rectangle. Move the rectangle to

the desired location then click to add a new signature field. These operations are detailed

here.

· Click Place Signature to create and sign a digital signature field in one step. The pointer will

become a blue rectangle. This rectangle represents the new signature field. Move it to the

desired location and then click to add it to the document. The Sign Document dialog box will

open and can be used to customize digital signatures, as detailed here.

· Click Certify to certify documents and add a physical signature. This process is identical to the

Sign Document process detailed above. However, it is only possible to certify documents a

single time, whereas is it possible to digitally sign documents multiple times.

· Click Certify (Invisible) to certify documents and add an invisible signature. This process is

identical to the Certify (Visible) process detailed above, but the physical signature is excluded

from the process.

· Click Timestamp to timestamp documents, as detailed here.

· Click Validate All Signatures to validate all signatures in the current document.

· Click Clear all Signatures to remove signatures from signature fields.

Signatures and Initials

The Signatures and Initials group is used to select and manage physical signatures. Current signatures

are displayed in the pane. Use the arrows to browse/select signatures. Click to select signatures, then

click again to add them to documents. Signatures can be edited as normal content items until the

Apply All option detailed below is used.

· Click Manage to manage signatures. The Manage Signatures and Initials dialog box will

open, which is detailed here.

· Click Apply All to apply signatures that have been added to the document. Signatures are

flattened to base content when this option is used.
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· Click Cancel All to remove signatures that have been added to the document but have not

been applied.

Redact

The Redact group is used to mark document content for redaction and perform the redaction

operation:

· Click Mark for Redaction to mark the document areas to be redacted.

· Click Apply Selected to apply redaction to the marked redaction area in cases where multiple

areas have been marked.

· Click Apply All to apply redaction to all areas marked for redaction.

· Click Find and Redact to locate specific words or patterns (phone numbers, credit card

numbers, social security numbers, emails or dates) in documents and either mark them for

redaction or perform redaction on then immediately, as detailed here.

· Click Sanitize Document to sanitize the current document, as detailed here.

Further information about the Redaction feature is available here.

Document Security

The Document Security group contains options for viewing/editing document security:

· Click Security Properties to view/edit document security properties, as detailed here.

· Click Security Policies to view/manage security policies, as detailed here.

DocuSign

The DocuSign group contains options for using DocuSign with documents:
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· Click Sign with DocuSign to sign the current document with DocuSign.

· Click Send with DocuSign to send the current document with DocuSign.

· Click Create Envelope to create a DocuSign envelope, as detailed here.

· Click Login to DocuSign to log in to DocuSign.

· Click Logout of DocuSign to log out from DocuSign.

672
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3.3.5.1 Digital Signature Options

 Digital Signature Options

Use the options in the Digital Signatures group to perform operations that relate to digital signatures:

Figure 1. Protect Tab, Digital Signatures Group

Digital signatures are used to demonstrate the authenticity of documents and increase their security.

They can also be used to determine editing permissions for documents, and to add timestamp server

verification to documents. The Form  tab can be used to add digital signature fields to documents.

Digital signatures utilize a digital ID in order to operate. Digital IDs are used to create digital

signatures and to decrypt documents that have been encrypted for the owner. They contain the

information detailed in (figure 5) below, as well as two keys: the public key and the private key. The

676
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public key contains the information about its owner, and can be shared by the owner in order for a

recipient to encrypt information that is intended for only the owner to view. The public key can also be

used to validate the digital signature of the owner. The private key is used to create/apply digital

signatures, and to decrypt documents that have been encrypted via certificate security. 

Sign Document

Click Sign Document to sign existing signature fields. The dialog box detailed in (figure 2) will open.

If more than one signature field is present then it is necessary to select the desired field. If there are no

existing signature fields then the pointer will transform into a blue rectangle. This represents a new

signature field. Place it at the desired location in the document and then click to create the signature

field. The following dialog box will open:
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Figure 2. Sign Document Dialog Box

· Select a certificate from the system store or the local computer.

· Click View Certificate to view details about the selected certificate.

· Click Create Certificate to create a new certificate. The dialog box displayed in (figure 3) will

open.

· Click the Reason for Signing menu, or enter text into the box manually, to add a reason for

signing the document.

· Click the Location box to enter a location as desired.

· Click the Contact Info box to add contact information to the signature.

· Click the Permissions box to determine the changes that are permitted after the document has

been signed. 
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· Click the Sign Template menu to select layout options for the signature and associated

information. 

· Click Manage to manage/customize/create signature templates. The Digital Signature

Appearance Templates dialog box will open, as detailed below.

· Select the Use Timestamp Server box to select a timestamp server to add to the signature,

then select a timestamp server from the dropdown menu. Click Change to view/edit the details

of the timestamp server used.

Click OK to add the digital signature to the document.
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Figure 3. Digital Signature Appearance Templates Dialog Box

· Select signature templates, then select Clone/Reset/Edit as desired:

· Click Clone to clone the selected signature template. This is a useful feature if parameters

of existing signature templates need to be changed and saved without editing the

original template.

· Click Reset to revert the values of the the selected signature template to its default state. 

· Click Edit to adjust the values of the selected signature template:
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Figure 4. Edit Template of Digital Sign Dialog Box

· Use the Template Name text box to edit the name of the signature template.

· Use the Icon dropdown menu to specify the icon used with the signature, and use the adjacent

Font dropdown menu to specify the font used.

· Use the Background Logo dropdown menu to specify the logo used with the signature, and

use the adjacent Opacity number box to specify the transparency level of the background.

· Use the Display Text check box options to specify the text that is displayed with the signature.

Click OK to save changes.

Creating Digital Certificates

The following dialog box is used to create digital certificates:
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Figure 5. Create Self-Signed Digital ID Dialog Box

· Enter the desired user information in Name, Organization and Email text boxes.

· Use the Country/Region dropdown menu to enter the nationality of the owner of the digital

certificate.

· Select either 1024-bit RSA or 2048-bit RSA as the key algorithm. 1024-bit RSA is more

universally compatible than 2048-bit RSA, but 2048-bit RSA offers more security.

· Select a storage location for the digital certificate. If the PKCS#12 option is used then enter

and confirm a password in the Password text boxes.

Click OK to create the digital certificate. It will then be available in the Use Certificate from System

Store dropdown menu detailed in (figure 2).
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Place Signature

Click Place Signature to create and sign a digital signature field in one step. A blue rectangle will

appear beneath the pointer. This rectangle represents the new signature field. Move it to the desired

location and then click to add it to the document. The Sign Document dialog box will open. Follow the

instructions as detailed beneath (figure 2). 

Certify (Visible) and (Invisible)

Click Certify (Visible) to certify documents and add a visible signature. This process is identical to the

Sign Document process detailed above. However, it is only possible to certify documents a single

time, whereas is it possible to digitally sign documents multiple times.

Click Certify (Invisible) to certify documents and add an invisible signature. This process is identical to

the Certify (Visible) process detailed above, but the physical signature is excluded from the process.

Timestamp

Click Timestamp to add timestamps to documents. The following dialog box will open:

Figure 6. Timestamp Server Dialog Box

Timestamps are used to ensure the long-term preservation of digital signatures, time-seal date objects

(to prove when they were received), protect copyrights/intellectual property and provide notarization

services.

· Use the Timestamp Server dropdown menu to select a timestamp server.

· If a timestamp server is being used for the first time then enter the website address in the

Server URL text box.
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· If the selected timestamp server requires authentication then select the indicated box and enter

the User Name and Password in the associated text boxes.

Click OK to timestamp documents.

Validate All Signatures

Click Validate All Signatures to validate all document signatures. (Please note that the default settings

of the computer on which the files are viewed may result in this happening automatically when

documents are opened).

Clear all Signatures

Click Clear All Signatures to clear all digital signatures/certificates from signature fields. Please note

that this process does not remove the signature field itself. The Select Fields  feature is used for this

purpose. 

Please note that when digital signatures have been applied to documents and need to be subsequently

verified it is necessary to have the incremental save feature enabled. This feature can be

enabled/disabled using the Documents settings of the Preferences tab, as detailed here.   

676
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3.3.5.2 Signatures and Initials

 Signatures and Initials 

Use the options in the Signatures and Initials group to view customized (non-digital)

signatures/initials and manage, apply or cancel current signatures/initials:

Figure 1. Protect Tab, Signatures and Initials Group

· Available signatures are displayed in the pane. Click to select signatures, then click again to add

them to the document. They can then be resized and/or repositioned as detailed here.

· Click Manage to manage signatures. The dialog box detailed in (figure 2) will open.

· Click Apply All Signatures to apply all placed signatures to the document. This process

converts signatures from editable objects into base content of documents. 

1087
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· Click Cancel All Signatures to remove signatures that have been placed in documents. (This

action will not remove signatures that have been applied. The Undo action in the Quick

Access  toolbar can be used to remove applied signatures).

Figure 2. Manage Signatures and Initials Dialog Box

· Click Add to add new signatures/initials to the list of available options:

· Click From File to add a new signature from a file.

· Click From Clipboard to use the current clipboard content to create a new signature.

· Click Draw Signature to draw a new signature.

· Click Type Signature to type a new signature. The Type Signature dialog box will open,

as detailed below.

· Click From Webcam to create a new signature using your webcam.

· Click Edit to edit selected signatures. The Edit Signatures/Initials Information dialog box will

open. Update the signature name/password as desired then click OK.

· Click Remove to remove selected signatures, or Remove All to remove all signatures.
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Figure 3. Type Signature Dialog Box

· Enter the name to be used for the signature in the window.

· Use the Color dropdown menu to determine the color of the signature.

· Click Clear to clear existing text from the signature pane.

· Use the Change Style dropdown menu to change the font used for the signature. Pecita is the

only font available by default, but you can use any TrueType/OpenType font for this purpose.

If you want to make additional fonts available, then copy the corresponding .ttf/.otf file from

"C:\Windows\Fonts" into the folder "C:\Program Files\Common Files\Tracker

Software\Common\SignatureFonts".

Click OK to create the new signature.
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3.3.5.3 Redaction and Sanitization

 Redaction and Sanitization

Use the options in the Redact group to perform redaction or sanitization on the current document:

Figure 1. Protect Tab, Redact Group

Redaction "blacks out" designated document content. Click Mark for Redaction to determine sections

of the document for redaction. The pointer will become a crosshairs icon. Click and drag to determine

areas for redaction:
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Figure 2. Areas Marked for Redaction

The area on the right has just been determined, which means editing options are available:

· Use the control points to resize areas.

· Use the editing aids detailed here  to assist in the precise placement of areas marked for

redaction.

· Click and drag areas to reposition them.

· Right-click areas for further options: 

· Click Apply All to redact all areas marked for redaction. 

· Click Apply Selected to redact only selected areas. (The Select Comments Tool  can

be used to select multiple areas). 

· See here  for an explanation of the remaining options.

Click Apply All to perform the redaction. Marked areas will be replaced with black fill:
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Figure 3. Redacted Areas

Note that the Format tab is enabled when the Redaction feature is in use. Use the commands in this

tab to customize the style and properties of redactions:
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Figure 4. Format Tab, Redaction Tool

· Use the Fill Color dropdown menu to determine the color of areas marked for redaction.

· Use the Stroke Color dropdown menu to determine the border color of areas marked for

redaction.

· Use the Opacity dropdown menu to determine the level of transparency in areas marked for

redaction.

· Keep Selected determines whether or not the Redaction feature remains selected after a single

area has been marked for redaction. If this setting is enabled then the tool will remain selected

and can be used to create areas consecutively. If this setting is not enabled then PDF-XChange

Editor will revert to the designated default tool immediately after a single area is marked

· Exclusive Mode simplifies the process of using the Redaction feature. When Exclusive Mode is

enabled, the pointer ignores all interactive elements of documents other than base content.

This makes it possible to mark areas for redaction without the risk of accidentally selecting

undesired items. When Exclusive Mode is disabled, the pointer recognizes and interacts with

all underlying elements in the usual manner.

· Use the Overlay Type dropdown menu to determine the type of overlay used for the reaction:

· Click Standard to use stand redaction overlays, which are a fill of a specified color.

· Click Blur to use a blur for redaction overlays, or Blur Extra to use a stronger blur than

the default option.
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· Click Pixelate to use pixelation for redaction overlays, or Pixelate Extra to use a stronger

pixelation than the default option.

· Use the Redaction Color dropdown menu to determine the color of redacted areas.

· Use the Text Color dropdown menu to determine the color of text used to overlay redacted

areas when the text option is enabled. Use the Text property in the Redaction Properties pane

to specify the text used.

· Use the Font combo box to determine the font used when the Text property is being used.

· Use the Font Size combo box to determine the font size when the Text property is being used.

· Use the Align options determine the alignment of text when the Text property is being used.

· Enable the Repeat Overlay Text option to repeats the text used within redacted areas when

the Text property is being used.

· Click Apply All to apply all redactions marked in the current document.

· Click Properties to view/edit the Redaction Properties pane, as detailed in (figure 4). Click to

edit properties. Note that the options in the Overlay section apply to applied redactions.

Find and Redact

Click Find and Redact to launch the Find and Redact feature:

Figure 5. Protect Tab, Find and Redact Highlighted
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This feature is used to search for specific words or patterns (phone numbers, credit card numbers, social

security numbers, emails or dates) in documents and then either mark them for redaction or redact

them immediately. When it is selected, the Find and Redact Text dialog box will open:

Figure 6. Find and Redact Text Dialog Box

· Select Single word or phrase to search for a single word/phrase, then enter the desired

word/phrase in the text box.

· Select the Match Case box to match the case of word entered in the text box.

· Select the Whole Words Only box to match only whole words in the document to the

word entered in the text box.

· Select the Use regular expressions box to enable the use of ECMAScript syntax-based

regular expressions in the search. Further information about regular expressions is

available here.

· Select Multiple words or phrases to search for multiple words/phrases. Click Add/Remove to

add/remove words/phrases, then enter the desired words/phrases in the text box. Click Save to

save the current word list to a plain text file for subsequent use. Click Load to load a plain text

file of words into the text box.

· Select Patterns to search for specific patterns, then select either Phone numbers, Credit cards,

Social security numbers, Emails or Dates to determine the patterns that you want to find.

http://www.cplusplus.com/reference/regex/ECMAScript/
https://en.wikipedia.org/wiki/Regular_expression
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· Select an option in the Locale dropdown menu to determine the language used in the

search.

· Click Add to add a custom pattern to the available search options. Enter the name, value

and description of the custom pattern and click OK to save. The custom pattern will then

be available in the list of patterns.

· Click Remove to remove selected custom patterns. 

· Select a Page text radio button to determine the outcome of the operation for page text:

· Select Mark found text for redaction to mark search results for redaction.

· Select Redact found text to immediately redact search results.

· Select the check boxes on the right side of the dialog box to determine where you want to

search for text to redact.

· Select an Objects text radio button to determine the outcome of the operation for object-

based text (such as text in comments):

· Select Delete found text to delete text that matches the search terms.

· Select Replace text with: to replace text that matches the search terms, then enter the

desired replacement text in the text box.

Click OK to find and mark/redact content.

Sanitize Document

Click Sanitize Document to remove sensitive information from documents:
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Figure 7. Document Tab Submenu, Redaction Options, Sanitize Document

The Sanitize Document Options dialog box will open:
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Figure 8. PDF-XChange Editor Dialog Box

Select the check boxes of the document content that you want to sanitize in the document,

then use the Rasterization resolution dropdown menu to specify the desired resolution for

sanitization, and click OK to sanitize the document.
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3.3.5.4 Create DocuSign Envelope

 Create DocuSign Envelope

Click Create Envelope to create a DocuSign envelope:

Figure 1. Protect Tab, Create Envelope

The Choose Files dialog box will open:
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Figure 2. Choose Files Dialog Box

· Click Add Files to select files from the local computer to add to the list of source files. Click the

dropdown arrow for additional options:

· Click Add All Opened Documents in Opened Order to add all open documents in the

order in which they were opened.

· Click Add All Opened Documents in the Current Tab Order to add all open documents

in their current order in the document tab.

· Click Add Folder to add entire folders to the list of source files. Click the arrow adjacent to the

button to determine further options. The Add Files From Folder Options dialog box will open.

This is detailed in (figure 3).

· If you want to use a custom page range from a document in the list, then double-click it and

specify the desired page range in the Page Range Setup dialog box. Page range settings are

detailed here.  

· Use the arrow icons (or click and drag) to reorder selected documents in the list. This

determines the order in which they appear in the new document.

· Click Options to determine the actions taken with objects contained within combined files. The

Options dialog box will open. The available actions relate to comments, form fields and

bookmarks. Select the Add root bookmark with file name box as desired.

Click OK to create a DocuSign envelope from all files in the Combine Files dialog box.

1285
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Figure 3. Add Files From Folder Options Dialog Box

· Select the Ask for suitable file extensions after choosing a source folder box to launch this

dialog box when folders are selected using the Add Folder button. 

· Select the Include Subfolders box to include subfolders of the parent folder when the software

searches for files to add to the list of source files.

· Select the Select file types which should be added while searching folders box to determine

file types to be included when the software performs a search.

· Custom filters can be added using the Add Custom Filter option. This facilitates the creation of

custom profiles for subsequent use that search for specific file extensions. Click Add Custom

Filter to open the Add Custom Filter dialog box:

Figure 4. Add Custom Filter Dialog Box



675

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Enter a name for the custom filter.

· Enter the desired file extensions. File extensions must begin with an asterisk and a period, for

example: *.apm, *.bmp. 

· When the desired details have been entered, click OK to save the custom filter.
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3.3.6 Form Tab

 Form Tab

When the Form tab is selected, the following options are available:

Figure 1. Form Tab

The options in the Form tab are used to create and edit form fields, form data, and JavaScript. There

are four groups in the Form tab:

Tools

The Tools group contains shortcuts to tools and other features:
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· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Further

information about this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

Form Fields

The Form Fields group contains options for creating and editing form fields:
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· Click Select Fields to select fields for editing or repositioning. Click a field to select it, or click

and drag to reposition fields.

· Click Text to enable the Text Field feature, then click to add text fields. These fields are used to

denote a space in which users can can enter text, such as their address or credit card details.

Further information and instructions for this feature are available here.

· Click Button to enable the Button feature, then click to add buttons. Buttons allow users to

trigger an event/action, such as opening a web link or playing a sound. Further information and

instructions for this feature are available here.

· Click Check Box to enable the Check Box feature, then click to add check boxes. Check boxes

allow users to make a binary choice between mutually exclusive options, such as yes/no

answers. Further information and instructions for this feature are available here.

· Click Radio to enable the Radio Button feature, then click to add radio buttons. Radio buttons

allow users to choose only one of a predefined set of options, such as when answering multiple

choice questions. Further information and instructions for this feature are available here .

· Click  List Box to enable the List Box feature, then click to add list boxes. List boxes allow

users to select one or more items from a list of options contained within a static, multiple line

text box, such as a list of months of the year. Further information and instructions for this

feature are available here.

· Click  Barcode to enable the Barcode feature, then click to add barcodes. Barcodes

translate form data into an encoded pattern that compatible devices can read and archive.

Further information and instructions for this feature are available here.

· Click  Dropdown to enable the Dropdown feature, then click to add dropdown menus.

Dropdown menus allow users to select only one value from a list of options contained within a

static, multiple line text box, such as a list of nationalities. Further information and instructions

for this feature are available here.

· Click  Date to enable the Date feature, then click to add date fields. These fields are a

modified version of the Text Fields feature detailed above and feature date functionality by

default.

· Click  Digital Signature to enable the Digital Signature feature, then click to add digital

signature fields. These fields allow users to add digital signatures to documents. Further

information and instructions for this feature are available here.

· Click  Image to enable the Image feature, then click to add image fields. These fields are a

modified version of the Button feature detailed above, and feature JavaScript by default that

enables the insertion of images to be submitted as form data.
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· Click Highlight Fields to highlight all form fields in the document. Alternatively, click the

dropdown arrow to select manually which fields are highlighted.

· Click Grid to enable the grid feature, which is used to assist in the placement of form fields.

· Click Fields to show/hide the Fields  pane, which displays a breakdown of form fields in the

current document and can be used to edit fields.

· Click Identify Forms to identify content that is structured like form fields (for example in forms

converted from other formats to PDF) as detailed here.

Form Data

The Form Data group contains options that are used to manipulate form data:

· Click Reset Form to reset all form fields in the current document.

· Click Import Form Data to import data into the forms of the current document. The Open Files

dialog box will open. Select the desired file and click OK to import form data. Please note that

the field names of forms must match in order for form data to be imported. For example, if

there are three forms in the file from which data is imported that have the field names 'Text1',

'Text2' and 'Text3' respectively, then the current document must feature forms with the same

field names in order for form data to import. The field name property can be viewed/edited in

the Properties pane for forms, as detailed here.

· Click Export Form Data to export all data from the forms of the current document. The Save

File dialog box will open. Enter a name for the new file in the text box, then select a file format

from the Save as type dropdown menu and click Save to export the form data.

· Click Email Form Data to email the current document form data. The PDF-XChange Editor

dialog box will open. Select the desired file format and then click OK to email the form data.

PDF-XChange Editor will use the current email method as defined in the Send Mail

 preferences to email the form data. Please note that only the form data is sent, and not the

form itself. Recipients of these emails can use the Import Form Data option detailed above to

import the form data.

· Click Populate Forms to fill forms using data from a (*.csv) file, as detailed here.

JavaScript

The JavaScript group contains options that are used to edit JavaScript in the current document:

366

841

685

261

836



680

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Click JavaScript Console to open the JavaScript Console, which is used to add JavaScript to

documents. This feature is detailed here.

· Click Document JavaScript to open the JavaScript category of the Document Properties

dialog box, which can be used to create, edit or delete JavaScript, as detailed here.

· Click Document Actions to open the Actions category of the Document Properties dialog

box, which can be used to enable JavaScript actions when documents close, save or print, as

detailed here.

834
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3.3.6.1 Add Text Fields to Documents

 Add Text Fields to Documents

 

Text fields are used to denote a space in which users can enter form information such as their name,

password and date of birth:

Figure 1. Example Text Fields

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for text

fields. Click the dropdowns below for further information:

Add Text Fields to Documents
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1. Click the Form Tab, then click the Text Field icon. A blue rectangle will be displayed

beneath the pointer. This rectangle represents the text field:

Figure 2. Active Text Field Tool

2. Move the rectangle to the desired location and then click to add the text field to the

document. Added text fields appear as detailed below:
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Figure 3. Added Text Fields

· Click and drag the yellow control points to resize text fields.

· Use the options in the Format Tab to determine the style and appearance of selected

text fields:
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Figure 4. Format Tab, Text Field Forms

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple text fields consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single text field.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· Click Calculation Order to show/hide the order in which calculations are

performed when there is more than one form field that contains a value

calculation. Further information about value calculations is detailed below.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields pane,  which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the text field.

· Click Stroke Color to determine the border color of text fields.

· Click Width to determine the width of text field borders.

· Click Border to determine the style of text field borders.

843
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· Select an option in the Font and Font Size dropdown menus to determine the

font style and size used in text fields.

· Use the Text Color dropdown menu to determine the color of fonts used in text

fields.

· Click Properties to open the Text Field Properties pane, which enables the

customization of additional elements of text fields and is detailed in the section

below.

The Text Field Properties Pane 

The Text Field Properties pane can be used to determine a range of style and functionality

options for text fields. For example, it is possible to use the Actions properties to add multiple

dynamic actions to text fields, such as running JavaScript, launching web links and opening

files on the local computer. (JavaScript is a high-level programming language that can be used

to perform custom operations. See here for an index of existing JavaScript operations that the

PDF-XChange Editor forms can use, as well as additional information about JavaScript). Click

Select Fields to select form fields, then click the desired field and click Properties in the

Format tab to open the Text Field Properties pane:

Figure 5. Text Field Tool, Text Field Properties Pane

The options detailed below are available in the Text Field Properties pane:

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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The General properties determine the general parameters of text fields:

· Read Only determines whether or not the text field can be edited.

· Locked determines whether or not the text field can be moved, and whether or not its

properties can be modified.

· Field Name determines the name of the text field. This name is present when the

Select Fields tool is enabled, and when text fields are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

text field.

· Mapping Name determines the mapping name that the text field uses. This name is

used to reference interactive form data when the form is exported, and does so

without affecting the appearance of the name in the original document.

· Orientation determines the orientation of text entered in the text field.

· Visibility determines the visibility of the text field.

· Required determines whether or not the text field is a required field. Required fields

must be filled before documents that contain them can be submitted.

· Exportable determines whether or not the text field data can be exported from the

form.

· Layer determines the optional content layer to which the text field belongs. When a

field belongs to an optional content layer, it displays only when the layer is enabled.

Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of text fields. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of text fields:

· Left determines the distance of the text field from the left margin.

· Top determines the distance of the text field from the bottom of the page.

· Width/Height determine the width/height of the text field.

The Default Text Format properties determine the default properties when text is entered

into the text field:

· Font determines the font used. 

· Font Size determines the size of the font. 

· Text Color determines the color of the font.

The Options properties determine additional options for text fields:

· Alignment determines the text alignment within the text field.

· Default Value determines the default value of the text field. Text fields will show this

value by default. If they are edited and then reset then the value entered for this

property will be displayed.

· File Select determines whether or not files on the local computer are selected when

their filename is entered in the text field. If set to Yes then the file contents are

submitted as the value of the text field when the form is submitted.

366
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· Password determines whether or not the text field is a password field. If text fields are

designated as passwords then text entered into them will be encrypted in the standard

manner:

Figure 6. Standard Text Field (above) and Standard Text Field with Password Enabled (below)

· Check Spelling determines whether or not the spelling of words entered in the text

field is automatically checked.

· Multi Line determines whether or not multiple lines of text are permitted in the text

field.

· Scroll determines whether or not a scroll bar is added when multiple lines of text are

entered into text fields.

· Allow Rich Text determines whether or not the text field permits rich text such as bold

and italics.

· Comb determines whether or not line separators are inserted between characters in

the text field:

Figure 7. Standard Text Field (above) and Standard Text Field with Comb Enabled (below)

· Character Limit determines the maximum number of characters permitted in the text

field.

The Actions properties determine the action taken when users interact with the text field:

· Mouse Down initiates an action when the left mouse button is pressed (without being

released) on the text field.

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released) on the text field.

· Mouse Enter initiates an action when the pointer moves into the text field.

· Mouse Leave initiates an action when the pointer moves out of the text field.

· On Focus initiates an action when the text field is selected.

· On Blur initiates an action when the text field is deselected.

· Click the ellipsis icon on the right of actions to add/edit text field actions: 
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Figure 8. Text Field Properties Pane, Action Ellipses

The process of adding actions is detailed here.

The Format Value properties determine the type of information permitted to be entered in

the text field and the format in which it should be entered:

· Category determines the category of the text field. Each category has different

options, as detailed below:

· None is the default setting. Text fields do not have a Format Value category

when this option is selected.

· Number sets the text field input to numerical values. The following options are

available for this property:

· Decimal Places determines the number of decimal places displayed.

· Separator Style determines the separators used for numbers.

· Currency Symbol determines the currency symbol used in the text field.

· Symbol Location determines the location of the currency symbol in

relation to the number.

· Add Space inserts a space between the currency symbol and the number.

· Negative Number Style determines how numbers with negative values

are displayed.

302
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· Percentage sets the text field input to percentage values. The following options

are available for this property:

· Decimal Places determines the number of decimal places permitted.

· Separator Style determines the separator used for numbers.

· Date sets the text field input to date values and adds a dropdown calendar to

the text field. Use the Date Format parameter to determine the format of dates.

· Time sets the text field input to time values (hours and minutes). Use the Time

Format parameters to determine the format of time values.

· Special sets the text field input values to one of the special options. Use the

Special Format parameter to determine the format. The options are:

· ZIP Code

· ZIP Code +4, which is used for nine-digit postal codes.

· Phone Number

· Social Security Number

· Custom Action adds custom JavaScript actions to text fields. There are two

options:

· Format Action is used to enable custom JavaScript for formats. Click the

ellipsis icon to add/view JavaScript.

· Keystroke Action is used to enable custom JavaScript for keystrokes. Click

the ellipsis icon to add/view JavaScript.

· If the options above are used then the Add Action: "Run a JavaScript"

dialog box will open. Enter the desired JavaScript for the action and then

click OK:



690

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 9. Edit Action: "Run a JavaScript" Dialog Box

The Value Validation properties determine the validation of values entered into the text field.

These properties can be used to ensure that the information entered into forms fits within

specific parameters:

· Validation determines how values are validated:

· Value in Range sets the range within which values entered into the text field

must fall:

· From specifies the minimum value.

· To specifies the maximum value.

· Custom Action enables the use of custom JavaScript in order to validate values

entered in the text field:

· Validation Action specifies the JavaScript to use, as detailed in (figure 9).

The Value Calculation properties determine the value of text fields from other text fields, and

are used in forms where entered form data creates the value of further forms, such as when

several orders are placed that combine to give a total cost. The available properties are

detailed below:

· None specifies that calculations are not performed.

· Sum uses the sum of specified fields. 

· Product uses the product of specified fields.

· Average uses the average of specified fields.

· Minimum uses the minimum value of all the specified fields.
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· Maximum uses the maximum value of all specified fields.

· Please note that when the Sum, Product, Average, Minimum and Maximum

properties are used, the additional entry "Fields" will appear beneath the Calculation

property. Use this entry to specify the fields used in these calculations.

· Simplified Notation enables the insertion of a custom calculation to be performed on

fields. Use the Simple Notation box to determine the calculation. Use the document

field names and standard mathematical notation (+, -, *, /) to specify the calculation. If

there are spaces in form field names then they must be entered in quotation marks. For

example: Field1 + Field 2 / "Division Field" * 64.

· Custom Action enables the use of custom JavaScript in order to perform calculations

and determine the order in which calculations are performed. Click the ellipsis icon to

add custom JavaScript, as detailed in (figure 9).

Value Validation Example 

The following example details a simple value validation of values entered into the text field

'Text1':

Figure 10. Value Validation Example, Text Field

This example will detail how to validate that values entered into the text field 'Text1' fall in

the range 0-100:
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1. Click the Form tab, then click Select Fields and select the text field. 

2. Click the Format tab and click Properties. The Text Field Properties pane will open: 

Figure 11. Value Validation Example, Text Field Properties Pane

3. Scroll down the Text Field Properties pane to the Format Value tab, then click the

Category property and select Number:
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Figure 12. Value Validation Example, Category Option

4. Scroll down the Text Field Properties pane to the Value Validation tab, then click the

Validation option and select Value in Range:
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Figure 13. Value Validation Example, Validation Option

Note that the From and To options will appear beneath the Validation property.

5. Enter '0' in the From option and '100' in the To option:



695

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 14. Value Validation Example, From/To Option

All values subsequently entered into 'Text1' must fall into the range 0-100. Values outside of

the specified range will not be permitted, and if they are entered then an error message will

appear.

Value Calculation Example

The following example details a simple value calculation. There are three text fields: 'Text1',

'Text2' and 'Text3':
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Figure 15. Value Calculation Example, Text Fields

This example will detail how to use the product of the values entered in 'Text1' and 'Text2' to

create the value for 'Text3':

1. Click the Form tab, then click Select Fields and select 'Text3'.

2. Click the Format tab, then click Properties. The Text Field Properties pane will open:
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Figure 16. Value Calculation Example, Text Field Properties Pane

3. Scroll down the Text Field Properties pane to the Value Calculation tab, then click

the Calculation property and select Product:
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Figure 17. Value Calculation Example, Calculation Option

Note that the Fields property will appear beneath the Calculation property, as detailed in the

image below. This option is used to specify the source of the values to use in the product

calculation that will create the value for 'Text3'.

4. Click the ellipsis icon (three dots) on the right of the Fields option. The Fields

Selection dialog box will open. Select 'Text1' and 'Text2', then click OK: 
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Figure 18. Value Calculation Example, Field Selection Dialog Box

The value of 'Text3' will then be the product of the values entered in 'Text1' and 'Text2':



700

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 19. Value Calculation Example, Process Complete

If the values in 'Text1' and 'Text2' are subsequently changed, then the value in 'Text3' will

update.

Please note that the Calculation Order setting in the Fields Pane  can be used to determine

the order in which fields are calculated. This is a useful feature when documents contain more

than one form field that has value calculation settings. Follow the steps below to determine

the order of calculation:

1. Press Ctrl+I to open the Fields pane:

366
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Figure 20. View Submenu, Other Panes, Fields

2. Click Options and then click Calculation Order in the submenu:
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Figure 21. Fields Pane, Set Field Calculation Order

The Calculation Order dialog box will open:
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Figure 22. Calculation Order Dialog Box

The Calculation Order dialog box displays all form fields that contain value calculations. The

order from top to bottom is the order in which calculations are performed. Click to select form

fields and then click Move Up/Move Down to move fields up or down in the list.
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3.3.6.2 Add Check Boxes to Documents

 Add Check Boxes to Documents

Check boxes enable the selection of predefined options:

Figure 1. Example Check Boxes

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for check

boxes. Click the dropdowns below for further information:

Add Check Boxes to Documents
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1. Click the Form tab, then click Check Box. A blue square will be displayed beneath the

pointer. This square represents the check box:

Figure 2. Active Check Box Tool

2. Move the square to the desired location and then click to add the check box to the

document. Added check boxes appear as detailed below:
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Figure 3. Added Check Boxes

· Click and drag the yellow control points to resize check boxes.

· Use the options in the Format Tab to determine the style and appearance of selected

check boxes:
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Figure 4. Format Tab, Check Boxes

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple check boxes consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single check box.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· Click Calculation Order to show/hide the order in which calculations are

performed when there is more than one form field that contains a value

calculation. Further information about value calculations is detailed below.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the check box.

· Click Stroke Color to determine the border color of check boxes.

· Click Width to determine the width of check box borders.

· Click Border to determine the style of check box borders.

843
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· Select an option in the Font Size dropdown menus to determine the size of the

check mark used in check boxes.

· Use the Text Color dropdown menu to determine the color of the check mark

used in check boxes.

· Click Properties to open the Check Box Properties pane, which enables the

customization of additional elements of check boxes and is detailed in the

section below.

The Check Box Properties Pane

The Check Box Properties pane can be used to determine a range of style and functionality

options for check boxes. For example, it is possible to use the Actions properties to add

multiple dynamic actions to check boxes, such as running JavaScript, launching web links and

opening files on the local computer. (JavaScript is a high-level programming language that

can be used to perform custom operations. See here for an index of existing JavaScript

operations that the PDF-XChange Editor forms can use, as well as additional information

about JavaScript). Click Select Fields to select form fields, then click the desired field and click

Properties in the Format tab to open the Check Box Properties pane:

Figure 5. Check Box Tool, Check Box Properties Pane

The options detailed below are available in the Check Box Properties pane:

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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The General properties determine the general parameters of check boxes:

· Read Only determines whether or not the check box can be edited.

· Locked determines whether or not the check boxes can be moved, and whether or not

its properties can be modified.

· Field Name determines the name of the check box. This name is present when the

Select Fields tool is enabled, and when check boxes are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

check box.

· Mapping Name determines the mapping name that the check box uses. This name is

used to reference interactive form data when the form is exported, and does so

without affecting the appearance of the name in the original document.

· Orientation determines the orientation of the check box.

· Visibility determines the visibility of the check box.

· Required determines whether or not the check box is a required field. Required fields

must be filled before documents that contain them can be submitted.

· Exportable determines whether or not the check box data can be exported from the

form.

· Layer determines the optional content layer to which the check box belongs. When a

field belongs to an optional content layer, it displays only when the layer is enabled.

Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of check boxes. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of check boxes:

· Left determines the distance of the check box from the left margin.

· Top determines the distance of the check box from the bottom of the page.

· Width/Height determine the width/height of the check box.

The Default Text Format properties determine the default properties when text is entered

into the check box:

· Font Size is always set to auto for check boxes. This is because the font size refers to

the size of the tick when check boxes are selected, and the tick must be proportionate

to the size of the check box.

· Text Color determines the color of the tick when check boxes are selected.

The Options properties determine additional options for check boxes:

· Check Box Style determines the icon used when check boxes are selected.

· Export Value determines the value that represents check boxes when they are

exported.

· Checked by Default determines whether or not the check box is checked by default.

The Actions properties determine the action taken when users interact with the check box:

366
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· Mouse Down initiates an action when the left mouse button is pressed (without being

released).

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released).

· Mouse Enter initiates an action when the pointer moves into the check box.

· Mouse Leave initiates an action when the pointer moves out of the check box.

· On Focus initiates an action when the check box is selected.

· On Blur initiates an action when the check box is deselected.

· Click the ellipsis icon on the right of actions to add/edit check box actions:

Figure 6. Check Box Properties Pane, Action Ellipses

 The process of adding actions is detailed here.

Example Check Box List Creation 

The following example will detail how to create a check box list for the months of the year:

1. Click the Form tab, then click Check Box.

 

2. Click the Format tab, then click Grid and Keep Mode:

302
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Figure 7. Format Tab, Keep Mode Highlighted

3. Click to place check boxes in the document:
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Figure 8. Adding Check Boxes

The next step is to add text labels for the check boxes:

4. Click the Add dropdown menu in the Home tab, then click Text and add text labels

for the months of the year:
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Figure 9. Home Tab, Add Text Tool Selected
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3.3.6.3 Add Radio Buttons to Documents

 Add Radio Buttons to Documents

Radio buttons enable the selection of a single choice from several options, such as in answers to

multiple choice questions:

Figure 1. Example Radio Buttons

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for radio

buttons. Click the dropdowns below for further information:

Add Radio Buttons to Documents
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1. Click the Form tab, then click Radio Button. A blue square will be displayed beneath

the pointer. This square represents the radio button:

Figure 2. Active Radio Button Tool

2. Move the square to the desired location and then click to add the radio button to the

document. Added radio buttons appear as detailed below:



716

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 3. Added Radio Buttons

· Click and drag the yellow control points to resize radio buttons.

· Use the options in the Format Tab to determine the style and appearance of selected

radio buttons:
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Figure 4. Format Tab, Radio Buttons

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple radio buttons consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single radio button.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· The Calculation Order setting is not available for radio buttons.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the radio button.

· Click Stroke Color to determine the border color of radio buttons.

· Click Width to determine the width of radio button borders.

· Click Border to determine the style of radio button borders.

· Use the Text Color dropdown menu to determine the color of the check mark

used in radio buttons.

843
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· Click Properties to open the Radio Button Properties pane, which enables the

customization of additional elements of radio buttons and is detailed in the

section below.

The Radio Button Properties Pane

The Radio Button Properties pane can be used to determine a range of style and

functionality options for radio buttons. For example, it is possible to use the Actions

properties to add multiple dynamic actions to radio buttons, such as running JavaScript,

launching web links and opening files on the local computer. (JavaScript is a high-level

programming language that can be used to perform custom operations. See here for an index

of existing JavaScript operations that the PDF-XChange Editor forms can use, as well as

additional information about JavaScript). Click Select Fields to select form fields, then click the

desired field and click Properties in the Format tab to open the Radio Button Properties

pane:

Figure 5. Radio Button Tool, Radio Button Properties Pane

The options detailed below are available in the Radio Button Properties pane:

The General properties determine the general parameters of radio buttons:

· Read Only determines whether or not the radio button can be edited.

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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· Locked determines whether or not the radio buttons can be moved, and whether or

not their properties can be modified.

· Field Name determines the name of the radio button. This name is present when the

Select Fields tool is enabled, and when radio buttons are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

radio button.

· Mapping Name determines the mapping name that the radio button uses. This name

is used to reference interactive form data when the form is exported, and does so

without affecting the appearance of the name in the original document.

· Orientation determines the orientation of the radio button.

· Visibility determines the visibility of the radio button.

· Required determines whether or not the radio button is a required field. Required

fields must be filled before documents that contain them can be submitted.

· Exportable determines whether or not the radio button data can be exported from the

form.

· Layer determines the optional content layer to which the radio button belongs. When

a field belongs to an optional content layer, it displays only when the layer is enabled.

Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of radio buttons. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of radio buttons:

· Left determines the distance of the radio button from the left margin.

· Top determines the distance of the radio button from the bottom of the page.

· Width/Height determine the width/height of the radio button.

The Default Text Format properties determine the default properties when text is entered

into the radio button:

· Font Size is always set to auto for radio buttons. This is because the font size refers to

the size of the mark when radio buttons are selected, and the mark must be

proportionate to the size of the radio button.

· Text Color determines the color of the tick when radio buttons are selected.

The Options properties determine additional options for radio buttons:

· Radio Button Style determines the icon used when radio buttons are selected.

· Button Choice is a unique identifier for the radio button and differentiates it from

other radio buttons that have the same name.

· In Unison enables single-click selection for all radio buttons that share the same name

and content as the selected radio button.

· Checked by Default determines whether or not the radio button is checked by default.

The Actions properties determine the action taken when users interact with the radio button:

366
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· Mouse Down initiates an action when the left mouse button is pressed (without being

released).

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released).

· Mouse Enter initiates an action when the pointer moves into the radio button.

· Mouse Leave initiates an action when the pointer moves out of the radio button.

· On Focus initiates an action when the radio button is selected.

· On Blur initiates an action when the radio button is deselected.

· Click the ellipsis icon on the right of actions to add/edit radio button actions:

Figure 6. Radio Button Properties Pane, Action Ellipses

 The process of adding actions is detailed here.

Example Radio Button List Creation 

The following example will detail how to create a radio button list of countries:

1. Click the Form tab, then click Radio Button. 

2. Click the Format tab, then click Keep Mode:

302
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Figure 7. Format Tab, Keep Mode Highlighted

3. Press Ctrl+# to enable the grid in order to assist in the accurate placement of radio

buttons, then click to place radio buttons in the document:
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Figure 8. Adding Radio Buttons

The next step is to add text labels for the radio buttons:

4. Click the Add dropdown menu in the Home tab, then click Text and add text labels

for the desired countries:
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Figure 9. Text Boxes and Names Added
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3.3.6.4 Add List Boxes to Documents

 Add List Boxes to Documents

List boxes enable the selection of one or more options from a fixed list of options:

Figure 1. Example List Box

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for list

boxes. Click the dropdowns below for further information: 

Add List Boxes to Documents
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1. Click the Form tab, then click List Box. A blue rectangle will be displayed beneath the

pointer. This rectangle represents the list box:

Figure 2. Active List Box Tool

2. Move the rectangle to the desired location and then click to add the list box to the

document. Added list boxes appear as detailed below:
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Figure 3. Added List Boxes

· Click and drag the yellow control points to resize list boxes.

· Use the options in the Format Tab to determine the style and appearance of selected

list boxes:
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Figure 4. Format Tab, List Boxes

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple list boxes consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single list box.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· The Calculation Order setting is not available for list boxes.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the list box.

· Click Stroke Color to determine the border color of list boxes.

· Click Width to determine the width of list box borders.

· Click Border to determine the style of list box borders.

· Use the Font and Font Size dropdown menus to determine the font and font

size used for list box items.
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· Use the Text Color dropdown menu to determine the color of the font used in

list box items.

· Click Properties to open the List Box Properties pane, which enables the

customization of additional elements of list boxes and is detailed in the section

below.

The List Box Properties Pane

The List Box Properties pane can be used to determine a range of style and functionality

options for list boxes. For example, it is possible to use the Actions properties to add multiple

dynamic actions to list boxes, such as running JavaScript, launching web links and opening files

on the local computer. (JavaScript is a high-level programming language that can be used to

perform custom operations. See here for an index of existing JavaScript operations that the

PDF-XChange Editor forms can use, as well as additional information about JavaScript). Click

Select Fields to select form fields, then click the desired field and click Properties in the

Format tab to open the List Box Properties pane:

Figure 5. List Box Tool, List Box Properties Pane

The options detailed below are available in the List Box Properties pane:

The General properties determine the general parameters of list boxes:

· Read Only determines whether or not the list box can be edited.

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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· Locked determines whether or not the list box can be moved, and whether or not its

properties can be modified.

· Field Name determines the name of the list box. This name is present when the Edit

Form tool is selected, and when list boxes are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the list

box.

· Mapping Name determines the mapping name that the list box uses. This name is

used to reference interactive form data when the form is exported, and does so

without affecting the appearance of the name in the original document.

· Orientation determines the orientation of the list box.

· Visibility determines the visibility of the list box.

· Required determines whether or not the list box is a required field. Required fields

must be filled before documents that contain them can be submitted.

· Exportable determines whether or not the list box data can be exported from the

form.

· Layer determines the optional content layer to which the list box belongs. When a

field belongs to an optional content layer, it displays only when the layer is enabled.

Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of list boxes. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of list boxes:

· Left determines the distance of the list box from the left margin.

· Top determines the distance of the list box from the bottom of the page.

· Width/Height determine the width/height of the list box.

The Default Text Format properties determine the default properties when text is entered

into the list box:

· Font determines the font used to create the list box entries.

· Font Size determine the size of the font used to create the list box entries.

· Text Color determines the color of the font used to create the list box entries.

The Options properties determine additional options for list boxes:

· List Box Items determine the options in the list box. See below for an example on

how to add/edit options in the list box.

· Sort Items arranges the listed items numerically and/or alphabetically. Note that

numerical sorts are performed before alphabetical sorts in cases where both sorts

apply. 

· Multiple Selection enables the selection of multiple list box entries.

· Immediately Commit saves selected values as soon as they are selected. If this option

is not enabled then the value is saved only when the user tabs out of the current

366
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field/clicks a different form field. Please note that this option is not available when the

Multiple Selection property is enabled.

The Actions properties determine the action taken when users interact with the list box:

· Mouse Down initiates an action when the left mouse button is pressed (without being

released).

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released).

· Mouse Enter initiates an action when the pointer moves into the list box.

· Mouse Leave initiates an action when the pointer moves out of the list box.

· On Focus initiates an action when the list box is selected.

· On Blur initiates an action when the list box is deselected.

· The Selection Change property initiates a JavaScript action when the selection in the

list box is changed. Click the ellipsis icon to add custom JavaScript. The Edit Action:

"Run a JavaScript" dialog box will open. Enter the desired JavaScript for the action

and then click OK:

Figure 6. Edit Action: "Run a JavaScript" Dialog Box

Click the ellipsis icon on the right of actions to add/edit list box actions:
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Figure 7. List Box Properties Pane, Action Ellipses

The process of adding actions is detailed here.

Adding and Editing List Box Items

Follow the steps below to add/edit list box items:

1. Click Select Fields in the Form tab and select the list box, then click the Format tab

and click Properties:

302
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Figure 8. Selected List Box

The List Box Properties pane will open.

2. Scroll down to the List Box Items property and click <Empty>:
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Figure 9. List Box Properties Pane, List Box Items Property

The List Box pane will open. This pane is used to add/edit list box items.

3. Click Add New to add new entries to the list box:
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Figure 10. List Box Pane

· Click Delete Item to delete the selected item from the list box.

· Click the Up and Down buttons to move selected items up or down in the list.

The order of items in the pane represents the order to items in the list box.

· Enter values in the Export Value column to determine the value given for

exported list box items. Note that values must be first selected in the List Box

Items pane and then clicked in order to edit the name.

· Click to select Display Value names, and then click them again in order to edit

the name.

· Select the check box of the item to be used as the default selection in the list

box. This item will be selected when the list box is in its default state.

· Click and drag the yellow control points to resize the list box as desired.

4. Click outside the List Box Items pane to complete the process, then use the Hand

Tool to select list box items:
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Figure 11. Completed List Box
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3.3.6.5 Add Dropdown Menus to Documents

 Add Dropdown Menus to Documents

Dropdown menus enable the selection of one option from a fixed list of options:

Figure 1. Example Dropdown Menu

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for

dropdown menus. Click the dropdowns below for further information:

Add Dropdown Menus to Documents
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1. Click the Form tab, then click the Dropdown icon (highlighted in the image below). A

blue rectangle will be displayed at the location of the pointer. This rectangle represents

the dropdown menu:

Figure 2. Active Dropdown Menu Tool

2. Move the rectangle to the desired location and then click to add the dropdown menu

to the document. Added dropdown menus appear as detailed below:
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Figure 3. Added Dropdown Menus

· Click and drag the yellow control points to resize dropdown menus.

· Use the options in the Format Tab to determine the style and appearance of selected

dropdown menus:
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Figure 4. Format Tab, Dropdown Menus

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple dropdown menus consecutively. If this

option is disabled then PDF-XChange Editor will revert to the designated

default tool after the creation of a single dropdown menu.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· The Calculation Order setting is not available for dropdown menus.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the dropdown menu.

· Click Stroke Color to determine the border color of dropdown menus.

· Click Width to determine the width of dropdown menu borders.

· Click Border to determine the style of dropdown menu borders.

· Use the Font and Font Size dropdown menus to determine the font and font

size used for dropdown menu items.
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· Use the Text Color dropdown menu to determine the color of the font used in

dropdown menu items.

· Click Properties to open the Dropdown Properties pane, which enables the

customization of additional elements of dropdown menus and is detailed in the

section below.

The Dropdown Properties Pane

The Dropdown Properties pane can be used to determine a range of style and functionality

options for dropdown menus. For example, it is possible to use the Actions properties to add

multiple dynamic actions to dropdown menus, such as running JavaScript, launching web links

and opening files on the local computer. (JavaScript is a high-level programming language

that can be used to perform custom operations. See here for an index of existing JavaScript

operations that the PDF-XChange Editor forms can use, as well as additional information

about JavaScript). Click Select Fields to select form fields, then click the desired field and click

Properties in the Format tab to open the Dropdown Properties pane:

Figure 5. Dropdown Menu Tool, Dropdown Properties Pane

The options detailed below are available in the Dropdown Properties pane:

The General properties determine the general parameters of dropdown menus:

· Read Only determines whether or not the dropdown menu can be edited.

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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· Locked determines whether or not the dropdown menu can be moved, and whether or

not its properties can be modified.

· Field Name determines the name of the dropdown menu. This name is present when

the Edit Form tool is selected, and when dropdown menus are listed in the Fields

pane.

· Tooltip determines the information displayed when the pointer is hovered over the

dropdown menu.

· Mapping Name determines the mapping name that the dropdown menu uses. This

name is used to reference interactive form data when the form is exported, and does

so without affecting the appearance of the name in the original document.

· Orientation determines the orientation of the dropdown menu.

· Visibility determines the visibility of the dropdown menu.

· Required determines whether or not the dropdown menu is a required field. Required

fields must be filled before documents that contain them can be submitted.

· Exportable determines whether or not the dropdown menu data can be exported

from the form.

· Layer determines the optional content layer to which the dropdown menu belongs.

When a field belongs to an optional content layer, it displays only when the layer is

enabled. Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of dropdown menus. They are detailed

beneath (figure 4).

The Position properties determine the position and dimensions of dropdown menus:

· Left determines the distance of the dropdown menu from the left margin.

· Top determines the distance of the dropdown menu from the bottom of the page.

· Width/Height determine the width/height of the dropdown menu.

The Default Text Format properties determine the default properties when text is entered

into the dropdown menu:

· Font determines the font used to create the dropdown menu entries.

· Font Size determine the size of the font used to create the dropdown menu entries.

· Text Color determines the color of the font used to create the dropdown menu

entries.

The Options properties determine additional options for dropdown menus:

· Combo Box Items determine the options in the dropdown menu. See below for an

example on how to add/edit options in the dropdown menu.

· Sort Items arranges the listed items numerically and/or alphabetically. Note that

numerical sorts are performed before alphabetical sorts in cases where both sorts

apply.

· Allow Edit enables a text box at the top of dropdown menus that can be used to enter

custom values as the value of the dropdown menu:
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Figure 6. Standard Dropdown (left) and Allow Edit Dropdown (right)

Please note that this property can also be used to give dropdown menus a title that is different

from the entries that it contains. An example of this process is detailed below.

· Check Spelling is available only when the Allow Edit property is enabled, and auto-

checks the spelling of custom values entered into dropdown menus.

· Immediately Commit saves selected values as soon as they are selected. If this option

is not enabled then the value is saved only when the user tabs out of the current

field/clicks a different form field.

The Actions properties determine the action taken when users interact with the dropdown

menu:

· Mouse Down initiates an action when the left mouse button is pressed (without being

released).

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released).

· Mouse Enter initiates an action when the pointer moves into the dropdown menu.

· Mouse Leave initiates an action when the pointer moves out of the dropdown menu.

· On Focus initiates an action when the dropdown menu is selected.

· On Blur initiates an action when the dropdown menu is deselected.

· Click the ellipsis icon on the right of actions to add/edit dropdown menu actions:
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Figure 7. Dropdown Properties Pane, Action Ellipses

The process of adding actions is detailed here.

The Format Value properties determine the type of information permitted to be entered in

the dropdown menu and the format in which it should be entered. This setting applies to both

predefined items in the dropdown list, and custom entries entered when the Allow Edit

property is enabled:

· Category determines the category of the dropdown menu. Each category has different

options, as detailed below:

· None is the default setting. Dropdown menu do not have a Format Value

category when this option is selected.

· Number sets the dropdown menu input to numerical values. The following

options are available for this setting:

· Decimal Places determines the number of decimal places displayed.

· Separator Style determines the separators used for numbers.

· Currency Symbol determines the currency symbol used in the dropdown

menu.

· Symbol Location determines the location of the currency symbol in

relation to the number.

· Add Space inserts a space between the currency symbol and the number.
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· Negative Number Style determines how numbers with negative values

are displayed.

· Percentage sets the dropdown menu input to percentage values. The following

options are available for this setting:

· Decimal Places determines the number of decimal places permitted.

· Separator Style determines the separator used for numbers.

· Date sets the dropdown menu input to date values and adds a dropdown

calendar to the dropdown menu. Use the Date Format parameter to determine

the format of dates.

· Time sets the dropdown menu input to time values (hours and minutes). Use the

Time Format parameters to determine the format of time values.

· Special sets the dropdown menu input values to one of the special options. Use

the Special Format parameter to determine the format. The options are:

· ZIP Code

· ZIP Code +4, which is used for nine-digit postal codes.

· Phone Number

· Social Security Number

· Custom Action adds custom JavaScript actions to dropdown menu. There are

two options:

· Format Action is used to enable custom JavaScript for formats. Click the

ellipsis icon to add/view JavaScript.

· Keystroke Action is used to enable custom JavaScript for keystrokes. Click

the ellipsis icon to add/view JavaScript.

· If the options above are used then the Edit Action: "Run a JavaScript"

dialog box will open. Enter the desired JavaScript for the action and then

click OK:
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Figure 8. Edit Action: "Run a JavaScript" Dialog Box

The Value Validation properties determine the validation of values entered into the

dropdown menu:

· Validation determines how values are validated:

· Value in Range sets the range within which values entered into the dropdown

menu must fall:

· From specifies the minimum value.

· To specifies the maximum value.

· Custom enables the use of custom JavaScript in order to validate values entered

in the dropdown menu. Click the ellipsis icon to add/view custom JavaScript, as

detailed in (figure 8).

The Value Calculation properties determine the value of dropdown menu from other

dropdown menus:

· None specifies that calculations are not performed.

· Sum uses the sum of specified fields.

· Product uses the product of specified fields.

· Average uses the average of specified fields.

· Minimum uses the minimum value of all the specified fields.

· Maximum uses the maximum value of all specified fields.
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· Please note that when the Sum, Product, Average, Minimum and Maximum

properties are used, the additional entry "Fields"will appear beneath the Calculation

property. Use this entry to specify the fields used in these calculations.

· Simplified Notation enables the insertion of a custom calculation to be performed on

fields. Use the Simple Notation box to determine the calculation. Use the document

field names and standard mathematical notation (+, -, *, /) to specify the calculation. If

there are spaces in form field names then they must be entered in quotation marks. For

example: Field1 + Field 2 / "Division Field" * 64.

· Custom Action enables the use of custom JavaScript in order to perform calculations

and determine the order in which calculations are performed. Click the ellipsis icon to

add custom JavaScript, as detailed in (figure 8).

Adding and Editing Dropdown Menu Items

Follow the steps below to add/edit dropdown menu items:

1. Click Select Fields in the Form tab and select the dropdown menu, then click the

Format tab and click Properties. The Dropdown Properties pane will open:

Figure 9. Selected Dropdown Menu

2. Move to the Combo Box Items property and click <Empty>:
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Figure 10. Dropdown Properties Pane, Combo Box Items

The Dropdown Menu Items pane will open. This pane is used to add/edit dropdown menu

items:



748

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 11. Dropdown Menu Items Pane

3. Click Add New to add new entries to the dropdown menu:
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Figure 12. Dropdown Menu Items Pane

· Click Delete Item to delete the selected item from the dropdown menu.

· Click the Up and Down buttons to move selected items up or down in the list.

The order of items in the pane represents the order to items in the dropdown

menu.

· Enter values in the Export Value column to determine the value given for

exported dropdown menu items. Note that values must be first selected in the

Dropdown Menu Items pane and then clicked in order to edit the name.

· Click to select Display Value names, and then click them again in order to edit

the name.

· Select the check box of the item to be used as the default selection in the

dropdown menu. This item will be selected when the dropdown menu is in its

default state.

· Click and drag the yellow control points to resize the dropdown menu as

desired.

4. Click outside the Dropdown Menu Items pane to complete the process, then enable

the Hand Tool to select dropdown menu items:
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Figure 13. Completed Dropdown Menu

Value Validation Example

The following example details a simple value validation of values entered into the dropdown

'Dropdown1':
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Figure 14. Value Validation Example, Dropdown Menu

This example will detail how to validate that values entered into 'Dropdown1' fall in the range

0-100:

1. Click the Form Tab, then click Select Fields and select the dropdown menu. 

2. Click the Format tab, then click Properties. The Dropdown Properties pane will

open:
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Figure 15. Value Validation Example, Dropdown Properties Pane

3. Scroll down the Dropdown Properties pane to the Format Value tab, then click the

Category property and select Number:
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Figure 16. Value Validation Example, Category Property Options

4. Scroll down the Dropdown Properties pane to the Value Validation tab, then click

the Validation option and select Value in Range:
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Figure 17. Value Validation Example, Validation Property Options

Note that the From and To options will appear beneath the Validation property when Value

in Range is selected.

5. Enter '0' in the From option and '100' in the To option:
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Figure 18. Value Validation Example, From/To Option

All values subsequently entered into 'Dropdown1' must fall into the range 0-100. Values

outside of the specified range will not be permitted, and if they are entered then an error

message will appear.

Edit the Display Name of Dropdown Menus

The default settings of dropdown menus use a list item as the display name. The process

below details how to create a different display name for dropdown menus:

A default dropdown menu is detailed below and the display name is 'Item 1':
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Figure 19. Default Dropdown Menu

1. Click the Form Tab, then click Select Fields and select the dropdown menu. 

2. Click the Format tab, then click Properties. The Dropdown Properties pane will

open:
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Figure 20. Dropdown Menu Tool, Dropdown Properties Pane

3. Scroll down the Dropdown Properties pane to the Allow Edit property and change

the setting to Yes:
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Figure 21. Dropdown Menu Tool, Allow Edit Property

4. Click the Home tab and select the Hand Tool, then click the dropdown menu and

enter the desired display name. This example will use 'Select...':
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Figure 22. New Dropdown Menu Display Name

5. Click the Form tab and click Select Fields, then select the dropdown menu and click

Properties in the Format tab. The Dropdown Properties pane will open:
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Figure 23. Dropdown Menu Tool, Dropdown Properties Pane

6. Scroll down the Dropdown Properties pane to the Allow Edit property and change

the setting to No:
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Figure 24. Dropdown Properties Pane,, Allow Edit Property

The dropdown menu will display as detailed below:
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Figure 25. Dropdown Menu, New Display Name
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3.3.6.6 Add Buttons to Documents

 Add Buttons to Documents

Buttons enable the triggering of predefined events:

Figure 1. Example Buttons

The functionality of PDF-XChange Editor enables a wide range of customization for buttons. Click the

dropdowns below for further information:

Add Buttons to Documents
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1. Click the Form tab, then click Button. A blue rectangle will be displayed at the

location of the pointer. This rectangle represents the button:

Figure 2. Active Button Tool

2. Move the rectangle to the desired location and then click to add the button to the

document. Added buttons appear as detailed below:
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Figure 3. Added Buttons

· Click and drag the yellow control points to resize buttons.

· Use the options in the Format Tab to determine the style and appearance of selected

buttons:
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Figure 4. Format Tab, Buttons

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple buttons consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single button.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· The Calculation Order setting is not available for buttons.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the button.

· Click Stroke Color to determine the border color of buttons.

· Click Width to determine the width of button borders.

· Click Border to determine the style of button borders.

· Use the Font and Font Size dropdown menus to determine the font and font

size used for button labels.
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· Use the Text Color button to determine the color of the font used in button

labels.

· Click Properties to open the Push Button Properties pane, which enables the

customization of additional elements of buttons and is detailed in the section

below.

The Push Button Properties Pane

The Push Button Properties pane can be used to determine a range of style and functionality

options for buttons. For example, it is possible to use the Actions properties to add multiple

dynamic actions to buttons, such as running JavaScript, launching web links and opening files

on the local computer. (JavaScript is a high-level programming language that can be used to

perform custom operations. See here for an index of existing JavaScript operations that the

PDF-XChange Editor forms can use, as well as additional information about JavaScript). Click

Select Fields to select form fields, then click the desired field and click Properties in the

Format tab to open the Push Button Properties pane:

Figure 5. Button Tool, Push Button Properties Pane

The options detailed below are available in the Push Button Properties pane:

The General properties determine the general parameters of buttons:

· Read Only determines whether or not the button can be edited.

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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· Locked determines whether or not buttons can be moved, and whether or not their

properties can be modified.

· Field Name determines the name of the button. This name is present when the Edit

Form tool is selected, and when buttons are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

button.

· Mapping Name determines the mapping name that the button uses. This name is used

to reference interactive form data when the form is exported, and does so without

affecting the appearance of the name in the original document.

· Orientation determines the orientation of the button.

· Visibility determines the visibility of the button.

· Layer determines the optional content layer to which the button belongs. When a field

belongs to an optional content layer, it displays only when the layer is enabled. Use the

Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of buttons. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of buttons:

· Left determines the distance of the button from the left margin.

· Top determines the distance of the button from the bottom of the page.

· Width/Height determine the width/height of the button.

The Default Text Format properties determine the default properties when text is entered

into the button:

· Font Size is always set to auto for buttons. This is because the font size refers to the

size of the mark when buttons are selected, and the mark must be proportionate to the

size of the button.

· Text Color determines the color of the tick when buttons are selected.

The Options properties determine additional options for buttons:

· Layout determines the layout of the button, which can be displayed as text label, icon

or a combination of both elements:

· Label Only is the default setting. The text label that the Up Label property

specifies is the only element displayed on the button. The Up Label property

becomes available in the Options properties when the Label Only setting is

enabled.

· Icon Only uses the custom image that the Up Icon property specifies to

represent the button. The Up Label property becomes available in the Options

properties when Icon Only setting is enabled.

· Icon Top, Label Bottom displays a custom image as the upper section of the

button and the text label beneath the image.
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· Label Top, Icon Bottom displays the text label as the upper section of the

button and a custom image beneath the text.

· Icon Left, Label Right displays a custom image on the left and the text label on

the right.

· Label Left, Icon Right displays the text label on the left and a custom image on

the right.

· Label over Icon uses a custom image to represent the button and places the text

label over the image.

   

  
Figure 6. Available Layout Options for Buttons

· Behaviour specifies the visual effect when buttons are pressed:

· None specifies that no visual change occurs.

· Invert inverts the fill color of the button.

· Outline creates an outline around the button.

· Push creates a visual effect when buttons are clicked:

Figure 7. Default to Invert (Top), Default to Outline (Centre) and Default to Push (Bottom) 

· Up Label specifies the text that the button uses. N.b. A Layout property that specifies a

label must be enabled for the option to be available.

· Up Icon specifies the icon that the button uses. N.b. A Layout property that specifies

an icon must be enabled for the option to be available.

The Icon Placement properties determine settings for the icon used in the button:
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· When to Scale determines when icons are scaled to the size of the button on which

they are featured:

· Always scales the icon to the size of the button in all cases.

· Scale Type determines how the icon is scaled:

· Proportionally retains the aspect ratio of the icon

· Non-proportionally ignores the aspect ratio of the icon.

· Never retains the original size of the icon regardless of the size of the button. 

· Icon is Too Big scales icons in cases where icons are larger than the button.

· Icon is Too Small scales icons in cases where icons are smaller than the button.

· Fit to Bounds fits the icon to the bounds of the button.

· Horizontal Position determines the horizontal position of the icon in the button.

· Vertical Position determines the vertical position of the icon in the button.

The Actions properties determine the action taken when users interact with the button:

· Mouse Down initiates an action when the left mouse button is pressed (without being

released).

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released).

· Mouse Enter initiates an action when the pointer moves into the button.

· Mouse Leave initiates an action when the pointer moves out of the button.

· On Focus initiates an action when the button is selected.

· On Blur initiates an action when the button is deselected.

· Click the ellipsis icon on the right of actions to add/edit button actions:
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Figure 8. Push Button Properties Pane, Action Ellipses

 The process of adding actions is detailed here.

Button Creation Example

The following example will detail the creation of a button that contains an icon and text, and

activates a link to the PDF-XChange website when it is clicked:

1. Click the Form tab, then click Button. The blue rectangle that represents the button

will be displayed beneath the pointer:
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Figure 9. Active Button Tool

2. Click to add the button, then click the Format tab and click Properties. The Push

Button Properties pane will open:
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Figure 10. Active Button Tool, Push Button Properties Pane

3. Scroll down the Push Button Properties pane to the Font Size property and change

the font size to 8 pt, then scroll down to the Up Label property and then enter the text

"Launch Website":
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Figure 11. Active Button Tool, Up Label Property Highlighted

The next step is to add an icon to the button:

4. Click Select Fields, then select the button and click Properties. The Push Button

Properties pane will open. Scroll down to the Options tab, then select Icon top, label

button for the Layout property. The Up Icon property will appear. Click the ellipsis icon

on the right of the Up Icon property, then select the desired icon from the local

computer:
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Figure 12. Push Button Properties Pane, Options Properties 

The next step is to add the action to the button:

5. Click Select Fields, then select the button and click Properties. The Push Button

Properties pane will open. Scroll down to the Actions tab, then click the ellipsis icon on

the right of the Mouse Up property:
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Figure 13. Push Button Properties Pane, Mouse Up Property

The Edit Action List dialog box will open.

6. Click Add and then click Open a Web Link in the submenu:
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Figure 14. Button Tool, Edit Action List Dialog Box

The Add Action: "Open a Web Link" dialog box will open.

7. Enter the desired web location for the button to launch when it is clicked and then

click OK in both dialog boxes:
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Figure 15. Button Tool, Add Action: "Open a Web Link" Dialog Box

The button is then complete and will launch the PDF-XChange website when it is clicked:
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Figure 16. Completed Button
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3.3.6.7 Add Digital Signature Fields to Documents

 Add Digital Signature Fields to Documents

Digital signatures are used to demonstrate the authenticity of documents and increase their security.

They can also be used to determine editing permissions for documents and/or utilize timestamp

servers in order to further increase document security and integrity:

Figure 1. Example Signature Fields, Unsigned (above) and Signed (below)

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for signature

fields. Click the dropdowns below for further information:
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Add Digital Signature Fields to Documents

1. Click the Form tab, then click Digital Signature. A blue rectangle will be displayed at

the location of the pointer. This rectangle represents the signature field:

Figure 2. Active Signature Field Tool

2. Move the rectangle to the desired location and then click to add the signature field to

the document. Added signature fields appear as below:
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Figure 3. Added Signature Fields

· Click and drag the yellow control points to resize signature fields.

· Use the options in the Format Tab to determine the style and appearance of selected

signature fields:
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Figure 4. Format Tab, Signature Fields

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple signature fields consecutively. If this option

is disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single signature field.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· The Calculation Order setting is not available for signature fields.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the signature field.

· Click Stroke Color to determine the border color of signature fields.

· Click Width to determine the width of signature field borders.

· Click Border to determine the style of signature field borders.

· Use the Font and Font Size dropdown menus to determine the font and font

size used when signature fields are signed.
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· Use the Text Color signature field to determine the color of the font used when

signature fields are signed.

· Click Properties to open the Digital Signature Properties pane, which enables

the customization of additional elements of signature fields and is detailed in

the section below.

The Digital Signature Properties Pane

The Digital Signature Properties pane can be used to determine a range of style and

functionality options for signature fields. For example, it is possible to use the Actions

properties to add multiple dynamic actions to signature fields, such as running JavaScript,

launching web links and opening files on the local computer. (JavaScript is a high-level

programming language that can be used to perform custom operations. See here for an index

of existing JavaScript operations that the PDF-XChange Editor forms can use, as well as

additional information about JavaScript). Click Select Fields to select form fields, then click the

desired field and click Properties in the Format tab to open the Digital Signature Properties

pane:

Figure 5. Signature Field Tool, Digital Signature Properties Pane

The options detailed below are available in the Digital Signature Properties pane:

The General properties determine the general parameters of signature fields:

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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· Read Only determines whether or not the signature field can be edited.

· Locked determines whether or not signature fields can be moved, and whether or not

their properties can be modified.

· Field Name determines the name of the signature field. This name is present when the

Edit Form tool is selected, and when signature fields are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

signature field.

· Mapping Name determines the mapping name that the signature field uses. This

name is used to reference interactive form data when the form is exported, and does

so without affecting the appearance of the name in the original document.

· Orientation determines the orientation of the signature field.

· Visibility determines the visibility of the signature field.

· Required determines whether or not the digital signature field is a required field.

Required fields must be filled before documents that contain them can be submitted.

· Exportable determines whether or not the digital signature field data can be exported

from the form.

· Layer determines the optional content layer to which the digital signature field

belongs. When a field belongs to an optional content layer, it displays only when the

layer is enabled. Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of signature fields. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of signature fields:

· Left determines the distance of the signature field from the left margin.

· Top determines the distance of the signature field from the bottom of the page.

· Width/Height determine the width/height of the signature field.

The Default Text Format properties determine the default properties when text is entered

into the signature field:

· Font determines the font used for digital signature fields. 

· Font Size determines the size of the font.

· Text Color determines the color of the text.

The Actions properties determine the action taken when users interact with the signature field:

· Mouse Down initiates an action when the left mouse button is pressed (without being

released).

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released).

· Mouse Enter initiates an action when the pointer moves into the signature field.

· Mouse Leave initiates an action when the pointer moves out of the signature field.

· On Focus initiates an action when the signature field is selected.

· On Blur initiates an action when the signature field is deselected.

366
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· Click the ellipsis icon on the right of actions to add/edit signature field actions:

Figure 6. Digital Signature Properties Pane, Action Ellipses

The process of adding actions is detailed here.

The When Signed property determines the action taken when signature fields are signed:

· Do Nothing determines that no action is taken.

· Custom Action enables the activation of custom JavaScript when signature fields are

signed. When this option is selected the Action property will appear. Click the ellipsis

icon on the right of the property to add JavaScript:

302
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Figure 7. Digital Signature Properties Pane, Action Property

The Edit Action: "Run a JavaScript" dialog box will open. Enter the desired JavaScript for the

action and then click OK:
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Figure 8. Edit Action: "Run a JavaScript" Dialog Box

· Mark as Read-Only sets specified fields as read-only in order to disable subsequent

editing. When this option is selected, the Fields Range property will appear beneath

the When Signed property:
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Figure 9. Mark as Read-Only Options

· Select All fields to set all fields in the document as read-only.

· Select Only specified Fields to specify the fields that are set as read-only.

· Select All fields except specified to specify the fields that are not set as read-only.

The Fields property will become available when an option to specify fields is selected. Click

the ellipsis icon on the right of the property to specify fields. The Field Selection dialog box

detailed in (figure 9) will open. Select the desired fields and then click OK.

Signature Field Creation Example

The following example will detail the creation of a signature field that displays a tooltip when

the pointer is hovered over it, and creates a bookmark for the current page when it is clicked:

1. Click the Form tab, then click Digital Signature. The blue rectangle that represents the

signature field will be displayed beneath the pointer:
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Figure 10. Active Signature Field Tool

2. Click to add the signature field, then click the Format tab and click Properties. The

Digital Signature Properties pane will open:
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Figure 11. Active Signature Field Tool, Digital Signature Properties Pane

3. Click the Tooltip property and enter the desired text for the tooltip:
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Figure 12. Digital Signature Properties Pane, Tooltip Property

4. Scroll down the Digital Signature Properties pane to the Actions properties and click

the ellipsis icon on the right of the Mouse Up property:
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Figure 13. Digital Signature Properties Pane, Mouse Up Property

The Edit Action List dialog box will open.

5. Click Add in the Edit Action List dialog box and then click Execute a Command in

the dropdown menu:
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Figure 14. Edit Action Dialog Box, Execute a Command

The Add Action: "Execute a Command" dialog box will open.

6. Click the dropdown menu, then scroll down to and click the NewBookmark

command:
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Figure 15. New Bookmark Command

7. Click OK in the Add Action: "Execute a Command" and Edit Action List dialog

boxes.

The signature field is then complete. The tooltip entered at step three will be present when the

pointer is hovered over the signature field:
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Figure 16. Active Tooltip

A new bookmark is created for the current page when the signature field is clicked:
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Figure 17. New Bookmark Created
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3.3.6.8 Add Barcodes to Documents

 Add Barcodes to Documents

Barcodes enable the encoding of form data and display it as a visual pattern that can be decoded by

compatible software/hardware:

Figure 1. Example Barcodes. PDF417 Barcode (Left), QR Code Barcode (Center), Data Matrix Barcode (Right)

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for

barcodes. Click the dropdowns below for further information:

Add Barcodes to Documents
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1. Click the Form tab, then click Barcode. A blue rectangle will be displayed at the

location of the pointer. This rectangle represents the barcode:

Figure 2. Active Barcode Tool

2. Move the rectangle to the desired location and then click to add the barcode to the

document. Added barcodes appear as below:
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Figure 3. Added Barcodes

· Click and drag the yellow control points to resize barcodes.

· Use the options in the Format Tab to determine the style and appearance of selected

barcodes:
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Figure 4. Format Tab, Barcodes

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple barcodes consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single barcode.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· The Calculation Order setting is not available for barcodes.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· The Fill Color option is not available for barcodes.

· Click Stroke Color to determine the border color of barcodes.

· The Width, Border and Font options are not available for barcodes.

· Click Properties to open the Barcode Field Properties pane, which enables the

customization of additional elements of barcodes and is detailed in the section

below.
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The Barcode Field Properties Pane

The Barcode Field Properties pane can be used to determine a range of style and

functionality options for barcodes. For example, it is possible to use the Actions properties to

add multiple dynamic actions to barcodes, such as running JavaScript, launching web links and

opening files on the local computer. (JavaScript is a high-level programming language that

can be used to perform custom operations. See here for an index of existing JavaScript

operations that the PDF-XChange Editor forms can use, as well as additional information

about JavaScript). Click Select Fields to select form fields, then click the desired field and click

Properties in the Format tab to open the Barcode Field Properties pane:

Figure 5. Barcode Tool, Barcode Field Properties Pane

The options detailed below are available in the Barcode Field Properties pane:

The General properties determine the general parameters of barcodes:

· Read Only determines whether or not the barcode can be edited.

· Locked determines whether or not the barcode can be moved, and whether or not its

properties can be modified.

· Field Name determines the name of the barcode. This name is present when the Edit

Form tool is selected, and when barcodes are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

barcode.

366
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· Mapping Name determines the mapping name that the barcode uses. This name is

used to reference interactive form data when the form is exported, and does so

without affecting the appearance of the name in the original document.

· Layer determines the optional content layer to which the barcode belongs. When a

field belongs to an optional content layer, it displays only when the layer is enabled.

Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of barcodes. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of barcodes:

· Left determines the distance of the barcode from the left margin.

· Top determines the distance of the barcode from the bottom of the page.

· Width/Height determine the width/height of the form field that contains the barcode.

(The X Dimension property, detailed below, determines the size of the barcode itself).

The Default Text Format properties determine the default properties when text is entered

into the barcode:

· Font Size is always set to auto for barcodes. This is because the font size refers to the

size of the tick when barcodes are selected, and the tick must be proportionate to the

size of the barcode.

· Text Color determines the color of the tick when barcodes are selected.

The Options properties determine additional options for barcodes:

· Symbology determines the format of the barcode, as detailed in (figure 1):

· PDF417 is a stacked linear barcode used primarily in transport, identification

cards and inventory management.

· QR Code is a matrix barcode that features advanced storage capacity in

comparison to older barcodes, and is one of the most common barcodes used

worldwide.

· Data Matrix is similar to a QR Code barcode. Data Matrices hold less

information that QR Codes, but they are more secure.

Additional barcode options are available, depending on the selected barcode format:

· Compress Data converts the content of barcodes into a .zip archive when it is

enabled. Please note that this is not recommended for mobile scanners, as they

are usually incompatible with .zip files.

· X Dimension determines the size of the barcode.

· ECC Level (Error Correction Capability) determines the level of compensation

when barcodes are damaged, for example when printing imperfections occur. A

higher ECC level results in a higher degree of data retention in the event of

damage, but also requires more space. Please note that this property is not

available for the Data Matrix barcode format.

374
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· Y/X Ratio sets the ratio of the barcode axes when the PDF417 barcode format

is used.

The Actions properties, although displayed in the Barcode Field Properties pane, are not

compatible with barcodes and should be ignored.

The Value Calculation properties determine the physical appearance of the barcode:

· Calculation Type determines the type of calculation used to create the barcode:

· Custom Script enables the use of custom JavaScript in order to create the

barcode:

· Calculation Script is used to enter custom JavaScript. Click the ellipsis icon

to add JavaScript. The Edit Action: "Run a JavaScript" dialog box will

open. Enter the desired JavaScript for the action and then click OK:

Figure 6. Edit Action: "Run a JavaScript" Dialog Box

· Reference is an optional property that has several uses, such as to

reference the URL of the published form or other relevant information.

Values entered in this property will appear beneath the barcode.

· Encode Using Tab Delimited Format encodes fields into the barcode as tab-

delimited values. Please note that if the form is configured to output the data in

individual XFDF or XDP files, then this format must be used. Additionally, this
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format enables the inclusion of the most data and is the best choice in cases

where the form data will be copied into a database/spreadsheet.

· Fields is used to determine the fields that create the content of the

barcode. This property becomes available when the Encode Using Tab

Delimited Format option is selected, as detailed in (figure 7). Click the

ellipsis icon (three dots) to open the Field Selection dialog box, then

select the fields to include for the barcode and click OK:

Figure 7. Encode Using Tab Delimited Format, Fields Property Highlighted and Field Selection Dialog Box

· Include Field Name determines whether or not the field name is included

in the data of the barcode. Please note that if the form is configured to

output the data in individual XFDF or XDP files then the data must be in a

tab-delimited format and the field names must be in the first line.

· Reference is an optional property that has several uses, such as to

reference the URL of the published form or other relevant information.

Values entered in this property will appear beneath the barcode.

· Encode Using XML Format encodes fields into the barcode in standard XFDF

format.

· Fields is used to determine the fields that create the content of the

barcode. This property becomes available when the Encode Using XML

Format option is selected, as detailed in (figure 8). Click the ellipsis icon
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to open the Field Selection dialog box, then select the fields to include for

the barcode and click OK:

Figure 8. Encode Using XML Format, Fields Property Highlighted and Field Selection Dialog Box

· Reference is an optional property that has several uses, such as to

reference the URL of the published form or other relevant information.

Values entered for this property will appear beneath the barcode.

Barcode Creation Example

The following example will detail the creation of a barcode that represents numerical form

data entered elsewhere in the same form:

1. Click the Form tab, then click Barcode. The blue rectangle that represents the barcode

will be displayed:
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Figure 9. Active Barcode Tool

2. Click to add the barcode, then click the Format tab and click Properties. The Barcode

Field Properties pane will open:
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Figure 10. Active Barcode Tool, Barcode Field Properties Pane

3. Scroll down the Barcode Field Properties pane to the Calculation Type property,

then select Encode Using Tab Delimited Format:
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Figure 11. Calculation Type Property, Encode Using Tab Delimited Format

The next step is to create the form fields from which the barcode will take its data:

4. Click Text Field and Keep Mode, then click to add some text fields to the document:
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Figure 12. New Text Boxes 

5. Click the Home tab, then click the Hand Tool. Select the text fields one at a time and

enter some numerical data:
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Figure 13. Active Hand Tool

6. Click the Form tab, then click Select Fields and select the barcode:
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Figure 14. Selected Barcode

7. Scroll down the Barcode Field Properties pane to the Fields property and click the

ellipsis icon (three dots). The Field Selection dialog box will open. Note that the text

fields entered at step four each feature a corresponding check box. Select the boxes of

the forms to be included in the creation of the barcode and click OK:



813

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 15. Selected Barcode and Field Selection Dialog Box

The barcode will update to represent the numerical information:
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Figure 16. Updated Barcode

If the content of the text fields used to create the barcode is updated then the barcode will

update to represent the new information.
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3.3.6.9 Add Date Fields to Documents

 Add Date Fields to Documents

 

Date fields are used to add an interactive calendar to documents in order to specify dates:

Figure 1. Example Date Fields

Please note that date fields are a modified version of the text fields detailed here.  The only

difference is that the Category property in the Format Value tab of the Properties pane is set to Date

by default for convenience of use. This means that some properties and functions available by default

for text fields are disabled by default for date fields. These can be edited using the Properties pane

detailed below. 
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The functionality of PDF-XChange Editor enables a wide range of dynamic customization for date

fields. Click the dropdowns below for further information:

Add Date Fields to Documents

1. Click the Form Tab, then click the Date icon. A blue rectangle will be displayed

beneath the pointer. This rectangle represents the date field:

Figure 2. Active Date Field Tool

2. Move the rectangle to the desired location and then click to add the date field to the

document. Added date fields appear as detailed below:
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Figure 3. Added Date Field

· Click and drag the yellow control points to resize date fields.

· Use the options in the Format Tab to determine the style and appearance of selected

date fields:
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Figure 4. Format Tab, Date Field Forms

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple date fields consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single date field.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· Click Calculation Order to show/hide the order in which calculations are

performed when there is more than one form field that contains a value

calculation. Further information about value calculations is detailed below.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the date field.

· Click Stroke Color to determine the border color of date fields.

· Click Width to determine the width of date field borders.

· Click Border to determine the style of date field borders.

· Click the options in the Text Format group to format the text of date fields.
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· Click Properties to open the Text Field Properties pane, which enables the

customization of additional elements of date fields and is detailed in the section

below.

The Text Field Properties Pane

The Text Field Properties pane can be used to determine a range of style and functionality

options for date fields. For example, it is possible to use the Actions properties to add

multiple dynamic actions to date fields, such as running JavaScript, launching web links and

opening files on the local computer. (JavaScript is a high-level programming language that

can be used to perform custom operations. See here for an index of existing JavaScript

operations that the PDF-XChange Editor forms can use, as well as additional information

about JavaScript). 

Click Select Fields to select form fields, then click the desired field and click Properties in the

Format tab to open the Text Field Properties pane:

Figure 5. Date Field Tool, Text Field Properties Pane

The options detailed below are available in the Text Field Properties pane:

The General properties determine the general parameters of date fields:

· Read Only determines whether or not the date field can be edited.

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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· Locked determines whether or not the date field can be moved, and whether or not its

properties can be modified.

· Field Name determines the name of the date field. This name is present when the

Select Fields tool is enabled, and when date fields are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

date field.

· Mapping Name determines the mapping name that the date field uses. This name is

used to reference interactive form data when the form is exported, and does so

without affecting the appearance of the name in the original document.

· Orientation determines the orientation of text entered in the date field.

· Visibility determines the visibility of the date field.

· Required determines whether or not the date field is a required field. Required fields

must be filled before documents that contain them can be submitted.

· Exportable determines whether or not the date field data can be exported from the

form.

· Layer determines the optional content layer to which the date field belongs. When a

field belongs to an optional content layer, it displays only when the layer is enabled.

Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of date fields. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of date fields:

· Left determines the distance of the date field from the left margin.

· Top determines the distance of the date field from the bottom of the page.

· Width/Height determine the width/height of the date field.

The Default Text Format properties determine the default properties when text is entered

into the date field:

· Font determines the font used. 

· Font Size determines the size of the font. 

· Text Color determines the color of the font.

The Options properties determine additional options for date fields:

· Alignment determines the text alignment within the date field.

· Default Value determines the default value of the date field. Date fields will show this

value by default. If they are edited and then reset then the value entered for this

property will be displayed.

· File Select determines whether or not files on the local computer are selected when

their filename is entered in the date field. If set to Yes then the file contents are

submitted as the value of the date field when the form is submitted.

· The Password property is not applicable to date fields.

· The Check Spelling property is not applicable to date fields.

366
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· The Multi Line property is not applicable to date fields.

· The Scroll property is not applicable to date fields.

· Allow Rich Text determines whether or not the date field permits rich text such as

bold and italics.

· The Comb property is not applicable to date fields.

· Character Limit determines the maximum number of characters permitted in the date

field.

The Actions properties determine the action taken when users interact with the date field:

· Mouse Down initiates an action when the left mouse button is pressed (without being

released) on the date field.

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released) on the date field.

· Mouse Enter initiates an action when the pointer moves into the date field.

· Mouse Leave initiates an action when the pointer moves out of the date field.

· On Focus initiates an action when the date field is selected.

· On Blur initiates an action when the date field is deselected.

· Click the ellipsis icon on the right of actions to add/edit date field actions: 

Figure 7. Date Field Properties Pane, Action Ellipses
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The process of adding actions is detailed here.

The Format Value properties determine the type of information permitted to be entered in

the date field and the format in which it should be entered. Date fields are set to Date by

default.

· Category determines the category of the field. Each category has different options, as

detailed below:

· None determines that there is no category for the field.

· Number sets the field input to numerical values. The following options are

available for this property:

· Decimal Places determines the number of decimal places displayed.

· Separator Style determines the separators used for numbers.

· Currency Symbol determines the currency symbol used in the date field.

· Symbol Location determines the location of the currency symbol in

relation to the number.

· Add Space inserts a space between the currency symbol and the number.

· Negative Number Style determines how numbers with negative values

are displayed.

· Percentage sets the field input to percentage values. The following options are

available for this property:

· Decimal Places determines the number of decimal places permitted.

· Separator Style determines the separator used for numbers.

· Date is the default setting and sets the field input to date values, then adds a

dropdown calendar to the date field. Use the Date Format parameter to

determine the format of dates.

· Time sets the field input to time values (hours and minutes). Use the Time

Format parameters to determine the format of time values.

· Special sets the field input values to one of the special options. Use the Special

Format parameter to determine the format. The options are:

· ZIP Code

· ZIP Code +4, which is used for nine-digit postal codes.

· Phone Number

· Social Security Number

· Custom Action adds custom JavaScript actions to date fields. There are two

options:

· Format Action is used to enable custom JavaScript for formats. Click the

ellipsis icon to add/view JavaScript.

· Keystroke Action is used to enable custom JavaScript for keystrokes. Click

the ellipsis icon to add/view JavaScript.

· If the options above are used then the Edit Action: "Run a JavaScript"

dialog box will open. Enter the desired JavaScript for the action and then

click OK:

302
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Figure 8. Edit Action: "Run a JavaScript" Dialog Box

The Value Validation properties determine the validation of values entered into the date field.

These properties can be used to ensure that the information entered into forms fits within

specific parameters:

· Validation determines how values are validated:

· Value in Range sets the range within which values entered into the date field

must fall:

· From specifies the minimum value.

· To specifies the maximum value.

· Custom Action enables the use of custom JavaScript in order to validate values

entered in the date field:

· Validation Action specifies the JavaScript to use, as detailed in (figure 9).

The Value Calculation properties determine the value of date fields from other date fields,

and are used in forms where entered form data creates the value of further forms, such as

when several orders are placed that combine to give a total cost. The available properties are

detailed below:

· None specifies that calculations are not performed.

· Sum uses the sum of specified fields. 

· Product uses the product of specified fields.

· Average uses the average of specified fields.

· Minimum uses the minimum value of all the specified fields.
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· Maximum uses the maximum value of all specified fields.

· Please note that when the Sum, Product, Average, Minimum and Maximum

properties are used, the additional entry "Fields" will appear beneath the Calculation

property. Use this entry to specify the fields used in these calculations.

· Simplified Notation enables the insertion of a custom calculation to be performed on

fields. Use the Simple Notation box to determine the calculation. Use the document

field names and standard mathematical notation (+, -, *, /) to specify the calculation. If

there are spaces in form field names then they must be entered in quotation marks. For

example: Field1 + Field 2 / "Division Field" * 64.

· Custom Action enables the use of custom JavaScript in order to perform calculations

and determine the order in which calculations are performed. Click the ellipsis icon to

add custom JavaScript, as detailed in (figure 9).

Examples of Value Validation and Value Calculation are available here. 691
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3.3.6.10 Add Image Fields to Documents

 Add Image Fields to Documents

 

Image fields are used to add form fields that enable the submission of images as form data:

Figure 1. Example Image Fields. Empty Field (left), Selected Empty Field (center), Image Added (right).

Please note that image fields are a modified version of the button fields detailed here.  The only

difference is that the Layout property in the Options tab of the Properties pane is set to Icon Only by

default for convenience of use. All properties can be edited using the Properties pane detailed below.

The functionality of PDF-XChange Editor enables a wide range of dynamic customization for image

fields. Click the dropdowns below for further information:

763
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Add Image Fields to Documents

1. Click the Form tab, then click Image. A blue rectangle will be displayed at the

location of the pointer. This rectangle represents the image field:

Figure 2. Active Image Field Tool

2. Move the rectangle to the desired location and then click to add the image field to

the document. Added image fields appear as detailed below:
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Figure 3. Added Image Fields

· Click and drag the yellow control points to resize image fields.

· Use the options in the Format Tab to determine the style and appearance of selected

image fields:
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Figure 4. Format Tab, Image Fields

· Click Select Fields to select and edit form fields.

· Click the options in the Form Fields group to enable alternative form field

formats.

· Click Keep Mode to create multiple image fields consecutively. If this option is

disabled then PDF-XChange Editor will revert to the designated default tool

after the creation of a single image field.

· Click Tab Numbers to show/hide the tab order numbers of form fields.

· The Calculation Order setting is not available for image fields.

· Click Grid to enable/disable the grid, which is used to assist in the accurate

placement of form fields, as detailed in (figure 4).

· Click Create Multiple Copies to create multiple copies of selected form fields, as

detailed here.

· Click Fields to show/hide the Fields  pane, which is used to view/edit form

fields.

· Click Fill Color to determine the fill color of the image field.

· Click Stroke Color to determine the border color of image fields.

· Click Width to determine the width of image field borders.

· Click Border to determine the style of image field borders.

· The options in the Text Format group are not applicable to image fields.

843
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· Click Properties to open the Push Button Properties pane, which enables the

customization of additional elements of image fields and is detailed in the

section below.

The Push Button Properties Pane

The Push Button Properties pane can be used to determine a range of style and functionality

options for image fields. For example, it is possible to use the Actions properties to add

multiple dynamic actions to image fields, such as running JavaScript, launching web links and

opening files on the local computer. (JavaScript is a high-level programming language that

can be used to perform custom operations. See here for an index of existing JavaScript

operations that the PDF-XChange Editor forms can use, as well as additional information

about JavaScript). Click Select Fields to select form fields, then click the desired field and click

Properties in the Format tab to open the Push Button Properties pane:

Figure 5. Image Field Tool, Push Button Properties Pane

The options detailed below are available in the Image Field Properties pane:

The General properties determine the general parameters of image fields:

· Read Only determines whether or not the image field can be edited.

· Locked determines whether or not image fields can be moved, and whether or not

their properties can be modified.

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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· Field Name determines the name of the image field. This name is present when the

Edit Form tool is selected, and when image fields are listed in the Fields pane.

· Tooltip determines the information displayed when the pointer is hovered over the

image field.

· Mapping Name determines the mapping name that the image field uses. This name is

used to reference interactive form data when the form is exported, and does so

without affecting the appearance of the name in the original document.

· Orientation determines the orientation of the image field.

· Visibility determines the visibility of the image field.

· Layer determines the optional content layer to which the image field belongs. When a

field belongs to an optional content layer, it displays only when the layer is enabled.

Use the Layers pane to view/create/edit layers, as detailed here.

The Style properties determine stylistic elements of image fields. They are detailed beneath

(figure 4).

The Position properties determine the position and dimensions of image fields:

· Left determines the distance of the image field from the left margin.

· Top determines the distance of the image field from the bottom of the page.

· Width/Height determine the width/height of the image field.

The Default Text Format properties are not applicable to image fields.

The Options properties determine additional options for image fields.

· Layout determines the layout of the image field, which can be displayed as text label,

icon or a combination of both elements:

· Label Only is the default setting for standard buttons. The text label that the Up

Label property specifies is the only element displayed on the button. The Up

Label property becomes available in the Options properties when Label Only

setting is enabled.

· Icon Only uses the custom image that the Up Icon property specifies to

represent the button. The Up Label property becomes available in the Options

properties when Icon Only setting is enabled. Image fields are set to Icon Only

by default.

· Icon Top, Label Bottom displays a custom image as the upper section of the

button and the text label beneath the image.

· Label Top, Icon Bottom displays the text label as the upper section of the

button and a custom image beneath the text.

· Icon Left, Label Right displays a custom image on the left and the text label on

the right.

· Label Left, Icon Right displays the text label on the left and a custom image on

the right.

366
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· Label over Icon uses a custom image to represent the button and places the text

label over the image.

   

  
Figure 6. Available Layout Options for Image Fields

· Behaviour specifies the visual effect when buttons are pressed:

· None specifies that no visual change occurs.

· Invert inverts the fill color of the button.

· Outline creates an outline around the button.

· Push creates a visual effect when buttons are clicked:

Figure 7. Default to Invert (Top), Default to Outline (Centre) and Default to Push (Bottom) 

· Up Label specifies the text that the button uses. N.b. A Layout property that specifies a

label must be enabled for the option to be available.

· Up Icon specifies the icon that the button uses. N.b. A Layout property that specifies

an icon must be enabled for the option to be available.

The Icon Placement properties determine settings for the icon used in the image field:

· When to Scale determines when icons are scaled to the size of the image field on

which they are featured:

· Always scales the icon to the size of the image field in all cases.

· Scale Type determines how the icon is scaled:

· Proportionally retains the aspect ratio of the icon

· Non-proportionally ignores the aspect ratio of the icon.
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· Never retains the original size of the icon regardless of the size of the image

field. 

· Icon is Too Big scales icons in cases where icons are larger than the image field.

· Icon is Too Small scales icons in cases where icons are smaller than the image

field.

· Fit to Bounds fits the icon to the bounds of the image field.

· Horizontal Position determines the horizontal position of the icon in the image field.

· Vertical Position determines the vertical position of the icon in the image field.

The Actions properties determine the action taken when users interact with the image field:

· Mouse Down initiates an action when the left mouse button is pressed (without being

released).

· Mouse Up initiates an action when the left mouse button is clicked (pressed and

released).

· Mouse Enter initiates an action when the pointer moves into the image field.

· Mouse Leave initiates an action when the pointer moves out of the image field.

· On Focus initiates an action when the image field is selected.

· On Blur initiates an action when the image field is deselected.

· Click the ellipsis icon on the right of actions to add/edit image field actions:

Figure 8. Image Field Properties Pane, Action Ellipses



833

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

 The process of adding actions is detailed here. 302
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3.3.6.11 JavaScript Console

 JavaScript Console

The JavaScript Console is used to execute JavaScript in documents. JavaScript is a high-level

programming language that can be used to perform a range of operations. 

Click the Form tab, then click JavaScript Console (or press Ctrl+J) to open the JavaScript Console:

Figure 1. Form Tab, JavaScript Console

The JavaScript Console will open:
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Figure 2. JavaScript Console

· Enter the desired JavaScript in the upper window, then click Run (or press Ctrl+Enter) to run

JavaScript. Errors in JavaScript and/or output of JavaScript will be displayed in the lower

window.

· Click Clear to remove error messages/output from the lower window.

· Click Options to customize JavaScript preferences, as detailed here.

Note that the Link Creation Tool  can be used to create JavaScript-enabled links. 

If you want to add JavaScript permanently to documents, then the Actions/JavaScript categories in

Document Properties  must be used.

An index of existing JavaScript operations that PDF-XChange Editor supports and additional

information about JavaScript is available here.

231

299

179

https://opensource.adobe.com/dc-acrobat-sdk-docs/acrobatsdk/pdfs/acrobatsdk_jsapiref.pdf
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3.3.6.12 Populate Forms

 Populate Forms

Click Populate Forms to create and populate forms with data from an existing file:

Figure 1. Forms Tab, Populate Forms

The Populate PDF Forms dialog box will open:
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Figure 2. Populate PDF Forms Dialog Box

· Use the Document dropdown menu to determine the template used to create the form.

· Use the Filename dropdown menu to determine the file used to populate the form fields in the

created document, and the Delimiter dropdown menu to determine the delimiter used to

define files and values in the data source document. If you want to specify image files to be

used to populate form fields then you must specify the full file name of the image in the input

file. Note that it is only necessary to specify the delimiter when plain text files are used, and it

may be necessary to add these delimiters before the document is used for this feature.

· Use the Row(s) dropdown menu to determine the rows of information used in cases where the

source document contains more than one set of form information.
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When you have selected a template and a data source file, the Mapping between PDF Template and

Data Source section will display the form fields from the template file in the left column:

Figure 3. Populate PDF Forms Dialog Box, Data Source Column Selection Active

· Select entries in the PDF Form Field column and click Add (or click the associated entry in the

Data Source Column) to add data from the data source file to the selected form field in

output documents.

· Click Guess to auto-fill forms. This is a useful feature when the names of the forms in the

template document match the names of the forms in the data source document, as they will

populate automatically with the matching information.

· Click Remove to remove selected entries from the Data Source Column.
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· Click Reset to reset all entries in the Data Source Column.

· Use the Destination Folder dropdown menu to determine the folder for created documents.

· Use the Filename dropdown menu to determine the filename of created documents. Note that

you can use macros  when creating the file name. Two of the available macros apply

specifically to the populate forms feature:

· Row Data by Column uses the form data from either the Column Index or the Column

Name to determine the file name.

· Row Index uses the index values of the rows of data in the data source document to

determine the file name.

Click OK to create and populate the form.

Click Options for additional options:

Figure 4. Populate PDF Forms Options

· Select the Flatten all form fields in the output PDF documents box to flatten form fields into

base content when the output documents are created.

· Select the Make all form fields read-only to enable the read-only property of form fields in

output documents. This means that form fields cannot be edited unless the read-only property

is subsequently disabled.

· Select the Remove duplicate spaces from data values box to remove duplicated spaces from

data values in output documents.

· Select the Hide all of the empty fields in output forms to hide empty fields in output

documents.

· Select the Format dates as box to specify the use of a date format, then select the desired

format in the adjacent dropdown menu.

Click OK to save changes.

1166
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Note that you can use the Export Form Data  feature to export data from filled-out forms to (*.csv)

format for subsequent use as data source files with the Populate Forms feature.

679
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3.3.6.13 Identify Forms

 Identify Forms

Click Identify Forms to identify form fields in documents:

Figure 1. Forms Tab, Identify

This feature is intended to identify content that is structured like form fields (for example in forms

converted from other formats to PDF). When it is selected, the Identify Forms dialog box will open:
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Figure 2. Identify Forms Dialog Box

· Use the OCR languages dropdown menu to determine the OCR language used when

identifying forms.

· Select the box to include table cells when the OCR engine identifies forms in the document.

· Use the Pages option to determine the page range included in the operation. Further

information about the specification of page ranges is available here.

Click OK to identify forms.

1285
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3.3.6.14 Editing Forms

 Editing Forms

Right-click fields to open the fields shortcut menu, which is used to edit and manipulate form fields:

Figure 1. Forms Shortcut Menu

· Click Rename Field to rename selected fields. 

· Click Set as Required Field to designate selected field as required, which means it must be

filled before the document can be submitted. These fields will also be highlighted when the

Highlight Required Fields Only option outlined here  is enabled.

· Click Add New Field to add new form fields to documents.

· Click Cut, Copy or Delete to cut/copy/delete selected forms.  

224
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· Click Select All to select all form fields. 

· Click Arrange to arrange fields. This option is available only when multiple fields are selected.

If the fields were group-selected with the mouse, then the first field placed in the document is

used as the reference point to arrange the other fields. If the form fields were group-selected

by holding Ctrl and selecting fields one at a time, then the first field selected will be used as the

reference point. The Arrange options are detailed below:

· Align Left Edges

· Align Horizontal Centers

· Align Right Edges

· Align Top Edges

· Align Vertical Centers

· Align Bottom Edges

· Align to Selection aligns selected forms to Selection Bounds, Key Object or Page as

desired.

· Distribute Horizontally

· Distribute Vertically

· Make Same Width

· Make Same Height

· Make Same Size

· Bring Forward, which brings the selected field up a step in cases where multiple forms

overlap.

· Send Backward, which sends the selected field back a step in cases where multiple forms

overlap.

· Bring to Front, which brings the selected field to the top in cases where multiple forms

overlap.

· Send to Back, which sends the selected field to the back in cases where multiple forms

overlap.

· Click Create Multiple Copies to create copies of selected forms, as detailed below.

· Click Duplicate to duplicate selected forms to a specific page range, as detailed below.

· Click Show Tab Numbers to display automated tab numbers in each form field. These

numbers represent the tab order when the Tab key is used to navigate between forms.

· Click Show Grid to activate the grid feature, which displays in the background of documents

and assists in the placement of objects.

· Click Make Current Properties Default to set the properties of the form field currently

selected as the default properties for all subsequent forms of the same format.

· Click Apply Default Properties to apply the default properties to the selected form field.

· Click Properties to launch the Properties  pane, which can be used to view/edit the

properties of selected fields.

Create Multiple Copies of Form Fields

Follow the steps below to create multiple copies of form fields:

441
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1. Click the Form tab, then click Select Fields and select the form fields to be copied:

Figure 2. Form Tab, Select Fields Enabled, Forms Selected

2. Click the Format tab, then click Create Multiple Copies:
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Figure 3. Format Tab, Create Multiple Copies

The Create Multiple Copies of Fields dialog box will open:
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Figure 4. Create Multiple Copies of Files Dialog Box

· The figure entered in the the Copy selected fields down number box determines the amount

of copies placed vertically below source fields.

· The figure entered in the the Copy selected fields across number box determines the amount

of copies placed horizontally from source fields.

· Select Specify distance between fields to determine the distance between copies. Enter the

desired distances in the Horizontal space and Vertical space number boxes.

· Select a unit of measurement from the Units menu.

· Select Specify overall size of all fields to determine the size of the area in which fields are

multiplied. The value entered in the Overall width and Overall height number boxes

determines the overall width and height of the area in which the selected field is multiplied.

Select the desired units of measurement from the Units menu. 

· The Overall Position settings can be used to determine the overall position of copied fields.

Edit the X and Y values as desired. The position selected in the grid determines the starting

point for measurements when multiple copies of form fields are created.

· Select the Preview box to place a preview before the creation of copied fields.

· Select the Use the same names box as desired. This is useful for fields that require the same

user data or other elements such as the current date. Copies will feature the same name as

source fields, followed by a unique number.
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Duplicate Form Fields

Follow the steps below to duplicate form fields:

1. Click the Form tab, then click Select Fields and select the form fields to be copied:

Figure 5. Selected Fields

2. Right click the fields and then click Duplicate:
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Figure 6. Right-Click Shortcut Menu, Duplicate

The Duplicate Annotations dialog box will open:
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Figure 6. Duplicate Annotations Dialog Box

· Use the Destination Settings  to determine the output settings for duplicated forms:

· Select the upper button to duplicate forms through a specified page offset from the

source form. Enter the desired page offset in the upper number box and the number of

duplicates in the lower number box. For example, if the page offset is specified as '3' and

the number of duplicates is specified as '3', then three duplicates will be created, with one

placed on every third page starting from the source form.

· Select the lower button to duplicate forms to a specified page range:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range

in the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or

Even as desired.

· Use the Duplicates per Page number box to specify the number of duplicate forms

created per page.

· Use the Duplicate Options settings to determine the duplication of selected forms:

1285
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· The value entered in the Horizontal Offset number box determines the horizontal offset

from the duplicated field.

· The value entered in the Vertical Offset number box determines the vertical offset from

the duplicated field.

Tab Order of Forms

Please note that the Tab key can be used to scroll through text field forms after they have been added

to documents. Follow the steps below to change the tab order of forms:

1. Click the View tab.

2. Click the Panes dropdown menu, then click Fields. The Fields pane will open.

3. Click Options, then click Order by Pages in the submenu.

4. Click the Form tab at the top of the user interface, then click Select Fields and drag fields

within the Fields pane to change the tab order.

Figure 7. Fields Pane, Tab Order Submenu
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3.3.7 Organize Tab

 Organize Tab

When the Organize tab is selected, the following options are available:

Figure 1. Organize Tab

The options in the Organize tab are used to edit and manipulate document pages. There are four

groups in the Organize tab:

Tools

The Tools group contains shortcuts to tools and other features:
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· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Further

information about this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

Pages

The Pages group contains options for the manipulation of document pages:
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· Click Insert to view options for inserting pages into the document. These options are detailed

here.

· Click Delete to view options for deleting pages from documents. These options are detailed

here.

· Click Extract Pages to extract a specified page range of the document to a new document, as

detailed here.

· Click Move Pages to move a specified page range to a new document location, as detailed

here.

· Click Duplicate Page to duplicate document pages and insert them at a specified document

location, as detailed here.

· Click Merge Pages to merge split pages, as detailed here.

· Click Replace Pages to replace document pages with pages from other documents, as detailed

here.

· Click the Split dropdown menu to view splitting options for the current page/document:

· Click Split Document to split the current document into smaller documents, as detailed

here.

· Click Split Pages to split the pages of the current document, as detailed here.

· Click Swap Pages to switch the location of two pages in the current document, as detailed

here.

· Click Overlay to overlay document pages, as detailed here.

Transform Pages

The Transform Pages group contains options for editing the pages of the current document:

· Click Rotate to rotate the pages of the current document, as detailed here.

· Click Crop to crop the pages the current document, as detailed here.

· Click Resize to resize the pages of the current document, as detailed here.

· Click Margins to set the page margins of the current document, as detailed here.
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Page Marks

The Page Marks group contains options for creating and editing additional page elements:

· Click the Watermarks dropdown menu, then click Add, Remove All or Manage to perform

these operations on watermarks, as detailed here.

· Click the Background dropdown menu, then click Add, Remove All or Manage to perform

these operations on backgrounds, as detailed here.

· Click the Header and Footer dropdown menu, then click Add, Remove All or Manage to

perform these operations on headers and footers, as detailed here.

· Click the Bates Numbering dropdown menu, then click Add, Add to Multiple Files, Remove

All or Manage to perform these operations on watermarks, as detailed here.

· Click Number Pages to assign new labels to pages, as detailed here.
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3.3.7.1 Insert

 Insert

Click Insert to view page insertion options:

Figure 1. Organize Tab, Insert

Click Insert Pages to insert pages into the active document:
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Figure 2. Insert Pages Dialog Box

· Select From File to insert pages from a file into the active document.

· Use the Actions with Objects options to determine the action taken for Comments, Form

Fields and Bookmarks contained in the inserted pages.

· Select the Add root bookmark, with file name box to create a root bookmark from inserted

pages.

· Use the Page Range options to determine which pages are inserted: 

· Select All to specify all pages.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Use the Destination options to determine the location at which the new pages are inserted.

Click OK to insert pages.

1285
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Click Insert Empty Pages to insert empty pages into the active document:

Figure 3. Insert Empty Pages Dialog Box

· Select an option in the Pages section to determine the dimensions of new pages:

· Select Document to match the dimensions of the current document.

· Select Standard to select a standard document size, such as those used by the ISO and

ANSI.

· Select Custom to enter custom dimensions. Enter the desired dimensions into the

number boxes. 

· Select either Portrait or Landscape for the orientation of new pages.

· Use the Count menu to determine the number of pages inserted.  

· Use the Destination options to determine the location at which the new pages are inserted.

Click OK to insert the empty pages.

Click Insert Pages from Clipboard to insert pages from the clipboard on your machine:
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Figure 4. Insert Pages from Clipboard Dialog Box

The current clipboard content on your machine is detailed in the dialog box. Select the content that

you want to insert as a page, then use the Location and Page options to specify the location at which

you want to insert the pages and click OK to perform the operation. Click Options for additional

insertion options. Note that the options available depend on the type of content that you are inserting

into the document.

Click Insert Images to insert images into the active document:
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Figure 5. Images to PDF Dialog Box

· Click Add Files to add images to the list of source files.

· Click Add Folder to add folders of images to the list of source files.

· Click Import to add images from the local scanner. See here  for further details.

· Click Edit to edit selected images before insertion.

· Use the blue arrow icons to reorder images. The order of images in the Image to PDF dialog

box determines the order in which images are inserted into the active document.

· Click Remove to remove selected images.

· Use the Change View Mode button to select Details, Icons or Thumbnails as the display

mode of list items.

· Use Destination options to determine at which images are inserted.

· Click Options to determine the options for inserted images. See here  for further details.

Click OK to insert images.

Click Insert Scanned Pages to insert scanned pages into the active document:

151
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Figure 6. Scan Properties Dialog Box

· Click the Scanner Settings menu to select a preset scanning mode. 

· Click the Scanner menu to select a scanner. 

· Click the Data Transfer Method menu to select either Native Mode or Memory Mode:

· Native Mode uses a single memory buffer. This is the default and fastest

mode, and is compatible with the broadest range of scanners.

· Memory Mode enables the use of multiple memory buffers. This is a useful

function in cases where memory is low and/or when large images are scanned.

· The Show Native UI box is selected by default, which means the user interface of

the device driver is used. This is the most reliable option, and the scanner will select

certain parameters of the scan itself: Color Mode, Resolution, Paper Size and

Source. Clear the Show Native UI box to customize these options:
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· Color Mode has four options: Auto detect, Color, Grayscale and Black & White. These

refer to the format of scanned documents.

· Click the Resolution menu to select the DPI (dots per inch) of scanned documents.

· Paper Size refers to the size of the paper used when scanning. Click Setup for further

options:

· Automatic set the paper size automatically.

· Standard contains standard sizes such as those used by the ISO and ANSI.

· Custom can be used to enter custom dimensions.

· Source has three options Auto, Flatbed and Feeder. These refer to the type of scanner

used.

· Click Sides to determine which sides of documents are scanned. There are three options:

Simple Scan, Manual Duplex and Manual Duplex Reversed. Click the dropdown arrow for an

explanation of these options.

· Click Scan More Pages to determine when additional pages are scanned.

· Select the After scanning, show images insertion dialog box to view the images insertion

dialog box after the scan has been performed. This enables the customization of images and

image settings.

· Click Images Insertion Options to determine further options for images. These options are

detailed here.

· Use the Destination options to determine the location at which scanned pages are inserted.

· Please note that the Save Current Settings option in the Scanner Settings dropdown menu

can be used to save customized settings.

Click Scan to scan images.

Click Insert Text to insert text files into the active document:

141
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Figure 7. Convert Text Files to PDF Dialog Box

· Click Add Files to add text files to the list of source files.

· Click Add Folder to add all text files from a folder to the list of source files.

· Use the blue arrows to reorder files. The order of files in the list determines the order in which

they are added to the document.

· Click Remove to remove selected files.

· Select files to enable the Selected File Options:

· Text Encoding determines character encoding of text.

· New Paragraph Mode determines how PDF-XChange Editor defines paragraphs in

inserted text:

· Auto-Detect searches for and identifies paragraphs automatically.

· Each newline character starts a new paragraph. (A newline is a special character

in computing that signifies the end of a line of text).

· Two newline characters start a new paragraph, single is ignored.

· A double newline character starts a new paragraph, a single is converted to a

space.

· Place File Mode determines how files are placed:

· Start each file from new paragraph places each file in a new paragraph, and files

can share the same page.

· Start each file from new page places each file in a new page.
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· Use the Destination options to determine the location at which scanned pages are inserted.

· Click Options to determine the options for inserted text files, as detailed here.

Click OK to insert text files.

Click Insert RTF to insert RTF files into documents:

Figure 8. Convert RTF Files to PDF Dialog Box

· Click Add Files to add RTF files to the list of source files.

· Click Add Folder to add all RTF files from a folder to the list of source files.

· Use the blue arrows to reorder files. The order of files in the list determines the order in which

they are added to the document.

· Click Remove to remove selected files.

· Use the Destination options to determine the location at which files are inserted.

· Click Options to determine the relative path options for inserted files.

Click OK to insert files.

122



866

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.3.7.2 Delete Pages

 Delete Pages

Click Delete to view the Delete options for pages in the current document:

Figure 1. Organize Tab, Delete Pages Options

Click Delete Pages to delete document pages:
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Figure 2. Delete Pages Dialog Box

· Use the Page Range options to determine which pages are inserted: 

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

Click OK to delete the pages.

Click Delete Empty Pages to delete empty document pages:

Figure 3. Delete Empty Pages Dialog Box

· Use the Delete pages that: dropdown menu to specify the deletion of specific types

of pages:

1285
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· Select Do no contain any content items within Page Box to delete only

pages that do not contain content items in the page box of the document. The

page box is defined as the intersection between the crop box and the media

box, as detailed here.

· Select Do not contain any content items to delete only pages that do not

contain content items.

· Select Have only a solid background to delete pages that contain only a

solid background.

· Select the ignore annotations on pages box to ignore annotations when PDF-

XChange Editor decides which pages to delete.

· Use the Page Range options to determine the page range from which empty pages are

deleted:

· Select All to specify all pages.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

Click OK to delete the pages.
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3.3.7.3 Extract Pages

 Extract Pages

Click Extract Pages (or press Ctrl+Shift+E) to extract pages from the current document:

Figure 1. Organize Tab, Extract Pages

The Extract Pages dialog box will open:
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Figure 2. Extract Pages Dialog Box

· Use the Page Range settings to determine the page range of extracted pages:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Use the Actions with Objects options to determine the action taken for Comments, Form

Fields and Bookmarks contained in extracted pages.

· Select the Delete pages after extraction box to delete pages from the source document after

they are extracted.

· Use the Output Options to determine how extracted pages are saved:

· Use the Type dropdown menu to determine the grouping of extracted pages. The

options are:

1285
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· Extract all pages to a new document.

· Save all extracted pages to one file.

· Save each page to a separate file.

· Save each pages range to a separate file.

· Use the Filename text box to set a file name for extracted pages. Click the blue icon to

use macros.

· Use the Destination Folder text box to set the destination folder, or click the yellow icon

to select a folder.

· Select the Open the Destination Folder with Result Files box to open the destination

folder when the operation is complete.

Click OK to extract pages.
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3.3.7.4 Duplicate Pages

 Duplicate Pages

Click Duplicate Pages to duplicate document pages and insert them at a specified location in the

current document:

Figure 1. Organize Tab, Duplicate Pages

The Duplicate Pages dialog box will open:
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Figure 2. Duplicate Pages Dialog Box

Use the Actions with Objects dropdown menus to determine the actions taken for comments and

form fields contained within duplicated pages.

Use the Page Range settings to determine which pages are duplicated:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

Use the Destination settings to determine the insertion location of duplicated pages:

· Use the Location options to select either Before or After.

· Use the Page options to select First, Current or Last as desired. Select Custom to specify a

custom page, then enter the desired page in the adjacent number box.

· Use the Number of copies dropdown menu to determine the amount of duplicates created.
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· Select the Collate box to collate document pages. This is a useful feature when duplicating

multiple copies of multi-page documents. It duplicates entire copies of documents together, as

opposed to multiple copies of each page at a time.

Click OK to duplicate pages.
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3.3.7.5 Move Pages

 Move Pages

Click Move Pages to move a specified page range to a new document location:

Figure 1. Organize Tab, Move Pages

The Move Pages dialog box will open:
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Figure 2. Move Pages Dialog Box

Use the Page Range settings to determine the page range of moved pages:

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

Use the Destination settings to determine the new location of the specified pages:

· Select either Before or After in the Location dropdown menu.

· Use the Page options to select First, Current or Last as desired. Select Custom to specify a

custom page, then enter the desired page in the adjacent number box.

Click OK to move pages.
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3.3.7.6 Replace Pages

 Replace Pages

Click Replace Pages to replace document pages with pages from other documents:

Figure 1. Organize Tab, Replace Pages

The Replace Pages dialog box will open:
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Figure 2. Replace Pages Dialog Box

Use the Page Range settings to determine the page range of replaced pages:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

· Select the box to retain interactive features such as comments and form fields on the places

being replaced.

Use the New Pages from File settings to determine options for the replacement pages:

· Use the File box to specify the file to be used to replace document pages. 

· Use the Page Range settings to determine the page range used from the source document:

· Select All to specify all pages.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

Click Options for additional options:

1285
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Figure 3. Options Dialog Box

· Use the dropdown menus to determine the action taken for Comments, Form Fields,

Bookmarks and Layers in replacement files.

· Select the box to merge layers with existing layers in cases where both sets of layers have the

same name.

Click OK to replace pages.
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3.3.7.7 Split Options

 Split Options

Click Split to view splitting options:

Figure 1. Organize Tab, Split Options

Split Document

The Split Document feature is useful for the breaking down of one document into several smaller

documents, such as books into chapters. Click Split Document to split the current document. The Split

Document dialog box will open:
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Figure 2. Split Document Dialog Box

· Select a Splitting Method to determine how the document is split:

· Select Split by using Bookmarks with the deepest nesting level of to split documents

according to bookmarks nested at the level specified in the number box.

· Select Every n page(s) to split the document every n pages. For example, enter the value

'3' to place a split after every third page.

· Select By Size less then to split documents into smaller documents that have a maximum

size of that specified in the number box.

· Use the Actions with Objects options to determine the settings for objects in split documents.

· Use the Output Options to determine how split documents are saved:

· Enter the name of the desired folder in the Destination Folder text box, or click the icon

to select a folder.

· Select the Open the Destination Folder box to open the destination folder when the

process is complete.

· Select the Overwrite Existing Files box to overwrite existing files that have the same

name as those being saved. This is a useful feature when documents need to be split

multiple times.
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Click OK to split documents.

Split Pages

The Split Pages feature is a convenient feature for splitting document pages into smaller sections. Click

Split Pages to split the pages of the current document. The Split Pages dialog box will open:

Figure 2. Split Pages Dialog Box

· Percentage is the default method used to split pages. Clear the Use relative offset values box

to use metric measurements instead, then select the desired measurement in the adjacent

dropdown menu.

· Select the Calculate split offsets from top box to calculate splits from the top of the page.

Note that the default settings calculate splits from the bottom of the page.

· Click Split Every to split at even intervals throughout the document. The Split Every dialog box

will open, as detailed below.
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· Click Add Horizontal Split and/or Add Vertical Split at the top of the preview pane to add

splits to documents. Splits are inserted at 50% by default and will appear in the preview pane

and the list of splits when these options are used, as detailed above. Click and drag to

reposition splits as desired.

· Use the plus and minus zoom icons to edit the view of the preview pane.

· Click Edit Split/Remove Split to edit/remove selected splits in the list of splits.

· Select the Use Right To Left splitting method box to split documents from right to left. Note

that the order in which documents are split determines the order of sections in the split

document.

· Select the Remove source pages after splitting them to remove the original document from

the active pane when pages are split. If this box is cleared then both the original document and

the split pages will be present after pages are split.

· Select an option from the Select split method dropdown menu to determine the method used

to split documents:

· Change the physical size of the pages adjusts the size of pages in order to split them.

· Redefine the visible area (crop box) of the pages adjusts the crop box of pages.

Further information about the crop box and other page boxes is available here.

When this option is used the Preserve original content box is available. If this option is

enabled then the visible page area will be reduced, but the cropped content will

remain available and be present if, for example, pages are resized subsequently.

· Use the Page Range settings to determine the pages to which the split applies:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

Figure 3. Split Every Dialog Box

1282
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· Select Standard to split documents at intervals of standard dimensions, then select the desired

dimension in the dropdown menu, and specify the desired orientation in the second dropdown

menu.

· Select Custom to split documents at intervals of custom dimensions, then enter the desired

dimensions and units of measurement in the adjacent number box and dropdown menu.

· Select Percentage to split documents according to a percentage of the document page size.

· Select the Add horizontal/vertical splits boxes as desired.

Click OK to split documents.

Split Pages by Guide Lines

The Split Pages by Guide Lines feature is used to split documents according to guide lines, which you

can create and edit as detailed here.  When this option is selected the Split Pages dialog box will

open:

Figure 4. Split Pages Dialog Box

· Select the Use Right to Left splitting method box to split documents from the top-right

corner, or clear this box to split documents from the top-left corner.

· Select the Remove source pages after splitting them box to remove split pages from the

document when the split is performed.

· Use the Select split method dropdown menu to determine the type of split that is performed:

· Select Redefine the visible area (crop box) of the page(s) to redefine the crop box

in order to crop pages.

450
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· Select Change the physical size of the pages to change the size of pages in order to

crop pages.

· Select the Preserve original content to preserve the original document content when

pages are split.

· Use the Page Range settings to determine the pages to which the split applies:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

Click OK to split pages.
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3.3.7.8 Swap Pages

 Swap Pages

Click Swap Pages to swap the location of two document pages:

Figure 1. Organize Tab, Swap Pages

The Swap Pages dialog box will open:
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Figure 2. Swap Pages Dialog Box

Enter the page numbers of the pages to be swapped and then click OK to swap pages.
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3.3.7.9 Merge Pages

 Merge Pages

Click Merge Pages to merge document pages:

Figure 1. Organize Tab, Merge Pages

The Merge Pages dialog box will open:
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Figure 2. Merge Pages Dialog Box

· Use the Pages options to determine the size of the new page:

· Click Calculate Size based on the merged pages dimensions to retain the size of the

source pages in the output document.

· Click Standard to use a standard page size for the output document, then select an

option in the dropdown menu.

· Click Custom to use a custom page size for the output document, then enter the

measurements in the combo boxes and select a unit of measurement as desired.

· Use the Orientation dropdown menu to determine the orientation of the output

document.

· Use the Margins number boxes to determine the margins of the output document.

· Use the Page Range settings to determine the pages to merge:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

1285
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· Select the Reverse Order check box to merge pages in reverse order.

· Use the Page Placement and Scaling options to determine how source pages are placed in the

output document, as detailed in the preview pane when settings are edited.

· Select/clear the Remove source pages after merging them box as desired.

Click OK to merge pages.
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3.3.7.10 Overlay Pages

 Overlay Pages

Click Overlay Pages to overlay document pages:

Figure 1. Organize Tab, Overlay Pages

The Overlay Pages dialog box will open:
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Figure 2. Overlay Pages Dialog Box

· Use the File dropdown menu to select a file to use as an overlay on the document.

· Use the Pages option to determine the pages used from the source document. Click All to use

all pages, or click Custom to specify a custom page range.

· Use the Import Options to determine import options for the overlay:

· Click Do not Create a New Layer to not add the overlay as a new layer in the document.

· Click Create New Layer to create a new layer for the overlay. Enter a name for the new

layer in the text box and click Properties to determine layer properties, as detailed

below.

· Click Add to Existing Layer to add the overlay to an existing layer, then selected the

desired layer from the dropdown menu.

· Click Copy Corresponding Layers from Source to copy corresponding layers from the

overlay document into the current document.

· Click Copy Structure of Corresponding Layers From Source to copy the layer structure

from the overlay document into the current document.

· Use the Destination Page Range options to determine the page range into which the overlay

is imported:
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· Use the Pages option to determine the pages used from the overlay. Click All to use all

pages, or click Custom to specify a custom page range.

· Use the Repeat Source dropdown menu to determine repeat options for the overlay in

cases where it contains fewer pages than the current document:

· Select No to disable the repeating of the overlay pages from the source document

in the current document.

· Select Last selected page to repeat the last selected page of the overlay in the

source document.

· Select Continuously repeat selected pages to repeat the overlay pages until they

fill the current document.

· Use the Appearance options to determine the appearance of the overlay:

· Select an option in the Rotation dropdown menu to determine the rotation of the

overlay.

· Select an option in the Opacity dropdown menu to determine the opacity of the overlay.

· Select an option in the Scale dropdown menu to determine the scaling of the overlay.

· Use the Placement Options to determine the placement of the overlay:

· Use the Horizontal Offset number box to determine the horizontal offset the overlay.

Use the adjacent dropdown to determine the location from which the offset is made.

· Use the Vertical Offset number box to determine the vertical offset of the overlay. Use

the adjacent dropdown to determine the location from which the offset is made.

· Use the Units dropdown menu to specify the units of measurement for offsets.

· Select the As Background box to import the overlay as a background.

Click OK to overlay the document.

Figure 3. Add New Layer Dialog Box
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· Select/clear the is ON box to set the default state of the layer to on/off.

· Select/clear the Is Locked box to disable/enable subsequent users from changing the state of

the layer. 

· Use the Object Visibility Options dropdown menus to determine the visibility of the layer

when the documents that contains it are viewed/printed/exported.

· Select the Show when system language matches box to show the layer when the application

language matches a given language, then select the desired language in the adjacent

dropdown menu.

· Select the Use partial language match to display the layer when there is a partial language

match with the language specified. A partial language match occurs when the region of the

language is the same as in the language specified but the locale is different. For example, if US

English is specified in the Show when system language matches dropdown menu and the

Use partial language match box is selected, then the layer will be displayed when the

application language is identified as US English, United Kingdom English, South African

English and all other derivatives of English listed in the dropdown menu.

· Select the Show on Zoom box to display the layer when the zoom function is used. Use the

adjacent number boxes to specify the minimum and maximum levels of zoom at which the

layer is displayed.

· Select the Add to a Layer Radio Button Group to add the layer to a Layer Radio Button

Group. Layers contained in a radio button group are mutually exclusive - if one layer is enabled

then the rest are disabled.

Click OK to save changes.
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3.3.7.11 Rotate Pages

 Rotate Pages

Click Rotate (or press Ctrl+Shift+R) to rotate document pages:

Figure 1. Document Tab Submenu. Rotate Pages

 The Rotate Pages dialog box will open:
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Figure 2. Rotate Pages Dialog Box

· Use the Direction dropdown menu to determine the type of rotation.

· Use the Page Range options to determine the page range of rotated pages:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Use the Orientation dropdown menu to specify the orientation of pages that you want

to rotate.

Click OK to rotate pages.

1285
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3.3.7.12 Crop

 Crop

Click Crop to view cropping options for the current document:

Figure 1. Document Tab Submenu. Crop Pages

Click Crop Pages to crop document pages:
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Figure 2. Crop Pages Dialog Box

PDF documents define five boundaries that control the imaging process: the Crop Box, Bleed Box,

Trim Box, Art Box and Media Box. PDF-XChange Editor uses these boxes to determine areas when

the Crop Pages feature is used. Use the Apply to Box dropdown menu, detailed below, to display the

editing boxes in the preview pane, then click and drag boxes and/or use the number boxes to adjust

their dimensions. Further information about editing boxes is available here.  The following options

are available in the Crop Pages dialog box:

· Click Show All Boxes to view the Crop Box, Bleed Box, Trim Box and Art Box in the preview

pane. (Please note that the Bleed Box, Trim Box and Art Box use the same dimensions as the

Crop Box by default.

· Use the Crop Method dropdown menu to determine the crop method used:

· Manual Margin Control enables the user to determine the cropping margins. Click the

text of menu entries in the Apply to Box dropdown menu to view them in the preview

pane. Click and drag boxes in the preview pane, or use the number boxes, to adjust their

dimensions. Select the check boxes of menu entries in the Apply to Box dropdown menu

to include them in the Crop Pages operation.

· Remove All White Space is a predefined mode that removes all white space from

documents.

1282
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· Remove Horizontal White Space/Remove Vertical White Space are predefined modes

that remove horizontal/vertical white space as required.

· None adjusts the page size to the crop box without changing existing crop boxes.

· Select the Constrain Proportions box to maintain the ratio of margins. For example if the

margin in the Left box is changed to 5mm then the margins in the Right, Top and Bottom

boxes will also be changed to 5mm. 

· Use Set to Zero, Revert to Original and Set To White Margins to apply these functions to

boxes selected in the Apply to Box dropdown menu.

· Select the Remove the content/comments/form fields outside of the crop box area box to

remove content/comments/form fields outside of the Crop box. Please note that cropping

pages reduces the visible page content, but the cropped content is still present in the file's

underlying code and, for example, will be visible if the document pages are increased in size.

Select this option to remove cropped content from the file.

· Select the Select the Adjust the page size to match the cropped area box to define the

Media box with the same dimensions as the Crop box.

· Select the Normalize Media Box to start from (0;0) box to reset the media box coordinates

in cases where previous operations have shifted them from the default location.

· Use the Page Range settings to determine the page range of cropped pages:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

 

Click OK to crop pages.

Click Crop Page Tool to crop documents manually. The Crop Tool dialog box will open:

1285
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Figure 3. Crop Page Tool, Crop Tool Dialog Box

Click Drag Crop Rectangle. The pointer will become a crosshairs icon. Click and drag to select the area

to be cropped. When the mouse button is released, the dialog box detailed in (figure 2) will launch.

Configure the parameters as detailed above and then click OK to crop documents.

Click Remove Cropped Content to remove cropped content from documents. Please note that content

is not removed by default. Cropping pages reduces the visible page content, but the content remains

available (and takes up memory) unless the Remove Cropped Content option is used.

Click Crop to White Margins to redefine the visible area of documents to match the bounding box of

content on each page.
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3.3.7.13 Resize

 Resize

Click Resize to resize the pages of the current document:

Figure 1. Organize Tab, Resize

The Resize Pages dialog box box will open:
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Figure 2. Resize Pages Dialog Box

· Use the Paper Size options to determine the size and layout of resized pages: 

· Click Standard to select a standard size, such as those used by the ISO and ANSI. Use the

adjacent box to select either Landscape or Portrait as the page orientation. 

· Click Custom to enter custom dimensions. Enter the dimensions in the number boxes and

select the units of measurement as desired.

· Click Page's Size to use the dimensions of an existing document page, then select the

desired page in the dropdown menu.

· Click Percentage to resize pages to a percentage of the existing page size.
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· Use the Orientation dropdown menu to determine the orientation of resized pages.

· Use the Skip Pages dropdown menu to skip document pages from being resized as

required.

· Select the Normalize Media Box to start from (0;0) box to reset the media box

coordinates in cases where previous operations have shifted them from the default

location.

· Use the Placement options to determine the horizontal/vertical offset of resized pages and the

location from which the offset is made.

· Use the Page Range settings to determine the page range of resized pages:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

· Use the Content Scale Options to determine the scale of page content in relation to the new

page size: 

· Select the Scale page content according new page size box to scale the content of

resized pages to the new page size.

· Clear the Keep content aspect ratio box to scale all content of resized pages to the new

page size.

· Select the Scale comments and form fields and Scale text in comments and form

fields boxes as desired.

Click OK to resize pages.

1285
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3.3.7.14 Set Margins

 Set Margins

Click Set Margins to set the margins of the current document:

Figure 1. Organize Tab, Set Margins

The Set Margins dialog box box will open:
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Figure 2. Set Margins Dialog Box

· Use the Page Range settings to determine the page range for the new margins:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

· Use the Margins dropdown menus to determine the new margins for the document.

· Use the Units dropdown menu to determine the units used for the margins.

· Select the To Mirror the horizontal margins for even pages box to create mirror-image

margins for even pages in the document. This is a useful feature if you are printing

books/booklets, or printing on both sides of each paper sheet.

· Select the Scale comments and form fields and Scale text in comments and form fields

boxes as desired.

Click OK to set margins.
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3.3.7.15 Watermarks

 Watermarks

Click Watermarks to view watermark options:

Figure 1. Organize Tab, Watermarks

· Click Add to add new watermarks. The Add Watermark dialog box will open, as detailed in

(figure 2).

· Click Remove All to remove all existing watermarks.

· Click Manage to manage existing watermarks.
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Figure 2. Add Watermark Dialog Box

· The Source options determine the source of watermarks. Enter text into the box or select a file.

Use the font, macro  and alignment options to customize watermarks when text is used.

· The Appearance options determine the rotation, opacity and scale of the watermark: 

· The Rotation value determines the rotation (in degrees) of watermarks. 

· The Opacity value determines the opacity (transparency) of watermarks. 

· The Scale value determines the scale of watermarks. Select the check box to scale

watermarks to the target page. If this box is not selected then the scale is relative to the

size of the original image used as the source for the watermark.

· The Visible On dropdown menu determines when the watermark will be visible. Select

View, Print and/or Export as desired.

· The Placement options determine the horizontal and/or vertical offset of the watermark from

the left, right or center of the document. 

· Select the As Background box to insert watermarks into the background as opposed to the

foreground of documents.

· The Page Range options are as follows:

· Select All to specify all pages.

1166
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· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

· The Preview Page pane displays a preview of pages. Select the numbers beneath the pane to

preview the corresponding document pages. 

· The Settings menu features two predefined watermarks: Draft and Confidential. The

remaining options relate to customized settings:

· Click Save to save settings.

· Click Delete to remove settings.

· Click Manage to manage settings.

Click OK to add watermarks.

1285
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3.3.7.16 Background

 Background

Click Background to view background options:

Figure 1. Organize Tab, Background

· Click Add to add new backgrounds. The Add Background dialog box will open, as detailed in

(figure 2).

· Click Remove All to remove all existing backgrounds.

· Click Manage to manage existing backgrounds.
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Figure 2. Add Background Dialog Box

· The Source options determine the source of the background:

· Select From Color to add a color-based background.

· Select Name to specify a file to be used as the background, or click the icon to select a

file from the local computer. If you are using a document that contains multiple pages,

then use the Page number box to specify the page number of the page/image to be

used.

· The Appearance options determine the rotation, opacity and scale of the background: 

· The Rotation value determines the rotation (in degrees) of the background.

· The Opacity value determines the opacity (transparency) of the background.

· The Scale value determines the scale of backgrounds. Select the check box to scale

backgrounds to the target page. If this box is not selected then the scale is relative to the

size of the original image used as the source for the background.

· The Placement options determine the horizontal and/or vertical offset of the background from

the left, right or center of the document.

· The Page Range options are as follows:

· Select All to specify all pages.

· Select Current to specify only the current page.
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· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

· Please note that it is possible to create more than one background for pages within the

same document as long as they are not located within the same page/page range.

· The Preview Page pane displays a preview of pages. Select the numbers beneath the pane to

preview the corresponding document pages. 

· Use the Settings dropdown menu to save/delete customized settings and/or manage existing

customized settings:

· Click Save to save settings.

· Click Delete to remove settings.

· Click Manage to manage settings.

Click OK to add backgrounds.

1285
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3.3.7.17 Header and Footer

 Header and Footer

Click Header and Footer to view header and footer options:

Figure 1. Organize Tab, Header and Footer

· Click Add to add new headers and footers. The Add Header and Footer dialog box will open,

as detailed in (figure 2).

· Click Remove All to remove all existing headers and footers. 

· Click Manage to manage existing headers and footers.
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Figure 2. Add Header and Footer Dialog Box

· Enter text in the text boxes to insert headers/footers on the left/center/right of pages as

desired. Alternatively, click the  macro icon to use macros as the source for header/footer

text. Further information about macros is available here.

· Click Font to determine the font settings for headers and footers, as detailed below.

· Use the Margins settings to reposition the location of headers/footers.

· Select the Shrink pages' content to avoid overwriting document's text and graphics box to

shrink page content in order to ensure headers and footers do not overlap with existing page

content when they are added to the document.

· Enter page numbers in the Preview Page number box to view a preview of headers/footers in

the preview window.

1166
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· Click Page Range Options to select the pages of the document that will feature

headers/footers.

· Click the Settings dropdown arrow to save/delete customized settings and/or manage existing

customized settings:

· Click  to save settings.

· Click  to remove settings.

· Click  to manage settings.

Click OK to create headers/footers.

Select Font Options

Figure 3. Select Font Dialog Box

· Use the Font text box to enter the name of the desired font, or select one from the options

listed below the text box.

· Use the Style menu to determine the style of the font.

· Use the Size menu to determine the size of the font.

· Use the Fill menu to determine the color of the font. 
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· Use the Stroke menu to determine the color of the stroke. This color will border the text.

· Use the Stroke width menu to determine the size of the stroke. 

· Use the Underline menu to enable/disable font underline.

Click OK to save settings.
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3.3.7.18 Bates Numbering

 Bates Numbering

Click Bates Numbering to view Bates numbering options:

Figure 1. Organize Tab, Bates Numbering

Bates numbering is a dynamic way to provide identification, protection and automatic consecutive

numbering within documents as they are processed/scanned.

· Click Add to add Bates numbering to documents. The Add Bates Numbering dialog box will

open, as detailed in (figure 2).
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· Click Add to Multiple Files to add Bates numbering to multiple files. The Add Bates

Numbering to Files dialog box will open, as detailed in (figure 3).

· Click Remove All to remove all existing Bates numbering.

· Click Manage to manage existing Bates numbering.

Add Bates Numbering

Figure 2. Add Bates Numbering Dialog Box

· Enter text in the text boxes to insert Bates numbering on the left/center/right and as a

header/footer of pages as desired. Alternatively, click the  macro icon to source the

content of Bates numbering with macros. Further information about macros is available

here. 1166
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· Click Font to determine the font settings for Bates numbering, as detailed here.

· Use the Margins settings to reposition the location of Bates numbering.

· Select the Shrink pages' content to avoid overwriting document's text and graphics box to

shrink page content in order to ensure Bates numbering does not overlap with existing page

content when it is added to the document.

· Enter page numbers in the Preview Page number box to view a preview of Bates numbering in

the preview window.

· Click Page Range Options to select the pages of the document that will feature Bates

numbering.

· Use the Settings dropdown menu to save/delete customized settings and/or manage existing

customized settings:

· Click  to save settings.

· Click  to remove settings.

· Click  to manage settings.

Click OK to add Bates numbering.

Add to Multiple Files

Click Add to Multiple Files to add continuous Bates numbering to multiple files. The following dialog

box will open:
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Figure 3. Add Bates Numbering to Files Dialog Box

· Click Add Files to add files from the local computer to the list of source files.

· Click Add Folder to add folders to the list of source files.

· Select files and then click Page Range to determine page ranges for Bates numbering.

· Use the blue arrow icons (or click and drag) to move selected documents to the top/bottom of

the list, or to move them up/down in the order of documents. The order in which documents

are listed determines the order of Bates numbering throughout the documents.

· Click Remove to remove selected documents from the list. 

· Select Replace file names with starting and ending Bates number as desired.

· Use the Output Options to determine options for output files:

· Select the upper radio button to convert filenames to Bates numbering.

· Select the lower radio button to enter a custom name for converted files. Enter the

desired name/folder in the text boxes. Click the blue icon to use macros  as desired.

Use the Destination Folder test box, or click the yellow icon, to determine the location of

converted files.

· Select the Overwrite Existing Files, Open folder with results and Create Log File boxes

as desired..

· Click Options to determine the Bates numbering options as detailed in (figure 2) above.

1166



920

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Click OK to insert Bates numbering into the documents.
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3.3.7.19 Number Pages

 Number Pages

Click Number Pages to number document pages and create number ranges:

Figure 1. Organize Tab, Number Pages

Please note that this feature relates to page numbers/ranges as they appear in the Thumbnails

 pane and the Page Navigation  toolbar. (The Header and Footer  feature can be used to

create/edit physical page numbers). The main purpose of this feature is to rectify cases where the page

numbers on document pages do not match the page numbers that appear in the Thumbnails pane

and the Page Navigation toolbar. This is often the case in documents that feature 'front matter' such as

copyright pages and/or a table of contents and other similar pages. Additionally, it is necessary to

351
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select the Use logical page numbers box in the Page Display  preferences tab, as detailed in

(figure 7), in order for changes made with this feature to be visible.

When this option is selected, the following dialog box will open:

Figure 2. Page Numbering Dialog Box

· Existing page ranges are detailed in the dialog box. Click Add new range to add a new page

range to the active document. The Add new range dialog box will open. Enter the number of

the first page in the number box and click OK to create the page range.

· Use the sliders detailed in (figure 2) to adjust page ranges.

· Click Remove to remove the selected page range.

· Click Reset ranges to reset all page ranges.

· Use the Style menu to set the numbering style of the selected page range.

· Use the Prefix box to add a prefix to page numbers in the selected page range.

· Use the Start numbering from box to determine the first number of the selected page range.

· Use the arrow icons on the left of the Add New Range button to redo/undo operations.

Click OK to apply changes.

Number Pages Example

The document detailed below contains a table of contents that results in a two-page difference

between the page numbering of pages in the Thumbnails pane and the Page Navigation toolbar in

comparison to the page numbers of the document:

202
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Figure 3. Number Pages Example. Page Number Disparity

Follow the steps below to resolve this issue:

1. Click the Organize tab, then click Number Pages:
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Figure 4. Number Pages Example. Organize Tab, Number Pages

The Page Numbering dialog box will open.

2. Click Add new range. The Add New Range dialog box will open:
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Figure 5. Page Numbering Feature, Add New Range Dialog Box

3. Enter the desired starting page for the new range. (Note that the issue detailed above requires

page three to be the first page of the new range).

4. Click OK in the Add New Range and Page Numbering dialog boxes.

5. Click the File tab, then click Preferences:
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Figure 6. File Tab, Preferences

The Preferences dialog box will open. 

6. Click Page Display in the Categories menu, then select the Use logical page numbers box:
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Figure 7. Page Display Preferences, Use Logical Page Numbers Highlighted

7. Click Apply and then click OK.

The page numbering of pages in the Thumbnails pane and the Page Navigation toolbar will then

match the page numbering of the main document:
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Figure 8. New Page Range

Note that the physical page numbers are also displayed in the Page Navigation toolbar. Additionally,

the copyright and table of contents pages retain their existing page numbering. If desired, this can be

adjusted as follows: 

1. Click the Organize tab, then click Number Pages:
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Figure 9. Organize Tab, Number Pages

The Page Numbering dialog box will open.

2. Click the page range that contains the copyright and table of contents pages, then click the

Style dropdown menu and select a new style, such as Roman numerals:
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Figure 10. Page Numbering Dialog Box, Roman Numerals Selected

3. Click OK. The process is then complete:
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Figure 11. Number Pages Process Complete
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3.3.8 Convert Tab

 Convert Tab

When the Convert tab is selected, the following options are available:

Figure 1. Convert Tab

The options in the Convert tab are used to convert content into different formats. There are four

groups in the Convert tab:

Tools

The Tools group contains shortcuts to tools and other features:
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· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Further

information about this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

Create

The Create group contains options for creating new documents:
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· Click Scan to create a new document from the local scanner, as detailed here.  Click the Scan

dropdown menu to view/select/configure preset scanning modes.

· Click the From Files dropdown menu to view options for creating new document from existing

files:

· Click Combine Files into a Single PDF to combine existing files into a new document, as

detailed here.

· Click From Text Files to create a new document from text files, as detailed here.

· Click From Rich Text Format (RTF) Files to create a new document from RTF files, as

detailed here.

· Click From Image Files to create a new document from image files, a detailed here.

· Click Blank to create a new empty document.

Modify

The Modify group contains modification option:

Click Rasterize Pages to rasterize document pages, as detailed here.

Click Recompress Images to recompress document images, as detailed here.

Click Replace Fonts to replace document fonts, as detailed here.

Export

The Export group contains options for exporting the current document to different formats:
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· Click Export to Images to export documents to image format, as detailed here.

· Click To MS-Word to export documents to MS Word format. Note that files exported to this

format are compatible with MS Word 2010 and later. This feature is detailed here.

· Click To MS-Excel to export documents to MS Excel format. This feature is detailed here.

· Click To MS-PowerPoint to export documents to MS Powerpoint format. This feature is

detailed here.

OCR/Enhance Pages

The OCR group contains options for interacting with scanned content:

· Click OCR Pages to perform OCR on documents, as detailed here.

· Click Enhance Scanned Pages to enhance the quality of scanned pages, as detailed here.

· Click Deskew Pages to deskew pages that have been scanned crookedly. The Deskew Pages

dialog box will open. Enter the page range of the pages that you want to deskew and then click

OK to deskew pages. 

Convert Colors

The Convert Colors group contains the Convert Colors option:

Click Convert Colors to convert document colors, as detailed here.
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3.3.8.1 OCR Pages

 OCR Pages

Click OCR Pages to perform optical character recognition on documents:

Figure 1. Convert Tab, OCR Pages

Note that two optical character recognition engines are available in PDF-Exchange Editor: the Default

OCR engine and the Enhanced OCR engine, which is available when PDF-Exchange Editor Plus is

purchased (either as a stand-alone product or as part of the PDF-XChange PRO bundle). The

Enhanced OCR engine is faster, more accurate and more dynamic than the default OCR engine, and it

also contains some extra features. Further information about the Enhanced OCR engine is available
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here.  You can use the OCR Preferences (available via the Preferences option in the File tab) to switch

between default and enhanced OCR:

Figure 2. Preferences Dialog Box, OCR Category, OCR Engine Dropdown Menu

Default OCR Engine

The default engine's OCR process in PDF-XChange Editor analyzes image-based documents,

recognizes text and then places a duplicate, invisible text layer on top of it, which makes the source text

selectable and searchable in the same manner as ordinary text. When this option is selected the OCR

Pages dialog box will open:

https://www.tracker-software.com/product/ocr-plugin
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Figure 3. OCR Pages Dialog Box

Use the Page Range settings to determine the page range for OCR:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in the

adjacent number box. Further information about how to specify custom page ranges is

available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even as

desired.

Use the Recognition Options to determine the language and accuracy of the OCR process. Please note

that increasing the accuracy also increases the time that the process takes and vice versa. Additionally,

it should be noted that setting the accuracy to high may result in unusual output if the document

contains imperfections. This is because the software will search to a greater depth and may attempt to

1285
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recognize imperfections as text. Click Add/Update Languages to add/update the language packs used

for OCR.

· Select the Detect skew of page content box to enable automatic detection of skewed pages,

which happens when documents are scanned crookedly.

· Select the Detect incorrect page rotation box to enable the automatic detection of incorrect

page rotation in documents.

· Select the Ignore existing text on page box to omit existing text from the process of optical

character recognition.

· Select the Ignore comments on page box to omit comments from the process of optical

character recognition.

· Select the Ignore form fields on page box to omit form fields from the process of optical

character recognition.

Use the Output Options to determine the format and quality of output from the OCR process:

· Select the Fix content skew and incorrect page rotation box to deskew pages that are

scanned crookedly and auto-correct page rotation issues.

· Select the Create a New Document box to create a new document for the output of the

optical character recognition. If this box is not selected, then the original document will be

updated with the output instead.

Click OK to OCR documents.

Enhanced OCR Engine

The Enhanced OCR dialog box appears as detailed below:
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Figure 4. OCR Pages (Enhanced) Dialog Box

The options in this dialog box are the same as those detailed in (figure 3) but with additional Output

Options:

· Select Searchable Image to retain the image-based content on which OCR is performed and

insert a duplicate, invisible text layer on the text recognized during the operation. This will

make the source text selectable and searchable in the same manner as ordinary text.

· Select Editable Text and Images to replace image-based text in source documents with the

text recognized in the process of optical character recognition. This will convert image-based

text into editable text, and retain existing content such as text and images.

· Select Fine Page Content to replace the content of source documents with new content that

contains only the text and images recognized during optical character recognition.
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· Select the Draw Lines for tables box to replace recognized column/row lines in tables with

editable vector lines in output documents.

Please note that in some cases (for example documents that contain one large graphic zone that takes

up the whole page area and has some text zones over it) the visual output for Editable Text and

Images and Fine Page Content will be very similar. 

Click OK to OCR documents.

OCR Selected Region

It is also possible to perform OCR on selected regions of documents. This is possible after either the

Snapshot Tool  or the Crop Page Tool  has been used to define a page area, and the option is

available in the right-click shortcut menu. For example, click Other Tools in the Organize tab, then click

Snapshot Tool and click and drag the mouse to define a snapshot area:

Figure 5. Active Snapshot Tool

When the area has been defined, right-click it and then click OCR Selected Region in the shortcut

menu:

269 899
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Figure 6. Right-Click Shortcut Menu, OCR Selected Region Highlighted

The OCR Options dialog box will open. Determine parameters as detailed above and then click OK to

perform OCR on the selected region of the document.
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3.3.8.2 Enhance Scanned Pages

 Enhance Scanned Pages

Click Enhance Scanned Pages to enhance the quality of scanned pages:

Figure 1. Convert Tab, Enhance Scanned Pages

The Enhanced Scanned Pages dialog box will open:
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Figure 2. Enhance Scanned Pages Dialog Box

· Use the Page Range options to determine the page range to be enhanced.:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here. 1285
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· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Use the Color/Grayscale, Monochrome, Grayscale and Indexed dropdown menus to

determine the type of compression for these formats.

· Select/clear the Apply Adaptive Compression box as desired.

· Use the slider to select between Small Size and High Quality as desired.

· Use the Filters dropdown menus to set options for deskewing, background removal,

descreening and text sharpening as desired.

· Select the Recognize Text box to perform OCR  on pages. 

· Click Edit to change the language and/or accuracy of the OCR operation. Note than increasing

the accuracy will also increase the time taken to perform the operation and vice versa.

Additionally, the OCR options available depend on the OCR engine currently in use, as PDF-

XChange Editor Plus features an Enhanced OCR plugin that contains additional features to the

default OCR engine. The differences between these engines are detailed here.

Click OK to enhance pages.

936
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3.3.8.3 Convert Colors

 Convert Colors

Click Convert Colors to convert document colors:

Figure 1. Convert Tab, Convert Colors

The Convert Colors dialog box will open:
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Figure 2. Convert Colors Dialog Box

· The default settings profile for color conversion are available in the pane on the left.

If you want to create customized settings for color conversion, then click Add and

customize the settings as detailed below:

· Use the Matching Criteria section to determine the characteristics of content

that will have its color converted:

· Use the Object Type dropdown menu to specify the type of objects that

you want to convert.

· Use the Color Type dropdown menu to specify the color space you want

to convert.

·  Use the Minimum/Maximum Text Size dropdown menus to specify

the minimum/maximum size for converted text.

· Use the Conversion Attributes to determine how the colors of objects in the

document that meet the Matching Criteria are converted:

· Use the Convert Command dropdown menu to determine the

conversion operation performed:

· Preserve preserves objects from conversion.

· Convert to Profile converts objects to the destination colorspace

using the profile selected in the Conversion Profile dropdown

menu.

· Decalibrate removes embedded profiles from objects. 

· Use the Conversion Profile dropdown menu to determine the profile to

which objects are converted. Select the Embed box to tag objects with
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the selected ICC profile to calibrate color, which is useful when PDFs are

shared between users on different devices.

· Use the Rendering Intent dropdown menu to determine the rendering

intent used during color conversion.

· Use the Convert Options to determine additional options:

· Select the Convert Colors to Output Intent box to convert document

colors to the Output Intent specified in the Rendering Intent

dropdown menu. Note that documents must contain the output intent

profile in order for their colors to be converted.

· Select the Preserve Black box to preserve black objects in CMYK, RGB

or Grayscale content of converted documents, for example to prevent

RGB text from converting into rich black CMYK when conversion is

performed.

· Select the Preserve CMYK Primitives to preserve colors that contain

only one colorant.

· Select the Promote Gray to CMYK Black to convert device gray to

CMYK black with only a black component.

· Use the Page Range options to determine the page range on which color

conversion takes place in input documents. Further information on the

specification of page ranges is available here.

· Click Document Colors to view a breakdown of colors in the current

document and determine which colors are converted, as detailed below.

· Click the Settings dropdown arrow to save/manage/delete custom settings:

· Click Save Current Settings to save the current settings as a profile for

subsequent use.

· Click Delete to delete selected profiles. Note that this option is only

available for customized profiles.

· Click Manage to manage preset/customized profiles. The Manage

Presets dialog box will open:

1285
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Figure 3. Manage Presets Dialog Box

· Click Edit to edit selected profiles. Note that this option is only available

for customized profiles.

· Click Clone to clone selected profiles. This option can be used to

customize the settings of preset profiles, which cannot be customized in

the default state.

· Use the up and down arrows to move selected profiles up or down in

the list.

· Click Delete to delete selected profiles. Note that this option is only

available for customized profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.

Document Colors
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Figure 4. Document Colors Dialog Box

All colors contained in the document are detailed in this dialog box. Select the boxes of

spot colors to include them in the conversion, or select the Convert all spot colors box to

convert all spot colors.
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3.3.8.4 Rasterize Pages

 Rasterize Pages

Click Rasterize Pages to rasterize document pages:

Figure 1. Convert Tab, Rasterize Pages Highlighted

Rasterization converts vector graphics into raster images. The main purpose of this process

is to preserve resolution, as rasterized images always display in the the same manner

regardless of their size. Vector images may not scale or print to an acceptable standard, and

many printers use dots in order to print - which means they must first rasterize the content.

This can become a problematic process, and if you instead perform the rasterization before

printing then you can avoid these issues.
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When this feature is selected, the Rasterize Pages dialog box will open:

Figure 2. Rasterize Pages Dialog Box

· Use the Page Range options to determine the page range to be rasterized:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Use the Actions with Objects dropdown menus to determine the action taken for

comments, form fields and links when rasterization is performed.

1285
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· Use the Type dropdown menu to determine the type of rasterization performed on

the document.

· Use the Compression dropdown menu to determine the type of compression used

for the rasterization.

· Use the Page Background dropdown menu to determine the fill color for

transparent sections of the document when rasterization takes place.

· Use the JPEG Quality dropdown menu to determine the JPEG quality when JPEG

compression is used.

· Use the Horizontal and Vertical Resolution number boxes to determine the

resolution of rasterized images.

Click OK to rasterize pages.
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3.3.8.5 Recompress Images

 Recompress Images

Click Recompress Images to recompress document images:

Figure 1. Convert Tab, Recompress Images Highlighted

The Recompress Images dialog box will open:
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Figure 2. Recompress Images Dialog Box

· Use the Page Range options to determine the page range of images to be

recompressed:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here. 1285
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· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Alternatively, select the Selected Graphic button to recompress only the

graphic currently selected in the document.

· Select a recompression option in the pane to determine the type of image

recompression for the operation. Note that you can click Edit or Reset to edit/reset

recompression settings.

· Select the Replace all instances box to replace all instances of the graphic that is

being recompressed in cases where the graphic appears multiple times in the same

document.

· Select the Replace when size of new image is smaller than size of original image

box to replace recompressed images when they are smaller than the source image

used to create them.

· Use the Settings dropdown menu to determine the quality of the recompression.

Note that increasing quality will increase the file size and vice versa.

Click OK to recompress images.
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3.3.8.6 Replace Fonts

 Replace Fonts

Click Replace Fonts to replace document fonts:

Figure 1. Convert Tab, Replace Fonts Highlighted

The Replace Fonts dialog box will open:
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Figure 2. Replace Fonts Dialog Box

· Use the Pages option to specify the pages in which you want to replace fonts:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Click Add to add a new font to be replaced. The Add Rule(s) dialog box will open,

as detailed in (figure 3).

· Click Add from Selection to add text currently selected in the document as the

template for text to be replaced in the document. Note that text must be selected

with the Select Text Tool  in order for this feature to operate.

· Use the arrow buttons to move items up or down in the list, and use the Remove

feature to remove items from the list.

· Select the Allow increasing width of text columns box to allow the width of

columns of text to become wider when you are increasing the size of fonts.

1285

1087
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· Select the Replace symbols that are not present in the new font box to replace

symbols that are present in the current font but absent in the replacement font, then

enter the desired font in the text box.

· Click Settings to manage saved custom settings. The Manage Presets dialog box

will open, as detailed in (figure 4).

Click OK to replace fonts.

Figure 3. Add Rules Dialog Box

· Select the Font Names box to specify fonts to be replaced in the document. Click Add to add

existing fonts in the document, or click Add Custom to add custom fonts. Note that you can

leave the Font Names box unchecked if you want to specify only all fonts within a size and/or

color range, and then use the settings below to specify the desired parameters.

· Select the Font Size box to specify the size range of fonts to be replaced.

· Select the Color box to specify the color of fonts to be replaced.

· Use the Replace with check boxes to specify the Font Name, Size and Color that you want to

use to replace the text in the document.

Click OK to save changes.
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Figure 3. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles. This makes it possible to duplicate profiles

and then customize their settings whilst retaining the existing profile and its

parameters.

· Use the up/down arrow to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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3.3.9 Share Tab

 Share Tab

When the Share tab is selected, the following options are available:

Figure 1. SharePoint Submenu

The options in the Share tab are used to interact with SharePoint files and email documents from

PDF-XChange Editor. SharePoint facilitates the convenient sharing of files for group viewing/editing.

There are three groups in the Share tab:

Tools
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The Tools group contains shortcuts to tools and other features:

· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Further

information about this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

Send To

The Send To group contains only the Email feature:
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· Click Email to email the current document in PDF-XChange Editor. This feature uses the

settings determined in the Email preferences, which are detailed here.

· Click Email All to email all open documents.

· Click the Email dropdown menu to select/manage presets for the Email feature.

SharePoint

The SharePoint group contains options for interacting with documents located in a SharePoint server:

· Click Check In/Out to check the current document in to/out from a SharePoint server.

· Click Discard Check Out to discard documents currently checked out from a SharePoint server.

Note that unsaved changes are lost when this option is used.

· Click Enable Editing to enable editing for SharePoint files.

Opening SharePoint Files in PDF-XChange Editor

Follow the steps below to open SharePoint files:

1. Click the File tab.

2. Click Add a Place, then click SharePoint:

261
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Figure 2. File Tab, Add a Place, SharePoint

The PDF-XChange Editor dialog box will open.

3. Enter the URL for the SharePoint file, then click Connect.

The Authentication Required dialog box will open.

4. Enter your SharePoint credentials and click OK.

The Open Files dialog box will open:



965

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 3. SharePoint Open Files Dialog Box

5. Select the desired file from the list and click Open or Open with Check Out. Click Open to

make the file both available and editable for other users. Click Open with Check Out to make the

file editable for the current user only, and read-only for other users. Further information on using

SharePoint is available here.

The document is then displayed in PDF-XChange Editor:

https://support.office.com/en-us/article/Open-or-check-out-Office-files-from-a-SharePoint-library-b4221e42-d47c-49fc-92a6-04ed88befc0c
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Figure 4. SharePoint File Displayed in PDF-XChange Editor

· Click Enable Editing to enable editing for the document. 

· Click Check Out to check the document out from SharePoint.

When you use either of these options and then make changes to and save a document, the changes will

be saved in the version of the document stored at the SharePoint location. If you check out a

document, make changes to it and check the document back in to SharePoint, then the following

dialog box will be displayed:
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Figure 5. SharePoint Check In Options

· If you want to add a comment about the changes that you made to the document then enter

them in the Comment text box.

· Select the Increment minor version button to specify an increment in the minor version of the

document.

· Select the Increment major version button to specify an increment in the major version of the

document.

· Select the Overwrite without changing version button to overwrite the existing document

with changing the version number.

· Click Check In to check the document in to SharePoint.

· Click Check in and Keep Checked Out to check the document in to SharePoint (i.e. update the

version that is saved there) and also keep the document checked out.

· Click Keep Checked Out to keep the document checked out.

If you are using PDF-XChange Editor as part of the PDF-XChange PRO bundle, then the additional

functionality detailed below is also available:  

Using SharePoint to Interact with Files in PDF-XChange Editor
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Your documents are detailed in the Documents section of your SharePoint account. You can use the

options highlighted in the image below to open selected documents in PDF-XChange Editor:

Figure 6. SharePoint, Open in PDF-XChange Options
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3.3.10 Review Tab

 Review Tab

When the Review tab is selected, the following options are available:

Figure 1. Review Tab

The options in the Review tab are used to edit, analyze and update documents and document

comments. There are three groups in the Review tab:

Tools

The Tools group contains shortcuts to tools and other features:
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· The Hand Tool is used as a basic scrolling device and navigation aid when browsing through

documents. Click to enable the Hand Tool, then click and drag the page in the desired scrolling

direction in order to browse through documents. Further information about the Hand Tool and

its settings is available here.

· The Select Text Tool is used to select base-content text. Click to enable the Select Text Tool,

then click and drag the pointer to select text. Double-click to select words, triple-click to select

paragraphs and quadruple-click to select all text on the current page. Right-click selections for

editing options, as detailed here.  Note that the default setting of the Select Text Tool

results in it selecting entire lines of text. If you instead want to select a custom area of text, such

as text that is located over several lines at the center of a larger block of surrounding text,

simply press and hold the Alt key and then select the desired text. Additionally, please note that

when text is copied from PDF documents and pasted into applications/locations outside of

PDF-XChange Editor (such as Microsoft Word) additional page breaks may appear. This is a

recognized issue with PDF documents. The Edit Objects Tool  should be used instead of the

Select Text Tool in order to avoid this issue when copying text.

· Click the Other Tools dropdown menu to view/select additional tool options:

· The Select Comments Tool is used to select and edit comments. Click to enable the

Select Comments Tool, then click to select comments. Click and drag to select multiple

comments. Selected comments can be edited, as detailed here.

· The Snapshot Tool is used to take screenshots of pages/selected page content. Click to

enable the Snapshot Tool, then click or click and drag to take snapshots. Further

information about this tool is available here.

· The options in the Clipboard dropdown menu is used to interact with the current content

of the clipboard. Click the dropdown menu to cut/copy/paste clipboard content.

· The Find feature is used to Find  or Search  text, or to search the internet for text

selected with the Select Text Tool in the current document.

Proofing

The Proofing group contains options for proofing documents:
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· Click Text Correction to perform text corrections on document text. This feature is detailed

here.

· Click Spell Check to perform a spell check on the current document. This feature is detailed

here.

· Click Word Count to perform a word count on the current document.

· Click Compare Documents to compare the current document with a different document. This

feature is detailed here.

Comments

The Comments tab contains options for adding, deleting and editing comments:

· Click the Add Comments dropdown menu to add comments to the current document:

· Click Add Sticky Note to add a sticky note comment. The Sticky Note feature is detailed

here.

· Click Highlight Text to add highlights to selected text. Use the Select Text Tool, detailed

above, to select text to highlight with this feature. The Highlight Text tool is detailed

here.

· Click Underline Text to add underlines to selected text. Use the Select Text Tool,

detailed above, to select text to underline with this feature. The Underline Text tool is

detailed here.

· Click Crossout Text to strike out selected text. Use the Select Text Tool, detailed above,

to select text to strike out with this feature. The Strikeout Text tool is detailed here.

· Click the Delete Comments dropdown menu to view/select options for deleting comments:

· Click Delete Selected Comments to delete comments currently selected in the

document. Use the Select Comments  tool to select comments to delete with this

feature.

· Click Delete Visible Comments to delete all comments that are visible in the document.

Use the Show feature detailed below to determine which comments are shown/hidden.

Hidden comments are not deleted when the Delete Visible Comments feature is used.
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· Click Delete All Comments to delete all comments in the current document.

· Click Previous/Next to move to the previous/next comment.

· Click Comments List to show/hide the Comments  pane.

· Click the Show dropdown menu to determine which comments are shown/hidden in the current

document:

· Click Show All Comments to display all comments, in both the Comments pane and the

active document.

· Click Hide All Comments to hide all comments, in both the Comments pane and the

active document.

· Hover over By Type, By Author, Checked or By Status to determine the display status

of comments according to their type, author, checked/unchecked value in the Comments

pane, or status. A submenu will be displayed that details all available options for the

selected method. Select an option from the list as desired.

· Click Open/Close All Pop-ups to open/close all comment pop-ups.

· Click the Flatten Comments dropdown menu for options to flatten comments in the current

document. Comments are moved to the base content layer of documents when they are

flattened and can no longer be edited:

· Click Flatten Selected Comments to flatten the comments selected in the current

document. Use the Select Comments  tool to select comments to flatten with this

feature.

· Click Flatten Comments to flatten all comments from a user-specified page range in the

current document. This feature is detailed here.

358
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3.3.10.1 Spell Check

 Spell Check

Click Spell Check to launch the spell check feature:

Figure 1. Review Tab, Spell Check

The Spell Check pane will open:
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Figure 2. Spell Check Pane

Note that the default settings of the spell check include page text, comments and form fields. Clear the

text boxes to exclude elements from the spell check as desired. Click Spell Check Settings to

determine the settings for the spell check, as detailed below. Click Start to perform the spell check.

Words that are not contained in its dictionary will be underlined in the document and displayed one at

a time in the spell check pane:
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Figure 3. Active Spell Check

The Spell Check feature is correcting the word "X Change" in this example. 

· A list of potential candidates for the correct word is displayed. 

· Select the desired word from the list and click Replace to replace the word in the active

document with the word from the list. 

· Click Ignore to ignore the selected word and continue to the next misspelled word. 

· Click Ignore All to ignore all remaining instances of the selected word. 

· Click Add to add the selected word to the custom word list. The Spell Check feature includes

the words in the custom word list in its dictionary.

· Use the check boxes to determine which document elements are included in the spell-check

process.

· Press F7 to enable the spell check feature. F7 is also used to move to the next misspelled word

when moving through the results of spell checks. Press Alt+F7 to move to the previous

misspelled word.

Spell Checker Settings
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Figure 4. Spell Checker Settings Dialog Box

· Select/clear the check boxes to customize the spell check as desired.

· Select the check boxes of the languages that you want to spell check.

· Click Add Dictionary to add a new dictionary to the list of available options. Note that

dictionaries must be in the (*.oxt) format.

· Click Custom Word List to view/edit the list of custom words added by the user to the spell

checker feature.

Click OK to save settings.
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3.3.10.2 Compare Documents

 Compare Documents

Click Compare Documents to compare documents:

Figure 1. Review Tab, Compare Documents

The Compare Documents dialog box will open:
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Figure 2. Compare Documents Dialog Box

The current document is detailed in the left pane. Use the dropdown menu in the right pane to

determine the document to which you want to compare the current document, or click and drag the

document into the pane, then click OK to perform the document comparison. Select the Compare Text

Only box if you want to compare only text between the documents, and not text styles such as fonts,

colors and text size. When the document comparison is complete a new document tab will open with

the results: 
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Figure 3. Compare Documents Output

Browse through the output document to view replacements, insertions and deletions between the two

source documents. The Differences pane displays a breakdown of changes to text between the

documents. Use the options in the viewing window for further options:

· Click Old Document to view the initial document that was open in PDF-XChange Editor.

· Click New Document to view the document to which the initial document was compared.

· Click Previous Change to scroll backwards to the previous change between the documents.

· Click Next Change to scroll forward to the next change between the documents.

· Click the filter icon to determine which changes are displayed. The options are Text,

Formatting, Images, Annotations, Headers and Footers and Backgrounds.

· Click the Show dropdown menu to determine how results are displayed.

Please note that a license for PDF-XChange Editor Plus/PDF-XChange PRO is required in order to use

this feature in an unrestricted capacity.
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3.3.11 Accessibility

 Accessibility Tab

When the Accessibility tab is selected, the following options are available:

Figure 1. Accessibility Tab

The options in the Accessibility tab are used to view/edit document accessibility and utilize

accessibility features. These features are intended to make documents accessible to visually impaired

or otherwise disabled users. Documents must therefore meet a range of requirements and pass thirty-

two accessibility rules in order to be defined as 'accessible.' These requirements include:
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· Searchable text that ensures screen readers and other similar software can read and/or extract

the document text, as well as ensuring that users can select, edit and manipulate the text. If

documents contain scanned images of text that cannot be searched of selected, then those

documents will not meet accessibility requirements and may fail an accessibility check. It will

be necessary for OCR  to be performed on those documents in order to make the scanned

text searchable and selectable.

· Fonts that enable accurate character extraction in order to enable use of both the Read Out

Loud  feature and some screen readers, as well as saving text for braille embossers.

· Labeled form fields that have accessible error messages and no timing. These requirements

are intended for PDF documents that contain forms that users will fill out with information.

Form fields must be interactive in order to be accessible, and users must be able to enter

information into the forms. Forms must also provide identification, provide tips on how they

should be completed and prevent errors from being made. Form completion should not be

timed unless the user can request additional time.

· Document language and Title indication in order to enable screen readers to use the correct

speech synthesizer and language, and enable users to locate and identify the document.

· Security that does not interfere with assistive technology. The text of accessible PDFs must

be available to screen readers. Some PDF document authors restrict users from printing,

copying, extracting, editing or adding comments to the document. The security settings of

documents must not interfere with the ability of screen readers to convert the text to speech or

braille in order for the document to meet accessibility requirements.

· Document structure and reading order tags that enable screen readers and other text-to-

speech tools to present document content to users in a logical order.

· Alternate text descriptions for non-text elements that enables screen readers to provide an

explanation for document content that is not text-based.

There are two groups in the Accessibility tab:

Accessibility Check

The Accessibility Check group contains options for performing an accessibility check on the current

document, and to view associated accessibility check reports:

· Click Accessibility Check to perform an accessibility check on the current document. The

Accessibility Checker Options dialog box will open, as detailed in (figure 3) below.

· Click Accessibility Report to show/hide the Accessibility Report pane, which is used to view

the details of the accessibility report for the current document. This pane is detailed here.
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Edit

· Click Reading Order to determine the reading order of pages. Screen readers and other

assisting technologies use the reading order to determine the order in which page content

should be dictated to users. When this option is selected, click and drag to determine the first

item in the desired reading order of the page, then right-click and select the type of tag that

you want to apply to the item. It will then be designated as the first item in the reading order.

Repeat this process to create a complete reading order for the page. Further information on

determining the reading order of pages is available here.

· Click Set Alternate Text to add alternate text to items that have been tagged in the document

as figures. The Fix Figures Alternate Text dialog box will open:

Figure 2. Fix Figures Alternate Text Dialog Box

· Click to select figures and then enter the desired alternate text in the Alternate Text pane.

1078
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· Select the Decorative figure box to specify that the figure is a decorative image for which

alternate text is not required.

· Click Prev or Next to move to the previous/next figure.

Click OK to save changes.

Perform an Accessibility Check

Click Accessibility Check to perform an accessibility check on the current document:

Figure 3. Accessibility Tab, Accessibility Check Highlighted

The Accessibility Checker Options dialog box will open:
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Figure 4. Accessibility Checker Options Dialog Box

· The thirty-two accessibility checks/rules are detailed in the pane. The definitions for these rules

are available here.

· Select the boxes of the checks that you want to perform on the document.

· Select the Save accessibility report box to save a copy of the report to file, then specify the

folder in which you want to save the report.

· Select the Attach report to document box to attach a copy of the report to the current

document.

· Select the Show this dialog box when the Checker starts box to keep the Accessibility

Checker Options dialog box open when the check runs.

· Click Start Checking to start the accessibility check. The check will then run and the results will

be displayed in the Accessibility Checker  pane.

1083
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3.3.12 Bookmarks Tab

 Bookmarks Tab

When the Bookmarks tab is selected, the following options are available:

Figure 1. Bookmarks Tab

The options in the Bookmarks tab are used to create, modify and convert bookmarks. There are three

groups in the Bookmarks tab:

Create

The options in the Create group are used to create bookmarks:
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· Click From Page Text to create bookmark generators that create bookmarks from document

text, as detailed here.

· Click Bookmark Every Nth Page to create bookmarks from pages at user-defined intervals, as

detailed here.

· Click From Table of Contents to create bookmarks from the table of contents in the current

document, as detailed here.

· Click From Text File to create bookmarks from text-based files, as detailed here.

Modify

The options in the Modify group are used to modify existing bookmarks:

· Click Add Text to add prefixes/suffixes to bookmark titles, as detailed here.

· Click Change Case to change the case of bookmark titles, as detailed here.

· Click Change Zoom to change the zoom level of bookmarks, as detailed here.

· Click Named Dest. to Regular to convert named destinations to regular destinations, as

detailed here.

· Click Find and Replace to locate specified text in bookmarks and replace it with custom text, as

detailed here.

· Click Remove Actions to remove actions from bookmarks, as detailed here.

· Click Sort to sort bookmarks, as detailed here.

· Click Validate to validate the functionality of bookmarks, as detailed here.

· Click Merge Duplicate Bookmarks to merge bookmarks that have identical titles into single

bookmarks, as detailed here.

Convert

The options in the Convert group are used to convert bookmarks:
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· Click Build Table of Contents to create a table of contents from bookmarks, as detailed

here.

· Click Links from Bookmarks to create links in document text from bookmarks, as detailed

here.

· Click Sort Pages to sort pages by bookmarks, as detailed here.

· Click Convert to Named Destinations to convert bookmarks to named destinations, as

detailed here.

· Click Export to HTML to export a copy of the bookmarks' structure to an HTML file, as

detailed here.

· Click Export to Text File to export a copy of bookmarks to a text file, as detailed here.

Additionally, please note that several of the keyboard shortcuts relate to bookmarks. See here  for a

comprehensive list of available keyboard shortcuts. 
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3.3.12.1 Generate Bookmarks from Page Text

 Generate Bookmarks from Page Text

Click Generate Bookmarks from Page Text to create bookmark generators that create bookmarks

from document text:

Figure 1. Generate Bookmarks From Page Text Dialog Box

· Click Add to add a new bookmark generator. The dialog box displayed in (figure 4) will open.

· Click Edit to edit the selected bookmark generator.

· Click Remove to remove the selected bookmark generator.

· The Page Range options determine the pages included in the generation of bookmarks:

· Select All to specify all pages.

· Select Current to specify only the current page.
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· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

· Select the Ignore text that contains stop words box as desired. Text containing stop words

will be excluded from the bookmark generation process when this option is enabled. Click the

ellipsis button to view/edit the list of stop words.

· Select the Ignore consecutive duplicate bookmarks box to prevent the creation of

consecutive identical bookmarks.

· Click the Settings dropdown arrow to save/manage/delete bookmark generator settings:

Figure 2. Generate Bookmarks from Page Text Dialog Box, Save/Manage/Delete Options

· Click Save Current Settings to save the current settings as a profile for subsequent

use.

· Click Delete to delete the current profile.

· Click Manage to manage saved profiles. The Manage Presets dialog box will open:

1285
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Figure 3. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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Figure 4. Bookmark Generation Properties Dialog Box

The options selected in the Bookmark Generation Properties dialog box determine the text used to

generate bookmarks, and the style of the generated bookmarks:

Text Matching Options

These options determine text used in the generation of bookmarks according to font, size and color:

· Select the Font Names box to include text of specific fonts in the generation of bookmarks.

Click Add to add fonts to the list, Add Custom to add custom fonts, or Remove to remove

selected fonts.

· Select the Font Size box to include text of a specific size in the generation of bookmarks. Use

the number boxes to determine the Size, Tolerance and Units of text included in the

generation of bookmarks. The Tolerance value determines the degree to which selected text

can differ from the specified Font Size and remain included in the generation of bookmarks.

· Select the Text Color box to include text of of a specific color in the generation of bookmarks,

then select a color in the dropdown menu.
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· Click Get Style from Selected Text to determine the font settings detailed above according to

text currently selected in the active document. Use the Select Text tool in the Home  tab to

select text for this purpose.

· The option selected in the Match Text Case dropdown menu determines text used in the

generation of bookmarks according to text case:

· Select No Restrictions to include text of all cases in the generation of bookmarks.

· Select All Characters Are Capital to include only upper-case text in the generation of

bookmarks.

· Select First Character is Capital to include only text that starts with a capital letter in the

generation of bookmarks.

· Select First Character is Digit to include only text that starts with a digit in the

generation of bookmarks.

· Select the Allow multiline bookmark titles box to allow bookmark titles to exceed one line in

length. This is useful in cases where it is not possible to shorten bookmark titles.

· Select the Match Text Pattern box to specify a sequence of words that document text must

match in order to be included in the generation of bookmarks. Enter the desired text patten in

the text box. Note that it is possible to use ECMAScript regular expressions for this feature.

· Select the Match text case box to include only text that matches the case of the text entered in

the Match Text Pattern box. If this box is not selected then all matching text will be included

regardless of its case.

· Select the Limit bookmark titles to matching pattern only box to determine that only text

matching the specified pattern will be included in the generation of bookmarks.

Resulting Appearance

These options determine characteristics of generated bookmarks:

281
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Figure 5. Resulting Appearance Dialog Box

· Use the Text Color menu to determine the text color of bookmarks.

· Use the Text Style menu to determine the text style of bookmarks.

· Use the Zoom menu to determine the zoom level when bookmarks are clicked. Select Inherit

to use the current zoom level.

· Select the Show expanded box to expand all generated bookmarks.

Title Formatting

These options are used to format bookmark titles:
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Figure 6. Bookmark Generation Properties Dialog Box

· Select a Text Case option to determine the text case of generated bookmark titles.

· Select the Search and replace bookmark title with text patterns box to search for specific

text in bookmark titles and replace it with customized text:

· Enter the text to be replaced in the Search Pattern text box.

· Enter the replacement text in the Replace Pattern text box.

· Select the Match text case box as desired.

· Select the Insert text before each title box to add text before bookmark titles. Enter the

desired text in the text box.

· Select the Add text after each title box to add text after bookmark titles. Enter the desired

text in the text box.

· The Leading Numbers dropdown menu is used to add/remove/retain leading numbers for

bookmarks. Select No Change, Add or Remove as desired. If leading numbers are being

added then use the Use dropdown menu to select Numbers, Letters or Roman Numerals.

· Use the Maximum Title Length text box to set the maximum number of characters for

generated bookmarks.

· Select the Remove duplicate spaces box to remove instances of adjacent blank characters.
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· Select the Replace line breaks with spaces box to use spaces instead of line breaks for

bookmarks.

Click OK to generate bookmarks.
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3.3.12.2 Bookmark Every Nth Page

 Bookmark Every Nth Page

Click Bookmark Every Nth Page to create bookmarks from pages at user-defined intervals:

Figure 1. Bookmark Every N-th Page Dialog Box

· Enter a figure in the number box to determine the interval at which bookmarks are created. For

example, if 2 is entered then a bookmark will be created from every second document page.

· Enter a value for the Bookmark title template as desired. This value determines the template

for bookmark titles. Click the blue icon to add macros.  The default value is 'Page %[Page]',

which will result in the bookmark titles 'Page 1', 'Page 2', 'Page 3' etc.

· The page range options for bookmark generation are as follows:

· Select All to specify all pages.

· Select Current to specify only the current page.

· Select Custom to specify a custom page range, then enter the desired page range in

the adjacent number box. Further information about how to specify custom page

ranges is available here.

· Use the Subset options to specify a subset of selected pages. Select All, Odd or Even

as desired.

1166
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Click OK to create bookmarks.
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3.3.12.3 Generate Bookmarks from Table of Contents

 Generate Bookmarks from Table of Contents

Click Generate Bookmarks from Table of Contents to create bookmarks from an existing table of

contents. Please note that the table of contents must first be selected using the Select Text Tool for

this feature to be available. When it is selected, the following dialog box will open:

Figure 1. Bookmark Table of Contents Dialog Box

· Select check boxes to enable/disable parameters. 

· Use the Choose separator type dropdown menu to select a separator for bookmarks.

· Use the Page Offset box to set a page offset as desired.

· Click Change Offsets to adjust top and/or bottom offsets.

Click OK to generate bookmarks.
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3.3.12.4 Generate Bookmarks from Text File

 Generate Bookmarks from Text File

Click Generate Bookmarks from Text File to create bookmarks from a text file: 

Figure 1. Generate Bookmarks From Text File Dialog Box

· Enter the name of the source text file in the File Name text box. Alternatively, click the ellipsis

icon to select a file from the local computer. (Please note that the file used must be plain text

(*.txt) format).

· Use the Field Delimiter box to determine the field delimiter as required. PDF-XChange Editor

will use the delimiter to define bookmarks in the source file. 

Click OK to generate bookmarks.

Please note that the format of source files for this feature must be the same as that of files created

using the Export Bookmarks to Text File  feature.

Example

The following file can be used to create bookmarks in documents:

1031
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Figure 2. Example Bookmarks Text File

When this file is selected for use in conjunction with the Generate Bookmarks from Text File feature,

bookmarks are created as detailed below:
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Figure 3. Bookmarks Created from Text File
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3.3.12.5 Add Text to Bookmark Titles

 Add Text to Bookmark Titles

Click Add Text to Bookmark Titles to add text to bookmark titles:

Figure 1. Add Text to Bookmark Title Dialog Box

· Use the Add Prefix/Suffix text boxes to add prefixes/suffixes to bookmark titles. Click the icon

to add macros.  

· Select the Remove excess spaces from original Bookmark Title box to remove additional

spaces from bookmark titles.

1166
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· Select either All Bookmarks or Selected Bookmarks in the Use Bookmarks dropdown menu

to determine which bookmarks are updated. Select bookmarks in the Bookmarks  pane in

order to use the Selected Bookmarks option.

· Select the Process all bookmark levels box to process all bookmark levels. Alternatively, clear

the box and select a customized level. The number entered in the number box determines the

level of bookmarks that are processed. Select the Include all sub-levels box to include all

bookmark levels.

Click OK to add text to bookmarks.

345
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3.3.12.6 Change Bookmark Case

 Change Bookmark Case

Click Change Bookmark Case to edit the case of bookmark text:

Figure 1. Change Bookmark Case Dialog Box
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· Select either All Bookmarks or Selected Bookmarks in the Use Bookmarks dropdown menu

to determine which bookmarks are updated. Select bookmarks in the Bookmarks  pane in

order to use the Selected Bookmarks option.

· Select the Include all sub-bookmarks box to include sub-bookmarks. 

· Select an option from the Select Text Case option buttons to determine the new case for

bookmark text.

· Select the Enter a custom list of words that will not be processed box to create/edit the list

of words excluded from the process. Use the Add, Edit and Remove buttons to add, edit and

remove words.

Click OK to update bookmark text.

345
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3.3.12.7 Change Bookmarks Zoom Factor

 Change Bookmarks Zoom Factor

Click Change Bookmarks Zoom Factor to edit the zoom factor of document bookmarks:

Figure 1. Set Bookmark Zoom Type Dialog Box

· Select an option in the Zoom dropdown menu to determine the new zoom level for

bookmarks.

· Select the Change Named Destinations used in Bookmarks box to include named

destinations in the operation.

· Select the Change GoToR actions' zoom level box to include links to other documents in the

operation.

· Select the Change GoToE actions' zoom level box to include links to embedded documents in

the operation.

Click OK to update the bookmark zoom settings.
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3.3.12.8 Convert Named Destinations to Regular Destinations

 Convert Named Destinations to Regular Destinations

Click Convert Named Destinations to Regular Destinations to convert named destinations into

regular destinations. Named destinations are user-defined locations in documents that are created

using the current view of the document at the time of their creation. They can be used in conjunction

with Bookmarks,  Go To Page  actions and the /Open  command line. Existing named

destinations can be viewed in the Named Destinations pane.  This feature converts named

destinations into regular destinations, which means a different set of data is referenced to link to the

destination. Named destinations use the current view at the time of their creation, whereas regular

destinations use page numbers, page coordinates and either zoom level or a custom-sized rectangle.

This means that regular destinations are not affected when document pages are moved or deleted,

which is their main benefit in comparison to named destinations. When this feature is selected the

following dialog box will open:

Figure 1. Convert Named Destinations To Regular Destinations Dialog Box

· Select either All Bookmarks or Selected Bookmarks in the Use Bookmarks dropdown menu

to determine which bookmarks are updated. Select bookmarks in the Bookmarks  pane in

order to use the Selected Bookmarks option.

345 309 1124
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· Select the Include all sub-bookmarks and Remove converted named destinations from

document boxes as desired.

Click OK to convert named destinations to regular destinations.
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3.3.12.9 Find and Replace Bookmark Text

 Find and Replace Bookmark Text

Click Find and Replace Bookmark Text to locate and replace text in bookmark titles:

Figure 1. Find And Replace Bookmark Text Dialog Box

· Enter the terms to be replaced in the Find what text box.

· Enter the replacement terms in the Replace with text box.

· Select the Match case, Match whole word and Use regular expressions boxes as desired.

Further information on regular expressions is available here. You can use ECMAScript regular

expressions in conjunction with this feature.

· Select either All Bookmarks or Selected Bookmarks in the Use Bookmarks dropdown menu

to determine which bookmarks are updated. Select bookmarks in the Bookmarks  pane in

order to use the Selected Bookmarks option.

· Select the Include all sub-bookmarks box as desired. 

345
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Click OK to find and replace bookmark text.
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3.3.12.10 Remove Actions from Bookmarks

 Remove Actions from Bookmarks

Click Remove Actions to remove actions from bookmarks:
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Figure 1. Remove Actions Dialog Box

· Use the dropdown menu to determine the bookmarks from which actions are removed.

· Select the Include all sub-bookmarks box to include sub-bookmarks.

· Select the Remove bookmarks that match selected action criteria box to remove bookmarks

that match the criteria specified in the Select Actions pane when the Remove Actions

command is executed.

· Select the Do not remove sub-bookmarks while removing matched ones box to retain sub-

bookmarks in cases where parent bookmarks are removed.

· Use the Select Actions pane to determine which actions are removed from bookmarks.

· Click Select All/Deselect All to select/deselect all bookmark actions.

· Click Invert Selection to invert the current selection of actions.
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Click OK to remove actions from bookmarks.
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3.3.12.11 Sort Bookmarks

 Sort Bookmarks

Click Sort Bookmarks to sort existing document bookmarks:

Figure 1. Sort Bookmarks Dialog Box

· Select either Sort bookmarks by referencing page number or Sort bookmarks

alphabetically as desired.

· Select an option in the Use Bookmarks dropdown menu to determine the bookmarks to be

sorted:

· Select All bookmarks to sort all bookmarks.

· Select Children of selected to sort child bookmarks of the bookmark currently selected.

· Select Bookmark level to sort a level of bookmarks, then use the Level to sort number

box to specify the level.

· Select the Ignore text case box to ignore the text case when the sorting bookmarks

alphabetically.
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· Use the Sorting type dropdown menu to select either Ascending or Descending as the sort

mode for bookmarks.

Click OK to sort bookmarks.
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3.3.12.12 Validate Bookmarks

 Validate Bookmarks

Click Validate Bookmarks to determine the validity of bookmarks. The Validate Bookmarks dialog

box will open, which contains a list of bookmark elements that can be validated:

Figure 1. Validate Bookmarks Dialog Box
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· Select boxes as desired to determine the elements of bookmarks to be validated.

· Click Validate to validate bookmarks. Bookmarks that fail validation are displayed in the pane.

Select bookmarks in the pane and then click Rename, Edit or Remove as desired. If the option

to edit bookmarks is selected then the Action List will be displayed for the bookmark. Use this

list to determine the actions that take place when bookmarks are clicked. Note that the

Bookmarks  pane can also be used to view/edit the Action List for bookmarks. Right-click

bookmarks in the pane and then click Properties to view bookmark properties. The Bookmark

Properties pane will open. Existing bookmark actions are detailed in the Actions property:

Figure 2. Bookmark Properties Pane, Action Tab

Click the ellipsis icon on the right of the tab to edit bookmark actions. Further information on

adding/editing actions is available here.

345
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3.3.12.13 Merge Duplicate Bookmarks

 Merge Duplicate Bookmarks

Click Merge Duplicate Bookmarks to merge bookmarks that have identical titles into single

bookmarks. The Merge Duplicate Bookmarks dialog box will open:

Figure 1. Merge Duplicate Bookmarks Dialog Box

· Use the Examine dropdown menu to specify either All Bookmarks or Selected Bookmarks to

be examined in order to identify duplicate bookmarks to merge.

· Select the Include all sub-bookmarks box to include sub-bookmarks in the search.

· Select the Ignore text case and/or Ignore consecutive spaces box to ignore text cases and

consecutive spaces in bookmarks when PDF-XChange Editor examines bookmarks to merge.

· Use the Resulting title dropdown menu to specify which bookmark title is used to create the

name for merged bookmarks.

· Use the Resulting action list dropdown menu to specify which action list is used for merged

bookmarks.

Click OK to merge duplicate bookmarks.
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3.3.12.14 Build Table of Contents

 Build Table of Contents

Click Build Table of Contents to create a table of contents from the current document bookmarks:

Figure 1. Build Table of Contents Dialog Box

· Enter a title for the table of contents in the Title text box.
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· Click Change Title Format to edit the font and style of the title.

· The style for each level in the table of contents is detailed in the pane on the left. The levels

correspond to the levels of the bookmark tree. Click Add, Edit or Remove to add, edit or

remove levels.

· Use the Insert TOC before page number box to set the location of the table of contents, or

select the As last page box to insert it at the end of the document.

· Select an option button to determine the page size of the table of contents:

· Document uses the same page size as the pages of the source document.

· Standard contains a list of standard page sizes, such as those used by the ISO and ANSI.

Select an option from the list and then select Portrait or Landscape as desired in the

dropdown menu on the right.

· Custom uses custom page dimensions. Enter the desired dimensions in the number boxes

and select a unit of measurement from the dropdown menu.

· Use the Page Margins number boxes to determine the page margins used for the table of

contents.

· Select the Use all bookmark levels to include all bookmark levels in the creation of the table

of contents. Alternatively clear the box and use the number boxes to determine the first and

last bookmark levels to be included.

· Select the Skip invalid bookmarks box to exclude invalid bookmarks from the table of

contents.

· Select the Remove consecutive spaces from bookmark titles box to rectify instances of

consecutive white spaces.

· Select an option from the Output page numbers as dropdown menu to determine the format

of page numbers in the table of contents:

· Original Page Numbers uses the page number of pages.

· Page Labels uses the page labels of pages. These labels are detailed in the

Thumbnails  pane for pages.

· Bates Numbers uses the Bates number of pages.

· Select an option from the Style menu to determine the style of the table of contents.

· Select an option in the Line Spacing dropdown menu to determine the line spacing used.

· Select an option in the Level Indent dropdown menu to determine the level indentation used.

· Click the Settings dropdown arrow to save/manage/delete custom settings:

· Click Save Current Settings to save the current settings as a profile for

subsequent use.

· Click Delete to delete selected profiles. Note that this option is only available

for customized profiles.

· Click Manage to manage preset/customized profiles. The Manage Presets

dialog box will open:

351
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Figure 2. Manage Presets Dialog Box

· Click Edit to edit selected profiles. Note that this option is only available

for customized profiles.

· Click Clone to clone selected profiles. This option can be used to

customize the settings of preset profiles, which cannot be customized in

the default state.

· Use the up and down arrows to move selected profiles up or down in

the list.

· Click Delete to delete selected profiles. Note that this option is only

available for customized profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.

Click Build to create the table of contents.
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3.3.12.15 Create Links from Bookmarks

 Create Links from Bookmarks

Click Create Links from Bookmarks to create links in document text from bookmarks:

Figure 1. Create Links from Bookmarks Dialog Box
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· Use the Use Bookmarks dropdown menu to determine the bookmarks used to create links.

· Select the Include all sub-bookmarks box to include sub-bookmarks.

· Use the Page Range options to determine the page range from which links are created. Further

information about page range specification is available here.

· Use the Text Style options as necessary in order to specify the size and style options of

document text that you want to convert to links. These options are included in order to make it

possible to distinguish between several instances of the same text within documents. If there is

only a single instance of the text then it is not necessary to use these options.

· Use the Link Style options to determine the style of links.

· Select boxes in the Options section to enable/disable options for creating links.

Click OK to create links from bookmarks.

1285
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3.3.12.16 Sort Pages by Bookmarks

 Sort Pages by Bookmarks

Click Sort Pages by Bookmarks to sort document pages according to the order of bookmarks:

Figure 1. Bookmarks Tab, Sort Pages by Bookmarks Highlighted

PDF-XChange Editor will then reorder document pages to match the order of bookmarks.
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3.3.12.17 Convert to Named Destinations

 Convert to Named Destinations

Click Convert to Named Destinations to convert regular bookmark destinations into named

destinations. Regular bookmark destinations reference a page number, page coordinates and either a

zoom level or a custom-sized rectangle when they are used. Named destinations are user-defined

locations in documents that are created using the current view of the document at the time of their

creation. They can be used in conjunction with Bookmarks,  Go To Page  actions and

the /Open  command line. This feature converts regular destinations into named destinations, which

means the associated bookmark will reference the same page view after pages are moved/reordered,

which is their main benefit in comparison to regular destinations. When this feature is selected the

following dialog box will open:

Figure 1. Convert to Named Destinations Dialog Box

· Enter a name for the new named destination in the Named Destination Title box. The default

value is %[Title], which means the name of the associated bookmark is used. Click the blue

icon to add macros  as desired.

345 309

1124

1166



1029

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Select either All Bookmarks or Selected Bookmarks in the Use Bookmarks dropdown menu

to determine which bookmarks are updated. Select bookmarks in the Bookmarks  pane in

order to use the Selected Bookmarks option.

· Select the Include all sub-bookmarks box as desired.

Click OK to convert regular destinations to named destinations. Note that named destinations can be

viewed in the Named Destinations  pane.

345
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3.3.12.18 Export Bookmarks to HTML

 Export Bookmarks to HTML

Click Export Bookmarks to HTML to export document bookmarks to an HTML file: 

Figure 1. Bookmarks Tab, Export to HTML

The Save File dialog box will open. Enter the desired name for the file in the file Name text box and

click Save to export the file.
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3.3.12.19 Export Bookmarks to Text File

 Export Bookmarks to Text File

Click Export Bookmarks to Text File to export bookmarks to a (*.txt) text file:

Figure 1. Export Bookmarks to Text File Dialog Box, General Tab Selected

Select the General tab to determine general export options:

· Select the Export all option button to export all bookmarks.

· Select the Export selected bookmarks option button to to export only selected bookmarks.

Select bookmarks in the Bookmarks  pane to use this option. Select the Include all sub-

bookmarks box as desired.

345
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· Select the Export bookmarks that perform hyperlink actions option button to export only

bookmarks that perform hyperlink actions. Use the dropdown menu to determine which

bookmarks are included in the process.

· Select the Use PDF-document filename to save results option button to use the name of the

current document as the name of the text file.

· Alternatively, enter a name in the Filename text box. Use the Folder text box to determine the

destination folder, or click the icon to select the folder manually.

· Select the Overwrite existing files box to overwrite files that have the same name in the

destination folder.

· Select the Open containing folder box to open the containing folder at the end of the

operation.

Select the Bookmark Properties tab to determine which bookmark properties are exported:

Figure 2. Export Bookmarks to Text File Dialog Box, Bookmark Properties Tab Selected

· Select the Export bookmark actions box to include bookmark actions in the export.

· Select the Export Page that bookmark points to box to include the page number of

bookmark links.

· Select the Resolve named destinations to page numbers box to display named destinations

as page numbers in the created text file. If this box is not selected then the name of the named
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destination will be exported instead. Further information on named destinations is available

here.

· Select the Export detailed destination description box to export a more detailed description

of named destinations.

· Select the Export Web Links box to include weblinks in the export file.

· Select the Export 'Open File' actions description to include a description of 'Open File'

actions in the export file. These actions open files when bookmarks are clicked. Further

information on bookmark actions is available here.

· Select the Export 'Remote Go-to' actions description box to include a description of 'Go-To'

actions in the export file. These actions navigate to a document page when bookmarks are

clicked. Document pages can be located in the current document, a different document or an

embedded document. Further information on bookmark actions is available here.

· Select the Export JavaScript actions code box to include bookmark JavaScript actions in the

export file. These actions execute JavaScript when bookmarks are clicked. Further information

on bookmark actions is available here.  

· Select the Export Bookmark text style and color properties box as desired.

· Select the Export bookmark tree's "contracted" state box to export bookmarks in collapsed

format.

· Use the Properties delimiter box to set the delimiter that separates bookmark properties in

the text file.

· Select the Do not escape service symbols box as desired. If the files that the Export

Bookmarks to Text Files feature creates will be used in conjunction with the Generate

Bookmarks from Text File feature then it is advisable to select this box.

Click OK to export bookmarks to text file.

393
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3.3.13 Help Tab

 Help Tab

When the Help tab is selected, the following options are available:

Figure 1. Help Tab

The options in the Help tab are used to customize PDF-XChange Editor and access help and other

options associated with the software. There are three groups in the Help tab:

UI Options

The options in the UI Options group are used to customize the layout and content of the user interface:
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· Click Customize Theme to customize the fonts, colors and backgrounds used in the user

interface, as detailed here.

· Click Customize Toolbars to customize the content, display and interactive options of the

toolbars in PDF-XChange Editor, as detailed here.

Help

The options in the Help group are used to access assistance when using PDF-XChange Editor:

· Click Contents (or press F1) to access the online manual.

· Click Support to launch the PDF-XChange Editor support forum.

· Click Report to reports bugs and other issues with the software, as detailed here.

· Click Command Line Help to view command line options for the software.

Product

The options in the Product tab contain further options for PDF-XChange Editor:

· Click Check for Updates to check for updates to the PDF-XChange family of products.

· Click About to view further details about PDF-XChange Editor.

· Click File Associations to view/edit file associations for PDF-XChange Editor, as detailed

here.

· Click Purchase Now to purchase a license for the software.

218
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· Click License Key to view/edit/add license keys, as detailed here.

· Click Home Page to launch the PDF-XChange Editor page of the PDF-XChange website. 

208
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3.3.13.1 Customize Toolbars

 Customize Toolbars

Click Customize Toolbars to customize the ribbon tabs and their settings in PDF-XChange Editor:

Figure 1. Help Tab, Customize Toolbars

 The Customize Toolbars dialog box will open:
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Figure 2. Customize Toolbars Dialog Box, Toolbars Tab

Use the options in the Toolbars tab to determine the ribbon tabs that are visible in the user interface

and the commands that they contain, and Rename/Reset/Delete selected toolbars/ribbon tabs. Note

that the Reset Settings  feature can be used to revert to the default settings and layout of PDF-

XChange Editor at any time.

The tabs in the ribbon (with the exception of the File tab) each have a corresponding box in the

Customize Toolbars dialog box. Select/clear the boxes in the dialog box to show/hide the

corresponding tab:

276
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Figure 3. Customize Toolbars Dialog Box, Ribbon Tabs and Check Boxes Highlighted

Expand the boxes to view a breakdown of the groups that the associated ribbon contains, then

select/clear boxes to show/hide the corresponding group in the ribbon tab:
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Figure 4. Customize Toolbars Dialog Box, Ribbon Groups and Check Boxes Highlighted

Note that it is also possible to right-click ribbon tabs in order to perform these operations:
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Figure 5. Ribbon Tab Right-Click Submenu Options

Additional options are available when the Customize Toolbars dialog box is open and ribbon items

are right-clicked:



1042

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 6. Shortcut Menu for Ribbon Items

· Click Delete to remove the selected item from the ribbon.

· Click Show Icon to show/hide the icon of the selected item.

· Click Show Text to show/hide the text for the selected item.

· Click Insert Separator Before/After to insert an item separator before/after the selected item.

Separators are used to define areas in which ribbon items can be placed.

· Click Reset Toolbar to reset the selected ribbon group.

· Click Properties to view/edit the properties of the selected item. Please note that properties

are read-only, except for those that relate to the keyboard shortcut for the item. The process of

creating/editing keyboard shortcuts is detailed here.

Other Main Toolbars and Document Toolbars

Select/clear the boxes in the Other Main Toolbars and Document Toolbars sections to show/hide the

associated toolbars in the user interface:

1162
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Figure 7. Customize Toolbars Dialog Box, Other Main Toolbars and Document Toolbars Options

Quick Access, Quick Find and Quick Launch Toolbars

These toolbars are located in the upper section of the user interface:
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Figure 8. Quick Access, Quick Launch and Quick Find Toolbars

· Click  Undo to undo the most recent editing action.

· Click  Redo to reverse the most recent undo action.

· Click  Find to activate the Find  function and locate specified text in the active

document.

· Click  Search to open the Search  pane and search documents open in PDF-

XChange Editor or folders on the local computer.

· Click  Full Screen Mode to view the active document in full screen mode.

· Click  UI Options to toggle between the options for the display of the user

interface:

Figure 9. UI Options

· Click Switch to Classic Toolbars to switch to the classic toolbars layout of PDF-

XChange Editor. The manual for this layout is available here.

1147
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· Click Switch to Touch-optimized UI to switch from Mouse-optimized UI to

Touch-Optimized UI and vice versa. The Touch-optimized UI features larger

icons and is intended for use in conjunction with tablets, smartphones and

similar devices.

· Click Customize Toolbars to customize the layout of toolbars, the commands

that they contain and their display/locking options.

Document Options Toolbar

The Document Options Toolbar is located in the lower left corner of the user interface:

Figure 10. Document Options Toolbar

Click the dropdown arrow to access the options detailed in the submenu below:
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Figure 11. Document Options Menu

· Click Bookmarks to open the Bookmarks pane. See here  for further information.

· Click Thumbnails to open the Thumbnails pane. See here  for further information.

· Click Comments to open the Comments pane. See here  for further information. 

· Click Attachments to open the Attachments pane. See here  for further

information.

· Click Fields to open the Fields pane. See here  for further information.  
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· Click Signatures to open the Signatures pane. See here  for further information.

· Click Layers to open the Layers pane. See here  for further information.

· Click Content to open the Content pane. See here  for further information.

· Click Destinations to open the Destinations pane. See here  for further

information.

· Click 3D Model Tree pane to open the 3D Model Tree pane. See here  for further

information.

· Click Links to open the Links pane. See here  for further information.

· Click Tags to open the Tags pane. See here  for further information.

· Click Order to open the Order pane. See here  for further information.

· Click Accessibility Checker to open the Accessibility Checker pane. See here  for

further information.

· Click Accessibility Report to open the Accessibility Report pane. See here  for

further information.

· Click History to open the History pane. See here  for further information.

· Click Spell Check to check the spelling of the active document. See here  for further

information.

· Click Properties Pane to open the Properties pane. See here  for further

information.

· Click Show Rulers to view/hide the document rulers. See here  for further

information.

· Click Show Grid to insert a grid behind the active document to assist in the accurate

placement of document content. See here  for further information.

· Click Show Page Size/Position to view/hide the Page Measurement information.

· Hover over Snap to view options for snapping:

· Click Enable Snapping to enable/disable snapping.

· Click Snap to Grid to enable/disable snapping to grids.

· Click Snap to Guides to enable/disable snapping to guides.

· Click Snap to Objects to enable/disable snapping to objects.

· Click Snap Options to customize options for snapping, as detailed here.

· Click Find to launch the find text function. See here  for further information.

· Click Document Properties to launch the Document Properties dialog box. See

here  for further information.

Launch Application Toolbar

The Launch Application Toolbar is located on the lower-right corner of the main window:
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Figure 12. Launch Application Toolbar

This toolbar provides a convenient way to open active documents using third party

applications. See here  for instructions on how to add applications to this toolbar.

Page Layout Toolbar

The Page Layout Toolbar is located on the lower right side of the main window:

235
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Figure 13. Page Layout Toolbar

· The page layout options determine how pages of active documents are displayed in

the main window. The layouts correspond to those displayed in the icons of the

toolbar: 

· Single Page displays documents a single whole page at a time. 

· Continuous displays documents as single pages continuously, which means

consecutive pages can be viewed at the same time when scrolling. 

· Two Pages displays documents two whole pages at a time. Pages are placed

adjacently in the main window.

· Two Pages Continuous displays documents as two pages continuously, which

means consecutive pairs of pages can be viewed at the same time when

scrolling.

Further options relating to the page display are available here.

Page Navigation Toolbar

The Page Navigation Toolbar is located at the bottom of the main window:

202
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Figure 14. Page Navigation Toolbar

· Click the blue arrow icons to move to the first page, previous page, next page or last

page of documents.

· Click the green arrow icons to move between the most recent document views.

· The number box at the center of the Page Navigation toolbar shows the current page

and the total number of pages in the active document. Enter a page number and press

Enter to move to it.

Page Zoom Toolbar

The Page Zoom Toolbar is located in the lower-right section of the main window:
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Figure 15. Page Zoom Toolbar

The Page Zoom Toolbar is used to zoom in on/out from the active document:

· Use the options in the dropdown menu to select a predefined zoom level.

· Clear the number box, then enter a custom zoom level and press Enter to zoom to a

custom level.

· Click the plus and minus icons on either side of the zoom slider to move between

predefined zoom levels.

· Click and drag the slider to move to a custom zoom level.

Reposition Toolbars

When the Customize Toolbars option is enabled in the PDF-XChange Editor user interface, you can

reposition toolbars as desired in the main window of the application. Simply click and drag the grid of

dots on the right side of toolbars to perform this operation:
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Figure 16. Customize Toolbars, Grid of Dots Highlighted for Page Display Toolbar

When you drag the toolbar around the user interface, the blue box that represents it will change shape

when it is hovered over a compatible docking location:
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Figure 17. Customize Toolbars, Page Display Toolbar Hovered over Compatible Docking Location

Release the mouse to add the toolbar to the new location:
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Figure 18. Customize Toolbars, Page Display Toolbar Docked on Left Side

Create New Toolbars

Follow the steps below to create new toolbars:

1. Click the New dropdown menu, then click New Toolbar:
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Figure 19. Customize Toolbars Dialog Box, New Toolbar

The New Toolbar dialog box will open.

2. Enter the title for the new toolbar, then click OK.

A new empty toolbar will then display in the upper-left section of the main window in the user

interface.

3. Click the Commands tab in the Customize Toolbars dialog box, then click and drag the

desired commands from the commands pane into the new toolbar:
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Figure 20. Customize Toolbars Dialog Box, Commands Tab. New Toolbar in Main Window

4. When all desired commands have been added to the new toolbar, click and drag it to the

desired location in the user interface. New toolbars can be docked between ribbon groups or at

the bottom of the user interface. The pointer will indicate that new toolbars can be docked when

they are hovered over compatible areas of the user interface:
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Figure 21. Example Toolbar Docking Points Highlighted

Release the mouse to dock the new toolbar at the desired location:
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Figure 22. New Toolbar Docked

Create New Ribbon Tabs

Follow the steps below to create a new ribbon tab:

1. Click the New dropdown menu, then click New Ribbon Tab:
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Figure 23. Customize Toolbars Dialog Box, New Ribbon Tab

The New Ribbon Tab dialog box will open.

2. Enter a name for the new ribbon tab, then click OK.

The new ribbon will be displayed in the user interface:
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Figure 24. New Ribbon Created

3. Click the new ribbon, then click and drag commands from the Commands tab of the

Customize Toolbars dialog box to add them to the ribbon:
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.
Figure 25. Commands Added to New Ribbon

Click and drag commands to reposition them in the ribbon, or to add multiple commands to the same

ribbon group. Customized ribbon tabs can be edited in the same manner as default ribbon tabs, as

detailed above.

Commands Tab

All the available commands in PDF-XChange Editor are contained in the Commands tab of the

Customize Toolbars dialog box:
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Figure 26. Customize Toolbars Dialog Box, Commands Tab

· Use the Categories menu to determine the group of commands displayed in the viewing pane. 

· Use the Commands text box to search for commands.

· Click and drag commands to the desired toolbar/submenu in the main window of PDF-

XChange Editor.

· Click Properties to view/edit the properties/tooltip/keyboard shortcuts and other variables for

selected commands.

· Click Export to CSV to export a list of all available commands to a comma-separated-values

file.

· Please note that customized comment styles are available in the Custom Comment Styles

category. Options for customizing comment styles are detailed here.

Options Tab

Click the Options tab to enable/disable toolbar options:

644
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Figure 27. Customize Toolbar Options
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3.3.13.2 Report a Problem

 Report a Problem

Click Report to report bugs and other issues with PDF-XChange Editor to PDF-XChange:

Figure 1. Help Tab, Report

The Report a Problem dialog box will open:
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Figure 2. Report a Problem Dialog Box

Select the check boxes to determine the information included in the report. If you want to review the

information then click Report to Clipboard to copy the report to your clipboard. When you have

selected all the required check boxes, click Next to open the bug report webform, then fill out the form

and send it to PDF-XChange for review.
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3.3.14 Format Tab

 Format Tab

The Format tab is used to edit content and comment and form field styles in PDF-XChange Editor:

Figure 1. Format Tab

The options available in the Format tab depend on the format of selected content in documents:

· The options available when editing page content are detailed here.

· The options available when editing comments are detailed in the Comment  section of the

manual.

1087
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· The options available when editing form fields are detailed in the Form  section of the

manual.

676
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3.3.15 Arrange Tab

 Arrange Tab

The Arrange tab is used to arrange selected content in PDF-XChange Editor. It is enabled when

comments, form fields or content items are selected:

Figure 1. Arrange Tab

Please note that some of the options in the Arrange tab are only available when multiple items are

selected. There are five groups in the Arrange tab and the commands in each group can be used to

edit selected content items in different ways:
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Alignment

The options in the Alignment tab are used to align selected content items. Note that the first content

item to be added to documents is used as the point from which all other content items are aligned:

· Click Left, Center, Right, Top, Middle or Bottom to align all content items to these locations

as desired.

· Click the Align to Selection dropdown menu to specify the to alignment of selected items to

Selection Bounds, Key Object or Page as desired.

Distribute

The options in the Distribute tab are used to distribute content items. Note that the first content item

to be added to documents is used as the point from which all other content items are distributed:

Click Horizontally/Vertically to distribute selected content items horizontally/vertically

Size

The options in the Size group are used to resize selected content items. Note that the first content item

to be added to documents is used as the point from which all other content items are resized:

Click Same Size/Width/Height to make all content items the same size/width/height
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Rotate

The options in the Rotate group are used to rotate selected content items:

Click Rotate 90° CCW, Rotate 90° CW or Rotate 180° as desired. Please note that these commands

are not available for form fields.

Z-Order

The options in the Z-Order group determine the Z-Order of selected content items:

· Click Bring Forward to bring the selected item up a step in cases where multiple items overlap.

· Click Send Backward to send the selected item back a step in cases where multiple items

overlap.

· Click Bring to Front to bring the selected item to the top in cases where multiple items

overlap.

· Click Send to Back to send the selected item to the back in cases where multiple items overlap.

Transform

The options in the Transform group are used to view/adjust the size and page location of selected

content:

https://en.wikipedia.org/wiki/Z-order
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· Click the boxes in the grid to view the current location of the corresponding points of the

selected content.

· Use the X and Y number boxes to determine the new positioning of the selected content. The X

value is the horizontal plane and the Y value is the vertical plane. 

· Use the Width and Height boxes to adjust the size of the selected content.

· Click Transform to transform the location, size and/or rotation of selected content, as detailed

here. 291
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3.3.16 Portfolio Tab

 Portfolio

PDF portfolio files are a unique format of PDF file in which multiple files are assembled into an

integrated PDF unit. The Portfolio settings detailed below are for PDF portfolio files and are only

available when these files are open in PDF-XChange Editor:

Figure 1. Portfolio Submenu

· Click Navigator Layout View to display the content of portfolio files in their expanded format,

or Navigator Details View to display the content of portfolio files in list format.

· Click Show Cover Sheet to show/hide the portfolio cover sheet.

· Click Portfolio Tools, or click the Portfolio tab, to move to the Portfolio tab:
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Figure 2. Portfolio Tab

· Click Layout/Details to switch between layout view and details view for the files that the

portfolio file contains, as detailed above

· Click Cover Sheet to display the cover sheet of the portfolio file.

· Click Preview Pane to set the location of the preview pane as Auto, Right or Bottom (in the

PDF-XChange Editor window), or select Off to disable the preview pane.

· Click Open, or double-click documents in the list of documents in the portfolio file, to open

documents in the default application for their file format.

· Click Info to view the file properties of selected files in the list of files within the portfolio file.

· Click Extract to extract selected files from the portfolio file.

· Click Delete to delete selected files from the portfolio file.

· Click Add Files/Folder to add files/folders to the portfolio file.

· Click Create Folder to add a new folder to the portfolio file. You can click and drag documents

in the portfolio file into new folders as desired.

· Click Print to print portfolio files, as detailed here.

If the portfolio file contains PDF documents, then you can use the editing options in the preview pane,

or the main tabs of PDF-XChange Editor, to edit the PDF documents:

158
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Figure 3. Document Edited via the Preview Pane

Right click the main window for additional options:



1075

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 4. Portfolio File Right-Click Submenu

· Click Open to open documents in the default application for their file format.

· Click Extract to extract selected files from the portfolio file.

· Click Add Files/Folder to add files/folders to the portfolio file.

· Click Create Folder to add a new folder to the portfolio file.

· Click Delete to delete selected files from the portfolio file.

· Click Sort by to determine the criteria used to sort the component files of portfolio files.

· Click View to determine the file information that is displayed in the file list of the main window

when portfolio files are open.

· Click Select All/Deselect All to select/deselect all files in portfolio files.

· Click Default document to specify selected documents as the default document in portfolio

files. The default document is displayed when the portfolio file is opened.

· Click Show Information to view the file properties of files within portfolio files.

· Click Portfolio Properties to view/edit file properties for portfolio files. The Portfolio

Properties dialog box will open, as detailed below.
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Figure 5. Portfolio Properties Dialog Box

· Select or clear property boxes to determine which properties are displayed in the main window

of PDF-XChange Editor.

· Click Add to add new portfolio properties to the portfolio file. The New Schema Field dialog

box will open. Enter a name for the new property and use the dropdown menu to determine

the type of property to be created, then click OK to create the new portfolio property.

· Click Move Up/Move Down to move selected properties up or down within the list of

properties. Note that the order of properties in the Portfolio Properties dialog box determines

the order in which properties are displayed in the main window of PDF-XChange Editor.

· Click Delete to delete selected properties. Note that this option is only available for custom

properties.

· Use the Sort By dropdown menu to determine the property used to sort documents in the main

window of PDF-XChange Editor.

· Use the Sorting Order dropdown menu to specify either Ascending or Descending as the

order in which documents are sorted according to the Sort by property in the main window of

PDF-XChange Editor.

You can create portfolio files in PDF-XChange Editor via the New Document option detailed here. 116
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3.3.17 Order Tab

 Order Tab

The Order tab is used to create/customize reading order and structure type tags in documents. It is

visible in the upper section of the UI when the Reading Order feature is selected in the Order  pane:

Figure 1. Order Tab Open and Reading Order Feature Enabled

Specifying a reading order for document content and tagging document structure is necessary in order

to meet accessibility requirements. You can use the features in this tab for these purposes:

Setting a Reading Order and Determining Tags

414
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Follow the steps below to set a reading order and determine tags for documents:

1. Open the Order  pane and click the Reading Order button.

2. Click and drag to determine the first location of the reading order. Highlights will appear

around the selected content:

Figure 2. Active Reading Order Determination

3. Select the type of tag that you want to apply to the selected area in the Order tab (or in the

right-click context menu). The first item in the reading order will then be defined, and the tag will

be applied to the document and detailed in the Tags pane:

414
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Figure 3. Tag Applied to Document Content

4. Repeat this process until all necessary document content is tagged and ordered.

Note that you can use the settings in the Show section of the Order tab to perform the following

operations:

· Click Page Content Order to display the page content order of tags. This is the reading order

of the document.

· Click Structure Types to display the structure types of tags.

· Click None to view tags without displaying their Page Content or Structure identifiers.

· Click Show table cells to highlight document content that has been tagged as a table cell.

· Click Show tables and figures to highlight document content that has been tagged as a table

or figure.
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3.4 Appendix

 Appendix

This section details additional information about settings and functions in PDF-XChange

Editor:

· Accessibility Check  - details the accessibility rules that are checked when

documents are assessed for accessibility.

· Alt Shortcuts  - details how to use Alt shortcuts to navigate the user interface.

· Add/Edit Content  - a breakdown of the ways in which it is possible to add/edit

content in PDF-XChange Editor.

· Blend Mode  - information about the blend mode feature and how it operates.

· Changing the Layout of Panes  - an explanation of how to edit the panes in

PDF-XChange Editor.

· Command Line Options  - a list of the available command line options, which

includes definitions and sample command lines.

· Comments Shortcut Menu  - an explanation of editing options for content

created with the PDF-XChange Editor tools.

· Converting Files to PDF  - details the available options for converting a range of

file formats to PDF.

· Date Format Specification  - an explanation of how to specify date formats.

· Document Tab Options  - an explanation of the options in the right-click

document tab shortcut menu.

· Editing Document Pages  - a breakdown of the methods through which PDF-

XChange Editor can be used to edit document pages.

· Editing Text in Annotations  - an explanation of the options available for

editing annotation text in PDF-XChange Editor.

· Features Added in Version 10  - details all features added in version 10 of PDF-

XChange Editor.

· Find  - an explanation of the Find feature, which is used to find specified text in

documents.

· Keyboard Shortcuts  - a comprehensive list of keyboard shortcuts, and

instructions on how to view/edit them in the software.

· Macros  - an explanation of macros and macro-enabled operations.
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· Page Boxes  - an explanation about the use of page boxes in PDF documents and

 PDF-XChange Editor.

· Page Range Settings  - a guide to the correct format for the specification of

page ranges.

· Read Out Loud Feature  - an explanation of this feature.

· Removing Trial Watermarks  - an explanation of how to remove trial

watermarks after a license has been purchased.

· Removing Activations from a License  - an explanation of how to remove an

activation from your license, in order to free up a space for a new machine.

· Search  - a profile of the Search feature, which is used to search documents open

in PDF-XChange Editor or folders on the local computer.

· Shell Extensions  - an explanation of the shell extensions and ifilter search tool.

· Tool Properties  - a table that defines all available properties for the PDF-

XChange Editor tools.

1282

1285

1286

1288

1293

1295

1300

1303



1083

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.4.1 Accessibility Check

 Accessibility Check

The Accessibility Check feature in PDF-XChange Editor enables you to verify whether document

conforms to international accessibility standards. Conformance with these standards ensures

accessibility for people with disabilities who use technology such as screen readers, screen magnifiers

and other equipment to navigate and read electronic content. The Accessibility Check contains thirty-

two rules that are used to determine the accessibility of documents. They concern specific elements of

documents and are therefore grouped into the following categories:

Document

· Accessibility Permission Flag reports the need to enable the security settings that permit

accessibility. This is because some documents contain permission settings that prevent them

from being copied, edited, printed, extracted and/or annotated. These settings may interfere

with a screen reader's ability to read the document, because screen readers must be able to

copy or extract document text in order to read it to the user. The Accessibility Permission Flag

reports whether or not it is necessary to turn on the security settings that allow accessibility for

the screen reader.

· Image-Only PDF reports that documents contains only inaccessible, non-text content such as

images. (Note that some images may be of text - in those cases, if the document does not

contain fonts, then the text will not be recognized).

· Tagged PDF reports whether documents contain tags that specify the order in which document

content should be read.

· Logical Reading Order must be checked manually and is included to ensure that the reading

order in the Tagged panel follows the logical reading order of the document.

· Document Language reports whether the primary text language of documents is specified,

and allows some screen readers to switch to the specified language.

· Title reports the title of documents as detailed in their document properties.

· Bookmarks reports whether documents that contain twenty-one or more pages also have

bookmarks that match the document structure.

· Color Contrast reports whether documents are sufficiently accessible for colorblind users.

Page Content
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· Tagged Content reports the status of document content, which must be either tagged or

marked as an artifact (such as graphics or decorative images) in order to conform to

accessibility standards.

· Tagged Annotations reports the status of annotations in documents. Annotations must be

either tagged or marked as artifacts to satisfy this rule.

· Tab Order reports whether the tab order of documents matches the document structure.

· Character Encoding reports whether documents contain the encoding required to display the

fonts that they contain.

· Tagged Multimedia reports the status of document multimedia objects, which must be either

tagged or marked as artifacts in order to conform to accessibility standards.

· Screen Flicker reports whether documents contain content that causes the screen to flicker. This

type of content can be difficult to see when the screen is magnified and can cause seizures in

people who have photosensitive epilepsy.

· Scripts reports whether documents contain scripts that interfere with keyboard navigation or

prevent the use of input devices. Document content and functionality must not be script-

dependent unless it is accessible to assisting technology.

· Timed Responses reports whether documents contain forms with JavaScript that require a

response from users within a specified time frame.

· Accessible Links reports whether the URLs in documents are tagged correctly, as well as

whether there are several identical links within the same document. URLs must be active and

correctly tagged in order to be accessible to screen readers.

Forms

· Tagged Form Fields reports whether all document form fields are tagged.

· Field Descriptions reports whether all form fields contain a text description, which is

requirement for accessible documents.

Alternate Text

· Figures Alternate Text reports whether document images either have alternate text or are

marked as artifacts. All document images must fall into these categories in order to conform to

accessibility standards.

· Nested Alternate Text reports whether documents contain nested alternate text, which screen

readers do not read.

· Associated with Content reports whether alternate text is associated with page content. This

rule is necessary because in cases where document elements have alternate text but do not

contain page content it is not possible to determine the document page with which the

alternate text is associated.

· Hides Annotation reports whether alternate text hides annotations, because screen readers are

unable to read annotations in cases where they are nested under a parent element that has

alternate text.
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· Other Elements Alternate Text reports whether documents contain content (other than

figures) that require alternate text, such as 3D models, annotations and multimedia. 

Tables

Please note that the structure of tables is often complex, and therefore it is advised that a manual check

is performed in order to ensure that tables conform to accessibility standards.

· Rows reports whether each table row is a child of Table, THead, TBody, or TFoot.

· TH and TD reports whether TH and TD are children of TR.

· Headers reports whether tables have headers, as this is necessary for tables to conform to

accessibility standards.

· Regularity reports whether tables contain the same number of columns in each row, and rows

in each column - both of which are necessary in order to conform to accessibility standards.

· Summary reports whether tables have a table summary. Table summaries are not required for

documents in order to conform to accessibility standards,

  

Lists

· List Items reports whether each list item is a child of a list. List elements must contain list item

elements, and list item elements must contain only label elements and list item body elements,

in order to conform to accessibility standards.

· Lbl and LBody is identical to List Items.

Headings

· Appropriate Nesting reports whether headings are nested correctly. 
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3.4.2 Alt Shortcuts

 Alt Shortcuts

The Alt shortcuts can be used to navigate the user interface with the keyboard in PDF-XChange Editor.

Press and hold the Alt key on your keyboard to view available Alt shortcuts:

Figure 1. Alt Shortcuts Enabled

When Alt shortcuts have been enabled, press the corresponding letter/number on the keyboard to

open the associated menu in the user interface.
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3.4.3 Add/Edit Content

 Add/Edit Content

A range of options to add and edit content is available in PDF-XChange Editor. These options are

available in the Home tab:

Figure 1. Home Tab, Content Editing Tools

These tools are used to edit the base content of documents and add text, images and barcodes to the

base content layer of documents. Please note that the Content  pane is a useful feature to use in

conjunction with the content editing tools.

Edit Objects Tool

388
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Click Edit Objects to select and edit document content:

Figure 2. Edit Objects Tool

Click the Edit Objects dropdown menu to view content selection/editing options:
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Figure 3. Home Tab, Edit Objects Tool, Content Options

· Click All to select/edit text, images and shapes simultaneously when the Edit Objects tool is

enabled.

· Select Text Elements to edit only text when the Edit Objects tool is enabled.

· Select Images to edit only images when the Edit Objects tool is enabled.

· Select Shapes to edit only shapes when the Edit Objects tool is enabled. Shapes are defined

as paths, shading, XForms and all other document base content that is neither text nor

imaged-based.

When the Edit Objects Tool is selected, click to select content items, or click and drag to group-

select content items. Note that group-selected items are edited simultaneously. Selected content

items appear as below:
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Figure 4. Selected Content Item

· Click and drag the yellow control points to resize content. 

· Click and drag the circle at the center to reposition content.

· Click and drag the green control point at the top to rotate content items. Hold down Shift to

rotate at increments of fifteen degrees.

· Use the arrow keys to reposition content. Hold down Shift to move at an increased

increment.

· Use the editing aids detailed here  to assist in the precise placement of document

content.

· Press Ctrl+' to open the Properties pane for selected content and view/edit properties. Note

that not all properties are editable.

· Click the Format tab to format selected content, as detailed below:

Format Tab for Images

450
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Figure 5. Format Tab for Images

· Use the Opacity dropdown menu to determine the transparency of the image.

· Use the Blend Mode to determine the blend mode used when content overlaps with other

content, as detailed here.

· Click Edit to edit the image in either the default application for editing images or an

alternative application.

· Click Save to save the image to file.

· Click Recompress to recompress the image, as detailed below.

· Click Replace to replace the image with an alternative image.

· Click OCR to perform optical character recognition on the image.

· Click Properties to view/edit the properties of the image.

Format Tab for Text

1109
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Figure 6. Format Tab for Text

· Use the Fill Color dropdown menu to determine the color of the text.

· Use the Stroke Color dropdown menu to determine the border color of the text.

· Use the Width dropdown menu to determine the width of the Stroke Color.

· The Border option is not available for text.

· Use the Opacity and Stroke Opacity dropdown menus to determine the level of

transparency of the Fill Color and Stroke Color respectively.

· Use the Blend Mode to determine the blend mode used when text overlaps with other

content, as detailed here.

· Use the Font and Font Size settings to determine the font used and the size of the font.

· Use the Bold, Italic and Alignment options to enable/disable bold and italic and/or adjust

the alignment of text as desired.

· Use the Grow Font and Shrink Font options to increase/decrease the size of the font.

· Click Properties to view/edit the properties of selected text.

Format Tab for Shapes

1109
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Figure 7. Format Tab for Shapes

· Use the Fill Color dropdown menu to determine the color of the shape.

· Use the Stroke Color dropdown menu to determine the border color of the shape.

· Use the Width dropdown menu to determine the width of the Stroke Color.

· The Border option is not available for shapes.

· Use the Opacity and Stroke Opacity dropdown menus to determine the level of

transparency of the Fill Color and Stroke Color respectively.

· Use the Blend Mode to determine the blend mode used when shapes overlap with other

content, as detailed here.

· Click Properties to view/edit the properties of selected shapes.

Editing Shapes/Paths/Objects

Double-click shapes, or right-click shapes and and select Edit Object in the shortcut menu, to open

the Edit Path tab in order to edit paths:

1109
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Figure 8. Edit Path Tab

You can use the options in this tab to edit paths as follows:

· Click Line, Corner Rectangle, 3-Point Rectangle, Parallelogram, Circle, Perimeter Circle,

Centerpoint Arc, 3-Point Arc or Ellipse to expand the selected path with the shape

indicated, then click and drag to create the shape.

· Click Add Polyline to expand the selected path with a polyline, then click within the

document to determine the shape of the polyline.

· Click Add Bezier to expand the selected path with a bezier curve, then click within the

document to determine the shape of the curve.

· Click Add Free Paint to expand the selected path in freehand, then click and drag within the

document to determine the created shape.

 

You can use the options on the left side of the Edit Path tab when you have selected a line within a

path:

· Click Add Point to add a point to the line.

· Click Delete to delete the line.

· Click Close Path to complete the shape of paths that have open ends.

· Click Break Apart to break apart lines at points.

· Click Reverse to reverse sub-paths.
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· Click Convert to Line to convert bezier curves to lines.

· Click Convert to Bezier to convert lines to bezier curves.

· Click Corner to specify the use of a corner for selected bezier handles.

· Click Straight to specify the use of a straight edge for selected bezier handles.

· Click Smooth to specify the use of a smooth edge for selected bezier handles.

Click Finish Editing to complete the current editing operation, or click Cancel Editing to cancel it.

Right-Click Options Menu

Right-click content for further options. Please note that available options depend on the format of

selected content. The menu below contains all available options:
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Figure 9. Content Items Right-Click Menu
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· Hover over Edit Image to view editing options for images:

· Click Default Application to edit the image in the default application for editing

images. Note that changes made to images in the application will be updated in

the current document when the image is saved.

· Click Open With to select a non-default application with which to edit the

image. The Open with dialog box will open. Selected the desired application

and click OK to launch it.

· Click Edit/Save Images Without Display Transformations to enable/disable this

feature. When it is enabled, images can be edited/saved in the state that they were in

when added to the document. All subsequent rotations, transformations and scaling

operations applied to the image/page are ignored.

· Click Edit All Image Instances to edit all instances of images simultaneously in

documents. When this option is enabled and an image is edited, all identical images in

the document will be edited in the same manner.

· Click Replace Image to replace selected images with an image from file. Note that

replacement images are automatically scaled to match the dimensions of images that

they replace.

· Click Recompress Image to recompress images, as detailed below.

· Click Save Image As to save a copy of selected images to file. The Save File As dialog

box will open. Enter a file name in the File name text box, then click Save to save the

image.

· Click OCR Image to perform optical character recognition on selected images. The

OCR Image dialog box will open. Select the desired language and accuracy then click

OK to perform OCR.

· Click Add Bookmark to add a bookmark at the selected location. Further information

on bookmarks is available here.

· Hover over Add Link to view the options for adding links:

· Click Add Goto Link to create a link from the selected location to a location

within the current document. The Browse for Link Target dialog box will open.

Move to and select the desired document location and then click Set Link to

create the link.

· Click Add Weblink to create a link from the selected location to an internet

location. The Add Action: "Open a Web Link" dialog box will open. Enter the

desired URL in the text box and then click OK to create the link.

· Click Add Open File Link to create a link from the selected location to a file on

the local computer. The Add Action: "Open a File" dialog box will open.

Determine options as detailed here  then click OK to create the link.

· Click Add Custom Link to create a custom link. Custom links can be used to

create a range of dynamic links, such as links that launch JavaScript actions, move

to pages in other documents, open files, execute PDF-XChange Editor

commands, reset/submit forms, play sounds and show/hide form fields. The Edit

Action List dialog box will open. Determine options as detailed here  then

click OK to create the link.

345
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302
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· Current Layer displays the current layer to which selected content belongs. Hover over

this option to view a list of all layers in the document. Click a layer to move the

selected content there, or click New Layer to move the selected content to a new

layer. Further information about layers and layer creation is available here.

· Click Hand Tool, Snapshot Tool, Select Text or Zoom In/Out Tool to enable these

tools.

· Click Cut, Copy, Paste or Delete to perform these actions on selected content. If you

have selected text then additional options are available:

· Click Paste as plain text to paste text as plain text.

· Click Paste as Rich Text to paste text as rich text.

· Hover over Arrange to view arrangement options for selected content:

· Use the Align options to align selected content items.

· Use the Distribute options to distribute selected content items evenly on the

horizontal or vertical axis as desired.

· Click Make Same Width/Height/Size to make selected content items the same

width/height/size as desired.

· Use the Rotate/Flip options to rotate/flip selected content.

· Click Transform to edit the position, size and/or rotation of selected content, as

detailed here.

· Click Duplicate to to duplicate selected content items, as detailed here.

· Click Bring Forward to bring content items forward one step in cases of multiple

items overlapping.

· Click Send Backward to send content items back one step in cases of multiple

items overlapping.

· Click Bring to Front to bring content items to the front in cases of multiple

items overlapping.

· Click Send to Back to send content items to the back in cases of multiple items

overlapping.

· Hover over Select to view options for selecting all content of a specific format in

documents:

· Click All to select all content items in the document.

· Click Text to select all text in the document.

· Click Images to select all images in the document.

· Click Shapes to select all shapes in the document.

· Click XForms to select all XForms in the document.

· Click Deselect to deselect selected content.

· Click Select Correspondent Thumbnails to select the thumbnails of currently selected

content. The corresponding thumbnails will then be selected in the Thumbnails

 pane.

· Click New Stamp from Selection to create a new stamp from selected content, as

detailed here.

· Click New Document from Selection to create a new document from selected

content. The new document will open in a new window in PDF-XChange Editor.

374
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· Hover over Export to view export options for selected content, then click Export to

Images or Export Selection to Microsoft Word Document/Excel/Powerpoint

Presentation as desired. If you are exporting to image format then you can customize

options as detailed here.  If you are exporting to MS Office format then the Save

File dialog box will open. Enter a name/location for the new file and then click Save to

export the content.

· Click Properties to open the Page Content Properties pane for selected content. This

pane is used to view/edit content properties, as detailed here.

Recompress Images

Figure 10. Recompress Image Dialog Box

· Use the Image options to determine conversion options:

· Use the Convert to dropdown menu to determine the format into which the

image is compressed.

· Use the Compress method dropdown menu to determine the compression

method.

· Use the JPEG Quality dropdown menu to determine the compression quality.

166

389
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· Use the Downsampling method to determine the downsampling method used,

and the adjacent number boxes to determine the downsampled resolution on

the X and Y axes respectively.

· Select the Replace current instance only box to replace only the current

instance of the image in documents where the same image is used multiple

times.

Note that the values in the Image Details pane display details about the current image and

the image after compression has taken place using the values entered in the Recompress

Image dialog box. Additionally, the preview pane will update according to any changes made.

Add Text/Images/Barcodes to Documents

Click Add to add content to documents:

Figure 11. Tools Tab Submenu. Content Editing Tools, Add Options

These options are used to add text, images and barcodes to documents:

Add Text

Click Add Text to add text to documents: 
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Figure 12. Home Tab, Add Content Options

When this feature is selected the pointer will become a cross icon. Move the icon to the desired

location and click to designate the location of the new text box. Text can then be entered as

desired:
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Figure 13. Add Text Tool Example

· Click and drag the central yellow control points on either side of text boxes to resize them

horizontally. (Note that it is not possible to resize text boxes vertically until text has been

entered into them).

· Click and drag the green control point to rotate text boxes. Hold down Shift to rotate at

increments of fifteen degrees.

· Use the editing aids detailed here  to assist in the precise placement of text boxes.

· Enter the desired text in the text box. Press Enter to start new lines. The options in the

Format tab can be used to adjust the text style, as detailed above.

· Press Insert to enable/disable the 'overtype' feature, which enters text over existing text.

· Right-click text for further options:

450



1103

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 14. Editing Options

· Click Undo to reverse the most recent action.

· Click Cut to cut selected text to the clipboard.

· Click Copy to copy selected text to the clipboard.

· Click Paste to paste current clipboard text at the selected location.

· Click Paste as plain text to paste current clipboard text as plain text at the selected

location.

· Click Select All to select all text in the selected area.

· Click Paragraph to edit paragraph settings, as detailed in (figure 15).

· Click Text Style to update the style of selected text. The following options are available:

· Bold

· Italic

· Underline

· Superscript transforms selected text into superscript, which is used for specific

purposes such as detailing chemical compounds.  

· Subscript transforms selected text into subscript, which is used for specific purposes

such as detailing mathematical formulae.

· Clear Text Formatting clears formatting from selected text.

· Make Current Text format Default sets the format of selected text as the default

format for subsequent text. 

· Apply Default Text Format applies the default text format to selected text.

· Select Hyphenate Text to hyphenate text automatically when it crosses line endings.



1104

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 15. Paragraph Options

· Use the Alignment menu to determine the alignment of paragraphs.

· Use the Indentation number boxes to determine the indentation from the left and right

margins, and the Special and By menus to determine hanging options. 

· Use the Spacing options to determine line spacing.

Click OK to save paragraph settings.

Add Images

Click Add Image to add images to documents:
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Figure 16. Tools Tab Submenu. Add Image Tool

The Select Image Placement Tool dialog box will open. Click Drag Image Rectangle, then click

and drag to determine the location at which the image is inserted. The Open Files dialog box will

open. Select an image from the local computer. The Add Image dialog box will open:
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Figure 17. Add image Dialog Box

· Click the folder icon to select an alternative file.

· Select an option to determine how the image is added: 

· As a Stamp adds images as stamp annotations, as detailed here.

· As a Content Item adds images as content items.

Please note that stamps and content items feature different editing options.

575
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Click Place to add images.

Add Barcodes

Barcodes provide a useful method for the storage of information that barcode readers and

mobile devices such as smartphones and tablets can access. Hover over Add QRCode to add

barcodes to documents:

Figure 18. Add Submenu. Add Barcode

Select the type of barcode you want to add to the document. The Select Barcode Placement

Tool dialog box will open. Click Drag Barcode Rectangle to add a new barcode. The pointer will

become a crosshairs icon. Click and drag to determine the size and location of the barcode. The

Add Barcode dialog box will open:
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Figure 19. Add Barcode Dialog Box

· Use the Data type menu to set the format of the data contained in the barcode:

· Free Text is used to store text-based content.

· URL is used to store internet addresses.

· Email is used to store information in email format.

· Telephone Number is used to store information in phone number format.

· Contact (vCard) is a file format standard that is used to store electronic business

cards.

· Enter any desired test in the Enter Text window. Barcodes are created automatically when

data is entered, and can be viewed in the preview pane.

· Barcode properties are detailed beneath the preview pane and can be edited as desired.

Click Place to add the barcode to the document.
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3.4.4 Blend Mode

 Blend Mode

The Blend Mode property is available for document content and many of the commenting styles in

PDF-XChange Editor. When the Blend Mode feature is available, it is displayed in the Format  tab

and the Properties  pane:

Figure 1. Blend Mode Locations

The Blend Mode feature determines how content blends with overlapping content. Note that the Fill

Color property is referenced when Blend Modes are used. This property can be edited in the Format

tab or the Properties pane.

1066

441
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· Normal maintains the selected Fill Color.

· Multiply multiples the Fill Color value with the color value of the underlying content. Resultant

colors are at least as dark as one of the source colors.

· Screen multiplies the complements of the Fill Color value with the color value of underlying

content and then complements the result. The resulting color will be at least as light as one of

the source colors.

· Overlay either multiplies or screens the Fill Color value with the color value of underlying

content, depending on the color value of the latter. The Fill Color will overlay the underlying

content while preserving its highlights and shadows. The color of underlying content will be

blended with the Fill Color to reflect its shade.

· Darken selects the darker of the Fill Color value and the color value of underlying content.

· Lighten selects the lighter of the Fill Color value and the color value of underlying content.

· Color Dodge brightens the color of the underlying content to reflect the Fill Color. Note that if

black is used as the Fill Color then there will be no effect.

· Color Burn darkens the color of the underlying content to reflect the Fill Color. Note that if

white is used as the Fill Color then there will be no effect.

· Hardlight either multiples or screens the Fill Color value with the color value of underlying

content, depending on the Fill Color value. This creates the effect of shining a strong spotlight

on the underlying color.

· Softlight either darkens or lightens colors, depending on the Fill Color value. This creates the

effect of shining a diffused spotlight on the underlying color.

· Difference subtracts the darker of the constituent colors from the lighter color.

· Exclusion performs a less contrasted version of the Difference option.

· Hue combines the Fill Color value with the saturation and luminosity of the color value of the

underlying content.

· Saturation combines the saturation of the Fill Color with the hue and luminosity color value of

the underlying content.

· Color combines the the hue and saturation of the Fill Color with the luminosity color value of

the underlying content.

· Luminosity combines the luminosity of the Fill Color with the hue and saturation of the color

value of the underlying content.

Note that the Arrange tab can be used to change the layer order of overlapping content, which has a

direct effect on the Blend Mode. The Arrange tab is available when content that is compatible with it

is selected:
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Figure 2. Arrange Tab, Selected Comments

· Click Bring Forward to bring the selected content up a step in cases where multiple items

overlap.

· Click Send Backward to send the selected content back a step in cases where multiple items

overlap.

· Click Bring to Front to bring the selected content to the top in cases where multiple items

overlap.

· Click Send to Back to send the selected content to the back in cases where multiple items

overlap.
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3.4.5 Changing the Layout of Panes

 Changing the Layout of Panes 

The size and location of all panes in PDF-XChange Editor can be customized as desired. 

Editing Panes

The editing panes are listed in the Panes dropdown menu in the View tab:

Figure 1. View Tab, Panes Dropdown Menu

Click to open panes:
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Figure 2. Thumbnails and Properties Panes Opened

Click and drag panes to undock them from the user interface, then move them to the desired location

or to a new docking point. Available docking points will be displayed as detailed in (figure 3). Drag

panes onto docking points to dock them:
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Figure 3. Example Docking Points



1115

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 4. Repositioned Thumbnails Pane

Note that the minimize/maximize buttons can be used to minimize/maximize panes:
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Figure 5. Minimize/Maximize Buttons

Document Panes

Document panes can be edited in the same manner as editing panes. Click and drag document tabs to

reposition document panes:
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Figure 6. Document Tab Highlighted

Available docking points will be displayed in the center of the user interface:
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Figure 7. Document Pane Docking Points

Drag document panes onto docking points in order to open them in a new window above/below or to

the left/right of the current pane. Dragging document panes to any other location will open them in a

new instance of PDF-XChange Editor. 
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3.4.6 Command Line Options

 Command Line Options

The command line options detailed below are available in PDF-XChange Editor. Please note:

· If any values have spaces, backslashes or forwardslashes then the entire options list should be

enclosed in quotation marks.

· If the optionslistfile contains spaces then it should be enclosed in quotation marks.

· If a profile is specified then changes will be made to that profile. If a profile is not specified

then the changes will apply only to the current printer's settings.

· These options are for the PDFXEdit.exe executable, the default location of which is:

"C:\Program Files\Tracker Software\PDF Editor"

· Unless the path to PDFXEdit.exe is added to the system %path% variable, the full path to

PDFXEdit.exe must be specified.

· Use semicolons to delimiter options when more than one option is being used. 

Formal Syntax 

<anytext> means any text string.

<a>|<b> means <a> or <b>.

[expression] is the optional part of the command line. For example if the syntax is: /print[:

[default[=yes|no]][;showui[=yes|no]]] <filename> then the following examples are correct:

/print "c:\example.pdf"

/print:default "c:\example.pdf"

/print:default;showui "c:\example.pdf"

/print:default=yes;showui=yes "c:\example.pdf"
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<filename> means full or relative path to file. When the path contains white spaces it should be

enclosed in quotation marks. For example: c:\MyDocuments\MyTestDocument.pdf should be "c:\My

Documents\My Test Document.pdf".

<pagesrange> specifies the range of pages to be processed. See here  for further information on

the specification of page ranges.

Command Line Options

/addlang 

This command installs new UI-languages from a special UI-languages pack. The UI-languages pack is a

zip-archive that contains one or more *.xcl files. The format of the file will be .xclpack. See here for a

list of available language packs for PDF-XChange Editor.

Syntax

/addlang[:[mode=]ask|user|all]] <filename>

Parameters

· mode=ask – asks user about installing mode: “for this user only” or “for all users on this

machine”. This is the default mode.

· mode=user – installs new UI-languages silently, for only the current user.

· mode=all – installs new UI-languages silently, for all users on the target machine.

Please note that system administrator privileges are required when making changes that affect all

users. 

Example

PDFXEdit.exe /addlang:mode=user "c:\Users\John\Downloads\German.xclpack"

/close

This command closes open documents according to the specified source file name.

Syntax

1285

https://www.pdf-xchange.com/editor_lang
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/close[:[mode=]save|discard|ask]

Parameters

· mode=ask – if the document has been edited then the software will prompt the user about

saving changes before it closes. This is the default mode.

· mode=discard – closes the document silently, i.e. without prompting the user about saving

changes.

· mode=save – if the document has been edited then the software saves changes silently before

closing.

Examples

PDFXEdit.exe /close "c:\example.pdf"

PDFXEdit.exe /close:mode=save "c:\example.pdf"

PDFXEdit.exe /close:discard "c:\example.pdf"

/exportp 

This command exports all the application settings to a specified file. It creates a new file with a special

format that contains all the non-default options.

Syntax

/exportp <filename>

Parameters

There are no available parameters for this command.

Example

PDFXEdit.exe /exportp "c:\PXCEditor.MySettings.Backup.dat"

/exportsettings 

This command exports settings of the application to a file on the local computer. This operation can

also be achieved via the Export Settings  feature.

Syntax

276
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/exportsettings[:<parameters>] <filename>

Parameters

Note that all parameters support the values yes, no, 1, 0, true and false.

· common - exports common program options (but does not include presets lists,

trusted/untrusted locations and names or places). The default value is true.

· presets - exports the preset lists of the application, such as color management and scanner

presets. The default value is true.

· trustedlist - exports the list of the trusted/untrusted locations and names. The default value is

true.

· places - exports the list of places (user-defined locations that are used to open files, such as

Dropbox folders). The default value is true.

· history - exports the list of recently opened files. The default value is true.

· stamps - exports all custom stamps collections. The default value is false.

· dsatemplates - exports the digital signature appearance templates. The default value is false.

· pluginsdata - exports the advanced plugins data. The default value is false.

· signatures - exports the list of signatures and initials. The default value is false.

· all - exports all settings. Note that this command line option can be customized using any of

the available parameters. For example, "/exportsettings:all=yes;stamps=0" exports all

settings except stamps, and "/exportsettings:all=no;stamps=1" exports only stamps. This

command line does not have a default value because it is a combined option, but each option

has its own default value, as detailed above.

· settings - exports all application settings (common, presets, trustedlist and places). This

command line does not have a default value because it is a combined option, but each option

has its own default value, as detailed above.

Examples

PDFXEdit.exe /exportsettings "c:\PDFXChangeEditorSettings.xces"

PDFXEdit.exe /exportsettings:history=no "c:\PDFXChangeEditorSettings.xces"

PDFXEdit.exe /exportsettings:history=no;stamps=yes;pluginsdata=yes "c:

\PDFXChangeEditorSettings.xces"

/fileassoc

This command determines the file associations for PDF-XChange Editor. 

Syntax
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/fileassoc[:user=no|yes] 

Parameters

· user=no - then file associations will be placed in HKEY_ LOCAL_MACHINE.

· user=yes - then file associations will be placed in HKEY_CURRENT_USER and HKEY_

LOCAL_MACHINE.

Example

PDFXEdit.exe /fileassoc:user=yes

/importp 

This command launches PDF-XChange Editor and imports application settings from the specified file

to the system registry or, in the case of portable applications, to a special settings file. The input file

must be in the same format as the /ExportP command detailed below.

Syntax

/importp <filename>

Parameters

There are no available parameters for this command.

Example

PDFXEdit.exe /importp "c:\PXCEditor.MySettings.dat"

/importsettings 

This command imports all settings from a file created by the /exportsettings command, or by the

Export Settings  feature. This operation can also be achieved via the Import Settings  feature.

Syntax

/importsettings[:<parameters>] <filename>

Parameters

276 276
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Note that all parameters support the values yes, no, 1, 0, true and false.

· common - imports common application options (but does not include the presets lists,

trusted/untrusted locations and names or places). The default value is true.

· presets - imports the application presets lists, such as color management and scanner presets.

The default value is true.

· trustedlist - imports the list of trusted/untrusted locations and names. The default value is

true.

· places - imports the list of places (user-defined locations that are used to open files, such as

Dropbox folders). The default value is true.

· history - imports the list of recently opened files. The default value is true. The value merge

can be used to combine the existing history with the imported history.

· stamps - imports all custom stamps collections. The default value is true.

· dsatemplates - imports the digital signature appearance templates. The default value is true.

· pluginsdata – imports advanced plugins data. The default value is true.

· signatures - imports the list of signatures and initials. The default value is true.

· all - imports all settings. Note that this command line option can be customized using any of

the available parameters. For example, "/importsettings:all=yes;stamps=0" imports all

settings except stamps, and "/importsettings:all=no;stamps=1" imports only stamps. This

command line does not have a default value because it is a combined option, but each option

has its own default value, as detailed above.

· settings - imports all application settings (common, presets, trustedlist and places). This

command line does not have a default value because it is a combined option, but each option

has its own default value, as detailed above.

Examples

PDFXEdit.exe /importsettings "c:\PDFXChangeEditorSettings.xces"

PDFXEdit.exe /importsettings:history=merge "c:\PDFXChangeEditorSettings.xces"

PDFXEdit.exe /importsettings:history=merge;stamps=yes;settings=no "c:

\PDFXChangeEditorSettings.xces"

/open - please note that /A can also be used for this command.

This command opens documents from a specified file and determines the custom view location, search

words and highlight rectangles as necessary.

Syntax

/A <param1>=<value1>[;<param2>=<value2>[;...]][=OpenParameters] <filename>
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Parameters

· nameddest=<destName> – specifies a named destination in the PDF document.

· page=<pageNum> – uses an integer value to specify a numbered page in the document. The

document’s first page has a pageNum value of 1.

· comment=<commentID> – specifies a comment on a given page in the PDF document. Use

the page parameter before this command. For example:

· page=1;comment=452fde0e-fd22-457c-84aa-2cf5bed5a349

· zoom=<scale>[,<left>,<top>] – sets the zoom and scroll factors using float or integer

values. For example, a scale value of 100 indicates a zoom value of 100%. Scroll values left and

top are in a coordinate system where 0,0 represents the top left corner of the visible page

regardless of document rotation.

· view=Fit|FitH[,<top>]|FitV[,<left>]|FitB|FitBH[,<top>]|FitBV[,<left>] – sets the view of

the displayed page using the keyword values defined in the PDF language specification. For

more information, see the PDF Reference. Scroll values left and top are floats or integers in a

coordinate system where 0,0 represents the top left corner of the visible page, regardless of

document rotation. Use the page parameter before this command.

· viewrect=<left>,<top>,<width>,<height> – sets the view rectangle using float or integer

values in a coordinate system where 0,0 represents the top left corner of the visible page,

regardless of document rotation. Use the page parameter before this command. 

· pagemode=<bookmarks|thumbs|none> – displays bookmarks or thumbnails. The default

setting is none.

· scrollbar=1|0 – turns scrollbars on or off.

· search=<wordList> – opens the Search pane and performs a search for the words in the

specified word list. All matching words are highlighted in the document. The words list must be

enclosed in quotation marks and separated by spaces. It is only possible to search for single

words. For example: search="sample search words" will locate and highlight the words

sample, search and words. When searching for multiple terms they must be adjacent in the

content, i.e. separated by only white space/simple punctuation, or they will not be identified.

· highlight=<left>,<right>,<top>,<bottom> – highlights a specified rectangle on the

displayed page. Use the page parameter before it. The rectangle values are integers in a

coordinate system where 0,0 represents the top left corner of the visible page, regardless of

document rotation.

· fullscreen[=yes|no] – when enabled, the document will open in full screen mode.

· password=<password> – specifies the password string to open silently a password-protected

document.

· usept[=yes|no] – when specified, all values for positioning are absolute and measured in

points (1/72 inch).

Examples

PDFXEdit.exe /A zoom=1000 "c:\example.pdf"
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PDFXEdit.exe /A page=255;zoom=200;pagemode=thumbs;search="lazy dog" "c:

\example.pdf"

/print

This command prints pages from specified documents.

Syntax

/print[:[default[=yes|no]][;showui[=yes|no [;printer=<printername>]

[;pages=<pagesrange>]] <filename1> [<filename2> ... <filenameN>]

Parameters

· default - if specified then default parameters will be used for printing. PDF-XChange Editor

uses the most recently used print parameters by default.

· showui - if specified then the standard print dialogue will be displayed before printing. The

default setting is that the application prints pages silently (without user interaction).

· printer - is used to specify the printer to be used. The default printer will be used when this

option is not enabled.

· pages - is used to specify the page range to be printed. All pages of the active document will

be printed when this option is not enabled.

Example

PDFXEdit.exe /print:default=yes;showui=yes;printer="PDF-XChange Printer" "c:

\example.pdf"

/resetsettings 

This command resets the settings for PDF-XChange Editor on the local computer. 

Syntax

/resetsettings[:<parameters>]

Parameters

Note that all parameters support the values yes, no, 1, 0, true and false.
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· common - resets common application options (but does not include the presets lists,

trusted/untrusted locations and names or places). The default value is true.

· presets - resets the application presets lists, such as color management and scanner presets.

The default value is true.

· trustedlist - resets the list of trusted/untrusted locations and names. The default value is true.

· places - resets the list of places (user-defined locations that are used to open files, such as

Dropbox folders). The default value is true.

· prompts - resets prompts and warning messages (the "do not show this message again" dialog

boxes). The default value is false.

· uilang - resets the language of the user interface. The default value is false.

· history - resets the list of recently opened files. The default value is true.

· stamps - resets all custom stamps collections. The default value is true.

· dsatemplates - resets the digital signature appearance templates. The default value is true.

· pluginsdata – resets advanced plugins data. The default value is false.

· signatures - resets the list of signatures and initials. The default value is false.

· all - resets all settings. Note that this command line option can be customized using any of the

available parameters. For example, "/resetsettings:all=yes;stamps=0" resets all settings

except stamps, and "/resetsettings:all=no;stamps=1" resets only stamps. This command line

does not have a default value because it is a combined option, but each option has its own

default value, as detailed above.

· settings - resets all application settings (common, presets, trustedlist, places, UILang and

history). This command line does not have a default value because it is a combined option,

but each option has its own default value, as detailed above.

Examples

PDFXEdit.exe /resetsettings "c:\PDFXChangeEditorSettings.xces"

PDFXEdit.exe /resetsettings:history=yes "c:\PDFXChangeEditorSettings.xces"

PDFXEdit.exe /resetsettings:stamps=yes;settings=no;history=yes "c:

\PDFXChangeEditorSettings.xces"

/runjs

This command launches JavaScript.

Syntax

/runjs[:log[=yes|no]] <scriptfilename> [<filename1> ... <filenameN>]

Parameters
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· log=yes|no – if specified without a value, or the value is yes, then the application creates a log

when this command is executed. The log file _RunJSLog.txt will be added to the program

folder on the local computer.

· <scriptfilename> – specifies the full path to the file that contains the JavaScript.

Example

The following command line launches the JavaScript contained in the file "AddDraftStamp.js":

PDFXEdit.exe /runjs "c:\AddDraftStamp.js" "c:\example.pdf"

/usep

This command instructs the application to use the input file as the source for all settings.

Syntax

/usep[:readonly[=yes|no]] <filename>

Parameters

· readonly – if specified then the input file with the application settings will be used as "read-

only" and will not be changed when the application is closed.

Example

PDFXEdit.exe /usep:readonly "c:\PXCEditor.MySettings.dat"

/webassoc

This command determines the mime type (web browser) associations for PDF-XChange Editor. 

Syntax

/webassoc[:user=no|yes] 

Parameters

· user=no - then mime type associations will be placed in HKEY_ LOCAL_MACHINE. 
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· user=yes - then mime type associations will be placed in HKEY_CURRENT_USER and HKEY_

LOCAL_MACHINE.

Example

PDFXEdit.exe /webassoc:user=yes
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3.4.7 Comments Shortcut Menu

 Comments Shortcut Menu

A range of options are available for editing and interacting with comments in their right-click shortcut

menu. The options available depend on the type of comment selected. Right-click comments to view

the options available, as detailed below:

Figure 1. Example Tool Content Shortcut Menu

The list below details all editing options available for tool content:

· Click Open Pop-Up Note to view the content pop-up note. Pop-up notes are created

automatically when content is created. (Note that in the case of the Measuring Tools  it is597
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necessary to use the Edit Label and Delete Label options, detailed below, to edit/delete note

content). Highlight note content and then use the options in the Format Tab  to edit its

appearance.

· Click Hide Pop-Up Note to close the view/edit pane of content pop-up notes.

· Click Reset Pop-Up Note Location to reset the location of content pop-up notes. 

· Click Cut, Copy, Paste or Delete to perform these operations on selected content.

· Click Flatten Selected Comments to flatten selected comments to the base content layer of

documents.

· Click Locked to enable/disable the locked property for comments. If this property is enabled

then the annotation cannot be deleted and its properties (including its position and size)

cannot be modified by users.

· Click Printable to enable/disable the printable property for comments. If this property is

enabled then the annotation is printed with the document. If this property is not enabled then

the annotation is not printed.

· Current Layer displays the current layer to which content belongs. Hover over this option to

view a list of all layers in the document. Click a layer to move the content there, or click New

Layer to move the content to a new layer. Further information about layers and layer creation is

available here.

· Click Fit Box by Text Content to fit the size of the selected box to the text that it contains. This

feature is available for the Text Box, Callout and Typewriter tools.

· Click Add Reply to add replies to existing pop-up notes.

· Select an option from the Status submenu to define the status of content for subsequent

editing. The options are Accepted, Cancelled, Completed and Rejected.

· Use the Arrange submenu arrange/edit selected content:

· Click the Align options to align selected content items.

· Click Rotate 90° CCW, Rotate 90° CW or Rotate 180° to rotate selected content.

· Click Flip Horizontal/Vertical to flip selected content horizontally/vertically.

· Click Transform to edit the position and/or size of selected content as detailed here.

· Click Duplicate to duplicate selected content as detailed here.

· Click Bring Forward to bring selected content items forward one step in cases of

multiple objects overlapping.

· Click Send Backward to send selected content back one step in cases of multiple objects

overlapping.

· Click Bring to Front to bring selected content to the front in cases of multiple objects

overlapping.

· Click Send to Back to send selected content to the back in cases of multiple objects

overlapping.

· Use the Set Scale submenu to select a scale for selected content:

· Click a scale to select a predefined scale from the list.

· Click Manage Measurements to view/edit the list of predefined scales. Use Delete and

Edit buttons to delete/edit selected scales. Use the Clone button to clone predefined

scales. Cloned scales can be edited and saved for subsequent use.

· Click Calibrate Measurement to create a new scale as detailed here.

1066

374

291

293

617
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· Click Export Measurements To CSV File to export output of the Measuring Tools  to a

comma-separated-values file. Note that when documents that contain perimeter or area

annotations are exported to comma-separated-values, the output document will contain an

"Alt. Value" column for annotations. This value details the area of perimeter annotations and

the perimeter of area annotations.

· The Restore Caption Placement feature will be added in a future build.

· Click Edit Label to edit the pop-up note of selected content. Please note that it is not possible

to remove the scale reference figure that the Measuring Tools  create.

· Click Delete Label to delete information that has been added to the label. Please note that it is

not possible to remove the scale reference figure that the Distance Tools create.

· Click Deselect to deselected selected content.

· Use the Control Points submenu to add/delete control points as desired:

· Click Add Point to add new control points.

· Right-click control points and then select Delete Point to delete points.

· The Auto Adjust Arm Position option is used in conjunction with the callout arm of the

Callout Tool. When this setting is enabled the control point from which callout arms originate

changes automatically. The control point closest to the end of the callout arm is used. When

this setting is disabled the control point from which the callout arm originates remains constant

when callout text boxes are repositioned. 

· Click Flip Line to flip content through one hundred and eighty degrees.

· Click Convert to Measurement to convert selected annotations into measurement annotations.

· Click Convert to Polyline to convert line or distance annotations into polyline annotations.

· Click Convert to Lines to convert polygon, polyline, perimeter, area or rectangle annotations

into line annotations. 

· Click Transform to Quadrilateral to enable link shape editing when using the Link Tool or the

Redaction feature. Click and drag the inner control points to edit the shape. When this option is

enabled it is replaced in the submenu with the option to Transform to Rectangle. Click this

option to revert to the default mode. Selected links will update automatically. Please note that

the Link Creation Tool  must be selected in order to edit/delete links.

· Click Style Tools to view style options for selected content:

· Click Copy Comment Style to copy the style properties of selected content, such as the

Fill Color, Border Style and Opacity value. (Use the Properties  pane to view/edit

content properties).

· Click Apply Copied Comment Style to apply copied comment and text properties to

selected content.

· Click Apply Copied Comment Appearance to apply copied comment properties to

selected content.

· Click Apply Copied Text Style to apply copied text styles to selected text. Right-click

selected text to copy text styles, as detailed here.

· Click Make Current Properties Default to set the properties of selected content as the

default properties for subsequent content of the same format.

· Click Apply Default Properties to apply default content properties to selected content.

597

597

299

441

1142



1133

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Click Make Current Text Format Default to set the current text properties as the default

text properties for the selected annotation format.

· Click Apply Default Text Format to apply the default text format to selected text. Note

that each annotation format has a different default text format.

· Click Export to view export options for selected content. Available options depends on the

format of selected content. All options are detailed below:

· Click Export selection to Microsoft Word Document to export selected content to

(*.docx) format.

· Click Export selection to Microsoft Excel to export selected content to (*.xlsx) format.

· Click Export selection to Microsoft Powerpoint Presentation to export selected

content to (*.pptx) format. 

· Click Properties to view/edit content properties in the Properties pane, as detailed here.

Note that the Comment Styles Palette  is a useful resource that can be used to view/edit comment

style properties.

441
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3.4.8 Converting Files to PDF

 Converting Files to PDF

A range of options are available in PDF-XChange Editor for converting files to PDF, including the

default features to:

· Convert CSV Files to PDF.

· Convert Image Files to PDF.

· Convert Markdown Files to PDF.

· Convert RTF Files to PDF.

· Convert Text Files to PDF.

· Convert Clipboard Content to PDF.

A list of all file formats that can be converted to PDF is available in the Convert to PDF category in the

Preferences dialog box available via the File tab:

128

140

125

131

120

155
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Figure 1. Preferences Dialog Box, Convert to PDF Category

Available formats include MS Excel/PowerPoint/Word/Publisher/Visio, Windows Metafile and XPS.

If you want to convert these files formats to PDF, then simply open them in PDF-XChange Editor and

the conversion will take place automatically.
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3.4.9 Date Format Specification

 Date Format Specification

Several of the features in PDF-XChange Editor utilize an option to specify the date and/or time format

to be used. These features use both predefined and custom dates/times. The following options are

available:

Date Format Pictures

DATE

FORMAT 

DEFINITION

d Day of the month as digits and without leading

zeros for single-digit days.

dd Day of the month as digits and with leading

zeros for single-digit days.

ddd Abbreviated day of the week. For example,

"Mon" in English (United States).

dddd Day of the week.

M Month of the year as digits and without leading

zeros for single-digit months.

MM Month of the year as digits and with leading

zeros for single-digit months.

MMM Abbreviated month of the year, for example,

"Nov" in English (United States).

MMMM Month of the year, for example "November" for

English (United States), and "Noviembre" for

Spanish (Spain).

y Year represented by only the last digit.

yy Year represented by only the last two digits. A

leading zero is added for single-digit years.
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yyyy Year represented by four or five digits,

depending on the calendar used. Thai Buddhist

and Korean calendars have five-digit years. The

"yyyy" pattern shows five digits for these two

calendars, and four digits for all other supported

calendars. Calendars that have single-digit or

two-digit years, such as for the Japanese

Emperor era, are represented differently. A

single-digit year is represented with a leading

zero, for example, "03". A two-digit year is

represented with two digits, for example, "13".

No additional leading zeros are displayed.

yyyyy Behaves identically to "yyyy".

g, gg Period/era string. Note that these format pictures

are ignored in date strings if there is no

associated period/era string.

Please note that PDF-XChange Editor uses these elements to construct a null-terminated format

picture string. If spaces are used to separate the elements in the input string then they will appear in the

same location in the output string. The format types "d", "g", and "y" must be lowercase, and the letter

"M" must be uppercase. PDF-XChange Editor uses single quotation marks to mark characters to

display exactly as specified. If you need to display a single quotation mark in the output string then

place two single quotation marks in a row in the input string. For example, 'abc''bar' is displayed as

"abc'bar".

Hour, Minute, Second and Time Marker Format Pictures

DATE

FORMAT 

DEFINITION

h Hour without leading zeros for single-digit hours

(12-hour clock).

hh Hour with leading zeros for single-digit hours

(12-hour clock).

H Hour without leading zeros for single-digit hours

(24-hour clock).

HH Hour with leading zeros for single-digit hours

(24-hour clock).

m Minute without leading zeros for single-digit

minutes.
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mm Minute with leading zeros for single-digit

minutes.

s Second without leading zeros for single-digit

seconds.

ss Second with leading zeros for single-digit

seconds.

t One-character time marker string. Please note

that this format is not recommended for use with

some languages, such as Japanese (Japan).

tt Multi-character time marker string.

Z Time zone offset (from UTC) of current user.

Please note that PDF-XChange Editor uses these elements to construct a format picture string. Format

pictures consist of a combination of one string of each of the hour, minute, second and time marker

format types. The format types "m", "s", and "t" must be lowercase, and "h" must be lowercase to

denote the 12-hour clock or uppercase ("H") to denote the 24-hour clock. PDF-XChange Editor uses

single quotation marks to mark characters to display exactly as specified. If you need to display a single

quotation mark in the output string then place two single quotation marks in a row in the input string.

For example, 'abc''bar' is displayed as "abc'bar".
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3.4.10 Document Tab Options

 Document Tab Options

Document tab options are available in the right-click shortcut menu of document tabs:

Figure 1. Document Tab Right-Click Shortcut Menu

· Click Duplicate Tab to duplicate the selected tab. A new window will open for the same

document and the current page and layout options will be inherited.

· Click Rename to rename the document.

· Click Close This Tab to close the selected tab.

· Click Close All Tabs But This to close all tabs except the selected tab.

· Click Sort All Tabs Alphabetically to sort all open tabs alphabetically.
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· Hover over Tab Title Style to view tab title style options:

· Select Auto to determine the tab title style automatically.

· Select Document Title to use the document title as the tab title. Document titles can be

viewed/edited in the Document Properties of the document.

· Select Document Filename to use the document filename as the tab title.

· Select Middle Ellipsis to set ellipses in the middle of document names that are too long

to fit in the document title tab.

· Select End Ellipsis to set ellipses at the end of document names that are too long to fit in

the document title tab.

· Click Copy Full File Name to copy the full name of the selected file to the clipboard.

· Click Copy File to copy the file.

· Click Open Containing Folder to open the containing folder of the selected file.

· Click Move to Trash to move documents into the Windows recycle bin.

· Click Document Properties to view document properties.

Note that when multiple tabs are open you can use the keyboard shortcut [Ctrl+Num1] to activate the

desired document tab. For example, [Ctrl+Num2] opens the second document tab, and [Ctrl+Num5]

opens the fifth document tab.
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3.4.11 Editing Document Pages

 Editing Document Pages

Use the options detailed below to edit documents:

· The Edit Objects Tool  is used to select/edit document content such as images and text.

· The Add Tool  is used to add text, images and barcodes to documents.

· The Select Fields Tool  is used to select/edit form fields.

· The Select Comments Tool  is used to select/edit comments and annotations.

· The Content  pane is used to to view/edit page content.

· The Selection  feature is used to edit selected content.
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3.4.12 Editing Text in Annotations

 Editing Text in Annotations

When commenting tools that contain text options are being used, text settings are detailed in the

Format tab: 

Figure 1. Format Tab, Text Editing Options

Available properties depend on the tool in use. All available properties are detailed below:

· Select an option in the Fill Color dropdown menu to determine the fill color of the text.

· Enter a font in the Font combo box, or use the dropdown menu, to determine the font of the

text.



1143

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Enter a value in the Font Size combo box, or use the dropdown menu, to determine the size of

the text.

· Click Grow Font/Shrink Font to increase/decrease the size of the text.

· Click Bold, Italic, Underline, Strikethrough, Subscript or Superscript to enable/disable these

text options.

· Click Align Text Left, Center Text, Align Text Right or Justify Text to adjust the alignment of

text.

· Click Clear Style to revert text to the default style for the current tool.

· Click Make Default to set the current style as the default style for the current tool.

· Click Copy Style to copy the style properties of selected text. Use the Apply Copied Style

feature detailed below to apply copied styles to text.

· Click Apply Default Style to apply the default text style for the current tool to selected text.

· Click Properties to open the Properties  pane, which can be used to view/edit the properties

of selected text. The Properties pane contains two additional properties for editing text:

· Script Style determines the script style of text:

· No means that the text does not have a script style.

· Superscript transforms selected text into superscript, which is used for specific

purposes such as detailing chemical compounds.  

· Subscript transforms selected text into subscript, which is used for specific

purposes such as detailing mathematical formulae.

· Char Spacing determines how characters are spaced within the annotation. Enter a

numerical value between 1 and 1000 in the number box to determine the spacing used.

Right-click text for further editing options:

441
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Figure 2. Text Editing Right-Click Submenu

· Click Undo to undo the most recent editing action.

· Click Cut, Copy, Paste or Select All to perform these editing options on selected text.

· Click Paste as plain text to paste text in the clipboard as plain text in the document.

· Click HyperLink to convert selected text into a hyperlink.

· Click Paragraph to view/edit paragraph options:

· Use the Alignment options to align text to the left/center/right or justify text.

· Use the Left and Right indentation number boxes to determine the left and right

indentation.

· Use the Special dropdown menu to add indentation for the first line/hanging indentation.

· Use the Spacing options to determine paragraph spacing.

· Click Text Style edit the style of selected text. These options are detailed in (figure 1).

· Click Hyphenate Text to enable/disable text hyphenation for words at the end of lines.
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3.4.13 Features Added in V10

 Features Added in V10

The following features were added in version 10 of PDF-XChange Editor:

Version 10.0.0.370

· Added functionality that enables the creation of custom stamps, as detailed here.

· 'Add from Bookmark' option added to the 'Edit Action List' when setting link targets, making it

possible to add 'Go To Page' actions using a link target from a bookmark.

· Added the option to create PDFs from webpages without the need to open the webpage, as

detailed here.

· The Accounting Calculator was added to the software, making it possible to perform

mathematical calculations and add accounting tapes to documents, as detailed here.

· The Identify Forms feature was added to the software, making it possible to identify form

fields in documents converted to PDF from other formats, as detailed here.

· Added the option to use the a webcam for various operations, such as creating new documents

from images and creating physical signatures for documents.

· Added functionality that makes it possible to export links to a CSV file, as detailed here.

· Added functionality enables the editing and manipulation of shapes/paths in document

content, as detailed here.

Version 10.1.0.380

· Added the ability to reverse sub-paths, as detailed here.

· Updated the 'Replace Pages'  page range options to use a new page range style.

· Added an option to fix invalid 'ToUnicode' maps for embedded fonts.

· Added an option to use 'bottom-up Y-axis' in the Transform  tool.

· Added an 'Audit Space Usage' command in the DocumentInfo  location and the File

menu.

· Added a feature to Merge Selected Layers.

· Added an option to paste copied PDF content as stamp.

· Added a feature to search for terms inside the 'Preferences'  dialog box.

· Enhanced the 'Quick Launch' feature to include finding items inside the 'Preferences' dialog

box. 
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· Added a live preview of the inking process for the Pencil Tool when using a stylus/digitizer.

· Added an option to choose how to truncate document tab titles when the tab is too narrow to

display all its text.

· Added an option to allow the application of stamps with the previously used stamp size.

· Added a Group Policy to the PDF-XChange Editor Administrative Template to prevent users

from creating self signed certificates.

· Added a “Filling Rule” property for path content items.

· Added an option to apply redactions to form field content.

Version 10.2.0.384

· Added the ability to create 'Places' for WebDAV services, as detailed here.

· Added commands that enable the toggling of document tab title styles in the document tab

context menu, as detailed here.

· Improved control of image compression in the Enhance Scanned Pages  operation.

· Updated the Comments  pane with a range of new features.

· Added the Set Margins  feature that can be used to set the margins of document pages.

· Added the Convert Email to PDF  feature.
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3.4.14 Find

 Find

Click Find (or press Ctrl+F) to launch the Find function:

Figure 1. Find Function

The Find function is used to find specified text in the current document:

Figure 2. Find Function
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· Enter the search terms in the text box and press enter to search the active document. Text that

matches the search terms will be highlighted. Click the red 'x' icon, detailed in (figure 1), to

reset the search.

· Use the arrow in the text box to browse previous searches.

· Use the second arrow to customize the parameters and location of searches. 

· Use the left and right arrow icons, or press F3/Shift+F3, to move backwards and forwards

between search results.
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3.4.15 Keyboard Shortcuts

 Keyboard Shortcuts

PDF-XChange Editor supports a number of keyboard shortcuts that can be used to activate

commands:

COMMAND SHORTCUT

Activate Document Tab

Activate the tab number

specified, in cases where

multiple document tabs are

open.

Ctrl+Num1 to Ctrl+Num10

Actual Size

Set the zoom level to 100%

and show document pages at

their actual size.

Ctrl+1 

Add Bookmark

Create a new bookmark that

points to the current page.

Ctrl+Shift+B

Align Text Left

Align text to the left.

Ctrl+L

Align Text Right

Align text to the right.

Ctrl+R
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Attachments

Show/Hide the Attachments

pane.

Ctrl+Shift+A

Auto-Scroll

Enable/Disable the auto-scroll

feature.

Ctrl+Shift+H

Back

Navigate Backward.

Alt+Left

Bold

Make the selected text bold.
Ctrl+B

Bookmarks

Show/Hide the Bookmarks

pane. 

Ctrl+B 

Calibrate Measurement

Create a new scale for use

with the measurement tools.

Ctrl+Shift+C

Center Text

Center selected text.
Ctrl+E

Close

Close the active document.
Ctrl+W

Comments

Show/Hide the Comments

pane.

Ctrl+M

Contents

Launch online manual.
F1

358
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Copy

Copy the selection to the

clipboard. 

Ctrl+C 

Create New Document

Create a new, blank

document.

Ctrl+N

Crop Pages

Redefine the visible area of

the document.

Ctrl+Shift+T 

Cut 

Copy the selection to the

clipboard and remove it from

the active document.

Ctrl+X 

Delete

Delete the selection.

 

Delete 

Delete Pages

Delete pages from the active

document.

Ctrl+Shift+D 

Demote Bookmarks

Demote the selected

bookmarks.

Alt+Right

Document Info Bar

Show/Hide the Document Info

Bar.

Ctrl+Alt+I
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Document Properties

Show the properties of the

active document.

Ctrl+D 

Edit Code Snippets

Manage JavaScript code

snippets.

Ctrl+J

Edit Form

Edit/create form fields. 

Ctrl+Shift+7

Enable Hand Tool

Temporarily

Override the active tool with

the Hand Tool

Press and hold Space

Enable Snapping

Enable the snapping feature. 

Ctrl+Shift+;

Exclusive Mode

Enable/Disable exclusive

mode for the active tool. Hold

Shift to enable Exclusive

Mode temporarily.

Ctrl+G, Ctrl+E

Exit

Exit the application.

Ctrl+Q

Extract Pages

Extract pages from the active

document.

Ctrl+Shift+E

Fields

Show/Hide the Fields pane. 

 

Ctrl+I 
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Find

Find text in the active

document.

 

Ctrl+F 

First Page

Move to the first page of the

document.

Home

Fit Page

Fit the active page(s) to the

document window.

Ctrl+0

Fit Visible

Fit the active page(s)

according to width and

exclude white margins.

Ctrl+3

Fit Width

Fit the active page(s)

according to width and

include white margins. 

Ctrl+2 

Forward

Navigate forward.

Alt+Right

Full Screen Mode

View document in full screen.

F11

Go to Bookmark

Move to the selected

bookmark.

Space

Go to Destination Space
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Move to the selected

bookmark.

Go to Next Entry

Move to the next found item.

(This is intended for use with

the Find  feature).

F3

Go to Page

Move to specific page of the

active document.

Ctrl+Shift+N

Go to Previous Entry

Move to previous found item.

(This is intended for use with

the Find  feature). 

Shift+F3

Hide All Comments

Hide all comments in the

active document.

Ctrl+Shift+8

Highlight Form Fields

Highlight required form fields.

A color background will be

inserted. 

Ctrl+Alt+H

Insert Pages

Insert pages into the active

document.

Ctrl+Shift+I

Invert Selection

Deselect the current selection

and select unselected items.

This shortcut is intended for

use with the Editing

Panes.

"Num *"

1147

1147

342
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Italic

Italicize selected text.

Ctrl+I

Justify Text

Justify selected text.

Ctrl+J

Last Page

Move to the final page of the

document.

End 

Layers 

Show/Hide the Layers pane.

The Layers pane shows the

structure of the document's

layers, allowing for their

visibility to be altered.

Ctrl+L 

Menu Toolbar

Show/Hide the Menu

Toolbar.  Note that this

toolbar is visible only in the

Classic UI layout and not

present in the Ribbon UI.

F9

Move Down

Move the selected

bookmark(s) down.

Alt+Down

Move Keybord Focus to

Page View

Moves the focus of the

keyboard to the page view.

Ctrl+Home

Move Up

Move the selected

bookmark(s) up.

Alt+Up

1037
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New Attachment

Add a new attachment.

Insert

New Bookmark After

Selected

Creates a new bookmark after

the selected bookmark. If no

bookmark is selected then a

new one is created at the end

of the bookmark list.

Insert

New Bookmark Before

Selected

Creates a new bookmark

before the selected

bookmark. If no bookmark is

selected then a new one is

created at the end of the

bookmark list.

Alt+Insert

New Child Bookmark

Creates a new bookmark as

the first child of the selected

bookmark. If no bookmark is

selected then a new one is

created at the end of the

bookmark list.

Ctrl+Alt+Insert

New Last Child Bookmark

Creates a new bookmark as

the last child of the selected

bookmark. If no bookmark is

selected then a new one is

created at the end of the

bookmark list.

Ctrl+Insert

New Destination

Assign the the current view as

a new destination.

Insert
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Next Document

Move to the next open

document.

Ctrl+Tab

Next Page

Move to the next page of the

active document.

Ctrl+Right

Open

Open an existing document.

Ctrl+O

Override Document Colors

Display document colors

according to the selected

color scheme.

Ctrl+Shift+6

Paste

Paste the clipboard content

into the active document.

Ctrl+V

 

Preferences

Launch the Preferences dialog

box.

Ctrl+K

 

Previous Document

Move to the previous

document.

Ctrl+Shift+Tab

Previous Misspelling

Move to the previous

misspelling. (This shortcut is

intended for use with the

Spell Check feature).

Alt+F7

Previous Page Ctrl+Left
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Move to the previous page of

the active document.

 

 

Print

Print the active document.

Ctrl+P

 

Promote Bookmark

Promote the selected

bookmark(s).

Alt+Left

Properties Pane

Show/Hide the Properties

pane for the selected

object(s).

Ctrl+`

Properties Toolbar

Show/Hide the Properties

Toolbar.  Please note that

the contents of this toolbar

depends on selected content

and/or active tool.

Additionally, this toolbar is

visible only in the Classic UI

layout and not present in the

Ribbon UI.

Ctrl+E

Redo

Reverse the most recent undo

action.

Ctrl+Y

Rename

Rename the selected item.

Please note that this shortcut

only works with items that

have editable names, such as

forms.

F2

1037
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Reopen Recently Closed

Document

Reopen closed documents.

Ctrl+Shift+W

Rotate Counterclockwise

Rotate the current view

counterclockwise. Please note

that this feature is intended

for viewing purposes - the

original document is not

modified.

Ctrl+Shift+"Num-"

Rotate Clockwise

Rotate the current view

clockwise. Please note that this

feature is intended for viewing

purposes - the original

document is not modified.

Ctrl+Shift+"Num+"

Rotate Pages

Rotate pages of the active

document.

Ctrl+Shift+R

 

Run

Run the script written in the

console window. 

Ctrl+Enter

Run Selection

Run selected script.

Ctrl+Shift+Enter

Save

Save the active document.

 

Ctrl+S

 

Save As

Save the active document with

a new name/location.

Ctrl+Shift+S 
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Search Pane

Show/Hide the Search pane.

Ctrl+Alt+F

Select All

Select all text.

Ctrl+A

Show All Comments

show all comments in the

active document.

Ctrl+8

Show Gaps Between Pages

Show/Hide gaps between

pages. 

Ctrl+Shift+G

Show Grid

Inserts a grid into the

document background to

assist in content placement.

Ctrl+'

Show Guides

Show/Hide guides to assist in

content placement. Click and

drag from rulers (see Show

Rulers, below) to create

guides.  

Ctrl+;

Show JavaScript Console

Show the JavaScript Console.

Ctrl+J

Show Rulers

Show/Hide rulers. These can

be used to determine the size

of document content. The

units of measurement for the

rulers can be determined in

Ctrl+R
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the Measurement

 preferences.

Spell Check

Activate the Spell Check

feature and move to the first

misspelling.

F7

Strikethrough

Insert a line through selected

text.

Ctrl+Shift+S

Thin Lines

Enable/Disable the Thin Lines

feature, which displays all lines

used for editing purposes at a

thickness of one pixel. 

Ctrl+5

Thumbnails

Show/Hide the Thumbnails

pane. This pane displays

miniature previews of each

page within active documents

and enables simple document

browsing.

Ctrl+T

Toggle All Command Panes

Show/Hide all toolbars and

menus.

Ctrl+F8

Toggle All Toolbars

Show/Hide all toolbars.

F8

Underline

Underline selected text.

Ctrl+U

238
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Undo

Undo the most recent action.

Ctrl+Z

Zoom In

Zoom in on the page.

Ctrl+"Num+"

Zoom Out

Zoom out from the page.

Ctrl+"Num-"

Zoom To

Zoom to a custom level.

Ctrl+Shift+M

Follow the steps below to customize keyboard shortcuts:

1. Click Customize Toolbars in the Help tab:



1163

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 1. Help Tab, Customize Toolbars

The Customize Toolbars dialog box will open:

2. Click the Commands tab:
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3. Use the Categories list to select a section of the application. (The default selection is <All

Commands>, which means all available keyboard shortcuts are displayed). When sections are

selected their actions and associated keyboard shortcuts are displayed in the list on the right. 

4. Select an action and click Properties. The Command Properties dialog box for the selected

action will open. The Command Properties dialog box for the Add Bookmark function is

detailed below:



1165

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

5. Assigned shortcuts are detailed in the Assigned pane. Use the Keys text box to determine new

shortcuts and then press OK. (If entered key combinations are already in use then the associated

feature will be displayed in the Shortcut currently used by text box).



1166

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.4.16 Macros

 Macros

Macros are used throughout PDF-XChange Editor. 'Macro' is an abbreviation of 'macroinstruction' - a

term in computer science for a rule that specifies how input characters should be entered to create

corresponding output. This means that components of the output process can be simplified during the

input process, which makes the work involved less intensive and more dynamic. Multiple macros can be

used simultaneously as desired. The format for macros is: 

%[<Macro Name>] or, when it is customizable: %[<Macro Name>:<Parameter>]. The

<Parameter> step is optional.

For example, the Page Number macro can be used to specify the page numbering format. The syntax

for the Page Number macro is %[Page:<Parameter>] and the following parameters are available:

· 'r' specifies the use of lower-case roman numerals - %[Page:r].

· 'R' specifies the use of upper-case roman numerals - %[Page:R].

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used - %

[Page:L].

· '<integer>' specifies the minimum number of digits used. This value can be any positive

integer from 1 to 12 - for example %[Page:4] starts the page numbering as "0001, 0002,

0003...".

When macros are available the macro icon is displayed:
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Figure 1. Macro Icon

Click the macro icon to view a list of available options, then click macros to add them to the associated

text box. All available macros are detailed below:

· Application Version

· Auto Number

· Bates Numbering

· Bates Page Numbering Value

· Bookmark Level

· Bookmark Title

· Computer Name

· Date

· Day

· Document Index

· Document Info

· Document Title

1169

1171

1174

1176

1178

1181

1184

1186

1189

1192

1195

1201
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· Environment Variable,  which has multiple options relating to the environment variables

of the file.

· FileName

· File Extension

· File to Open

· Folder Name

· Folder Title

· Hierarchical Index

· Hour

· Index in Parent

· Minute

· Month

· Named Destination

· Number of Pages

· Page First Text Line

· Page Label

· Page Number

· Page Numbering Style

· Seconds

· Sequential Number

· Time

· Username

· Web Link to Open

· Year

A list of macro-enabled operations is available here.

Please note that certain symbols are not compatible with macros and therefore are not permitted in

document names. If inconsistencies occur between the name used when files are saved and the final file

name then it is advised to change the name used when files are saved.

1203

1207

1211

1213

1217

1219

1221

1224

1227

1230

1233

1236

1240

1243

1246

1249

1254

1261

1264

1267

1270

1272

1276

1279

https://en.wikipedia.org/wiki/Environment_variable
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3.4.16.1 Application Version

 Application Version

The Application Version macro inserts the build and version of PDF-XChange Editor on the local

computer.

The syntax for this macro is %[AppVersion]

Example
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Figure 1. %[Application Version] Macro Example
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3.4.16.2 Auto Number

 Auto Number

The Auto Number macro inserts a numerical value as the name for output files.

The syntax for this macro is %[AutoNumber] and two sections of parameters are available.

The first section determines the format of page numbers:

· 'r' specifies the use of lower-case roman numerals.

· 'R' specifies the use of upper-case roman numerals.

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used.

· '<integer>' specifies the minimum number of digits displayed for page numbers. This value

can be any positive integer from 1 to 12 - for example %[Autonumber:4] starts the numbering

as "0001, 0002, 0003...".

The second section determines the offset for the start value. Note that the default offset is zero and the

default starting value is 1. This means that if, for example, you want to start from 5, then you must

specify '4'. 

Please note that a semicolon must be used to delimit the sections of parameters. If the second section

is not used then the semicolon can be omitted. However, if the first section is not used and the second

section is used, then it is necessary to use the semicolon.

The syntax for this macro when both parameters are used is %[Autonumber:<Parameter

1>;<Parameter 2>]

The syntax for this macro when only the second parameter is used is %[Autonumber:;<Parameter

2>]. For example, '%[AutoNumber:;3]' sets the start value as four. 

Note that the starting value for output files depends on files contained in the destination folder. If the

folder is empty, or does not contain files with names that match the output parameters detailed above,

then the default values are used. If the folder does contain files that match the output parameters

detailed above, then the starting value will be the lowest possible integer.
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Example

Follow the steps below to use the Auto Number macro to name extracted document pages:

1. Open a multi-page document in PDF-XChange Editor.

2. Click the Organize tab, then click Extract Pages. The Extract Pages dialog box will open.

3. Enter the desired page range for extraction in the Page Range section.

4. Enter the desired %[AutoNumber] macro in the Filename text box:

Figure 1. Extract Pages Dialog Box

5. Click OK. The pages will then be extracted from the document and autonumbered:
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Figure 2. Output Files

Note that each file name uses six digits as the parameter '6' was used.
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3.4.16.3 Bates Numbering

 Bates Numbering

The Bates Numbering macro inserts the Bates numbering value of document pages and can only be

used in conjunction with the Add Bates Numbering  feature.

The syntax for this macro is %[Bates]

Example

If the %[Bates] macro is used then the Bates numbering value of the page is inserted:

916
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Figure 1. %[Bates Value] Macro Example
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3.4.16.4 Bates Page Numbering Value

 Bates Page Numbering Value

The Bates Page Numbering macro inserts the existing Bates numbering value of document pages.

The syntax for this macro is %[BatesValue] and a parameter is available for the specification of a page

number as detailed below. If no parameter is used, then the Bates value used will match the Bates

number of the pages in the specified page range of the operation.

The syntax for this macro when parameters are used is %[BatesValue:n] where 'n' specifies the page

from which the Bates number is taken. It is also possible to use %[BatesValue:^n] to specify the page

that is 'n' pages from the end of the document.

Example

Follow the steps below to use the Bates Page Numbering Value macro to create watermarks that

contain the Bates number of pages:

1. Open a document that contains Bates numbering in PDF-XChange Editor.

2. Click Watermarks, then click Add. The Add Watermark dialog box will open.

3. Enter %[BatesValue] in the Text text box. The Bates number of pages is then used to create

the watermark text for the associated page:
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Figure 1. %[Bates Value] Macro Example
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3.4.16.5 Bookmark Level

 Bookmark Level

The Bookmark Level macro inserts the nested level of bookmarks.

The syntax for this macro is %[Level]

Example

Follow the steps below to insert the nested level of bookmarks when adding text to bookmark titles:

1. Open a document that contains bookmarks in PDF-XChange Editor.

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Title dialog box will open.

3. Add the %[Level] macro to the Add Suffix text box:
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Figure 1. Add Text To Bookmark Title Dialog Box, %[Level] Macro Used as Suffix

4. Click OK. The nested level of bookmarks will then be added as a suffix to the existing

bookmark titles:
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Figure 2. Bookmarks Titles Updated to Include Nested Level
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3.4.16.6 Bookmark Title

 Bookmark Title

The Bookmark Title macro inserts the title of bookmarks.

The syntax for this macro is %[Title]

Example

Follow the steps below to insert the title of bookmarks when converting bookmarks to named

destinations:

1. Open a document that contains bookmarks in PDF-XChange Editor.

2. Click the Bookmarks tab, then click Convert to Named Destinations. The Convert to Named

Destinations dialog box will open.

3. Add the %[Title] macro to the text box:
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Figure 1. Convert to Named Destinations Dialog Box, %[Title] Macro Used as Pattern

4. Click OK. The title of each bookmarks will then be used as the title for each corresponding

named destination:
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Figure 2. New Named Destinations Created with Matching Names to Source Bookmarks 

Further information about named destinations is available here. 393
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3.4.16.7 Computer Name

 Computer Name

The Computer Name macro inserts the name of the local computer as defined by the Windows

Computer Name.

The syntax for this macro is %[Computer]

Example
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Figure 1. %[Computer] Macro Example



1186

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.4.16.8 Date

 Date

The Date macro inserts the current date. Multiple date formats are available, as detailed below.

The syntax for this macro is %[Date] and the following parameters are available:

· d inserts the day of the month and omits the zero in cases of single-digit values.

· dd inserts the day of the month and includes a zero in cases of single-digit values.

· ddd inserts the day of the week as a three-letter abbreviation.

· dddd inserts the day of the week.

· M inserts the month and omits the zero in cases of single-digit values.

· MM inserts the month and includes a zero in cases of single-digit values.

· MMM inserts the month as a three-letter abbreviation.

· MMMM inserts the month.

· yy inserts the year as two digits and adds a zero in cases of values lower than 10.

· yyyy inserts the year.

The syntax for this macro when parameters are used is %[Date:<Parameter>]

Note that several parameters can be used in sequence in order to insert a customized date. For

example, %[Date:dddd, dd MMMM yyyy] inserts the day of the week followed by the day of the

month, the month name in full and the year as four digits (as detailed below). If parameters are not

specified then output values revert to default, which is the date on the local machine in the format

dd/MM/yyy.

Example

Follow the steps below to use the Date macro to add a header that uses a customized version of the

current date:

1. Click the Organize tab.

2. Click Header and Footer, then click Add. The Add Header and Footer dialog box will open.
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3. Enter %[Date:dddd, dd MMMM yyyy] in a header text box. A customized version of the

current date is then added to the document:

Figure 1. %[Date] Macro Example

Note that a range of preset date formats are provided in PDF-XChange Editor:
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Figure 2. Default Date Macro Formats
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3.4.16.9 Day

 Day

The Day macro inserts the current day of the month.

The syntax for this macro is %[Day]

Example

If the date is 5th April then the %[Day] macro inserts "05":



1190

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 1. %[Day] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Month]/%[Day] output the current

time followed by the month and the day of the month:
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Figure 2. %[Day] Combined Macro Example
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3.4.16.10 Document Index

 Document Index

The Document Index macro inserts the index value of pages, which is the input/output order of the

content in the context of a group of input/output content items.

The syntax for this macro is %[DocNumber] and a parameter is available for the specification of the

minimum amount of digits used for numbering output. This value can be any positive integer from 1 to

12. If the parameter is not used then the output is numbered with the default settings, which uses the

page number of source files as the output number.

The syntax for this macro when parameters are used is %[DocNumber:<Parameter>] - for example %

[DocNumber:4] starts the numbering as "0001, 0002, 0003...".

Example

Follow the steps below to use the Document Index macro to extract each page of a document to a

new document that uses the page number of source pages as the title of the output documents:

1. Click the Organize tab, then click Extract Pages. The Extract Pages dialog box will open.

2. Specify a page range to be extracted. This example will extract pages 6-10 of a ten page

document. 

3. Select Save each page to a separate file in the Type dropdown menu, then enter the macro %

[DocNumber:5] in the Filename text box:
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Figure 1. Extract Pages Dialog Box, Organize Tab

4. Click OK. 

A new document will then be made for each specified page of the source document. The names of the

new documents will be the page numbers of the source pages. The parameter '5' was used, therefore

five digits are used for each document title:
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Figure 2. %[DocNumber] Macro Output Folder
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3.4.16.11 Document Info

 Document Info

The Document Info macro inserts document metadata information. 

The syntax for this macro is %[DocInfo] and the following parameters are available:

· Title inserts the data in the Document Title field.

· Author inserts the data in the Author field.

· Subject inserts the data in the Subject field.

· Keywords inserts the data in the Keywords field.

· Creator inserts the name of the application used to create the document.

· Producer inserts the PDF Producer of the document.

· CreationDate inserts the date and time when the document was created, followed by the UTC

offset.

· ModDate inserts the date and time when the document was last modified, followed by the

UTC offset.

The syntax for this macro when parameters are used is %[DocInfo:<Parameter>]

Note that the names of any standard fields from the document properties can be used as parameters

for this macro. For example, entering the macro %[DocInfo:Trapped] inserts the current value of the

Trapped field detailed here.  Additionally, if parameters have been specified using the JavaScript

console and custom names have been used to replace the standard names, then the custom names can

be used.

Document properties can be viewed/edited in the Document Properties dialog box. Click the File tab,

then click Document Properties to view this dialog box:

188

https://en.wikipedia.org/wiki/UTC_offset
https://en.wikipedia.org/wiki/UTC_offset
https://en.wikipedia.org/wiki/UTC_offset
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Figure 1. Document Properties Location

The Document Properties dialog box will open:
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Figure 2. Document Properties Dialog Box

Examples

Follow the steps below to use the Document Info macro to add Bates numbering that uses the date

and time that the document was last modified:

1. Click the Organize tab.

2. Click Bates Numbering, then click Add. The Add Bates Numbering dialog box will open.

3. Enter %[DocInfo:ModDate] in the desired text box. The date and time the document was last

modified is then inserted as Bates numbering:
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Figure 3. %[DocInfo] Macro Example

Alternatively, enter %[DocInfo:Title] to insert the document title:
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Figure 4. %[DocInfo] Macro Example Two

Note that it is possible to use more than one macro at a time. For example the text %[DocInfo:Title],

%[DocInfo:Author] returns both the document name and the author name:
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Figure 5. %[DocInfo] Macro Example Three
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3.4.16.12 Document Title

 Document Title

The Document Title macro inserts the document title. 

The syntax for the this macro is %[DocTitle]

Example

Follow the steps below to use the Document Title macro to create a watermark from the document

title:

1. Click the Organize tab.

2. Click Watermarks, then click Add. The Add Watermark dialog box will open.

3. Enter %[DocTitle] in the Text text box. The document title is then used as the watermark text:
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Figure 1. %[DocTitle] Macro Example
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3.4.16.13 Environment Variable

 Environment Variable

The Environment Variable macro inserts information taken from user-specified environment variables.

The syntax for this macro is %[Env:<Parameter>] 

Note that a parameter must be used in order for this macro to return information. The following

parameters are available:

ALLUSERSPROFILE

Inserts the full path to the All Users profile directory.

APPDATA

Inserts the full path to the Application Data directory of the current user.

CommonProgramFiles

Inserts the full path to the Common Files directory.

CommonProgramFiles(x86)

Inserts the full path to the (x86) Common Files directory in 64-bit versions of Windows.

CommonProgramFilesW6432

Inserts the full path to the Common Files directory in 64-bit versions of Windows.

COMPUTERNAME

Inserts the computer name.

HOMEDRIVE
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Inserts the drive letter on the local computer that is connected to the user's home directory.

HOMEPATH

Inserts the complete path of the current user's Home directory, as defined by the user's account

properties.

LOCALAPPDATA

Inserts the complete path to the current user's Application Data directory.

LOGONSERVER

Inserts the name of the domain controller that authenticated the client's logon request.

OS

Inserts the name of the operating system.

PROCESSOR_ARCHITECTURE

Inserts the chip architecture of the CPU.

ProgramData

Inserts the full path to the All Users profile directory.

ProgramFiles

Inserts the full path to the Program Files directory.

ProgramFiles(x86)

Inserts the full path to the (x86) Program Files directory in 64-bit versions of Windows.

ProgramFilesW6432

Inserts the full path to the Program Files directory in 64-bit versions of Windows.

PUBLIC

Inserts the full path to the Public directory.
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SESSIONNAME

Inserts the session name and number when a client is connected via a terminal server.

SystemDrive

Inserts the name of the drive on which the system folder was placed.

SystemRoot

Inserts the name of the system folder.

TEMP

Inserts the name of the default temporary folder used by the operating system and applications

available to the current user.

TMP

Inserts the name of the default temporary folder used by the operating system and applications

available to the current user. (Note that some applications require the TEMP environment

variable, whilst others require TMP. The values for both should be identical).

USERDOMAIN

Inserts the name of the user domain that contains the account of the current user.

USERDOMAIN_ROAMINGPROFILE

Inserts the name of the user domain for RDS or standard roaming profile paths.

USERNAME

Inserts the name of the current user.

USERPROFILE

Inserts the location of the current user's profile directory. 

windir

Inserts the full path to the Windows directory.



1206

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Example

%[Env:CommonProgramFiles] inserts the full path to the Common Files directory:

Figure 1. [Env:CommonProgramFiles] Macro Example

Further information on environment variables is available here.

https://en.wikipedia.org/wiki/Environment_variable
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3.4.16.14 FileName

 FileName

The FileName macro inserts the name of the source file.

The syntax for this macro is %[FileName:range]

The 'range' parameter is optional and can be used to specify a section of the filename as desired.

Available options for this parameter are detailed below: 

· Character numbers separated by a comma. For example: %[FileName:1,3,5,7] outputs the first,

third, fifth and seventh characters of the filename.

· Character ranges (i.e. indexes in the range separated with a dash). For example: %[FileName:2-

6] outputs the second to the sixth characters of the filename.

· A dash followed by a character number. This outputs the characters of the filename up to the

specified character. For example: %[FileName:-5] outputs the first five characters of the

filename.

· A character number followed by a dash. This outputs all characters of the filename from the

specified character. For example: %[FileName:5-] outputs all characters from the fifth

character of the filename.

Example

Follow the steps below to use the FileName macro to insert the name of the source file as the stamp

title when creating a new stamp:

1. Click the Stamp dropdown menu in the Home tab, then click then click Stamps Palette. The

Stamps Palette will open.

2. Click Add New, then click Add New Stamp from File:
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Figure 1. Stamps Palette, Add New Stamp From File

The Open Files dialog box will open.

3. Select a file to use as the stamp and then click Open. The Add New Stamp dialog box will

open.

4. Enter %[FileName] in the Stamp Title dialog box and select a target collection:
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Figure 2. Add New Stamp Dialog Box

5. Click OK.

A new stamp will then be created and the name of the source file will be used as the title:
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Figure 3. New Stamp
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3.4.16.15 File Extension

 File Extension

The File Extension macro inserts the file extension of the current file.

The syntax for this macro is %[FileExt]

Example

Follow the steps below to use the File Extension macro to insert the file extension of the current file

when adding a header to documents:

1. Click the Organize tab.

2. Click Header and Footer, then click Add. The Add Header and Footer dialog box will open.

3. Enter %[FileExt] in one of the header/footer text boxes. The file extension of the file is then

inserted as a header:
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Figure 1. %[FileExt] Macro Example
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3.4.16.16 File to Open

 File to Open

The File to Open macro inserts the name of the file in bookmark actions that involve the opening of a

file.

The syntax for this macro is %[File]

Example

Follow the steps below to use the File to Open macro to insert the name of the file specified in the

associated bookmark action when adding text to bookmark titles:

1. Open a document that contains bookmarks (including a bookmark with an Open a File action)

in PDF-XChange Editor. For example, in the following document, "Bookmark A" contains an

Open a File action and the associated document is "Icons.pdf":
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Figure 1. Edit Action List for 'Bookmark A'

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Titles dialog box will open.

3. Add the %[File] macro to the Add Suffix text box:
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Figure 2. Add Text To Bookmark Title Dialog Box, %[File] Macro Used as Suffix

4. Click OK. The name of the file in the Open a File bookmark action is then added to the

bookmark title:
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Figure 3. Bookmark Title Updated to Include Name of File to Open
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3.4.16.17 Folder Name

 Folder Name

The Folder Name macro inserts the path of the folder that contains the source file. Note that folder

names end with a backslash when local files are used.

The syntax for this macro is %[FolderName]

Example

Follow the steps below to use the Folder Name macro to insert the path of the folder that contains the

source file when a new watermark is created:

1. Click the Organize tab.

2. Click Watermarks, then click Add. The Add Watermark dialog box will open.

3. Enter %[FolderName] in the Text text box. The path of the folder that contains the source file

is then used as the watermark text:
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Figure 1. %[FolderName] Macro Example
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3.4.16.18 Folder Title

 Folder Title

The Folder Title macro inserts the title of the folder that contains the source file.

The syntax for this macro is %[FolderTitle]

Example

Follow the steps below to use the Folder Title macro to insert the title of the folder that contains the

source file when a new watermark is created:

1. Click the Organize tab.

2. Click Watermarks, then click Add. The Add Watermark dialog box will open.

3. Enter %[FolderTitle] in the Text text box. The title of the folder that contains the source file is

then used as the watermark text:
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Figure 1. %[FolderTitle] Macro Example
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3.4.16.19 Hierarchical Index

 Hierarchical Index

The Hierarchical Index macro inserts the hierarchical order of bookmarks.

The syntax for this macro is %[HierIndex]

Example

Follow the steps below to use the Hierarchical Index macro to insert the hierarchical order of

bookmarks when adding text to bookmark titles:

1. Open a document that contains bookmarks in PDF-XChange Editor.

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Titles dialog box will open.

3. Enter %[HierIndex] in the Add Suffix text box:
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Figure 1. %[HierIndex] Macro Example

4. Click OK. The hierarchical index of bookmarks will then be added as a suffix to all bookmark

titles:
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Figure 2. %[HierIndex] Macro Output Example



1224

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.4.16.20 Hour

 Hour

The Hour macro inserts the hour value from the current time.

The syntax for this macro is %[Hour]

Example

If the current time is 17:22 then the [Hour] macro inserts '17':
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Figure 1. %[Hour] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Hour]:%[Minute] output the hour followed by the

minutes of the hour:
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Figure 2. %[Hour] Combined Macro Example
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3.4.16.21 Index in Parent

 Index in Parent

The Index in Parent macro inserts the index of bookmarks in relation to their parent bookmark.

The syntax for this macro is %[IndexInPar]

Example

Follow the steps below to use the Index in Parent macro to insert the index of bookmarks in relation

to their parent bookmark when adding text to bookmark titles:

1. Open a document that contains bookmarks in PDF-XChange Editor.

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Titles dialog box will open.

3. Enter %[IndexInPar] in the Add Suffix text box:
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Figure 1. %[IndexInPar] Macro Example

4. Click OK. The index of bookmarks in relation to their parent bookmark will then be added as a

suffix to all bookmark titles:
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Figure 2. %[IndexInPar] Macro Output Example
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3.4.16.22 Minute

 Minute

The Minute macro inserts the minute value from the current time.

The syntax for this macro is %[Minute]

Example

If the current time is 11:26 then the %[Minute] macro inserts '26':
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Figure 1. %[Minute] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Hour]:%[Minute] output the hour followed by the

minutes of the hour:
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Figure 2. %[Minute] Combined Macro Example



1233

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

3.4.16.23 Month

 Month

The Month macro inserts the current month as a numerical value from 1-12.

The syntax for this macro is %[Month]

Example

If the current month is July then the %[Month] macro inserts "07":
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Figure 1. %[Month] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Month]/%[Day] output the current

time followed by the month and the day of the month:
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Figure 2. %[Month] Combined Macro Example
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3.4.16.24 Named Destination

 Named Destination

The Named Destination macro inserts name of the named destination in bookmark actions that

involve the opening of a named destination.

The syntax for this macro is %[Dest]

Example

Follow the steps below to use the Named Destination macro to insert the name of the named

destination specified in the associated bookmark action when adding text to bookmark titles:

1. Open a document that contains bookmarks (including a bookmark with a Named Destination

action) in PDF-XChange Editor. For example, in the following document, "Bookmark A"

contains a Named Destination goto action and the associated named destination is

"Destination 1":
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Figure 1. Edit Action List for 'Bookmark A'

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Titles dialog box will open.

3. Add the %[Dest] macro to the Add Suffix text box:
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Figure 2. Add Text To Bookmark Title Dialog Box, %[Dest] Macro Used as Suffix

4. Click OK. The name of the named destination in the bookmark action is then added to the

bookmark title:
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Figure 3. Bookmark Title Updated to Include Named Destination Title
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3.4.16.25 Number of Pages

 Number of Pages

The Number of Pages macro inserts the total number of document pages.

The syntax for this macro is %[Pages] and the following parameters are available

· 'r' specifies the use of lower-case roman numerals.

· 'R' specifies the use of upper-case roman numerals.

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used.

· '<integer>' specifies the minimum number of digits used. This value can be any positive

integer from 1 to 12 - for example %[Pages:4] starts the numbering as "0001, 0002, 0003...".

The syntax for this macro when parameters are used is %[Pages:<Parameter>]

Examples

Follow the steps below to use the Page Number macro to insert the total number of document pages

as a watermark:

1. Click the Organize tab.

2. Click Watermarks, then click Add. The Add Watermark dialog box will open.

2. Enter %[Pages] in the Text text box. The total number of document pages is then inserted as a

watermark:
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Figure 1. Add Watermark Dialog Box, %[Pages] Macro Example

Alternatively, enter %[Pages:R] in the Filename text box to insert the total number of document pages

as a watermark and specify the use of upper-case roman numerals:
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Figure 2. Add Watermark Dialog Box, %[Pages] Macro Example Two
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3.4.16.26 Page First Text Line

 Page First Text Line

The Page First Text Line macro inserts the first line of page text as the title for generated bookmarks.

The syntax for this macro is %[FirstLine]

Example

Follow the steps below to use the Page First Text Line macro to insert the first line of page text as the

bookmark title when using the Bookmark Every Nth Page  feature:

1. Open a document in PDF-XChange Editor.

2. Click the Bookmarks tab, then click Bookmark Every Nth Page. The Bookmark Every Nth

Page dialog box will open.

3. Enter %[FirstLine] in the Bookmark Title Template text box:

996
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Figure 1. %[First Line] Macro Example

4. Click OK. The first line of text on each page will then be added as the bookmark title:
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Figure 2. %[First Line] Macro Output Example
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3.4.16.27 Page Label

 Page Label

The Page Label macro inserts the page label of bookmarks.

The syntax for this macro is %[Label]

Example

Follow the steps below to use the Page Label macro to insert the page label of bookmarks when using

the Add Text to Bookmark Titles feature:

1. Open a document in PDF-XChange Editor.

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Title dialog box will open.

3. Enter %[Label] in the Add Suffix text box:
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Figure 1. %[Label] Macro Example

4. Click OK. The page label of bookmarks will then be added to the respective bookmark title:



1248

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 2. %[Label] Macro Output Example
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3.4.16.28 Page Number

 Page Number

The Page Number macro inserts the page number of source pages. 

The syntax for this macro is %[Page] and two sections of parameters are available.

The first section determines the format of page numbers:

· 'r' specifies the use of lower-case roman numerals.

· 'R' specifies the use of upper-case roman numerals.

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used.

· '<integer>' specifies the minimum number of digits used. This value can be any positive

integer from 1 to 12 - for example %[Page:4] starts the numbering as "0001, 0002, 0003...".

The second section determines the starting value for page numbers, and must therefore be an integer.

Please note that a semicolon must be used to delimit the sections of parameters. If the second section

is not used then the semicolon can be omitted. However, if the first section is not used and the second

section is used, then it is necessary to use a semicolon.

The syntax for this macro when both parameters are used is %[Page:<Parameter 1>;<Parameter 2>]

The syntax for this macro when only the second parameter is used is %[Page:;<Parameter 2>]

Examples

Follow the steps below to use the Page Number macro to insert page numbers as Bates numbering:

1. Click the Organize tab.

2. Click Bates Numbering, then click Add. The Add Bates Numbering dialog box will open.

3. Enter %[Page] in the desired text box. Page numbers are then inserted as Bates numbering:
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Figure 1. %[Page] Macro Example

Alternatively, enter %[Page:R] to specify the use of upper-case roman numerals:
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Figure 2. %[Page] Macro Example Two

Alternatively, enter %[Page:4;10] to specify a minimum of four digits for output values and a starting

value of ten:
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Figure 3. %[Page] Macro Example Three

Alternatively, enter %[Page:;5] to omit the first parameter and specify a starting value of five:



1253

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

Figure 4. %[Page] Macro Example Four
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3.4.16.28.1  Page Numbering Style

 Page Numbering Style

The Page Numbering Style feature is an additional macro feature that uses the Page Number and

Number of Pages macros to create page number styles. Follow the step below to view the options

available for this feature:

1. Click the Organize tab, then click the Header and Footer dropdown menu and click Add. The

Add Header and Footer dialog box will open:
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Figure 1. Add Header and Footer Dialog Box

2. Click a macro icon to view the macro shortcut menu. The current Page Number Style will be

detailed in the menu. Click Edit Page Numbering Style to view/select alternative page

numbering styles:
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Figure 2. Add Header and Footer Dialog Box, Macro Shortcut Menu, Edit Page Numbering Style Highlighted

The Edit Page Numbering Style Format dialog box will open:
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Figure 3. Edit Page Numbering Style Format Dialog Box

3. Click the arrow in the Page Number Format dropdown menu to view alternative page number

formats. The following options are available:

· 1 outputs the page number. This is the default setting.

· 1 of n outputs the page number followed by 'of n', where 'n' is the total number of

document pages.

· 1/n outputs the page number followed by a forward slash and 'n', where 'n' is the total

number of document pages.

· Page 1 outputs the text "Page" followed by the page number.

· Page 1 of n outputs the text "Page" followed by the page number and 'of n', where 'n' is

the total number of document pages.

· Use the First Page Number text box to determine the first page number used.

· Use the Number of Pages Increment text box to increase the total number of pages

given as the output figure when the options above that involve 'n' are used. 

Example

The Add Header and Footer dialog box detailed below is for a blank, four-page document. The first

step is to select one of the macro icons and then click Edit Page Numbering Style:
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Figure 4. Add Header and Footer Dialog Box, Edit Page Numbering Style Highlighted

The second step is to select the desired page numbering format in the Edit Page Numbering Style

Format dialog box:
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Figure 5. Edit Page Numbering Style Format Dialog Box, Page Number Format and Number of Pages Increment Fields
Updated

The third step is to click OK, after which the custom macro will be added to the Add Header and

Footer dialog box, and the preview pane will update to show its output in the document:
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Figure 6. Header and Footer Dialog Box, Page Numbering Style Options Added to Left Header Text Box, Preview Pane
Updated
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3.4.16.29 Seconds

 Seconds

The Seconds macro inserts the seconds value from the current time.

The syntax for this macro is %[Seconds]

Example

If the current time is 11:32 and 38 seconds then the %[Seconds] macro inserts '38':
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Figure 1. %[Seconds] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Hour]:%[Minute],%[Seconds] output the hour followed

by the minutes of the hour and the seconds of the minute:
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Figure 2. %[Seconds] Combined Macro Example
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3.4.16.30 Sequential Number

 Sequential Number

The Sequential Number macro inserts the sequential number of bookmarks, which is the sequential

value of each bookmark in the context of the entire bookmarks tree.

The syntax for this macro is %[SeqNum]

Example

Follow the steps below to use the Sequential Number macro to insert the sequential number of

bookmarks when adding text to bookmark titles:

1. Open a document that contains bookmarks in PDF-XChange Editor.

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Titles dialog box will open.

3. Enter %[SeqNum] in the Add Suffix text box:
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Figure 1. %[SeqNum] Macro Example

4. Click OK. The sequential number of each bookmark will then be added as a suffix to all

bookmark titles:
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Figure 2. %[SeqNum] Macro Example Output
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3.4.16.31 Time

 Time

The Time macro inserts the current time. Multiple time formats are available, as detailed below.

The syntax for this macro is %[Time] and the following parameters are available:

· h inserts the hour and omits the zero in cases of single-digit values.

· hh inserts the hour and includes a zero in cases of single-digit values.

· H inserts the hour, includes a zero in cases of single-digit values and uses a 24 hour-clock.

· m inserts the minutes and omits the zero in cases of single-digit values.

· mm inserts the minutes and includes a zero in cases of single-digit values.

· s inserts the seconds and omits the zero in cases of single-digit values.

· ss inserts the seconds and includes a zero in cases single-digit values.

· t inserts a single character to reference the a.m./p.m. variable: a or p.

· tt inserts two characters to reference the a.m/p.m. variable: AM or PM.

The syntax for this macro when parameters are used is %[Time:<Parameter>] 

Note that several parameters can be used in sequence in order to insert a customized time. For

example, %[Time:H:mm tt] inserts the current hour and minutes, and inserts two characters to

reference the a.m./p.m. variable (as detailed below).

Example

Follow the steps below to use the Time macro to create a watermark that inserts a customized version

of the current time:

1. Click the Organize tab.

2. Click Watermarks, then click Add. The Add Watermark dialog box will open.

3. Enter %[Time:H:mm tt] in the Text text box. A customized version of the time is then added

as a watermark:
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Figure 1. %[Time] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Month]/%[Day] output the current

time followed by the month and the day of the month:
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Figure 2. %[Time] Combined Macro Example
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3.4.16.32 Username

 Username

The Username macro inserts the name of the current user.

The syntax for this macro is %[User]

Example

Figure 1. %[Username] Macro Example
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3.4.16.33 Web Link to Open

 Web Link to Open

The Web Link to Open macro inserts the URI link of bookmarks. These links are used to specify an

internet address that opens when bookmarks are clicked. You can view/edit these links in the

bookmark's properties, as detailed here.

The syntax for this macro is %[URI]

Example

Follow the steps below to use the Web Link to Open macro to insert the URI link of bookmarks when

adding text to bookmark titles:

1. Open a document that contains bookmarks with URI links in PDF-XChange Editor. For

example, the bookmark detailed below contains a URI link to the PDF-XChange website:

345
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Figure 1. Edit Action List Dialog Box, Open a Web Link Action for Bookmark A1 Highlighted

2. Click the Bookmarks tab, then click Add Text to Bookmark Titles. The Add Text to

Bookmark Titles dialog box will open.

3. Enter %[URI] in the Add Suffix text box:
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Figure 2. %[URI] Macro Example

4. Click OK. The URI link in the bookmark will then be added as a suffix to the bookmark title:
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Figure 3. %[SeqNum] Macro Example Output
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3.4.16.34 Year

 Year

The Year macro inserts the current year as a four-digit value.

The syntax for this macro is %[Year]

Example
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Figure 1. %[Year] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Date:dd MMMM] %[Year] output the

current time, date and year:
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Figure 2. %[Year] Combined Macro Example
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3.4.16.35 Macro-Enabled Operations

 Macro-Enabled Operations

Macros are available for the following operations:

OPERATION LOCATION

Add Header and Footer Organize Tab> Header and Footer> Add

Add Bates Numbering Organize Tab> Bates Numbering> Add/Add to

Multiple Files

Add New Stamp from File Comment Tab> Stamp Tool> Stamps Palette

then click Add New and select a file to be used as

a stamp, or click New Stamp from Active

Document. The Add New Stamp dialog box will

open. Macros can be used in the Stamp Title text

box.

Add Text to Bookmark Titles     Bookmarks Tab> Add Text to Bookmark Titles

Add Watermarks Organize Tab> Watermarks> Add>. Macros can

be entered in the Text text box.

Bookmark Every Nth Page  Bookmarks Tab> Bookmark Every Nth Page
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Convert to Named Destinations  Bookmarks Tab> Convert to Named

Destinations

Extract Pages Organize Tab> Extract Pages

Export to Images Convert Tab> Export to Images

Launch Application File Tab> Preferences> then select Launch

Applications in the Categories menu and click

New. The New Launch Application dialog box will

open. Macros can be used in the Parameters text

box. Note that a different set of macros is used for

this feature. See here  for further information.

New Document From Image Files 1. File Tab> New Document> From Image File(s)

then click Options. The Images to PDF dialog box

will open. Select Image Labels in the Categories

menu. Macros can be used in the text box.

2. Document Tab> Insert Pages > Insert Images

then click Options. The Images to PDF dialog box

will open. Select Image Labels in the Categories

menu. Macros can be used in the text box.

New Document From Text Files 1. File Tab> New Document> From Text Files

then click Options. The Options dialog box will

open. Select File Separator in the Categories

menu. Macros can be used in the text box.

2. Document Tab> Insert Pages> Insert Text

then click Options. The Options dialog box will

open. Select File Separator in the Categories

menu. Macros can be used in the text box.

Summarize Comments Comment Tab> Summarize Comments. Macros

can be used in the Filename text box.

235
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3.4.17 Page Boxes

 Page Boxes

PDF documents feature five boxes that determine their content and appearance. They are the Media

Box, Crop Box, Bleed Box, Trim Box and Art Box:
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Figure 1. Document Boxes

PDF-XChange Editor uses four of these boxes:

Crop Box

The Crop Box defines the region to which page contents are clipped when displayed or printed.

Programs use the dimensions of this box for screen display and printing. Unlike the other boxes, the

Crop Box has no defined meaning in terms of physical page geometry or intended use - it merely

imposes clipping on page contents. However, in the absence of additional information, the Crop Box

determines how the page contents will be positioned on the output medium. 

Bleed Box

The Bleed Box defines the region to which the contents of the page are clipped when output in a

production environment. This may include the "bleed area" needed to accommodate the physical

limitations of cutting, folding and trimming equipment. Usually the Bleed Box is three to five

millimeters larger than the Trim Box. When a page is printed it may include printing marks that fall

outside the Bleed Box. The default value of the Bleed Box is the value of the Crop Box.  

Trim Box

The Trim Box defines the intended dimensions of the finished page after trimming has taken place. As

opposed to the Crop Box, the Trim Box is very important because it defines the actual page size.

Programs use the Trim Box as the basis for positioning pages on a press sheet. The default value of the

Trim Box is the value of the Crop Box.

Art Box

The Art Box defines the extent of the page’s meaningful content (including potential white space) as

intended by the page’s creator. The default value for the Art Box is the value of the Crop Box.

These boxes can be viewed/edited in the Crop Pages dialog box:
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Figure 2. Crop Pages Dialog Box

Click Crop Pages in the Crop dropdown menu of the Organize tab to access these settings. Further

information on page boxes is available here.

Note that the Loupe Tool  contains a feature that can be used to display page boxes.444

https://www.prepressure.com/pdf/basics/page-boxes
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3.4.18 Page Range Settings

 Page Range Settings

Page range settings are available in many of the PDF-XChange Editor dialog boxes. Follow the rules

detailed below to customize page ranges:

· Use commas to delimiter individual pages.

· Use hyphens to delimiter page ranges. 

· Use commas to delimiter page ranges if multiple page ranges are being defined.

· Use a dash before a page number to determine all pages from the beginning of the document

to the specified page. For example -7 defines all pages from the beginning of the document to

page seven.

· Use a dash after a page number to determine all pages from the specified page to the end of

the document. For example 7- defines all pages from page seven to the end of the document.

· Use the caret symbol (^n) to specify the document page that is n pages from the end of the

document, or use (^n-^n) to specify a page range from the end of the document. For example,

^2 specifies the second-last page of the document, and ^5-^1 specifies the last five pages of

the document.

· Note that when you are specifying a custom page range it is not necessary for the order of

pages to be sequential, or for each value in the range to be unique. 

Examples

1, 3, 5-7  will process pages 1, 3, 5, 6 and 7.

1, 3, 5-7, ^2-^1 (when applied to a document with ten pages) will process pages 1, 3, 5, 6, 7, 9

and 10.

3- will process all pages except the first two pages of the document.

-5, 7 will process pages 1, 2, 3, 4, 5 and 7.

-5, ^3-^1 (when applied to a document with ten pages) will process pages 1, 2, 3, 4, 5, 8, 9 and

10.
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3.4.19 Read Out Loud Feature

 Read Out Loud Feature

This feature of PDF-XChange Editor enables the software to "read out loud" document text. Follow the

steps below to use this feature:

1. Click the Home tab, then click Select Text.

2. Select the text to be read out loud.

3. Right-click the text.

4. Click Read Selected Text Out Loud in the submenu:
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Figure 1. Home Tab, Select Text Tool, Read Selected Text Out Loud

The selected text will be read out loud according to the settings determined here.  Click Stop

Reading to cancel the process.

271
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3.4.20 Removing Trial Watermarks

 Removing Trial Watermarks

If licensed features are used without a license in PDF-XChange Editor then trial watermarks (and

underlying links) will be added to the document:

Figure 1. Trial Watermarks

Follow the steps below to remove this content from documents:

1. Click the Organize tab, then click the Watermarks dropdown menu and click Manage:
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Figure 2. Organize Tab, Watermarks Dropdown Menu, Manage

The Manage Watermarks dialog box will open:
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Figure 3. Manage Watermarks Dialog Box, Remove Highlighted

2. Select the trial watermark and then click Remove. The watermarks will then be removed from

the document.

3. Click the View tab, then click the Panes dropdown menu and click Links:
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Figure 4. View Tab, Panes Dropdown Menu, Links

The Links pane will open:
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Figure 5. Links Pane, Trial Links Detailed

4. Select the trial links and then click Delete. The links will then be removed from the document.
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3.4.21 Removing Activations from a License

 Removing Activations from a License

If you reach the maximum permitted number of activations for your license key, and would like to

remove a machine from the license in order to free up a space for a new machine, you can follow the

steps below to do so:

1. Log in to your PDF-XChange account here.

2. Go to the Your Products and Serial Keys tab, and then click Activations List:

The Activations List will open:

https://www.pdf-xchange.com/login
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All machines that are currently registered on your license are detailed in the list.

3. Click Deregister to deregister a machine from the Activations List, then click OK in the

confirmation box to confirm the deregistration. A free space will then be available on your

license to add a new machine.

Note that the license keys for PDF-XChange software are assigned a specific number of users, and each

user is permitted to activate the license on two machines - a desktop PC and a laptop/touch-based

device - provided that they are the primary user of both machines. For example, a five-user license key

is permitted to be activated on ten total machines. When the activations limit is reached it is no longer

possible to use the license key to activate the software on additional devices. If you want to do so then

it is necessary to first remove a machine from your license, as detailed above.
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3.4.22 Search

 Search

Click Search (or press Ctrl+Alt+F) to launch the Search pane:

Figure 1. Search Function

The Search pane is used to search documents open in PDF-XChange Editor or folders on the local

computer:
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Figure 2. Search Pane

· Enter the search terms in the upper text box or select Advanced Criteria, which is explained

below.

· Use the lower text box to select where the search will take place:

· In the Active Document searches only the active document.

· In All Open Documents searches all documents currently open in PDF-XChange Editor.

· In All Documents from this Window searches all documents open in the current

window of PDF-XChange Editor.

· Browse for Folder launches the Select Folder dialog box. Select the desired folder on

the local computer and then click Select. The folder will be added to the search location

box.

· Click the Options button to determine further search variables. These are explained beneath

(figure 4) below.

· If you want to search for a specific combination of words then enter the words in double

quotations.

· Click the Search button to execute the search. The results will be displayed in the lower section

of the pane.

Click Advanced Criteria to enable additional search options:
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Figure 3. Advanced Criteria Options

· Use the arrow on the right side of the Custom text box to select a predefined search. If no

searches have been predefined then the Custom option is not available. Click the blue disk icon

to save custom search terms as a predefined search for subsequent use.

· Use any combination of the three Find text with: text boxes to determine the search

parameters:

· If search terms are entered in the all of these words text box, then the results will include

only text strings that contain all the entered search terms.

· If search terms are entered in the this exact phrase text box, then the results will include

only text strings that match the exact phrase entered. 

· If search terms are entered in the any of these words text box, then the results will

include text strings that contain any of the entered search terms.

· If search terms are entered in the none of these words text box, then the results will

exclude text strings that contain any of the entered search terms.
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Figure 4. Search Options

· Select Case Sensitive to include the case of search terms in the search.

· Select Whole Words to return only whole words.

· Select Ignore Diacritics to ignore accents, cedillas and other similar symbols in the search.

· Select Include Page Text to include text on pages of the document in the search.

· Select Include Bookmarks to include bookmark names in the search.

· Select Include Comments to include comment text in the search.

· Select Form Fields to include form field text in the search.

· Select Include External Links to include links to external locations/files in the search.

· Select Include Attachments to include embedded documents in the search.

· Select Include Document Info to include document metadata/information in the search.

· Select Pre-Estimate Search in Folder to have PDF-XChange Editor perform a folder count

prior to the search. This facilitates exact search progress in the progress bar when searches take

place.

· Select Look in Sub-Folders to include all directory subfolders in the search.



1299

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

· Select Proximity to determine the proximity of returned results. The options are:

· Only Adjacent Words

· Words from the Same Paragraph

· Words from the Same Page

· Words from the Same Document

· Select Colored Search Results to highlight matching terms after the search has taken place.

· Click an option in the Annotate Search Results submenu to enable annotation options after

the search has taken place. The options are:

· Highlight Search Results

· Underline Search Results

· Strikeout Search Results

· Redact Search Results

· Click Comment Styles Palette to launch the Comment Styles Palette  for further

annotation options.

· Click Open from file to open a previous search that was saved to file using the option below.

· Click Save Results to save the results of the most recent search operation.

· Click Clear Results to the clear the search results list.

644
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3.4.23 Shell Extensions

 Shell Extensions

PDF-XChange Editor features a Windows shell extension that causes thumbnails of PDF files to display

in Windows Explorer when thumbnails are selected as the file display mode. The first page of PDF

documents is displayed, instead of the standard PDF document icon, which makes the process of

viewing/selecting files more efficient. Note that the folders must set to display medium, large or extra-

large icons for the thumbnails to be visible:

Figure 1. Shell Extensions Example

iFilter

The shell extension feature includes the PDF iFilter, which is a search tool. This tool can be used to

index PDF documents with Microsoft iFilter indexing. This means that Windows will locate search



1301

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Editor Plus V10 User Manual

terms through not only document names, but also text within documents, annotations, bookmarks,

document XMP information and files attached/embedded within documents. This process takes place

automatically when the standard Windows search option is used. The PDF iFilter integrates into

existing Windows operating systems and thus provides a convenient way to search text within PDF

documents on the local computer and company network/intranet, as well as greatly increasing your

ability to accurately locate many forms of information contained within your PDF documents.

View/Edit Shell Extension Settings

These settings are detailed on your machine at the following default location:

C:\Program Files\Tracker Software\Shell Extensions

If you want to view/edit shell extension settings, then please go to the folder above and then double-

click XCShInfoSetup.exe. The PDF-XChange Shell Extensions Setup dialog box will open:
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Figure 2. PDF-XChange Shell Extensions Setup Dialog box

The current handlers are detailed in the dropdown menus. Click the dropdown menus to select

alternative handlers as desired, then click Apply to apply changes.
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3.4.24 Tool Properties

 Tool Properties

The table below contains all properties available for the PDF-XChange Editor tools. Click Properties in

the Format Tab  when tools are selected to view/edit tool properties in the Properties  pane.

GENERAL

PROPERTY DEFINITION

Diameter
The Diameter property determines the diameter of the Eraser

Tool.

Exclusive Mode

The Exclusive Mode property simplifies the process of using tools.

When it is enabled, the pointer ignores all interactive elements of

documents other than base content. This makes it possible to

create content on areas that overlap with other content without the

risk of accidentally selecting undesired items. When Exclusive

Mode is disabled, the pointer recognizes and interacts with all

underlying elements in the usual manner.

Inertial Scroll

The Inertial Scroll property is a dynamic scrolling option. When it is

enabled, document pages will continue to scroll and come to a stop

gradually after scrolling actions are performed. When it is disabled

document pages will scroll in synchronization with the pointer.

Keep Selected
The Keep Selected property is an editing convenience for tools.

When it is enabled tools will remain selected after they are used.

When it is disabled the active tool reverts to the designated default

tool after a single use.

1066 441
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STYLE

Border The Border property determines the border style of content.

Blend Mode

The Blend Mode property determines how content blends with

underlying/overlapping content. Further information on this

property is available here.

Fill Color The Fill Color property determines the fill color of content. 

Highlight Mode
The Highlight Mode property determines the visual effect when

links created using the Link Tool are selected.

Icon The Icon property determines the icon that content uses.

Opacity The Opacity property determines the transparency level of content.

Stroke Color The Stroke Color property determines the border color of content.

Thickness Scale
The Thickness Scale property determines the thickness of strikeout

and underline annotations.

Underline
The Underline property determines the underline style when the

Underline Text Tool is used.

Width The Width property determines the width of content. 

DEFAULT TEXT FORMAT

1109
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Font The Font property determines the content font.

Font Size The Font Size property determines the content font size.

Text Alignment
The Text Alignment property determines the content text

alignment.

Text Color The Text Color property determines the content text color.

OTHER

Decimal
The Decimal property determines the symbol used as the decimal

separator for the Measuring Tools.

End The End property determines the style of line endings.

End Scale The End Scale property determines the scale used for line endings. 

Group
The Group property determines the symbol used as the group

separator for the Measuring Tools.

Inline Caption

The Inline Caption property determines whether or not captions

are inline captions. If this option is enabled then captions are

placed inside annotations instead of on top of annotations.

Leader Extension

The Leader Extension property determines the length of optional

lines that extend from leader lines when using the

Line/Arrow/Distance Tool. 

Leader Length The Leader Length property determines the length of leader lines.

Leader Offset The Leader Offset property determines the length of the offset

between the pointer and leader lines.

597
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Precision
The Precision property determines the precision with which scale

conversions are displayed with the Measuring Tools.

Read Only

The Read Only property is the "read only" status of

comments/form fields. If this property is enabled then user-editing

is disabled. Please note that it is necessary to use JavaScript to

change the value of this property in the case of comments.

Scale The Scale property determines the scale used for content.

Show Caption

The Show Caption property determines caption visibility in the

Line/Arrow/Distance Tool. When it is enabled, the content of

annotations pop-ups is displayed in text format above the baseline.

When it is disabled, this content is not displayed.

Start The Start property determines the style at the beginning of lines.

Start Scale
The Start Scale property determines the scale used at the

beginning of lines. 

Subject
The Subject property determines the content subject title. Note that

it is not possible to edit this property in all tools.

Subject Kind

The Subject Kind property determines the content subject value:

· Custom renders a custom value for the subject. Enter the

desired value in the Subject text box.

· Default renders the default subject value.

· Global renders the global subject value. Use the Subject

text box to enter a new global subject value. All tools that

feature a global option in their Subject Kind property will

then be updated with the same information.

597
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4 PDF-Tools V10 User Manual

 PDF-Tools V10 User Manual

PDF-Tools is a dynamic and user-friendly solution for the creation and manipulation of PDF

and image files. It features seventy-seven default tools, as well as the option to clone, edit

and create fully-customizable tools, which makes it the ideal software to compliment your

existing PDF facilities.

This manual is composed of the following sections:

· Features Overview details the main features of PDF-Tools.

· User Interface details the software as it appears via the user interface.

· Create Tool details the Create Tool feature, which is used to create custom tools.

· Clone Tool details the Clone Tool feature, which is used to clone default tools and

adjust their settings.

· Actions Library details the actions that the Create Tool feature uses to build tools.

· Default Tools details the seventy-seven tools included in the application.

· Appendix details additional information that relates to the software.

Note that the icons in the upper left of the screen can be used to browse/search the manual:

 Click the Table of Contents to view/move to chapters of the manual.
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 Click the Keyword Index to view keywords, and click keywords to move to their location in

the manual.

 Click Search Topics to enter custom search terms.
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5 Features Overview

 Features Overview

The main features of PDF-Tools are as follows:

· The seventy-seven Default Tools, which are used to edit, enhance and manipulate

documents. These tools are listed below.

· The Clone Tool  feature, which can be used to clone and customize the Default

Tools.

· The Create Tool  feature, which can be used to build new tools. There are eighty-

six actions in the Actions Library  that can be combined as desired to create

tools.

· The Folder Monitors  can be used to set up folder-monitoring and automatically

perform tool operations on files that are moved into designated folders.

· The Import/Export tool features can be used to import/export customized tool

settings and custom tools.

· The Tool Report pane can be used to view a breakdown of operations when tools

run.

Note that source files to be used in conjunction with tools can be located on the local

computer or scanned directly into the application from the scanner. A list of supported file

types is available here.

Default Tools

There are seventy-seven default tools in PDF-Tools. These tools enable the simple and

effective manipulation of PDF/image files. They are grouped into eleven categories:

Create PDF Tools

These tools create PDF documents:

 Convert Files to PDFs  converts input files to PDF.
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 Create PDF from Images  converts images to PDF.

 Create PDF from Text  converts text files to PDF.

 Create PDF Portfolio  creates PDF portfolio files.

 Extract Pages  extracts specified page ranges from documents are converts them to a

new PDF document.

 Scan to PDF  converts scanned content into PDF documents.

 Split/Merge PDFs  splits documents into separate PDF documents or combines

documents into a single PDF document. 

Pages Tools

These tools edit the pages of PDF documents:

 Add Bates Numbering  inserts Bates numbering into documents.

 Add Header and Footer  inserts headers and/or footers.

 Add Watermark  adds text/image watermarks to documents.

 Crop Pages  adjusts the visible page area/margins/editing boxes.

 Delete Pages  deletes document pages.

 Duplicate Pages  duplicates document pages.

 Insert Empty Pages  inserts empty pages into documents.

 Import as Layer Overlay  uses an existing file to overlay documents.

 Insert Pages  inserts pages from input documents into a specified document.

 Merge Pages  merges pages into a single page.

 Move Pages  reorders document pages.

 OCR Pages  performs optical character recognition on documents.

 Overlay PDF  overlays PDF documents with other documents.

 Rasterize Pages  rasterizes the pages of input documents.

 Remove Bates Numbering  removes Bates numbering from documents.
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 Remove Headers and Footers  removes headers and footers from documents.

 Remove Pages Background  resets page backgrounds to their default state.

 Remove Watermarks  removes watermarks from documents.

 Replace Pages  replaces document pages with pages from another document.

 Resize Pages  adjusts the size of pages, and scales page content as desired.

 Rotate Pages  rotates document pages.

 Set Page Transitions  determines how transitions are made between pages in

full screen mode.

 Set Pages Background  adds backgrounds to documents.

 Split Pages  splits documents pages.

Links Tools

These tools are used to create/delete links:

 Create Weblinks  creates weblinks from document text.

 Delete Links  deletes links from documents.

 Delete Weblinks  deletes weblinks from documents.

Forms Tools

These tools are used to delete, export, import and/or reset form fields:

 Delete Form Fields  deletes form fields from documents.

 Export Form Data  exports form data from documents.

 Import Form Data  imports form data from file.

 Reset Forms  removes all form data from documents.

Comments Tools

These tools create/delete/manipulate comments in PDF documents:
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 Delete All Comments  deletes all comments from documents.

 Delete Markup Annotations  deletes markup annotations from documents.

 Export Comments  exports document comments to file.

 Flatten Comments and Fields  converts comments and forms into base

content items.

 Import Comments  imports comments into documents.

 Summarize Comments  creates a summary of document comments.

Bookmarks Tools

These tools convert, export/import or generate bookmarks in PDF documents: 

 Build Table of Contents  uses document bookmarks to create tables of contents.

 Export Bookmarks  exports a copy of document bookmarks.

 Export Bookmarks to Text File  exports a copy of document bookmarks to a text file.

 Generate Bookmarks from Page Text  creates bookmarks from document text.

 Find and Replace Bookmark Text  finds and replaces text in bookmark titles.

 Import Bookmarks  imports bookmarks into documents.

 Import Bookmarks from Text File  imports bookmarks into documents from text files.

Protection Tools

These tools protect and enhance the security of PDF documents:

 Apply Redaction  removes content that has been marked for redaction from documents.

 Certify PDFs  adds certified digital signatures to documents. 

 Clear All Digital Signatures  removes digital signatures from documents.

 Find and Redact  searches for specific words or patterns and then either marks them for

redaction or redacts them immediately.

 Sanitize Document  removes sensitive information from input documents.
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 Secure PDF  adds passwords to documents.

 Sign Document  adds digital signatures to documents.

 Timestamp PDFs  adds timestamps to documents.

Optimize PDF Tools

These tools enhance and optimize PDF documents:

 Enhance Scanned Pages  enhances the image quality in scanned documents.

 Optimize PDF  optimizes the content of PDF files in order to reduce their size.

 Recompress Images  recompresses document images.

PDF Standard Tools

These tools add/remove compliance with PDF standards:

 Convert to PDF/A  makes PDF documents compliant with the PDF/A standard, which is

used for long-term archiving.

 Convert to PDF/X  makes PDF documents compliant with the PDF/X standard, which

facilitates graphics exchange.

 Discard Special PDF-Standard  discards components of documents that comply with PDF

standards such as PDF/A, PDF/X and PDF/E.

Export PDF Tools

These tools export a copy of PDF documents and/or images to alternative formats: 

 Export PDF to Audio  exports a copy text in PDF documents to audio file

format.

 Export PDF to Images  exports a copy of document pages to image format.

 Export PDF to Microsoft Excel Spreadsheet  exports a copy of document pages to MS

Excel format.

 Export PDF to Microsoft Powerpoint Presentation  exports a copy of document pages

to MS PowerPoint format.
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 Export PDF to Microsoft Word Document  exports a copy of document pages to MS

Word format. Note that files exported to (*.docx) format are compatible with MS Word 2010

and later.

 Export PDF to Plain Text  exports a copy of PDF documents to plain text (*.txt) format. 

 Extract Images from PDF  extracts a copy of images from PDF documents to a new file.

Advanced Tools

These tools perform advanced operations:

 Change Document Properties  edits document metadata such as the Title, Author,

Subject and Keywords.

 Convert Colors  converts the colors of input documents.

 Extract Attachments  extracts attachments from documents:

 Print Document  prints input documents.

 Send E-mail  sends documents via email.
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6 User Interface

 User Interface

The PDF-Tools user interface has two workplaces - the Main window and the Edit window:

Main Window

 
Figure 1. Main Window

The Main window is used to view, select, edit, clone and launch tools:
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· Click tool Categories to view the tools that they contain, which will display in the

main window. All tool categories are detailed below.

· The Tool Info pane displays the name, description, optional settings and actions of

selected tools, and contains the following settings:

· The Batch Processing Mode setting determines the processing method in

cases of multiple input files. It is enabled by default, which means files are

processed simultaneously. Clear the Batch Processing Mode box to process

input files one at a time instead. Disabling this option should reduce memory

usage, but it may also result in unexpected output for tools that combine input

files into single documents.

· The Multi-Threaded Processing Mode setting is disabled by default. Select

the box to enable multi-threaded processing, which will use all available CPU

cores when tools run. This improves the processing performance but also

increases the demand on your computer, which may be detrimental to other

processes running at the same time.

· Click All Options to view additional options:

· The Do Not Ask for Passwords setting is disabled by default. This

means that PDF-Tools will prompt for passwords in cases of password-

protected input files that do not have corresponding passwords in

Predefined Passwords Storage.  Enable this option to skip these files

when tools run.

· Use the Keep output documents in order according to input data

dropdown menu to specify the order of output documents in relation to

input documents. Note that this option is only available when the Batch

Processing Mode setting is disabled and the Multi-Threaded

Processing Mode setting is enabled. The following options are

available:

· Auto is the default setting and means that PDF-Tools will decide

automatically whether or not retaining the input order of

documents is necessary.

· Yes specifies that the input order is retained for output

documents.

· No specifies that the input order is not retains for output

documents.

· Use the Successfully processed files dropdown menu to determine the

action taken for successfully processed files.

· Use the Unsuccessfully processed files dropdown menu to determine

the action taken for unsuccessfully processed files.

· Click the dropdown arrows in the Tool Info pane to customize tool action

parameters. These parameters are detailed in the Actions Library.  Click the

circular reset arrow to reset tool action parameters to their default values.

· Select/clear tool action check boxes (where possible) to include/exclude them

when the tool runs.

1886
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· Click the  icon adjacent to the tool name to launch the associated page of the online

manual.

· Click  Add to add a custom category to the list of categories. Click and drag

tools to add them to custom categories. Note that default tools cannot be moved

from their home categories.

· Click  Rename or  Delete to rename/delete custom categories.

· Use the  Search Tool to search for tools.

· Click  Run (or press Ctrl+R) to launch the selected tool.

· Click  Edit (or press Ctrl+E) to edit the selected tool, as detailed in (figure 6).

· Click  Clone (or press Ctrl+D) to create a clone of the selected tool, which enables the full

customization of its actions/parameters, as detailed here.

· Click  Create (or press Ctrl+N) to create a new tool, as detailed here.

· Click  Delete to remove the selected tool. Note that this option is available only for custom

tools.

· Click  Options (or press Alt+O) to view program options:

Figure 2. Options Tab

· Click Preferences to view/edit the preferences of PDF-Tools, as detailed here.

· Click Tool Report to enable/disable the Tool Report pane, which details a breakdown of

operations when tools run.

· Click Folder Monitors to view/edit folder monitors, which are used to watch user-

specified folders and automatically perform tool operations on files moved into them.

Folder monitors are detailed here.

· Click Export All Settings to export the current tool settings and custom tools to file. This

is a useful feature in cases where several parties require the same settings, such as

employees of the same organization. 
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· Click Import All Settings to import settings that the Export All Settings feature has

been used to export.

· Click Reset All Settings to reset all settings and remove all custom tools.

· Click Export Tools to export a selection of tools to file.

· Click Import Tools to import tools that the Export Tools feature has been used to

export.

· Click  Help to view help options:

Figure 3. Help Tab

· Click Contents to navigate to the online help manual.

· Click Home Page to navigate to the PDF-Tools page on the PDF-XChange website.

· Click Support to navigate to the PDF-XChange support forums.

· Click Enter License Key to view/edit license keys for PDF-Tools, as detailed here.

· Click Check for Updates to launch the PDF-XChange Updater and check for updates to

all PDF-XChange applications installed on the local computer.

· Click About to view license/version information, and further details about PDF-Tools.

Right-click tools for additional options:

1888
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Figure 4. Tool Options Menu

· Click Run (or double-click) to launch the selected tool.

· Click Edit to edit the selected tool, as detailed in (figure 6).

· Click Clone to create a clone of the selected tool, which enables the full customization of its

actions/parameters, as detailed here.

· Click Create to create a new tool, as detailed here.

· Click Add to Favorites to add tools to the Favorites category.

· Click Remove from Favorites to remove tools from the Favorites category.

· Click Add to/Remove from Shell Menu to add/remove tools from the Windows shell menu,

as detailed here.

· Click Export Selected Tools to export tools. The Save Export File dialog box will open. Select

a name and location for the file. Tools will be saved as a .pdtex file. The Import Tools option

detailed above can be used to import these files.

· Click Reset Selected Tools to revert the settings of selected tools to their default values.

· Click Create Shortcut on Desktop to create a desktop shortcut for tools. A shortcut icon will

appear on the desktop when this feature is used. Double-click icons, or drag and drop files

onto them, in order to launch the associated tool.

· Click Copy Tool Identifier to copy the unique tool identifier to the clipboard for the selected

tool. Tool identifiers are used in conjunction with the /RunTool command line in order to run

tools from the command prompt.

· Click Delete to delete tools. Note that this option is not available for default tools.

· Click Sort Tools to determine how tools are sorted within the user interface. Note that you can

also click and drags tools within the user interface to sort them as desired.
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Edit Window

Right-click tools and then click Edit to view the Edit window for the tool. The Edit window is

used to view and customize tool functions. For example, the Edit window for the Convert

Files to PDFs  tool is detailed below:

Figure 6. Edit Window, Convert Files to PDFs

The name, icon and description of the selected tool is displayed in the Edit window. These

parameters can be edited for cloned/custom tools. All tools feature actions that can be

adjusted to meet specific requirements. These actions are contained in the Tool Actions

Sequence. The order of actions in the Tool Actions Sequence determines the order of

actions when tools run, and can be reordered in cloned/custom tools. Click the arrow icons

on the left side of actions to expand their parameters, which can then be customized, as

detailed in the the Actions Library.  Use the icons in the Edit window to perform the

following operations:

Click  Close Edit to close the editing session.

Click  Save Changes to save changes made to the tool.

Click  Undo to undo the most recent editing action.

Click  Redo to redo the most recent undo action.
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Click  Reset Tool to reset all tool settings. 

Click  Move Up to move the selected action up in the Tool Actions Sequence.

Click  Move Down to move the selected action down in the Tool Actions

Sequence.

Click  Collapse All to collapse all actions in the Tool Actions Sequence.

Click  Expand All to expand all actions in the Tool Actions Sequence.

Click  Reset to reset the selected action options in the Tool Actions Sequence.

Click  Delete to delete selected actions.

Select/clear  boxes to include/exclude actions when tools run.

Click  Reset to reset action options to their default values.

Tool Categories

PDF-Tools contains the following default tool categories:

Figure 5. Default Tool Categories

· The Most Used category contains the five most-often used tools.

· The Recents category contains the ten most recently used tools.
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· The Favorites category contains the favorite tools of the user. Drag tools to add

them to this folder. Alternatively, click the heart in the upper-left of the tool pane to

add/remove tools to/from the Favorites category.

· The Shell Menu category contains all tools that the user has added to this category.

Tools added to this category can be accessed via the Windows context menu when

users right-click files, as detailed here.

· All Tools contains all seventy-seven default tools, which are detailed here.

· Create PDF contains the tools used to create PDF files. These tools are detailed

here.

· Pages contains the tools used to edit, update and delete document pages. These

tools are detailed here.

· Links contains the tools used to create/delete links and weblinks. These tools are

detailed here.

· Forms contains the tools used to import/export, delete or reset forms and form

data. These tools are detailed here.

· Comments contains the tools used to manipulate document comments such as

weblinks and form fields. These tools are detailed here.

· Bookmarks contains the tools used to create and manipulate document bookmarks.

These tools are detailed here.

· Protection contains the tools used to protect and secure documents. These tools are

detailed here.

· Optimize PDF contains the tools used to optimize and enhance documents. These

tools are detailed here.

· PDF Standard contains the tools used to add/remove PDF subset compliance to

PDF documents, such as the PDF/A and PDF/X formats. These tools are detailed

here.

· Export PDF contains the tools used to export copies of PDF documents to different

output formats, such as plain text, image format and MS Word/Excel/Powerpoint.

(Note that files exported to (*.docx) format are compatible with MS Word 2010

and later). These tools are detailed here.

· Advanced contains the tools used to perform more advanced operations, such as

changing document properties and emailing documents. These tools are detailed

here.
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7 Create Tool

 Create Tool

The Create Tool feature of PDF-Tools is used to create custom tools. Follow the steps

below to create tools:

1. Click Create in the main toolbar:

Figure 1. Main Window, Create Tool Option

The Edit window will open:
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Figure 2. Edit Window, New Tool Creation

2. Enter a name and description for the new tool. Click the  icon to select an icon

for tools. (Note that icons must be in the *.ico format).

3. Build the Tool Actions Sequence. The Tool Actions Sequence determines the

functionality of tools and is composed of actions from the Actions Library. Therefore

it is necessary to add actions from the Actions Library to the Tool Actions Sequence

in order to create tools. Drag actions from the Actions Library (or double-click them)

to add them to the Tool Actions Sequence. There are eighty-six available actions. See

the Actions Library  for an explanation of all actions and their associated

parameters. Please note:

· All tools require input files to operate. Therefore it is necessary to start the Tools Actions

Sequence with either the Choose Input Files or the Get Images from Scanner action.

· Almost all tools require files to be saved after they are created/converted, and in those

cases either the Save Documents or the Save Images action must be included.

· Note that the order of actions in the Tools Actions Sequence determines the order in

which actions are performed when tools run. Select actions and then click the Move Up

or Move Down buttons displayed in (figure 2) to change their order in the Tool Actions

Sequence. Several actions require additional actions in order to function correctly.

Additional actions may be required before (prerequisite) or after (postrequisite) actions.

For example the Convert Files to PDF action requires both an action that sources input

1336
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files to convert to PDF and an action that saves converted files. If an ordering mistake is

made then a warning icon will appear. Click the icon for further information and a

solution to the issue.

· The Batch Processing Mode setting determines the processing method in

cases of multiple input files. It is enabled by default, which means files are

processed simultaneously. Clear the Batch Processing Mode box to process

input files one at a time instead. Disabling this option should reduce memory

usage, but it may also result in unexpected output for tools that combine input

files into single documents.

· The Multi-Threaded Processing Mode setting is disabled by default. Select

the box to enable multi-threaded processing, which will use all available CPU

cores when tools run. This improves the processing performance but also

increases the demand on your computer, which may be detrimental to other

processes running at the same time.

· Click All Options to view additional options:

· The Do Not Ask for Passwords setting is disabled by default. This

means that PDF-Tools will prompt for passwords in cases of password-

protected input files that do not have corresponding passwords in

Predefined Passwords Storage.  Enable this option to skip these files

when tools run.

· Use the Successfully processed files dropdown menu to determine the

action taken for successfully processed files.

· Use the Unsuccessfully processed files dropdown menu to determine

the action taken for unsuccessfully processed files.

· The Edit window (figure 2) and the options it contains are detailed here.

4. Click  Save Changes to save the new tool.

Example

This example will build a tool that creates a PDF document from text files, changes the

document properties, adds a watermark and a digital signature, then saves the document to

the local computer. The following actions are required from the Actions Library for these

operations:

1.  Choose Input Files

2.  Create PDF from Text

3.  Change Document Properties

4.  Add Watermarks

5.  Sign Document

1886
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6.  Save Documents

Follow the steps below to create the tool:

1. Click Create in the main window:

Figure 3. Main Window, Create Tool Option

The Edit window for the new tool will open:
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Figure 4. Edit Window, New Tool Creation

2. Enter a name and description for the tool, then drag the necessary actions from the

Actions Library into the Tool Actions Sequence:
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Figure 5. Edit Window, Adding Actions

Note that the the order of actions in the Tool Actions Sequence determines the order in

which they are performed when the tool runs.

· Click the  icon to expand/collapse actions. Available parameters are displayed

when actions are expanded. A complete breakdown of all actions and their

parameters is available here.

· Click the  icon to revert to default parameters after action parameters have been changed.

· Click the  icon to remove actions from the Tool Actions Sequence.

· Actions that feature a check box are optional. A selected box means actions are included in the

Tool Actions Sequence when the tool runs. A cleared box means that actions are skipped when

the tool runs, but are retained in the Tool Actions Sequence for subsequent use. (This is a

useful feature in cases where actions are required only some of the time).

3. Click  Save Changes to save the tool, which will then be available in the Main Window:

1336
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Figure 6. Main Window, New Tool Complete

· Double-click to launch the tool, or right-click for further options, as detailed

here.

· Note that new tools are moved into the tool category that was open when the Create button

was clicked. Drag tools into different categories as desired. 

· Click and drag tools onto the desktop to create a shortcut to the tool.
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8 Clone Tool

 Clone Tool

The Clone Tool feature of PDF-Tools is used to clone tools. This makes it possible to

duplicate tools and then customize their settings whilst retaining the existing tool and its

parameters. This is especially useful in the case of the default tools, as many of their

parameters are locked by default. Cloning the default tools makes it possible to

add/remove actions to/from the Tool Actions Sequence as desired, and thus enables the

advanced customization of tools. For example, the Create PDF from Text  tool is used to

convert text files into PDF format, and it uses five actions from the Actions Library  to

achieve this:

Figure 1. Create PDF from Text, Tool Actions Sequence

When the tool is launched it will prompt the user for input text files, convert them into PDF

format, change document properties, save the files according to the user specifications and

1612
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display them in their desktop folder. If this tool is cloned then further options become

possible. For example, the Show Files action could be removed and the Add Watermarks

and Sign Document actions could be added. The Tool Actions Sequence would then

appear as follows:

Figure 2. Create PDF from Text Tool Clone, Updated Tool Actions Sequence

The tool would then prompt the user for input text files, convert them into PDF format,

change document properties, add a customized watermark and sign the document, and

then save them according to the user's specifications (but not display them in their

containing folder on the desktop, as the Show Files action has been removed).

Cloning and Editing Tools

Follow the steps below to clone tools:

1. Right-click the desired tool and click Clone in the submenu:
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Figure 3. Right-Click Content Menu for Tool, Clone Option

The PDF-Tools dialog box will open:

Figure 4. PDF-Tools Dialog Box, Tool Name Text Box

2. Enter a name for the cloned tool and click OK. It will then be available in the main

window. Right-click the cloned tool and then click Edit:
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Figure 5. Main Window, Cloned Tool Right-Click Menu

The Edit window for the tool will open:
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Figure 6. Cloned Tool Edit Window

· Click the  icon to expand/collapse actions. Available parameters are

displayed when actions are expanded. A complete breakdown of all actions

and their parameters is available here.

· Click the  icon to revert to default parameters after action parameters have been

changed.

· Click the  icon to remove actions from the Tool Actions Sequence.

· Actions that feature a check box are optional. A selected box means actions are included

in the Tool Actions Sequence when the tool runs. A cleared box means that actions are

skipped when the tool runs, but are retained in the Tool Actions Sequence for

subsequent use. (This is a useful feature in cases where actions are required only some of

the time).

· Drag actions from the Actions Library (or double-click them) to add them to the Tool

Actions Sequence. There are eighty-six available actions. See the Actions Library  for

an explanation of all actions and their associated parameters. 

· The order of actions in the Tool Actions Sequence determines their order of operation

when tools run. Select actions and then click the Move Up or Move Down buttons

displayed in (figure 6) to change their order in the Tool Actions Sequence. Several

actions require additional actions in order to function correctly. Additional actions may

be required before (prerequisite) or after (postrequisite) actions. For example the Create

PDF From Text action requires both an action that sources input files to convert to PDF

and an action that saves converted files. If an ordering mistake is made then a warning

icon will appear. Click the icon for further information and a solution to the issue.

· The Batch Processing Mode setting determines the processing method in

cases of multiple input files. It is enabled by default, which means files are

processed simultaneously. Clear the Batch Processing Mode box to process

input files one at a time instead. Disabling this option should reduce memory

usage, but it may also result in unexpected output for tools that combine input

files into single documents.

· The Multi-Threaded Processing Mode setting is disabled by default. Select

the box to enable multi-threaded processing, which will use all available CPU

cores when tools run. This improves the processing performance but also

increases the demand on your computer, which may be detrimental to other

processes running at the same time.

· Click All Options to view additional options:

· The Do Not Ask for Passwords setting is disabled by default. This

means that PDF-Tools will prompt for passwords in cases of password-

protected input files that do not have corresponding passwords in

Predefined Passwords Storage.  Enable this option to skip these files

when tools run.

· Use the Successfully processed files dropdown menu to determine the

action taken for successfully processed files.

1336
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· Use the Unsuccessfully processed files dropdown menu to determine

the action taken for unsuccessfully processed files.

· The Edit window (figure 6) and the options it contains are detailed here.

3. Click  Save Changes to save changes to tools.
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9 Actions Library

 Actions Library

The Actions Library contains the eighty-six available actions in PDF-Tools. These actions

are used to create the Tool Actions Sequence, which determines the functionality of tools.

The Actions Library is located on the right side of the Edit window:

Figure 1. Edit Window, Actions Library Highlighted

The actions are grouped into twelve categories:

 The Create PDF Actions  are used to create PDF documents from documents of

other formats, image files, scanned input or through splitting/merging existing PDF

documents.
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 The Export PDF Actions  are used to export content from PDF documents into

alternative formats such as image files and MS Office formats.

 The Input/Output Actions  relate to input/output processes when files are

sourced/saved.

 The Bookmarks Actions  are used to create and manipulate document bookmarks.

 The Optimize PDF Actions  are used to enhance the quality of scanned pages and

optimize the size of documents.

 The PDF Standard Actions  are used to add/remove compliance with the PDF

subsets PDF/A and PDF/X. 

 The Pages Actions  are used to edit and enhance document pages.

 The Links Actions  are used to create/delete links and weblinks.

 The Forms Actions  are used to import, export, reset or delete forms and form

data.

 The Comments Actions  are used to import/export, remove and interact with

document comments, annotations and form fields. 

 The Protection Actions  are used to determine document security via digital

signatures, timestamps and passwords.

 The Advanced Actions  are used to change the document properties or email

documents.

Click action categories for further information.
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9.1 Create PDF Actions

 Create PDF Actions

The Create PDF actions are used to create PDF documents from documents of other

formats, image files, scanned input or through splitting/merging existing PDF documents:

 Convert Files to PDFs  creates PDF documents from documents of other

formats.

 Create PDF Portfolio  creates PDF portfolio files from source documents.

 Create PDF from Images  creates PDF documents from image files.

 Create PDF from Text  creates PDF documents from text files.

 Extract Pages  creates PDF documents from pages of existing documents.

 Get Images From Scanner  sources images from the local scanner for use with other

actions from the Actions Library.

 Split/Merge Documents  splits single documents into several smaller documents, or

combines multiple documents into a single file.
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9.1.1 Convert Files to PDFs

 Convert Files to PDFs

The Convert Files to PDF action creates PDF documents from documents of other formats.

Please note:

· This action is intended for use with files that contain both text and images. Use the

Create PDF from Text  action to create PDF documents from text files and the

Create PDF from Images  action to create PDF documents from image files.

· This action creates a new PDF document from each input file. Use the Split/Merge

Documents  action to create a single PDF document from multiple input files.

· This action must be ordered after the Choose Input Files  action in the Tool

Actions Sequence or the tool will not run.

· A complete list of supported file formats is available here.

The Convert Files to PDF action contains the following customizable parameters:
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Figure 1. Convert Files to PDF Action Parameters

· The Converters dropdown menu details input formats that have adjustable

parameters that can be customized. Select a format and click Setup to determine

adjustable parameters when files of the specified format are converted to PDF.

· The MS Word File option contains three parameters:

· Select the Allow for the conversion of RTF files with Microsoft Word

box to allow MS Word to convert (*.rtf) files to MS Word format.

· Select the Enable macros in macro-enabled documents box to enable

macros  in converted MS Word files.

· Select the Include markups in conversion box to include markups

made to MS Word files in the conversion to PDF.

· The MS Excel, MS Powerpoint and MS Visio File options contain one

parameter:

· Select the Enable macros in macro-enabled documents box to enable

macros  in converted MS Excel/Powerpoint/Visio files.

· The Text File options are detailed below:

1796
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Figure 2. Text File Options Dialog Box, New Page Options

These options are used to determine the size and layout parameters for converted text

files:

· Select Standard to convert text files into a PDF of standard dimensions, then

select a standard size in the dropdown menu.

· Select Custom to convert text files into a PDF of custom dimensions, then

enter the desired dimensions in the number boxes and select the desired units

of measurement, orientation and page rotation.

· Use the Margins number boxes to determine the page margins.
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Figure 3. Text File Options Dialog Box, Text Format Options

· Click Font/Paragraph to determine font/paragraph options, as detailed

here.

· Use the Number of columns dropdown menu to determine the number of

columns of text.

· Use the Space between columns dropdown menu to determine the distance

between columns and the Units dropdown menu to determine the units of

measurement.

· Select the Line between columns box to insert a line between columns of

text, then use the dropdown menus to determine the Style, Thickness and

Color of columns as desired.

The CSV to PDF options are detailed below:

1794
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Figure 4. CSV to PDF Dialog Box

· Use the Delimiter text box to specify the delimiter used to delimit values in input

CSV documents. Alternatively, select the Automatically calculate delimiter based

on data box to detect delimiters automatically.

· Use the Quotes text box to specify the quotes used in input CSV documents.

· Use the Page Settings to determine the size and orientation of converted files:

· Use the Standard dropdown menu to specify standard page dimensions such

as those used by the ISO and ANSI, then use the adjacent dropdown menu to

specify either Portrait or Landscape as the orientation of output documents.

· Click the Custom button to use custom dimensions, then enter the desired

dimensions in the adjacent number boxes. Use the adjacent dropdown menu

to specify the units of measurement used.

· Use the Style options to specify the style of output documents:

· Use the Margins boxes to specify the margins of output documents.

· Click the Font button to specify the font of output documents. The Select Font

dialog box will open. Select the font, style and size of the desired font and

then click OK to save changes.

· Use the Border Width number box to specify the border width on the pages

of output documents, and use the adjacent dropdown menu to specify the

border color.
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· Use the check boxes to enable/disable additional options as desired.

Click OK to save changes.

The Markdown to PDF options are detailed below:

Figure 5. Markdown to PDF Options Dialog Box

· Use the Standard dropdown menu to specify standard page dimensions such as

those used by the ISO and ANSI.

· Click the Custom button to use custom dimensions, then enter the desired

dimensions in the adjacent number boxes. Use the adjacent dropdown menu to

specify the units of measurement used.

· Use the Orientation dropdown menu to specify the orientation of output

documents.

· Use the Page Rotation dropdown menu to specify the page rotation of output

documents.

· Use the Margins number boxes to specify the margins of output documents.

· Use the Path text box to specify the path to a CSS file in order to specify text style

options in output documents.

Click OK to save changes.
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9.1.2 Create PDF Portfolio

 Create PDF Portfolio

The Create PDF Portfolio action creates PDF portfolio files from source documents:

Figure 1. Create PDF Portfolio Action Parameters

· Enter the file that you want to use as the cover for the PDF portfolio in the text box,

or click the ellipsis icon to select a file from the local computer.

· Click the eye icon to view further information about the document selected for the

portfolio cover.

· Use the number box to specify the page number to be used as the portfolio cover.

· If you are using a folder as the input files for the creation of the PDF portfolio, and

you want to retain the structure of the folder in the output file, then select the Keep

folder structure box. 
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Click  Save Changes to save changes.
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9.1.3 Create PDF from Images

 Create PDF from Images

The Create PDF from Images action creates PDF documents from image files. It contains

the following customizable parameters:

 
Figure 1. Create PDF from Images Action Parameters

· Click All Options to determine conversion options for images. The Image to PDF

Options dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Image to PDF

Options dialog box and customize settings each time this action is used. Clear this

box to disable the Image to PDF Options dialog box from opening each time the

action is used, which is useful when the same settings are used consistently.
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New Page Options

Figure 2. Image to PDF Options Dialog Box, New Page Options

· The New Page Options determine the page dimensions of output documents:

· Select the Select Paper Size by Image Size option to use the dimensions of

input images as the page size of output documents.

· Select the Standard option to use an industry-standard size for output

documents, then select an option from the dropdown menu.

· Select the Custom option to use custom dimensions for output documents,

then enter the dimensions in the number boxes and select the desired units of

measurement, orientation and page rotation. 

· Use the Margins number boxes to determine the page margins of output

documents.

Image Layout Options
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Figure 3. Image to PDF Options Dialog Box, Image Layout Options

These settings are used to customize the layout of images in output documents:

· Use the Columns and Rows number boxes to determine the layout of output

documents that feature multiple images. Use the number boxes on their right to

determine the distance between columns and rows of images in output documents.

· Use the Fit dropdown menu to determine how images fit into the dimensions of the

output document:

· Select Reduce to Cell to reduce the size of images to fit the dimensions of the

PDF document. If images are smaller than the PDF document then they will

remain at their original size.

· Select Fit to Cell to fit images to the dimensions of the PDF document. If

images are smaller than the PDF document then they will be increased in size.

· The Keep Aspect Ratio check box is selected by default, which means images

retain their proportions and fit the specified dimensions of the output

documents as far as possible within those proportions. Clear the check box to
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disable the aspect ratio. Images will then match the specified dimensions of

the output document, but they may distort as a result.

· The Horizontal/Vertical Alignment dropdown menus determine the location

at which images appear in the output document.

Image Labels

Figure 4. Image to PDF Options Dialog Box, Image Labels

These settings are used to add labels to images in output documents: 

· Select the Use a custom text label for each image box to add a label to images,

then use the remaining settings to customize the label:

· Enter the desired text for the label in the text box. Click the blue icon to

view/add macros.

· Use the Back Color dropdown menu to determine the back color of the label.

· Click the Paragraph and Font buttons to determine paragraph and font

settings, as detailed here.
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· Select the Place label above image box to place the labels above images. If

this box is cleared then labels are placed below images.

· Select the Add bookmark for each image, with the same text as the label

option as desired. If this option is selected then a bookmark will be created

for each image in the output document. The bookmark titles will be the same

as the text entered in the text box in (figure 4) - which means the text will be

the same for all bookmark titles unless macros  are used, which is the

advisable option.

Image Processing

Figure 5. Image Processing Options

These settings determine image processing options, which are the same for True Color,

Grayscale, Indexed and Monochrome images:

· Select an option in the Downsampling dropdown menus to enable Linear, Bilinear

or Bicubic downsampling for converted images. Further information about these

1796
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options is available here. Use the pixels per inch number boxes to set the resolution

to which images are downsampled, and the minimum resolution at which images

are downsampled. 

· Select an option in the Conversion dropdown menus to convert images to a

different format. Select the Dithering box to enable dithering as desired. 

Image Compression

Figure 6. Image Compression Options

These settings determine image compression options:

· Select/clear the Compression Enabled boxes to enable/disable compression for

True Color, Grayscale, Indexed and/or Monochrome images.

· Use the Auto dropdown menus to determine the format of compression used for

True Color, Grayscale, Indexed and/or Monochrome images.

· Select options in the the JPEG Quality/JBIG2 Method dropdown menus and

select/clear the Lossless boxes as desired. 

https://en.wikipedia.org/wiki/Decimation_(signal_processing)
https://en.wikipedia.org/wiki/Dither
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Image Post-Processing

These settings determine post-processing options for images:

Figure 7. Image Post-Processing Options

· Select the Deskew box to deskew images. Deskewing is used to straighten the

edges of images that have been scanned/photographed crookedly.

· Select the Despeckle box to despeckle images. Despeckling is used to remove

speckles from images during conversion.

Click OK to save changes.
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9.1.4 Create PDF from Text

 Create PDF from Text

The Create PDF from Text action creates PDF documents from text files. It contains the

following customizable parameters:

Figure 1. Create PDF from Text Action Parameters

· Use the Text Encoding dropdown menu to determine the text conversion used for

the conversion.

· Use the New Paragraph Mode dropdown menu to determine how new paragraphs

are created in converted documents.

· Use the Place File Mode dropdown menu to determine how documents are placed

in the output document in cases where more than one input document is used.

· Click More Options to determine conversion options for documents. The Options

dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Options dialog box

and customize settings each time this action is used. Clear this box to disable the
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Options dialog box from opening each time the action is used, which is useful when

the same settings are used consistently.

Figure 2. Options Dialog Box

New Page Options

These options determine the page dimensions of output documents:

· Select the Standard option to use an industry-standard size for output documents,

then select an option from the dropdown menu.

· Select the Custom option to use custom dimensions for output documents, then

enter the dimensions in the number boxes and select the desired units of

measurement, orientation and page rotation. 

· Use the Margins number boxes to determine the page margins of output

documents.

Text Format Options

These options determine the font, paragraph and layout of text during conversion to PDF:
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Figure 3. Text Format Options

· Use the Font and Paragraph buttons to determine the font and paragraph settings

of the text, as detailed here.

· Use the Columns options settings to determine the number of columns of text and

the distance between columns.

· Select the Line between columns box to insert lines between the columns of text,

then use the Style, Thickness and Color boxes to determine the parameters of the

lines.

File Separator Options

The file separator option inserts labels to indicate spaces between converted documents.

The following customizable parameters are available:

1794
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Figure 4. File Separator Options

· Select the Show title box to display a title with file separators, then enter the

desired title in the text box. Click the blue icon to add macros.

· Use the Back color dropdown menu to determine the color of file separators.

· Use the Font and Paragraph settings to determine the font and paragraph layout of

file separators, as detailed here.

· Select the Draw line box to add a line to file separators. Select the Style, Thickness

and Color options as desired.

· Select the Place line above header box to position the line above the document

header.

Click OK to save changes.
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9.1.5 Extract Pages

 Extract Pages

The Extract Pages action creates PDF documents from pages of existing documents. It

contains the following customizable parameters:

Figure 1. Extract Pages Action Parameters

· Click All Options to determine conversion options for extracted pages. The Extract

Pages dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Extract Pages

dialog box and customize settings each time this action is used. Clear this box to

disable the Extract Pages dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Extract Pages Dialog Box

· Use the Page Range options to determine which pages from the source document

are extracted to create the new PDF document.

· Select All to extract all pages.

· Select Custom to extract a custom page range. Further information on how to specify page

ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Use the Actions with Objects dropdown menus to determine conversion options

for Comments, Form Fields and Bookmarks in extracted pages.

Click OK to save changes.

1873
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9.1.6 Get Images from Scanner

 Get Images from Scanner

The Get Images from Scanner action sources images from the local scanner for use with

with other actions from the Actions Library. It contains the following customizable

parameters:

Figure 1. Get Images from Scanner Action Options

 

· Click More Options to determine scan parameters. The Scan Properties dialog box

will open, as detailed below.

· Select the Show setup dialog while running box to launch the Scan Properties

dialog box and customize scan parameters each time this action is used. Clear this

box to disable the Scan Properties dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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Figure 2. Scan Properties Dialog Box

· Use the Scanner Settings dropdown menu to save/select scanning profiles, as detailed in

(figure 3). 

· Use the Scanner dropdown menu to determine the scanner used to source images. 

· Select either Native Mode or Memory Mode in the Data Transfer Method dropdown menu:

· Native Mode uses a single memory buffer. This is the default and fastest

mode, and is compatible with the broadest range of scanners.

· Memory Mode enables the use of multiple memory buffers. This is a useful

function in cases where memory is low and/or when large images are being

scanned.

· The Show Native UI box is selected by default, which means the user interface of

the device driver is used. This is the most reliable option, and the scanner will select

certain parameters of the scan itself: Color Mode, Resolution, Paper Size and

Source. Clear the Show Native UI box to customize these options:

· Use the Color Mode dropdown menu to select Auto detect, Color, Grayscale or Black &

White as the format of scanned documents.

· Use the Resolution dropdown menu to set the dpi (dots per inch) of scanned documents.

· Use the Paper Size number box to determine the paper size of scanned documents. Click

Setup for further options:

· Select Automatic to allow the paper size to be determined automatically.

· Select Standard to use an industry-standard paper size.
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· Select Custom to use custom dimensions.

· Use the Source dropdown menu to specify Auto, Flatbed or Feeder as the type of

scanner used in the operation.

· Use the Sides dropdown menu to determine which sides of documents are scanned.

There are three options: Simple Scan, Manual Duplex and Manual Duplex Reversed.

Click the dropdown arrow on the right side of the box to view an explanation of these

options.

· Use the Scan More Pages dropdown menu and number box to determine when

additional pages are scanned.

Click OK to save changes.

Scanner Settings

Use the Scanner Settings dropdown menu to select preset scanning modes or

save/manage/delete custom settings:

 
Figure 3. Scanner Settings Dropdown Menu Options

· Select predefined modes as desired.

· Click Save Current Settings to save the current settings as a profile for subsequent

use.

· Click Delete to delete selected profiles. Note that this option is only available for

customized profiles.
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· Click Manage to manage preset/customized profiles. The Manage Presets dialog

box will open:

Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles. Note that this option is only available for

customized profiles.

· Click Clone to clone selected profiles. This option can be used to customize the

settings of preset profiles, which cannot be customized in their default state.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles. Note that this option is only available for

customized profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.1.7 Split/Merge Documents

 Split/Merge Documents

The Split/Merge Documents action splits single documents into several smaller documents,

or combines multiple documents into a single file. It contains the following customizable

parameters:

Figure 1. Split/Merge Documents Action Options

· Use the Method options to determine how pages are split/merged:

· Select an option in the dropdown menu to determine the split/merge mode:

· All pages to One document merges all input pages into a single

document.

· Every N pages in Separate document splits an input document into

smaller documents of n pages. Enter a value for n in the adjacent

number box. For example, if a document of nine pages is selected and

the value of n is three, then three documents of three pages will be

created from pages 1-3, 4-6 and 7-9.
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· Keep input document(s) as is retains the original format of input

documents.

· Split by top bookmarks splits an input document into smaller

documents that are defined by the top-level bookmarks of the input

document. If this option is selected then the Generate document name

from dropdown menu will be displayed. Select an option from the

dropdown menu to determine the source of the document name.

· Select the Reverse pages order box to reverse the order of pages of input

documents.

· Use the Name for generated document(s) text box to specify a name for

generated documents. Click the dropdown arrow to include macros  as

desired.

· Select the Every N pages from different document box to interleaf merged

documents. Use the adjacent number box to specify the intervals at which

interleafing takes place.

· Use the Insert blank page after document that has: dropdown menu to

insert a blank page into output documents. The options are as follows:

· Select None to disable this feature.

· Select Odd Pages Count to insert a blank page at the end of output

documents that have an odd number of pages.

· Select Even Pages Count to insert a blank page at the end of output

documents that have an even number of pages.

· Select the Show dialog for manual split/merge to open the Manual

Split/Merge Documents dialog box when the tool runs. This dialog box is

used to reorder, add and/or remove pages and to preview output documents.

· Use the Actions with Objects options to determine actions for objects in input

documents:

· Select an option in the Form Fields, Comments and Bookmarks dropdown

menus to determine the action taken for these objects. 

· Select the Add root bookmark with filename box to add a root bookmark to

output documents. The filename of the input file will be used as the bookmark

title.

· Select the Show setup dialog while running box to launch the Split/Merge

Documents dialog box and customize settings each time this action is used. Clear

this box to disable the Split/Merge Documents dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.

Click  Save Changes to save changes.
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9.2 Export PDF Actions

 Export PDF Actions

The Export PDF actions copy and convert PDF documents and images to alternative

formats:

 Export PDF to Images  copies PDF documents and converts them to raster

images.

 Export PDF to Microsoft Excel Spreadsheet  copies PDF documents and

converts them to Microsoft Excel (.xlsx) format.

 Export PDF to Microsoft Powerpoint Presentation  copies PDF documents

and converts them to Microsoft Powerpoint Presentation (*.pptx) format.

 Export PDF to Microsoft Word Document  copies PDF documents and

converts them to Microsoft Word (.docx) format.

 Export PDF to Plain Text  copies PDF documents and converts them to plain

text (*.txt) format.

 Extract Attachments  extracts attachments from documents.

 Extract Images from PDF  copies images in PDF documents and saves them to

file.

 PDF to Audio  copies text in PDF documents to audio file format.
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9.2.1 Export PDF to Images

 Export PDF to Images

The Export PDF to Images action copies PDF documents and converts them to raster

images. It contains the following customizable parameters:

Figure 1. Export PDF to Images Action Options

· Click All Options to determine conversion options for extracted pages. The Export

to Images dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Export to Images

dialog box and customize settings each time this action is used. Clear this box to

disable the Export to Images dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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Figure 2. Export to Images Dialog Box

· Use the Page Range options to determine the page range from which to export

pages to image format. Further information on page range options is available

here.

· Use the Graphics options to determine settings for exported graphics:

· Use the Page Zoom number box to determine the level of zoom used when

pages are exported.

· Use the Page Background dropdown menu to determine the background

color of exported pages.

· Use the Resolution number boxes to determine the horizontal and vertical

resolution of exported pages.

· Use the Export Settings dropdown menu to save/manage/delete custom profiles:

1873
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Figure 3. Export to Images Dialog Box, Custom Profiles

· Click Save Current Settings to save custom settings for subsequent use. Saved

profiles are detailed in the Export Settings dropdown menu.

· Click Delete to delete selected profiles.

· Click Manage to manage saved custom settings. The Manage Presets dialog box

will open, as detailed below.

Click OK to save changes.
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles. This makes it possible to duplicate profiles

and then customize their settings whilst retaining the existing profile and its

parameters.

· Use the up and down arrow to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.2.2 Export PDF to Microsoft Excel Spreadsheet

 Export PDF to Microsoft Excel Spreadsheet

The Export PDF to Microsoft Excel Spreadsheet action copies PDF documents and

converts them to Microsoft Excel (*.xlsx) format. It contains the following customizable

parameters:

Figure 1. Export PDF to Microsoft Excel Spreadsheet Action Options

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Folder dropdown menu to determine where converted files are saved:



1373

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

· Always ask for file location prompts the user to select a location each time

the action is used.

· Use source folder as destination uses the source folder of input files as the

save location. 

· Use custom folder specified enables the user to specify a folder. If this

option is used then the folder location must be specified in the text box

beneath the dropdown menu.

· Use the Filename text box to name output files. The default name is defined by the

macro %[Filename], which uses the name of the source file. Click the dropdown

arrow to add additional macros.

· Use the When File Already Exists dropdown menu to determine the action taken

when filenames are already in use: 

· Prompt for action prompts the user for an action to take.

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save the

new file. 

· Save new with other unique name inserts a prefix to the filename and then

saves the new file.

· Click More Options for further options. The MS Excel File dialog box will open:
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Figure 2. MS Excel File Dialog Box

The current settings for exporting files to MS Excel format are detailed in the dialog box.

· Use the Page Range options to determine the page range from which to export

pages to MS Excel format. Further information on page range options is available

here.

· Click Edit to edit export settings. The Options dialog box will open:

Figure 3. Options Dialog Box

· Use the Language dropdown menu to specify the language of the source document. This

setting is necessary in cases where document text has the incorrect encoding and OCR is used

to determine the correct unicode to use. AUTO is the default setting and the language is taken

from the document properties when it is used.

· Use the Numeric settings to determine the symbols used as decimal points and to delineate

thousands in numerical values of one thousand or more:

· Select Detect decimal and thousands separators using regional settings to use the

regional settings for decimal points and thousands separators.

· Select Treat the following as decimal and thousands separators to specify either

periods or commas for these functions, then select the desired options in the dropdown

menus.

· Select the Make invisible text visible in output document to convert invisible text into visible

text in output documents.

1873
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· Select an option in the Create Worksheet dropdown menu to determine the output option for

documents:

· Select for each page to create a worksheet for each page of the input documents.

· Select Single for the document to export the source document to a single worksheet.

· Select either Paragraph or Line in the lower dropdown menu to determine how rows are

created in output documents. If Paragraph is selected then each paragraph in the source file is

converted to a new row in the output document. If Line is selected then each line in the source

file is converted to a new row in the output document. 

Click OK to save changes.

Please note that MS Office must be installed on the local computer for this feature to

operate, and Save As XPS functionality must be available in the version of MS Office being

used. This functionality was added in MS Office 2007.
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9.2.3 Export PDF to Microsoft PowerPoint Presentation

 Export PDF to Microsoft Powerpoint Presentation

The Export PDF to Microsoft Powerpoint Presentation action copies PDF documents and

converts them to Microsoft Powerpoint Presentation (*.pptx) format. It contains the

following customizable parameters:

Figure 1. Export PDF to Microsoft Powerpoint Presentation Action Options

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Folder dropdown menu to determine where converted files are saved:



1377

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

· Always ask for file location prompts the user to select a location each time

the action is used.

· Use source folder as destination uses the source folder of input files as the

save location. 

· Use custom folder specified enables the user to specify a folder. If this

option is used then the folder location must be specified in the text box

beneath the dropdown menu.

· Use the Filename text box to name output files. The default name is defined by the

macro %[Filename], which uses the name of the source file. Click the dropdown

arrow to add additional macros.

· Use the When File Already Exists dropdown menu to determine the action taken

when filenames are already in use: 

· Prompt for action prompts the user for an action to take.

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save the

new file. 

· Save new with other unique name inserts a prefix to the filename and then

saves the new file.

· Click More Options for further options. The MS PowerPoint File dialog box will

open:
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Figure 2. MS PowerPoint File Dialog Box

The current settings for exporting files to MS PowerPoint Presentation format are detailed

in the dialog box.

· Use the Page Range options to determine the page range from which to export

pages to MS PowerPoint Presentation format. Further information on page range

options is available here.

· Click Edit to edit export settings. The Options dialog box will open:

1873
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Figure 3. Options Dialog Box

· Select the Convert Entire page content to image box to convert all page content

into image format in output documents.

· Use the Resolution dropdown menu to determine the resolution of output

documents.

· Use the Text Conversion Options determine how text is converted:

· Use the Language dropdown menu to specify the language of the source document. This

setting is necessary in cases where document text has the incorrect encoding and OCR is

used to determine the correct unicode to use. AUTO is the default setting and the

language is taken from the document properties when it is used.

· Use the Mode dropdown menu to determine the text conversion mode:

· Select Preserve text editable to preserve the existing format of text and

retain the option of editing text in output documents.

· Select Convert to curves to convert text into vector curves. Please note

that curves cannot be edited.
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· Select Convert to images to convert text into image format.

· Select the Embed all fonts box to embed all fonts in converted documents.

(This increases the file size but ensures compatibility on all machines).

· Select the Allow to use substitution for fonts that cannot be embedded

box to enable the use of substitute fonts in cases where fonts cannot be

embedded. 

· Select the Allow to convert a text that uses problematic fonts to curves

box to enable the conversion of problematic fonts into curves.

· Use the Resolution dropdown menu to determine the rasterization resolution

of converted text. Text will be rasterized in cases where it cannot be converted

with the specified text conversion options.

· Select the Make invisible text visible in output document to convert invisible text into

visible text in output documents.

· Select the Include Comments and/or Include Links boxes to include

comments and/or links when files are converted.

Click OK to save changes. 

Please note that MS Office must be installed on the local computer for this feature to

operate, and Save As XPS functionality must be available in the version of MS Office being

used. This functionality was added in MS Office 2007.
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9.2.4 Export PDF to Microsoft Word Document

 Export PDF to Microsoft Word Document

The Export PDF to Microsoft Powerpoint Word Document action copies PDF documents

and converts them to Microsoft Word Document (*.docx) format. Files exported to

(*.docx) format are compatible with MS Word 2010 and later. This action contains the

following customizable parameters:

Figure 1. Export PDF to Microsoft Word Document Action Options

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Folder dropdown menu to determine where converted files are saved:
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· Always ask for file location prompts the user to select a location each time

the action is used.

· Use source folder as destination uses the source folder of input files as the

save location. 

· Use custom folder specified enables the user to specify a folder. If this

option is used then the folder location must be specified in the text box

beneath the dropdown menu.

· Use the Filename text box to name output files. The default name is defined by the

macro %[Filename], which uses the name of the source file. Click the dropdown

arrow to add additional macros.

· Use the When File Already Exists dropdown menu to determine the action taken

when filenames are already in use:

· Prompt for action prompts the user for an action to take.

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save the

new file. 

· Save new with other unique name inserts a prefix to the filename and then

saves the new file.

· Click More Options for further options. The MS Word File dialog box will open:
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Figure 2. MS Word File Dialog Box

The current settings for exporting files to MS Word format are detailed in the dialog box.

· Use the Page Range options to determine the page range from which to export

pages to MS Word format. Further information on page range options is available

here.

· Click Edit to edit export settings. The Options dialog box will open:

Figure 3. Options Dialog Box

· Use the Language dropdown menu to specify the language of the source document. This

setting is necessary in cases where document text has the incorrect encoding and OCR is used

to determine the correct unicode to use. AUTO is the default setting and the language is taken

from the document properties when it is used.

· Use the Fonts dropdown menu to determine embedding options for fonts in output

documents:

· Select Embed only fonts embedded in PDF document to embed the

embedded fonts of source documents in output documents.

· Select No Embed to exclude font embedding in output documents.

· Use the Layout Settings to determine the layout setting for exported documents:

· Select either the Retain Page Layout or the Retain Flowing Text button as desired. Retain

Page Layout adds a page break after each page and a line break to lines that are shorter than

other lines within the same paragraph. Retain Flowing Text retains the text flow as a priority

over the page layout and will allow text to wrap if there are multiple columns of text.
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· Select the Make invisible text visible in output document to convert invisible text into visible

text in output documents.

· Select/clear the Include Comments box to include/exclude comments in the

conversion process.

· Select/clear the Include Images box to include/exclude images in the conversion

process.

· Select/clear the Include Links box to include/exclude links in the conversion

process.

Click OK to save changes.

Please note that MS Office must be installed on the local computer for this feature to

operate, and Save As XPS functionality must be available in the version of MS Office being

used. This functionality was added in MS Office 2007.
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9.2.5 Export PDF to Plain Text

 Export PDF to Plain Text

The Export PDF to Plain Text action copies PDF documents and converts them to plain text

(*.txt) format. It contains the following customizable parameters:

Figure 1. Export PDF to Plain Text Action Options

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Folder dropdown menu to determine where converted files are saved:

· Always ask for file location prompts the user to select a location each time

the action is used.



1386

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

· Use source folder as destination uses the source folder of input files as the

save location. 

· Use custom folder specified enables the user to specify a folder. If this

option is used then the folder location must be specified in the text box

beneath the dropdown menu.

· Use the Filename text box to name output files. The default name is defined by the

macro %[Filename], which uses the name of the source file. Click the dropdown

arrow to add additional macros.

· Use the When File Already Exists dropdown menu to determine the action taken

when filenames are already in use: 

· Prompt for action prompts the user for an action to take.

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save the

new file. 

· Save new with other unique name inserts a prefix to the filename and then

saves the new file.

· Click More Options for further options:

Figure 2. Options Dialog Box

· Select the Add page numbers to the text and/or Insert line breaks boxes as

desired.

· Select an option from the End lines with dropdown menu to determine the newline

character. Further information on newline characters is available here.

· Select an option from the Text encoding dropdown menu to determine the text

encoding format.

Click OK to save changes.
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9.2.6 Extract Attachments

 Extract Attachments

The Extract Attachments action extracts attachments from documents. It contains the

following customizable parameters:

Figure 1. Extract Attachments Action Options

· Select the File name box to specify a file mask for the attachments you want to

extract. A file mask is a pattern of fixed characters followed by a wildcard that

specifies the end of the file mask. You can use either an asterisk or a question mark

to specify masks for this action. Asterisks match zero or more arbitrary characters.

For example, if you are using this action with a document that contains a large

number of attachments, and you want to extract only the attachments that start with

the prefix "test", then you can enter the file mask "test*" and only those attachments

will be extracted. Alternatively, if you want to specify that only PDF format files are

extracted then you can use the file mask "*.pdf" Question marks match one arbitrary

character. For example, the file mask "201?" will extract all attachments that have a
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file name with the prefix '201' followed by exactly one character. If you need to

specify more than one mask then you must use a semicolon between masks. 

· Select the File size box to specify the size range of attachments you want to extract.

· Select the Show setup dialog while running box to launch the Extract

Attachments dialog box and customize settings each time this action is used. Clear

this box to disable the Extract Attachments dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.

Click OK to save changes.
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9.2.7 Extract Images from PDF

 Extract Images from PDF

The Extract Images from PDF action copies images from PDF documents and saves them

to file. It contains the following customizable parameters:

Figure 1. Extract Images from PDF Action Options

· Use an Exclude images smaller than dropdown menu to specify a minimum size

for extracted images, or enter a custom size in one of the text boxes.

· Select the Actual image view box to save images as they appear in the original

document.

· Select the Keep Transparency box to retain transparency in images.

· Select the Show setup dialog while running box to launch the Extract Images

from PDF dialog box and customize settings each time this action is used. Clear this

box to disable the Extract Images from PDF dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.
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Click  Save Changes to save changes.
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9.2.8 PDF to Audio

 PDF to Audio

The PDF to Audio action copies text in PDF documents to audio file format. It contains the

following customizable parameters:

Figure 1. Export PDF to Audio Action Options
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· Use the Volume slider to determine the volume of the voice used in the audio file.

· If you do not want to use the default voice for the audio file, then clear the Use

default voice box and select an alternative voice in the dropdown menu.

· Use the Pitch and Rate sliders to determine the pitch and speed of the voice used in

the audio file.

· Select the Read Comments and/or Read Form Fields box to include the text of

comments and form fields in the audio file. Text from comments and form fields is

placed at the end of the audio file recording.

· Select the Split audio file by document's top bookmarks to split input documents

into output documents according to the top bookmarks of the input document.

· Select the Split audio file by box to split input documents into output documents of

the length specified in the dropdown menu. The default length is ten minutes. Use

the dropdown menu to specify an alternative length as desired.

· Select All to convert the text from all pages.

· Select Pages to specify a page range for conversion. Information on how to specify

page ranges is available here.

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Folder dropdown menu to determine where converted files are saved:

· Always ask for file location prompts the user to select a location each time

the action is used.

· Use source folder as destination uses the source folder of input files as the

save location. 

· Use custom folder specified enables the user to specify a folder. If this

option is used then the folder location must be specified in the text box

beneath the dropdown menu.

· Use the Filename text box to name output files. The default name is defined by the

macro %[Filename], which uses the name of the source file. Click the dropdown

arrow to add additional macros.

· Use the Audio format dropdown menu to determine the format of the audio file.

Click the settings icon to determine the Sample rate, Channels and/or Bitrate as

desired.

· Use the When File Already Exists dropdown menu to determine the action taken

when filenames are already in use:

· Prompt for action prompts the user for an action to take.

· Overwrite with a new file overwrites the existing file with the new file. 

1873
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· Keep existing file unchanged retains the existing file and does not save the

new file. 

· Save new with other unique name inserts a prefix to the filename and then

saves the new file.

· Select the Show setup dialog while running box to launch the PDF to Audio

dialog box and customize settings each time this action is used. Clear this box to

disable the PDF to Audio dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.

Click  Save Changes to save changes.

Note that it is necessary to have Media Foundation installed on the local machine for this action to

operate, as detailed here. 1871
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9.3 Input/Output Actions

 Input/Output Actions

The Input/Output actions determine parameters for the input/output process when tools

run:

 Choose Input Files  prompts the user to select input files to use in conjunction

with other tool actions.

 Save Documents  determines the save options for output documents.

 Save Images  determines the save options for output images.

 Send Mail  sends output documents/images via the user's desktop email client.

 Show Files  displays output documents.
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9.3.1 Choose Input Files

  Choose Input Files

The Choose Input Files action sources files for use in conjunction with other actions in PDF-

Tools. It contains the following customizable parameters:

Figure 1. Choose Input Files Action Options

· Use the Choose From dropdown menu to determine where source files are taken

from:

· Click My Computer to use files from the local computer.

· Hover over Add Place to add a new place from which to take files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to source files as desired.

· Select Choose files to source individual input files. If this option is selected then the

following options are available:
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· Select the Allow select multiple files box to enable the selection of multiple

files.

· Select the Show extended dialog for files selecting box to launch the

Choose Input Files dialog box each time this action is used. The Choose

Input Files dialog box is detailed in (figure 4). It is used to view, edit and

reorder input files. Clear the Allow extended dialog for files selecting box to

disable the launching of the Choose Input File dialog box each time this

action is used.

· Select the Store selected file names for future use box to create a record of

the input files used next time the tool runs. These files will be added

automatically on subsequent runs of the tool. Click the pencil icon to view/edit

stored files, or the brush icon to remove stored files. Note that if this option

has been used to store files for subsequent use then it is not possible to select

different files for use with the tool.

· Select Select folder to source all files from one folder to use as input files.

Parameters for this setting are detailed in (figure 3).

· Select Select file list to source files from a list of files. Note that files must saved

with the extension (*.pdtfl) to be compatible with this option. List files can be

created in text editors such as Microsoft Notepad, and should contain only a list of

source files, as detailed in (figure 2) below. Note that folder paths can also be used.

· Select an option in the File types dropdown menu to determine the permitted file

types for the Choose Input Files action. Click the ellipsis icon to view/edit Available

File Filters. 1774
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Figure 2. Sample File List

Select Folder Options
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Figure 3. Select Folder Options

· Click the text box or the ellipsis icon to select a folder.

· Select the Look in subfolders box to include files located in subfolders.

· Select an option in the Sort dropdown menu to determine the order in which input

files are processed.

Choose Input Files

The Choose Input Files dialog box is used to view, edit and reorder input files:
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Figure 4. Choose Input Files Dialog Box

Use the icons as follows:

· Click  Add Files to add files from the local computer. 

· Click  Add Folder to add all files from a specified folder. 

· Click  Add From Scanner to add input files via a scanner. The Scan Properties dialog box

will open, which is used to determine scanning parameters. Further information on this dialog

box is available here.

· Click  to view Files List options. Click Save all files to Files List to save the files in the

dialog box to a list for subsequent use. Click Save Selected Files to save only selected files to a

list. Click Load Files List to load an existing list of files into the dialog box.

· Click  Move Up to move selected files up in the order of processing.

· Click  Move Down to move selected files down in the order of processing.

· Click  Edit to edit selected image files. The Edit Image dialog box will open. This dialog

box is detailed in (figure 6).

· Click  Zoom Out or  Zoom In, or use the slider, to zoom out from/in on page

thumbnails.

1361
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· Click  Delete to remove selected files from the dialog box.

· Click  Details to view the details of files added to the dialog box. Alternatively,

click  Thumbnails to view files as thumbnails.

· Click  Preview to view a post-conversion preview of selected files, which will

display on the right of the dialog box, as detailed in (figure 4).

Click OK to proceed with the tool operation.

Right-click the dialog box for additional options:

Figure 5. Choose Input Files Shortcut Menu

· Click Zoom Out/In to zoom out from/in on documents in the dialog box.

· Click Add Files/Folder/from Scanner to add additional files to the dialog box.

· Hover over Files List to view files list options:

· Click Save all files to files list to save all files in the dialog box to a files list

for subsequent use. If you want to use the same selection of files for a

subsequent tool then you can load the files list later for this purpose.

· Click Save selected files to files list to save selected files in the dialog box to

a files list.

· Click Load Files List to load an existing files list to use in conjunction with the

tool.

· Click Open Containing Folder to open the containing folder of the selected file in

the dialog box.
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· Click Sort to sort the files in the dialog box. Files can be sorted by Name,

Extension, Location, Modified (date), Size, Pages Range (in cases where page

ranges have been specified in input documents using the Select Pages option

detailed above), Info, and in either Ascending or Descending order.

· Click Copy/Paste/Delete to perform these operations on selected files.

Edit Image

The Edit Image dialog box is used to edit images before they are processed by tools:

Figure 6. Edit Image Dialog Box

Use the icons as follows:

· Click  Flip Horizontal to flip images horizontally.

· Click  Flip Vertical to flip images vertically.

· Click  Rotate 90 CCW to rotate images ninety degrees counter-clockwise.

· Click  Rotate 90 CW to rotate images ninety degrees clockwise.

· Click  the Apply Filter dropdown menu to view/select filters for images.

· Click  the Convert to dropdown menu to view/select color depths for images.

· Click  Grayscale to convert images to grayscale format.

· Click  Deskew to deskew images. Deskewing is used to straighten the edges of

images that have been scanned/photographed crookedly.
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· Click  Fit Visible to fit images to the border of the editing pane.

· Click  the Zoom In or  Zoom Out button to zoom in on/out from images, or

use the number box to adjust the zoom level manually.

Click OK to save changes and proceed with the tool operation.
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9.3.2 Save Documents

 Save Documents

The Save Documents action determines the save options for output documents. It contains

the following customizable parameters:

Figure 1. Save Documents Action Options

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Folder dropdown menu to determine where converted files are saved:

· Always ask for file location prompts the user to select a location each time

the action is used.
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· Use source folder as destination uses the source folder of input files as the

save location. 

· Use custom folder specified enables the user to specify a folder. If this

option is used then the folder location must be specified in the text box

beneath the dropdown menu.

· Use the Filename text box to name output files. The default name is defined by the

macro %[Filename], which uses the name of the source file. Click the dropdown

arrow to add additional macros.

· Use the When File Already Exists dropdown menu to determine the action taken

when filenames are already in use: 

· Prompt for action prompts the user for an action to take.

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save the

new file.

· Append existing document appends the file to an existing document.

· Save new with other unique name inserts a prefix to the filename and then

saves the new file.

· Select the Preserve original timestamp for file box to preserve the last modification date of

documents. Note that this setting works only when documents are saved locally.

· Select the Use incremental save if possible box to use incremental save, when possible, to

save documents. Incremental save retains original document content and stores information

about new changes. Enabling this option may reduce the time taken to save files, but it will also

increase the size of the file. 

Click  Save Changes to save changes.

1796
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9.3.3 Save Images

 Save Images

The Save Images action determines the save options for output images. It contains the

following customizable parameters:

Figure 1. Save Images Action Options

· Use the Grouping Mode options to determine how saved images are grouped:

· Select Each image to a separate file to save each image to a separate file. 

· Select All images from one page to one multipage image file to save all

images from each page to one multi-page image file.
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· Select All images to one multipage image file to save all images to one

multi-page image file.

· Select All images from one document to one multipage image file to save

all images from each document to one multi-page image file.

· Select the Save in reverse order box to save images in reverse order.

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Folder dropdown menu to determine where converted files are saved:

· Always ask for file location prompts the user to select a location each time

the action is used.

· Use source folder as destination uses the source folder of input files as the

save location. 

· Use custom folder specified enables the user to specify a folder. If this

option is used then the folder location must be specified in the text box

beneath the dropdown menu.

· Use the Filename text box to name output files. The default name is defined by the

macro %[Filename], which uses the name of the source file. Click the dropdown

arrow to add additional macros.

· Select an option in the Choose type of singlepage images dropdown menu

to determine the format for single-page output.

· Select an option in the Choose type of multiplage images dropdown menu

to determine the format for multi-page output.

· Select the Always use multipage format box to use multi-page output in for

all images.

· Select the Choose color depth automatically box to enable the auto-

selection of color depth for output images. Note that the image type

parameter of the image format will be ignored.

· Use the When File Already Exists dropdown menu to determine the action

taken when filenames are already in use:

· Prompt for action prompts the user for an action to take.

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save

the new file. 

· Save new with other unique name inserts a prefix to the filename and

then saves the new file.

· Select the Show setup dialog while running box to launch the Save Images dialog

box and customize settings each time this action is used. Clear this box to disable

1796
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the Save Images dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.

Click  Save Changes to save changes.
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9.3.4 Send Mail

 Send Mail

The Send Mail action sends output documents/images via the user's desktop email client. It

contains the following customizable parameters:

Figure 1. Send Mail Action Options

· Click the ellipsis icon next to Desktop Mail Client to view/edit the settings of the

current desktop email client, as detailed here.

· Enter the email address of the recipient in the To text box.

· Enter the email address of additional recipients in the Cc text box.

· Enter the subject of the email in the Subject text box and the text of the email in the

Message text box.

· Select the Send e-mail without files box to send the email without attaching files.

This can be used as a notification method for when the tool has finishing running.

1910
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· Select the Put all files into one e-mail box to place all files in a single email. Clear

this box to send one file per email.

· Select an option in the Compress dropdown menu to compress files before they are

sent:

· Select each file to a separate archive or All files to one archive as desired,

then enter a name for the archive in the Archive name text box.

· Select the Show setup dialog while running box to launch the Send Mail dialog

box and customize settings each time this action is used. Clear this box to disable

the Send Mail dialog box from opening each time the action is used, which is useful

when the same settings are used consistently.

Click  Save Changes to save changes.
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9.3.5 Show Files

 Show Files

The Show Files action displays output documents. It contains the following customizable

parameters:

Figure 1. Show Files Action Options

· Use the Choose action dropdown menu to determine how output files are

displayed:

· Select Open containing folder and select files to open the specified output

folder and highlight the output files.

· Select View files using the external program associated with them to open

files using the default program for the format of output files.

Click  Save Changes to save changes.
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9.4 Bookmark Actions

 Bookmark Actions

The Bookmark actions determine parameters for creating, importing, exporting and

manipulating bookmarks:

 Build Table of Contents  uses bookmarks to create a table of contents for input

documents.

 Export Bookmarks  create a copy of the bookmarks in input documents and then saves

them to file.

 Export Bookmarks to Text File  creates a copy of the bookmarks in input documents and

then saves them to a plain text (*.txt) file.

 Find and Replace Bookmark Text  finds and replaces text in bookmark titles.

 Generate Bookmarks from Page Text  creates bookmarks from the text of input

documents.

 Import Bookmarks  imports bookmarks into documents.

 Import Bookmarks from Text File  imports bookmarks from a text file into documents.
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9.4.1 Build Table of Contents

 Build Table of Contents

The Build Table of Contents action uses bookmarks to create a table of contents for

documents. It contains the following customizable parameters:

Figure 1. Build Table of Contents Action Options

· Click All Options to determine conversion options for the table of contents. The

Build Table of Contents dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Build Table of

Contents dialog box and customize settings each time this action is used. Clear this

box to disable the Build Table of Contents dialog box from opening each time the

action is used, which is useful when the same settings are used consistently.
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Figure 2. Build Table of Contents Dialog Box

· Use the Title text box to enter a title for the table of contents. Click Change Title

Format to change the font style of the title, as detailed here.

· Click Add to add font styles to bookmark levels. Font styles are detailed here.

· Use the Page Settings to determine settings for the table of contents:

· Use the Insert TOC before page number box to determine where the table of

contents is inserted, or selected the As last page box to append it to the

document.

· Select Document to set the page size of the table of contents as the same

size of the input document pages.

· Select Standard to set the page size of the table of contents to a standard

size, then select a size in the dropdown menu and either Portrait or

Landscape as the orientation.

· Select Custom to set a custom page size, then use the number boxes and the

units of measurement dropdown menu to determine the size.

· Use the Page Margins number boxes to determine the margins in the table of

contents.

1794
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· Use the Bookmarks settings to determine the bookmarks used in the creation of the

table of contents:

· Select the Use all bookmark levels box to use all bookmark levels.

Alternatively, use the number boxes to determine the first and last bookmark

level used.

· Select the Skip invalid bookmarks box to exclude invalid bookmarks, such as

those that do not have a destination, from the table of contents.

· Select the Remove consecutive spaces from bookmark titles box as desired.

· Use the Page Numbering options to determine how page numbers are displayed in

the table of contents:

· Select an option in the Output Page Numbers as dropdown menu to

determine the reference used for entries in the table of contents.

· Select an option in the Style dropdown menu to determine the style of entries

in the table of contents.

· Use the Output Options to determine additional output options:\

· Use the Line Spacing dropdown menu to determine the line spacing for the

table of contents.

· Use the Level Indent dropdown menu to determine the level indent used for

the table of contents.

Click OK to save changes.

Table of Contents Settings

Use the Settings dropdown menu to save/manage/delete custom settings:
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Figure 3. Scanner Settings Dropdown Menu Options

· Select predefined modes as desired.

· Click Save Current Settings to save the current settings as a profile for subsequent

use.

· Click Delete to delete selected profiles. Note that this option is only available for

customized profiles.

· Click Manage to manage preset/customized profiles. The Manage Presets dialog

box will open:
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles. Note that this option is only available for

customized profiles.

· Click Clone to clone selected profiles. This option can be used to customize the

settings of preset profiles, which cannot be customized in their default state.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles. Note that this option is only available for

customized profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.4.2 Export Bookmarks

 Export Bookmarks

The Export Bookmarks action creates a copy of the bookmarks in documents and then

saves them to file:

Figure 1. Export Bookmarks Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.4.3 Export Bookmarks to Text File

 Export Bookmarks to Text File

The Export Bookmarks to Text File action creates a copy of the bookmarks in input

documents and then saves them to a plain text (*.txt) file. It contains the following

customizable parameters:

Figure 1. Export Bookmarks to Text File Action Options

· Select Export All to export all bookmarks to text file.

· Select Export bookmarks that perform hyperlink action to export only bookmarks that

perform hyperlink actions, then use the dropdown menu to determine which hyperlinks are

exported.

· Click All Options to view/edit export options. The Export Bookmarks to Text File

dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Export Bookmarks

to Text File dialog box and customize settings each time this action is used. Clear

this box to disable the Export Bookmarks to Text File dialog box from opening
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each time the action is used, which is useful when the same settings are used

consistently.

Figure 2. Export Bookmarks to Text File Dialog Box

· Select the Export bookmark actions box to include bookmark actions in the export.

· Select the Export Page that bookmark points to box to include the page number of

bookmark links.

· Select the Resolve named destinations to page numbers box to display named destinations

as page numbers in the created text file. If this box is not selected then the name of the named

destination will be exported instead. 

· Select the Export detailed destination description box to export a more detailed description

of named destinations.

· Select the Export Web Links box to include weblinks in the export file.

· Select the Export 'Open File' actions description to include a description of 'Open File'

actions in the export file. These actions open files when bookmarks are clicked.

· Select the Export 'Remote Go-to' actions description box to include a description of 'Go-To'

actions in the export file. These actions navigate to a document page when bookmarks are

clicked. Document pages can be located in the current document, a different document or an

embedded document.

· Select the Export JavaScript actions code box to include bookmark JavaScript actions in the

export file. These actions execute JavaScript when bookmarks are clicked. 
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· Select the Export Bookmark text style and color properties box as desired.

· Select the Export bookmark tree's "contracted" state box to export bookmarks in collapsed

format.

· Use the Properties delimiter box to set the delimiter that separates bookmark properties in

the text file.

· Select the Do not escape service symbols box as desired. If the files that the Export

Bookmarks to Text Files action creates will be used in conjunction with the Generate

Bookmarks from Page Text  action then it is advisable to select this box.

Click OK to save changes.

1424



1422

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

9.4.4 Find and Replace Bookmark Text

 Find and Replace Bookmark Text

The Find and Replace Bookmark Text action finds and replaces text in bookmark titles. It

contains the following customizable parameters:

Figure 1. Find and Replace Bookmark Text Action Options

· Click All Options to view/edit action options. The Find and Replace Bookmark

Text dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Find and Replace

Bookmark Text dialog box and customize settings each time this action is used.

Clear this box to disable the Find and Replace Bookmark Text dialog box from

opening each time the action is used, which is useful when the same settings are

used consistently.
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Figure 2. Find and Replace Bookmark Text Dialog Box

· Enter the terms to be replaced in the Find what text box.

· Enter the replacement terms in the Replace with text box.

· Select the Match case, Match whole word and Use regular expressions boxes as desired.

Further information on regular expressions is available here.

Click OK to save changes.

https://en.wikipedia.org/wiki/Regular_expression
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9.4.5 Generate Bookmarks from Page Text

 Generate Bookmarks from Page Text

The Generate Bookmarks from Page Text action creates bookmarks from the text of input

documents. It contains the following customizable parameters:

Figure 1. Generate Bookmarks from Page Text Action Optons

· Click All Options to view/edit all options. The Generate Bookmarks from Page

Text dialog box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Generate

Bookmarks from Page Text dialog box and customize settings each time this

action is used. Clear this box to disable the Generate Bookmarks from Page Text

dialog box from opening each time the action is used, which is useful when the

same settings are used consistently.
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Figure 2. Generate Bookmarks from Page Text Dialog Box

Note that it is necessary to create bookmark generators in order to generate bookmarks

from page text.

· Click Add to add a new bookmark generator. The Bookmark Generation Properties dialog

box will open, as detailed in (figure 5).

· Click Edit to edit the selected bookmark generator.

· Click Remove to remove the selected bookmark generator.

· The Page Range options determine the pages included in the generation of bookmarks:

· Select All to use all document pages.

· Select Custom to use a custom page range. Further information on how to specify page

ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Select the Ignore text that contains stop words box as desired. Text containing stop words

will be excluded from the bookmark generation process when this option is enabled. Click the

ellipsis icon to view/edit the list of stop words.

· Select the Ignore consecutive duplicate bookmarks box to prevent the creation of

consecutive identical bookmarks.

· Select the Replace Existing bookmarks box as desired.

· Click the Settings dropdown arrow to save/manage/delete bookmark generator settings:

1873
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Figure 3. Generate Bookmarks from Page Text Dialog Box, Save/Manage/Delete Options

· Click Save Current Settings to save the current settings as a profile for subsequent

use.

· Click Delete to delete the current profile.

· Click Manage to manage profiles. The Manage Presets dialog box will open:

Figure 4. Manage Presets Dialog Box
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· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.

Bookmark Generation Properties

Figure 5. Bookmark Generation Properties Dialog Box, Text Matching Options Category

The options selected in the Bookmark Generation Properties dialog box determine the text used to

generate bookmarks, and the style of the generated bookmarks:

Text Matching Options

These options determine text used in the generation of bookmarks according to font, size and color:
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· Select the Font Names box to include text of specific fonts in the generation of bookmarks.

Click Add to add fonts to the list, Add Custom to add custom fonts, or Remove to remove

selected fonts.

· Select the Font Size box to include text of a specific size in the generation of bookmarks. Use

the number boxes to determine the Size, Tolerance and Units of text included in the

generation of bookmarks. The Tolerance value determines the degree to which selected text

can differ from the specified Font Size and remain included in the generation of bookmarks.

· Select the Text Color box to include text of a specific color in the generation of bookmarks,

then select a color in the dropdown menu.

· The Get Style from Selected Text option is not currently available. It will be available in a

future build of PDF-Tools.

· The option selected in the Match Text Case dropdown menu determines text used in the

generation of bookmarks according to text case:

· Select No Restrictions to include text of all cases in the generation of bookmarks.

· Select All Characters Are Capital to include only upper-case text in the generation of

bookmarks.

· Select First Character is Capital to include only text that starts with a capital letter in the

generation of bookmarks.

· Select First Character is Digit to include only text that starts with a digit in the

generation of bookmarks.

· Select the Allow multiline bookmark titles box to allow bookmark titles to exceed one line in

length. This is useful in cases where it is not possible to shorten bookmark titles.

· Select the Match Text Pattern box to specify a sequence of words that document text must

match in order to be included in the generation of bookmarks. Enter the desired text patten in

the text box.

· Select the Match text case box to include only text that matches the case of the text entered in

the Match Text Pattern box. If this box is not selected then all matching text will be included

regardless of its case.

· Select the Limit bookmark titles to matching pattern only box to determine that only text

matching the specified pattern will be included in the generation of bookmarks.

Resulting Appearance

These options determine characteristics of generated bookmarks: 
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Figure 6. Bookmark Generation Properties Dialog Box, Resulting Appearance Category

· Use the Text Color menu to determine the text color of bookmarks.

· Use the Text Style menu to determine the text style of bookmarks.

· Use the Zoom menu to determine the zoom level when bookmarks are clicked. Select Inherit

to use the current zoom level.

· Select the Show expanded box to expand all generated bookmarks.

Title Formatting

These options are used to format bookmark titles:
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Figure 7. Bookmark Generation Properties Dialog Box, Title Formatting Category

· Select a Text Case option to determine the text case of generated bookmark titles.

· Select the Search and replace bookmark title with text patterns box to search for specific

text in bookmark titles and replace it with customized text:

· Enter the text to be replaced in the Search Pattern text box.

· Enter the replacement text in the Replace Pattern text box.

· Select the Match text case box as desired.

· Select the Insert text before each title box to add text before bookmark titles. Enter the

desired text in the text box.

· Select the Add text after each title box to add text after bookmark titles. Enter the desired

text in the text box.

· The Leading Numbers dropdown menu is used to add/remove/retain leading numbers for

bookmarks. Select No Change, Add or Remove as desired. If leading numbers are being

added then use the Use dropdown menu to select Numbers, Letters or Roman Numerals.

· Use the Maximum Title Length text box to set the maximum number of characters for

generated bookmarks.

· Select the Remove duplicate spaces box to remove instances of adjacent blank characters.
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· Select the Replace line breaks with spaces box to use spaces instead of line breaks for

bookmarks.

Click OK to save changes.
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9.4.6 Import Bookmarks

 Import Bookmarks

The Import Bookmarks action imports bookmarks into documents. It contains the

following customizable parameters:

Figure 1. Import Bookmarks Action Options

Note that imported bookmarks must be contained in a (*.xcbkm) format file. The Export

Bookmarks  tool can be used to create these files. 

· Select Choose bookmarks export file to select a bookmarks file to import. Enter

the path of the file in the text box, or click the ellipsis icon to select a file manually.

· Select Choose folder that contains bookmarks export files to specify a folder that

contains a (*.xcbkm) format file to use for the import. Enter the location of the

folder in the text box, or click the ellipsis icon to select a folder manually.

· Select the Show setup dialog while running box to launch the Import Bookmarks

dialog box and customize settings each time this action is used. Clear this box to

1704
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disable the Import Bookmarks dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.

Click  Save Changes to save changes.
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9.4.7 Import Bookmarks from Text File

 Import Bookmarks from Text File

The Import Bookmarks from Text File action imports bookmarks from a text file into

documents. It contains the following customizable parameters:

Figure 1. Import Bookmarks from Text File Action Options

Note that imported bookmarks must be contained in a (*.txt) file and formatted in the same

manner as output files from the Export Bookmarks to Text File  tool. 

· Select Choose text file that contains bookmarks' definition to select a bookmarks

file to import. Enter the path of the file in the text box, or click the ellipsis icon to

select a file manually.

· Select Choose folder that contains text files with bookmarks' definitions to

specify a folder that contains a (*.txt) file to use for the import. Enter the location of

the folder in the text box, or click the ellipsis icon to select a folder manually.

· Use the Field Delimiter text box to specify the fields delimiter used in import files.

1706
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· Select the Show setup dialog while running box to launch the Import Bookmarks

from Text File dialog box and customize settings each time this action is used.

Clear this box to disable the Import Bookmarks from Text File dialog box from

opening each time the action is used, which is useful when the same settings are

used consistently.

Click  Save Changes to save changes.
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9.5 Optimize PDF Actions

 Optimize PDF Actions

The Optimize PDF actions determine parameters for the optimization of input files:

 Enhance Scanned Pages  enhances scanned images in PDF documents to improve quality

and reduce the file size.

 Optimize PDF  optimizes document content in order to reduce the file size.

 Recompress Images  recompresses document images. 

1437
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9.5.1 Enhance Scanned Pages

 Enhance Scanned Pages

The Enhance Scanned Pages action enhances scanned images in PDF documents to improve their

quality and reduce the file size. It contains the following customizable parameters:

Figure 1. Enhance Scanned Pages Action Options

· Click All Options to view/edit all options. The Enhance Scanned Pages dialog box

will open, as detailed below.

· Select the Show setup dialog while running box to launch the Enhance Scanned

Pages dialog box and customize settings each time this action is used. Clear this

box to disable the Enhance Scanned Pages dialog box from opening each time the

action is used, which is useful when the same settings are used consistently.
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Figure 2. Enhance Scanned Pages Dialog Box

· Use the Page Range options to determine which pages are enhanced. Page range options are

detailed here.

· Select the Apply Adaptive Compression box to apply adaptive compression to scanned

pages. Adaptive compression is a method of data compression that dynamically adjusts the

algorithm used to compress data. The adjustments made depend on the content of the data.

· Use the Color/Grayscale and Monochrome dropdown menus to determine the format of

compression used for Color/Grayscale and Monochrome content respectively.
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· Use the slider to determine the resolution used for compressed content.

· Use the Filters to determine additional filters:

· Enable the Deskew filter to deskew scanned pages. Deskewing is used to straighten the

edges of pages that have been scanned crookedly.

· Select an option in the Background Removal dropdown menu to adjust the level of

background removal for scanned pages. Background removal is used to whiten off-white

areas in the pages of grayscale and/or color-based input.

· Select an option in the Descreen dropdown menu to adjust the descreening level for

scanned pages. Descreening is used to remove the halftone dot structure that is common

in printed images and causes issues in scanned content.

· Select an option in the Text Sharpening dropdown menu to adjust the level of text

sharpening used for scanned pages.

· Use the Text Recognition Options to perform optical character recognition on scanned pages:

· Select the Recognize Text box to enable optical character recognition. The process of

optical character recognition analyzes scanned content, recognizes text and then makes it

selectable and searchable. Note that the current languages and accuracy level for the

OCR process are detailed in the pane. Click Edit to add/remove language and/or adjust

the level of accuracy. (Decreasing the level of accuracy has the benefit of decreasing the

time taken to perform the operation).

·  Click Defaults to revert all values in the Enhance Scanned Pages dialog box to their default

values.

Click OK to save changes.



1440

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

9.5.2 Optimize Document

 Optimize Document

The Optimize Document action optimizes the size of PDF documents. It contains the

following customizable parameters:

Figure 1. Optimize Document Action Options

· Click All Options to view/edit all options. The Optimize PDF dialog box will open,

as detailed below.

· Select the Show setup dialog while running box to launch the Optimize PDF

dialog box and customize settings each time this action is used. Clear this box to

disable the Optimize PDF dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Optimize PDF Dialog Box, Images Tab

These settings are used to optimize PDF content:

Images

The options for optimizing images are detailed in (figure 2). They are as follows:

· Click the Color Images, Grayscale Images, Indexed Images and Monochrome Images menus

to select settings for the respective image formats.

· Click the Bicubic Downsampling/Subsampling menus to increase/reduce the resolution of

images.

· Click the arrows in the dpi box, or enter a figure manually, to select the dots-per-inch resolution

for new images.

· Click the arrows in the for images above box, or enter a figure manually, to select the

minimum dpi at which images are downsampled/subsampled.

· Click the Compression menus to select the compression format of images. Where applicable

click the Quality menu to select the compression quality.  

· The Optimize images only if there is a reduction in size box is selected by default. Clear this

box to optimize images even when there is no reduction in size.
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Fonts

Click Fonts to determine the settings for font optimization:

Figure 3. Optimize PDF Dialog Box, Fonts Tab

· Select Do Not Unembed any font to retain all embedded fonts.

· Select Unembed recommended fonts to unembed recommended fonts, which will result in

the unembedding of the most common fonts in order to reduce the file size.

· Select Unembed all fonts to unembed all fonts. This will reduce the size of files as far as

possible with regard to fonts. However, it also increases the risk of compatibility issues for

subsequent users of the document. This is because they will not be able to read the document

unless the application they are using to view the document contains the font. Therefore this

setting should be used only in cases where documents contain only common fonts. 

· Select the Merge fonts subsets box to merge duplicated font subsets.



1443

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

Discard Objects

Click Discard Objects to determine the settings for discarding objects:

Figure 4. Optimize PDF Dialog Box, Discard Objects Tab

· Select the Discard all form submissions, import and reset actions box to remove these

elements from the document.

· Select the Discard all JavaScript actions box to remove JavaScript actions from the document.

· Select the Discard all alternate images box to remove alternate images from the document.

Alternate images are additional versions of existing images that may differ slightly, such as in

resolution or color space.

· Select the Discard embedded page thumbnails box to remove embedded page thumbnails

from the document.

· Select the Detect and merge image fragments box to merge image fragments. Note that

some images are composed of fragmented sections that are spliced together. Merging these

fragments will reduce the file size.
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· Select the Discard embedded print settings box to discard remnant encoding in cases where

documents were created with a virtual printer.

· Select the Discard bookmarks box to remove all bookmarks from the document. 

Discard User Data

Click Discard User Data to determine the settings for discarding user data:

Figure 5. Optimize PDF Dialog Box, Discard User Data Tab

· Select the Discard all comments, forms and multimedia box to remove these elements from

the document.

· Select the Discard document information and metadata box to remove all metadata from

the document.

· Select the Discard file attachments box to remove attached/embedded files from the

document.
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· Select the Discard private data of other applications box to remove information from the

document that is useful only to the application used to create it.

· Select the Discard hidden layer content and flatten visible layers box to remove hidden

layers from the document and flatten the visible layers to base content.

Cleanup

Click Cleanup to determine cleanup options:

Figure 6. Optimize PDF Dialog Box, Cleanup Tab

· Select the Discard Duplicates of Fonts box to remove redundant fonts from the document.

· Select the Discard Duplicates of Images box to remove duplicate images from the document.

· Select the Discard duplicates of XForms box to remove duplicate XForms from the document.

· Select the Use Flate to encode streams that are not encoded box to compress document

information that is pending for compression.
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· Select the In Streams that use LZW encoding use Flate instead box to use Flate compression

instead of LZW encoding. This is recommended as Flate is compatible with a wider range of

platforms.

· Select the Discard Invalid Bookmarks box to discard bookmarks that do not contain

actions/valid destinations. 

· Select the Discard Unreferenced Named Destinations box to remove named destinations

that are not referenced in the document. 

· Select the Find and Remove Content Outside of the Crop Box box to remove content outside

the crop box. Note that this content is hidden when documents are displayed.

· Select the Remove unused Layers box to remove any unused layers from documents.

Settings

Click the Settings dropdown menu to toggle between Standard Mode, which is best for computers,

and Mobile Mode, which is best for tablets and cell phones:

Figure 7. Optimize PDF Dialog Box, Settings Dropdown Menu
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The Settings dropdown menu is also used to save, manage and delete customized settings:

· Click Save Current Settings to save custom settings for subsequent use. Saved

profiles are detailed in the Settings dropdown menu.

· Click Delete to delete selected profiles.

· Click Manage to manage saved custom settings. The Manage Presets dialog box

will open, as detailed below.

Figure 8. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles. This makes it possible to duplicate profiles

and then customize their settings whilst retaining the existing profile and its

parameters.

· Use the up and down arrow to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.

Select an option in the Make Compatible With dropdown menu to make optimized

documents compatible with specified versions of PDF:
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Figure 9. Optimize PDF Dialog Box, Make Compatible Dropdown Menu

Click OK to save changes.
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9.5.3 Recompress Images

 Recompress Images

The Recompress Images action recompresses document images. It contains the following

customizable parameters:

Figure 1. Recompress Images Action Options

· Click All Options to view/edit all options. The Recompress Images dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Recompress

Images dialog box and customize settings each time this action is used. Clear this

box to disable the Recompress Images dialog box from opening each time the

action is used, which is useful when the same settings are used consistently.
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Figure 2. Recompress Images Dialog Box

· Use the Page Range options to determine the page range of images to be

recompressed. Page range settings are detailed here.  Alternatively, select the

Selected Graphic button to recompress only the graphic currently selected in the

document.

· Select a recompression option in the pane to determine the type of image

recompression for the operation. Note that you can click Edit or Reset to edit/reset

recompression settings.
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· Select the Replace all instances box to replace all instances of the graphic that is

being recompressed in cases where the graphic appears multiple times in the same

document.

· Select the Replace when size of new image is smaller than size of original image

box to replace recompressed images when they are smaller than the source image

used to create them.

· Use the Settings dropdown menu to determine the quality of the recompression.

Note that increasing quality will increase the file size and vice versa.

Click OK to save changes.

Settings

Click the Settings dropdown menu to toggle between preset modes or save/manage custom settings:
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Figure 3. Recompress Images Preset Options

· Select a present mode from the list as desired.

· Click Save Current Settings to save custom settings for subsequent use. Saved

profiles are detailed in the Settings dropdown menu.

· Click Delete to delete selected profiles.

· Click Manage to manage saved custom settings. The Manage Presets dialog box

will open, as detailed below.
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles. This makes it possible to duplicate profiles

and then customize their settings whilst retaining the existing profile and its

parameters.

· Use the up and down arrow to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.6 PDF Standard Actions

 PDF Standard Actions

The PDF Standard actions make documents compliant with alternative PDF formats:

 Convert to PDF/A  makes documents compliant with the PDF/A format, which

is used for long-term archiving.

 Convert to PDF/X  makes documents compliant with the PDF/X standard,

which is used to exchange printing data.

 Discard Special PDF-Standard  discards special PDF information from

documents such as PDF/X, PDF/A and PDF/E information.
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9.6.1 Convert to PDF/A

 Convert to PDF/A

The Convert to PDF/A action makes documents compliant with the PDF/A format, which is

used for long-term archiving. It contains the following customizable parameters:

Figure 1. Convert to PDF/A Action Options

 

· Select an option in the dropdown menu to determine the action taken in cases

where input documents already contain PDF/A information:

· Skip PDF/A document excludes the document from the process.

· Keep PDF/A document unchanged retains the existing version of the

document.

· Reconvert document performs a fresh conversion of the document to PDF/A

format.  

· Click More Options to view/edit all options. The Convert to PDF/A dialog box will

open, as detailed below.
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· Select the Show setup dialog while running box to launch the Convert to PDF/A

dialog box and customize settings each time this action is used. Clear this box to

disable the Convert to PDF/A dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.

Figure 2. Convert to PDF/A Dialog Box

· Select an option in the Choose conformance dropdown menu to determine the file

conformance. Further information on conformance options is available here.

· Select an option in the Choose profile dropdown menu to select a color profile.

· Select/clear the Embed Font Subset and Rasterize unembedded fonts boxes as

desired.

Click OK to save changes.

https://en.wikipedia.org/wiki/PDF/A#PDF.2FA-1
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9.6.2 Convert to PDF/X

 Convert to PDF/X

The Convert to PDF/X action makes documents compliant with the PDF/X standard, which

is used to exchange printing data. It contains the following customizable parameters:

Figure 1. Convert to PDF/A Action Options

 

· Click All Options to view/edit all options. The Convert to PDF/X dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Convert to PDF/X

dialog box and customize settings each time this action is used. Clear this box to

disable the Convert to PDF/X dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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Figure 2. Convert to PDF/X Dialog Box

· Use the Choose Standard dropdown menu to select a PDF/X format. Further

information on these formats is available here.

· Use the Choose Profile dropdown menu to select a color profile.

· Select the Embed Font Subset box to embed font subsets in output documents.

· Select the Remove annotations box to remove annotations in output documents.

· Select the Rasterize unembedded fonts box to rasterize unembedded fonts. 

Click OK to save changes.

https://en.wikipedia.org/wiki/PDF/X


1459

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

9.6.3 Discard Special PDF-Standard

 Discard Special PDF-Standard

The Discard Special PDF-Standard action discards special PDF-standard information from

documents. It contains the following customizable parameters: 

Figure 1. Convert to PDF/A Action Options

 

· Select an option from the Choose PDF Standard to discard dropdown menu to

determine the PDF standard discarded from documents when the tool runs.

· Select the Show setup dialog while running box to launch the Discard Special

PDF-Standard dialog box and customize settings each time this action is used.

Clear this box to disable the Discard Special PDF-Standard dialog box from

opening each time the action is used, which is useful when the same settings are

used consistently.

Click  Save Changes to save changes.
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9.7 Pages Actions

 Pages Actions

The Pages actions edit and enhance the pages of input documents:

 Add Bates Numbering  inserts Bates numbering into input documents.

 Add Header and Footer  inserts headers and footers into input documents.

 Add Watermarks  inserts watermarks into input documents.

 Change Page Background  changes the background of input documents.

 Crop Pages  adjusts document dimensions, white margins and page boxes in

input documents.

 Delete Pages  deletes pages of input documents.

 Duplicate Pages  duplicates pages of input documents.

 Import as Layer Overlay  imports an existing file to overlay documents.

 Insert Empty Pages  inserts empty pages into input documents.

 Insert Pages  inserts pages from existing documents into input documents.

 Merge Pages  merges pages into a single page.

 OCR Pages  performs optical character recognition on input documents.

 Overlay PDF  overlays input documents with existing files.

Rasterize Pages  rasterizes the pages of input documents.

 Remove Bates Numbering  removes Bates numbering from input documents.

 Remove Headers and Footers  headers and footers from input documents.

 Remove Page Background  removes backgrounds from input documents.

 Remove Watermarks  removes watermarks from input documents.

 Replace Pages  replaces specified pages of input documents with pages from

existing documents.

 Resize Pages  resizes specified pages of input documents.
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 Rotate Pages  rotates specified pages of input documents.

Setup Page Transitions  determines the animated effect when moving between

document pages in fullscreen mode.

Split Pages  splits the pages of input documents into custom sections.
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9.7.1 Add Bates Numbering

 Add Bates Numbering

The Add Bates Numbering action inserts Bates numbering into input documents. It

contains the following customizable parameters:

Figure 1. Add Bates Numbering Action Options

· Click All Options to view/edit all options. The Add Bates Numbering dialog box

will open, as detailed below.

· Select the Show setup dialog while running box to launch the Add Bates

Numbering dialog box and customize settings each time this action is used. Clear

this box to disable the Add Bates Numbering dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.
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Figure 2. Add Bates Numbering Dialog Box

· Enter text in the text boxes to insert Bates numbering on the left/center/right and as a

header/footer of pages as desired. Alternatively, click the  macro icon to use macros

as the source of Bates numbering content. Select Bates Numbering in the macro dropdown

menu to add Bates numbering in the default style, or click Bates Numbering Settings to

customize the style of Bates numbering used. Further information about macros is available

here.

· Use the Margins settings to reposition the location of Bates numbering.

· Select the Shrink pages' content to avoid overwriting document's text and graphics box to

shrink page content in order to ensure Bates numbering does not overlap with existing page

content when it is added to the document.

· Click Font to determine the font settings for Bates numbering, as detailed here.

· Enter page numbers in the Preview Page number box to view a preview of Bates numbering in

the preview window. 
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· Click Page Range Options to select the pages of the document that will feature Bates

numbering. Further information on the specification of page ranges is available here.

· Click the Settings dropdown arrow to save/delete customized settings and/or manage existing

customized settings, as detailed below.

Click OK to save settings.

Figure 3. Add Bates Numbering Dialog Box, Settings Dropdown Menu

· Click  Save to save the current settings to a profile for subsequent use.

· Click  Delete to delete the current profile.

· Click  Manage to manage saved profiles. The Manage Presets dialog box will open:
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.7.2 Add Header and Footer

 Add Header and Footer

The Add Header and Footer action inserts headers and footers into input documents. It contains the

following customizable parameters:

Figure 1. Add Header and Footer Action Options

· Click More Options to view/edit more options. The Add Header and Footer dialog

box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Add Header and

Footer dialog box and customize settings each time this action is used. Clear this

box to disable the Add Header and Footer dialog box from opening each time the

action is used, which is useful when the same settings are used consistently.
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Figure 2. Add Header and Footer Dialog Box

· Enter text in the text boxes to insert headers/footers on the left/center/right of documents.

Alternatively, click the  macro icon to source the content of headers/footers with macros.

Note that the current page numbering style is detailed in the macro dropdown menu. Click Edit

Page Numbering Style to change the page numbering style. Further information about macros

is available here.

· Use the Margins settings to reposition the location of headers and footers.

· Select the Shrink pages' content to avoid overwriting document's text and graphics box to

shrink page content in order to ensure headers and footers do not overlap with existing page

content when they are added to the document.

· Click Font to determine the font settings for headers/footers, as detailed here.

· Use the Appearance Options settings to reposition the location of headers/footers.

· Enter page numbers in the Preview Page number box to view a preview of headers/footers in

the preview window. 
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· Click Page Range Options to select the pages of the document that will feature

headers/footers. Further information on the specification of page ranges is available here.

· Click the Settings dropdown arrow to save/delete customized settings and/or manage existing

customized settings, as detailed below.

Click OK to save settings.

Figure 3. Add Bates Numbering Dialog Box, Settings Dropdown Menu

· Click  Save to save the current settings to a profile for subsequent use.

· Click  Delete to delete the current profile.

· Click  Manage to manage saved profiles. The Manage Presets dialog box will open:
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.7.3 Add Watermarks

 Add Watermarks

The Add Watermarks action inserts watermarks into input documents. It contains the

following customizable parameters:

Figure 1. Add Watermark Action Options

· Click All Options to view/edit all options. The Add Watermark dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Add Watermark

dialog box and customize settings each time this action is used. Clear this box to

disable the Add Watermark dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Add Watermark Dialog Box

· The Source options determine the source of watermarks. Enter text into the box or select a file.

Use the font, macro  and alignment options to customize watermarks when text is used as

the source.

· The Appearance options determine the rotation, opacity and scale of the watermark: 

· The Rotation value determines the rotation (in degrees) of watermarks. 

· The Opacity value determines the opacity (transparency) of watermarks. 

· The Scale value determines the scale of watermarks. Select the check box to scale

watermarks to the target page. If this box is not selected then the scale is relative to the

size of the original image used as the source for the watermark.

· The Placement options determine the horizontal and/or vertical offset of the watermark from

the left, right or center of the document. 

· Select the As Background box to insert watermarks into the background as opposed to the

foreground of documents.

· The Page Range options are as follows:

· Select All to add watermarks to all pages.

· Select Custom to add watermarks to a custom page range. Further information on how

to specify page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

1796

1873



1473

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

· The Preview Page pane displays a preview of pages. Select the numbers beneath the pane to

preview the corresponding document pages. 

· Click the Settings dropdown arrow to save/delete/manage customized settings, as detailed

below.

Click OK to save changes.

Figure 3. Add Watermark Dialog Box, Settings Dropdown Menu

· Click Draft or Confidential to load these preset watermark profiles.

· Click  Save to save the current settings to a profile for subsequent use.

· Click  Delete to delete the current profile.

· Click  Manage to manage saved profiles. The Manage Presets dialog box will open:
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles. Note that preset profile cannot be edited or

deleted.

· Click Clone to clone selected profiles.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.7.4 Change Page Background

 Change Page Background

The Change Page Background action changes the background of input documents. It

contains the following customizable parameters:

Figure 1. Change Page Background Action Options

· Click All Options to view/edit all options. The Add Background dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Add Background

dialog box and customize settings each time this action is used. Clear this box to

disable the Add Background dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Add Background Dialog Box

· The Source options determine the source of the background:

· Select From Color to add a color-based background.

· Select Name to enter a file to be used as the background, or click the icon to select a file

from the local computer. Enter the page number of the desired background in the Page

number box.

· The Appearance options determine the rotation, opacity and scale of the background: 

· The Rotation value determines the rotation (in degrees) of the background.

· The Opacity value determines the opacity (transparency) of the background.

· The Scale value determines the scale of backgrounds. Select the check box to scale

watermarks to the target page. If this box is not selected then the scale is relative to the

size of the original image used as the source for the background.

· The Placement options determine the horizontal and/or vertical offset of the background from

the left, right or center of the document.

· The Page Range options are as follows:

· Select All to add backgrounds to all pages.

· Select Custom to add backgrounds to a custom page range. Further information on how

to specify page ranges is available here.

· Use the Pages box to determine backgrounds for specific page ranges. Further

information on this process is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.
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· Note that it is possible to create more than one background for pages within the same

document as long as they are not located within the same page/page range.

· The Preview Page pane displays a preview of pages. Select the numbers beneath the pane to

preview the corresponding document pages.

· Click the Settings dropdown arrow to save/delete customized settings, or manage existing

customized settings, as detailed below.

Click OK to save changes.

Figure 3. Add Background Dialog Box, Settings Dropdown Menu

· Click  Save to save the current settings to a profile for subsequent use.

· Click  Delete to delete the current profile.

· Click  Manage to manage saved profiles. The Manage Presets dialog box will open:
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.7.5 Crop Pages

Crop Pages

The Crop Pages action adjusts dimensions, white margins and page boxes in input

documents. It contains the following customizable parameters:

Figure 1. Crop Pages Action Options

· Click All Options to view/edit all options. The Crop Pages dialog box will open, as

detailed below.

· Select the Show setup dialog while running box to launch the Crop Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Crop Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.



1480

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

Figure 2. Crop Pages Dialog Box

PDF documents define five boundaries that control the imaging process: the Crop Box, Bleed Box,

Trim Box, Art Box and Media Box. PDF-Tools uses these boxes to determine areas when the Crop

Pages feature is used. Use the Apply to Box dropdown menu, detailed below, to display the editing

boxes in the preview pane, then click and drag boxes and/or use the number boxes to adjust their

dimensions. Further information about editing boxes is available here.  The following options are

available in the Crop Pages dialog box:

· Click Show All Boxes to view the Crop Box, Bleed Box, Trim Box and Art Box in the preview

pane. (Please note that the Bleed Box, Trim Box and Art Box use the same dimensions as the

Crop Box by default.

· Use the Crop Method dropdown menu to determine the crop method used:

· Manual Margin Control enables the user to determine the cropping margins. Click the

text of menu entries in the Apply to Box dropdown menu to view them in the preview

pane. Click and drag boxes in the preview pane, or use the number boxes, to adjust their

dimensions. Select the check boxes of menu entries in the Apply to Box dropdown menu

to include them in the Crop Pages operation.

· Remove All White Space is a predefined mode that removes all white space from

documents.

· Remove Horizontal White Space/Remove Vertical White Space are predefined modes

that remove horizontal/vertical white space as required.
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· Select the Constrain Proportions box to maintain the ratio of margins. For example if the

margin in the Left box is changed to 5mm then the margins in the Right, Top and Bottom

boxes will also be changed to 5mm. 

· Use Set to Zero, Revert to Original and Set To White Margins to apply these functions to

boxes selected in the Apply to Box dropdown menu.

· Select the Remove the content outside of the crop box area box to remove content outside

of the Crop box. Please note that cropping pages reduces the visible page content, but the

cropped content is still present in the file's underlying code and, for example, will be visible if

the document pages are increased in size. Select this option to remove cropped content from

the file.

· Use the Page Range settings to determine the page range of cropped pages:

· Select All to crop all pages.

· Select Custom to crop a custom page range. Further information on how to specify page

ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

 

Click OK to save changes.
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9.7.6 Delete Pages

 Delete Pages

The Delete Pages action deletes pages of input documents. It contains the following

customizable parameters:

Figure 1. Delete Pages Action Options

· Use the Page range(s) for deletion number box to determine the page range to be

deleted:

· Select All to delete all document pages.

· Select Pages to specify a custom page range, as detailed here.

· If a custom range is specified, then select an option in the dropdown menu to

determine a subset of pages.

· Select the Delete only empty pages box to delete only empty pages from the

specified range.

· Use the Delete pages that: dropdown menu to specify the deletion of specific types

of pages:
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· Select Do no contain any content items within Page Box to delete only

pages that do not contain content items in the page box of the document. The

page box is defined as the intersection between the crop box and the media

box, as detailed here.

· Select Do not contain any content items to delete only pages that do not

contain content items.

· Select Have only a solid background to delete pages that contain only a

solid background.

· Select the ignore annotations on pages box to ignore annotations when PDF-

Tools decides which pages to delete.

· Select the Show setup dialog while running box to launch the Delete Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Delete Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.

Click  Save Changes to save settings.
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9.7.7 Duplicate Pages

 Duplicate Pages

The Duplicate Pages action duplicates pages of input documents. It contains the following

customizable parameters:

Figure 1. Duplicate Pages Action Options

· Click All Options to view/edit all options. The Duplicate Pages dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Duplicate Pages

dialog box and customize settings each time this action is used. Clear this box to

disable the Duplicate Pages dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Duplicate Pages Dialog Box

Use the Page Range settings to determine which pages are duplicated:

· Select All to duplicate all pages.

· Select Custom to duplicate a custom page range. Further information on how to specify page

ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

Use the Destination settings to determine the insertion location of duplicated pages:

· Select either Before or After in the Location dropdown menu.

· Select First Page or Last Page as desired. Alternatively, select Page to specify a different

document page.

· Use the Number of copies dropdown menu to determine the amount of duplicates created.

Click OK to save settings.
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9.7.8 Import as Layer Overlay

 Import as Layer Overlay

The Import as Layer Overlay action uses an existing file to overlay documents. It contains

the following customizable parameters:

Figure 1. Import as Layer Overlay Action Options

· Click All Options to view/edit all options. The Duplicate Pages dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Import as Layer

dialog box and customize settings each time this action is used. Clear this box to

disable the Import as Layer dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Import as Layer Dialog Box

· Use the File dropdown menu to select a file to import as a layer into the document.

· Use the Pages option to determine the pages used from the source document. Click All to use

all pages, or Custom to specify a custom page range.

· Use the Import Options to determine import options for the new layer:

· Click Create New Layer to create a new layer for the imported content. Enter a name for

the new layer in the text box and click Properties to determine layer properties, as

detailed in (figure 9) above.

· Click Add to Existing Layer to add imported content to an existing layer, then selected

the desired layer from the dropdown menu.

· Click Copy Corresponding Layers from Source to copy corresponding layers from the

source document into the current document.

· Click Copy Structure of Corresponding Layers From Source to copy the layer structure

from the source document into the current document.

· Use the Destination Page Range options to determine the page range into which layers are

imported:

· Use the Pages option to determine the pages used from the source document. Click All

to use all pages, or Custom to specify a custom page range. Further information on how

to specify page ranges is available here.

· Use the Repeat Source dropdown menu to determine repeat options for the source

document in cases where it contains fewer pages than the current document:
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· Select No to disable the repeating of layers from the source document in the

current document.

· Select Last selected page to repeat the last selected layer in the source document.

· Select Continuously repeat selected pages to repeat the layers selected in the

source document repeatedly until they fill the current document.

· Use the Appearance options to determine the appearance of layers from the source document

in the current document:

· Select an option in the Rotation dropdown menu to determine the rotation of the layers.

· Select an option in the Opacity dropdown menu to determine the opacity of the layers.

· Select an option in the Scale dropdown menu to determine the scaling of the layers.

· Use the Placement Options to determine the placement of layers:

· Use the Horizontal Offset number box to determine the horizontal offset of layers. Use

the adjacent dropdown to determine the location from which the offset is made.

· Use the Vertical Offset number box to determine the vertical offset of layers. Use the

adjacent dropdown to determine the location from which the offset is made.

· Use the Units dropdown menu to specify the units of measurement for offsets.

· Select the As Background box to import layers as a background.

Click OK to save changes.
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9.7.9 Insert Empty Pages

 Insert Empty Pages

The Insert Empty Pages action inserts empty pages into input documents. It contains the

following customizable parameters:

Figure 1. Insert Pages Action Options

· Click All Options to view/edit all options. The Insert Empty Pages dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Insert Empty Pages

dialog box and customize settings each time this action is used. Clear this box to

disable the Insert Empty Pages dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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Figure 2. Insert Pages Dialog Box

· Select an option in the Pages section to determine the dimensions of new pages:

· Select Document to match the dimensions of the current document.

· Select Standard to select a standard document size, such as those used by the ISO and

ANSI.

· Select Custom to enter custom dimensions. Enter the desired dimensions into the

number boxes. 

· Select either Portrait or Landscape for the orientation of new pages.

· Use the Count menu to determine the number of pages inserted.  

· Use the Destination options to determine the location at which the new pages are inserted.

Click OK to save settings.
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9.7.10 Insert Pages

 Insert Pages

The Insert Pages action inserts pages from existing documents into input documents. It

contains the following customizable parameters:

Figure 1. Insert Pages Action Options

· Click All Options to view/edit all options. The Insert Pages dialog box will open, as

detailed below.

· Select the Show setup dialog while running box to launch the Insert Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Insert Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.
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Figure 2. Insert Pages Dialog Box

· Use the From File text box to specify the document from which to insert pages, or click the

folder icon to select a file manually.

· Use the Actions with Objects options to determine the action taken for Comments, Form

Fields and Bookmarks contained in the inserted pages.

· Select the Add root bookmark, with file name box to create a root bookmark from inserted

pages.

· Use the Page Range options to determine which pages are inserted: 

· Select All to insert all pages. 

· Use the Pages number box to specify individual pages, separated with a comma, and/or

page ranges, separated with a hyphen. Further information on the specification of page

ranges is available here.

· If a custom range is specified, then select an option in the Subset dropdown

menu to determine a subset of pages as desired.

· Use the Destination options to determine the location at which the new pages are inserted.

Click OK to save settings.
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9.7.11 Merge Pages

Merge Pages

The Merge Pages action merges pages into a single page. It contains the following

customizable parameters:

Figure 1. Merge Pages Action Options

· Click All Options to view/edit all options. The Merge Pages dialog box will open, as

detailed below.

· Select the Show setup dialog while running box to launch the Merge Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Merge Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.
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Figure 2. Merge Pages Dialog Box

· Use the Pages options to determine the size of the new page:

· Click Calculate Size based on the merged pages dimensions to retain the size of the

source pages in the output document.

· Click Standard to use a standard page size for the output document, then select an

option in the dropdown menu.

· Click Custom to use a custom page size for the output document, then enter the

measurements in the combo boxes and select a unit of measurement as desired.

· Use the Orientation dropdown menu to determine the orientation of the output

document.

· Use the Margins number boxes to determine the margins of the output document.

· Use the Page Range options to determine the page range of the source document used to

create the output document:

· Click All to include all pages.

· Click Custom to specify a custom page range, then enter the desired range in the box.

Information on the specification of page ranges is available here.

· If a custom range is specified, then select an option in the Subset dropdown

menu to determine a subset of pages as desired.

· Use the Page Placement and Scaling options to determine how source pages are placed in the

output document, as detailed in the preview pane when settings are edited.

· Select/clear the Remove source pages after merging them box as desired.
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Click OK to save settings.
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9.7.12 Move Pages

Move Pages

The Move Pages action reorders document pages. It contains the following customizable

parameters:

Figure 1. Merge Pages Action Options

· Use the Page Range options to determine the page range of move pages:

· Click All to include all pages.

· Click Custom to specify a custom page range, then enter the desired range in the box.

Information on the specification of page ranges is available here.

· If a custom range is specified, then select an option in the Subset dropdown

menu to determine a subset of pages as desired.

· Use the Destination options to determine the location to which the specified page

range of pages is moved:

· Select Before or After to specify that pages are moved either before or after

the page specified using the Page option.
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· Select First, Last or Custom to specify the first, last or custom page to which

the specified page range of pages is moved.

· Select the Show setup dialog while running box to launch the Merge Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Merge Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.

Click OK to save settings.
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9.7.13 OCR Pages

OCR Pages

The OCR Pages action performs optical character recognition on documents. Note that two

optical character recognition engines are available in PDF-Tools: the Default OCR engine

and the Enhanced OCR engine, which is available when PDF-Tools is purchased via the

PDF-XChange PRO bundle. The Enhanced OCR engine is faster, more accurate and more

dynamic than the default OCR engine, and it also contains some extra features. Further

information about the Enhanced OCR engine is available here. If you have purchased PDF-

XChange PRO, then you can use the OCR preferences detailed here  to switch between

the Default and Enhanced OCR engines.

This action contains the following customizable parameters:

.
Figure 1. OCR Pages Action Options

· Select an option in the dropdown menu to determine the action taken when input

documents contain text:

1901

https://www.pdf-xchange.com/product/ocr-plugin


1500

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

· Select OCR Document to perform OCR on input documents.

· Select Do not OCR but continue processing to omit the OCR process from

the operation and continue with the remaining actions.

· Select Skip processing the document to exclude the document from

processing.

· Click More Options to view/edit all options. The OCR Pages dialog box will open,

as detailed below.

· Select the Show setup dialog while running box to launch the OCR Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the OCR Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.

Note that the options in the OCR Pages dialog box depend on the OCR engine being used:

Default OCR Engine

Figure 2. OCR Pages Dialog Box
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Use the Page Range settings to determine the page range for OCR:

· Select All to specify all pages.

· Select Custom to specify a custom page range. Further information on how to specify page

ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Select the Skip pages that already contain text content items box to omit pages

that contain text content from the OCR process.

Use the Recognition settings to determine the language and accuracy of the OCR process. Please note

that increasing the accuracy also increases the time that the process takes and vice versa. Additionally,

it should be noted that setting the accuracy to high may result in unusual output if the document

contains imperfections. This is because the software will search to a greater depth and may attempt to

recognize imperfections as text. Click More Languages to view available language packs.

Click OK to save settings.

Enhanced OCR Engine
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Figure 3. OCR Pages (Enhanced) Dialog Box

The options in this dialog box are the same as those detailed in (figure 2) but with additional Output

Options, which are available in the dropdown menu:

· Select Searchable Image to retain the image-based content on which OCR is performed and

insert a duplicate, invisible text layer on the text recognized during the operation. This will

make the source text selectable and searchable in the same manner as ordinary text.

· Select Editable Text and Images to replace image-based text in source documents with the

text recognized in the process of optical character recognition. This will convert image-based

text into editable text.

· Select Fine Page Content to replace the content of source documents with new content that

contains only the text and images recognized during optical character recognition.
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Click OK to OCR documents.
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9.7.14 Overlay PDF

Overlay PDF

The Overlay PDF action overlays input documents with existing files. It contains the

following customizable parameters:

Figure 1. Overlay PDF Action Options

· Enter the name of the file to be used in the Overlay File text box, or click the ellipsis icon to

select a file manually. Click the  icon to preview the overlay file.

· Select the Place overlay file as foreground box to position the overlay in the foreground of

the document.

· Select an option in the Repeat Options dropdown menu to determine the outcome

when there are fewer pages in the overlay document than the printed document:

· Select No Repeat to not repeat the overlay document. Pages in the printed

document that exceed the range of the overlay document will not feature an

overlay.



1505

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

· Select Repeat Last Page of Shorter Overlay File to repeat the final page of

the overlay document on the pages of the printed document that exceed the

range of the overlay document.

· Select Continuous Repeat of Shorter Overlay File to repeat the overlay

document from its first page on the pages of the printed document that

exceed the range of the overlay document.

· Use the Positions settings to determine the placement of overlay files relative to

input documents:

· Select an option from the By Horizontal dropdown menu to determine the

horizontal position.

· Select an option from the By Vertical dropdown menu to determine the

vertical position.

· Select the Fit overlay pages to newly created document pages box to fit overlay

pages to the page size of printed documents.

· Select the Keep Aspect Ratio box to retain the aspect ratio of overlays when the Fit

Overlay Pages to Newly Created Document Pages option is used.

· Select the Show setup dialog while running box to launch the Overlay PDF dialog

box and customize settings each time this action is used. Clear this box to disable

the Overlay PDF dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.

Click  Save Changes to save changes.
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9.7.15 Rasterize Pages

Rasterize Pages

The Rasterize Pages action rasterizes document pages. It contains the following

customizable parameters:

Figure 1. Rasterize Pages Action Options

· Click All Options to view/edit all options. The Rasterize Pages dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Merge Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Merge Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.
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Figure 2. Rasterize Pages Dialog Box

· Use the Page Range options to determine the page range to be rasterized:

· Select All to specify all pages.

· Select Custom to specify a custom page range. Further information on how to specify

page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Use the Actions with Objects dropdown menus to determine the action taken for

comments, form fields and links when rasterization is performed.

· Use the Type dropdown menu to determine the type of rasterization performed on

the document.

· Use the Compression dropdown menu to determine the type of compression used

for the rasterization.

· Use the Page Background dropdown menu to determine the fill color for

transparent sections of the document when rasterization takes place.

1873
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· Use the JPEG Quality dropdown menu to determine the JPEG quality when JPEG

compression is used.

· Use the Horizontal and Vertical Resolution number boxes to determine the

resolution of rasterized images.

Click OK to save settings.



1509

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

9.7.16 Remove Bates Numbering

 Remove Bates Numbering

The Remove Bates Numbering action removes Bates numbering from input documents:

Figure 1. Remove Bates Numbering Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.7.17 Remove Headers and Footers

 Remove Headers and Footers

The Remove Headers and Footers action removes headers and footers from input

documents:

Figure 1. Remove Headers and Footers Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.7.18 Remove Page Background

 Remove Page Background

The Remove Page Background action removes backgrounds from input documents:

Figure 1. Remove Page Background Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.7.19 Remove Watermarks

 Remove Watermarks

The Remove Watermarks action removes watermarks from input documents:

Figure 1. Remove Watermarks Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.7.20 Replace Pages

 Replace Pages

The Replace Pages action replaces specified pages of input documents with pages from

existing documents. It contains the following customizable parameters:

Figure 1. Replace Pages Action Options

· Click All Options to view/edit all options. The Replace Pages dialog box will open,

as detailed below.

· Select the Show setup dialog while running box to launch the Replace Pages

dialog box and customize settings each time this action is used. Clear this box to

disable the Replace Pages dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Replace Pages Dialog Box

· Enter the page numbers of the pages to be replaced in the Page to Replace number boxes.

· Use the File box to specify the document to be used to replace pages, or click the folder icon

to select a file manually. 

· Use the Page Range options to determine the page range to use from the

replacement file:

· Select All to specify all pages.

· Select Custom to specify a custom page range. Further information on how to specify

page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Select a Replace Pages Options radio button to determine the parameters of the page

replacement, as detailed in (figure 2). Use the dropdown menus to determine the action taken

for Comments, Form Fields and Bookmarks in replacement files.

Click OK to save changes.
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9.7.21 Resize Pages

Resize Pages

The Resize Pages action resizes specified pages of input documents. It contains the

following customizable parameters:

Figure 1. Resize Pages Action Options

· Click All Options to view/edit all options. The Resize Pages dialog box will open, as

detailed below.

· Select the Show setup dialog while running box to launch the Resize Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Resize Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.
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Figure 2. Resize Pages Dialog Box

· Use the Paper Size options to determine the size and layout of resized pages: 

· Select Standard to use a standard size, such as those used by the ISO and ANSI. Use the

adjacent box to select either Landscape or Portrait as the page orientation. 

· Select Custom to enter custom dimensions. Enter the dimensions in the number boxes

and select the units of measurement as desired.

· Select Percentage to set the new paper size as a percentage of the existing paper size,

then enter the desired percentage in the number box.
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· Use the Placement options to determine the horizontal/vertical offset of resized pages and the

location from which the offset is made.

· Use the Page Range settings to determine the page range of resized pages:

· Select All to resize all pages.

· Select Custom to resize a custom page range. Further information on how to specify

page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Use the Content Scale Options to determine the scale of page content in relation to the new

page size:

· Select the Scale page content according new page size box to scale the content of

resized pages to the new page size.

· Clear the Keep content aspect ratio box to scale all content of resized pages to the new

page size.

· Select the Scale comments and form fields and Scale text in comments and form

fields boxes as desired.

Click OK to save settings.
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9.7.22 Rotate Pages

 Rotate Pages

The Rotate Pages action rotates specified pages of input documents. It contains the

following customizable parameters:

Figure 1. Rotate Pages Action Options

· Click All Options to view/edit all options. The Rotate Pages dialog box will open,

as detailed below.

· Select the Show setup dialog while running box to launch the Rotate Pages

dialog box and customize settings each time this action is used. Clear this box to

disable the Rotate Pages dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Rotate Pages Dialog Box

· Use the Direction dropdown menu to determine the rotation.

· Use the Page Range options to determine the page range of rotated pages:

· Select All to rotate all pages.

· Select Custom to rotate a custom page range. Further information on how to specify

page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Use the dropdown menu to specify Pages of Any Orientation, Portrait Pages or

Landscape Pages as desired.

Click OK to save settings.
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9.7.23 Setup Page Transitions

 Setup Page Transitions

The Setup Page Transitions action determines the animated effect when moving between

document pages in fullscreen mode. It contains the following customizable parameters:

Figure 1. Setup Page Transitions Action Options

· Click All Options to view/edit all options. The Page Transitions dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Page Transitions

dialog box and customize settings each time this action is used. Clear this box to

disable the Page Transitions dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Page Transitions Dialog Box

Use the Page Transition settings to determine transition parameters:

· Use the Transition dropdown menu to determine the transition style.

· Use the Direction dropdown menu to determine the direction of transitions.

· Use the Duration dropdown menu to determine the rate of transitions.

· Select the check box to move automatically through pages, then select an option from the

dropdown menu to set an automatic scrolling rate.

Use the Page Range settings to determine the page range to which the specified transition settings

apply:

· Select All to specify all pages.

· Select Custom to specify a custom page range. Further information on how to specify page

ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

Click OK to save changes.
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9.7.24 Split Pages

 Split Pages

The Split Pages action splits the pages of input documents into custom sections.. It contains

the following customizable parameters:

Figure 1. Setup Page Transitions Action Options

· Click All Options to view/edit all options. The Split Pages dialog box will open, as

detailed below.

· Select the Show setup dialog while running box to launch the Split Pages dialog

box and customize settings each time this action is used. Clear this box to disable

the Split Pages dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.
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Figure 2. Split Pages Dialog Box

· Percentage is the default method used to split pages. Clear the Use relative offset values box

to use metric measurements instead.

· Select the Calculate split offsets from top box to calculate splits from the top of the page.

Note that the default settings calculate splits from the bottom of the page.

· Click Split Every to split at even intervals throughout the document. The Split Every dialog box

will open, as detailed below.

· Click Add Horizontal Split and/or Add Vertical Split at the top of the preview pane to add

splits to documents. Splits are inserted at 50% by default and will appear in the preview pane

and the list of splits when these options are used. Click and drag to reposition splits as desired.

· Use the plus and minus zoom icons to edit the view of the preview pane.

· Click Edit Split/Remove Split to edit/remove selected splits in the list of splits.

· Select the Use Right To Left splitting method box to split documents from right to left. Note

that the order in which documents are split determines the order of sections in the split

document.

· Select the Remove source pages after splitting them to remove the original document from

the active pane when pages are split. If this box is cleared then both the original document and

the split pages will be present after pages are split.

· Select an option from the Select split method dropdown menu to determine the method used

to split documents:

· Change the physical size of the pages adjusts the size of pages in order to split them.

· Redefine the visible area (crop box) of the pages adjusts the crop box of pages. Further

information about crop boxes is available here.  When this option is used the Preserve

original content box is available. If this option is enabled then the visible page area will

1790



1525

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

be reduced, but the cropped content will remain available and be present if, for example,

pages are resized subsequently.

· The Page Range settings are as follows:

· Select All to split to all pages.

· Select Custom to split a custom page range. Further information on how to specify page

ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

Click OK to save changes.

Figure 3. Split Every Dialog Box

· Select Standard to split documents at intervals of standard dimensions, then select the desired

dimension in the dropdown menu, and specify the desired orientation in the second dropdown

menu.

· Select Custom to split documents at intervals of custom dimensions, then enter the desired

dimensions and units of measurement in the adjacent number box and dropdown menu.

· Select Percentage to split documents according to a percentage of the document page size.

· Select the Add horizontal/vertical splits boxes as desired.

Click OK to save changes.
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9.8 Links Actions

 Links Actions

The Links actions create/delete links and weblinks:

 Create Weblinks  creates weblinks from the text of input documents.

 Delete Links  deletes links from input documents.

 Delete Weblinks  deletes weblinks from input documents.

1527

1529

1531



1527

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

9.8.1 Create Weblinks

 Create Weblinks

The Create Weblinks action creates weblinks from the text of input documents. It contains

the following customizable parameters:

Figure 1. Create Weblinks Action Options

· Select All to create weblinks from the appropriate text of all pages in the input

document.

· Select Pages to specify a custom page range, then enter the desired range in the

text box. Further information on the specification of page ranges is available

here.

· Use the dropdown menu to select a subset of specified page ranges as desired.

· Select the Show setup dialog while running box to launch the Create Weblinks

dialog box and customize settings each time this action is used. Clear this box to

disable the Create Weblinks dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Click  Save Changes to save changes.
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9.8.2 Delete Links

 Delete Links

The Delete Links action deletes links from input documents. It contains the following

customizable parameters:

Figure 1. Delete Links Action Options

· Select All to delete links from all pages of the input document.

· Select Pages to specify a custom page range, then enter the desired range in the

text box. Further information on the specification of page ranges is available

here.

· Use the dropdown menu to select a subset of specified page ranges as desired.

· Select the Show setup dialog while running box to launch the Delete Links dialog

box and customize settings each time this action is used. Clear this box to disable

the Delete Links dialog box from opening each time the action is used, which is

useful when the same settings are used consistently.
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Click  Save Changes to save changes.
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9.8.3 Delete Weblinks

 Delete Weblinks

The Delete Weblinks action deletes weblinks from input documents. It contains the

following customizable parameters:

Figure 1. Delete Weblinks Action Options

· Select All to delete weblinks from all pages of the input document.

· Select Pages to specify a custom page range, then enter the desired range in the

text box. Further information on the specification of page ranges is available

here.

· Use the dropdown menu to select a subset of specified page ranges as desired.

· Select the Show setup dialog while running box to launch the Delete WebLinks

dialog box and customize settings each time this action is used. Clear this box to

disable the Delete WebLinks dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Click  Save Changes to save changes.
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9.9 Forms Actions

 Forms Actions

The Forms actions create/delete links and weblinks:

 Delete Form Fields  deletes form fields from input documents.

 Export Form Data  exports form data to a file.

 Import Form Data  imports form data from a file.

 Reset Form  resets all form fields in input documents.
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9.9.1 Delete Form Fields

 Delete Form Fields

The Delete Form Fields action deletes form fields from input documents. It contains the

following customizable parameters:

Figure 1. Delete Form Fields Action Options

· Select All to delete form fields from all pages of the input document.

· Select Pages to specify a custom page range, then enter the desired range in the

text box. Further information on the specification of page ranges is available

here.

· Use the dropdown menu to select a subset of specified page ranges as desired.

· Select the Show setup dialog while running box to launch the Delete Form Fields

dialog box and customize settings each time this action is used. Clear this box to

disable the Delete Form Fields dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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Click  Save Changes to save changes.
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9.9.2 Export Form Data

 Export Form Data

The Export Form Data action exports form data from documents to a file. It contains the

following customizable parameters:

Figure 1. Export Form Data Action Options

· Select an option in the Data file(s) destination dropdown menu to determine the

folder of output documents:

· Select To folder of input PDF(s) to place output documents in the same

folder as the source documents.

· Select to custom folder to place output documents in a custom folder, then

click the text box or the ellipsis icon to select a folder.

· Select/clear the Exclude password fields box to exclude/include password fields in

the exported data when this action is used.

· Select/clear the Include empty fields box to include/exclude empty fields in the

exported data when this action is used.
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· Select/clear the Include comments box to include/exclude comments in the

exported data when this action is used.

· Select an option in the Data Format dropdown menu to determine the format of

output files.

· Select an option in the When File Already Exists dropdown menu to determine the

action taken when the filename specified for output documents is already in use: 

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save the

new file. 

· Select the Show setup dialog while running box to launch the Export Form Data

dialog box and customize settings each time this action is used. Clear this box to

disable the Export Form Data dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.

Click  Save Changes to save changes.
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9.9.3 Import Form Data

 Import Form Data

The Import Form Data action imports form data from a file. It contains the following

customizable parameters:

Figure 1. Import Form Action Options

· Select an option in the Data file(s) destination dropdown menu to specify the

location of the file that contains the form data to be imported:

· Select In folder of input PDF(s) to specify a file that is located in the same

folder as the source documents.

· Select In custom folder to specify a custom folder, then click the text box or

the ellipsis icon to select a folder.

· Select In specific file to specify a specific file, then click the text box or the

ellipsis icon to select a file.

· Select the Show setup dialog while running box to launch the Import Form Data

dialog box and customize settings each time this action is used. Clear this box to
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disable the Import Form Data dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.

Please note that the field names of forms must match in order for form data to be imported.

For example, if there are three forms in the file from which data is imported that have the

field names 'Text1', 'Text2' and 'Text3' respectively, then the target document must contain

forms with the same field names in order for form data to import.

Additionally, the file format of the files that contain the imported form data must be (*.fdf),

(*.xfdf) or (*.csv). The Export Form Data  tool can be used to export form data from

documents to these formats.

Click  Save Changes to save changes.
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9.9.4 Reset Form

 Reset Form

The Reset Form action removes all form data from input documents:

Figure 1. Reset Form Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.10 Comments Actions

 Comments Actions

The Comments actions edit and manipulate the comments of input documents:

 Delete All Comments  deletes comments of all formats from input documents.

 Delete Markup Annotations  deletes markup annotations from input documents.

 Export Comments  exports comments from input documents to file.

 Flatten Comments and Fields  flattens comments and fields in input documents.

 Import Comments  imports comments into input documents.

 Summarize Comments  creates a summary of the comments in input documents.
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9.10.1 Delete All Comments

 Delete All Comments

The Delete All Comments action deletes comments of all formats from input documents. It

contains the following customizable parameters:

Figure 1. Delete All Comments Action Options

· Select All to delete comments from all pages of the input document.

· Select Pages to specify a custom page range, then enter the desired range in the

text box. Further information on the specification of page ranges is available

here.

· Use the dropdown menu to select a subset of specified page ranges as desired.

· Select the Show setup dialog while running box to launch the Delete All

Comments dialog box and customize settings each time this action is used. Clear

this box to disable the Delete All Comments dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.
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Click  Save Changes to save changes.
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9.10.2 Delete Markup Annotations

 Delete Markup Annotations

The Delete Markup Annotations action deletes markup annotations from input documents.

It contains the following customizable parameters:

Figure 1. Delete Markup Annotation Action Options

· Select All to delete markup annotations from all pages in the input document.

· Select Pages to specify a custom page range, then enter the desired range in the

text box. Further information on the specification of page ranges is available

here.

· Use the dropdown menu to select a subset of specified page ranges as desired.

· Select the Show setup dialog while running box to launch the Delete Markup

Annotations dialog box and customize settings each time this action is used. Clear

this box to disable the Delete Markup Annotations dialog box from opening each

time the action is used, which is useful when the same settings are used consistently.
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Click  Save Changes to save changes.
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9.10.3 Export Comments

 Export Comments

The Export Comments action exports comments from input documents. It contains the

following customizable parameters:

Figure 1. Export Comments Action Options

· Use the Save to dropdown menu to determine where output files are saved:

· Click My Computer to save files to the local computer.

· Hover over Add Place to add a new place at which to save files, then click

Box.com, Dropbox, Google Drive, OneDrive or Sharepoint to add accounts

from these locations. PDF-Tools will prompt for the login information for the

selected account. When this information has been entered, the account will be

detailed in the list and can be used to save files as desired.

· Use the Data file(s) destination dropdown menu to determine the folder of output

documents:
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· Select To folder of input PDF(s) to place output documents in the same

folder as the source documents.

· Select to custom folder to place output documents in a custom folder, then

click the text box or the ellipsis icon to select a folder.

· Select an option in the Data format dropdown menu to determine the format of

the output document.

· Select an option in the When file already exists dropdown menu to determine the

action taken when the filenames of output documents are already in use:

· Overwrite with a new file overwrites the existing file with the new file. 

· Keep existing file unchanged retains the existing file and does not save the

new file.

· Select the Show setup dialog while running box to launch the Export Comments

dialog box and customize settings each time this action is used. Clear this box to

disable the Export Comments dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.

Click  Save Changes to save changes.
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9.10.4 Flatten Comments and Fields

 Flatten Comments and Fields

The Flatten Comments and Fields action flattens the comments and form fields of input

documents into base content. It contains the following customizable parameters:

Figure 1. Flatten Comments and Fields Action Options

· Click All Options to view/edit all options. The Flatten Annotations dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Flatten

Annotations dialog box and customize settings each time this action is used. Clear

this box to disable the Flatten Annotations dialog box from opening each time the

action is used, which is useful when the same settings are used consistently.



1549

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

Figure 2. Flatten Annotations Dialog Box

· Use the Page Range options to determine the page range in which comments are flattened:

· Select All to flatten comments on all pages.

· Select Custom to specify a custom page range. Further information on how to specify

page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Use the Non-Printable and Form Fields dropdown menus to determine the outcome of the

flattening process for non-printable annotations and form fields:

· Select Flatten to flatten content

· Select Left as Is to retain the existing state of content.

· Select Remove to remove the content from the document.

 

Click OK to save changes.
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9.10.5 Import Comments

 Import Comments

The Import Comments action imports comments into input documents. It contains the

following customizable parameters:

Figure 1. Import Comments Action Options

· Select an option in the Data file(s) location dropdown menu to specify the location

of the file that contains the comments to be imported:

· Select In folder of input PDF(s) to specify a file that is located in the same

folder as the source documents.

· Select In custom folder to specify a custom folder, then click the text box or

the ellipsis icon to select a folder.

· Select In specific file to specify a specific file, then click the text box or the

ellipsis icon to select a file.

· Select the Show setup dialog while running box to launch the Import Comments

dialog box and customize settings each time this action is used. Clear this box to
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disable the Import Comments dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.

Click  Save Changes to save changes.



1552

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

9.10.6 Summarize Comments

  Summarize Comments

The Summarize Comments action creates a summary of comments in input documents. It

contains the following customizable parameters:

Figure 1. Summarize Comments Action Options

· Click All Options to view/edit all options. The Summarize Comments dialog box

will open, as detailed below.

· Select the Show setup dialog while running box to launch the Summarize

Comments dialog box and customize settings each time this action is used. Clear

this box to disable the Summarize Comments dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.
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Figure 2. Summarize Comments Dialog Box

· Use the Group by and Sort By dropdown menus to determine how comments are grouped

and summarized:

· Select Page to group/sort comments by page.
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· Select Type  to group/sort comments by type.

· Select Author to group/sort comments by author.

· Select Date to group/sort comments by date. 

· Select Subject to group/sort comments by subject.

· Select Visual Order to sort comments by their visual order.

· Select the Exclude replies box to exclude replies to comments from the summary.

· Select the Include invisible comments box to include invisible comments in the

summary.

· Use the Page Range settings to determine the page range from which the comment summary

comes:

· Select All to include all pages.

· Select Custom to specify a custom page range. Further information on how to specify

page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Use the Output dropdown menu to determine the format of the summary.

· Use the Options dropdown boxes to determine customizable options for the selected output

format.

· Use the Destination Folder text box to determine the destination folder for the summary, or

click the icon to select a folder on the local computer. 

· Use the Filename text box to determine the name of the summary. Click the macro dropdown

menu to add macros  as desired.

Click OK to save changes.
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9.11 Protection Actions

 Protection Actions

The Protection actions add/remove digital signatures, certified signature fields, timestamps

and passwords to input documents, as well as sanitize/redact their content:

 Add Timestamp  adds document-level time stamps to input documents.

 Apply Redaction  removes content that has been marked for redaction from documents.

 Certify Document  adds certified signature fields to input documents.

 Clear Digital Signatures  removes digital signatures from input documents.

 Find and Redact  searches for specific words or patterns (phone numbers, credit card

numbers, social security numbers, emails or dates) in documents and then either marks them for

redaction or redacts them immediately.

 Sanitize Document  removes sensitive information from input documents.

 Secure Document  adds password security to input documents.

 Sign Document  uses a certificate-based digital ID to add and sign signature fields in

input documents.
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9.11.1 Add Timestamp

 Add Timestamp

The Add Timestamp action adds document-level timestamps to input documents. It

contains the following customizable parameters:

Figure 1. Add Timestamp Action Options

· Click All Options to view/edit all options. The Timestamp Server dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Timestamp Server

dialog box and customize settings each time this action is used. Clear this box to

disable the Timestamp Server dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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Figure 2. Timestamp Server Dialog Box

· Use the Timestamp Server dropdown menu to select a timestamp server.

· If a timestamp server is being used for the first time then enter the website address in the

Server URL text box.

· If the selected timestamp server requires authentication then select the indicated box and enter

the User Name and Password in the associated text boxes.

· Click Timestamp Server dropdown menu to save/delete/manage customized settings, as

detailed below.

Click OK to save settings. 

Figure 3. Timestamp Server Dropdown Menu

· Click  Save to save the current settings to a profile for subsequent use.

· Click  Delete to delete the current profile.
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· Click  Manage to manage saved profiles. The Manage Presets dialog box will open:

Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles.

· Use the up and down arrows to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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9.11.2 Apply Redaction

 Apply Redaction

The Apply Redaction action removes content that has been marked for redaction from

documents:

Figure 1. Apply Redaction Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.11.3 Certify Document

 Certify Document

The Certify Document action adds certified signature fields to input documents. It contains

the following customizable parameters:

Figure 1. Certify Document Action Options

· Click All Options to view/edit all options. The Timestamp Server dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Timestamp Server

dialog box and customize settings each time this action is used. Clear this box to

disable the Timestamp Server dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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Figure 2. Certify Document Dialog Box

· Select a certificate from the system store or the local computer.

· Click View Certificate to view details about the selected certificate.

· Click Create Certificate to create a new certificate. The dialog box displayed in (figure 3) will

open.

· Click the Reason for Signing menu, or enter text into the box manually, to add a reason for

signing the document.

· Click the Location box to enter a location as desired.

· Click the Contact Info box to add contact information to the signature.

· Click the Permissions box to determine the changes that are permitted after the document has

been signed. 

· Click the Sign Template menu to select layout options for the signature and associated

information. 

· Click Manage to further customize the Sign Template.

· Select the Use Timestamp Server box to select a timestamp server to add to the signature,

then select a timestamp server from the dropdown menu. Click Change to view/edit the details

of the timestamp server used.

· Use the Placement Options to determine the location at which the digital signature

is added to input documents:

· Enter the page number in the To Page number box, or select the To Last Page

box to add the digital signature to the last page.

· Click and drag the bounding box in the preview pane to position the signature

field manually and/or resize its dimensions.

· Alternatively, use the number boxes to determine the location and dimensions

of the digital signature.
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Note that it is only possible to certify documents a single time, whereas is it possible to digitally sign

documents multiple times. The Sign Document  action is used to digitally sign documents.

Click OK to save changes.

Creating Digital Certificates

Figure 3. Create Self-Signed Digital ID Dialog Box

· Enter the desired user information in Name, Organization and Email text boxes.

· Use the Country/Region dropdown menu to enter the nationality of the owner of the digital

certificate.
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· Select either 1024-bit RSA or 2048-bit RSA as the key algorithm. 1024-bit RSA is more

universally compatible than 2048-bit RSA, but 2048-bit RSA offers more security.

· Select a storage location for the digital certificate. If the PKCS#12 option is used then enter

and confirm a password in the Password text boxes.

Click OK to create the digital certificate. It will then be available in the Use Certificate from System

Store dropdown menu detailed in (figure 2).
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9.11.4 Clear Digital Signatures

 Clear Digital Signatures

The Clear Digital Signatures action clears digital signature fields in documents:

Figure 1. Clear Digital Signatures Action Options

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.
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9.11.5 Find and Redact

 Find and Redact

The Find and Redact action searches for specific words or patterns (phone numbers, credit

card numbers, social security numbers, emails or dates) in documents and then either marks

them for redaction or redacts them immediately. It contains the following customizable

parameters:

Figure 1. Find and Redact Action Options

· Click All Options to view/edit all options. The Find and Redact Text dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Find and Redact

Text dialog box and customize settings each time this action is used. Clear this box

to disable the Find and Redact Text dialog box from opening each time the action

is used, which is useful when the same settings are used consistently.
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Figure 2. Find and Redact Text Dialog Box

· Select Single word or phrase to search for a single word/phrase, then enter the desired

word/phrase in the text box.

· Select the Match Case box to match the case of word entered in the text box.

· Select the Whole Words Only box to match only whole words in the document to the

word entered in the text box.

· Select the Use regular expressions box to enable the use of ECMAScript syntax-based

regular expressions in the search. Further information about regular expressions is

available here.

· Select Multiple words or phrases to search for multiple words/phrases. Click Add/Remove to

add/remove words/phrases, then enter the desired words/phrases in the text box. Click Save to

save the current word list to a plain text file for subsequent use. Click Load to load a plain text

file of words into the text box.

· Select Patterns to search for specific patterns, then select either Phone numbers, Credit cards,

Social security numbers, Emails or Dates to determine the patterns that you want to find.

· Select an option in the Locale dropdown menu to determine the language used in the

search.

http://www.cplusplus.com/reference/regex/ECMAScript/
https://en.wikipedia.org/wiki/Regular_expression
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· Click Add to add a custom pattern to the available search options. Enter the name, value

and description of the custom pattern and click OK to save. The custom pattern will then

be available in the list of patterns.

· Click Remove to remove selected custom patterns. 

· Select a Page text radio button to determine the outcome of the operation for page text:

· Select Mark found text for redaction to mark search results for redaction.

· Select Redact found text to immediately redact search results.

· Select the check boxes on the right side of the dialog box to determine where you want to

search for text to redact.

· Select an Objects text radio button to determine the outcome of the operation for object-

based text (such as text in comments):

· Select Delete found text to delete text that matches the search terms.

· Select Replace text with: to replace text that matches the search terms, then enter the

desired replacement text in the text box.

Click OK to find and mark/redact content.
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9.11.6 Sanitize Document

 Sanitize Document

The Sanitize Document action removes sensitive information from input documents:

Figure 1. Sanitize Document Action Options

· Click All Options to view/edit all options. The Sanitize Document Options dialog

box will open, as detailed below.

· Select the Show setup dialog while running box to launch the Sanitize Document

Options dialog box and customize settings each time this action is used. Clear this

box to disable the Sanitize Document Options dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.
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Figure 2. Sanitize Document Dialog Box

· Select the check boxes to determine the content to be removed from documents.

· Click Check All/Uncheck All to select/clear all check boxes.

Click OK to save settings. 
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9.11.7 Secure Document

 Secure Document

The Secure Document action adds password security to input documents. It contains the

following customizable parameters:

Figure 1. Secure Document Action Options

· Select Password Security in the dropdown menu to set a password for input

documents. The Password Security Settings dialog box will open, as detailed

below.

· Select the Show setup dialog while running box to launch the Password Security

Settings dialog box and customize settings each time this action is used. Clear this

box to disable the Password Security Settings dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.
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· Use the Compatibility menu to select the document security compatibility.

· Select an encryption option button to determine which elements of documents are encrypted.

· Select the Require password to open the document box to set a password for opening the

document. Enter the password in the Document Open Password text box and confirm it in the

text box below.

· Select the Restrict editing and printing of the document box to set a password for editing

and printing the document. Enter the password in the Change Permissions Password text box

and confirm it in the text box below. Use the dropdown menus and check boxes in the

Permissions section to select the settings that these passwords will enable. 

Click OK to save changes.
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9.11.8 Sign Document

 Sign Document

The Sign Document action uses a certificate-based digital ID to add and sign signature

fields in input documents. It contains the following customizable parameters:

Figure 1. Sign Document Action Options

· Click All Options to view/edit all options. The Sign Document dialog box will open,

as detailed below.

· Select the Show setup dialog while running box to launch the Sign Document

dialog box and customize settings each time this action is used. Clear this box to

disable the Sign Document dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Sign Document Dialog Box

· Select a certificate from the system store or the local computer.

· Click View Certificate to view details about the selected certificate.

· Click Create Certificate to create a new certificate. The dialog box displayed in (figure 3) will

open.

· Click the Reason for Signing menu, or enter text into the box manually, to add a reason for

signing the document.

· Click the Location box to enter a location as desired.

· Click the Contact Info box to add contact information to the signature.

· Click the Permissions box to determine the changes that are permitted after the document has

been signed. 

· Click the Sign Template menu to select layout options for the signature and associated

information. 

· Click Manage to further customize the Sign Template.

· Select the Use Timestamp Server box to select a timestamp server to add to the signature,

then select a timestamp server from the dropdown menu. Click Change to view/edit the details

of the timestamp server used.

· Use the Placement Options to determine the location at which the digital signature

is added to input documents:

· Enter the page number in the To Page number box, or select the To Last Page

box to add the digital signature to the last page.

· Click and drag the bounding box in the preview pane to position the signature

field manually and/or resize its dimensions.

· Alternatively, use the number boxes to determine the location and dimensions

of the digital signature.
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· Click the Page Size button to set the page size/orientation of the page in the

preview pane.

Click OK to save changes.

Creating Digital Certificates

Figure 3. Create Self-Signed Digital ID Dialog Box

· Enter the desired user information in Name, Organization and Email text boxes.

· Use the Country/Region dropdown menu to enter the nationality of the owner of the digital

certificate.
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· Select either 1024-bit RSA or 2048-bit RSA as the key algorithm. 1024-bit RSA is more

universally compatible than 2048-bit RSA, but 2048-bit RSA offers more security.

· Select a storage location for the digital certificate. If the PKCS#12 option is used then enter

and confirm a password in the Password text boxes.

Click OK to create the digital certificate. It will then be available in the Use Certificate from System

Store dropdown menu detailed in (figure 2).
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9.12 Advanced Actions

 Advanced Actions

The Advanced actions change document properties or print documents:

 Change Document Properties  edits the properties of input documents.

 Convert Colors  converts the colors of input documents.

 Create File List  creates a file list of the files used when tools run:

 Filter Documents  sets criteria for the automatic selection of documents to be processed

by subsequent actions in the same tool.

 Filter Files  sets criteria for the automatic selection of files to be processed by

subsequent actions in the same tool.

 Filter Pages  sets criteria for the automatic selection of pages to be processed

by subsequent actions in the same tool.

 Find by Regular Expression  find texts in documents via regular expressions.

 Print Document  prints input documents.

 Run Application  launches third-party applications via the command line.
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9.12.1 Change Document Properties

 Change Document Properties

The Change Document Properties action is used to edit document properties. It contains

the following customizable parameters:

Figure 1. Change Document Properties Action Options

· Use the text boxes to create/edit the Title, Author, Subject, Keywords and Creator

properties of the document.

· Click the dropdown arrows to add macros.

· Click All Options to view/edit all options. The Document Properties dialog box will

open, as detailed below.

· Select the Show setup dialog while running box to launch the Document

Properties dialog box and customize settings each time this action is used. Clear

this box to disable the Document Properties dialog box from opening each time

the action is used, which is useful when the same settings are used consistently.
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Figure 2. Document Properties Dialog Box, Description Category

The options in the Description category are the same as those detailed in the Change Document

Properties actions options detailed above, with the additional option to select the Apply Metadata

Template box in order to apply metadata templates when you change document properties. Specify

the template file you want to use in the XMP template file box, then select an option in the Apply

XMP Method dropdown menu to determine the method you want to use:

· Select Append to add new values when a value with the same name doesn't exist in the

document.

· Select Merge to combine the existing values list with the new list.

· Select Replace to replace existing lists with the new list of values.

Select options in the Categories pane to view/edit document properties. The Description document

properties determine the metadata of input documents. These properties are detailed in (figure 1).
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Initial View

Figure 3. Document Properties Dialog Box, Initial View Category

The Initial View document properties determine the initial view of input documents.

The Layout and Magnification options are as follows:

· The Navigation View menu determines the panes that are visible when documents are opened:

· Select Default to retain the default settings of the application used to open documents. 

· Select Page Only to view only the document itself.  

· Select Bookmarks pane and page to view the document and the bookmarks pane.

· Select Thumbnails pane and page to view the document and the thumbnails pane. 
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· Select Layers pane and page to view the document and the layers pane. 

· Select Attachments pane and page to view the document and the attachments pane.

· The Page Layout menu determines the page layout when documents are opened:

· Select Default to retain the default settings of the application used to open documents.

· Select Single Page to view a single page at a time.

· Select Continuous to view pages in a single, scrolling column.

· Select Two Pages Continuous to view two pages at a time in scrolling columns.

· Select Two Pages Continuous, with Cover Page to view as above, but with a cover page

included.

· Select Two Pages to view two pages at a time.

· Select Two Pages with Cover Page to view as above, but with a cover page included.

· The Magnification menu determines the level of zoom when documents are opened:

· Select Default to retain the default settings of the application used to open documents.

· Select Actual Size to view pages at their actual size. The resulting display will include

resolution settings. 

· Select Fit Page to view the full extent of page content regardless of its size.

· Select Fit Width to fit pages according to their width.

· Select Fit Height to fit pages according to their height.

· Select Fit Visible to view the entire page within the confines of the viewing area.

· Alternatively, select an option from the list of numerical percentages to determine the

magnification level. 

· Use the Open to Page dropdown menu to determine the page at which documents open.

The Window Options are as follows:

· Use the Show in Title dropdown menu to determine the name displayed in the document tab

when documents are opened.

· Select the Hide Menu bar box to hide the menu bar in the application used to open the

document.

· Select the Hide Toolbars box to hide toolbars in the application used to open the document.

· Select the Hide Window Controls box to window controls in the application used to open the

document.

· Select the Open in Full Screen Mode box to open documents in full screen mode.

· Select the Resize Window to Initial Page box to resize the viewing window according to the

dimensions of the first page of the document.

· Select the Center Window on Screen box to center the viewing window on the monitor screen.

Custom
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Figure 4. Document Properties Dialog Box, Custom Category

You can use the options in this dialog box to add custom document properties to documents:

· Select the Change Custom Values check box to change custom document properties in

documents.

· Select an option in the Choose Method dropdown menu to determine how custom document

properties are applied:

· Select Append to add new values when a value with the same name doesn't exist in the

document.

· Select Merge to combine the existing values list with the new list.

· Select Replace to replace existing lists with the new list of values.
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· Click Add to add new document properties to documents, then enter the desired Name and

Value in the Custom Document Property dialog box and click OK to save it.

· Click Edit/Delete to edit/delete custom document properties.

· Click Remove All to remove all custom document properties from documents.

Advanced

Figure 5. Document Properties Dialog Box, Advanced Category

The Advanced document properties determine printing/reading options:

· Select the Print Dialog Presets box to override the viewing application's default print settings

with those specified within the file itself:



1584

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

· Select an option in the Page Scaling dropdown menu to determine the page scaling

used:

· Default retains the default settings. 

· None disables page scaling. 

· Select an option in the Duplex Mode dropdown menu to determine the default duplex

mode for printing.

· Select the Paper Size by document Page Size box to use the size of the document pages

to determine the paper size of the document.

· Enter the pages to be printed in the Print Page Range text box. Further information on

the specification of page ranges is available here.

· Use the Number of Copies dropdown menu to determine how many copies of the

document are printed.

· Select the Reading Options box to enable binding and language options:

· Select eithe Left to Right or Right to Left as the document Binding option.

· Select an option in the Language dropdown menu to determine the language of the

document.

Click OK to save settings.

1873
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9.12.2 Convert Colors

 Convert Colors

The Convert Colors action is used to convert the colors of documents. It contains the

following customizable parameters:

Figure 1. Convert Colors Action Options

· Click All Options to view/edit all options. The Convert Colors dialog box will open,

as detailed below.

· Select the Show setup dialog while running box to launch the Convert Colors

dialog box and customize settings each time this action is used. Clear this box to

disable the Convert Colors dialog box from opening each time the action is used,

which is useful when the same settings are used consistently.
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Figure 2. Convert Colors Dialog Box

· The default settings profile for color conversion are available in the pane on the left.

If you want to create customized settings for color conversion, then click Add and

customize the settings as detailed below:

· Use the Matching Criteria section to determine the document content that

you want to convert:

· Use the Object Type dropdown menu to specify the type of objects that

you want to convert.

· Use the Color Type dropdown menu to specify the color space you want

to convert.

·  Use the Minimum/Maximum Text Size dropdown menus to specify

the minimum/maximum size of text that you want to convert.

· Use the Conversion Attributes to determine how the colors of objects in the

document that meet the Matching Criteria are converted:

· Use the Convert Command dropdown menu to determine the

conversion operation performed:

· Preserve preserves objects from conversion.

· Convert to Profile converts objects to the destination colorspace

using the profile selected in the Conversion Profile dropdown

menu.

· Decalibrate removes embedded profiles from objects. 

· Use the Conversion Profile dropdown menu to determine the profile to

which objects are converted. Select the Embed box to tag objects with

the selected ICC profile to calibrate color, which is useful when PDFs are

shared between users on different devices.
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· Use the Rendering Intent dropdown menu to determine the rendering

intent used during color conversion.

· Use the Convert Options to determine additional options:

· Select the Convert Colors to Output Intent box to convert document

colors to the Output Intent specified in the Rendering Intent

dropdown menu. Note that documents must contain the output intent

profile in order for their colors to be converted.

· Select the Preserve Black box to preserve black objects in CMYK, RGB

or Grayscale content of converted documents, for example to prevent

RGB text from converting into rich black CMYK when conversion is

performed.

· Select the Preserve CMYK Primitives to preserve colors that contain

only one colorant.

· Select the Promote Gray to CMYK Black to convert device gray to

CMYK black with only a black component.

· Use the Page Range options to the page range on which color conversion takes place in

input documents:

· Select All to convert colors on all pages.

· Select Custom to specify a custom page range. Further information on how to

specify page ranges is available here.

· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Click Document Colors to view a breakdown of colors in the current

document and determine which colors are converted, as detailed in (figure 4)

below.

· Click the Settings dropdown arrow to save/manage/delete custom settings:

· Click Save Current Settings to save the current settings as a profile for

subsequent use.

· Click Delete to delete selected profiles. Note that this option is only

available for customized profiles.

· Click Manage to manage preset/customized profiles. The Manage

Presets dialog box will open:

1873
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Figure 3. Manage Presets Dialog Box

· Click Edit to edit selected profiles. Note that this option is only available

for customized profiles.

· Click Clone to clone selected profiles. This option can be used to

customize the settings of preset profiles, which cannot be customized in

their default state.

· Use the up and down arrows to move selected profiles up or down in

the list.

· Click Delete to delete selected profiles. Note that this option is only

available for customized profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.

Document Colors
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Figure 4. Document Colors Dialog Box

All colors contained in the document are detailed in this dialog box. Select the boxes of

spot colors to include them in the conversion, or select the Convert all spot colors box to

convert all spot colors.
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9.12.3 Create File List

 Create File List

The Create File List action is used to create a file list of the files used when tools run:

Figure 1. Create File List Action Options

When tools that contain this action run a (*.pdtfl) file will be created that contains the files used when

the tool ran. You can use these files as input files in the Choose Input Files  dialog box when tools

run, and avoid the need to repeatedly enter the same set of files manually.

Select/clear the check box to enable/disable this action, then click  Save Changes to save changes.

1395
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9.12.4 Filter Documents

 Filter Documents

The Filter Documents action is used to set criteria for the automatic selection of documents

to be processed by subsequent actions in the same tool. It contains the following

customizable parameters:

Figure 1. Filter Documents Action Options

Use the check boxes to determine which documents are selected:

· Select the Select only documents that do not fulfill the criteria above to specify

only documents that do not meet the criteria specified in the Filter Documents

action.

· Select the Apply OR logical operation between criterias (AND is applied by

default) box to apply an 'or' logical operation between criteria. Documents that

meet any individual criteria in the list will then be included in the filter output.
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· Select the Select documents with non-empty content box to select only

documents that contain content. If this box is not selected then documents that do

not contain content will be included when the tool runs.

· Select the Select documents with bookmarks box to select documents that contain

bookmarks.

· Select the Select documents with comments and fields to select documents that

contain comments and form fields. When this box is selected, additional check

boxes will appear in the dialog box. Use these check boxes to specify the types of

comments and form fields that you want to include.

· Select the Select documents with text box to select documents that contain text.

When this box is selected, additional check boxes will appear in the dialog box. Use

these boxes to specify the criteria through which text-based documents are selected

to be included when the tool runs:

· Select Any Text to include documents that contain any text.

· Select By custom criteria to set custom criteria to be used to determine

which documents are included when the tool runs, then use the text and check

boxes to set the criteria.

· Select the Show setup dialog while running box to to launch the Filter Documents

dialog box and customize settings each time this action is used. Clear this box to

disable the Filter Documents dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.
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9.12.5 Filter Files

 Filter Files

The Filter Files action is used to set criteria for the automatic selection of files to be

processed by subsequent actions in the same tool. It contains the following customizable

parameters:

Figure 1. Filter Files Action Options

Use the check boxes to determine which documents are selected:

· Select the Select only documents that do not fulfill the criteria above to specify

only documents that do not meet the criteria specified in the Filter Files action.

· Select the Apply OR logical operation between criterias (AND is applied by

default) box to apply an 'or' logical operation between criteria. Documents that

meet any individual criteria in the list will then be included in the filter output.

· Select the File Name box to filter files according to their file name, then enter the

desired name of the file in the text box.
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· Select the File Size box to filter files according to their size, then use the dropdown

menus to specify the desired minimum/maximum/exact size for files.

· Select the Creation date box to filter files according to their creation date, then use

the dropdown menus and boxes to specify the desired creation date.

· Select the Modified date box to filter files according to their modification date,

then use the dropdown menus and boxes to specify the desired modification date.

· Select the Show setup dialog box while running box to launch the Filter Files

dialog box and customize settings each time this action is used. Clear this box to

disable the Filter Files dialog box from opening each time the action is used, which

is useful when the same settings are used consistently.
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9.12.6 Filter Pages

 Filter Pages

The Filter Pages action is used to set criteria for the automatic selection of file pages to be

processed by subsequent actions in the same tool. It contains the following customizable

parameters:

Figure 1. Filter Pages Action Options

Use the check boxes to determine which pages are selected:

· Select the Select only documents that do not fulfill the criteria above to specify

only documents that do not meet the criteria specified in the Filter Pages action.

· Select the Apply OR logical operation between criterias (AND is applied by

default) box to apply an 'or' logical operation between criteria. Documents that

meet any individual criteria in the list will then be included in the filter output.
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· Select the Select pages with non-empty content box to select only documents that

contain content. If this box is not selected then documents that do not contain

content will be included when the tool runs.

· Select the Select pages with bookmarks box to select documents that contain

bookmarks.

· Select the Select pages with comments and fields to select documents that

contain comments and form fields. When this box is selected, additional check

boxes will appear in the dialog box. Use these check boxes to specify the types of

comments and form fields that you want to include.

· Select the Select pages with text box to select documents that contain text. When

this box is selected, additional check boxes will appear in the dialog box. Use these

boxes to specify the criteria through which text-based documents are selected to be

included when the tool runs:

· Select Any Text to include documents that contain any text.

· Select By custom criteria to set custom criteria to be used to determine

which documents are included when the tool runs, then use the text and check

boxes to set the criteria.

· Select the Show setup dialog while running box to to launch the Filter Documents

dialog box and customize settings each time this action is used. Clear this box to

disable the Filter Documents dialog box from opening each time the action is

used, which is useful when the same settings are used consistently.



1597

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Actions Library

9.12.7 Find by Regular Expression

 Find by Regular Expression

The Find by Regular Expression action is used to find text in documents via regular

expressions:

Figure 1. Find by Regular Expression Action Options

· Enter the regular expression that you want to use in the Find by regular expression

text box. You can use ECMAScript regular expressions for this feature.

· Enter the name of the value that you want to find in the Value name text box.

· Select the Skip processing document for which matched value was not found

box to exclude from processing documents that do not meet the search criteria.

· Select the Ignore Input Pages Range box to override any page range settings

specified in the action options when this action is included.  

· Select the Show setup dialog while running box to launch the Find by Regular

Expression dialog box and customize settings each time this action is used. Clear

http://www.cplusplus.com/reference/regex/ECMAScript/
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this box to disable the Find by Regular Expression dialog box from opening each

time the action is used, which is useful when the same settings are used consistently.
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9.12.8 Print Document

 Print Document

The Print Document action is used to print input documents. It contains the following customizable

parameters:

Figure 1. Print Document Action Options

· Details about the current printer and paper size are displayed in the upper section

of the action.

· Enter the desired number of copies in the Copies number box and select the Collate

box to collate output.

· Select an option in the Duplex dropdown menu to specify the type of duplex

printing used when using this action in conjunction with printers that support duplex

printing.
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· Click All Options to view/edit all options. The Print dialog box will open, as

detailed below.

· Select the Show setup dialog while running box to launch the Print dialog box

and customize settings each time this action is used. Clear this box to disable the

Print dialog box from opening each time the action is used, which is useful when

the same settings are used consistently.

Figure 2. Print Dialog Box

· The options in the Printer section determine the printer to be used and its associated settings:

· Use the Name text box to select a printer to use.

· Use the Copies text box to determine how many copies of the document are printed.

· Select the Collate box to collate document pages. This is a useful feature when printing

multiple copies of multi-page documents. It prints entire copies of the document

together, as opposed to multiple copies of each page at a time.

· Click the Properties button to open the Properties dialog box for the selected printer.

· Click the Page Setup button to open the Page Setup dialog box and determine page

setup options, as detailed in (figure 3) below.

· The options in the Page Range section determine which pages of the document will be

printed: 

· Select All to print to all pages.

· Select Custom to print a custom page range. Further information on how to specify page

ranges is available here. 1873
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· Use the Subset option to select All Pages, Odd Pages or Even Pages as desired.

· Select the Reverse Order box to print documents in reverse numerical order.

· The options in the Pages Placement and Scaling section determine the placement and scaling

of the document:

· Use the Type menu to select a standard placement setting. When a setting is selected its

features will be shown in the preview window. Each setting has further options that

become available when the setting is selected. The effect that these have will be shown in

the preview window when they are adjusted.

· Use the Page Zoom number box to determine the level of zoom on the page. Select the

check boxes to enable further settings.

· The options in the Advanced Print Options tab determine advanced printing options: 

· Use the Print menu to determine which elements of the document are printed. Click

More for further options, as detailed in (figure 4) below.

· Select the Print as Image box to print the selected pages as images.

· When the desired parameters have been selected, click Print to print the document.

Figure 3. Page Setup Dialog Box

· Select a size for the document from the Size menu.

· Select a source for the document from the Source menu.

· Use the option buttons to select either Portrait or Landscape as the orientation for the

document.
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· Click OK to apply changes.

Figure 4. Advanced Print Options Dialog Box

· Use the Print Content Options to determine printed document content.

· Use the Rendering Options to determine how documents are rendered:

· Use the Color Override dropdown menu to determine color override options:

· Auto permits PDF-XChange Editor to select the color override setting. 

· Grayscale prints documents in grayscale.

· Monochrome prints documents in monochrome.

· Color prints documents in color.

· Use the Text Rendering Mode dropdown menu to determine how text is rendered:
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· Auto permits PDF-XChange Editor to select the text rendering mode. Additionally,

it should be noted that this option is required in order to print embedded fonts.

· Outline for Embedded Fonts prints embedded fonts as outlines, which are vector

images.

· Outline Always prints all fonts as outlines.

· Bitmap for Embedded Fonts prints embedded fonts as bitmap images.

· Bitmap Always prints all fonts as bitmap images.

· Use the Maximum Resolution for Images dropdown menu to set the maximum

resolution of images in printed documents.

· Use the Resolution for Gradient Fills dropdown menu to determine the resolution used

for gradient fills.

· Select the Ignore check boxes as desired.

Click OK to save changes.
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9.12.9 Run Application

 Run Application

The Run Application action is used to launch third-party applications via the command line. It contains

the following customizable parameters:

Figure 1. Run Application Action Options

· Click the ellipsis icon on the right side of the Choose application text box to select

the application that you want to launch from the command line.

· Select the Wait for application to launch box to wait for applications to launch

completely before executing the command line. This option is necessary only in

cases of applications that require a large amount of resources.

· Enter the command line that you want to use in the Parameters text box.

· Select the Place input file names to list box to add the names of files used to a list

that is sent to the application specified in the Choose application text box.
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Click OK to save changes.
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10 Default Tools

 Default Tools 

There are seventy-seven Default Tools in PDF-Tools. They are grouped into eleven

categories:

 The Create PDF  tools are used to create PDF documents.

 The Pages  tools are used to edit and enhance document pages.

 The Links  tools are used to create/delete links and weblinks.

 The Forms  tools are used to import/export or delete forms and form data.

 The Comments  tools are used to import/export, remove, summarize and

flatten comments.

 The Bookmarks  tools are used to create, import, export and build tables of

contents from bookmarks.

 The Protection  tools are used to add (or clear) digital signature fields,

password protection and timestamps to documents.

 The Optimize  tools are used to enhance scanned pages and optimize the size

of documents.

 The PDF Standard  tools convert PDF documents to/from PDF subsets such as

PDF/A and PDF/X.

 The Export PDF  tools convert PDF documents to different formats, such as MS

Office and image formats.

 The Advanced  tools are used to change document properties and print or

email documents.

Note that the Clone Tool  or Create Tool  features can be used to edit and enhance the

functionality of tools in order to meet complex requirements.
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10.1 Create PDF Tools

 Create PDF Tools 

The Create PDF tools are used to create PDF documents:

 Convert Files to PDFs  converts files to PDF.

 Create PDF from Images  creates PDF files from raster images.

 Create PDF from Text  creates PDF files from text files.

 Create PDF Portfolio  creates PDF portfolio files from source documents.

 Extract Pages  extracts specified pages of PDF documents.

 Scan to PDF  uses the local scanner to create PDF files.

 Split/Merge PDFs  splits single PDF documents into multiple files or merges multiple PDF

documents into a single file.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.1.1 Convert Files to PDFs

 Convert files to PDFs

The Convert Files to PDFs tool converts files to PDF:

Figure 1. Convert Files to PDFs Tool Actions Sequence

The Convert Files to PDFs tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Convert Files to PDF  - the source documents are converted to PDF.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330

1315
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10.1.2 Create PDF from Images

 Create PDF from Images

The Create PDF from Images tool creates PDF files from raster images:

Figure 1. Create PDF from Images Tool Actions Sequence

The Create PDF from Images tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Create PDF from Images  - raster images are identified and saved in a new PDF file.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

1395

1348

1577

1403

1410



1611

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Default Tools

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330
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10.1.3 Create PDF from Text

 Create PDF from Text

The Create PDF from Text tool creates PDF files from text files:

Figure 1. Create PDF from Text Tool Actions Sequence

The Create PDF from Text tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for plain text (*.txt) source documents. 

2.  Create PDF from Text  - the documents are converted to PDF format.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

1395

1355

1577

1403

1410



1613

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Default Tools

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330
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10.1.4 Create PDF Portfolio

  Create PDF Portfolio

The Create PDF Portfolio tool creates PDF portfolio files:

Figure 1. Create PDF Portfolio Tool Actions Sequence

The Create PDF Portfolio tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Create PDF Portfolio  - the documents are combined into a PDF portfolio file.

3.  Save Documents  - the document is saved.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.1.5 Extract Pages

 Extract Pages

The Extract Pages tool extracts specified pages from PDF documents and saves them as a

new file:

Figure 1. Extract Pages Tool Actions Sequence

The Extract Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Extract Pages  - document pages are specified, extracted and converted to PDF.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.1.6 Scan to PDF

  Scan to PDF

The Scan to PDF tool uses the local scanner to create PDF files:

Figure 1. Scan to PDF Tool Actions Sequence

The Scan to PDF tool uses six tool actions:

1.  Get Images From Scanner  - images are sourced from the local scanner.

2.  Create PDF from Images  - raster images are identified and saved in a new

PDF file.

3.  OCR Pages  (skipped by default) - optical character recognition is performed on the

scanned documents.

4.  Change Document Properties  (skipped by default) - the document properties are

changed.
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5.  Save Documents  - the updated documents are saved.

6.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.1.7 Split/Merge PDFs

 Split/Merge PDFs

The Split/Merge PDFs tool splits single PDF documents into multiple files or merges

multiple PDF documents into a single file:

Figure 1. Split/Merge PDFs Tool Actions Sequence

The Split/Merge PDFs tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Split/Merge Documents  - a single PDF document is split into multiple documents, or

multiple PDF documents are merged into a single document.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2 Pages Tools

 Pages Tools 

The Pages tools are used to edit and enhance document pages:

 Add Bates Numbering  inserts Bates numbering to input documents.

 Add Header and Footer  inserts headers and footers into input documents.

 Add Watermark  inserts watermarks into input documents.

 Crop Pages  adjusts document dimensions, white margins and page boxes in

input documents.

 Delete Pages  deletes pages from input documents.

 Duplicate Pages  duplicates pages of input documents.

 Import as Layer Overlay  uses an existing file to overlay documents.

 Insert Empty Pages  inserts empty pages into input documents.

 Insert Pages  inserts pages from existing documents into input documents.

 Merge Pages  merges pages into a single page.

 Move Pages  reorders pages within PDF documents.

 OCR Pages  performs optical character recognition on input documents.

 Overlay PDF  overlays input documents with existing files.

Rasterize Pages  rasterizes the pages of input documents.

 Remove Bates Numbering  removes Bates numbering from input documents.

 Remove Headers and Footers  removes headers and footers from input

documents.

 Remove Page Background  removes backgrounds from input documents.

 Remove Watermarks  removes watermarks from input documents.

 Replace Pages  replaces specified pages of input documents with pages from

existing documents.
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 Resize Pages  resizes specified pages of input documents.

 Rotate Pages  rotates specified pages of input documents.

 Set Page Transitions  determines the animated effect when moving between

document pages in fullscreen mode.

 Set Pages Background  changes the background of input documents.

 Split Pages  splits the pages of input documents into custom sections.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.2.1 Add Bates Numbering

 Add Bates Numbering

The Add Bates Numbering tool inserts Bates numbering into input documents. Bates

numbering is a dynamic way to provide identification, protection and automatic consecutive

numbering within documents as they are processed/scanned. Further information on Bates

numbering is available here.

Figure 1. Add Bates Numbering Tool Actions Sequence

The Add Bates Numbering tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Add Bates Numbering  - Bates numbering is inserted into the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.2 Add Header and Footer

 Add Header and Footer

The Add Header and Footer tool adds headers and footers to input documents:

Figure 1. Add Header and Footer Tool Actions Sequence

The Add Header and Footer tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Add Header and Footer  - headers and/or footers are added to the documents. 

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.3 Add Watermark

 Add Watermark

The Add Watermark tool inserts watermarks into input documents:

Figure 1. Add Watermark Tool Actions Sequence

The Add Watermark tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Add Watermarks  - watermarks are added to the documents. 

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.4 Crop Pages

Crop Pages

The Crop Pages tool adjusts document dimensions, white margins and page boxes in input

documents:

Figure 1. Crop Pages Tool Actions Sequence

The Crop Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Crop Pages  - the document dimensions, white margins and/or page boxes are

adjusted. 

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.5 Delete Pages

 Delete Pages

The Delete Pages tool deletes pages from input documents:

Figure 1. Delete Pages Tool Actions Sequence

The Delete Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Delete Pages  - specified pages of the documents are deleted.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.6 Duplicate Pages

 Duplicate Pages

The Duplicate Pages tool duplicates pages of input documents:

Figure 1. Duplicate Pages Tool Actions Sequence

The Duplicate Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Duplicate Pages  - specified document pages are duplicated.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.7 Import as Layer Overlay

 Import as Layer Overlay

The Import as Layer Overlay tool uses an existing file to overlay documents:

Figure 1. Insert Empty Pages Tool Actions Sequence

The Insert As Layer Overlay tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Import as Layer Overlay  - the document pages are overlaid with pages from the

source file.

3.  Save Documents  - the updated documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.2.8 Insert Empty Pages

 Insert Empty Pages

The Insert Empty Pages tool inserts empty pages into input documents:

Figure 1. Insert Empty Pages Tool Actions Sequence

The Insert Empty Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Insert Empty Pages  - empty pages are inserted into the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.9 Insert Pages

  Insert Pages

The Insert Pages tool inserts pages from existing documents into input documents:

Figure 1. Insert Pages Tool Actions Sequence

The Insert Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Insert Pages  - existing document pages are specified and inserted into the

source documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.10 Merge Pages

  Merge Pages

The Merge Pages tool merges pages into a single page:

Figure 1. Merge Pages Tool Actions Sequence

The Merge Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Merge Pages  - existing document pages are specified and inserted into the

source documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.11 Move Pages

  Move Pages

The Move Pages tool reorders document pages:

Figure 1. Move Pages Tool Actions Sequence

The Merge Pages tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Move Pages  - existing document pages are specified and moved to a new

document location.

3.  Save Documents  - the updated documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.2.12 OCR Pages

OCR Pages

The OCR Pages tool performs optical character recognition on input documents:

Figure 1. OCR Pages Tool Actions Sequence

The OCR Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  OCR Pages  - optical character recognition is performed on the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

1395

1499

1577

1403

1410



1647

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Default Tools

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.13 Overlay PDF

 Overlay PDF

The Overlay PDF tool overlays input documents with existing files:

Figure 1. Overlay PDF Tool Actions Sequence

The OCR Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Overlay PDF  - existing files are used to overlay the source documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

1395

1504

1577

1403

1410



1649

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Default Tools

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.14 Rasterize Pages

 Rasterize Pages

The Rasterize Pages tool rasterizes document pages:

Figure 1. Rasterize Pages Tool Actions Sequence

The OCR Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Rasterize Pages  - the specified document pages are rasterized.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.15 Remove Bates Numbering

 Remove Bates Numbering

The Remove Bates Numbering tool removes Bates numbering from input documents:

Figure 1. Remove Bates Numbering Tool Actions Sequence

The Remove Bates Numbering tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Remove Bates Numbering  - Bates numbering is removed from the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.16 Remove Headers and Footers

 Remove Headers and Footers

The Remove Headers and Footers tool removes headers and footers from input

documents:

Figure 1. Remove Headers and Footers Tool Actions Sequence

The Remove Headers and Footers tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Remove Headers and Footers  - headers and footers are removed from the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.17 Remove Pages Background

 Remove Pages Background

The Remove Pages Background tool removes backgrounds from input documents:

Figure 1. Remove Pages Background Tool Actions Sequence

The Remove Pages Background tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Remove Pages Background  - backgrounds are removed from the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.18 Remove Watermarks

 Remove Watermarks

The Remove Watermarks tool removes watermarks from input documents:

Figure 1. Remove Watermarks Tool Actions Sequence

The Remove Watermarks tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Remove Watermarks  - watermarks are removed from the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.19 Replace Pages

 Replace Pages

The Replace Pages tool replaces specified pages of input documents with pages from

existing documents:

Figure 1. Replace Pages Tool Actions Sequence

The Replace Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Replace Pages  - specified document pages are replaced with pages from

existing documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.20 Resize Pages

 Resize Pages

The Resize Pages tool resizes specified pages of input documents:

Figure 1. Resize Pages Tool Actions Sequence

The Resize Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Resize Pages  - specified document pages are resized.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.21 Rotate Pages

 Rotate Pages

The Rotate Pages tool rotates specified pages of input documents:

Figure 1. Rotate Pages Tool Actions Sequence

The Rotate Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Rotate Pages  - specified document pages are rotated.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.22 Set Page Transitions

 Set Page Transitions

The Set Page Transitions tool determines the animated effect when moving between

document pages in fullscreen mode:

Figure 1. Set Page Transitions Tool Actions Sequence

The Set Page Transitions tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Setup Page Transitions  - page transitions are determined for the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.23 Set Pages Background

  Set Pages Background

The Set Pages Background tool changes the background of input documents:

Figure 1. Set Pages Background Tool Actions Sequence

The Set Pages Background tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Change Page Background  - backgrounds are added/edited for the

documents. 

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.2.24 Split Pages

 Split Pages

The Split Pages tool splits the pages of input documents into custom sections:

Figure 1. Split Pages Tool Actions Sequence

The Split Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Split Pages  - the documents are split into custom sections.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.3 Links Tools

 Links Tools 

The Links tools are used to create/delete links and weblinks:

 Create Weblinks  creates weblinks from the text of input documents:

 Delete Links  deletes weblinks from input documents:

 Delete Weblinks  deletes weblinks from input documents:

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.3.1 Create Weblinks

 Create Weblinks

The Create Weblinks tool creates weblinks from the text of input documents:

Figure 1. Create Weblinks Tool Actions Sequence

The Create Weblinks tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Create Weblinks  - weblinks are created from specified text in the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.3.2 Delete Links

 Delete Links

The Delete Links tool deletes links from input documents:

Figure 1. Delete Links Tool Actions Sequence

The Delete Links tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Delete Links  - all links are deleted from specified pages in the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.3.3 Delete Weblinks

 Delete Weblinks

The Delete Weblinks tool deletes weblinks from input documents:

Figure 1. Delete Weblinks Tool Actions Sequence

The Delete Weblinks tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Delete Weblinks  - all weblinks are deleted from specified pages in the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.4 Forms Tools

 Forms Tools 

The Forms tools are used to import/export or delete forms and form data:

 Delete Form Fields  deletes form fields from input documents:

 Export Form Data  exports form data from documents to a file.

 Import Form Data  imports form data from a file.

 Reset Forms  removes all form data from input documents.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.4.1 Delete Form Fields

 Delete Form Fields

The Delete Form Fields tool deletes form fields from input documents:

Figure 1. Delete Form Fields Tool Actions Sequence

The Delete Form Fields tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Delete Form Fields  - all form fields are deleted from specified pages in the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.4.2 Export Form Data

 Export Form Data

The Export Form Data tool exports form data from documents to file:

Figure 1. Export Form Data Tool Actions Sequence

The Export Form Data tool uses three tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Export Form Data  - form data from the documents is exported.

3.  Show Files  - the file that contains the exported form data is highlighted in its folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.4.3 Import Form Data

 Import Form Data

The Import Form Data tool imports form data into documents:

Figure 1. Import Form Tool Actions Sequence

The Import Form tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Import Form Data  - form data is imported into the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.4.4 Reset Forms

 Reset Forms

The Reset Forms tool resets form data in documents:

Figure 1. Reset Forms Tool Actions Sequence

The Reset Forms tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Reset Form  - form data in the documents is reset.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.5 Comments Tools

 Comments Tools 

The Comments tools are used to edit and manipulate the comments of input documents:

 Delete All Comments  deletes comments of all formats from input documents.

 Delete Markup Annotations  deletes markup annotations from input documents.

 Export Comments  exports comments from input documents.

 Flatten Comments and Fields  flattens comments and form fields in input documents.

 Import Comments  imports comments into input documents.

 Summarize Comments  creates a summary of the comments in input documents.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.5.1 Delete All Comments

 Delete All Comments

The Delete All Comments tool deletes comments from input documents:

Figure 1. Delete All Comments Tool Actions Sequence

The Delete All Comments tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Delete All Comments  - all comments are deleted from specified pages in

the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.5.2 Delete Markup Annotations

 Delete Markup Annotations

The Delete Markup Annotations tool deletes markup annotations from input documents:

Figure 1. Delete Markup Annotations Tool Actions Sequence

The Delete Markup Annotations tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Delete Markup Annotations  - all markup annotations are deleted from

specified pages in the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.5.3 Export Comments

 Export Comments

The Export Comments tool exports comments from input documents:

Figure 1. Export Comments Tool Actions Sequence

The Export Comments tool uses three tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Export Comments  - comments are exported from the documents.

3.  Show Files  - the document that contains the exported comments is displayed in its

destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.5.4 Flatten Comments and Fields

 Flatten Comments and Fields

The Flatten Comments and Fields tool flattens the comments and form fields of input

documents into base content:

Figure 1. Flatten Comments and Fields Tool Actions Sequence

The Flatten Comments tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Flatten Comments and Fields  - the comments and form fields of input

documents are flattened into base content.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.5.5 Import Comments

 Import Comments

The Import Comments tool imports comments into input documents.:

Figure 1. Import Comments Tool Actions Sequence

The Import Comments tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Import Comments  - comments are imported into the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.5.6 Summarize Comments

  Summarize Comments

The Summarize Comments tool creates a summary of comments in input documents:

Figure 1. Summarize Comments Tool Actions Sequence

The Flatten Comments tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Summarize Comments  - a summary is created from document comments.

3.  Save Documents  - the updated documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.6 Bookmarks Tools

 Bookmarks Tools 

The Boomarks tools are used to create, import, export and manipulate bookmarks:

 Build Table of Contents  uses bookmarks to create a table of contents for input

documents.

 Export Bookmarks  creates a copy of the bookmarks in input documents and then saves

them to file.

 Export Bookmarks to Text File  creates a copy of the bookmarks in input documents and

then saves them to a plain text (*.txt) file.

 Find and Replace Bookmark Text  finds and replaces text in bookmark titles.

 Generate Bookmarks from Page Text  creates bookmarks from the text of input

documents.

 Import Bookmarks  imports bookmarks into documents.

 Import Bookmarks from Text File  imports bookmarks from a text file into documents.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.6.1 Build Table of Contents

 Build Table of Contents

The Build Table of Contents tool uses bookmarks to create a table of contents for input

documents:

Figure 1. Build Table of Contents Tool Actions Sequence

The Build Table of Contents tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Build Table of Contents  - a table of contents is created from document bookmarks.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.6.2 Export Bookmarks

 Export Bookmarks

The Export Bookmarks tool creates a copy of bookmarks in input documents and saves

them to a new file:

Figure 1. Export Bookmarks Tool Actions Sequence

The Export Bookmarks tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Export Bookmarks  - a copy of document bookmarks is created.

3.  Save Documents  - the new documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.6.3 Export Bookmarks to Text File

 Export Bookmarks to Text File

The Export Bookmarks to Text File tool creates a copy of bookmarks in input documents

and saves them to a new text file:

Figure 1. Export Bookmarks to Text File Tool Actions Sequence

The Export Bookmarks to Text File tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Export Bookmarks to Text File  - a copy of document bookmarks is created.

3.  Save Documents  - the new documents are saved to a text file.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.6.4 Find and Replace Bookmark Text

 Find and Replace Bookmark Text

The Find and Replace Bookmark Text tool finds and replaces text in bookmark titles:

Figure 1. Find and Replace Bookmark Text Tool Actions Sequence

The Find and Replace Bookmark Text tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Find and Replace Bookmark Text  - the specified terms are searched for and replaced.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the new documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.6.5 Generate Bookmarks from Page Text

 Generate Bookmarks from Page Text

The Generate Bookmarks from Page Text tool creates bookmarks from the text of input

documents:

Figure 1. Generate Bookmarks from Page Text Tool Actions Sequence

The Generate Bookmarks from Page Text tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Generate Bookmarks from Page Text  - bookmarks are generated from specified

document text.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.6.6 Import Bookmarks

 Import Bookmarks

The Import Bookmarks tool imports bookmarks into documents:

Figure 1. Import Bookmarks Tool Actions Sequence

The Import Bookmarks tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Import Bookmarks  - bookmarks are imported into the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

1395

1432

1577

1403

1410



1713

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Default Tools

Click actions to view customizable parameters. Note that the Export Bookmarks  tool can be used

to export bookmarks to use in conjunction with this tool.

Additionally, please note that the Clone Tool  feature can be used to clone this tool and then

add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.6.7 Import Bookmarks from Text File

 Import Bookmarks from Text File

The Import Bookmarks from Text File tool imports bookmarks from text files into

documents:

Figure 1. Import Bookmarks from Text File Tool Actions Sequence

The Import Bookmarks from Text File tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Import Bookmarks from Text File  - bookmarks are imported from text files into the

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.7 Protection Tools

 Protection Tools 

The Protection tools are used to add/remove digital signatures, certified signature fields,

timestamps and passwords to input documents, as well as to sanitize/redact their content:

 Apply Redaction  removes content that has been marked for redaction from

documents.

 Certify PDFs  adds certified signature fields to input documents.

 Clear All Digital Signatures  removes digital signatures from input documents.

 Find and Redact  searches for specific words or patterns (phone numbers, credit card

numbers, social security numbers, emails or dates) in documents and then either marks them for

redaction or redacts them immediately.

 Sanitize Document  removes sensitive information from input documents.

 Secure PDF  adds password security to input documents.

 Sign Document  uses a certificate-based digital ID to add and sign signature fields in

input documents.

 Timestamp PDFs  adds document-level time stamps to input documents.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.7.1 Apply Redaction

 Apply Redaction

The Apply Redaction tool removes content that has been marked for redaction from

documents:

Figure 1. Apply Redaction Tool Actions Sequence

The Apply Redaction tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Apply Redaction  - content that has been marked for redaction is removed from

documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.7.2 Certify PDFs

Certify PDFs

The Certify PDFs tool adds certified signature fields to input documents:

Figure 1. Certify PDFs Tool Actions Sequence

The Certify PDFs tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Certify Document  - certified signature fields are added to the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.7.3 Clear All Digital Signatures

 Clear All Digital Signatures

The Clear All Digital Signatures tool removes digital signatures from input documents:

Figure 1. Clear All Digital Signatures Tool Actions Sequence

The Clear All Digital Signatures tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Clear Digital Signatures  - digital signatures are removed from the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.7.4 Find and Redact

 Find and Redact

The Find and Redact tool searches for specific words or patterns (phone numbers, credit

card numbers, social security numbers, emails or dates) in documents and then either marks

them for redaction or redacts them immediately:

Figure 1. Find and Redact Tool Actions Sequence

The Find and Redact tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Find and Redact  - the specified words/patterns are located and marked for redaction

(or redacted immediately).

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.7.5 Sanitize Document

 Sanitize Document

The Sanitize Document tool removes sensitive information from input documents:

Figure 1. Sanitize Document Tool Actions Sequence

The Sanitize Document tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Sanitize Document  - the input documents are sanitized.

3.  Save Documents  - the updated documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.7.6 Secure PDF

 Secure PDF

The Secure PDF tool adds password security to input documents:

Figure 1. Secure PDF Tool Actions Sequence

The Secure PDF tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Secure Document  - password security is added to the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.7.7 Sign Document

 Sign Document

The Sign Document tool uses a certificate-based digital ID to add and sign signature fields

in input documents:

Figure 1. Sign Document Tool Actions Sequence

The Sign Document tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Sign Document  - digital signatures are added to the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.7.8 Timestamp PDFs

 Timestamp PDFs

The Timestamp PDFs tool adds document-level time stamps to input documents and saves

them as a new file:

Figure 1. Timestamp PDFs Tool Actions Sequence

The Timestamp PDFs tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Add Timestamp  - document-level timestamps are added to the documents.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.8 Optimize PDF Tools

  Optimize PDF Tools 

The Optimize PDF tools are used to enhance and optimize input files:

 Enhance Scanned Pages  enhances scanned images in input documents to improve

quality and reduce the file size.

 Optimize PDF  optimizes the content of input documents in order to reduce the file size.

 Recompress Images  recompresses document images. 

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.8.1 Enhance Scanned Pages

 Enhance Scanned Pages

The Enhance Scanned Pages tool enhances scanned images in input documents to improve

their quality and reduce the file size:

Figure 1. Enhance Scanner Pages Tool Actions Sequence

The Enhance Scanned Pages tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Enhance Scanned Pages  - the document images are enhanced and the file size is

reduced.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.
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4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.8.2 Optimize PDF

 Optimize PDF

The Optimize PDF tool optimizes the content of input documents in order to reduce the file

size:

Figure 1. Optimize PDF Tool Actions Sequence

The Optimize PDF tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Optimize Document  - the documents are optimized.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.
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4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.8.3 Recompress Images

 Recompress Images

The Recompress Images tool recompresses document images:

Figure 1. Recompress Images Tool Actions Sequence

The Recompress Images tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Recompress Images  - the document images are recompressed.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.
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5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.9 PDF Standard Tools

 PDF Standard Tools 

The PDF Standard tools make input documents compliant with alternative PDF standards:

 Convert to PDF/A  makes documents compliant with the PDF/A standard,

which is used for long-term archiving.

 Convert to PDF/X  makes documents compliant with the PDF/X standard,

which is used to exchange printing data.

 Discard Special PDF-Standard  discards special PDF standard information from

documents such as PDF/X, PDF/A and PDF/E information.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.9.1 Convert to PDF/A

 Convert to PDF/A

The Convert to PDF/A tool makes documents compliant with the PDF/A format, which is

used for long-term archiving:

Figure 1. Convert to PDF/A Tool Actions Sequence

The Convert to PDF/A tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Convert to PDF/A  - the documents are made compliant with the PDF/A format.

3.  Save Documents  - the updated documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.9.2 Convert to PDF/X

 Convert to PDF/X

The Convert to PDF/X tool makes documents compliant with the PDF/X format, which is

used to exchange printing data:

Figure 1. Convert to PDF/X Tool Actions Sequence

The Convert to PDF/X tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Convert to PDF/X  - the documents are made compliant with the PDF/A format.

3.  Save Documents  - the updated documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.9.3 Discard Special PDF-Standard

Discard Special PDF-Standard

The Discard Special PDF-Standard tool discards special PDF-standard information from

documents such as PDF/X, PDF/A and PDF/E information:

Figure 1. Discard Special PDF-Standard Tool Actions Sequence

The Discard Special PDF-Standard tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Discard Special PDF-Standard  - special PDF-standard information is discarded from

the documents.

3.  Save Documents  - the updated documents are saved.
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4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.10 Export PDF Tools

 Export PDF Tools

The Export PDF tools copy and convert PDF documents/images to alternative formats:

 Export PDF to Audio  copies text in PDF documents and exports them to audio

file format.

 Export PDF to Images  copies PDF documents and converts them to raster

images.

 Export PDF to Microsoft Excel Spreadsheet  copies PDF documents and

converts them to Microsoft Excel (.xlsx) format.

 Export PDF to Microsoft Powerpoint Presentation  copies PDF documents

and converts them to Microsoft Powerpoint Presentation (*.pptx) format.

 Export PDF to Microsoft Word Document  copies PDF documents and

converts them to Microsoft Word (.docx) format.

 Export PDF to Plain Text  copies PDF documents and converts them to plain

text (*.txt) format.

 Extract Images from PDF  copies images in PDF documents and saves them to

a new file.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.10.1 Export PDF to Audio

 Export PDF to Audio

The Export PDF to Audio tool exports a copy text in PDF documents to audio file format:

Figure 1. Export PDF to Audio Tool Actions Sequence

The Export PDF to Images tool uses three tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  PDF to Audio  - the text in source documents is copied and exported to audio format.

3.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Note that it is necessary to have Media Foundation installed on the local machine for this tool to

operate, as detailed here.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.10.2 Export PDF to Images

 Export PDF to Images

The Export PDF to Images tool copies PDF documents and converts them to raster images:

Figure 1. Export PDF to Images Tool Actions Sequence

The Export PDF to Images tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Export PDF to Images  - the documents are copied to image format.

3.  Save Documents  - the new documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.
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10.10.3 Export PDF to Microsoft Excel Spreadsheet

 Export PDF to Microsoft Excel Spreadsheet

The Export PDF to Microsoft Excel Spreadsheet tool copies PDF documents and converts

them to Microsoft Excel (.xlsx) format:

Figure 1. Export PDF to Microsoft Excel Spreadsheet Tool Actions Sequence

The Export PDF to Microsoft Excel Spreadsheet tool uses three tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Export PDF to Microsoft Excel Spreadsheet  - the documents are copied to Microsoft

Excel (.xlsx) format and saved.

3.  Show Files  - the new documents are displayed in their destination folder.
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Please note that MS Office must be installed on the local computer for this feature to operate, and

Save As XPS functionality must be available in the version of MS Office being used. This functionality

was added in MS Office 2007.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330
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10.10.4 Export PDF to Microsoft Powerpoint Presentation

 Export PDF to Microsoft Powerpoint Presentation

The Export PDF to Microsoft Powerpoint Presentation tool copies PDF documents and

converts them to Microsoft Powerpoint Presentation (*.pptx) format:

Figure 1. Export PDF to Microsoft Powerpoint Presentation Tool Actions Sequence

The Export PDF to Microsoft Powerpoint Presentation tool uses three tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Export PDF to Microsoft Powerpoint Presentation  - the documents are copied to

Microsoft Powerpoint Presentation (*.pptx) format and saved.

3.  Show Files  - the new documents are displayed in their destination folder.

1395

1376

1410
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Please note that MS Office must be installed on the local computer for this feature to operate, and

Save As XPS functionality must be available in the version of MS Office being used. This functionality

was added in MS Office 2007.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330

1315
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10.10.5 Export PDF to Microsoft Word Document

 Export PDF to Microsoft Word Document

The Export PDF to Microsoft Word Document tool copies PDF documents and converts

them to Microsoft Word (.docx) format:

Figure 1. Export PDF to Microsoft Word Document Tool Actions Sequence

The Export PDF to Microsoft Word Document tool uses three tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Export PDF to Microsoft Word Document  - the documents are copied to Microsoft

Word (.docx) format and saved.

3.  Show Files  - the new documents are displayed in their destination folder.

1395

1381

1410
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Please note that MS Office must be installed on the local computer for this feature to operate, and

Save As XPS functionality must be available in the version of MS Office being used. This functionality

was added in MS Office 2007.

Note that files exported to (*.docx) format are compatible with MS Word 2010 and later.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330

1315



1758

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Default Tools

10.10.6 Export PDF to Plain Text

 Export PDF to Plain Text

The Export PDF to Plain Text tool copies PDF documents and converts them to plain text

(*.txt) format:

Figure 1. Export PDF to Pain Text Tool Actions Sequence

The Export PDF to Plain Text tool uses three tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Export PDF to Plain Text  - the documents are copied to plain text (*.txt) format and

saved.

3.  Show Files  - the new documents are displayed in their destination folder.

1395

1381

1410
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330

1315
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10.10.7 Extract Images from PDF

 Extract Images from PDF

The Extract Images from PDF tool copies images in PDF documents and saves them to a

new file:

Figure 1. Extract Images from PDF Tool Actions Sequence

The Extract Images from PDF tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents.

2.  Extract Images from PDF  - all images are extracted from the documents.

3.  Save Images  - the images are saved to file.

4.  Show Files  - the new documents are displayed in their destination folder.

1395

1389
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330

1315
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10.11 Advanced Tools

 Advanced Tools

The Advanced Tools tools are used to email or change the properties of input documents:

 Change Document Properties  is used to edit document properties.

 Convert Colors  converts colors in input documents.

 Extract Attachments  extracts attachments from documents.

 Print Document  is used to print input documents.

 Send E-Mail  sends output documents/images via the user's desktop email client.

Note that the Clone Tool  and Create Tool  features can be used to enhance the functionality of

existing tools/create new tools in order to meet complex requirements.
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10.11.1 Change Document Properties

  Change Document Properties

The Change Document Properties tool is used to edit the properties of input documents:

Figure 1. Change Document Properties Tool Actions Sequence

The Change Document Properties tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Change Document Properties  - the document properties are changed.

3.  Save Documents  - the updated documents are saved.

4.  Show Files  - the new documents are displayed in their destination folder.

1395
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Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here.

1330

1315
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10.11.2 Convert Colors

  Convert Colors

The Convert Colors tool is used to convert colors in input documents:

Figure 1. Convert Colors Tool Actions Sequence

The Convert Colors tool uses five tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Convert Colors  - the colors in the document are converted.

3.  Change Document Properties  (skipped by default) - the document properties are

changed.

4.  Save Documents  - the updated documents are saved.

5.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.11.3 Extract Attachments

  Extract Attachments

The Extract Attachments tool is used to extract attachments from documents:

Figure 1. Extract Attachments Tool Actions Sequence

The Extract Attachments tool uses four tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Extract Attachments  - attachments are extracted from the documents.

3.  Save Documents  - the attachments are saved as new documents.

4.  Show Files  - the new documents are displayed in their destination folder.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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10.11.4 Print Document

  Print Document

The Print Document tool is used to print input documents:

Figure 1. Print Document Tool Actions Sequence

The Print Document tool uses two tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Print Document  - the documents are printed.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

1395

1599
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Information about the Batch Processing Mode, and Multi-Threaded Processing check boxes is

available here. 1315
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10.11.5 Send E-Mail

  Send E-Mail

The Send E-Mail tool is used to email documents:

Figure 1. Send E-Mail Tool Actions Sequence

The Send E-Mail tool uses two tool actions:

1.  Choose Input Files  - the tool prompts for source documents. 

2.  Send Mail  - the documents are emailed.

Click actions to view customizable parameters. Additionally, please note that the Clone Tool  feature

can be used to clone this tool and then add/remove actions from the Tool Actions Sequence.

1395
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Information about the Batch Processing Mode and Multi-Threaded Processing check boxes is

available here. 1315
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11 Appendix

 Appendix

The following chapters detail additional information relating to the settings and functions

within PDF-Tools. They are outlined below:

· Available File Filters  - further information about file filters and what they mean.

· Command Line Options  - a list of the available command line options that can

be used in conjunction with PDF-Tools.

· Crop Margins  - a detailed explanation relating to the cropping of margins,

including definitions of the various box features involved.

· Features added in Version 10  - details all features added in version 10 of PDF-

Tools.

· Font and Paragraph Options  - further information about font and paragraph

parameters.

· Macros  - an explanation of what macros are and how they are used.

· Page Range Options  - further details and options that relate to page ranges. 

· Preferences  - customizable options available in PDF-Tools.

· Scanner Settings  - options that relate to scanner settings.
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11.1 Available File Filters

 Available File Filters

The Available File Filters dialog box is used to determine permitted file formats in PDF-

Tools:
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Figure 1. Available File Filters Dialog Box

Click the Preset dropdown menu to select a preset mode, or select boxes in the dialog box

to specify permitted formats. The following options are available:

· All Supported Files supports all file formats.

· All Supported Images supports raster and vector images. 

· All Supported Raster Images supports only raster images. 

· All Supported Vectorial Images supports only vector images.
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· PDF Documents are documents saved in portable document format.

· XPS Documents are documents saved in the (*.xps) and (*.oxps) paper

specification formats. 

· BMP files are bitmap digital images.

· GIF files are raster graphic files that are usually animated. 

· ICO files are image files formatted for use as icons in Microsoft Windows.

· JBIG is a lossless image-compression standard that fax machines use.

· JBIG2 is an image-compression standard for bi-level images. It supports both

lossless and lossy compression. 

· PBM is a portable bitmap image format used and defined by the Netbpm Project.

· PPM is the pixmap images version of PBM.

· PGM is the grayscale version of PBM.

· TGA is a raster graphics file format.

· PCX is an image file format and the native file format of PC Paintbrush.

· DCX is a file extension for a bitmap/raster graphics file format that Multipage PCX

uses.

· PNG is a raster graphics file format that supports lossless data compression. 

· JPEG is used for photographs and other image files where the file size is necessarily

small.

· JPEG 2000 is an image compression standard and coding system with several

improvements from the original JPEG format.

· TIFF is a common format for exchanging raster graphics between application

programs.

· XDP is an XML format that allows PDF content and XFA resources to be packaged

within an XML container.

· Metafiles (*.emf;*.wmf;*.apm) are portable image formats that can contain both

vector graphics and bitmap components.

· MS Word Document is the standard document format of Microsoft Word.

· MS Excel Spreadsheet is the standard document format of Microsoft Excel.

· MS Power Point Presentation is the standard document format of Microsoft

Power Point.

· MS Visio Drawing is the standard document format of Microsoft Visio.

· Rich Text Format (*.rtf) is a proprietary document file format developed by the

Microsoft Corporation and used for cross-platform document interchange with

Microsoft products.

· Plain Text displays data in files that represent only readable characters.

Select the Create Compound Filter with All Selected Filters check box to define a

compound filter that contains all selected file types. You can then use the text boxes below

the check box to determine additional extensions that you want to include/exclude from the

custom filter.

Click OK to save settings.
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Please note that MS Office must be installed on the local computer for the MS Office

options detailed above to operate, and Save As XPS functionality must be available in the

version of MS Office being used. This functionality was added in MS Office 2007.

Also note that permitted file formats can be customized for each tool. Open the Tool

Actions Sequence for the tool, then click the Choose Input Files dropdown menu and click

the ellipsis icon to customize permitted file formats:

Figure  2. Convert Files to PDFs Tool Actions Sequence, Edit Permitted File Formats Ellipsis Highlighted
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11.2 Add Tools to the Windows Shell Menu

 Add Tools to the Windows Shell Menu

PDF-Tools contains a feature that enables you to add tools to the Windows shell menu on

the local machine, which enables direct access to specific tools via the Windows context

menu - even when PDF-Tools is not running. If you want to add a tool to the Windows shell

menu, simply open PDF-Tools and click the blue Windows icon that appears adjacent to

the tool name:

Figure 1. PDF-Tools Main Window, Windows Shell Menu Icon Highlighted

The tool will then be available in the right-click menu for files in Windows:
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Figure 2. Windows Shell Menu, Tools Added

Click tools in the menu to run them on the selected file.
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11.3 Command Line Options

 Command Line Options

The command line options listed below are available for PDF-Tools. Please note:

· If any values have spaces, backslashes or forwardslashes then the entire options list should be

enclosed in quotation marks.

· If the optionslistfile contain spaces then it must be enclosed in quotation marks.

· If a profile is specified, changes will be made to that profile. If not then the changes will apply

to the current printer's settings.

· These options are for the PDFXTools.exe executable, the default location of which is:

"C:\Program Files\Tracker Software\PDF Tools\PDFXTools.exe"

· Unless the path to PDFXTools.exe is added to the system %path% variable, the full path to

PDFXTools.exe must be specified.

· Use semicolons to delimiter options when more than one option is being used.

Formal Syntax

<anytext> means any text string.

<a>|<b> means <a> or <b>.

<filename> means full or relative path to file. When the path contains white spaces it should be

enclosed in quotation marks. For example: c:\MyDocuments\MyTestDocument.pdf should be "c:\My

Documents\My Test Document.pdf".

[expression] is the optional part of the command line. For example if the syntax

is:  /RunTool[:showui=yes|no][;showprog=yes|no][;showrep=yes|no] <ToolID> [<filename1>

[<filename2> ... <filenameN>]] then the following examples are correct:
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/RunTool imagesToPDF

/RunTool imagesToPDF "c:\picture1.png" "c:\picture2.png"

/RunTool:showprog=no imagesToPDF "c:\picture1.png" "c:\picture2.png"

Command Line Options

/DumpCategories

This command line saves identifiers of all existing tool categories to a plain text file.

Syntax

/DumpCategories <filename>

Parameters

· <filename> - is the path to the text file where identifiers of all existing tool categories will be

saved.

Example

PDFXTools.exe /DumpCategories "c:\PDF-Tools.txt"

/DumpTools 

This command line saves identifiers of all existing tools to a plain text file.

Syntax

/DumpTools <filename>

Parameters

· <filename> - is the path to the text file where identifiers of all existing tools will be saved.

Example

PDFXTools.exe /DumpTools "c:\PDF-Tools.txt"
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/ExportSettings 

This command line exports all program settings to a specified file.

Syntax

/ExportSettings <filename>

Parameters

· <filename> - is the path to the file where program settings will be saved.

Example

PDFXTools.exe /ExportSettings "c:\PDF-Tools_AppSettings.pdts"

/ExportTools 

This command line exports tools and their settings to a specified file.

Syntax

/ExportTools[:showui=no|yes|full] <filename>

Parameters

·  showui - if 'yes' is specified then the Choose Tools for Export dialog box will be displayed.

This allows users to select manually the tools to be exported.  If 'full' is specified then the main

window of the user interface will also be displayed. The default value is 'yes'.

· <filename> - is the path to the file where exported tools will be saved.

Example

PDFXTools.exe /ExportTools:showui=full "c:\PDF-Tools_Exchange.pdtex" - to export tools

via the Choose Tools for Export dialog box and display the main window of the user interface.
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/ImportSettings

This command line imports program settings/tools from a specified file.

Syntax

/ImportSettings[:showui=no|yes|full] <filename>

Parameters

· showui – if 'yes' is specified and the <filename> is a path to a PDF-Tools export file then the

Choose Tools for Import dialog box will be displayed. This allows users to select manually the

tools to be imported. (If settings are being imported then the import will take place without a

dialog box).  If 'full' is specified then the main window of the user interface will be displayed,

and if the <filename> is a path to a PDF-Tools tools export file then the Choose Tools for

Import dialog box will also be displayed. The default value is 'yes'.

· <filename> - is the path to the file that contains program settings/tools. These can be created

using the /ExportSettings or /ExportTools commands (or the corresponding features in the

user interface).

Examples

PDFXTools.exe /ImportSettings "c:\PDF-Tools_AppSettings.pdts" - to import all settings from

the file "c:\PDF-Tools_AppSettings.pdts".

PDFXTools.exe /ImportSettings:showui=full "c:\PDF-Tools_Exchange.pdtex" - to display the

main window of the user interface and import tools from the file "c:\PDF-

Tools_Exchange.pdtex" via the Choose Tools for Import dialog box.

/ImportTools

This command line imports tools to PDF-Tools.

Please note that this tool is identical to the /Open and /ImportSettings command line options in

cases where the <filename> contains a path to a file that contains exported tools.

Syntax

/ImportTools[:showui[=no|yes|full]] <filename>

Parameters
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· showui – if 'yes' is specified then the Choose Tools for Import dialog box will be displayed.

This allows users to select manually the tools to be imported.  If 'full' is specified then the main

window of the user interface will also be displayed. The default value is 'yes'.

· <filename> - is the path to the file that contains previously exported tools. The /ExportTools

command (or the corresponding feature in the user interface) can be used to export tools to

file.

Examples

PDFXTools.exe  /ImportTools "c:\my-custom-tools.pdtex" - to import all tools from the file

"c:\my-custom-tools.pdtex".

PDFXTools.exe  /ImportTools:showui "c:\pdf-tools.pdtex" - to import tools from the file "c:

\pdf-tools.pdtex" via the Choose Tools for Import dialog box.

PDFXTools.exe  /ImportTools:showui=full "c:\pdf-tools.pdtex" - to import tools from the file

"c:\pdf-tools.pdtex" via the Choose Tools for Import dialog box and display the main window

of the user interface.

/Open

This command line imports tools/program settings for PDF-Tools that have been exported to file.

Syntax

/Open[:showui=no|yes|full] <filename>

Parameters

· showui - if 'yes' is specified and the <filename> is a path to a PDF-Tools export file then the

Choose Tools for Import dialog box will be displayed. This allows users to select manually the

tools to be imported.  If 'full' is specified then the main window of the user interface will be

displayed, and if the <filename> is a path to a PDF-Tools tools export file then the Choose

Tools for Import dialog box will also be displayed. The default value is 'yes'.

· <filename> - is the path to the file that contains exported tools/program settings.

The /ExportSettings or /ExportTools commands (or the corresponding features in user

interface) can be used to create these files.

Examples

PDFXTools.exe /Open "c:\my-custom-tools.pdtex" - to import all tools from the file "c:\my-

custom-tools.pdtex".



1785

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Appendix

PDFXTools.exe /Open "c:\pdf-tools-settings.pdts" - to import all program settings from the

file "c:\pdf-tools-settings.pdts".

PDFXTools.exe /Open:showui "c:\pdf-tools.pdtex" - to import tools from the file "c:\pdf-

tools.pdtex" via the Choose Tools for Import dialog box.

PDFXTools.exe /Open:showui=full "c:\pdf-tools.pdtex" - to import tools from the file "c:\pdf-

tools.pdtex" via the Choose Tools for Import dialog box and display the main window of the

user interface.

/Output

This command line specifies parameters for the output action of the tool when it runs.

Syntax

/Output[:folder=ask|source|path][;filename][;overwrite=yes|makeunique|ask|no|]

[;showfiles=yes|openfolder|no|]

Parameters

· folder - determines the output path. If 'ask' is specified then the Choose Folder dialog box will

be displayed when the tool runs. If 'source' is specified then the source folder path will be used

as the output path. If '\"<path>\"' is specified then <path> will be used as the output path. If no

value is specified then the output action will take the output path from the tool settings. If the

folder parameter is not specified then the tool settings that determine the output folder will be

used.

· filename - determines the name template for generating the names of the output files. Users

must provide the name template for this parameter as it does not have a default value. If the

filename parameter is not specified then tool settings that determine the output filename will

be used.

· overwrite - determines the action taken in cases where the output filename is already in use. If

'yes' (or no value) is specified then existing files will be overwritten with the new files. If

'makeuniq' is specified then a unique file name will be generated. If 'ask' is specified then a

dialog box for selecting an overwrite action will be displayed. If 'no' is specified then the file

will be skipped. If the overwrite parameter is not specified then the tool settings that

determine the overwrite action will be used.

· showfiles - determines whether or not the output files are displayed in their destination folder.

If 'yes' (or no value) is specified then the tool settings will be used. If 'openfolder' is specified

then the output folder will be opened and the output files will be selected. If 'no' is specified

then the output files will not be displayed. If the showfiles parameter is not specified then the

tool settings that determine the show files action will be used.
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Examples

PDFXTools.exe /RunTool imagesToPDF /Output:folder=\"D:\PDFs from

images\";filename=\"%[Date].pdf\";overwrite=makeuniq;showfiles=no - to run the Create

PDF from Images tool, save the result to the "D:\PDFs from images" path, name the output

files using the "%[Date].pdf" name template, automatically generate unique filenames and not

display the output files.

PDFXTools.exe /RunTool pdfToDOCX /Output:folder=ask;overwrite=yes;showfiles=yes - to

run the Export PDF to Microsoft Word Document tool, ask for the folder in which to save files,

overwrite existing files in cases where filenames are already in use and use tool settings to

determine the show file action.

/ResetSettings 

This command line restores all program settings to their default state.

Syntax

/ResetSettings

Parameters

There are no available parameters for this command line option.

Example

PDFXTools.exe /ResetSettings

/RunFldMon

This command line launches a folder monitor. The GUID of the folder must be used to specify it.

Syntax

/RunFldMon <FolderMonID> 

Parameters
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<FolderMonID> must be the GUID of the the folder monitor to be launched. The GUID of folder

monitors can be retrieved from the context menu of the Folder Monitors dialog box. Right-click the

dialog box to select this option.

Example

PDFXTools.exe /RunFldMon {23954F34-C10B-4819-B15B-D35631D3CD94}

/RunTool 

This command line runs the specified tool. If custom tools are used then it is necessary to specify the

GUID of the tool. (The /DumpTools command line, detailed above, can be used to create a breakdown

of all existing tools and their identifiers).

Syntax

/RunTool[:showui=yes|no][;showprog=yes|no][;showrep=always|yes|no][;sort=name|size|

mdate|cdate[,dsc]][;subfolder=yes|no] <ToolID> [<foldername> |<filename1>

[<filename2> ... <filenameN>]] [/Log[:full=yes|no][;shared] <logfilename>]

[/Output[:folder[=ask|source|\"<path>\"]][;filename=\"<name_template>\"]

[;overwrite[=ask|yes|no|makeuniq]][;showfiles=[no|yes|openfolder]]]

Parameters

· showui - if 'yes' is specified then the main window of the user interface will be displayed. The

default value is 'no'.

· showprog - if 'yes' is specified then the progress bar will be displayed. The default value is

'yes'. Please note that if showui=yes is specified then showprog=no will be ignored.

· showrep - if 'yes' is specified then the Tool Report pane will be displayed when

errors/warnings occur during the operation of tools. If 'always' is specified then the Tool

Report pane will always be displayed. The default value is 'yes'.

· showprompt - if 'no' is specified, then the setup user interface of actions will not be shown

during the tool run. The default value is 'yes'. Please note that if showui=yes is specified then

showprompt=no will be ignored.

· sort - sorts input files by name, creation date (cdate), modification date (mdate) and size.

See below for examples.

· <ToolID> - specifies the tool to run. The string that contains the GUID of the tool must be used

to identify the tool. (The /DumpTools command line, detailed above, can be used to create a

breakdown of all existing tools and their identifiers).
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· <filename1> ... <filenameN> - is an optional list of input files that the specified tool will

process. It is also possible to specify folders, in which case the tool will process all

corresponding files recursively.

· [<foldername> |<filename1> [<filename2> ... <filenameN>]] - is an optional parameter

that can be used to specify the full or relative path to a folder, or to list full or relative file

names. If the path used contains white spaces then it must be enclosed in quotation marks. For

example C:\My Documents\My Test Document.pdf must be entered as "C:\My

Documents\My Test Document.pdf".

· subfolder - if 'yes' (or an empty value) is specified then the 'Choose Input Files' action of tools

will also search for input files in the subfolders of the folder specified in the command. If 'no' is

specified then the 'Choose Input Files' action of tools will look for files only in the specified

folder and will skip all nested folders. If the 'subfolder' option is not specified then the

parameters of the 'Choose Input Files' action will be used to determine which

folders/subfolders are searched.

Examples

PDFXTools.exe /RunTool imagesToPDF

PDFXTools.exe /RunTool imagesToPDF "c:\picture1.png" "c:\picture2.png"

PDFXTools.exe /RunTool:showprog=no;showrep=no imagesToPDF "c:\picture1.png" "c:

\picture2.png"

PDFXTools.exe /RunTool:showprog=no;showrep=no imagesToPDF "c:\FolderWithPictures"

PDFXTools.exe "/RunTool:sort=size" imagesToPDF "c:\FolderWithPictures" - to run the

Create PDF from Images tool and order files from the smallest to the largest.

PDFXTools.exe "/RunTool:sort=mdate,dsc"  imagesToPDF "c:\FolderWithPictures" - to run

the Create PDF from Images tool and order files and from the most recently modified file.

/Log - creates a log when the tool runs and then writes it to file. This option has the parameter full,

which determines the messages included in the log. If 'yes' is specified then all application messages

will be written to the log. If 'no' is specified then the only default messages (errors, warnings and

summary information) will be written to the log. The /Log option has the parameter shared. If this

parameter is specified then the file specified by <logfilename> can be shared between different

instances of PDF-Tools running in command line mode at the same time.

The Tool Report settings determine the default messages included in the log. 

Examples

PDFXTools.exe /RunTool imagesToPDF /Log:full “c:\pdf-tools.log” - to run the Create PDF

from Images tool and create a full log when the tool runs.

PDFXTools.exe /RunTool imagesToPDF "c:\MyPhotos\" /Log:full=no “c:\pdf-tools.log” - to

run the Create PDF from Images tool, process all files in the folder "MyPhotos" and create a

full log when the tool runs.
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PDFXTools.exe /RunTool imagesToPDF /Log:full;shared “c:\pdf-tools.log” - to run the Create

PDF from Images tool, create a full log when the runs and make the pdf-tools.log file available

to other instances of PDF-Tools running in command line mode.
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11.4 Crop Margins

 Crop Margins

PDF documents feature up to five boxes that determine their content and appearance. They are the

Media Box, Crop Box, Bleed Box, Trim Box and Art Box:
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Figure 1. Document Boxes

PDF-Tools uses four of these boxes to determine customizable settings:

Crop Box

The Crop Box defines the region to which page contents are clipped when displayed or printed.

Programs use the dimensions of this box for screen display and printing. Unlike the other boxes, the

Crop Box has no defined meaning in terms of physical page geometry or intended use - it merely

imposes clipping on page contents. However, in the absence of additional information, the Crop Box

determines how the page contents will be positioned on the output medium. 

Bleed Box

The Bleed Box defines the region to which the contents of the page are clipped when output in a

production environment. This may include the "bleed area" needed to accommodate the physical

limitations of cutting, folding and trimming equipment. Usually the Bleed Box is three to five

millimeters larger than the Trim Box. When a page is printed it may include printing marks that fall

outside the Bleed Box. The default value of the Bleed Box is the value of the Crop Box.  

Trim Box

The Trim Box defines the intended dimensions of the finished page after trimming has taken place. As

opposed to the Crop Box, the Trim Box is very important because it defines the actual page size.

Programs use the Trim Box as the basis for positioning pages on a press sheet. The default value of the

Trim Box is the value of the Crop Box.

Art Box

The Art Box defines the extent of the page’s meaningful content (including potential white space) as

intended by the page’s creator. The default value for the Art Box is the value of the Crop Box.

See here for further information on document boxes.

https://de.wikipedia.org/wiki/Portable_Document_Format#Angaben_der_Seitengeometrie
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11.5 Features Added in Version 10

 Features Added in Version 10

The following features were added in Version 10 of PDF-Tools:

Version 10.0.0.370

· Added an 'Application Variables' option that allows users to define custom values which can

be used in all fields that support macros. Application variables can be defined in the

application preferences.

· Added 'Custom' and 'Apply Metadata Template' options to the 'Change Document

Properties' action, as detailed here.

· Added a 'Create Compound Filter with All Selected Filters' option to the 'Choose Input

Files' dialog box. This option allows users to define a compound filter that contains all selected

file types and specify additional custom file types that should be included\excluded, as

detailed here.

· Added a 'PDF-Specification' option in the application preferences that determines the PDF

specification of created documents, as detailed here.

· Added an ability to use macros in the 'Keywords' field in the 'Change Documents Properties'

action, as detailed here.

· Added 'Select only documents/pages/files that do not fulfill the criteria above' and 'Apply

OR logical operation between criteria' options to the 'Filter Document',  'Filter Pages'

and 'Filter Files'  actions.

· Added a 'Skip processing documents for which a matching value was not found' option to

the 'Find by Regular Expression'  action.

Version 10.0.0.380

· Added 'External Links' and 'Document Info' search options for the 'Filter Pages'  and

'Filter Documents'  actions.

· Added a 'showprompt' parameter for the /RunTool  Command Line option.

· Added support for the 'Append to existing document' option for text-based file types (*.csv,

*.txt, *.ptdfl).

· Added support for the '%[BatesValue]' macro in the 'Change Document Properties'  and

'Save Documents'  actions.
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Version 10.2.0.384

· Added a 'Move Pages' tool/action that enables the reordering of pages in PDF documents, as

detailed here.

· Added functionality that enables the reordering of tools in the Tool Categories section of the

UI.

1644
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11.6 Font and Paragraph Parameters

 Font and Paragraph Options

Font and paragraph options are available in many of the actions/tools in PDF-Tools:

Font Options

Figure 1. Select Font Dialog Box

· Available fonts are displayed in the pane. Click to select fonts, or enter font names in

the Font text box to search for and select fonts.

· Use the Style dropdown menu to select the font style.

· Use the Size dropdown menu to select the font size.

· Use the Fill dropdown menu to select a font color.
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· Use the Stroke dropdown menu to select the font outline color. (Please note that

the stroke color may obscure the font color at smaller sizes).

· Use the Stroke Width dropdown menu to determine the width of the stroke.

· Use the Underline dropdown menu to enable/disable an underline for the current

font.

Click OK to save settings.

Paragraph Options

Figure 2. Paragraph Options Dialog Box

· Use the Alignment dropdown menu to determine the paragraph alignment.

· Use the Indentation number boxes to determine the indentation of paragraphs from the left

and right side of the page.

· Use the Special dropdown menu to enable First Line or Hanging indentation as desired. If

either option is used then use the By number box to specify the size of the indentation.

· Use the Spacing options to determine spacing options for paragraphs as desired.

Click OK to save settings.
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11.7 Macros

 Macros

Macros are used throughout PDF-Tools. 'Macro' is an abbreviation of 'macroinstruction' - a term in

computer science for a rule that specifies how input characters should be entered to create

corresponding output. This means that components of the output process can be simplified during the

input process, which makes the work involved less intensive and more dynamic. Multiple macros can be

used simultaneously as desired. The format for macros is: 

%[<Macro Name>] or, when it is customizable: %[<Macro Name>:<Parameter>]. The

<Parameter> step is optional.

For example, the Page Number macro can be used to specify the page numbering format. The syntax

for the Page Number macro is %[Page:<Parameter>] and the following parameters are available:

· 'r' specifies the use of lower-case roman numerals - %[Page:r].

· 'R' specifies the use of upper-case roman numerals - %[Page:R].

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used - %

[Page:L].

· '<integer> specifies the minimum number of digits used. This value can be any positive

integer from 1 to 12 - for example %[Page:4] starts the page numbering as "0001, 0002,

0003...".

Macros are available when determining the filename of output documents, and also when the macro

icon is displayed:
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Figure 1. Add Watermark Dialog Box, Macro Icon Highlighted

Click the macro icon to view a list of available options, then click macros to add them to the text box.

All available macros are detailed below:

· Application Version

· Auto Number

· Bates Numbering

· Bates Page Numbering Value

· Computer Name

· Date

· Day

· Document Index

· Document Info

· Document Title

· Environment Variable,  which has multiple options relating to the environment variables

of the file.

· FileName

1799
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https://en.wikipedia.org/wiki/Environment_variable
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· File Extension

· Folder Name

· Folder Title

· Hour

· Minute

· Month

· Number of Pages

· Page Number

· Page Numbering Style

· Seconds

· Time

· Username

· Year

1832
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11.7.1 Application Version

 Application Version

The Application Version macro inserts the build and version of PDF-Tools on the local computer.

The syntax for this macro is %[AppVersion]

Example

If the macro %[AppVersion] is used to specify watermark text then the build and version of PDF-Tools

 on the local computer are inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[AppVersion] Macro Example
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11.7.2 Auto Number

 Auto Number

The Auto Number macro inserts a numerical value as the name for output files.

The syntax for this macro is %[AutoNumber] and two sections of parameters are available.

The first section determines the format of page numbers:

· 'r' specifies the use of lower-case roman numerals.

· 'R' specifies the use of upper-case roman numerals.

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used.

· '<integer> specifies the minimum number of digits displayed for page numbers. This value

can be any positive integer from 1 to 12 - for example %[Autonumber:4] starts the numbering

as "0001, 0002, 0003...".

The second section determines the offset for the start value. Note that the default offset is zero and the

default starting value is 1. This means that if, for example, you want to start from 5, then you must

specify '4'. 

Please note that a semicolon must be used to delimit the sections of parameters. If the second section

is not used then the semicolon can be omitted. However, if the first section is not used and the second

section is used then it is necessary to use the semicolon.

The syntax for this macro when both parameters are used is %[Autonumber:<Parameter

1>;<Parameter 2>]

The syntax for this macro when only the second parameter is used is %[Autonumber:;<Parameter

2>]. For example, '%[AutoNumber:;3]' sets the start value as four. 

Note that the starting value for output files depends on the files contained in the destination folder. If

the folder is empty, or does not contain files with names that match the output parameters detailed

above, then the default values are used. If the folder does contain files that match the output

parameters detailed above, then the starting value will be the lowest possible integer.
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Example

The Filename text box of Save Images  action in the Extract Images from PDF  tool is set to %

[AutoNumber]:

Figure 1. Extract Images from PDF Tool Actions Sequence, Save Images Action, %[AutoNumber] Macro Added as
Filename

Therefore the output is autonumbered when the tool is used:

1405 1760
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Figure 2. Output Folder
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11.7.3 Bates Numbering

 Bates Numbering

The Bates Numbering macro inserts the Bates numbering value of document pages and can only be

used in conjunction with the Add Bates Numbering  action/tool.

The syntax for this macro is %[Bates]

Example

If the %[Bates] macro is used then the Bates numbering value of the page is inserted:

1463
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Figure 1. %[Bates] Macro Example
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11.7.4 Bates Page Numbering Value

 Bates Page Numbering Value

The Bates Page Numbering macro inserts the existing Bates numbering value of document pages.

The syntax for this macro is %[BatesValue]

Example

If the %[BatesValue] macro is used to specify watermark text, then the Bates numbering value of

document pages is inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[BatesValue] Macro Example



1808

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Appendix

11.7.5 Computer Name

 Computer Name

The Computer Name inserts the name of the local computer as defined by the Windows Computer

Name.

The syntax for this macro is %[Computer]

Example

If the %[Computer] macro is used to specify watermark text then the name of the computer is inserted:
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Figure 1. Add Watermark Dialog Box, %[Computer] Macro Example
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11.7.6 Date

 Date

The Date macro inserts the current date. Multiple date formats are available, as detailed below.

The syntax for this macro is %[Date] and the following parameters are available:

· d inserts the day of the month and omits the zero in cases of single-digit values.

· dd inserts the day of the month and includes a zero in cases of single-digit values.

· ddd inserts the day of the week as a three-letter abbreviation.

· dddd inserts the day of the week.

· M inserts the month and omits the zero in cases of single-digit values.

· MM inserts the month and includes a zero in cases of single-digit values.

· MMM inserts the month as a three-letter abbreviation.

· MMMM inserts the month.

· yy inserts the year as two digits and adds a zero in cases of values lower than 10.

· yyyy inserts the year.

The syntax for this macro when parameters are used is %[Date:<Parameter>]

Note that several parameters can be used in sequence in order to insert a customized date. For

example, %[Date:dddd, dd MMMM yyyy] inserts the day of the week followed by the day of the

month, the month name in full and the year as four digits (as detailed below). If parameters are not

specified then output values revert to default, which is the date on the local machine in the format

dd/MM/yyy.

Example

If the macro %[Date:dddd, dd MMMM yyyy] is added as a header to documents, then the output will

be the day of the week followed by the day of the month, the month name in full and the year as four

digits:
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Figure 1. Add Header and Footer Dialog Box, %[Date] Macro Example

Note that a range of preset date formats are provided in PDF-Tools:
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Figure 2. Date Macro Preset Options
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11.7.7 Day

 Day

The Day macro inserts the current day of the month.

The syntax for this macro is %[Day]

Example

If the %[Day] macro is used to specify watermark text and the date is 15th February then the number

"15" is inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[Day] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Month]/%[Day] output the current

time followed by the month and the day of the month:
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Figure 2. %[Day] Combined Macro Example
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11.7.8 Document Index

 Document Index

The Document Index macro inserts the index value of pages, which is the input/output order of the

content in the context of a group of input/output content items.

The syntax for this macro is %[DocNumber] and a parameter is available for the specification of the

minimum amount of digits used for numbering output. This value can be any positive integer from 1 to

12. If the parameter is not used then the output is numbered with the default settings, which uses the

page number of source files as the output number.

The syntax for this macro when parameters are used is %[DocNumber:<Parameter>] - for example %

[DocNumber:4] starts the numbering as "0001, 0002, 0003...".

Example

If the %[DocNumber:4] macro is used in the Filename text box when the Export PDF to Microsoft

Excel Spreadsheet tool is used to convert multiple documents to MS Excel format, then the name of

each output file will be its order (index value) in the input sequence, and each file name will contain

four digits:

The first step is to specify the macro in the Filename text box of the Tool Actions Sequence:
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Figure 1. Export PDF to Microsoft Excel Spreadsheet Tool Actions Sequence, %[DocNumber:4] Macro Specified

The second step is to run the tool and add the desired files for conversion:
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Figure 2. Choose Input Files Dialog Box, Files Added For Conversion

After the files are converted, the name of each output file is its order (index value) in the input

sequence, and each file name will contain four digits, as specified in the macro entered during the first

step of the process:
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Figure 3. Output Files
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11.7.9 Document Info

 Document Info

The Document Info macro inserts document metadata information. 

The syntax for this macro is %[DocInfo] and the following parameters are available:

· Title inserts the data in the Document Title field.

· Author inserts the data in the Author field.

· Subject inserts the data in the Subject field.

· Keywords inserts the data in the Keywords field.

· Creator inserts the name of the application used to create the document.

· Producer inserts the PDF Producer of the document.

· CreationDate inserts the date and time when the document was created, followed by the UTC

offset.

· ModDate inserts the date and time when the document was last modified, followed by the

UTC offset.

The syntax for this macro when parameters are used is %[DocInfo:<Parameter>] - see below for

examples.

Note that the names of any standard fields from document properties can be used as parameters for

this macro. Additionally, if parameters have been specified using the JavaScript console and custom

names have been used to replace the standard names, then the custom names can be used.

Examples

If the %[DocInfo:ModDate] macro is used to create Bates Numbering, then the output specifies the

date and time that the document was last modified:

https://en.wikipedia.org/wiki/UTC_offset
https://en.wikipedia.org/wiki/UTC_offset
https://en.wikipedia.org/wiki/UTC_offset


1821

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Appendix

Figure 1. Add Bates Numbering Dialog Box, %[DocInfo] Macro Example

Alternatively, enter %[DocInfo:Title] to insert the document title:
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Figure 2. Add Bates Numbering Dialog Box, %[DocInfo] Macro Example Two

Note that it is possible to use more than one macro at a time. For example the text %[DocInfo:Title],

%[DocInfo:Author] returns both the document name and the author name:
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Figure 3. Add Bates Numbering Dialog Box, %[DocInfo] Macro Example Three
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11.7.10 Document Title

 Document Title

The Document Title macro inserts the document title. 

The syntax for the this macro is %[DocTitle]

Example

If the %[DocTitle] macro is used to specify watermark text, then the document title is inserted as a

watermark:
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Figure 1. Add Watermark Dialog Box, %[DocTitle] Macro Example
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11.7.11 Environment Variable

 Environment Variable

The Environment Variable macro inserts information taken from user-specified environment variables.

The syntax for this macro is %[Env:<Parameter>] 

Note that a parameter must be used in order for this macro to return information. The following

parameters are available:

ALLUSERSPROFILE

Inserts the full path to the All Users profile directory.

APPDATA

Inserts the full path to the Application Data directory of the current user.

CommonProgramFiles

Inserts the full path to the Common Files directory.

CommonProgramFiles(x86)

Inserts the full path to the (x86) Common Files directory in 64-bit versions of Windows.

CommonProgramFilesW6432

Inserts the full path to the Common Files directory in 64-bit versions of Windows.

COMPUTERNAME

Inserts the computer name.

HOMEDRIVE
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Inserts the drive letter on the local computer that is connected to the user's home directory.

HOMEPATH

Inserts the complete path of the current user's Home directory, as defined by the user's account

properties.

LOCALAPPDATA

Inserts the complete path to the current user's Application Data directory.

LOGONSERVER

Inserts the name of the domain controller that authenticated the client's logon request.

OS

Inserts the name of the operating system.

PROCESSOR_ARCHITECTURE

Inserts the chip architecture of the CPU.

ProgramData

Inserts the full path to the All Users profile directory.

ProgramFiles

Inserts the full path to the Program Files directory.

ProgramFiles(x86)

Inserts the full path to the (x86) Program Files directory in 64-bit versions of Windows.

ProgramFilesW6432

Inserts the full path to the Program Files directory in 64-bit versions of Windows.

PUBLIC

Inserts the full path to the Public directory.
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SESSIONNAME

Inserts the session name and number when a client is connected via a terminal server.

SystemDrive

Inserts the name of the drive on which the system folder was placed.

SystemRoot

Inserts the name of the system folder.

TEMP

Inserts the name of the default temporary folder used by the operating system and applications

available to the current user.

TMP

Inserts the name of the default temporary folder used by the operating system and applications

available to the current user. (Note that some applications require the TEMP environment variable,

whilst others require TMP. The values for both should be identical).

USERDOMAIN

Inserts the name of the user domain that contains the account of the current user.

USERDOMAIN_ROAMINGPROFILE

Inserts the name of the user domain for RDS or standard roaming profile paths.

USERNAME

Inserts the name of the current user.

USERPROFILE

Inserts the location of the current user's profile directory. 

windir

Inserts the full path to the Windows directory.
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Example

If the macro %[Env:CommonProgramFiles] is used to specify watermark text, then the full path to the

Common Files directory is inserted:

Figure 1. Add Watermark Dialog Box, %[Env:CommonProgramFiles] Macro Example

Further information on environment variables is available here.

https://en.wikipedia.org/wiki/Environment_variable
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11.7.12 FileName

 FileName

The FileName macro inserts the name of the source file.

The syntax for this macro is %[FileName]

Example

If the %[FileName] macro is used to specify watermark text, then the name of the file is inserted as a

watermark:
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Figure 1. Add Watermark Dialog Box, %[FileName] Macro Example
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11.7.13 File Extension

 File Extension

The File Extension macro inserts the file extension of the current file.

The syntax for this macro is %[FileExt]

Example

If the %[FileExt] macro is used to specify watermark text, then the name of the file is inserted as a

watermark:
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Figure 1. %[FileExt] Macro Example
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11.7.14 Folder Name

 Folder Name

The Folder Name macro inserts the path of the folder that contains the source file. Note that folder

names end with a backslash when local files are used.

The syntax for this macro is %[FolderName]

Example

If the %[FolderName] macro is used to specify watermark text, then the name of the folder that

contains the source file is inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[FolderName] Macro Example
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11.7.15 Folder Title

 Folder Title

The Folder Title macro inserts the title of the folder that contains the source file.

The syntax for this macro is %[FolderTitle]

Example

If the %[FolderTitle] macro is used to specify watermark text, then the name of the folder that contains

the source file is inserted as a watermark:
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Figure 1. %[FolderTitle] Macro Example



1838

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Appendix

11.7.16 Hour

 Hour

The Hour macro inserts the hour value from the current time.

The syntax for this macro is %[Hour]

Example

If the %[Hour] macro is used to specify watermark text and the current time is 17:30 then '17' is

inserted:
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Figure 1. Add Watermark Dialog Box, %[Hour] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Hour]:%[Minute] output the hour followed by the

minutes of the hour:
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Figure 2. %[Hour] Combined Macro Example
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11.7.17 Minute

 Minute

The Minute macro inserts the minute value from the current time.

The syntax for this macro is %[Minute]

Example

If the %[Minute] macro is used to specify watermark text and the current time is 12:07 then '7' is

inserted:
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Figure 1. Add Watermark Dialog Box, %[Minute] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Hour]:%[Minute] output the hour followed by the

minutes of the hour:
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Figure 2. %[Minute] Combined Macro Example
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11.7.18 Month

 Month

The Month macro inserts the current month as a numerical value from 1-12.

The syntax for this macro is %[Month]

Example

If the %[Month] macro is used to specify watermark text and the current month is February then the

number "02" is inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[Month] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Month]/%[Day] output the current

time followed by the month and the day of the month:
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Figure 2. Add Watermark Dialog Box, Combined Macro Example
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11.7.19 Number of Pages

 Number of Pages

The Number of Pages macro inserts the total number of document pages.

The syntax for this macro is %[Pages] and the following parameters are available

· 'r' specifies the use of lower-case roman numerals.

· 'R' specifies the use of upper-case roman numerals.

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used.

· '<integer> specifies the minimum number of digits used. This value can be any positive

integer from 1 to 12 - for example %[Pages:4] starts the numbering as "0001, 0002, 0003...".

The syntax for this macro when parameters are used is %[Pages:<Parameter>]

Examples

If the %[Pages] macro is used to specify watermark text, then the total number of document pages is

inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[Pages] Macro Example

Alternatively, enter %[Pages:R] to insert the total number of document pages as a watermark and

specify the use of upper-case roman numerals:
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Figure 2. Add Watermark Dialog Box, %[Pages] Macro Example Two
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11.7.20 Page Number

 Page Number

The Page Number macro inserts the page number of source pages. 

The syntax for this macro is %[Page] and two sections of parameters are available:

The first section determines the format of page numbers:

· 'r' specifies the use of lower-case roman numerals.

· 'R' specifies the use of upper-case roman numerals.

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used.

· '<integer> specifies the minimum number of digits used. This value can be any positive

integer from 1 to 12 - for example %[Page:4] starts the numbering as "0001, 0002, 0003...".

The second section determines the starting value for page numbers, and must therefore be an integer.

Please note that a semicolon must be used to delimit the sections of parameters. If the second section

is not used then the semicolon can be omitted. However, if the first section is not used and the second

section is used, then it is necessary to use the semicolon.

The syntax for this macro when both parameters are used is %[Page:<Parameter 1>;<Parameter 2>]

The syntax for this macro when only the second parameter is used is %[Page:;<Parameter 2>]

Examples

If the %[Page] macro is used to specify a document header, then the page number of the source page

is inserted as a header:
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Figure 1. Add Header and Footer Dialog Box, %[Page] Macro Example

Alternatively, enter %[Page:R] to specify the use of upper-case roman numerals:
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Figure 2. Add Header and Footer Dialog Box, %[Page] Macro Example Two

Alternatively, enter %[Page:4;10] to specify a minimum of four digits for output values and a starting

value of ten:
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Figure 3. Add Header and Footer Dialog Box, %[Page] Macro Example Three

Alternatively, enter %[Page:;5] to omit the first parameter and specify a starting value of five:
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Figure 4. Add Header and Footer Dialog Box, %[Page] Macro Example Four
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11.7.20.1 Page Numbering Style

 Page Numbering Style

The Page Numbering Style feature is an additional macro feature that uses the Page Number and

Number of Pages macros to create page number styles. Follow the step below to view the options

available for this feature:

1. Open the Add Header and Footer tool, then expand the Add Header and Footer action and

click All Options:

Figure 1. Add Header and Footer Tool Actions Sequence, Add Header and Footer Action Selected

The Add Header and Footer dialog box will open:
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Figure 2. Add Header and Footer Dialog Box

2. Click a macro icon to view the macro shortcut menu. The current Page Number Style will be

detailed in the menu. Click Edit Page Numbering Style to view/select alternative page

numbering styles:
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Figure 3. Add Header and Footer Dialog Box, Macro Shortcut Menu, Edit Page Numbering Style Highlighted

The Edit Page Numbering Style Format dialog box will open:
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Figure 4. Edit Page Numbering Style Format Dialog Box

3. Click the arrow in the Page Number Format dropdown menu to view alternative page number

formats. The following options are available:

· 1 outputs the page number. This is the default setting.

· 1 of n outputs the page number followed by 'of n', where 'n' is the total number of

document pages.

· 1/n outputs the page number followed by a forward slash and 'n', where 'n' is the total

number of document pages.

· Page 1 outputs the text "Page" followed by the page number.

· Page 1 of n outputs the text "Page" followed by the page number and 'of n', where 'n' is

the total number of document pages.

· Use the First Page Number text box to determine the first page number used.

· Use the Number of Pages Increment text box to increase the total number of pages

given as the output figure when the options above that involve 'n' are used. 

Example
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Figure 5. Add Header and Footer Dialog Box, Page Numbering Style Set to '1 of n'
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11.7.21 Seconds

 Seconds

The Seconds macro inserts the seconds value from the current time.

The syntax for this macro is %[Seconds]

Example

If the %[Seconds] macro is used to specify watermark text and current time is 12:34 and 39 seconds

then '53' is inserted:
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Figure 1. Add Watermark Dialog Box, %[Seconds] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Hour]:%[Minute],%[Seconds] output the hour followed

by the minutes of the hour and the seconds of the minute:
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Figure 2. %[Seconds] Combined Macro Example
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11.7.22 Time

 Time

The Time macro inserts the current time. Multiple time formats are available, as detailed below.

The syntax for this macro is %[Time] and the following parameters are available:

· h inserts the hour and omits the zero in cases of single-digit values.

· hh inserts the hour and includes a zero in cases of single-digit values.

· H inserts the hour, includes a zero in cases of single-digit values and uses a 24 hour-clock.

· m inserts the minutes and omits the zero in cases of single-digit values.

· mm inserts the minutes and includes a zero in cases of single-digit values.

· s inserts the seconds and omits the zero in cases of single-digit values.

· ss inserts the seconds and includes a zero in cases single-digit values.

· t inserts a single character to reference the a.m./p.m. variable: a or p.

· tt inserts two characters to reference the a.m/p.m. variable: am or pm.

The syntax for this macro when parameters are used is %[Time:<Parameter>]

Note that several parameters can be used in sequence in order to insert a customized time. For

example, %[Time:H:mm tt] inserts the current hour and minutes, and inserts two characters to

reference the a.m./p.m. variable, as detailed below.

Example

If the macro %[Time:H:mm tt] is used to specify watermark text, then the current hour and minutes,

and two characters to reference the a.m./p.m. variable, are inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[Time] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Month]/%[Day] output the current

time followed by the month and the day of the month:
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Figure 2. %[Time] Combined Macro Example



1866

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Appendix

11.7.23 Username

 Username

The Username macro inserts the name of the current user.

The syntax for this macro is %[User]

Example

If the %[User] macro is used to specify watermark text then the name of the current user is inserted:
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Figure 1. Add Watermark Dialog Box, %[User] Macro Example
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11.7.24 Year

 Year

The Year macro inserts the current year as a four-digit value.

The syntax for this macro is %[Year]

Example

If the %[Year] macro is used to specify watermark text, then the current year is inserted as a watermark:
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Figure 1. Add Watermark Dialog Box, %[Year] Macro Example

Note that this macro is often used in conjunction with other macros in order to create combined

output. For example the combined macros %[Time:H:mm] %[Date:dd MMMM] %[Year] output the

current time, date and year:
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Figure 2. Add Watermark Dialog Box, Combined Macro Example
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11.8 Media Foundation Installation

 Media Foundation Installation

The PDF to Audio tool/action in PDF-Tools requires the installation of Windows Media

Foundation on the local machine in order to export PDF files to (*.mp3) format. If you want

to use this feature then it is necessary to install the Media Feature Pack that corresponds to

the version of your system:

· The Media Pack Installation for Windows 8/8.1/10/11 (intended for use by end

users) is available at the Microsoft website here.

· The Media Pack Installation for Windows Server (intended for use by system

administrators) can be installed using the following command in PowerShell:

Install-WindowsFeature Server-Media-Foundation

· The Media Pack Installation for Server Manager (intended for use by system

administrators) can be installed as follows:

1. Run Server Manager, then click the Manage tab and click Add Roles and

Features. The Add Roles and Features Wizard will open at the 'Before you begin'

page.

2. Click Next. The Select Installation type page will open. Click Next.

3. The Select destination server page will open. Select the desired server and click

Next. The Select server roles page will open.

4. Click Features in the list on the left, then select the Media Foundation box:

https://support.microsoft.com/en-au/help/3145500/media-feature-pack-list-for-windows-n-editions
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Figure 1. Add Roles and Features Wizard, Media Foundation Highlighted

5. Click Next. The Confirm installation selections page will open. Click Install to

complete the process.
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11.9 Page Range Options

 Page Range Options

There are multiple settings in PDF-Tools that feature Page Range specification:

Figure 1. Page Range Setup Dialog Box

· Select All to specify to all pages.

· Select Custom to specify a custom page range:

· Use commas to delimiter individual pages.

· Use hyphens to delimiter page ranges. 

· Use commas to delimiter page ranges if multiple page ranges are being defined.

· Use a dash before a page number to determine all pages from the beginning of the

document to the specified page. For example -7 defines all pages from the beginning of

the document to page seven.

· Use a dash after a page number to determine all pages from the specified page to the

end of the document. For example 7- defines all pages from page seven to the end of

the document.
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· Use the caret symbol (^n) to specify the document page that is n pages from the end of

the document, or use (^n-^n) to specify a page range from the end of the document. For

example, ^2 specifies the second-last page of the document, and ^1-^5 specifies the

last five pages of the document.

· Use the Subset menu to specify a subset of custom page ranges as desired. The

options are All Pages, Odd Pages Only and Even Pages Only.

· Note that when you are specifying a custom page range it is not necessary for the order of

pages to be sequential, or for each value in the range to be unique. 

Click OK to save changes.

Examples

1, 3, 5-7  will process pages 1, 3, 5, 6 and 7.

1, 3, 5-7, ^2-^1 (when applied to a document with ten pages) will process pages 1, 3, 5, 6, 7, 9

and 10.

3- will process all pages except the first two pages of the document.

-5, 7 will process pages 1, 2, 3, 4, 5 and 7.

-5, ^3-^1 (when applied to a document with ten pages) will process pages 1, 2, 3, 4, 5, 8, 9 and

10.
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11.10 Preferences

 Preferences

Click Preferences in the Options tab to launch the Preferences dialog box:

Figure 1. PDF-Tools Main Window, Options Tab, Preferences Highlighted

The Preferences dialog box will open:
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Figure 2. Preferences Dialog Box

These options are used to customize general settings in PDF-Tools. Click categories for

further information:

· General

· Languages

· Passwords

· Registration

· Color Management

· Convert from PDF

· Convert to PDF

· Customize UI

· Identity

· Measurement

· OCR

· Performance

· Plugins

· Scanner Presets

· Send Mail
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1894
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1900
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1903

1904

1906

1910
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· Signatures

· Update

1912

1916
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11.10.1 General

 General

The General preferences determine general preferences in PDF-Tools:

Figure 1. Preferences Dialog Box, General Tab

· Select the Play sound when tool processing ends box to play a sound in PDF-

Tools when tool operations are complete.
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· Select the Make application icon flash box to make the application icon flash in the

taskbar when tool processing ends.

· Select the Minimize application to tray box to minimize PDF-Tools to the tray

instead of the taskbar.

· Select the Do not show box to disable the displaying of the "new" label that

appears next to new tools in the user interface.

· Click the Hide "New" Labels button to hide new labels in the user interface in the

current version of the software.

· Use the High DPI scaling behavior dropdown menu to set the UI scale used for monitors when

you are switching between screens that have different resolution settings.

· Use the PDF-Specification dropdown menu to determine the PDF specification of new

documents created with PDF-Tools.

· Click Edit Application Variables to view/edit application variables that can be used to define

custom values in fields that support macros, as detailed below.

Click OK to save changes.

Edit Application Variables

When you click the Edit Application Variables button in the general preferences, the Manage

Application Variables dialog box will open:

Figure 2. Manage Application Variables Dialog Box
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· Click Add to add a new application variable. The Create Application Variable dialog box will

open, as detailed below.

· Click Edit to edit existing application variables.

· Click Remove to remove selected application variables.

Figure 3. Create Application Variable Dialog Box

· Enter the desired name for the application variable in the Name text box.

· Enter the desired value for the variable in the Value text box. This value will be used when the

variable is selected in the PDF-Tools user interface, as detailed below.

· Enter a description for the application variable as desired. This description will be detailed with

the application variable when it is selected in the PDF-Tools user interface, as detailed below.

· Select the Prompt box to set PDF-Tools to prompt for the value when the application variable

is used.

User-specified application variables can be selected via the user interface of PDF-Tools when you are

entering information into macro text boxes.

Example

The following application variable inserts the text 'Lorem Ipsum' when it is added to macro text boxes:
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Figure 4. Example Application Variable

The application variable can be selected when selecting a macro for use in conjunction with the Add

Watermark tool:
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Figure 5. Application Variable Available in User Interface

The text box and preview pane will update with the information contained within the application

variable:
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Figure 6. Application Variable Added to Text Box

When the tool is executed, the output document will contain the text specified within the application

variable.
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11.10.2 Languages

 Languages

The Languages preferences determine the language of the user interface in PDF-Tools:

Figure 1. Preferences Dialog Box, Language Tab

· Double-click languages to change the UI language.

· Click Set as Default to set the current language as the default language.

· Click More Languages to view additional language options.
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Click OK to save changes.
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11.10.3 Passwords

 Passwords

The Passwords preferences are used to create a database of stored passwords that is used

when PDF-Tools is processing files:

Figure 1. Preferences Dialog Box, Passwords Tab

If processed files are password-protected and the relevant password is included in this list

then PDF-Tools will not prompt for a password. 

· Click Add to add new passwords to the list.

· Click Edit to edit the name of existing passwords.

· Click Remove to remove selected passwords.
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· Click Clear to remove all passwords from the list.

Click OK to save changes.



1888

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

Appendix

11.10.4 Registration

 Registration

The Registration preferences are used to view/add/remove license keys:

Figure 1. Preferences Dialog Box, Registration Tab

· Click Add New License Key to add new license keys. 

· Click Remove to remove selected license keys from the list.

Click OK to save changes.
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11.10.5 Color Management

 Color Management

The Color Management preferences are used to determine color management options:

Figure 1. Preferences Dialog Box, Color Management Tab Selected

· The Color Settings dropdown menu is used to store and manage customized color profiles.

Use this menu to save settings when they have been adjusted using the options detailed below.

· Use the RGB, CMYK and Grayscale dropdown menus to determine the settings for these color

modes.

· Use the Engine dropdown menu to determine the engine used for color management.
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· Select the Use Black Point Compensation box to enable black point compensation, which is a

technique used in digital photography printing for the creation of adjustments between the

maximum black levels of digital files and the black capabilities of digital devices.

Click OK to save changes.
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11.10.6 Convert from PDF

 Convert from PDF

The Convert from PDF preferences are used to determine settings when customizable

formats are converted from PDF:

Figure 1. Preferences Dialog Box, Convert from PDF Tab

Double-click formats in the Available Converters pane to customize settings. Please note

that only formats that can be customized are listed. A complete list of file formats that PDF-

Tools can convert to PDF is detailed here.

Click OK to save changes.

1774
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11.10.7 Convert to PDF

 Convert to PDF

The Convert to PDF preferences are used to determine settings when customizable formats

are converted to PDF:

Figure 1. Preferences Dialog Box, Convert to PDF Tab

Double-click formats in the Available Converters pane to customize settings. Please note

that only formats that can be customized are listed. A complete list of file formats that PDF-

Tools can convert to PDF is detailed here.

Click OK to save changes.

1774
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11.10.8 Customize UI

 Customize UI

The Customize UI preferences are used to customize the user interface:

Figure 1. Preferences Dialog Box, Customize UI Tab

· Use the menus in the Fonts section to determine the font style and size for menus, toolbars and

dialog boxes.

· Use the menus in the Colors section to determine the colors of the UI.

· Use the menus in the Backgrounds section to determine the UI display for backgrounds:

· Use the Type menu to select the background to customize.

· Use the Style/Pattern menus to select the style and color of the selected background.

· Select the Show Overlay Shadows box as desired.
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· Select the Turn off all textured backgrounds to improve UI performance on terminal

session box as desired.

Click OK to save changes.
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11.10.9 Identity

 Identity

The Identity preferences determine the information used in comments, comment reviews and digital

signatures:

Figure 1. Preferences Dialog Box, Identity Tab

Enter the desired information in the text boxes or select the check box to use the information in your

Active Directory.

Click OK to save changes.
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11.10.10 Measurement

 Measurement

The Measurement preferences determine the units of measurement used in PDF-Tools:

Figure 1. Preferences Dialog Box, Measurement Tab

Use the dropdown menu to select a unit of measurement.

Click OK to save changes.
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11.10.11 OCR

 OCR

The OCR preferences determine the optical character recognition engine used in PDF-

Tools:

Figure 1. Preferences Dialog Box, OCR Tab

· Use the dropdown menu to switch between the Default OCR engine and the Enhanced OCR

engine. Note that the Enhanced OCR engine is an optional extra in PDF-Tools that was added

in version 8, and from version 9 is only available in PDF-Tools via a PDF-XChange PRO license.

The Enhanced OCR engine is faster, more accurate and more dynamic than the default OCR

https://www.pdf-xchange.com/product/pdf-xchange-pro
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engine, and it also contains some extra features. Further information about the Enhanced OCR

engine is available here.

· Click Add/Update Languages to add/update languages to be used in the process of optical

character recognition.

Click OK to save changes.

https://www.pdf-xchange.com/product/ocr-plugin
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11.10.12 Performance

 Performance

The Performance preferences determine the maximum number of working threads allowed

in PDF-Tools:

Figure 1. Preferences Dialog Box, Performance Tab

Use the dropdown menu to determine how many working threads are permitted to be used, then click

OK to save changes.
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11.10.13 Plugins

 Plugins

When the Plugins tab is selected the following options are available:

Figure 1. Preferences Dialog Box, Plugins Tab

This dialog box shows plugins available for PDF-Tools.

· Select plugins to view their details in the Plugin information section. 

· Click the Enable/Disable buttons to enable/disable selected plugins. 

· Click More Plugins to view further plugins available from PDF-XChange products.

Click Apply to apply changes and OK to save changes.
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11.10.14 Scanner Presets

 Scanner Presets

The Scanner Presets preferences determine the presets for tools that use scanners:

Figure 1. Preferences Dialog Box, Scanner Presets Tab

These options determine scanner presets for tools that use scanners:

· Click the Scanner Settings menu to select a preset scanning mode or a saved profile.

· Click the Scanner menu to select a scanner to use. 

· Click the Data Transfer Method menu to select either Native Mode or Memory Mode:

· Native Mode uses a single memory buffer. This is the default and fastest

mode, and is compatible with the broadest range of scanners.
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· Memory Mode enables the use of multiple memory buffers. This is a useful

function in cases where memory is low and/or when large images are being

scanned.

· The Show Native UI box is selected by default, which means the user interface of

the device driver is used. This is the most reliable option, and the scanner will select

certain parameters of the scan itself: Color Mode, Resolution, Paper Size and

Source. Clear the Show Native UI box to customize these options:

· Color Mode has four options: Auto detect, Color, Grayscale and Black & White.

· Click the Resolution menu to select the dpi (dots per inch) of scanned documents.

· Paper Size refers to the size of the paper used when scanning. Click Setup for further

options:

· Automatic determines the paper size automatically.

· Standard contains standard sizes such as those used by the ISO and ANSI.

· Custom can be used to enter custom dimensions.

· Source has three options Auto, Flatbed and Feeder. These refer to the type of scanner

used for scanning.

· Click the Sides menu to determine which sides of documents are scanned. There are three

options: Simple Scan, Manual Duplex and Manual Duplex Reversed. Click the dropdown

arrow for an explanation of these options.

· Click the Scan More Pages menu to select the setting for when additional pages are scanned.

Click the Scanner Settings dropdown menu to save/manage/delete custom profiles:
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Figure 3. Export to Images Dialog Box, Custom Profiles

· Click Save Current Settings to save custom settings for subsequent use. Saved

profiles are detailed in the Scanner Settings dropdown menu.

· Click Delete to delete selected profiles.

· Click Manage to manage saved custom settings. The Manage Presets dialog box

will open, as detailed below.

Click OK to save changes.
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Figure 4. Manage Presets Dialog Box

· Click Edit to edit selected profiles.

· Click Clone to clone selected profiles. This makes it possible to duplicate profiles

and then customize their settings whilst retaining the existing profile and its

parameters.

· Use the up and down arrow to move selected profiles up or down in the list.

· Click Delete to delete selected profiles.

· Click Import to import profiles from a saved file.

· Click Export to export profiles to file.
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11.10.15 Send Mail

 Send Mail

The Send Mail preferences determine the desktop client used to email documents via the

Send E-mail  tool/action in PDF-Tools:

Figure 1. Preferences Dialog Box, Send Mail Tab

Existing email methods are displayed in the Available Methods pane.

· Click New to add new email methods. Select SMTP, Gmail, Yahoo, Hotmail, Outlook or

Mail.ru as desired.

· Click Edit to edit selected email methods.

· Click Make Current to enable the selected email method.

1771
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· Click Remove to remove the selected email method.

Click OK to save changes.
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11.10.16 Signatures

 Signatures

The Signatures preferences determine settings for the creation, appearance and verification

of digital signatures in PDF-Tools:

Figure 1. Preferences Dialog Box, Signatures Tab

These options determine the settings for digital signatures:

· The Creation & Appearance settings determine the options detailed in (figure 2) below. Click

More to access these settings.

· The Verification settings determine how and when signatures are verified. Click More to access

these settings, then select the check boxes as desired.
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· Select either of the radio buttons in the Saving section to determine how documents opened

from external repositories are saved.

Figure 2. Creation and Appearance Dialog Box

The Creation settings are as follows:

· Select an option from the Default Signing Method menu to determine the default signing

method settings.  

· Select an option from the Default Signing Format menu to determine the signing format.

· PKCS#7 - Detatched encodes certificates in Abstract Syntax Notation One (ASN.1)

format. 

· CAdES is an electronic signature created in compliance with eIDAS and has the same

legal value as a handwritten signature.

· Select the Include signature's revocation status box as desired. The revocation status of the

signature will be shown in the main window when this option is enabled.

· Select the Flush PIN cache before applying signature box as desired.

· Click the More button to set the Digital Sign Appearance Templates:
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Figure 3. Digital Signature Appearance Templates Dialog Box

· Select signature templates, then select Clone/Reset/Edit as desired:

· Click Clone to clone the selected signature template. This is a useful feature if parameters of

existing signature templates need to be changed and saved without editing the original

template.

· Click Reset to revert the values of the the selected signature template to its default state. 

· Click Edit to adjust the values of the selected signature template:
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Figure 4. Edit Template of Digital Sign Dialog Box

· Use the Template Name text box to edit the name of the signature template.

· Use the Show Graphics option buttons to determine the graphics displayed with the template:

· Select Name as Icon to use the name of the current user as the icon.

· Select Custom Icon to use a custom icon. Enter the name of the file to be used in the text

box, or click the icon to select a file from the local computer.

· Select the Display Logo box to display the logo in the background of signature templates.

· Select the boxes in the Show Text section to determine the information that is shown with

templates.

· Use the Text Direction dropdown menu to determine the text direction.

Click OK to save changes.
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11.10.17 Update

 Update

The Update option is used to check for updates to PDF-XChange applications:

Figure 1. Preferences Dialog Box, Update Option

 Click the Check for Updates Now button to check for updates to PDF-Tools.
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11.11 Folder Monitors

 Folder Monitors

The Folder Monitors feature of PDF-Tools is used to watch user-specified folders and

automatically perform tool operations when new files are moved into them or when files

that they contain are edited. Note that PDF-Tools must be running in order for folder

monitors to operate. Click Folder Monitors to create/edit/delete folder monitors:

Figure 1. PDF-Tools Main Window, Options Tab, Folder Monitors

The Folder Monitors dialog box will open:
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Figure 2. Folder Monitors Dialog Box

· Click Create to create a new folder monitor. The Setup Folder Monitor dialog box

will open, as detailed below.

· Click Edit to edit selected folder monitors. Note that monitors must be disabled

before they can be edited.

· Click Enable/Disable/Delete to enable/disable/delete selected folder monitors.

· Right-click the dialog box for additional options:

· Click Copy Monitor Identifier to copy the identifier of the folder monitor to

the clipboard. Identifiers can be used in conjunction with the folder monitor

command line detailed here.

· Click Create Shortcut on Desktop to create a desktop shortcut to the folder

monitor.

1780
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Figure 3. Setup Folder Monitor Dialog Box

· Enter the name of the folder to be monitored in the Select folder for monitoring text box, or

click the icon to select a file manually.

· Enter the name of the tool to be executed in the Select tool to execute text box, or click the

ellipsis icon to select a tool manually.

· Enter a name for the folder monitor in the Folder Monitor Name text box.

· Use the Monitor Priority dropdown menu to determine the priority of the folder monitor. If

the priority is set to High then the process will be faster but will also use more memory, and

vice versa.

· Use the Tool UI interaction with user dropdown menu to determine tool interaction when

new files are copied into monitored folders:
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· Select Disable interaction to disable the launching of the tool UI. Note that some tools,

such as the Secure Document tool, require some settings to be determined before they

can run. The setup UI will be displayed the first time that these tools run and subsequently

disabled from opening.

· Select Use tool settings to launch the tool UI and customize settings each time a new

file is copied into the monitored folder.

· Use the Input Files Options to determine options for input files:

· Select an option in the Sort dropdown menu to determine how input files are sorted.

· Select an option in the File types dropdown menu to determine permitted file formats

for the tool associated with the monitored folder, or click the ellipsis icon to determine

permitted file formats manually.

· Select an option to determine the action taken for input files after the tool runs:

· Select Keep input files in folder to retain the input files in the monitored folder.

· Select Delete input files on success to delete input files.

· Select Move input files to folder to move input files to a different folder, then enter the

name of the folder in the text box, or click the icon to select a folder manually.

· Select Reprocess files on start to reprocess files when the folder monitor is enabled.

· Select Monitor subfolders to include subfolders of monitored folders.

· Select the Save report box to save the tool output report, then use the Select Folder and

Report name options to specify the destination folder and the filename of the report. 

Click OK to save changes.

Note that it is necessary to re-enable folder monitors after a system restart. If you want to

ensure that folder monitors are always running, then follow the steps below:

1. Click the Options tab in the PDF-Tools UI, then click Folder Monitors. The Folder

Monitors dialog box will open.

2. Right-click the desired folder monitor and then click Create Shortcut on Desktop:
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Figure 4. Folder Monitors Dialog Box, Right-Click Shortcut Menu

A shortcut to the folder monitor will then be created and an icon will appear on your

desktop.

3. Open your Windows Startup Folder, which is located by default at:

%appdata%\Microsoft\Windows\Start Menu\Programs\Startup

4. Click and drag the shortcut from your desktop into your Windows Startup Folder.

The folder monitor will then be enabled each time you log in to your Windows account.
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12 PDF-XChange Standard V10 User Manual

 PDF-XChange Standard V10 User Manual

PDF-XChange Standard is a virtual printer that is used to convert industry-standard file

formats to PDF. It's compatible with files from almost all Windows applications such as MS

Word, Excel and AutoCAD. It features an optimized, hybrid engine that significantly

increases the quality of conversion for images and image-based text characters, and prints

to both GDI and XPS. PDF-XChange Standard installs as a virtual printer that generates

fully-compatible, industry-standard, native PDF files. It is used in the same manner as a

standard printer - simply open files in their native application, select the option to Print and

then select PDF-XChange Standard from the list of available printers. The document will

then be converted into PDF. You can also right-click web pages and click 'Convert to PDF'

to convert web pages to PDF.

This manual is composed of the following sections

· Features Overview, which details the main features of PDF-XChange Standard.

· PDF-XChange Standard Printer Settings, which is structured to match the UI of the

software and details comprehensive operational instructions for its features and

functionality.

· Convert Web Pages to PDF details the process of converting web pages to PDF.

· PDF Saver details the PDF Saver feature, which is used to view/edit additional

settings and to run PDF-XChange Standard from the command line.

· MS Office Toolbar Add-in, which details the toolbar add-in for Microsoft

applications.

· MS Outlook Add-in details the MS Outlook Add-in, which is used to convert email

items to PDF.

· OFFice2PDF details the OFFice2PDF feature, which enables the batch conversion of

Microsoft Office formats to PDF.

· Features Added in Version 10 details a breakdown of the features added to PDF-

XChange Standard in version 10.0.0.370 and later. 

Note that the icons in the upper left of the screen can be used to browse/search the manual:



1923

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Standard V10 User Manual

 Click the Table of Contents to view/move to chapters of the manual.

 Click the Keyword Index to view keywords, and click keywords to move to their location in

the manual.

 Click Search Topics to enter custom search terms.



1924

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Standard V10 User Manual

13 Features Overview

 Features Overview

PDF-XChange Standard is one of the most feature-rich virtual printers available worldwide.

It combines high quality conversion with optimized compression to create professional

documents that are comparatively small in size. The main features of PDF-XChange

Standard are detailed below:

· AES Encryption to enhance security options.

· Booklet Mode enables the printing of booklets and similar documents.

· Bookmarks functionality for converted files.

· Compression Options that provide settings and standards for images and text.

· Conversion of colored images to grayscale/monochrome to enhance compression

and reduce file size.

· Customzied Printing Profiles that enable the saving of personalized settings for

subsequent use.

· Digital Signing of documents to demonstrate authenticity.

· Document Information options that support basic and advanced settings,

including the option to add XMP Metadata.

· DPI Reduction to reduce file size.

· Font Embedding to ensure compatibility on all computers. Chinese, Japanese and

Korean fonts are available.

· Enhanced Saving options that determine how files are saved/named. Macros

have been introduced to increase workflow efficiency. 

· Headers and Footers can be in inserted into converted files.

· Hybrid Conversion Engine that prints to both GDI and XPS. 

· Language options that support a wide range of languages.

· MAPI and SMTP options for emailing files, including .zip compression functionality.

· MRC (Mixed Raster Content) support.

· MS Office toolbar add-in that installs automatically and creates a tab in MS Office

programs on your computer.

· n-UP printing options enable the rescalding and/or resizing of pages, and the

placement of multiple pages on each printed sheet.

1940
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· The Office2PDF  feature enables the batch-conversion of files and the use of

'watched directories' that enable the auto-conversion of specified folders/files to

PDF.

· Overlay options that enable the use of PDF pages as overlays. 

· Paper Properties that provide options for paper size, resolution, scaling and output.

· PDF/A: 1a, 1b+2a, 2b and 2u (RGB) are supported as conversion options.

· Security options that determine document and password permissions.

· Tool Tips are visible when the pointed is hovered over functions/properties.

· URL and Email Links can be added when files are converted.

· Watermarks can be added to documents in text/graphic format.

2058
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14 PDF-XChange Printer Standard Printer Settings

 PDF-XChange Printer Standard Printer Settings

Follow the steps below to view/edit printer settings in PDF-XChange Standard:

1. Enter 'printers & scanners' in the Windows Search Box, then click Printers &

scanners in the search results:
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Figure 1. Windows Search Box Results

The Printers & scanners tab will open. 

2. Click PDF-XChange Standard, then click Manage:
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Figure 2. Printers & scanners Tab

The PDF-XChange Standard tab will open.

3. Click Printing Preferences:
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Figure 3. PDF-XChange Standard Tab, Printing Preferences

The PDF-XChange Standard Printing Preferences dialog box will open. These settings are

used to determine all options in PDF-XChange Standard:
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Figure 4. PDF-XChange Standard Printing Preferences Dialog Box

4. Click options in the list of settings on the left to view/edit settings for the PDF-

XChange Standard printer. All settings are listed below:

· Paper

· Custom Forms

· General

· Compression

· Graphics

· Fonts

· Watermarks

· Overlays

· Security

· Links

· Bookmarks

· Default File Append

· Headers and Footers

· Document Info

· Save
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· Email

· Optimization

· Languages

About

The About tab can be used to access further information about the product view help

pages, check for updates and register new serial keys/activation codes.

2030

2032

2035
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14.1 Profiles

 Profiles

The Profile section is used to save customized printer settings for subsequent use:

Figure 1. PDF-XChange Standard Printing Preferences Dialog Box. Profile Options Highlighted

Click the disk icon to open the Add Profile dialog box and saved customized settings:
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Figure 2. Add/Edit Profile Dialog box

· Use the Name text box to enter a name for the profile.

· Use the Comment text box to add a description of the profile.

· Click OK to save profiles. They will then be available in the Profile submenu

highlighted in (figure 1).

· Click the Manage button in (figure 1) to manage saved profiles. The Profiles

Manager dialog box will open:
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Figure 3. Profiles Manager Dialog Box

· Click Edit to edit selected profiles. The Edit Profile dialog box will open. Edit the Name and

Comment of the profile and click OK to save changes.

· Click Clone to clone selected profiles. This option enables the duplication and editing of profile

settings without changing the original profile. The cloned profile will appear in the list of

profiles and can then be edited as desired.

· Click Remove to remove selected profiles.

· Click Export to export selected profiles. Exported profiles save as (*.pxppp) files that can be

uploaded to other installations of PDF-XChange Standard via the Import feature detailed

below.

· Click Import to import settings that the Export feature has been used to export. Alternatively,

rundll32 can be used to install profiles, as detailed below. Further information on rundll32 is

available here.

RUNDLL32 OPTION

There is also a rundll32 option for profiles:

https://support.microsoft.com/en-us/help/164787/info-windows-rundll-and-rundll32-interface
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rundll32 "C:\Program Files\Tracker Software\PDF-XChange

Standard\drvui.x64.dll",DUI30_Command [/InstallProfile:"<fullpathtoprofile>"

| /SetDefProfile:"<profile_name>"] [/PrinterName:"PDF-XChange Standard"]

[/AsDefault] [/ForUser]

Note that the drvui.x64.dll, as detailed above, should be used for 64-bit systems. If a 32-bit system is

being used, then the drvui.x86.dll should be used instead.

Use the Export feature detailed in (figure 3) to export profiles for use in conjunction with the rundll32

option.

The rundll32 contains the following parameters:

· /InstallProfile:"<fullpathtoprofile>" installs a profile from the path specified.

If /AsDefault is specified then the profile will be set as the default profile.

· /AsDefault sets the new profile as the default profile.

· /SetDefProfile:"<profile_name>" sets the specified profile as the default profile.

For example: /SetDefProfile:"Current".

· /PrinterName specifies the printer to which changes are made. If no printer is

specified then the default printer is used.

· /ForUser changes the profile for only the current user. If this parameter is not

specified then the profile is changed for all users.

Example

The following command line installs an exported profile to the printer 'PDF-XChange Standard':

C:\Program Files\Tracker Software\PDF-XChange

Standard\drvui.x64.dll",DUI30_Command /InstallProfile:"C:<path to

profile>\ProfileName.pxpp" /PrinterName:"PDF-XChange Standard"
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14.2 Driver Mode

 Driver Mode

The Driver Mode determines the print mode of PDF-XChange Standard:

Figure 1. Driver Mode Options

Printer drivers on Microsoft Windows systems make use of GDI (Unidrv or P-Script-based) or XPS

(XPSDrv) in order to print documents. PDF-XChange Standard supports both of these modes, and the

Driver Mode settings determine which mode is used:

· Auto allows PDF-XChange Standard to determine the print mode.

· GDI specifies GDI printing to GDI.

https://en.wikipedia.org/wiki/Unidrv
https://en.wikipedia.org/wiki/PostScript
https://en.wikipedia.org/wiki/Open_XML_Paper_Specification
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· XPS specifies XPS printing to XPS.

Driver Mode Rules

The driver mode rules are used to set printing to GDI or XPS for specific applications. Click the icon

next to the Driver Mode dropdown menu in order to specify driver mode rules:

Figure 2. Driver Mode Rules Icon

The Driver Mode Rules dialog box will open:
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Figure 3. Driver Mode Rules Dialog Box

· Click Add to add applications to the list. The Add/Edit Driver Mode dialog box will open, as

detailed below.

· Click Edit/Remove to edit/remove selected applications. The Add/Edit Driver Mode dialog

box will open, as detailed below.

· Use the Default driver mode dropdown menu to determine the default driver mode in PDF-

XChange Printer Lite.

Figure 4. Add/Edit Driver Mode Dialog Box

· Enter the name of the application in the Application name text box. Note that the executable

file of the application must be used. Alternatively, click Browse to select an application

manually.

· Use the dropdown menu to determine the Driver Mode for the specified application. PDF-

XChange Printer Lite will then print in the specified mode when this application is used.
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Click OK to save changes.
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14.3 Macros

 Macros

Macros are used throughout PDF-XChange Standard. 'Macro' is an abbreviation of 'macroinstruction' -

a term in computer science for a rule that specifies how input characters should be entered to create

corresponding output. This means that components of the output process can be simplified during the

input process, which makes the work involved less intensive and more dynamic. Multiple macros can be

used simultaneously as desired. 

Please note that certain symbols are not compatible with macros and therefore are not permitted in

document names. If inconsistencies are noticed between the name used when files are saved and the

final file name then it is advised to change the name used when files are saved.

The format for macros is:

%[<Macro Name>] or, when it is customizable: %[<Macro Name>:<Parameter>]. The

<Parameter> step is optional in all cases except for the Environment Variable macro.

For example, the Page Number macro can be used to specify the page numbering format. The syntax

for the Page Number macro is %[Page:<Parameter>] and the following parameters are available:

· 'r' specifies the use of lower-case roman numerals - %[Page:r].

· 'R' specifies the use of upper-case roman numerals - %[Page:R].

· 'L' specifies page labels as the page numbering format in cases where page labels have been

specified. If page labels have not been specified then standard page numbers are used - %

[Page:L].

· '<integer> specifies the minimum number of digits used. This value can be any positive

integer from 1 to 12 - for example %[Page:4] starts the numbering as "0001, 0002, 0003...".

When macros are available the macro icon is displayed:
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Figure 1. Macro Icon

Click the macro icon to view a list of available options, then click to add macros to the associated text

box. All macros are detailed below:

· Application Name

· Computer Name

· Date and Time Macros

· Document Name

· Document Path

· Environment Variable

· Page Number

· Pages Count

· User Name

Further information about macros is available here.
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https://en.wikipedia.org/wiki/Macro_(computer_science)
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14.3.1 Application Name

 Application Name

The Application Name macro adds the executable filename of the application that calls

PDF-XChange Standard to print documents.

The syntax for this macro is %[AppName]

Example

Follow the steps below to use the Application Name macro to create a watermark:

1. Click Watermarks in the settings menu, then click Add:
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Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click Application Name in the

dropdown menu:
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Figure 2. Add/Edit Watermark Dialog Box, Application Name Macro Selected

The %[AppName] macro is then added to the text box, and the watermark text updates to the name

of the application that calls PDF-XChange Standard to print documents. For example, if Microsoft

Word is used then 'WINWORD' is added:
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Figure 3. Add/Edit Watermark Dialog Box, %[AppName] Macro Example
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14.3.2 Computer Name

 Computer Name

The Computer Name macro adds the name of the local computer as defined by the

Windows Computer Name.

The syntax for this macro is %[Computer]

Example

Follow the steps below to use the Computer Name macro to create a watermark:

1. Click Watermarks in the settings menu, then click Add:
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Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click Computer Name in the dropdown

menu:
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Figure 2. Add/Edit Watermark Dialog Box, Computer Name Macro Selected

The %[Computer Name] macro is then added to the text box, and the watermark text updates to

name of the local computer:
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Figure 3. Add/Edit Watermark Dialog Box, %[Computer] Macro Example
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14.3.3 Date and Time Macros

 Date and Time Macros

There are several macros in PDF-XChange Standard that are used to create date and time

output. They operate in an identical manner and are often used in conjunction with each

other. The date and time macros are detailed below: 

%[Date]

The %[Date] macro adds the current date. The following parameters are available:

· d inserts the day of the month and omits the zero in cases of single-digit values.

· dd inserts the day of the month and includes a zero in cases of single-digit values.

· ddd inserts the day of the week as a three-letter abbreviation.

· dddd inserts the day of the week.

· M inserts the month as a numerical value and omits the zero in cases of single-digit values.

· MM inserts the month as a numerical value and and includes a zero in cases of single-digit

values.

· MMM inserts the month as a three-letter abbreviation.

· MMMM inserts the month.

· yy inserts the year as two digits and adds a zero in cases of values lower than 10.

· yyyy inserts the year.

The syntax for this macro when parameters are used is %[Date:<Parameter>]

Note that several parameters can be used in sequence in order to insert a customized date. For

example, %[Date:dddd, dd MMMM yyyy] inserts the day of the week followed by the day of the

month, the month name in full and the year as four digits:
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Figure 1. Add/Edit Watermark Dialog Box, Example %[Date] Macro

If parameters are not specified for this macro then output reverts to default, which is the the format

d/M/yyyy.

%[Year]

The %[Year] macro adds the current year as a four-digit value.

%[Month]

The %[Month] macro adds the current month as a numerical value from 1-12.

%[Day]

The %[Day] macro adds the current day of the month as a two-digit value.
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%[Time]

The %[Time] macro adds the current time. The following parameters are available:

· h inserts the hour and omits the zero in cases of single-digit values.

· hh inserts the hour and includes a zero in cases of single-digit values.

· H inserts the hour, includes a zero in cases of single-digit values and uses a 24 hour-clock.

· m inserts the minutes and omits the zero in cases of single-digit values.

· mm inserts the minutes and includes a zero in cases of single-digit values.

· s inserts the seconds and omits the zero in cases of single-digit values.

· ss inserts the seconds and includes a zero in cases single-digit values.

· t inserts a single character to reference the a.m./p.m. variable: A or P.

· tt inserts two characters to reference the a.m/p.m. variable: AM or PM.

The syntax for this macro when parameters are used is %[Time:<Parameter>]

Note that several parameters can be used in sequence in order to insert a customized time. For

example, %[Time:H:mm tt] inserts the current hour and minutes, and inserts two characters to

reference the a.m./p.m. variable:
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Figure 2. Add/Edit Watermark Dialog Box, Example %[Time] Macro

%[Hour]

The %[Hour] macro adds the hour value from the current time.

%[Minute]

The %[Minute] macro adds the minute value from the current time.

%[Seconds]

The %[Seconds] macro adds the second value from the current time.

Note that these macros can be combined as desired. 
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14.3.4 Document Name

 Document Name

The Document Name macro adds the name of printed documents.

The syntax for this macro is %[DocName]

Example

Follow the steps below to use the Document Name macro to create a watermark that contains the

name of the document in text format:

1. Click Watermarks in the settings menu, then click Add:
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Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click Document Name in the dropdown

menu:
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Figure 2. Add/Edit Watermark Dialog Box, Document Name Macro Selected

The %[DocName] macro is then added to the text box, and the watermark text updates to the name of

the document:
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Figure 3. Add/Edit Watermark Dialog Box, %[DocName] Macro Example

Note that the preview pane displays the default value, which is the word 'Document.' The watermark

text will update to the name of documents when they are printed. For example, if the settings detailed

above are used to print a document entitled 'Lorem Ipsum', then it will print as detailed below:
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Figure 4. Sample %[DocName] Macro Output

Further Information

The getDocumentName function of the titrules.js JavaScript uses the document name at

the time of printing to define this macro. This JavaScript is included to give PDF-XChange

Standard priority over other applications when documents are saved. This is a necessary

process because of the complicated manner in which Microsoft defines document names.

Please note that modifying the titjules.js JavaScript is a complicated process that only

experienced JavaScript programmers should perform. If you require assistance in doing this

then please Contact Us.

http://www.pdf-xchange.com/contact
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14.3.5 Document Path

 Document Path

The Document Path macro adds the source path of the printed document.

The syntax for this macro is %[DocPath]

Example

Follow the steps below to use the Document Path macro to create a watermark:

1. Click Watermarks in the settings menu, then click Add:
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Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click Document Path in the dropdown

menu:
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Figure 2. Add/Edit Watermark Dialog Box, Document Path Macro Selected

The %[DocPath] macro is then added to the text box, and the watermark text updates to the path of

the document:
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Figure 3. Add/Edit Watermark Dialog Box, %[DocPath] Macro Example

Note that the preview pane displays the default value, which is 'C:\My Documents.' The watermark

text will update to the path of documents when they are printed. For example, if the settings detailed

above are used to print a document that is located on the desktop, then it will print as detailed below:
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Figure 4. Sample %[DocPath] Macro Output

Please note that some printing applications cannot identify the paths of printed documents, and this

macro will return no data in those cases. Furthermore, it should be noted that paths must be present in

order to be referenced - unsaved documents, for example, return no data when this macro is used.
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14.3.6 Environment Variable

 Environment Variable

The Environment Variable macro adds information taken from user-specified variables.

This macro must be qualified with a parameter in order to return information. 

The syntax for this macro is %[Env:<Parameter>] and the following parameters are available:

Parameters

· ALLUSERSPROFILE inserts the full path to the All Users profile directory.

· APPDATA inserts the full path to the Application Data directory of the current user.

· CommonProgramFiles inserts the full path to the Common Files directory.

· CommonProgramFiles(x86) inserts the full path to the (x86) Common Files directory in 64-bit

versions of Windows.

· CommonProgramFilesW6432 inserts the full path to the Common Files directory in 64-bit

versions of Windows.

· COMPUTERNAME inserts the computer name.

· HOMEDRIVE inserts the drive letter on the local computer that is connected to the user's home

directory.

· HOMEPATH inserts the complete path of the current user's Home directory, as defined by the

user's account properties.

· LOCALAPPDATA inserts the complete path to the current user's Application Data directory.

· LOGONSERVER inserts the name of the domain controller that authenticated the client's logon

request.

· OS inserts the name of the operating system.

· PROCESSOR_ARCHITECTURE inserts the chip architecture of the CPU.

· ProgramData inserts the full path to the All Users profile directory.

· ProgramFiles inserts the full path to the Program Files directory.

· ProgramFiles(x86) inserts the full path to the (x86) Program Files directory in 64-bit versions of

Windows.

· ProgramFilesW643 inserts the full path to the Program Files directory in 64-bit versions of

Windows.

· PUBLIC inserts the full path to the Public directory.
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· SESSIONNAME inserts the session name and number when a client is connected via a terminal

server.

· SystemDrive inserts the name of the drive on which the system folder was placed.

· SystemRoot inserts the name of the system folder.

· TEMP inserts the name of the default temporary folder used by the operating system and

applications available to the current user.

· TMP inserts the name of the default temporary folder used by the operating system and

applications available to the current user. (Note that some applications require the TEMP

environment variable, whilst others require TMP. The values for both should be identical).

· USERDOMAIN inserts the name of the user domain that contains the account of the current

user.

· USERDOMAIN_ROAMINGPROFILE inserts the name of the user domain for RDS or standard

roaming profile paths.

· USERNAME inserts the name of the current user.

· USERPROFILE inserts the location of the current user's profile directory. 

· windir inserts the full path to the Windows directory.

Example

Follow the steps below to use the Environment Variable macro to create a watermark from the full

path to the Common Files directory:

1. Click Watermarks in the settings menu, then click Add:
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Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click Environment Variable in the

dropdown menu:
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Figure 2. Add/Edit Watermark Dialog Box, Environment Variable Macro Selected

The %[Env] macro is then added to the text box. 

3. Add the text ":CommonProgramFiles" to the macro.

The watermark text will update to the full path to the Common Files directory:
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Figure 3. Add/Edit Watermark Dialog Box, %[Env:CommonProgramFiles] Macro Example
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14.3.7 Pages Count

 Pages Count

The Pages Count macro adds the number of document pages.

The syntax for this macro is %[Pages]

Example

Follow the steps below to use the Pages macro to create a watermark:

1. Click Watermarks in the settings menu, then click Add:
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Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click Pages Count in the dropdown

menu:
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Figure 2. Add/Edit Watermark Dialog Box, Pages Count Macro Selected

The %[Pages] macro is then added to the text box, and the watermark text updates to the number of

document pages. For example, in a three-page document, it appears as detailed below:
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Figure 3. Add/Edit Watermark Dialog Box, %[Pages] Macro Example
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14.3.8 Page Number

 Page Number

The Page Number macro adds the page number of source pages.

The syntax for this macro is %[Page]

Example

Follow the steps below to use the Page Number macro to create a watermark:

1. Click Watermarks in the settings menu, then click Add:



1975

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Printer Standard Printer Settings

Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click Page Number in the dropdown

menu:
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Figure 2. Add/Edit Watermark Dialog Box, Page Number Macro Selected

The %[Page] macro is then added to the text box, and the watermark text updates to the page

number:
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Figure 3. Add/Edit Watermark Dialog Box, %[Page] Macro Example

Note that the preview window displays the default value, which is '1' as this represents the first page. If

the Page Number macro is used when printing a three-page document, for example, then the output

pages will appear as detailed below:
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Figure 4. %[Page] Macro Output Example, Three Page Document
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14.3.9 User Name

 User Name

The User Name macro adds the name of the current user.

The syntax for this macro is %[User]

Example

Follow the steps below to use the User Name macro to create a watermark:

1. Click Watermarks in the settings menu, then click Add:
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Figure 1. Watermarks Settings Dialog Box, Add Watermark Button Highlighted

The Add/Edit Watermark dialog box will open.

2. Clear the Text text box, then click the macro icon and click User Name in the dropdown menu:
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Figure 2. Add/Edit Watermark Dialog Box, User Name Macro Selected

The %[User] macro is then added to the text box, and the watermark text updates to name of the

current user:
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Figure 3. Add/Edit Watermark Dialog Box, %[User] Macro Example
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14.4 Paper

 Paper

The Paper settings determine the size, orientation, margin, scaling factor, layout and printing order of

pages, and the DPI resolution of images. Please note that some programs, such as Microsoft Word,

override the properties determined in the Paper settings. This is because they use values determined

within their own parameters and give those values priority over the options in PDF-XChange Standard.

Click Paper in the menu on the left side of the main window to customize the Paper

Settings:

Figure 1. Paper Settings Dialog Box
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Page Size

· Standard features industry-standard standardized sizes, and also includes custom

profiles that the Custom Forms  feature has been used to create.

· Custom enables custom dimensions (to a maximum of two hundred inches). Use the

number boxes to determine document dimensions. Use the dropdown list to

determine the units of measurement. 

· Margins adjusts the size of document margins.

Please note that AutoCAD may present issues when printing, especially when it plots to virtual print

drivers such as PDF-XChange Standard. If problems arise, especially in regard to portions of output

exceeding the defined margin/page limits, we recommend setting a margin of at least 3.2mm.

Graphic

· Resolution is measured in DPI (dots per inch). Use the Resolution number boxes to

determine DPI. (Note that increasing DPI may decrease or increase the file size,

depending on the content being printed. If the content is predominantly drawings

(lines, curves, filled regions) or text, then increasing DPI may decrease the final file

size - especially in the case of text. However, if the content is predominantly image-

based, then increasing DPI will increase the file size in most cases).

· Scaling determines the size of converted documents in relation to original content.

· Orientation sets Portrait or Landscape as the page orientation.

Page Layout

· Standard layout features one page per PDF page. See here  for further options.

· Booklet layout features adjacent pages and is used for booklets and similar

documents. See here  for further options.

· Multiple Pages Per Sheet features multiple document pages per PDF page. Select a

value to view the layout in the preview window. See here  for further options.

Sheet Size

· Auto sets sheet size automatically. 

· Custom enables custom dimensions. 

· The remaining options are industry-standard dimensions.

Advanced Printing Options

· Select Mirror by X Axis to print a mirror version of the document that is reversed on

the horizontal axis.

1992
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· Select Mirror by X Axis to print a mirror version of the document that is reversed on

the vertical axis.

Click OK to save changes.
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14.4.1 Standard Layout

 Standard Layout

The Standard layout is used to print one document page per PDF page. The options

detailed below are available when Standard is selected in the Layout Type dropdown

menu:

Figure 1. Paper Settings Dialog Box, Layout Type Dropdown Menu Selected, Standard Option

The Sheet Size options determine document dimensions:

· Auto sets sheet size automatically. 
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· Custom enables custom dimensions. Enter the desired dimensions in the Size

boxes. 

· The remaining options are industry-standard dimensions.

Other Options

· If the Scale To Fit box is selected then layout options scale to the page size. Clear

the box to disable this setting and then enter values in the Size and Scale number

boxes or use the preview pane to resize pages.

· If the Center box is selected then documents are centered on the page and will

remain centered when the size is adjusted. Clear the box to disable this setting and

then enter values in the Position number boxes to determine page position.

Click OK to save changes.
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14.4.2 Booklet Layout

 Booklet Layout

The Booklet layout is used to print booklets and similar documents. When it is selected in

the Layout Type menu the following options are available:

Figure 1. Paper Settings Dialog Box, Booklet Options

The Sheet Size options determine document dimensions:

· Auto sets sheet size automatically. 

· Custom enables custom dimensions. Enter the desired dimensions in the Size

boxes. 
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· The remaining options are industry-standard dimensions.

The Booklet Type options determine the booklet format:

· Brochure creates brochures, which are usually two or four pages in length and fit on

a single sheet. 

· Books have more pages than brochures and usually feature double-sided printing. 

· Use the Sheets in signature number box to determine how sheets are folded.

· Use the Gutter size number box to determine the binding margin area, which the

gray area in the preview pane represents. The default size is the industry-standard

12.7mm

Click OK to save changes.
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14.4.3 Multiple Pages per Sheet

 Multiple Pages per Sheet

The Multiple Pages per Sheet layout is used to print multiple document pages per printed

page. When it is selected in the Layout Type menu the following options are available:

Figure 1. Paper Settings Dialog Box, Multiple Pages Per Sheet Options

The Sheet Size options determine document dimensions:

· Auto sets sheet size automatically. 

· Custom enables custom dimensions. Enter the desired dimensions in the Size

boxes. 
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· The remaining options are industry-standard dimensions.

Further Options

· The Page Per Sheet dropdown menu determines how many pages feature on each

sheet.

· The Page Order menu determines how pages are ordered in the PDF document.

Select an option to view the layout in the preview pane.

· Select the Print Pages Borders box to print page borders.

Click OK to save changes.
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14.5 Custom Forms

 Custom Forms

The Custom Forms settings are used to save custom forms for subsequent use:

Figure 1. Custom Forms Dialog Box

· Click Add to add a new custom form. The Add/Edit Custom Form dialog box will

open, as detailed below.

· Click Edit to edit selected forms.

· Click Remove to remove selected forms.
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Figure 2. Add/Edit Custom Form Dialog Box

· Enter a name in the Custom Form Name text box to name the custom form. 

· Enter dimensions in the Width and Height boxes and select a unit of measurement. 

Click OK to save custom forms. They will then be detailed in the Custom Forms dialog box,

and can also be selected in the Sheet Size dropdown menu in the Paper settings:
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Figure 3. Paper Settings, Sheet Size Dropdown Menu, Custom Forms
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14.6 General

 General

The General settings determine general document parameters for printed documents:

Figure 1. General Settings Dialog Box

· Use the Conform to Specification dropdown menu to determine the specification to which

printed files conform. These options are detailed in (figure 2) below.

· Select an option in the Page Layout dropdown menu to determine the page layout when

documents are opened:

· Viewer Default sets the page layout to the default settings of the program used to view

printed documents.
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· Single Page displays documents in single whole pages.

· Continuous displays documents in single pages continuously, which means consecutive

pages can be viewed at the same time when scrolling.

· Two Columns (Cover Page) displays the first page as a cover page and displays the

remaining pages in two columns.

· Two Columns displays documents in two columns.

· Two Pages (Cover Page) displays the first page as a cover page and displays the

remaining pages two pages at a time.

· Two Pages displays documents two pages at a time.

· Select an option in the Page Mode dropdown menu to determine which document

elements are displayed when documents are opened:

· Viewer Default displays documents in the default mode of the program used

to view printed documents.

· Pages view only displays only the document pages.

· Show Bookmarks Pane displays only document pages and the Bookmarks

pane.

· Show Thumbnails Pane displays only document pages and the Thumbnails

pane.

· Show Layers Pane displays only document pages and the Layers pane.

· Show Attachments Pane displays only document pages the Attachments

pane.

· Full Screen displays documents in full screen mode.

· Select an option in the Full Screen Page Mode dropdown menu to determine which

document elements are displayed when documents are opened in full screen mode.

Please note that these settings are applicable only to PDF viewers that support the

display of additional panes when full screen mode is enabled. The following options

are available:

· Viewer Default displays documents in the default full screen mode of the

program used to view printed documents.

· Pages view only displays only the document pages.

· Show Bookmarks Pane displays only document pages and the Bookmarks

pane.

· Show Thumbnails Pane displays only document pages and the Thumbnails

pane.

· Show Layers Pane displays only document pages and the Layers pane.

· Show Attachments Pane displays only document pages the Attachments

pane.

· Select an option in the Magnification dropdown menu to determine the level of

magnification when printed documents are opened:

· Default displays documents at the default magnification level.

· Actual Size displays documents at their physical size.

· Fit Page fits document pages to the viewer window.

· Fit Width fits documents to match the width of the viewer window.
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· Fit Height fits documents to match the height of the viewer window.

· Select a numerical option to set it as the zoom level when printed documents

are opened.

· Use the Open to Page number box to determine the page at which printed

documents are opened.

· Select an option in the Transition dropdown menu to determine the page transition

style when documents are viewed in full screen mode. Use the Page Duration

number box to determine how long each page remains open.

· Use the Transition Mode dropdown menu to determine the transition mode for

transition styles that feature multiple modes. Use the Transition Duration number

box to determine the length of transitions.

· Select boxes in the Viewer Preferences section as desired.

Figure 2. General Setting Dialog Box, Conform to Specification Dropdown Menu Options

· Select Auto to enable PDF-XChange Standard to select the PDF specification automatically.

· Select an option from Version 1.3 to Version 2.0 to set the PDF specification to these versions

of the the PDF specification. Further information about specifications is available here.

https://en.wikipedia.org/wiki/History_of_the_Portable_Document_Format_(PDF)
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· Select a PDF/A option to set the PDF specification to the PDF/A format, which is designed for

archiving documents. Further information about the PDF/A format is available here.

Click OK to save changes.
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14.7 Compression

 Compression

The Compression settings determine compression parameters for printed documents:

Figure 1. Compression Settings Dialog Box

· Select the Compress Graphics box to compress graphics in printed documents.

When this box is selected the compression options for High Color/Grayscale

Images, Indexed Images and Monochrome Images are enabled, as detailed

below.

· Select the ASCII format (Larger File) to compress printed documents to ASCII

character encoding.
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· Select the Compress Text box to compress document text.

High Color / Grayscale Images

· Select the Compress Using text box to enable compression for images of these formats, and

then use the dropdown menu to determine the type of compression.

· Use the JPEG Quality number box to determine the JPEG quality for high color/grayscale

images.

Indexed Images

Select the Compress Using text box to enable compression for indexed images, and then use the

dropdown menu to determine the type of compression.

Monochrome Images

· Select the Compress Using text box to enable compression for monochrome images, and then

use the dropdown menu to determine the type of compression.

· Use the JBIG2 Method dropdown menu to determine the method of JBIG2 compression used.

Click OK to save changes.
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14.8 Graphics

 Graphics

The Graphics settings are used to determine downsampling and conversion options for

graphics in printed documents:

Figure 1. Graphics Settings Dialog Box

High Color / Grayscale Images

· Use the upper dropdown menu to determine downsampling options for high

color/grayscale images:

· Select No Downsampling to disable downsampling.
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· Select Linear, Bilinear or Bicubic or enable these downsampling formats.

· Use the upper number box to determine the resolution to which images are

downsapled.

· Use the lower number box to determine the minimum resolution at which

images are downsampled.

· Use the lower dropdown menu to determine the format to which high

color/grayscale images are converted. Select the Use Dithering box as desired.

Indexed Images

· Use the upper dropdown menu to determine downsampling options for indexed

images:

· Select No Downsampling to disable downsampling.

· Select Linear, Bilinear or Bicubic or enable these downsampling formats.

· Use the upper number box to determine the resolution to which images are

downsapled.

· Use the lower number box to determine the minimum resolution at which

images are downsampled.

· Use the lower dropdown menu to determine the format to which high indexed

images are converted. Select the Use Dithering box as desired.

Monochrome Images

· Use the upper dropdown menu to determine downsampling options for

monochrome images:

· Select No Downsampling to disable downsampling.

· Select Linear, Bilinear or Bicubic or enable these downsampling formats.

· Use the upper number box to determine the resolution to which images are

downsapled.

· Use the lower number box to determine the minimum resolution at which

images are downsampled.

· Use the lower dropdown menu to determine the format to which high monochrome

images are converted. Use the Threshold number box to determine the threshold in

cases where monochrome images are converted to black and white. Pixels of a value

higher than the value entered in this box will be converted to white and all other

pixels will be converted to black.

Click OK to save changes.
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14.9 Fonts

 Fonts

The Fonts settings are used to determine font embedding options in printed documents:

Figure 1. Fonts Settings Dialog Box

· Select the Embed All Used Fonts box to embed all fonts. This increases the file size

but ensures that fonts can be viewed on all machines.

· Select the Force Embed Protected Fonts box to force the inclusion of protected

fonts in documents. Please note that some fonts are not licensed for widespread

distribution and therefore it is necessary to check license permissions when this

option is used.
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· Select the Embed Extended Font/Character Info box to embed extended fonts

and character information.

· Select the Force Embed Temporary Fonts box to force the inclusion of temporary

fonts in documents.

· Select the Embed a subset of fonts only, if percentage of characters used is less

than box to embed a subset of fonts when the percentage of total fonts they

represent in files is less than the percentage entered into the adjacent number box.

This optimizes the size of files as it saves a subset of fonts as opposed to the entire

character set, but it should only be used when there is no intention to edit

documents subsequently.

· The Available Fonts window displays all fonts available for embedding. Select fonts

and then use the arrow icons to add them to the Always Embed Fonts or Never

Embed Fonts panes. The best approach, in order to optimize file size, it to embed

uncommon fonts and leave common fonts unembedded. This is because it is

probable that common fonts will be available on the computers of subsequent

users, and therefore embedding these fonts will increase the size of files

unnecessarily. 

Click OK to save changes.



2005

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Printer Standard Printer Settings

14.10 Watermarks

 Watermarks

The Watermarks settings are used to add watermarks to printed documents:

Figure 1. Watermarks Settings Dialog Box

· Select the Enable Printing Watermark box to enable watermark printing.

Watermarks selected in the watermarks pane will be added when documents are

printed. Note that the Print On, On Background and Visible On columns provide a

summary of watermark parameters. Click Edit to adjust these parameters, as

detailed in (figure 2) below.

· Click Add/Edit to add/edit watermarks, as detailed in (figure 2) below.



2006

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Printer Standard Printer Settings

· Click Clone to clone selected watermarks.

· Click Remove to remove selected watermarks.

· Use the blue arrows to adjust the order of watermarks in the list.

Add/Edit Watermark

The options in this dialog box are used to determine the watermark content and style:

Figure 2. Add/Edit Watermark Dialog Box

· Use the Watermark Name text box to edit the watermark name. 

· Use the Type dropdown menu to select either Text Watermark or Image

Watermark as desired. Note that text and image watermarks feature different sets

of properties. The properties for text watermarks are detailed in (figure 2) and

explained below. The properties for image watermarks are detailed in (figure 3).

· Use the Text text box to edit the watermark text. Click the blue icon to add

macros  as desired. The sample watermark in (figure 2) utilizes the %[Date]

macro.

· Select an option in the Font dropdown menu to edit the watermark font.

· Use the Size dropdown menu to determine the size of the watermark font.

· Select the Bold, Italic and/or As Outlines boxes as desired.

1940
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· Use the Color dropdown menu to determine the font color.

· Select an option from the Text Align dropdown menu to determine the watermark

text alignment.

· Use the Rotation and Opacity number boxes to determine the rotation and

transparency of watermarks.

· Use the Horizontal/Vertical Offset number boxes to determine the offset of

watermarks on the horizontal and vertical axes. Select options in the from

dropdown menus to determine the location from which offsets are made.

· Select the As Background box to add watermarks as backgrounds.

· Use the Placed On dropdown menu to determine on which pages watermarks are

placed.

· Use the Visible On dropdown menu to determine when watermarks are visible.

Image Watermark Properties

Figure 3. Image Watermark Properties

· Enter the name of the file to be used in the Name text box, or click the icon to select

a file manually.

· Use the Page number box to specify the page number used from the source

document to create the watermark.
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· Use the Width and Height number boxes to determine the width and height of the

watermark.

· Select the Keep Aspect Ratio box to retain the aspect ratio of the image.

· Select the Fit to Page box to fit the image to the dimensions of the page on which

it is printed.

· Use the Transparent Color dropdown menu to determine the color of transparent

elements of watermarks.

The remaining options in this dialog box are detailed beneath (figure 2) above.

Click OK to save watermarks.
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14.11 Overlays

 Overlays

The Overlays settings are used to overlay printed documents with existing documents:

Figure 1. Overlays Settings Dialog Box

· Select the Overlay with an existing PDF File box to overlay printed documents.

· Enter the name of the overlay file in the Overlay File text box, or click Browse to

select a file manually.

· If selected files are password protected then enter the password in the Password to

open protected file text box.
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· Select the Place Overlay File as Foreground box to place overlays in the

foreground of printed documents.

· Select the Overlay pages added by extra appended documents to also overlay

pages added with the Default File Append  feature.

· The Repeat Options determine the outcome when there are fewer pages in the

overlay document than the printed document:

· Select No Repeat to not repeat the overlay document. Pages in the printed

document that exceed the range of the overlay document will not feature an

overlay.

· Select Repeat Last Page of Shorter Overlay File to repeat the final page of

the overlay document on the pages of the printed document that exceed the

range of the overlay document.

· Select Continuous Repeat of Shorter Overlay File to repeat the overlay

document from its first page on the pages of the printed document that

exceed the range of the overlay document.

· Use the Positions settings to determine the placement of overlay files relative to

printed documents:

· Select an option from the By Horizontal dropdown menu to determine the

horizontal position.

· Select an option from the By Vertical dropdown menu to determine the

vertical position.

· Select the Fit Overlay Pages to Newly Created Document Pages box to fit overlay

pages to the page size of printed documents.

· Select the Keep Aspect Ratio box to retain the aspect ratio of overlays when the Fit

Overlay Pages to Newly Created Document Pages option is used.

Click OK to save changes.

2021
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14.12 Security

 Security

The Security settings are used to add/edit document passwords and permission settings in

printed documents:

Figure 1. Security Settings Dialog Box

· Select the Use PDF security box to add passwords and permissions settings to

printed documents.

· Select the Password Required to Open the Document box to set a document

password, then enter the password in the Password text box. 



2012

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Printer Standard Printer Settings

· Select the Password Required to Change Permissions and/or Passwords box to

set a password for changing the permission settings and/or passwords of printed

documents, then enter the password in the Password text box.

· Select an option from the Encryption Level dropdown menu to determine the

encryption level of printed documents.

· Select the Document Permissions check boxes to set permissions as desired.

· Select the Digitally sign Document box to add a digital signature to printed

documents. Click Settings to determine digital signature settings. The Digital

Signature dialog box will open, as detailed in (figure 4) below.

· Select the Use Timestamp Server box to include time stamp verification in digital

signatures. Click Manage to add/view/edit time stamp servers. The Time Stamp

Servers List dialog box will open:

Figure 2. Time Stamp Servers List Dialog Box

Added time stamp servers are detailed in the dialog box. Click to select time stamp servers. Click

Add/Edit to add/edit time stamp servers. The Time Stamp Server dialog box will open:
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Figure 3. Time Stamp Server Dialog Box

· Use the Name text box to add/edit the name of time stamp servers.

· Use the Server URL text box to add/edit the URL of time stamp servers.

· If it is necessary to log in to the time stamp server then select the Server Requires

Authentication box and enter the login details in the Username and Password text

boxes.

Click OK to save time stamp servers.
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Figure 4. Digital Signature Dialog Box

· Select the Use Certificate from System Store option to use a certificate from the

system store. Click the dropdown menu to select a certificate, or click Browse to

select one manually.

· Select the Use Certificate From File option to use a certificate saved on the local

computer. Enter the filename of the certificate in the Filename text box, or click

Browse to select a certificate manually.

· Click View Certificate to view selected certificates.

· Click Create Certificate to create new certificates, as detailed in (figure 5) below.

· Use the Details options to edit digital signature details:

· Select an option in the Reason for Signing dropdown menu to add a reason

for signing the document.

· Use the Location and Contact Information text boxes to add a location

and/or contact information as desired.

· Select an option in the Permissions dropdown menu to determine

permissions in printed documents as desired.

· Select an option in the the Signing Format dropdown menu to determine the

signing format used when printing.

· Select/clear the Include signature's revocation status dialog box as desired.
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· Use the Appearance options to determine the appearance of digital signatures:

· Select an option from the Graphics dropdown menu to determine the

graphical element of digital signatures:

· Select No Graphic to omit the graphical element of the digital

signature.

· Select Name as Graphic to use the name of the signer as the graphic for

the digital signature.

· Select Image from File to select a file manually, then click the ellipsis

icon on the right of the text box to select an image.

· Select the Appearance check boxes to determine the details displayed with

the digital signature as desired.

· Use the Position pane to determine the size and location of digital signatures:

· Use the Page number box to determine the page on which the digital

signature is placed, or select the Place on Last Page to place signatures on

the last page of printed documents.

· Select the Place Visible Signature at Specified Position box to add a visible

signature, then use the number boxes to specify the position of signatures in

printed documents. Alternatively, click and drag the bounding box in the

image preview to place digital signatures manually. Click and drag the yellow

control points to change the dimensions of the digital signature field.

Create Certificate
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Figure 5. Create Self-Signed Digital ID Dialog Box

· Enter the desired details of the new digital ID in the Name, Organization Unit,

Organization Name and Email Address text boxes.

· Select the desired country from the Country/Region dropdown menu.

· Select a key algorithm in the Key Algorithm dropdown menu.

· Select an option in the Use Digital ID For dropdown menu to determine how the

digital ID will be used.

· Select either Windows Certificate Store or NewPKCS#12 Digital ID File for the

location at which the digital ID is saved. If the NewPKCS#12 Digital ID File option

is used, then enter and confirm a password for the digital ID in the text boxes.

Click OK to save new digital IDs.
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14.13 Links

 Links

The Links settings are used to determine parameters for URLs in printed documents:

Figure 1. Links Settings Dialog Box

· Select the Analize URLs in Printed Text box to enable link detection in printed

documents.

· Select the Detect Filenames and Convert to PDF Links box to convert filenames

into PDF links in printed documents. Note that linked files must be located on the

local computer.
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· Select the Check files Exist for Linking box to ensure that linked files are present

when links are created.

· Use the Links Options to determine the border Type, Color, Style and Width as

desired.

· The Links Options determine the parameters of link features. Use the Border Type,

Color, Style and Width boxes to determine these parameters of links.

· Click Default to revert to default settings for links.

Click OK to save changes.
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14.14 Bookmarks

 Bookmarks

The Bookmarks settings are used to determine parameters for bookmarks in printed

documents:

Figure 1. Bookmarks Settings Dialog Box

· Select the Enable Automatic Bookmarks Detection box to enable PDF-XChange

Standard to detect bookmarks automatically in printed documents.

· Select the Allow Multi-Line Bookmarks box to allow bookmark titles to exceed a

one line in length. This is a useful feature in cases where it is not possible to shorten

bookmark titles.
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· Select the Use Document Title As Bookmarks Root box to use document titles as

the root of bookmarks trees.

· Select the Match Node Regardless of Level box to link bookmarks irrespective of

their location in the bookmarks tree. If this box is cleared then some bookmarks may

not be recognized.

· Use the Display Mode dropdown menu to determine the initial appearance of

bookmark levels:

· All opened expands all levels of the bookmarks tree.

· All closed collapses all levels of the bookmarks tree.

· Defined by item references the State box in the Display Options settings to

determine whether bookmark levels are expanded or collapsed.

· Open to Node level opens bookmarks to the level entered in the Level

number box, which is displayed when this option is selected.

· The Template window displays the bookmark tree template of the current settings.

Click Add/Remove to add/remove bookmark levels, then use the Detection and

Display options to determine how bookmarks are detected and displayed for each

level:

· Use the Detection Options to determine the Font, Style, Size and Colour of

document text to be converted into bookmarks when documents are printed.

· Use the Display Options to determine the Style and Color of bookmarks in

printed documents. Select the Opened box to expand the bookmark level

when documents are printed.

Click OK to save changes.
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14.15 Default File Append

 Default File Append

The Default File Append settings are used to append/prepend printed documents:

Figure 1. Default File Append Options Dialog Box

· Select the Prepend output with a PDF file box to insert an existing file at to the

beginning of printed documents:

· Enter the name of the prepending file in the File text box, or click Browse to

select a file manually.

· If the file is password protected then enter the password in the Password text

box.
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· Select the Append output with a PDF file box to insert an existing file at the end of

printed documents.

· Enter the name of the appending file in the File text box, or click Browse to

select a file manually.

· If the file is password protected then enter the password in the Password text

box.

Click OK to save changes.
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14.16 Headers and Footers

 Headers and Footers

The Headers and Footers settings are used to add headers and footers to printed

documents:

Figure 1. Headers and Footers settings

· Select the Add Headers and Footers to the Document's Pages box to enable the

headers and footers functionality:

· Use the Header/Footer dropdown menus to determine the format of document

headers/footers. The following default formats are available:

· Page 1 adds the page number of each document page.



2024

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF-XChange Printer Standard Printer Settings

· Page 1 of ? adds the page number to each document page followed by "of

x" where x is the total number of document pages.

· Document adds the title of the document to each document page.

· Page 1 of ?, <current date>, Page 1 adds the page number of each

document page as the left header/footer, the current date as a central

header/footer and the page number as the right header/footer.

· Page 1, C:\My Documents\Document adds the last section of the full file

path.

· <current user>, Page 1, <current date> adds the current user as the left

header/footer, the page number of each document page as the central

header/footer and the current date as the right header/footer.

· Prepared by <current user> <current date>, Page 1 adds the text

"Prepared by <current user>" followed with the current date as a central

header/footer and the page number of each document page as the right

header/footer.

· Click Customize to edit the font style of headers/footers and/or add macros.

 The Customize dialog box will open, as detailed in (figure 2).

· Use the First Page Number dropdown menu to determine the first document page

that features headers and/or footers in printed documents.

· Use the Margins number boxes to determine the margins used for headers and

footers. Note that the margins in the preview panes update to reflect any changes

made.

Figure 2. Customize Dialog Box

· Enter text in the Left Section, Center Section and Right Section panes to

determine the text used as left, center and right headers/footers.

· Click the 'T' icon to edit font parameters.

· Use the color dropdown menus to edit the font color.

· Click the macro dropdown menus to add macros  to headers/footers.

1940

1940
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Click OK to save changes.
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14.17 Document Info

 Document Info

The Document Info settings are used to determine PDF information in printed documents:

Figure 1. Document Information Dialog Box

· Select the Place Additional Information Into the Document box to enable the

editing of document information.

· Select the Ask For Document Information on Printing Start box to enter

document information when documents are printed.

· Select the Add XMP Metadata to the Document box to add (XMP) information to

documents. See here for further information.

http://www.adobe.com/products/xmp.html
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· Enter data in the PDF information text boxes as desired.

· Select the Producer box to add the PDF producer to the information of the

document, or clear this box to exclude the PDF producer information from the

document.

Click OK to save changes.
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14.18 Save

 Save

The Save settings are used to determine how PDF-XChange Standard names and saves

printed documents:

Figure 1. Save Settings Dialog Box

· Select the Show 'Save As' Dialog box to launch the save as dialog for printed documents and

determine the name/location of saved files. Alternatively, enter the desired path and file name

for documents in the Path and File Name text boxes. 

· Click Browse to select a save location manually, or use the dropdown arrow to select standard

save locations such as the Desktop or My Documents.
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· Click Macro to add macros to the file name. Macros are a dynamic way to enhance the flow of

input data to output data. The example beneath the text box will update to show the output

file name when macros are added to the File Name text box. Further information on macros in

PDF-XChange Standard is available here.

· Select the Strip Path From Document Name box as desired.

· Select an option in the When File Already Exists dialog box to determine the

action taken when file names are already in use:

· Show Warning Dialog displays a warning and prompts the user for action.

· Always Overwrite saves the new file over the existing file.

· Auto Number uses the same file name and appends a number to it.

· Merge with Existing (Append To) appends the new file to the existing file.

· Merge with Existing (Insert Before) prepends the new file to the existing

file.

· Ask for new file name prompts the user for a new file name.

· Select the Run Application After Printing box to view documents immediately

after they are printed.

· Select the Default Application for PDF files option button to view printed

documents in the default PDF viewer of the local computer.

· Select the Application option button to view printed documents in an alternative

application to the default PDF viewer of the local computer. Enter the name of the

application in the Application text box, or click Browse to select an application

manually.

· Use the Parameters text box to enter application-specific printing parameters as

desired.

Click OK to save changes.

1940
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14.19 e-Mail

 e-Mail

The e-Mail settings are used to email printed documents:

Figure 1. Email Settings Dialog Box

· Select the Send Created Document as e-Mail Attachment box to automatically

email printed documents.

· Use the Method dropdown menu to determine how documents are emailed:

· Select Launch Default Email Client to launch the default email client of the

local computer when documents are printed, and then send emails manually.
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The values entered in the e-Mail Properties text boxes are used as default

values for emails.

· Select Send Through Default Email to email printed documents on the

default email client of the local computer. Documents are auto-emailed when

this option is used and the option to edit email properties is not available.

· Send Directly Through SMTP Server uses the server specified in the Server

text box of the SMTP Properties section to email printed documents. Use the

New, Edit and Remove buttons to create/edit/delete servers.

· Use the e-Mail Properties text boxes to determine the parameters used to send

emails: 

· Select the Send Document in ZIP Archive box to send files in (*.zip) format.

Click OK to save changes.
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14.20 Optimization

 Optimization

The Optimization settings are used to optimize printed documents:

Figure 1. Optimization Settings Dialog Box

· Use the Blending Operation dropdown menu to determine the blend mode used in

documents:

· Normal maintains the selected Fill Color.

· Multiply multiples the Fill Color value with the color value of the underlying content.

Resultant colors are at least as dark as one of the source colors.
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· Screen multiplies the complements of the Fill Color value with the color value of

underlying content and then complements the result. The resulting color will be at least

as light as one of the source colors.

· Overlay either multiplies or screens the Fill Color value with the color value of underlying

content, depending on the color value of the latter. The Fill Color will overlay the

underlying content while preserving its highlights and shadows. The color of underlying

content will be blended with the Fill Color to reflect its shade.

· Darken selects the darker of the Fill Color value and the color value of underlying

content.

· Lighten selects the lighter of the Fill Color value and the color value of underlying

content.

· Color Dodge brightens the color of the underlying content to reflect the Fill Color. Note

that if black is used as the Fill Color then there will be no effect.

· Color Burn darkens the color of the underlying content to reflect the Fill Color. Note that

if white is used as the Fill Color then there will be no effect.

· Hardlight either multiples or screens the Fill Color value with the color value of

underlying content, depending on the Fill Color value. This creates the effect of shining a

strong spotlight on the underlying color.

· Softlight either darkens or lightens colors, depending on the Fill Color value. This creates

the effect of shining a diffused spotlight on the underlying color.

· Difference subtracts the darker of the constituent colors from the lighter color.

· Exclusion performs a less contrasted version of the Difference option.

· Use the De-tesselation Method dropdown menu to enable/disable the de-tesselation of

complex objects, which reduces the size of files and optimizes viewing speeds. 

· Select the Use Transparency Drawing box to restore transparency after documents

are printed. Note that this box should be cleared when older versions of Adobe

Acrobat Reader are used, as they are not always compatible with transparency

drawing.

· Select the Use Masked Images box in order to simplify the imaging process. Note

that this process may result in bugs in some cases.

· Select the Write Grayscale Palette into RGB Colorspace box to include the

grayscale palette in the RGB colorspace. This may solve bugs experienced in relation

to the grayscale palette/colorspace.

· Select the Enable Optimization of Images Sequences box to permit PDF-XChange

Standard to optimize image sequences.

· Select the Swap to Disk Images Larger Than box to determine the size at which

images are swapped to disk. Enter the desired value in the number box.

If any issues are experienced in relation to transparency/flattening when using AutoCAD

and similar programs to print documents then please ensure that the Blending Operation

setting is set to Normal.

Click OK to save changes.
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14.21 Languages

 Languages

The Languages settings are used to determine the language of the user interface:

Figure 1. Choose Interface Language Dialog Box

· Select the Use Users Regional Settings box to use the regional language of the

local computer. Clear this box to select a language from the Available Languages

window. 

· Select a language and click Set as Default to enable it.

Click OK to save changes.
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15 Convert Web Pages to PDF

 Convert Web Pages to PDF

You can use PDF-XChange Standard to convert web pages in Chromium-based browsers to

PDF. Simply browse to the web page, right-click it and select Convert to PDF:

Figure 1. Right-Click Shortcut Menu from Chromium-Based Browser, Convert to PDF Highlighted

The Save As dialog box will open. Enter the desired name for the document, then click Save

to complete the conversion to PDF.
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16 PDF Saver

 PDF Saver

The PDF Saver feature is used to view/edit additional settings, and to run PDF-XChange

Standard from the command line. Enter "pdfsaver" in the Windows Search box, then click

PDF-XChange Standard pdfsaver to open the PDF Saver:



2039

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

PDF Saver

 
Figure 1. Windows Search Box

The PDF Saver feature will open:
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Figure 2. PDF-XChange Standard: pdfSaver Dialog Box, Settings Tab

· Select/clear the Show Icon in System Tray box to show/hide the PDF Saver icon in

the system tray.

· Select/clear the Show Printing Progress Window to show/hide the printing

progress window when print jobs are performed.

· Select/clear the Autounload pdfSaver after box to enable/disable the

autounloading of PDF Saver. If this option is enabled then enter the desired time in

the number box.

· Select/clear the Do not Remove Temporary Files to retain/discard temporary files.

· Select/clear the Do not Erase Temporary Folder at pdfSaver startup box to

retain/discard the temporary folder on PDF Saver startup.

About

The About tab provides further information about PDF Saver:
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Figure 3. PDF-XChange Standard: pdfSaver Dialog Box, About Tab

Command Line Options

Please note the following with regard to using command line options for PDF Saver: 

· Unless the path to pdfsaver.exe is added to the system %path%, then the full path to

pdfsaver.exe must be explicitly specified.

· If a profile is specified then changes will be made to that profile. If a profile is not specified

then the changes will be made to the current printer's settings.

· If any value has spaces, backslashes or forwardslashes then the option that contains

it should be enclosed in double quotation marks. Similarly, if there are spaces within

the optionslistfile, it should also be enclosed in double quotation marks.

Available command line options are detailed below:

pdfSaver.exe /AddPrinter <PrinterName> [/NoNotify]
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This command line can be used to install multiple copies of PDF-XChange Standard and

give each copy a custom name:

· <AddPrinter> adds a new printer to the printers list. 

· <PrinterName> determines the printer name. 

· <NoNotify> is an optional parameter that prevents the sending of information

about changes in the printers list to other applications.

Note that there are several benefits to installing multiple copies of PDF-XChange Standard,

such as the ability to send print jobs to different printing profiles without the need to

manually select a profile for each job. 

pdfSaver.exe /RemovePrinter <PrinterName> [/NoNotify]

This command line removes instances of the PDF-XChange printer. 

pdfSaver.exe /SetAsDefault <PrinterName>

This command line sets a specified printer as the default printer.

pdfSaver.exe /SetOptions optionname1=value1[;optionname2=value2] /Printer

<PrinterName> [/Profile <ProfileName>] [/NoNotify]

or

pdfSaver.exe /SetOptions @optionslistfile /Printer <PrinterName> [/Profile

<ProfileName>] [/NoNotify]

These command lines can be used to change the printer options.

pdfSaver.exe /DumpOptions [<dest_file_name>] /Printer <PrinterName> [/Profile

<ProfileName>]

This command line lists all settings of the printer specified. If <dest_file_name> is not

specified then settings will be listed in the console window.
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Command Line Examples
 

· Set the letter paper size:

pdfSaver.exe /SetOptions "DevMode.PaperSize=1" /Printer "PDF-XChange
Standard"

· Specify the generation of "PDF/A-2b" PDFs and to not run the PDF viewer after file

generation:

pdfSaver.exe /SetOptions "General.Specification=PDFA-
2b;Save.RunApp=false" /Printer "PDF-XChange Standard"

· Specify the use of an options file:

pdfSaver.exe /SetOptions @c:\documents\opt.lst /Printer "PDF-XChange
Standard"

An options file is a text file (supported text files in Unicode with BOM, UTF-8 with

BOM and UTF-8 w/o BOM formats) where each line has one option and value, such as:

General.Specification=PDFA-2b
Save.RunApp=false

Use the command line below to dump all printer options to the console:

pdfSaver.exe /DumpOptions /Printer "PDF-XChange Standard"

Alternatively, it is possible to specify a file in which to dump the printer options:

pdfSaver.exe /DumpOptions "C:\printer_settings.txt" /Printer "PDF-XChange
Standard"
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17 MSOffice Toolbar Add-in

 MSOffice Toolbar Add-in

The MSOffice Toolbar Add-in installs with PDF-XChange Standard and displays in MS

Word, Excel and PowerPoint toolbars. This means that different print settings can be

determined for these applications as desired and avoids the need to continually change

settings when documents are printed from different applications. You can use the Convert

to PDF option to print documents to PDF from MS Office applications. Click the PDF-

XChange tab to view options:

Figure 1. MSOffice Toolbar Add-in Options, MS Word

· Click Convert to PDF to convert the active document to PDF.

· Click Create PDF & Email to convert the active document to PDF and email it via

the e-Mail  settings.2030
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· Click Edit Settings to view/edit the PDF-XChange Standard settings, as detailed

below.

· Use the dropdown menu to determine the printing profile used to print documents,

as detailed here.

· Click Save Profile As to save the current settings to a new profile, as detailed

here.

· Click Manage Profiles to manage existing profiles, as detailed here.

Settings

Click Edit Settings to edit the print settings for the current MS Office application. The PDF-

XChange Settings dialog box will open. Available settings can be divided into two sections

- those that all MS Office applications share, and application-specific settings. Note that

changes made to settings will determine the output for only documents from the

application through which the MSOffice Toolbar Add-in was accessed. Additionally, the

commands in the MSOffice Toolbar Add-in, as detailed in and below (figure 1), must be

used in order for these settings to be utilized. If the option to print is selected from the File

menu instead then the Windows settings for PDF-XChange will be used.

Shared Settings

The shared settings are the same in the MS Office Toolbar for all MS Office applications:

1932

1932

1934
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Figure 2. PDF-XChange Settings Dialog Box, Settings Tab

These settings are used to determine printing parameters, as detailed in the earlier sections

of this manual.

Links Settings
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Figure 3. PDF-XChange Settings Dialog Box, Links Tab

The Links settings are used to determine options for links in printed documents:

· Select/clear the Generate Links in Result PDF File box to enable/disable links in

printed documents.

· Use the Convert MS Office Links check boxes to enable/disable link conversion for

the associated link formats.

· Use the Links Appearance dropdown menus to determine style options for links.

· Select the Address Target Document with Relative Path Name box to convert

fully-qualified path name links into path names that are relative to the active

document. This is a useful feature if documents are maintained in a folder hierarchy.

· Select the Change File Extension to PDF box to change the existing file extension

to (*.pdf). This is a useful feature if the current document points to other documents

that will also be converted to PDF format.

Advanced Settings
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Figure 4. PDF-XChange Settings Dialog Box, Advanced Tab

The Advanced settings are used to determine advanced options for printed documents:

· Select the Save Document Before Conversion box to save documents before

conversion to PDF.

· Select the Save Document to Original Document Folder box to save converted

documents in their source folder.

· Use the When File Exists dropdown menu to determine the action taken when

the document folder already contains a document with the same name as the

new document.

· Select the Remove PDF File After Email box to remove PDF files that have been

printed and emailed.

· Select the Convert Document Information box to include document properties

from source files in printed files.

· Select the Allow Actify 3D Recognition box to allow PDF-XChange Standard to

recognize and encode Actify-based 3D graphics.

· Select the Compress U3D streams box to compress Universal 3D files, which

reduces the size of files but may take longer to process.

· Select the Run Default Application for PDF Files After Conversion box to launch

the default PDF viewer after file conversion:

https://en.wikipedia.org/wiki/Universal_3D


2049

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

MSOffice Toolbar Add-in

· Select the Default Application for PDF files box to open converted

documents in the default PDF application.

· Select the Application button to specify an alternative application with which

to open converted emails. Enter the name of the application in the text box or

click Browse to select an application manually.

Application-Specific Settings

MS Word, Excel and PowerPoint each feature an application-specific tab in the MS Office

Toolbar Add-in. These settings determine output options for their respective applications:

MS Excel Options

Figure 5. MS Excel Options

· Select the Active Sheet Only box to convert only the active sheet to PDF.

· Select the Entire Workbook box to convert the entire workbook to PDF.

· Select the Sheets From a Range box to convert sheets from a custom range. Two

number boxes will open when this option is selected. Enter the first and last page of

the desired range.
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MS PowerPoint Options

Figure 6. MS PowerPoint Options

· Select the Place Each Slide As Bookmark box to create a bookmark from each slide

in the project.

· Select the Convert Slide Transition box to convert the transition slides in printed

files.

MS Word Options



2051

PDF-XChange PDF-XChange PRO V10 
 
                                                                                                                                                                                                          © 2024. PDF-XChange Co Ltd.

MSOffice Toolbar Add-in

Figure 7. MS Word Options

· Select the Convert Web Forms box to include web forms in the conversion to PDF.

· Select the Convert Revision Markups box to include revision markups in the

conversion to PDF.

Note that the Bookmarks tab is also available in the MSOffice Toolbar Add-in for MS

Word:
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Figure 8. MS Word Toolbar Add-in, Bookmarks Tab

· Select the Generate Bookmarks in Result PDF File to generate bookmarks in printed files.

· Select the Expand All Bookmarks box to expand all created bookmarks in printed files.

· Select styles in the Available Styles pane to determine the style of bookmarks. 

Click OK to save changes.
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18 MS Outlook Add-in

 MS Outlook Add-in

The PDF-XChange MS Outlook Add-in installs with PDF-XChange Standard and displays

in MS Outlook. It enables the immediate conversion to PDF of emails and bypasses the

need for an email client when it is used to archive emails. The PDF-XChange tab is available

in the main window of MS Outlook:

Figure 1. MS Outlook Main Window, PDF-XChange Tab

· Click Convert to PDF to convert the current email to PDF.

· Click Convert to PDF Portfolio to convert the current email to a PDF portfolio file.

· Click Settings to determine settings for the MS Outlook Add-in. The PDFXChange

Options dialog box will open:
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Figure 2. PDFXChange Options Dialog Box, PDF Page Tab

· Use the Page Size dropdown menu to determine the page size of converted emails.

Alternatively, use the number boxes and units of measurement dropdown menu to

determine custom sizes.

· Select either Portrait or Landscape as the orientation of converted emails.

· Use the Margins number boxes to determine the size of page margins in converted

emails.

Click Security to determine security settings:
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Figure 3. PDF-XChange Options Dialog Box, Security Tab

· Select the Use PDF Security box to enable PDF security.

· Select the Password Required to Open the Document box to set a password for

the document, then enter the desired password in the Password text box.

· Select the Password Required to Change Permissions and/or Passwords box to

set a password for changing document permissions and/or passwords, then enter

the desired password in the Password text box.

· Use the Document Permissions options the encryption level and permissions

settings of the document:

· Select the desired level of encryption level in the Encryption Level dropdown menu,

then select the check boxes as desired to determine additional settings.

Click Advanced to determine advanced settings for the conversion of emails:
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Figure 4. PDFXChange Options Dialog Box, Advanced Tab

· Select the Convert Attachments box to include email attachments in the

conversion.

· Use the Web page target width number box to specify the width of the converted

web page. Increase/decrease the value to increase/decrease the scale of converted

emails.

· Use the Compression level dropdown menu to determine the level of compression

for converted emails.

· Use the Conform to Specification dropdown menu to determine the PDF

Specification for converted emails.

· Select the Run default application for PDF files after conversion button to launch

the default PDF viewer after emails have been converted and view the new

documents.

· Select the Application button to specify an alternative application with which to

open and view converted emails. Enter the path to the application (for example,

PDF-XChange Editor uses the path PDFXEdit.exe by default) in the text box or click

Browse to select an application manually.

· Use the Parameters text box to enter additional run parameters for the application

specified in the Application text box.

Click OK to save changes.

https://en.wikipedia.org/wiki/History_of_the_Portable_Document_Format_(PDF)
https://en.wikipedia.org/wiki/History_of_the_Portable_Document_Format_(PDF)
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19 OFFice2PDF

 Office2PDF

The OFFice2PDF feature enables the convenient batch-conversion to PDF of MS Word,

Excel and HTML documents. Please note that MS Word/Excel must be installed on the local

computer in order to convert MS Word/Excel documents.

Enter "office2PDF" in the Windows Search Box, then click PDF-XChange Office2PDF to

launch this feature:
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Figure 1. Windows Search Box Results

The Office To PDF dialog box will open:
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Figure 2. Office2PDF Dialog Box

· The Watched directories list contains three entries by default: Microsoft Word,

Microsoft Excel and Internet Explorer. The Office2PDF feature is compatible with

the output from these applications. I.e. MS Word/Excel documents and (*.html)

files. Source files are displayed as children of the associated parent application

when they are added to the Office2PDF dialog box.

· Click Add, Delete or Delete All to add/delete/delete all added files.

· Click Folder to add folders to the Office2PDF feature. Files that are compatible with

the Office2PDF feature are converted to PDF automatically when they are added to

folders detailed in the list.

· Select/clear the Show Application's GUI box to enable/disable the display of the UI

of applications when files are converted.

· Select the Store converted documents in their original folders box to save

converted files in the same location as original files.
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· Select the Automatically process files from just added 'watched' folder box to

process files automatically when they are added to folders in the Watched

directories list.

· Note that it is also possible to drag files/folders into the Office2PDF dialog box.

There are two options in the Options dropdown menu:

· Click Settings to determine the print parameters of PDF-XChange Standard, as

detailed here.

· Click Exit to exit OFFice2PDF.

There are two options in the Info dropdown menu:

· Click Help to launch the help section of the PDF-XChange website.

· Click About to view further information about Office2PDF.

Click Go to convert files to PDF.

1983
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20 Features Added in Version 10

 Features Added in Version 10

The following features were added in Version 10 of PDF-XChange Standard:

· Added an option to set the Signing Format and Certificate Revocation status when printing.

· Added the ability to convert email attachments to PDF when converting emails in Outlook

using the PDF-XChange Outlook Add-In.

· Added Group Policy options to control which actions are available for serial key lists.
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